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Alcatel License Agreement

SAMPLE END USER LICENSE AGREEMENT

1. LICENSE
1.1 Subject to the terms and conditions of this Agreement, Alcatel grants to 

Customer and Customer accepts a non-exclusive, non-transferable license to use 
any software and related documentation provided by Alcatel pursuant to this 
Agreement ("Licensed Program") for Customer's own internal use,  solely in 
conjunction with hardware supplied or approved by Alcatel.  In case of 
equipment failure, Customer may use the Licensed Program on a back-up 
system, but only for such limited time as is required to rectify the failure.

1.2 Customer acknowledges that Alcatel may have encoded within the Licensed 
Program optional functionality and capacity (including, but not limited to, the 
number of equivalent nodes, delegate work stations, paths and partitions), which 
may be increased upon the purchase of the applicable license extensions.

1.3 Use of the Licensed Program may be subject to the issuance of an application 
key, which shall be conveyed to the Customer in the form of a Supplement to this 
End User License Agreement. The purchase of a license extension may require 
the issuance of a new application key.

2. PROTECTION AND SECURITY OF LICENSED PROGRAMS
2.1 Customer acknowledges and agrees that the Licensed Program contains 

proprietary and confidential information of Alcatel and its third party suppliers, 
and agrees to keep such information confidential.  Customer shall not disclose 
the Licensed Program except to its employees having a need to know, and only 
after they have been advised of its confidential and proprietary nature and have 
agreed to protect same.

2.2  All rights, title and interest in and to the Licensed Program, other than those 
expressly granted to Customer herein, shall remain vested in Alcatel or its third 
party suppliers.  Customer shall not, and shall prevent others from copying, 
translating, modifying, creating derivative works, reverse engineering, 
decompiling, encumbering or otherwise using the Licensed Program except as 
specifically authorized under this Agreement.  Notwithstanding the foregoing, 
Customer is authorized to make one copy for its archival purposes only.  All 
appropriate copyright and other proprietary notices and legends shall be placed 
on all Licensed Programs supplied by Alcatel, and Customer shall maintain and 
reproduce such notices on any full or partial copies made by it.

3.  TERM
3.1 This Agreement shall become effective for each Licensed Program upon 

delivery of the Licensed Program to Customer.
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3.2 Alcatel may terminate this Agreement: (a) upon notice to Customer if any 
amount payable to Alcatel is not paid within thirty (30) days of the date on which 
payment is due; (b) if Customer becomes bankrupt, makes an assignment for the 
benefit of its creditors, or if its assets vest or become subject to the rights of any 
trustee, receiver or other administrator; (c) if bankruptcy, reorganization or 
insolvency proceedings are instituted against Customer and not dismissed within 
15 days; or (d) if Customer breaches a material provision of this Agreement and 
such breach is not rectified within 15 days of receipt of notice of the breach from 
Alcatel. 

3.3 Upon termination of this Agreement, Customer shall return or destroy all copies 
of the Licensed Program.  All obligations of Customer arising prior to 
termination, and those obligations relating to confidentiality and non-use, shall 
survive termination.

4.  CHARGES
4.1 Upon shipment of the Licensed Program, Alcatel will invoice Customer for all 

fees, and any taxes, duties and other charges.  Customer will be invoiced for any 
license extensions upon delivery of the new software application key or, if a new 
application key is not required, upon delivery of the extension. All amounts shall 
be due and payable within thirty (30) days of receipt of invoice, and interest will 
be charged on any overdue amounts at the rate of 1 1/2% per month (19.6% per 
annum).

5.  SUPPORT AND UPGRADES
5.1 Customer shall receive software support and upgrades for the Licensed Program 

only to the extent provided for in the applicable Alcatel software support policy 
in effect from time to time, and upon payment of any applicable fees.  Unless 
expressly excluded, this Agreement shall be deemed to apply to all updates, 
upgrades, revisions, enhancements and other software which may be supplied by 
Alcatel to Customer from time to time.

6.  WARRANTIES AND INDEMNIFICATION
6.1 Alcatel warrants that the Licensed Program as originally delivered to Customer 

will function substantially in accordance with the functional description set out 
in the associated user documentation for a period of 90 days from the date of 
shipment, when used in accordance with the user documentation.  Alcatel's sole 
liability and Customer's sole remedy for a breach of this warranty shall be 
Alcatel's good faith efforts to rectify the nonconformity or, if after repeated 
efforts Alcatel is unable to rectify the non-conformity, Alcatel shall accept return 
of the Licensed Program and shall refund to Customer all amounts paid in 
respect thereof.  This warranty is available only once in respect of each Licensed 
Program, and is not renewed by the payment of an extension charge or upgrade 
fee.
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6.2 ALCATEL EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES, 
REPRESENTATIONS, COVENANTS OR CONDITIONS OF ANY KIND, 
WHETHER EXPRESS OR IMPLIED, INCLUDING WITHOUT 
LIMITATION, WARRANTIES  OR REPRESENTATIONS OF 
WORKMANSHIP, MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE, DURABILITY, OR THAT THE OPERATION OF THE 
LICENSED PROGRAM WILL BE ERROR FREE OR THAT THE 
LICENSED PROGRAMS WILL NOT INFRINGE UPON ANY THIRD 
PARTY RIGHTS.

6.3 Alcatel shall defend and indemnify Customer in any action to the extent that it is 
based on a claim that the Licensed Program furnished by Alcatel infringes any 
patent, copyright, trade secret or other intellectual property right, provided that 
Customer notifies Alcatel within ten (10) days of the existence of the claim, 
gives Alcatel sole control of the litigation or settlement of the claim, and 
provides all such assistance as Alcatel may reasonably require.  Notwithstanding 
the foregoing, Alcatel shall have no liability if the claim results from any 
modification or unauthorized use of the Licensed Program by Customer, and 
Customer shall defend and indemnify Alcatel against any such claim.

6.4 Alcatel Products are intended for standard commercial uses.  Without the 
appropriate network design engineering, they must not be sold, licensed or 
otherwise distributed for use in any hazardous environments requiring fail safe 
performance, such as in the operation of nuclear facilities, aircraft navigation or 
communication systems, air traffic control, direct life support machines, or 
weapons systems, in which the failure of products could lead directly to death, 
personal injury, or severe physical or environmental damage.  The Customer 
hereby agrees that the use, sale, licence or other distribution of the Products for 
any such application without the prior written consent of Alcatel, shall be at the 
Customer's sole risk.  The Customer also agrees to defend and hold Alcatel 
harmless from any claims for loss, cost, damage, expense or liability that may 
arise out of or in connection with the use, sale, licence or other distribution of the 
Products in such applications.

7.  LIMITATION OF LIABILITY
7.1 IN NO EVENT SHALL THE TOTAL COLLECTIVE LIABILITY OF 

ALCATEL, ITS EMPLOYEES, DIRECTORS, OFFICERS OR AGENTS FOR 
ANY CLAIM, REGARDLESS OF VALUE OR NATURE, EXCEED THE 
AMOUNT PAID UNDER THIS AGREEMENT FOR THE LICENSED 
PROGRAM THAT IS THE SUBJECT MATTER OF THE CLAIM.  IN NO 
EVENT SHALL THE TOTAL COLLECTIVE LIABILITY OF ALCATEL, 
ITS EMPLOYEES, DIRECTORS, OFFICERS OR AGENTS FOR ALL 
CLAIMS EXCEED THE TOTAL AMOUNT PAID BY CUSTOMER TO 
ALCATEL HEREUNDER.  NO PARTY SHALL BE LIABLE FOR ANY 
INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES, WHETHER OR 
NOT SUCH DAMAGES ARE FORESEEABLE, AND/OR THE PARTY HAD 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

7.2 The foregoing provision limiting the liability of Alcatel's employees, agents, 
officers and directors shall be deemed to be a trust provision, and shall be 
enforceable by such employees, agents, officers and directors as trust 
beneficiaries.
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8.  GENERAL
8.1 Under no circumstances shall either party be liable to the other for any failure to 

perform its obligations (other than the payment of any monies owing) where 
such failure results from causes beyond that party's reasonable control.

8.2 This Agreement constitutes the entire agreement between Alcatel and Customer 
and supersedes all prior oral and written communications.  All amendments shall 
be in writing and signed by authorized representatives of both parties.

8.3 If any provision of this Agreement is held to be invalid, illegal or unenforceable, 
it shall be severed and the remaining provisions shall continue in full force and 
effect.

8.4 The Licensed Program may contain freeware or shareware obtained by Alcatel 
from a third party source.  No license fee has been paid by Alcatel for the 
inclusion of any such freeware or shareware, and no license fee is charged to 
Customer for its use.  The Customer agrees to be bound by any license agreement 
for such freeware or shareware. CUSTOMER ACKNOWLEDGES AND 
AGREES THAT THE THIRD PARTY SOURCE PROVIDES NO 
WARRANTIES AND SHALL HAVE NO LIABILITY WHATSOEVER IN 
RESPECT OF CUSTOMER'S POSSESSION AND/OR USE OF THE 
FREEWARE OR SHAREWARE.

8.5 Alcatel shall have the right, at its own expense and upon reasonable written 
notice to Customer, to periodically inspect Customer's premises and such 
documents as it may reasonably require, for the exclusive purpose of verifying 
Customer's compliance with its obligations under this Agreement.

8.6 All notices shall be sent to the parties at the addresses listed above, or to any such 
address as may be specified from time to time.  Notices shall be deemed to have 
been received five days after deposit with a post office when sent by registered 
or certified mail, postage prepaid and receipt requested.

8.7 If the Licensed Program is being acquired by or on behalf of any unit or agency 
of the United States Government, the following provision shall apply:  If the 
Licensed Program is supplied to the Department of Defense, it shall be classified 
as "Commercial Computer Software" and the United States Government is 
acquiring only "restricted rights" in the Licensed Program as defined in DFARS 
227-7202-1(a) and 227.7202-3(a), or equivalent.  If the Licensed Program is 
supplied to any other unit or agency of the United States Government, rights will 
be defined in Clause 52.227-19 or 52.227-14 of the FAR, or if acquired by 
NASA, Clause 18-52.227-86(d) of the NASA Supplement to the FAR, or 
equivalent.  If the software was acquired under a contract subject to the October 
1988 Rights in Technical Data and Computer Software regulations, use, 
duplication and disclosure by the Government is subject to the restrictions set 
forth in DFARS 252-227.7013(c)(1)(ii) 1988, or equivalent.

8.8 Customer shall comply with all export regulations pertaining to the Licensed 
Program in effect from time to time. Without limiting the generality of the 
foregoing, Customer expressly warrants that it will not directly or indirectly  
export, re-export, or transship the Licensed Program in violation of any export 
laws, rules or regulations of Canada, the United States or the United Kingdom.
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8.9 No term or provision of this Agreement shall be deemed waived and no breach 
excused unless such waiver or consent is in writing and signed by the party 
claimed to have waived or consented.  The waiver by either party of any right 
hereunder, or of the failure to perform or of a breach by the other party, shall not 
be deemed to be a waiver of any other right hereunder or of any other breach or 
failure by such other party, whether of a similar nature or otherwise.

8.10This Agreement shall be governed by and construed in accordance with the laws 
of the Province of Ontario.  The application of the United Nations Convention 
on Contracts for the International Sale of Goods is hereby expressly excluded.
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Preface

About this document

The 5620 SAM User Guide and 5620 SAM Parameter Guide provide task-based 
workflows and user documentation to allow you to:

• use the GUI to perform tasks and maximize operator efficiency
• auto-discover and administer the 5620 SAM-managed network
• configure 7750 SR and 7450 ESS equipment
• find definitions, ranges, dependencies, and defaults for configurable parameters 

using the 5620 SAM Parameter Guide
• set and enable QoS and routing policies
• set and configure customer services, such as VLL, IES, VPRN, and VPLS
• manage network faults
• collect accounting and performance statistics

The 5620 SAM User Guide uses a task-based format. Each chapter contains:

• overview information about the task or function
• a workflow describing the steps necessary to complete the task or execute the 

functionality
• menus or commands used to complete the procedure
• a list of required procedures
• detailed procedures with key parameter descriptions and GUI windows that 

display the configuration options
Alcatel 5620 Service Aware Manager, Release 3.0 R1 ix
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Preface
The 5620 SAM Parameter Guide provides:

• parameter descriptions
• parameter options and option descriptions
• parameter and option dependencies

The 5620 SAM Parameter Guide also maps 5620 SAM GUI parameter names to 
their equivalent 5620 SAM-O XML property names.

Procedure 1  To view 5620 SAM Parameter Guide parameter 
descriptions from the 5620 SAM User Guide

You can click on a parameter name in a 5620 SAM User Guide procedure to open the 
matching parameter description in the 5620 SAM Parameter Guide. Ensure the following:

• the 5620 SAM Parameter Guide and 5620 SAM User Guide are located and 
opened from the same directory

• Adobe Reader Release 5.0 or later is installed

1 Open the 5620 SAM User Guide PDF using Adobe Acrobat.

2 Open the 5620 SAM Parameter Guide PDF using Adobe Acrobat.

3 Click on a parameter name in a procedure in the 5620 SAM User Guide. The 
parameter description is displayed in the 5620 SAM Parameter Guide.
x Alcatel 5620 Service Aware Manager, Release 3.0 R1
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Preface
About related documentation

There are many documents that define the 5620 SAM and the managed devices.

• Contact your Alcatel support representative for more information about network 
sizing and recommended hardware configurations. Use the 5620 SAM Planning 
Guide for more information about sizing.

• Use the 5620 SAM Installation and Upgrade Guide to install and upgrade the 
database, server, and client 5620 SAM software.

• Use the Alcatel 5620 SAM-O OSS Interface Developer Guide to use the XML 
OSS interface to create OSS applications, such as alarm monitoring and inventory 
controls. 

• Use the 5620 SAM Troubleshooting Guide to troubleshoot 5620 SAM-managed 
networks, services, applications and platforms.

• Use the 5620 SAM Routine Maintenance Procedures Guide to help develop and 
schedule regular maintenance activities.

• Use the 5620 SAM System Architecture Guide to understand how the software 
components are designed.

• Use the 5620 SAM Statistics Management Guide to manage statistics and view a 
list of supported MIB counters that can be collected by 5620 SAM.

• Use the  5620 SAM CNM Developer Guide to create CNM applications.
• See the index file in the User Documentation directory on the application DVD 

for additional documentation.

See the 7750 SR and 7450 ESS user documentation guides for more detailed 
information about specific CLI commands, device installation, and additional 
parameter information.

Conventions used in this guide

The following table lists the conventions that are used throughout the documentation.

Table 1  Documentation conventions

Convention Description Example

Key name Press a keyboard key Delete

Italics Identifies a variable hostname

Key+Key Type the appropriate consecutive keystroke sequence CTRL+G

Key–Key Type the appropriate simultaneous keystroke sequence CTRL–G

↵ Press the Return key ↵

— An em dash indicates there is no information. —

→ Indicates that a cascading submenu results from selecting a 
menu item

Policies→Alarm 
Policies
Alcatel 5620 Service Aware Manager, Release 3.0 R1 xi
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Preface
Procedures with options or substeps
When there are options in a procedure, they are identified by letters. When there are 
substeps in a procedure, they are identified by roman numerals.

Example of options in a procedure

At step 1, you can choose option a or b. At step 2, you must do what the step 
indicates.

1 This step offers two options. You must choose one of the following:

a This is one option.

b This is another option.

2 You must perform this step.

Example of substeps in a procedure

At step 1, you must perform a series of substeps within a step. At step 2, you must 
do what the step indicates.

1 This step has a series of substeps that you must perform to complete the step. You 
must perform the following substeps:

i This is the first substep.

ii This is the second substep.

iii This is the third substep.

2 You must perform this step.

Important information
The following conventions are used to indicate important information:

Warning —  Warning indicates that the described activity or situation 
may, or will, cause equipment damage or serious performance 
problems.

Caution —  Caution indicates that the described activity or situation 
may, or will, cause service interruption.

Note —  Notes provides information that is, or may be, of special 
interest.
xii Alcatel 5620 Service Aware Manager, Release 3.0 R1
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1 —  Workflows
1.1 5620 SAM workflow

The 5620 SAM workflow describes the high-level network and element 
management tasks performed using the 5620 SAM.

Use this workflow to:

• install, configure, create, and manage end-user services
• determine which workflow functions meet your user needs, then perform those 

functions

Figure 1-1 shows the high-level workflow necessary to commission, configure, 
deploy, and manage services.

Figure 1-1  Network workflow for lifecycle management

1.2 Workflow to install, configure, create, and manage 
end-user services

1 Install the 5620 SAM software, as described in the 5620 SAM Installation and 
Upgrade Guide.

2 Familiarize users with the client GUI.

a Review 5620 SAM features and functionality; see chapter 2.

b Start and learn GUI basics to navigate and use the 5620 SAM functions; see 
chapter 3.
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1 —  Workflows
c Use client GUI windows and forms; see chapter 5.

d Use the find and filter functions of the client GUI to search for equipment, 
network objects, or services; see chapter 6.

3 After the hardware has been configured, as described in the appropriate hardware 
documentation, such as the 7750 SR card and chassis installations guides, 
commission the devices to be managed by 5620 SAM.

a Use the CLI Telnet or SSH consoles from the 5620 SAM to view and configure 
devices, and to create CLI scripts; see chapter 7.

b Use the CLI Telnet or SSH consoles to perform commissioning 
preconfigurations on the devices before they are managed by 5620 SAM; see 
chapter 8.

c Discover the managed network and start managing equipment and services; 
see chapter 9.

d If required, modify polling to use in-band or out-of-band management; see 
chapter 10.

4 Perform 5620 SAM system administration tasks for the 5620 SAM system.

a Create a secure network management system and enable 5620 SAM users 
and accounts; see chapter 11.

b Create security policies on the managed devices and create accounts for users 
to securely access the managed devices using management access filters, 
RADIUS, or TACACS+ authentication; see chapter 12.

c If required, configure SSL for secure communications between 5620 SAM 
components; see chapter 13.

d Perform managed device database management tasks, for example, backing 
up a 7750 SR database or viewing deployment requests; see chapter 14.

e Perform 5620 SAM database tasks, for example backing up the 5620 SAM 
database; see chapter 15.

f Manage redundant 5620 SAM configurations; see chapter 16.

g Manage templates; see chapter 17.

h Use the 5750 SSC to interwork with the 5620 SAM for the management of 
triple play services and end-user subscribers; see chapter 18.

i Use non-5620 SAM network management software, for example, to navigate 
between applications and monitor alarms; see chapter 19.

5 Review how physical equipment is configured and managed; see chapter 20.

a Configure and manage physical equipment using the navigation tree; see 
chapter 21.

b Configure and manage physical equipment using the Equipment Manager; see 
chapter 22.
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6 Configure the device to set up network protocol communications and connections, 
such as MPLS LSPs, to allow customer traffic to flow from the access network 
through the core network.

a Configure the device and router interfaces; see chapter 23.

b Configure routing protocols; see chapter 24.

c Configure MPLS and LSPs; see chapter 25.

d Configure service tunnels (also known as SDPs); see chapter 26.

7 Determine and configure subscriber-based policies, such as QoS, and services, 
such as VLL, that can be configured to provide services to customers.

a Become familiar with service concepts, such as SAPs and HQoS; see 
chapter 27.

b Determine and configure local or global policies, such as QoS and filtering, that 
specify the quality of services delivered; see chapter 28.

c Configure and manage your subscriber (customer) base; see chapter 29.

d Configure VLL (also called Epipe, Apipe, and Fpipe) services for subscribers, 
which provides point-to-point connectivity between customer-facing access 
ports; see chapter 30.

e Configure VPLS services for subscribers, which provides a virtual LAN so 
multiple customer sites can be connected in a single bridged domain contained 
within the same IP/MPLS network; see chapter 31.

f Configure IES services for subscribers, which provides an IP router interface 
for customers to send and receive Internet traffic; see chapter 32.

g Configure VPRN services for subscribers, which provides a virtual IP LAN to 
connect multiple customer sites using L3 interfaces; see chapter 33.

h Configure VLAN services for subscribers connected to Telco devices, which 
allows interworking for L2 VPN, super VLAN, and broadcast TV services; see 
chapter 34.

i Use service mirroring functionality; see chapter 35.

j Configure composite services for subscribers that connect together numerous 
service types together; see chapter 36.

k View the topology of both the services subscribed to by customers and the 
service path topology used to route traffic by looking at maps; see chapter 37.

8 Monitor and troubleshoot customer services and the physical and logical network for 
faults.

a Use alarm to correlate network faults with impacts to subscriber services, and 
configure alarm policies; see chapter 38.

b Use OAM tools, such as MTU OAM and MAC trace, to troubleshoot circuits, 
service tunnels, and subscriber traffic down to the individual service level; see 
chapter 39.
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c Use 1+1 APS architecture to create configurations to protect SONET/SDH 
lines from linear unidirectional and bidirectional failures; see chapter 40.

9 Track network performance, equipment usage, billing data, and SLAs using 
accounting and performance statistics counters; see chapter 41 and the 5620 SAM 
Statistics Management Guide.
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2 —  5620 SAM releases features and functionality
2.1 New for this release of the 5620 SAM

Table 2-1 lists the 5620 SAM features or functionality added in this release of the 
5620 SAM.

Table 2-1 New 5620 SAM functionality

Feature or function Description Reference for more 
information

R1 features

Login security When you log in to the 5620 SAM GUI from a PC or 
workstation, the 5620 SAM displays a message dialog box 
with the date and time of the previous login using the same 
user account.

See chapter 3 for the 
basic GUI operation 
procedures.

Service creation process 
changes

The step-by-step wizard-like creation forms for services in the 
5620 SAM have been replaced by simpler tabbed 
configuration forms that incorporate a navigation tree for 
service object management. 

See the appropriate 
service chapter.

Composite service 
management

Through the 5620 SAM, services of the same or different types 
can be linked together by connectors to form a sophisticated 
service delivery mechanism.

See chapter 36 for 
information about 
configuring composite 
services.

VLL enhancements The 5620 SAM supports the creation of VLL services with 
end-to-end Ethernet, ATM, or Frame Relay encapsulation, or 
a combination of these encapsulation types, is supported.

See chapter 30 for 
information about 
configuring a VLL 
service.

802.1X support for EAP 
authentication

Enable and configure 802.1X authentication policies and port 
configurations to validate subscribers on the 7750 SR.

The 802.1X object no longer exists in the navigation tree. The 
device Properties form indicates whether 802.1X is enabled or 
disabled.

See chapter 21 for 
information about 
enabling 802.1X and 
configuring 802.1X for 
Ethernet ports.

See chapter 28 for 
information about 802.1X 
policy management.

Spoke redundancy added to 
the 7750 SR

The 5620 SAM now supports HVPLS spoke redundancy using 
MVPLS on the 7450 ESS and the 7750 SR.

See chapter 31 for 
information about 
configuring spoke 
redundancy.

Residential split horizon 
groups

RSHGs are SHGs that are configured with the Residential 
parameter. SAPs that are associated with an RSHG are 
lightweight SAPs. RSHGs are supported only on the 
7450 ESS.

See chapter 31 for 
information about 
configuring RSHGs.

See chapter 27 for 
information about 
lightweight SAPs.

Alarm management 
enhancements

Improvements and additions to 5620 SAM alarm management 
functions, including:

• configuration form for setting alarm type policies altered to 
allow easier listing and navigation

• new parameters to tag sets of alarms with the same name, 
for ease of grouping and listing

• updates to the navigation tree to display alarm status and 
aggregated alarm status of all objects in the network tree

• addition of alarm and connectivity status information to 
device icons on maps

See chapter 38 for more 
information about 
changes to alarm 
management.

(1 of 5)
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Graceful Restart For BGP, OSPF, and ISIS, the router can function as a helper 
and assist other capable routers with a graceful restart 
operation.

See chapter 24 for more 
information about 
configuring GR Helper 
mode.

BGP Advertise for Inactive 
Routes

Enable and configure BGP advertise for inactive routes. This 
parameter will advertise to peers any routes that have not been 
selected as the active route in the routing table as inactive.

See chapter 24 for more 
information about 
configuring BGP 
advertise for inactive 
routes.

BGP/LDP TTL Security 
Enhancement

BGP and LDP sessions can be protected by providing an 
expected TTL to peers.

See chapter 24 for more 
information about BGP 
and LDP peer 
configuration.

Support for new hardware The 5620 SAM supports the use of VSM-CCA daughter cards 
on the 7750 SR and 7450 ESS.

See the appropriate 
hardware documentation 
for specific node details. 
See also chapter 20 for 
more hardware support 
details.

Cross-connect aggregation 
groups use as an interface.

The 5620 SAM supports the creation and use of cross-connect 
aggregation groups for service configurations that may require 
paths that loop back onto themselves.

See chapter 21 for more 
information about 
configuring CCAG.

IES spoke into VPLS The 5620 SAM supports the connection of an IES and a VPLS 
or VLL through an internal cross-connect on the 7450 ESS, 
Release 3.0, and the 7750 SR, Release 3.0.

See chapter 36 for 
information about joining 
services to form 
composite services.

Restructure of client GUI 
main menu and submenu 
layout and names

To simplify operation of the 5620 SAM client GUI in customer 
networks, the menu and submenu structure was reorganized 
and renamed. Changes include:

• creation of new Administration and Tools main menu 
options to group together functions commonly performed 
by system administrators

• grouping of create and manage tasks
• organization of all maps and windows under the 

Application menu

All procedures in the 
5620 SAM 
documentation suite are 
updated to reflect the 
new menu structure.

See chapter 4 for 
information about 
mapping Release 2.1 or 
earlier menu names to 
the new Release 3.0 
menu names.

Feature or function Description Reference for more 
information

(2 of 5)
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Client GUI improvements GUI improvements provide more flexibility including:

• a drop-down menu in the navigation tree to choose the 
different navigation tree views, including a ring group view

• the ability to open multiple navigation trees at the same 
time

• a contextual menu option in the navigation tree to open 
another navigation tree with the selected object as the root

• a contextual menu option in the navigation tree to redefine 
a selected object as the root of the tree hierarchy

• a button in the navigation tree to restore the default root of 
the tree

• a Clipboard button on forms and in the navigation tree to 
copy the properties of selected objects to a clipboard from 
which you can copy and paste the properties, usually the 
object name and ID, to an external application

• a toolbar in the service topology map to allow the user to 
manipulate the map view

• Layer 3 interface port assignment and static route type 
displayed in network navigation tree

• device version displayed as part of the device label in 
topology maps

See chapter 3 for 
information about 
choosing navigation tree 
views and copying object 
properties to the 
clipboard.

See chapter 21 for 
information about 
grouping devices in a 
ring group and redefining 
the navigation tree root.

See chapter 37 for 
information about the 
map toolbar.

IGMP snooping IGMP snooping can be enabled for VPLSs on the 7750 SR, 
Release 3.0 or later.

See chapter 31 for 
information about 
configuring IGMP 
snooping on a VPLS.

Interface triggered MAC flush The 5620 SAM provides a LDP-based mechanism for 
recovering physical link failures in connections to VPLS 
services on the 7450 ESS.

See chapter 31 for 
support and 
configuration details.

IGMP Snooping: Show all 
routers with “show querier” 
command

The 5620 SAM can display all current and previous queriers 
that are receiving IGMP membership reports.

See chapter 31 for more 
information.

PIM: hello interval for 
neighbor down for the 
7750 SR

The 5620 SAM can change the neighbor down interval from 
the standard 3.5 multiplier.

See chapter 24 for 
configuration details.

PIM support for VPRN 
service

PIM can be enabled and configured to operate within a VPRN 
service.

See chapter 33 for more 
information.

OAM diagnostic test creation 
and management

Changes to the management and configuration of OAM 
diagnostics, to ease SLA management and provide easier 
access to tools:

• creation of a test manager, to search for, list, create, edit, 
and run diagnostics

• automatic enabling of all OAM diagnostics
• grouping of tests based on network application layer

See chapter 39 for more 
information about the 
types, creation, and 
running of OAM 
diagnostics.

Feature or function Description Reference for more 
information
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Service mirroring 
enhancements

The 5620 SAM supports service mirroring, introduced on 
7450 ESS Release 3.0, and service mirroring enhancements, 
including:

• the automatic creation of service tunnels when GRE is 
used as the transport type, and no other service tunnels 
exist between the source and destination sites

• CCAGs as mirror sources
• the default subscriber as the only subscriber to the service
• a consistent encapsulation type among sites associated 

with a mirror
• more stringent security requirements for the creation and 

management of service mirrors

See chapter 26 for 
information about service 
tunnels.

See chapter 35 for 
information about service 
mirroring.

RADIUS authentication of 
DHCP sessions

The 5620 SAM supports configuration and application of 
subscriber authentication policies for RADIUS authentication 
of DHCP sessions on the 7450 ESS, Release 3.0 or later, for 
VPLS and IES SAPs.

See chapter 12 for policy 
configuration 
information.

See the following 
chapters for DHCP 
configuration 
information:

• chapter 31 for VPLSs
• chapter 32 for IESs

DHCP relay enhancements DHCP relay can be enabled on the 7750 SR, Release 3.0 or 
later, for VPLS.

The 5620 SAM supports the following DHCP relay 
enhancements on the 7450 ESS, Release 3.0 or later, and the 
7750 SR, Release 3.0 or later:

• specifying the maximum number of lease states allowed 
on IES, VPLS, and VPRN SAPs

• automatic enabling of DHCP snooping on IES and VPRN 
SAPs when the number of lease states is specified

• specifying the Relay Information Option, defined in RFC 
3046, for IES, VPLS, and VPRN SAPs

• configuring DHCP relay when using service-based 
templates

See chapter 17 for 
information about service 
templates.

See the following 
chapters for DHCP 
configuration 
information:

• chapter 23 for Layer 
3 interfaces

• chapter 31 for VPLSs
• chapter 32 for IESs
• chapter 33 for 

VPRNs

Anti-spoof filter management The 5620 SAM supports anti-spoof filter management on the 
7450 ESS, Release 3.0 or later, and the 7750 SR, Release 3.0 
or later, for IES, VPLS, and VPRN SAPs. Use anti-spoof filter 
management to configure:

• anti-spoof filters on service configuration forms and when 
using service-based templates

• ARP reply agents
• population of static and dynamic hosts in the ARP cache
• static subscriber hosts
• MAC pinning

See chapter 17 for 
information about service 
templates.

See the following 
chapters for anti-spoof 
filter configuration 
information:

• chapter 31 for VPLSs
• chapter 32 for IESs
• chapter 33 for 

VPRNs

HP OpenView NNM Continued support for the latest managed device releases, and 
the addition of 5620 SAM support, allowing OpenView users to 
install and launch the network manager software.

See chapter 19 for more 
information about 
integrating 
non-5620 SAM 
applications.

Fault management using 
APS

The 5620 SAM supports 1+1 APS configurations on the 
7750 SR, Release 3.0 or later. Use APS to protect 
SONET/SDH lines from linear unidirectional and bidirectional 
failures.

See chapter 40 for 
information about APS.

Feature or function Description Reference for more 
information
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Table 2-2 lists key changes and additions to the 5620 SAM documentation suite.

Table 2-2 Changes and additions to 5620 SAM documentation

Multicast VPLS registration The 5620 SAM supports multicast VPLS registration for the 
7450 ESS, Release 3.0 or later. MVR allows a subscriber on a 
port to use IGMP messages to control a subscription to a 
multicast data stream. 

See chapters 24, 28, 
and 31 for more 
information about MVR.

License key size increased The 5620 SAM license key size has increased. See chapter 8 for more 
information about 
modifying an existing 
license key. See the 
5620 SAM Installation 
and Upgrade Guide for 
information about 
entering the license key 
during installation.

Feature or function Description Reference for more 
information

(5 of 5)

Document Description Reference for more 
information

Release R1

Alarm management overview 
in the 5620 SAM User Guide

Overview and example of the relationship between alarm 
status, alarm aggregation, and the differences between 
affecting, propagated, and related alarms.

See section 38.1 for 
illustrations and 
descriptions.

Restructure of the 5620 SAM 
Parameter Guide

The 5620 SAM Parameter Guide is restructured to match the 
new menu and sub-menu structure developed for the client 
GUI

See the 5620 SAM 
Parameter Guide.

Service configuration 
procedures changes

The step-by-step wizard-like service creation forms have been 
replaced by simpler configuration forms. All service 
procedures in the 5620 SAM User Guide have been rewritten.

See the appropriate 
service chapter.

Reorganization of the 
5620 SAM Installation and 
Upgrade Guide

The 5620 SAM Installation and Upgrade Guide is:

• organized by Solaris and Windows operating systems
• describes end-to-end workflows for setting up standalone 

and redundant systems, and upgrades
• uses the installation screens to illustrate the sequence of 

installation activities

See the 5620 SAM 
Installation and Upgrade 
Guide.

HQoS samples and 
description of the triple play 
service delivery architecture 
components

The 5620 SAM User Guide describes:

• sample HQoS configuration that uses tiered schedulers 
and queues incoming packets for processing based on the 
IP precedence marking of the packets

• the major components of the triple play service delivery 
architecture, and the role of 5620 SAM is setting QoS and 
filters, and for creating multicast BTV streams

See chapter 27 for 
information about sample 
HQoS configuration and 
TPSDA

Creation of example-based 
statistics documentation

The 5620 SAM Statistics Management Guide describes:

• performance, accounting, and on-demand statistics
• sample real-world network configuration and the 

associated procedures required to collect statistics
• mapping of statistics counter name to the associated MIB 

value

See the 5620 SAM 
Statistics Management 
Guide.
2-6 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



2 —  5620 SAM releases features and functionality
2.2 5620 SAM Release 2.1 functionality

Table 2-3 lists the 5620 SAM features or functionality added in Release 2.1 of the 
5620 SAM.

Table 2-3 5620 SAM Release 2.1 functionality

Feature or function Description Reference for more 
information

R1 features

Routing protocol 
enhancements

Multiple improvements have been made to routing policing 
configuration using the 5620 SAM, including:

• proxy ARP
• 31-bit mask IP address support
• BGP fast fail over, BGP community sending disabling, AS 

override, outbound route filtering, and default originate
• policy filtering for LDP label bindings and LDP tunnel 

damping
• ISIS IPv4 route summaries

See the appropriate 
routing protocol 
configuration information 
in chapter 24.

Interworking support with 
non-5620 SAM network 
management applications

The following network management software applications can 
be installed and configured to interwork with the 5620 SAM:

• 5620 NM
• 1354 BM
• HP OpenView NNM

Use the interworking functionality to:

• navigate between network management GUIs
• provide and view alarm feeds from the 5620 SAM to other 

network management applications

See the 5620 SAM 
Installation and Upgrade 
Guide for more 
information about 
installing non-5620 SAM 
network management 
applications.

See chapter 19 for 
information about 
performing network 
management 
interworking functions.

License key information The following information and functionality have been added to 
the license key:

• licensed quantity of MDA consumed and remaining
• alarms raised when thresholds are exceeded
• export license information to a text file
• update license key dynamically to support increased 

licensed quantities of daughter cards (MDAs) without 
restarting the server

See chapter 3 for more 
information about 
viewing and exporting 
license information.

Client GUI improvements GUI improvements provide a more flexible user interface:

• provides a standard Java look and feel
• provides the navigation tree and alarm windows as floating 

windows that can be resized, hidden, and have 
preferences stored, and that can be accessed from 
menus, tool bar icons, the taskbar, and shortcut keys

• provides access to object properties by double-clicking on 
a leaf object in the navigation tree

• provides title bars that display the object type, name, and 
ID in policy, subscriber, and service forms. When a form is 
minimized, a tooltip identifies it using the title-bar name. 
Additionally, titles of all opened form s are listed and can 
be selected from a Window menu. 

• provides Alcatel-standard alarm colors
• provides a configurable login message for client GUI users

See chapter 3 for more 
information about GUI 
basics.
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Modularization of client GUI 
components

The functions of the 5620 SAM have been split among four 
components, which can be enabled by the license key:

• 5620 SAM-E for device mediation, equipment 
management, security, CLI access to managed devices, 
backup and restore, equipment navigation, alarm policy 
management, real-time equipment statistics, and 
inventory and reporting

• 5620 SAM-P for service provisioning, templates, network 
tunnel and path management, subscriber management, 
and policy management

• 5620 SAM-A for service assurance functionality, fault 
correlation using alarms, OAM tools, topology views, 
statistics policies and historical statistical data, and 
accounting policies and accounting data

• 5620 SAM-O for the XML open interface

See chapter 3 for more 
information about the 
effects on not enabling all 
software components.

PIM management support PIM, used in conjunction with IGMP, defines an IP routing 
protocol that delivers multicast traffic to receivers. 5620 SAM 
provides:

• PIM configuration at the routing instance level
• PIM configuration at the interface level
• PIM availability for IES

See the PIM overview, 
configuration, and 
procedures in 
chapter 24.

For information about 
how to apply PIM to an 
IES, see the PIM-specific 
procedures in 
chapter 32.

IGMP management support IPv4 hosts and routers use IGMP to report their group 
memberships to neighboring multicast routers. 5620 SAM 
provides:

• IGMP configuration at the routing instance level
• IGMP configuration at the interface level
• IGMP availability for IES

See the IGMP overview, 
configuration, and 
procedures in 
chapter 24.

For information about 
how to apply IGMP to an 
IES, see the 
IGMP-specific 
procedures in 
chapter 32.

DHCP relay and snooping DHCP relay interconnects DHCP clients with a DHCP server 
connected to another LAN segment or network. DHCP 
snooping allows 5620 SAM to build ACL filters. These features 
are supported in version 2.1 of the 7750 SR and in version 2.0 
of the 7450 ESS.

See chapter 23 for DHCP 
configuration information 
for Layer 3 interfaces.

See chapter 32 for the 
DHCP component of 
configuring an IES 
service.

See chapter 33 for the 
DHCP component of 
configuring a VPRN 
service.

See chapter 31 for the 
DHCP component of 
configuring VPLS.

Feature or function Description Reference for more 
information
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Service templates The 5620 SAM supports the configuration of VLL, VPLS, IES, 
and VPRN services using service-based templates. The 
templates allow a user with service management privileges to 
define common characteristics for a service.

See chapter 17 for 
information on creating 
service templates.

See the following 
chapters for information 
on using a pre-created 
template to create a 
service:

• chapter 30 for VLL 
• chapter 31 for VPLS
• chapter 32 for IES
• chapter 33 for VPRN

Telco device, VLAN, and 
services

The 5620 SAM supports element and network management of 
Telco devices in the provider network. Telco Ethernet devices 
provide Ethernet and service-aware Ethernet aggregation 
across IP/MPLS networks. Telco devices are used in ring 
groups to distribute L2 VPN, Internet, and broadcast services 
from VPLS or VLL services on 7450 ESSs across VLANs to 
subscribers.

See chapter 20 for 
general support 
information.

See chapter 28 for Telco 
device policy 
management information

See chapter 34 for VLAN 
information.

Support for 7750 SR high 
availability

High availability on the router is used to ensure active and 
standby redundancy in the managed network elements. You 
can view the status of router redundancy and the reason for a 
fail over from the active to the standby from the properties form 
of the router.

—

Support for ATM traffic 
routing

The 5620 SAM supports: 

• the creation of SONET/SDH channels with ATM 
encapsulation

• ATM interface management to create PVCs within IES or 
VPRN services

• ATM QoS policy creation and management
• ATM OAM 

See chapter 21 for 
information about how to 
create SONET/SDH 
channels. 

See chapter 32 for IES 
service creation 
information and 
chapter 33 for VPRN 
service creation 
information. 

See chapter 28 for 
information about ATM 
QoS policy creation and 
management.

See chapter 39 for 
information about ATM 
OAM. 

802.1X support for EAP 
authentication

Enable and configure 802.1X authentication policies and port 
configurations to validate subscribers on the 7450 ESS.

See chapter 20 for 
general support 
information.

See chapter 21 for 
information about 
configuring 802.1X 
parameters for Ethernet 
ports.

See chapter 28 for 
information about 802.1X 
policy management.

Feature or function Description Reference for more 
information
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Forwarding subclass support Associates one or more forwarding subclasses with each 
forwarding class. This provides a greater degree of SAP 
ingress packet classification.

See chapter 28 for 
support and 
configuration 
information.

Shared network queues Supports shared queues for SAPs using a default shared 
queue policy

See chapter 28 for more 
information.

Policy management 
enhancements

Policy management functionality improvements include:

• doubling the number of managed policies to 131 072
• controlling local and global policy interaction
• limiting local policy influence to initial discovery
• synchronizing local and global policies
• auditing policies

See chapter 28 for more 
information.

IP interface trust override Provides the ability to explicitly override default trust states for 
IES, VPRN, and network IP interfaces

See chapter 32 for IES 
configuration 
information.

See chapter 33 for VPRN 
configuration 
information.

See chapter 23 for 
information about 
configuring a Layer 3 
interface.

IGMP snooping IGMP snooping can be enabled for VPLSs on the 7450 ESS. See chapter 31 for 
information about 
configuring IGMP 
snooping on a VPLS.

Spoke redundancy The 5620 SAM supports HVPLS spoke redundancy using 
MVPLS on the 7450 ESS.

See chapter 31 for 
information about 
configuring spoke 
redundancy.

Split horizon groups Split horizon groups control traffic flowing through SAPs or 
spoke SDPs for a VPLS.

See chapter 31 for 
information about 
configuring split horizon 
groups.

RSTP support Supports RSTP (802.1D-2004) for VPLS instances on the 
7750 SR and the 7450 ESS and remains compatible with older 
STP variants

See chapter 31 for RSTP 
configuration during 
VPLS creation.

Feature or function Description Reference for more 
information
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Support for new hardware Additional card support for the 7450 ESS includes:

• 20 × 10/100/1000 Ethernet Tx
• 20 × 10/100/1000 Ethernet SFP

Additional card support for the 7750 SR includes:

• 4 × OC3 Deep Channel
• 16 × ATM OC3 SFP
• 4 × DS3/E3 Deep Channel
• 4 × ATM OC12/OC3 SFP
• 1 × 10-Gig Ethernet XFP

Card support for the Telco devices includes:

• 24 × Fast Ethernet 10/100 TX
• 24 × Fast Ethernet 10/100 FX
• 48 × Fast Ethernet 10/100 TX
• 4 × Gig Ethernet (2 TX, 2 FX)
• 24 × Gig Ethernet (20 TX, 4 Dual TX/FX)
• 24 × Gig Ethernet (20 FX, 4 Dual TX/FX)

See the appropriate 
hardware documentation 
and port information, 
such as line length and 
hardware specifications.

See chapter 20 for 
information about 
hardware modelling 
support.

See Table 20-4 for a list 
of supported cards on the 
managed hardware.

IP SAP ingress Dot1P Q in Q 
classification

Allows the specification of which Dot1P bits in a Q in Q 
encapsulated packet are used to evaluate Dot1P QoS 
classification. Support for this feature is dependent on the 
software release of the NE. See the 7750 SR and 7450 ESS 
documentation for more information.

See chapters 30, 31, 32, 
and 33 for VLL, VPLS, 
IES, and VPRN QoS 
configuration 
information.

Single fiber router connection Supports the enabling of packet gathering and redirection from 
a single fiber on a SONET interface for redistribution to other 
interfaces. Support for this feature is dependent on the 
software release of the 7750 SR. See the 7750 SR 
documentation for more information.

See chapter 21 for 
configuration 
information.

Upgrading to a new 
5620 SAM release

Multiple upgrade scenarios are possible. Use the 
ClientServerInstaller and DBconfig installers to perform 
upgrades. Contact your Alcatel support representative for 
more information.

See the 5620 SAM 
Installation and Upgrade 
Guide for more 
information about 
upgrades.

R2 and later features

Service mirrors Service mirroring is used to forward packets or portions of 
packets from a customer service to a mirrored destination port. 
Use service mirroring to:

• troubleshoot service delivery issues
• allow service providers to meet regulatory obligations 

regarding call records
• reduce the complexity of an analyzer overlay network

See chapter 35 for more 
information about using 
service mirrors.

Database and server 
redundancy

Redundancy provides network visibility in case of the hardware 
or software failure of one or more 5620 SAM components, for 
example, a server.

When the active component fails, the standby component is 
configured to automatically take control. Alternately, perform 
manual failovers to test redundancy or prepare for network 
upgrades.

See the 5620 SAM 
Installation and Upgrade 
Guide for more 
information about 
installing redundancy 
components.

See chapter 16 for more 
information about 
redundancy 
configuration and 
management.

Feature or function Description Reference for more 
information
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Table 2-4 lists key changes and additions to the 5620 SAM documentation suite in 
Release 2.1.

Table 2-4 Changes and additions to 5620 SAM documentation in Release 2.1

Security management Security enhancements to the 5620 SAM allow system 
administrators to manage client GUI user security more 
effectively. Use security management to:

• enable user action logging
• view or close active client GUI sessions
• set scope of command for users and user groups
• specify the maximum number of admin sessions
• specify the expiry period for user accounts and passwords

See chapter 11 for more 
information about 
security configuration on 
the client GUI.

See the 5620 SAM 
Troubleshooting Guide 
for more information 
about user logs.

MAC move The 5620 SAM supports MAC move on the 7750 SR. The 
MAC move feature can be configured at VPLS creation for 
SAPs and spoke SDPs.

See chapter 31 for 
information about MAC 
move configuration.

Service tunnel auto-creation The 5620 SAM automatically creates service tunnels for VPLS 
and VLL services when GRE is used as the transport type, and 
no other service tunnels exist between the source and 
destination devices.

See chapter 26 for more 
information about service 
tunnels.

See chapter 30 for more 
information about VLLs. 
See chapter 31 for more 
information about VPLS.

Feature or function Description Reference for more 
information
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Document Description Reference for more 
information

Release 2.1 R1

5620 SAM Parameter Guide 
parameter descriptions

Allows planners, system administrators, and operators to find 
and view information for parameters that are configurable from 
the 5620 SAM client GUI, including:

• default value
• range
• description
• dependencies on other parameter values
• equivalent XML property name

See chapters 47 to 134

Parameter links between the 
5620 SAM User Guide and 
the 5620 SAM Parameter 
Guide

You can click on a parameter name in the 5620 SAM User 
Guide to launch and view the description of the parameter in 
the 5620 SAM Parameter Guide. 

—

Addition of the 5620 SAM 
Planning Guide

Allows planners and administrators to plan deployments of the 
5620 SAM database, server, and clients, including:

• supported operating system configurations
• hardware platform requirements
• redundancy architecture
• network bandwidth requirements
• scaling guidelines
• PC and workstation configurations, including disk layout 

recommendations

See the Support 
Documentation Service 
SDS site on 
www.alcatel.com
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2.3 5620 SAM Release 2.0 functionality

Table 2-5 lists the features or functionality added in 5620 SAM Release 2.0.

Addition of the 5620 SAM 
Routine Maintenance 
Procedures Guide

Allows planners and NOC staff responsible for developing 
maintenance procedures to plan maintenance activities, 
including:

• guidelines for developing base measures
• daily, weekly, monthly, and as required procedure 

baselines

See the Support 
Documentation Service 
SDS site on 
www.alcatel.com

See the User 
Documentation directory 
on the product 
DVD-ROMModification of the 5620 SAM 

Troubleshooting Guide to 
include network 
troubleshooting

Allows planners and NOC staff responsible for troubleshooting 
activities to understand the use of 5620 SAM in planning and 
managing network and service troubleshooting, including:

• theory of network troubleshooting
• troubleshooting using alarms from the 5620 SAM client 

GUI
• troubleshooting services using OAM tools from the 

5620 SAM client GUI

Release 2.1 R2

Addition of multicast sample 
configuration to the 
5620 SAM User Guide

Allows planners to see a sample configuration of multicast for 
broadcast TV, including:

• required PIM and IGMP configurations
• service setup and configuration

See chapter 24 for more 
information.

Addition to 5620 SAM user 
and user group security 
management

Allows 5620 SAM system administrators to understand in 
more detail the user privileges granted by each user group 
type, and an example configuration of users.

See chapter 11 for more 
information.

Document Description Reference for more 
information
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Table 2-5 5620 SAM Release 2.0 functionality

Feature or function Description Reference for more 
information

VPRN service The 5620 SAM supports the creation of VPRN services using 
the 7750 SR as a PE and provider core (P) router. VPRNs, 
which are also called IP VPNs or BGP/MPLS VPNs, are 
defined in RFC 2547bis, which details a method of forwarding 
data and distributing routing information across an IP/MPLS 
provider core network.

A VPRN service consists of CE devices connected to PE 
routers. PE routers connected to P routers transport data 
across the IP/MPLS provider core network in service tunnels. 
The 5620 SAM supports the creation of GRE or MPLS LSP 
service tunnels. 

See chapter 33 for 
overview and 
configuration 
information.

Router security 
management, including user 
domain control and using 
TACACS+ or RADIUS 
authentication

Security support for accessing the managed routers, such as 
the 7750 SR, in the following ways:

• Create and manage users, management access filters, 
profiles, and passwords for access to the managed 
routers.

• Configure RADIUS or TACACS+ authentication to allow 
controlled access to the managed routers using 5620 SAM 
user accounts.

RADIUS and TACACS+ are access server AAA protocols. 
Each protocol provides a standardized method of exchanging 
information between a RADIUS or TACACS+ client, located on 
the managed router, and a RADIUS or TACACS+ server, 
located externally from the managed router and the 
5620 SAM.

See chapter 12 for 
overview and 
configuration 
information.

LSP, VPRN, and MAC OAM 
diagnostics

The LSP ping and traceroute diagnostics provide a mechanism 
to detect data plane failures in MPLS LSPs. The diagnostics 
are modeled after the ICMP echo request/reply used to detect 
and isolate faults in IP networks.

The following MAC OAM diagnostics are supported.

• MAC ping determines whether an egress service access 
point that binds a given MAC address within a VPLS 
service exists.

• MAC trace OAM displays the hop-by-hop route of MAC 
addresses used to reach the target MAC address at the far 
end.

• MAC populate OAM populates a service FIB with an 
OAM-tagged MAC entry.

See chapter 39 for 
overview and 
configuration 
information.

Support for new hardware 7450 ESS chassis configurations that are managed include 
the following shelf types:

• 1-slot with 1 I/O slot that supports 2 daughter cards
• 7-slots with 6 slots that support 12 daughter cards.

Additional card and port support, including:

• 12-port DS3 to the T1/E1 and DS0 level and E3 to the E3 
level on the 7750 SR

• 1-port OC12/STM4 to the DS0 level on the 7750 SR
• Gigabit Ethernet with 10- and 20-ports on the 7450 ESS
• 10XGigabit Ethernet with 1 port LAN/WAN physical card 

on the 7450 ESS

See the appropriate 
hardware documentation 
for card and port 
information, such as line 
length and hardware 
specifications.

See chapter 20 for 
information about 
hardware modelling 
support by the 
5620 SAM.

See Table 20-4 for a list 
of supported cards and 
ports on the managed 
hardware.
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XML northbound OSS 
interfaces

An OSS application uses the Alcatel 5620 SAM Open 
Interfaces XML interface to configure or access network 
management information contained in the 5620 SAM 
database. The XML interface can then receive information 
from or manipulate the managed object model. All transactions 
with the 5620 SAM database are processed by the 5620 SAM 
server.

The 5620 SAM-O XML interface allows OSSs to:

• access all 5620 SAM FCAPS functionality for read, or read 
and write methods

• ensure backward compatibility
• access functionality using HTTP or HTTPS and simple 

SOAP encoding
• securely transport requests and receive responses

See the 
Alcatel 5620 SAM-O 
OSS Interface Developer 
Guide.

ISIS protocol support ISIS is a link-state interior gateway protocol that uses the 
shortest path first algorithm to make routing decisions. ISIS 
entities consist of:

• networks, which are autonomous system routing domains
• intermediate systems, which are routers such as the 

7750 SRs
• end systems, which are network devices that send and 

receive PDUs

The ISIS information displayed and configured from the GUI 
includes:

• a backbone area and the devices in the backbone area
• a list of areas with the devices that are participating in the 

area
• the open the area devices to display the interface IP 

addresses with the configured level (1, 2, or 1 and 2) of 
each interface

See the ISIS overview, 
configuration, and 
procedural information in 
chapter 24.

Protocol support 
enhancements for BGP and 
LDP

From the GUI, you can enable and configure LDP parameters. 
From the network tab routing instance, there are two trees for 
LDP: Interfaces and Targeted LDP Peers.

LDP is used to distribute labels. devices can establish LSPs 
across a network by mapping network-layer routing 
information directly to the data link layer-switched paths. After 
LDP distributes the labels to the LSRs, the LSR assigns the 
label to a FEC, and then informs all other LSRs in the path 
know about the label and how the label will switch data 
accordingly.

T-LDP is supported on 7750 SRs and 7450 ESSs, DU-LDP is 
only supported on the 7750 SR.

You can use the 5620 SAM to enable BGP on the device and 
to:

• set the AS values for the routing instance
• create confederations to group-managed routers 
• create BGP peer groups
• create neighbors within the BGP peer groups

See the BGP and LDP 
overview, workflow, and 
procedures in 
chapter 24.

Feature or function Description Reference for more 
information
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Daughter card and 
channelization support on the 
7750 SR

The 5620 SAM supports:

• Configuring unchannelized 1-port OC192, and 2- and 
4-port OC48 daughter cards and card objects.

• Configuring channelized 1-port OC12 and the 12-port DS3 
daughter cards. You cannot create DS3 children objects 
using the 5620 SAM. Ports and channels can only be used 
in access mode.

• Configuring BCP-Null, BCP Dot1q, Frame Relay, and 
IPCP encapsulation on access ports and channels on the 
daughter cards listed above.

• Configuring PPP encapsulation on network ports and 
channels on the daughter cards listed above.

• Configuring channelized 1x OC12 daughter cards and 
card objects to the DS0 level using the STS1 sub-channels 
that are available.

• Configuring channelized 12xDS3/E3 daughter cards and 
card objects to the DS0 level using TDM channels.

See the equipment 
manager overview and 
procedural information in 
chapter 20.

MPLS administrative group 
policy support

The 5620 SAM supports configuring MPLS administrative 
group policies, and assigning the groups to MPLS interfaces, 
LSPs, and LSP paths.

See the MPLS 
administrative group, 
MPLS interface, LSP, 
and LSP path procedural 
information in chapter 23.

Slope and network policy 
support

The 5620 SAM supports configuring slope and network 
policies which can be applied to router objects during service 
configuration or modification.

See the policy overview 
and procedural 
information in chapter 28.

Q in Q support The 5620 SAM supports enabling Q in Q encapsulation on 
applicable ports, and configuring Q in Q encapsulation values 
on interfaces.

See the port and channel 
procedural information in 
chapter 21 to enable Q in 
Q.

See the service creation 
procedural information in 
the appropriate service 
management chapter to 
configure encapsulation 
value on interfaces.

CSPF, Make before Break, 
and inheritance support on 
LSPs and LSP paths

The 5620 SAM supports configuring CSPF and Make before 
Break parameters on LSPs and LSP paths, and the inheritance 
of key LSP parameters, including CSPF and Make Before 
Break, by LSP paths.

See the LSP and LSP 
path procedural 
information in chapter 23.

MPLS topology maps, 
including LSP map

From the GUI, you can view additional maps that show the 
MPLS and LSP topology.

See the map 
management information 
in chapter 37.

Product renaming The 5620 SRM has been renamed to the 5620 Service Aware 
Manager. The majority of instances of 5620 SRM on the GUI 
have been renamed.

—

Feature or function Description Reference for more 
information
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2.4 Basic FAQs for using the 5620 SAM

Use the following FAQs to help improve your use of the 5620 SAM. See the 5620 
SAM Troubleshooting Guide for more information.

How do I limit the number of reads and writes to the router?
By default, the 5620 SAM activates a save command to the router every time a 
configuration change is made using the 5620 SAM. You can write changes to the 
router less often by using the Administration→Deployment and Site 
Backup/Upgrade configuration form from the 5620 SAM main menu. Click on the 
Deployments Policy tab. Set the Auto Save Scheme parameter to Every Nth 
Deployment. Set the Auto Save Threshold to N, where N is the number of SNMP 
deployments.

The higher the number, the less often changes are deployed to the router.

How should I name objects on the GUI?
Develop a standardized naming conventions to be used by all operators when they 
configure the network. This will:

• ease identification of the type of object
• ensure that data passed to a northbound OSS interface or southbound in a data file 

for processing are named consistently across platforms and software products

HVPLS A hierarchical VPLS is created by enhancing the VPLS core 
mesh with access spoke circuits that are interconnected to 
another VPLS, a VLL, or a site.

An HVPLS can:

• reduce the complexity of mesh configuration
• decrease the amount of signaling of routes between 

devices

When traffic arrives at an access spoke circuit, it acts similarly 
to a bridge port. Flooded traffic received on the access spoke 
is replicated to all other spokes, meshes, or service access 
points but is not transmitted on the port where it is received.

See the VPLS overview 
and procedures 
documentation for 
information about 
creating HVPLS spokes 
in chapter 31.

Grouping You can use the grouping function to:

• represent devices that are located in the same area, for 
example, in the same city

• indicate network topology, for example, devices that 
operate in the same spanning tree or SONET/SDH ring

See the navigation tree 
configuration 
Procedure 21-1 for more 
information about 
creating groups.

Feature or function Description Reference for more 
information

(4 of 4)

Caution —  The longer the delay in changes deployed to the device, 
the greater the risk of a router reboot that will cause you to lose 
changes.
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Name each object on the appropriate configuration form to identify:

• the type of object, for example, a VPLS service
• any customer associations with the object, for example, a VLL service for XYZ 

Industries
• the source and destination of endpoints, for example, the devices that start and 

terminate an LSP
• the ports and IP addresses used

For example, to create an Ethernet connection between devices with the names ‘top’ 
and ‘bottom’, using port 24 on each router, use the following name, Top/1/1/1/1 
(10.10.10.1/24) to Bottom/1/1/1 (10.10.10.2/24)

You can easily identify that link started on device Top, terminating on device 
Bottom, and used the specified addressing and ports.
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3.1 5620 SAM GUI overview

You can use the 5620 SAM client GUI on a 5620 SAM client PC or workstation. 
Many clients can connect to the same 5620 SAM server. The GUI provides FCAPS 
functionality for operators to perform tasks in the network operations centre.

• display equipment and alarm status
• configure and manage network management applications
• simplify the administration and execution of equipment, service, and subscriber 

configuration using configuration forms instead of CLI
• configure, manage, and monitor SLAs and equipment using performance 

counters
• create and manage security policies for secure access to the routers and for 

operations that use the 5620 SAM

The main GUI elements include three forms: the navigation tree, the dynamic alarm 
list, and the working pane. Figure 3-1 shows the main GUI elements.

Figure 3-1  GUI elements

The dynamic alarm
list tracks problems

The navigation tree
displays all managed
equipment, services,

and protocols
including OSPF

17184

The toolbar is
a shortcut for

menu functions

Use the menu bar to
execute tasks

Forms are used to
create and view

policies, services, and
other functions

The working pane
displays drawings and

configuration forms

The taskbar displays icons
representing open forms

The status bar indicates
information about the current client

Use the navigation tree toolbar
to change the view and root of

the tree, and to copy object
properties to the clipboard
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Floating windows

The 5620 SAM GUI uses floating windows that you can move, size, close, and bring 
to the foreground to provide optimum working space for the task that you are 
performing. By default, the navigation tree window appears at the left side of the 
GUI, the dynamic alarm list at the bottom, and the working pane or application forms 
appear at the right side. If a window is closed or hidden, you can bring it to the 
foreground by selecting a toolbar icon, a Window menu item, or by using shortcut 
keys. The icons are identified by tooltips. Navigation tree and dynamic alarm list 
window position and state (hidden or visible) preferences are stored locally on your 
workstation so that each time you start the GUI, the saved preferences are used.

Form titles in the working pane
Forms for viewing and configuring sites, policies/filters, subscribers, and services 
usually have a titlebar that displays the object type, object name, and ID, when 
appropriate. The type of information displayed in the titlebar is determined by the 
object. The displayed object name is the name specified when the object is created. 
If the object was not named, a default name is used. When a form is minimized, a 
tooltip identifies the form using the complete titlebar name. Additionally, titles of all 
opened forms are listed in the Window menu. 

Using the navigation tree toolbar

The navigation tree toolbar consists of the view selector, the Make Root At Top 
Level button, and the Copy to Clipboard button. Figure 3-1 shows the navigation tree 
toolbar. See Procedure 3-18 for information about using the Copy to Clipboard 
button.

Make Root At Top Level button

The Make Root At Top Level button restores the navigation tree to the default root. 
For example, in the equipment view, if you redefine the root of the tree as a card and 
click on the Make Root At Top Level button, the navigation tree refreshes with the 
default root, which is the network. The Make Root At Top Level button is enabled 
only when the root is not the network. The Make Root At Top Level button is 
available only for the equipment view.

Make Root and Make Root In New Tree menu options

The navigation tree contextual menus provide Make Root and Make Root In New 
Tree menu options that allow you to redefine the root of the tree. These menu 
options, along with the Make Root At Top Level button, help orientate users in 
densely populated navigation trees. The menu options are available only for the 
equipment view. See chapter 21 for more information about using these functions.
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Copy to Clipboard button

The clipboard function allows you to copy the properties of one or more objects 
managed by the 5620 SAM. The object properties, usually the object name and ID, 
are converted into text strings that you can copy and paste into an external 
application, such as a spreadsheet. Each property in the text string is delimited by a 
colon (:). The clipboard function uses the clipboard tool and the Copy to Clipboard 
button. See Procedure 3-18.

The Copy to Clipboard button is available from the navigation tree toolbar, list 
forms, and list tabs. The button is enabled on the navigation tree toolbar when one or 
more objects are selected. The button is enabled on list forms and list tabs when one 
or more objects are selected in a list. The clipboard tool is available from the 
5620 SAM Application menu and opens the Clipboard window. The Clipboard 
window displays the copied object properties. The Clipboard window contains a 
View Object button that allows you to view the properties form of the copied object. 
Figure 3-2 shows the Clipboard window.

Figure 3-2  Clipboard window

3.2 5620 SAM GUI workflow

1 Start the 5620 SAM GUI.

2 Set GUI preferences.

3 Navigate through the GUI elements.

a Navigate using shortcuts from the 5620 SAM main menu.

b Navigate through the GUI elements related to your job function, for example, 
the system administration forms.

You can determine which windows and forms are applicable to your job 
function by checking the appropriate workflow.

Note —  The Clipboard window keeps only the object properties 
from one copy action at a time. After you copy object properties to the 
clipboard, if you click on the Copy to Clipboard button again, for 
example, to copy the properties of another object, the properties 
copied from the second copy action overwrite the properties from the 
first copy action in the Clipboard window.

Object properties copied
to the clipboard

are converted to a 
text string format

The View Object button
opens the properties form

for the selected object
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4 Perform your job function.

3.3 5620 SAM GUI menus

Table 3-1 lists the top-level GUI menus and the groups of tasks they contain.

Table 3-1 5620 SAM GUI top-level menu options

3.4 5620 SAM GUI procedures

Table 3-2 lists the GUI-related procedures.

Note —  See chapter 4 for more information about mapping Release 
2.1 and earlier menu options to Release 3.0 menus.

Menu option Function

Application→Submenus Functions related to 5620 SAM client GUI main 
applications, such as the equipment manager, 
user preferences for the application, such as 
workspace settings, and other windows used to 
manage the network, such as topology maps.

Create→Submenus Create 5620 SAM services, using configuration 
forms or templates.

Manage→Submenus Manage 5620 SAM services, service templates, 
L3 objects such as LSPs, equipment, 
subscribers, routing instances, and FIBs.

Policies→Submenus Configure and manage policies related to quality 
of service, routing protocols, schedules, ACLs, 
services, files, accounting, and statistics.

Tools→Submenus Key system tools, such as viewing historical 
alarms and logged records, and launching CLI 
sessions to managed devices.

Administration→Submenus Perform system administration tasks, including:

• configure the discovery of objects
• manage the 5620 SAM database
• set polling, deployment, and alarm policies
• configure and manage 5620 SAM and 

managed device user accounts and security 
access

Window→Submenus Numerous functions, including how windows and 
forms are displayed and user display 
preferences.

Help→Submenus Show information about the release version of 
the software and license key information.
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Table 3-2 GUI procedures list

3.5 5620 SAM GUI basic operation procedures

Use the following procedures to perform GUI basic operations.

Procedure Purpose

To start the 5620 SAM GUI from a PC Start the 5620 SAM client GUI from a PC.

To start the 5620 SAM GUI from a Solaris 
workstation

Start the 5620 SAM GUI from a Solaris 
workstation.

To disable or enable the GUI inactivity check Set GUI user preference to prevent the GUI from 
closing based on an inactivity counter.

To navigate the GUI Navigate and familiarize users with the GUI 
layout and major functions.

To use menus, the toolbar, or shortcuts Quick ways to perform tasks.

To modify or hide the toolbar Modify or hide the toolbar according to user 
preference.

To turn off and on containing window warnings Hide the containing display or window warning 
messages.

To open or hide the navigation tree and dynamic 
alarm list

Open or hide the navigation tree or dynamic 
alarm list according to user preference.

To use windows, menus, and forms to set or view 
parameters

Quick ways to perform tasks.

To view and manipulate listed information Use lists to change the display of information.

To save list preferences Save preferences for the display of listed 
information.

To save GUI workspace preferences Save preferences for the display of the GUI 
workspace.

To manipulate list forms with filters Use filtered lists to provide inventories of network 
objects.

To view software release and license key 
information

View the build version of the 5620 SAM software 
and license information.

To verify that all software modules are installed Validating whether the user cannot perform a 
function from the client GUI because a required 
software module is not enabled.

To export license information to file Export the license information to a text file that 
can be sent to Alcatel to provide information 
about your system.

To use Remove buttons Verify the correct Remove button is used.

To use the clipboard Copy object properties for use in external 
applications.

To exit the 5620 SAM GUI Exit the 5620 SAM GUI.
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Procedure 3-1  To start the 5620 SAM GUI from a PC

1 Double-click on the 5620 SAM Client App shortcut icon that was created on your 
desktop when the client software was installed. The 5620 SAM login form appears.

Alternately, you can open a command window, navigate to the 5620 SAM client 
installation directory, and type nmsclient.bat.

2 Review the login statement, if required, and enter your login name and password in 
the appropriate fields. Select a server from the Server drop-down menu, if required.

a If this is the first time that you are logging in, go to step 3.

b If this is not the first time that you are logging in, a message dialog box appears 
with your login name and the date and time of your previous login.

i Click on the OK button to acknowledge the message.

ii Go to step 3.

3 Click on the Login button. The 5620 SAM GUI opens. 

Procedure 3-2  To start the 5620 SAM GUI from a Solaris workstation

1 From a bash shell, navigate to the appropriate bin directory in the 5620 SAM client 
installation directory, for example the /nms/bin directory.

2 Start the 5620 SAM client by typing: 

bash nmsclient.bash ↵

The 5620 SAM login form appears.

3 Review the login statement, if required, and enter your login name and password in 
the appropriate fields. Select a server from the Server drop-down menu, if required.

a If this is the first time that you are logging in, go to step 4.

Note 1 — If this is the first time that you are logging in, use the admin 
login. Contact your Alcatel technical support representative for default 
account information.

Note 2 — The login name and password used depends on whether 
client GUI users are authenticated locally or remotely, as determined by 
the system administrator. Use the login name and password provided by 
your system administrator. See chapter 11 for more information.

Note 1 — If this is the first time that you are logging in, use the admin 
login. Contact your Alcatel technical support representative for default 
account information.

Note 2 — The login name and password used depends whether client 
GUI users are authenticated locally or remotely, as determined by the 
system administrator. Use the login name and password provided by your 
system administrator. See chapter 11 for more information.
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b If this is not the first time that you are logging in, a message dialog box appears 
with your login name and the date and time of your previous login.

i Click on the OK button to acknowledge the message.

ii Go to step 4.

4 Click on the Login button. The 5620 SAM GUI opens. 

Procedure 3-3  To disable or enable the GUI inactivity check

Users with admin privileges can disable or enable GUI activity check functionality for all 
client GUI users.

1 Choose Administration→Security→5620 SAM User Security from the 5620 SAM 
main menu. The 5620 SAM User Security - Security Management (Edit) form 
opens.

2 Configure the Client Timeout (minutes) parameter.

Setting the parameter to 0 disables the GUI inactivity check for all users. Setting the 
parameter to a non-zero value enables the GUI inactivity check. When a client GUI 
is inactive for the indicated number of minutes, it closes. This affects only the 
inactive client GUI, not all other client GUIs. By default, the GUI inactivity check is 
disabled.

Procedure 3-4  To navigate the GUI

1 Start the 5620 SAM GUI.

2 Navigate through the main GUI elements, as shown in Figure 3-1.

• The menu bar organizes tasks under high-level headings and lower-level 
submenu options.

• The working pane displays drawings and forms.
• The navigation tree contains the managed equipment, services, and networking 

protocols.
• The task bar displays open windows and forms.
• The status bar displays user account, date, redundancy, alarm-related object 

propagation, and connection status information.
• The dynamic alarm list displays incoming events and alarms.

Procedure 3-5  To use menus, the toolbar, or shortcuts

1 Start the 5620 SAM GUI.
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2 Choose a menu:

a From the drop-down submenu options under each top-level menu, as shown 
in Table 3-1. An applicable shortcut icon for the menu item is shown next to the 
option text.

b From the menu equivalent in the toolbar. Scroll over the icons to view their 
function. You can modify or hide the toolbar. See Procedure 3-6 for more 
information.

c By typing the appropriate ALT+Key shortcut. For example, ALT+P opens the 
policies menu. The underlined letter in the main menu indicates the shortcut 
action.

Procedure 3-6  To modify or hide the toolbar

By default, a subset of icons that represent the main menu functions are available from 
the toolbar. You can add icons to the toolbar, or hide the toolbar.

1 Start the 5620 SAM GUI. The default subset list of toolbar icons appear under the 
5620 SAM main menu.

2 Right-click on an empty section of the toolbar. The toolbar contextual menu opens.

3 Modify or hide the toolbar:

a From the toolbar icon drop-down list, click on one or more icons to add or 
remove icons from the toolbar. The icon is added or removed from the toolbar.

b Choose Hide Toolbar from the toolbar drop-down menu. The toolbar is hidden.

To show the toolbar again, choose Application→User Preferences→Show 
Toolbar from the 5620 SAM main menu.

4 Click on an empty section of the GUI to close the toolbar contextual menu.

Note —  Using the CTRL+F4 key to close a form or window may cause 
problems if the parent form is still open. Alcatel recommends closing a 
form or window by using the Close button and responding appropriately 
to the prompts, or to click on the X button in the top right-corner of the 
form or window.
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Procedure 3-7  To turn off and on containing window warnings

When a child object configuration form is launched from a parent object, and the child 
object configuration is changed, a warning message appears. The warning message 
indicates that changes to the child form are not committed until they are applied in the 
parent object. You must acknowledge the message. You can use workspace preferences 
to turn off the warning message. You continue to receive a warning message that 
changes must be applied for parent objects before you can close the parent object 
configuration form.

1 Choose Application→User Preferences→Suppress containing window warning 
from the 5620 SAM main menu. Containing window warnings are suppressed.

2 Choose Application→Save Workspace from the 5620 SAM main menu. The 
workspace preferences are saved, and next time you log in, containing window 
warnings are suppressed.

3 To turn on the warning messages, choose Application→User Preferences→Show 
containing window warning from the 5620 SAM main menu. Window warnings are 
no longer suppressed. Save workspace preferences to keep this setting next time 
you log in.

Procedure 3-8  To open or hide the navigation tree and dynamic 
alarm list

1 Start the 5620 SAM GUI.

The navigation tree and dynamic alarm list position and state (hidden or visible) 
preferences are stored locally on your PC or workstation so that each time the GUI 
is opened using the same user account, the saved preferences are used.

2 Open a hidden window or bring these windows to the foreground using one of the 
following methods:

a Choose the navigation tree icon or the dynamic alarm list icon from the toolbar.

b Choose navigation tree or alarms from the Window menu.

c Use the navigation tree or dynamic alarms list shortcut key.

d Choose the icon that represents the form from the task bar. The task bar is 
located just above the status bar.

Procedure 3-9  To use windows, menus, and forms to set or view 
parameters

1 Start the 5620 SAM GUI.

2 Open a configuration form in the working pane to view or set parameters using one 
of the following methods:
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a Double-click on the lowest level leaf object in the navigation tree to open the 
properties form for the object. For tree objects, the next lowest-level object is 
opened. For example, double-clicking a channelized port icon displays the 
channel icons. Double-clicking a channel icon opens its properties form.

b Choose the appropriate menu option or submenu option from the 5620 SAM 
main menu, as listed in Table 3-1.

c Double-click on an appropriate object, for example, a subscriber from a list of 
subscribers.

d Click on the icon that represents the form from the taskbar.

e Right-click on an object in the navigation tree or dynamic alarm list and choose 
the appropriate option from the contextual menu. 

Figure 3-3 shows an example of a right-click contextual menu in the navigation 
tree.

Figure 3-3  Right-click contextual menu example

The appropriate form appears.

3 View the configuration form or window in the working pane.

Some configuration forms take you through a series of configuration screens. As 
shown in Figure 3-4, you complete each of the tasks in sequence and click on the 
Next button to continue the configuration until the task is complete. This figure 
shows that the first step is complete, and the second step is highlighted to show it 
is being performed. When the task is done, you click on the Finish button. Each of 
the steps must be completed, or the defaults accepted, before the full task is 
complete.
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Figure 3-4  Example of a configuration form with multiple steps

4 Set or view the parameters for the configuration form using the following methods:

a Type information next to the parameter, as appropriate. For example, enter 
text to provide a description for the Description parameter.

b Use the drop-down menu to choose an option from a list. For example, choose 
access as the port mode from a port configuration form.

c Follow the form prompts as directed, as described in step 3.

d Double-click an object in a row to open a new view or set of configurations. For 
example, from a list of ports double-click on a row to open the configuration 
form for that port.

e Right-click on an object in the navigation tree to display additional contextual 
menu choices, as shown in Figure 3-3.

f Set the appropriate parameters.

See the 5620 SAM Parameter Guide for a complete list of all configurable 
parameters.

5 Click on the appropriate button to complete the configuration:

Note —  Some steps may open a new configuration form. Complete the 
steps in the new configuration form. When you click the Finish or OK 
buttons, as appropriate, the previous configuration form reappears.

Note —  Parameters highlighted in yellow are mandatory and must be 
configured for the task or function to work.
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a The OK or Apply button to save the changes, as appropriate based on the 
configuration form. Applying a change saves the configuration to the database 
or managed devices, as appropriate.

b The Reset button to return to the last saved configuration.

c The Turn Up button to turn up the object being configured.

d The Shut Down button to shut down the object.

e The Cancel button to close the form or window without saving the changes.

f The Close button to close the form.

g The Resync button to ensure that the 5620 SAM and the managed devices are 
synchronized. Resynchronization does not impact the contents of the historical 
statistics database.

Procedure 3-10  To view and manipulate listed information

Many of the windows and forms are lists of network objects, for example, lists of ports 
from the equipment manager, displaying all the ports on a particular card. Figure 3-5 
shows the major elements of a list.

Note —  Using the CTRL+F4 key to close a form or window may cause 
problems if the parent form is still open. Alcatel recommends closing a 
form or window by using the Close button and responding appropriately 
to the prompts, or to click on the X button in the top right-corner of the 
form or window.
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Figure 3-5  List elements

You can manipulate most lists to:

• generate inventories of the listed data
• reorganize the information from most important to least important
• remove columns of data not of interest
• sort listed data in ascending or descending order

1 Generate a list.

2 Perform an action on the list.

a To generate an inventory of data, right-click on the list heading. The Count 
indicates the number of objects in the list.

b To reorganize the information, left-click on a column and drag the column to 
the right or left and drop the column in the desired location.

c To remove columns, right-click on the column heading and deselect the 
column from the check mark list. The column disappears from the display.

d To sort in ascending or descending order, left-click on the column heading. The 
arrow direction changes, indicating if the data is sorted in descending (up 
arrow) or ascending (down arrow) order.
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Procedure 3-11  To save list preferences

You can save the format of a list. When you generate the list, it automatically appears in 
the format saved.

1 Perform Procedure 3-10.

2 Right-click on the list column heading and choose Save Table Preferences.

A dialog box appears to confirm that you want to save the current table format.

3 Click on the Yes button.

The table format is saved.

Procedure 3-12  To save GUI workspace preferences

You can save the GUI workspace preferences on a client GUI PC or workstation. When 
the user that saved the workspace preference logs in to the GUI using the same user 
account on the same PC or workstation, the GUI launches using the saved preferences.

1 Start the client GUI.

2 Configure the GUI workspace according to your preference.

3 Choose Application→Save Workspace from the 5620 SAM main menu. The 
following GUI workspace preferences are saved:

• location of the navigation tree and dynamic alarm list
• enable or disable audible alarm notifications
• selected toolbar settings

Procedure 3-13  To manipulate list forms with filters

Many list forms allow you to set and use filters, which limit the number of objects that 
appear in a list. This allows you to more easily find what you need. See section 6.5 for 
information about performing searches using list forms.

Filtered list forms contain the list form and the filter form in the same window. The window 
panes are separated by a horizontal split bar that you can use to control the panes. In the 
filter pane, you can use a vertical split bar to control the amount of space used for the 
managed-object tree and the filter properties forms. Figure 3-6 shows the major elements 
of a filtered list form.
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Figure 3-6  Filtered list form

You can manipulate list forms with filters the following ways:

• size and hide the filter pane and the list pane
• size and hide panels within the filter pane

1 To change the size of the list pane and the filter pane, drag the horizontal split bar 
up or down to control the amount of space used for the filter forms and for viewing 
the list of search results.

2 To hide the filter pane or the list pane in order to increase the space used by one of 
the panes:

a Click on the horizontal split bar up arrow icon to hide the filter pane. The filter 
pane is hidden.

Click on the down arrow icon to open the closed filter pane.

b Click on the horizontal split bar down arrow icon to hide the list pane. The list 
pane is hidden.

Click on the up arrow icon to open the closed list pane.

3 To change the size of panels in the filter pane, drag the vertical split bar to the left 
or right to control the amount of space used by the managed object tree and by the 
filter properties form. 

4 To hide the managed-object tree or the filter properties panel in order to increase 
the space used by one of the panels:

a Click on the vertical split bar left-facing arrow icon to hide the managed-object 
tree. The tree panel is hidden.
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Click on the vertical split bar right-facing arrow icon to open the closed tree 
panel.

b Click on the vertical split bar right-facing arrow icon to hide the filter properties 
panel. The properties panel is hidden.

Click on the vertical split bar left-facing arrow icon to open the closed 
properties panel.

Procedure 3-14  To view software release and license key 
information

The 5620 SAM client application requires a license key that is valid for the installed 
software release. The license key contains information about supported features, 
installed software modules, and the number of daughter cards (MDAs) purchased, used, 
and remaining. Alarms are raised when the number of purchased daughter cards 
threshold is exceeded. 

1 To view:

a Software release information, choose Help→About 5620 SAM from the 
5620 SAM main menu. The About the 5620 SAM Client Application form 
appears.

i Review the software release information. The build information specifies 
the release of the 5620 SAM software installed, for example, Release 3.0 
R1, where 3.0 is the release number, and R1 is the first hardened load.

ii Click on the Close button to close the form.

b License key information, choose Help→5620 SAM License Information from 
the 5620 SAM main menu. The License form appears.

i Review the software license information, which includes the following:

• supported 5620 SAM modules (5620 SAM-E, 5620 SAM-A, 5620 SAM-P, 
and 5620 SAM-O)

• licensed quantity of 7450 ESS and 7750 SR daughter cards, quantity 
consumed, and quantity remaining

• status of the primary and standby servers
• supported client GUI operator positions

ii Click on the Cancel button to close the form.

2 Modify the license key, as required. You can update your license key dynamically to 
support more licensed daughter cards. You do not have to restart the 5620 SAM 
client or server to update the daughter card value. See Procedure 8-1 for more 
information.
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Procedure 3-15  To verify that all software modules are installed

The 5620 SAM functions are provided by four modules, which can be enabled by the 
license key:

• 5620 SAM-E for device mediation, equipment management, security, CLI 
access to managed devices, backup and restore, equipment navigation, alarm 
policy management, real-time equipment statistics, and inventory and reporting

• 5620 SAM-P for service provisioning, templates, and network tunnel, path, 
subscriber, and policy management

• 5620 SAM-A for service assurance functionality, fault correlation using alarms, 
OAM tools, topology views, statistics policies and historical statistical data, and 
accounting policies and accounting data

• 5620 SAM-O for the XML open interface

If a required module is not installed, you cannot perform some actions from the client GUI.

1 Start the 5620 SAM GUI by performing Procedure 3-1 or Procedure 3-2.

2 View the drop-down menu options. If you cannot see a drop-down menu option or 
the menu option is dimmed, the function is not enabled in the license key.

3 View the software release and license key information by performing 
Procedure 3-14.

Check whether all software modules are installed.

If you cannot perform a function using the client GUI and you have privileges on the 
managed devices, you can use CLI to configure the function.

Procedure 3-16  To export license information to file

You can export the license information as text to a file storage location. This text file can 
be sent to Alcatel to provide information about your system.

1 Perform Step 1 b of Procedure 3-14.

2 Click on the Export License information to file button. A dialog box appears that 
prompts you to choose a file storage location on your network.

3 Scroll to the location where you want to save the text file and enter a file name in the 
appropriate field.

4 Click on the Save button. The license key text file is saved to the specified location.

Note —  By default, the 5620 SAM-E is always enabled. You cannot 
install and run other modules without 5620 SAM-E installed.
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Procedure 3-17  To use Remove buttons

Some configuration forms contain two Remove buttons. For example, the Subscriber 
form contains a Remove button that appears at the bottom of the configuration form and 
another that appears below the Edit and Add buttons when you select certain tab buttons.

Ensure that you use the correct Remove button to perform the correct actions. Figure 3-7 
shows a form with two remove buttons, and the action performed by each.

Figure 3-7  Remove buttons action

Procedure 3-18  To use the clipboard

1 Select one or more objects to copy from one of the following locations:

a Equipment view of the navigation tree.

b List displayed or generated in a list form or list tab.

2 Click on the Copy to Clipboard button. The object properties are copied to the 
clipboard.

3 Choose Application→Clipboard from the 5620 SAM main menu. The Clipboard 
window opens displaying the copied object properties in a text string format.

4 Perform one of the following actions:

a Copy and paste the properties text string to an external application.

i Select the properties text string that you want to copy and press CTRL+C.

Only one text string can be selected and copied at a time.

13463

Selected object

This button
removes the site
from the service

This button
removes the
entire service

These buttons
perform actions on
the service object
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ii Paste the properties text string into an external application.

b View the property form for a copied object.

i Select the properties text string for the object that you want to view.

ii Click on the View Object button. The properties form for the object opens.

5 Repeat steps 1 to 4 to copy additional objects or close the Clipboard window.

Procedure 3-19  To exit the 5620 SAM GUI

Choose Application→Exit from the 5620 SAM main menu.

The GUI and application closes.
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4.1 5620 SAM menu changes for Release 3.0 overview

The 5620 SAM main menu and submenu structure changed between Release 2.1 and 
Release 3.0 to:

• create a more logical structure organized by FCAPS functions, including 
configuration, management, and administration operations

• group common operations

Use this menu mapping document to update any operational procedures that are 
being used in the NOC or lab environments.

4.2 5620 SAM menu mapping

Table 4-1 lists the Release 2.1 menu options, the equivalent Release 3.0 menu 
options, and any notes about the changed menu functionality.

Table 4-1 5620 SAM Release 2.1 to Release 3.0 menu mapping

Note —  Table 4-1 does not contain new menus or functions for the 
Release 3.0 features.

Release 2.1 menu Release 3.0 and later menu Notes

Application→Exit Application→Exit —

Find→Browse Equipment Manage→Equipment —

Find→Browse Routing Instances Manage→Routing Instances —

Find→Browse MPLS Manage→MPLS Objects —

Find→Browse Services Manage→Services —

Find→Browse Log Records Tools→Log Records Collected data used for performance 
monitoring, such as alarm records 
and real-time performance statistics, 
are grouped as tasks.

Find→Browse Alarm History Tools→Historical Alarms

Service Management→ Manage 
Subscribers/Services

Manage→Services

Manage→Subscribers

List and manage services and 
subscribers separately as 
management tasks.

Service Management→ Create 
Service

Create→Service→Type of Service Type of Service refers to the service 
type. For earlier releases, services 
were configured using a series of 
service configuration forms. For 
Release 3.0 or later, each service is 
configured from its own service form, 
for example, 
Create→Service→VPLS.

Service Management→ Create 
Service From Template

Create→ Service From Template —

Service Management→ Browse 
Services

Manage→Services —

(1 of 4)
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Service Management→ Manage FIB 
Entries

Manage→FIB Entries —

Service Management→ Expand 
Service On Edit

— —

Templates→Templates Manager Manage→Service Templates Template types used to build a 
service template are accessed from 
the same template management 
form.

Each type of template is configured 
from the appropriate tab on the 
template manager form. For 
example, to create IES templates, 
click on the IES Service Templates 
tab button, and click on the Add 
button to create an IES template, or 
click on the Edit button to edit an 
existing IES template.

Templates→New Service Template Manage→Service Templates

Templates→New Site Template Manage→Service Templates

Templates→New L2 Interface 
Template

Manage→Service Templates

Templates→New Circuit Template Manage→Service Templates

Templates→New L3 Interface 
Template

Manage→Service Templates

Topology→Service Path Topology Application→Service Tunnel Topology —

Topology→LSP Topology Application→LSP Topology —

Topology→MPLS Path Manager Manage→MPLS Paths —

Topology→LSP Manager Manage→LSPs

Application→LSP Topology

Separate menu options are used to 
manage LSP configurations and 
view LSPs on a map.

Topology→Service Tunnel Manager Manage→Service Tunnels

Application→Service Tunnel Topology

Separate menu options are used to 
manage service tunnel 
configurations and view service 
tunnels on a map.

Policies→Alarm Policies Administration→Alarm Settings 5620 SAM network-wide 
administration policies, such as 
alarm and 5620 SAM database 
management policies, are moved 
under the administration menu.

Policies→Database Manager Administration→Database

Policies→Policy Audit Tools→Policies Audit

Policies→Access Ingress Policy 
Manager

Policies→QoS→Access Ingress Policies are grouped under two 
major headings; QoS and Filter.

Policies→Access Egress Policy 
Manager

Policies→QoS→Access Egress

Policies→Network Policy Manager Policies→QoS→Network

Policies→Slope Policy Manager Policies→QoS→ WRED Slope

Policies→Network Queue Policy 
Manager

Policies→QoS→ Network Queue

Policies→Shared Queue Policy 
Manager

Policies→QoS→ Shared Queue

Policies→Scheduler Policy Manager Policies→QoS→ Scheduler

Policies→802_1_x Policy Manager Policies→802_1x —

Policies→ACL IP Filter Manager Policies→Filter→ ACL IP Filter Policies are grouped under two 
major headings; QoS and Filter.

Policies→ACL MAC Filter Manager Policies→Filter→ ACL MAC Filter

Policies→ATM QoS Policy Manager Policies→QoS→ ATM QoS

Release 2.1 menu Release 3.0 and later menu Notes

(2 of 4)
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Policies→File Policy Manager Policies→File —

Policies→Accounting Policy Manager Policies→Accounting —

Policies→Routing Policy Manager Policies→Routing —

Policies→Admin Group (MPLS) 
Policy Manager

Policies→MPLS Administration Groups —

Policies→Multicast Package Policy 
Manager

Policies→Multicast Package —

Policies→Telco→Telco Node QoS 
Level Policy Manager

Policies→QoS→ Telco QoS Policies are grouped under two 
major headings; QoS and Filter.

Policies→Telco→Telco ACL 
Standard IP Filter Manager

Policies→Filter→ Telco ACL Standard IP 
Filter

Policies→Telco→Telco ACL 
Extended IP Filter Manager

Policies→Filter→ Telco ACL Extended IP 
Filter

Policies→Telco→Telco ACL IGMP 
Filter Manager

Policies→Filter→ Telco ACL IGMP Filter

Policies→Telco→Telco ACL MAC 
Filter Manager

Policies→Filter→ Telco ACL MAC Filter

Equipment→Equipment Manager Application→Equipment Manager —

Mediation→Discovery Manager Administration→Discovery Management System wide functions are grouped 
under administration.

Mediation→Poller Policies Administration→Poller Policies

Mediation→Deployment and Site 
Backup/Upgrade

Administration→Deployment and Site 
Backup/Upgrade

Security→5620 SAM Security 
Manager

Administration→Security→5620 SAM User 
Security

The managed device and network 
management domain security is 
combined in an administration 
function.

NE refers to the network element, 
also known as device or site.

Security→5620 SAM 
RADIUS/TACACS Policy Manager

Administration→Security→5620 SAM 
RADIUS/TACACS+ User Authentication

Security→Change Password Administration→Security→Change 
Password

Security→Activity Log Manager Administration→Security→5620 SAM 
Usage and Activity Records

Security→Site Management Access 
Filter Manager

Administration→Security→NE 
Management Access Filters

Security→Site User Profile Manager Administration→Security→NE User Profiles

Security→Site User Manager Administration→Security→NE User 
Configuration

Security→Site Password Policy 
Manager

Administration→Security→NE Password 
Policy

Security→Site RADIUS Policy 
Manager

Administration→Security→NE RADIUS 
Authentication

Security→Site TACACS+ Policy 
Manager

Administration→Security→NE TACACS+ 
Authentication

Security→Site System Security Administration→Security→NE System 
Security

Release 2.1 menu Release 3.0 and later menu Notes

(3 of 4)
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Options→Disable Audible Alarm Application→User Preferences→Audible 
Alarms

Per-client GUI user options are 
grouped under user preferences. 
Use the checkmark to enable or 
disable audible alarms.

Options→SR CLI→Telnet Session Tools→CLI Session→Telnet Session —

Options→SR CLI→SSH Session Tools→CLI Session→SSH Session —

Window→Navigation Tree Application→Navigation Tree For Release 3.0, standard windows, 
for example, the navigation tree, are 
accessed from the Application 
menu.

Window→Alarm Window Application→Alarm Window

Window→Save Workspace Application→Save Workspace —

Window→Hide Toolbar Application→User Preferences→Show 
Toolbar

Per-client GUI user options are 
grouped under user preferences. 
Use the checkmark box to show or 
hide the toolbar.

Window→Reset to Preferred Sizes Window→Reset to Preferred Sizes General window management 
functions are unchanged.

Window→Cascade and Reset to 
Preferred Sizes

Window→Cascade & Reset to Preferred 
Sizes

Window→Close All Window→Close All

Window→Minimize All Window→Minimize All

Window→Tile Vertical Window→Tile Vertical

Window→Tile Horizontal Window→Tile Horizontal

Window→Tile Square Window→Tile Square

Window→Cascade Window→Cascade

Window→No Arrange Window→No Arrange

Window→Name of open window Window→Name of open window

Help→5620 SAM License 
Information

Help→5620 SAM License Information —

Help→About Help→About 5620 SAM

Release 2.1 menu Release 3.0 and later menu Notes

(4 of 4)
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5.1 Form overview

5620 SAM forms are used to:

• set configurations on configuration forms
• display drawings and settings
• perform tasks

5620 SAM forms, sometimes referred to as windows, can be displayed anywhere on 
the client GUI. Each newly opened form appears in the foreground. The previously 
opened form is placed in the background. With form management you can:

• organize forms according to operator preference
• keep forms open until they are needed
• perform side by side comparisons of data on different forms
• navigate quickly to other open forms using a numbered list, which is ordered 

according to the time that the form was opened

Figure 5-1 shows the client GUI with all forms tiled vertically.

Figure 5-1  Vertical tile format
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5.2 Form management workflow

1 Open the appropriate forms. By default, the navigation tree and dynamic alarm list 
forms are open when you launch the client GUI. See the appropriate chapter or 
section for the tasks to be performed.

2 Manage the open forms to maximize operator effectiveness and efficiency.

a Bring the form on which you want to work to the foreground.

b Organize the location and appearance of open forms. 

3 Close unnecessary forms to clear the working area.

5.3 Form menus

The following 5620 SAM main menu options contain form menu options:

• Window
• Application

Table 5-1 lists the Window menu options and their function.

Table 5-1 5620 SAM Window menu options

Table 5-2 lists the Application menu options and their function.

Menu option Function

Close All Close all open forms

Minimize All Reduce all forms to icons with a truncated titlebar 
title on the taskbar

Reset to Preferred Sizes Reset the foreground position and default size of 
the forms that open by default when you launch 
the client GUI

Cascade & Reset to Preferred Sizes Reset the form in the foreground to the default 
size and cascade

Tile Vertical

Tile Horizontal

Tile Square

Cascade

No Arrange (default)

Use the radio button to choose a method of tiling 
open forms

Open form 1

Open form 2

Open... etc.

Use the radio button to choose the form you want 
to bring to the foreground. The radio button is 
selected for the form currently in the foreground.
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Table 5-2 5620 SAM Application menu options

5.4 Form management procedures list

Table 5-3 lists the procedures to perform form management tasks.

Table 5-3 5620 SAM form procedures list

5.5 Form management procedures

Use the following procedures to perform form management tasks.

Procedure 5-1  To arrange forms

1 Choose the Window menu option from the 5620 SAM main menu.

2 Choose the Tile and Cascade menu options to organize the open forms by 
preference and efficiency.

Menu option Function

Navigation Tree Open a navigation tree window if it is not already 
open, bring it to the front, or maximize it if it had 
been minimized

Alarm Window Open a dynamic alarm list window if it is not 
already open, bring it to the front, or maximize it 
if it had been minimized

Save Workspace Save the current client GUI workspace 
configuration. The next time that you start the 
client GUI using the same user account and PC 
or workstation, the workspace settings are used. 
See Procedure 3-12 for more information.

User Preferences→Show Toolbar Show or hide the toolbar menu of icons below the 
5620 SAM main menu. See Procedure 3-6 for 
more information.

Procedure Purpose

To arrange forms Organize forms to maximize efficiency

To move an open form to the foreground Bring a form needed to complete a task to the 
foreground on the GUI

To close forms Close one or all open forms
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Procedure 5-2  To move an open form to the foreground

You can use a Window menu option or the taskbar to move open forms to the foreground.

Choose Window→Option from the 5620 SAM main menu and choose an open form from 
the list below the menu options. The selected form moves to the foreground.

From the taskbar, click on the icon that represents the open form. The selected form 
moves to the foreground.

Procedure 5-3  To close forms

When there is unsaved information on a form, you are prompted to save the changes 
before closing the form.

1 To close a single form, perform one of the following:

a Click on the X in the top-right corner of the form.

b Right-click on a form in the taskbar and choose Close from the contextual 
menu.

2 To close all open forms, choose Window→Close All from the 5620 SAM main menu.
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6.1 Performing searches overview

The 5620 SAM main menu options, Select button on configuration forms, and 
Search button on filter forms enable you to search and filter for many network 
objects, for example, services and service tunnels (also called SDPs).

Once you perform a search, you can manage the results, for example, view or edit 
information, change parameter values, or delete objects and log records. When you 
use many of the Application, Manage, Policies, Tools, and Administration menu 
options to perform a search, a filter form appears. The form contains buttons, check 
boxes, and filter options to refine the search criteria. 

6.2 Workflow to perform searches

1 Start the search:

a Choose the appropriate menu option from the 5620 SAM main menu.

b Click on the Select button from the appropriate configuration form.

2 Configure the search filter parameters, if required.

3 Click on the Search button. The results of the search are displayed.

4 Save the search filters, if required.

6.3 Performing searches menus

Table 6-1 lists and describes the 5620 SAM menus from which you can perform a 
search. 

Table 6-1 5620 SAM search menus

Menu option Description

Application→Equipment Manager Search for network devices

Application→Service Tunnel Topology Search for service tunnel topology maps

Application→LSP Topology Search for LSP topology maps

Manage→Option Search for one of the following:

• services
• composite services
• subscribers
• specific MPLS information across multiple devices
• MPLS paths
• LSP paths
• service tunnels
• equipment including slots, cards, and ports
• specific routing instances
• FIB entries
• service templates

(1 of 2)
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6.4 Performing searches procedures list

Table 6-2 lists and describes the procedures to perform a search.

Table 6-2 5620 SAM search procedures list

6.5 Performing searches procedures

Use the following procedures to perform searches in 5620 SAM.

Procedure 6-1  To perform a simple search from menus

1 Choose the appropriate menu option.

a Use a filter form to search for objects such as equipment, MPLS, alarms, or 
services. Go to step 2.

Figure 6-1 shows the Manage Equipment form.

Policies→Option Search for policies related to quality of service, routing 
protocols, schedules, ACLs, services, files, and statistics

Tools→Historical Alarms Review historical alarms for trends

Tools→Log Records Search for log records and view statistics information

Tools→Manage Tests Search for OAM diagnostic tests

Administration→Object Search for information related to system administration, 
including:

• 5620 SAM usage and activity records
• managed device user accounts and security access
• subscriber authentication policies

Menu option Description

(2 of 2)

Procedure Purpose

To perform a simple search from menus Find equipment, routing instances, MPLS, 
services, log records, and historical alarm 
information.

To save results table preferences Save results table list preferences so other 
searches on similar objects are listed in a similar 
fashion.

To save a filter, clear a filter, and load a filter Set a filter as the default filters for an object, clear 
currently defined filters, and reset default filters.

To perform a search by specifying endpoints Find MPLS paths, LSP paths, and service 
tunnels by specifying endpoints.

To perform a search using the Select button Find policies, subscribers, IDs, and other entities 
in a 5620 SAM configuration form.
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Figure 6-1  Manage Equipment filter form

b Use a filter form to search for log records. Go to step 4.

Figure 6-2 shows the Manage Log Records form.

Figure 6-2  Manage Log Records filter form
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2 Choose a category from the top left panel. The category properties of that category 
appear in the Unused Properties panel. Properties are the same as parameters.

3 Go to step 6.

4 Choose an item from the Log Class drop-down menu. A list of parameters is 
displayed in the Unused Properties box.

Leaving fields blank in the Filtered Properties box results in an any or all type of 
search. For example, if you are filtering on equipment, and you do not specify any 
equipment parameters in the Filtered Properties box, the search process returns a 
list of all available equipment. For fields that provide a pull-down list of options, the 
Unknown option is also used as an any or all type of search criteria. 

5 Choose an item from the Log Type drop-down menu.

6 Configure the filter parameters, if required.

i Click on the property or properties in the Unused Properties panel that you 
want to use as search filters and click on the right arrow. The properties are 
moved to the Filtered Properties panel. Properties are the same as 
parameters.

ii Set the search boundaries for each property in the Filtered Properties box. The 
search boundaries are based on options for the listed parameters.

7 Click on the Search button. The list form displays the results of the search.

8 To refresh the search results using the currently defined filter, click on the Search 
button. The current filter is used even when the filter panel is hidden or closed.

9 Choose an item from the results list, if required.

a Click on the Edit button to view or configure the parameters.

b Double-click on the item from the list to view or configure the parameters.

10 Click on the Close button to close the form.

Procedure 6-2  To save results table preferences

You can save results table preferences, so when similar searches on similar objects are 
performed, the output of the list in the table is organized according to your preferences.

Note —  You can click on the Search button without creating additional 
filters.

Note —  You can click on the Search button without creating additional 
filters.
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1 Define the filter properties as described in Procedure 6-1 and click on the Search 
button.

2 Organize the results table according to preference, for example, whether to sort 
columns of data in ascending or descending order. See Procedure 3-10 and 
Procedure 3-11 for more information about manipulating list information.

3 Right-click on a results table column heading and choose Save Table Preferences 
from the contextual menu. A dialog box appears to confirm that you want to save the 
current filter preferences.

4 Click on the Yes button. The results table format is saved.

Each time a similar list is generated for similar objects, for example, if you configured 
a table preference for generating lists of ports, then each time you list ports, results 
are displayed according to preconfigured table formats.

Procedure 6-3  To save a filter, clear a filter, and load a filter

Windows that support filtering let you save a default filter for an object type. You can clear 
defined filters and load a saved filter for the object search.

1 Define filter properties as described in Procedure 6-1 and click on the Save Filter 
button. The defined filter is saved for future use for a search on a similar object.

2 To clear a filter currently displayed in the filter panel, click on the Clear Filter button. 
The filter panel is cleared.

3 To load a saved filter for an object, click on the Load Filter button. The last saved 
filter is loaded in the filter panel and can be used as the current filter.

Procedure 6-4  To perform a search by specifying endpoints

Use the following procedure to find service tunnels, MPLS paths, and LSP paths by 
specifying endpoints.

1 Choose one of the following menu options from the 5620 SAM main menu:

• Manage→MPLS Paths
• Manage→LSPs
• Manage→Service Tunnels

The Manage filter form opens. Figure 6-3 shows the Manage LSP Paths filter form.
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Figure 6-3  Manage LSP Paths filter form

2 Choose Endpoints from the Select Filter Type drop-down menu. Endpoints is the 
default option.

3 Deselect the Any Source check box to pick a source IP address as a search filter. 
Otherwise, leave the Any Source check box selected to search by any source IP 
address.

4 Deselect the Any Destination check box to pick a destination IP address as a search 
filter. Otherwise, leave the Any Destination check box selected to search by any 
destination IP address.

5 Click on the Search button. Search results appear in the bottom panel of the form in 
the General tab.

6 Choose an item from the results list and click on the Edit button to view or configure 
the parameters, if required.

7 Click on the Properties tab button, if required.

8 Choose an item from the results list and click on the Edit button to view or configure 
the parameters, if required.

Search

Load
filter

Set
filter

View
result

17192
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9 Click on the Close button to close the search form.

Procedure 6-5  To perform a search using the Select button

Use the following procedure to find policies, subscribers, IDs, and other objects in a 
5620 SAM configuration form. The Select button appears as an option in some 
5620 SAM configuration forms, for example, when you have to choose a port for an 
interface. Use this button to search for and display valid options for a selection.

1 Click on the Select button in the configuration form. A Select filter form opens. 
Figure 6-4 shows a sample service configuration form with a Select button.

Figure 6-4  Sample service configuration form with Select button

2 Choose Simple from the Select Filter Type drop-down menu.

3 Click on the property or properties with which you want to filter your search from the 
Unused Properties box and click on the right arrow button. The selected properties 
are moved to the Filtered Properties box.

4 Set the search parameters for each property in the Filtered Properties box.

5 Click on the Search button. The Select form displays the results of the search.

17193
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Note —  You can click on the Search button without creating additional 
filters.
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6 Double-click on an entry to select it. Alternatively, select an entry and click on the 
OK button, as required. The Select form closes and the selected object appears in 
the configuration form.
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7.1 CLI overview

Most device management functions can be performed using the 5620 SAM client 
GUI. Experienced operators and system administrators can launch CLI sessions to 
managed devices, such as the 7750 SR, from the same workstation or PC that runs 
the 5620 SAM client GUI. The CLI can be used to:

• perform commissioning preconfigurations on managed devices
• validate actions performed on the GUI
• perform configurations not available from the GUI
• troubleshoot using managed device log files
• script a complex sequence of CLI commands and then run the script using a 

command button

Access to CLI commands is controlled by user account permission privileges. 
Permissions are set when security is configured on the managed device or by using 
5620 SAM security configuration forms. See chapter 12 for more information about 
setting device access privileges.

See the appropriate device hardware system guide for more information about CLI 
structure and usage. See the appropriate device hardware documentation for 
applicable CLI commands. The following CLI commands are below root in the CLI 
hierarchy for the 7750 SR:

7.2 Workflow to use the CLI

1 Ensure that the user logged in to the 5620 SAM client GUI has console access 
account privileges to the managed devices.

2 Ensure that the telnet server is started on the managed devices.

3 Launch a CLI session and configure CLI preference settings.

4 Launch a CLI session and log in to the managed device.

5 Configure CLI scripts.

6 Run CLI scripts according to user privilege and job function.

7.3 CLI menus

Table 7-1 lists the 5620 SAM CLI menus.

• admin
• bof
• configure
• environment
• file
• monitor

• help
• password
• show
• clear
• debug
• tools
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Table 7-1 5620 SAM CLI menus

7.4 CLI procedures list

Table 7-2 lists the procedures to use, configure, and manage CLI.

Table 7-2 5620 SAM CLI procedures list

7.5 CLI procedures

The following procedures describe how to launch and use the CLI.

Procedure 7-1  To launch a CLI session

1 You can:

a Use the navigation tree.

i Choose Equipment from the view selector.

ii Right-click on the device icon.

iii Choose CLI Session→option from the contextual menu, where option is 
Telnet Session or SSH Session.

Menu option Function

Tools→CLI Session→Telnet Session To launch a Telnet console session

Tools→CLI Session→SSH Session To launch an SSH console session

From the navigation tree, Equipment→Device 
right-click contextual menu CLI Session→option, 
where option is Telnet or SSH

To immediately connect using the IP address of 
the device, and display the CLI login window

Procedure Purpose

To launch a CLI session To open a Telnet or SSH console, and 
communicate directly with the managed device 
using CLI

To configure CLI console terminal preferences To set user preferences for displaying of CLI text, 
logging CLI sessions text, and using CLI scripts 
in the Telnet or SSH console

To create and use CLI scripts To create and use new or existing CLI scripts to 
manage modify device configurations

To save CLI scripts To save newly-created or modified CLI scripts to 
a networkstation directory or PC folder for 
storage or future use
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The Telnet Session or SSH Session form appears for the device.

b Use the 5620 SAM main menu.

i Choose Tools→CLI Session→option from the menu, where option is 
Telnet Session or SSH Session.

The Telnet Session or SSH Session form appears.

ii Type the management IP address of the device that you want to connect 
to beside the dimmed Connect button.

iii Click on the Connect button.

2 Log in using the required login user name and password.

You can now navigate the CLI according to your account security permissions.

Procedure 7-2  To configure CLI console terminal preferences

1 Launch a CLI session, as described in Procedure 7-1.

2 Right-click on the CLI console.

The CLI console contextual menu appears.

3 Choose Configure from the contextual menu.

The Terminal Configuration form appears.

4 Configure the parameters, as required.

i Set the Minimum number of scrolling lines parameter to specify how many 
lines you can scroll and view before the lines are wrapped.

ii Set the Font parameter and the Colors parameter to your viewing preferences.

iii Select the Send Console To a File parameter to send the console text to a log 
file.

Note —  The managed device must be configured for a telnet session. 
You can check by logging in at the device and typing: show system 
security and checking the status of the telnet server. If the telnet server is 
not configured, configure the telnet server by typing config system 
security telnet-server.
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When you choose to send the console output to a log file, you can specify the 
location of the log file using the Log File Location parameter.

• Click on the Change button.
The Open form appears.

• Navigate through the networkstation directory or PC folder structure for a 
log file storage location.

• Enter a name for the log file or use cli_output.txt, which is the default name.

iv Select the Show Scripting Command Buttons parameter to enable CLI 
scripting functionality.

5 Click on the OK button to save the changes.

The Telnet or SSH session uses the new parameter settings.

Procedure 7-3  To create and use CLI scripts

CLI scripts are used to create a series of CLI commands on a particular managed device, 
then use a single button to execute the commands. This eliminates the need to type a 
long series of CLI strings. You can create CLI scripts that perform a function or functions 
and then run the scripts using command buttons in the Telnet or SSH command console.

1 Launch a CLI session, as described in Procedure 7-1.

2 Right-click on the CLI console.

The CLI console contextual menu appears.

3 Choose Configure from the contextual menu.

The Terminal Configuration form appears.

4 Select the Show Scripting Command Buttons to enable CLI scripting functionality.

5 Click on the OK button.

The Sample Command button appears in the Telnet or SSH console.

6 Right-click on the Sample Command button.

The sample command contextual menu appears.

7 Perform the required CLI script creation or management task from the appropriate 
contextual menu option.

a Choose Add Command to add a CLI command script.

The CLI Scripting Command Configuration form appears.

Caution —  CLI scripts that are not applied or created correctly can 
cause serious damage to your network. Alcatel recommends that system 
administrators clearly define user responsibilities for CLI script usage, 
and that scripts are verified and validated before they are performed on 
devices in a live network.
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i Set the Name parameter to specify a name for the CLI script.

ii Create a CLI script that includes the CLI commands you want to execute 
in the Script Definition panel. Use the sample CLI script as a guideline.

You can:

• create send requests that perform a function on the managed device 
and then send the output to the console

• create requests that perform an action using CLI commands 
described in the appropriate device reference guide, for example, the 
7750 SR OS System Guide

iii Click on the OK button.

A command button, similar to the Sample Command button, is created in 
the Telnet or SSH console form.

b Choose Configure Command to modify an existing CLI command script.

The CLI Scripting Command Configuration form appears with the name of the 
script in the Name parameter.

i Modify the existing CLI script, as required.

ii Click on the OK button.

The script is updated.

c Choose Move Button to change the position of a command button.

The button is highlighted in red.

i Select the button.

ii Move the button along the gray bar at the bottom of the console to its new 
location.

iii Drop the button.

The button appears in the new location.

d Choose Remove Command to remove the CLI script for the selected button.

The command button is removed.

e Choose Remove All Commands to remove all CLI scripts.

All command buttons, except the default Sample Command button, are 
removed.

f Choose Cancel to stop any action being performed in this step, or to stop a CLI 
command.

8 If you created or modified a CLI script:

i Click on the CLI command button to perform the command.

The CLI command is executed in the console
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While the command is executed, an LED appears in the CLI command button. 
You can right-click on the button and choose Cancel from the contextual menu 
to stop the command.

ii Perform Procedure 7-4 to save the new or modified CLI script.

Procedure 7-4  To save CLI scripts

1 Create or modify a CLI script, as described in Procedure 7-3.

2 Right-click on the script command button and choose Configure Command from the 
contextual menu.

The CLI Scripting Command Configuration form appears.

3 Click on the Save Script to File button.

The Open form appears.

4 Navigate through the networkstation directory or PC file structure to locate a 
directory in which to store the script file.

5 Name the file appropriately with a .txt extension.

6 Click on the OK button.

The script file is saved.

Caution —  CLI scripts that are not applied or created correctly can 
cause serious damage to your network. Alcatel recommends that system 
administrators clearly define user responsibilities for CLI script usage, 
and that scripts are verified and validated before they are performed on 
devices in a live network.

Note —  Alcatel recommends that you back up scripts to a secure 
location. This prevents the accidental loss of scripts by, for example, 
overwriting a script.
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8.1 5620 SAM network and element management overview

The 5620 SAM is a network and element management system that is used to manage 
devices, such as the 7750 SR and 7450 ESS, by simplifying network and element 
management tasks.

The distributed 5620 SAM elements, collectively known as the 5620 SAM portfolio, 
run on independent PCs or workstations. These databases, servers, and clients were 
created when the 5620 SAM database, server, and client software was installed or 
upgraded. The installation and upgrade of 5620 SAM software is described in the 
5620 SAM Installation and Upgrade Guide.

The GUI and network management components use a Java-based technology that 
provides distributed, secure, and scalable applications. This architecture allows for 
scaling and fair load balancing, which improves performance. GUIs run on clients, 
and do not have direct access to the database or the network elements. Figure 8-1 
shows the basic architecture of a standalone system. See the 5620 SAM System 
Architecture guide for more information about high-level system design. See 
chapter 16 for more information about redundant systems.

Figure 8-1  5620 SAM standalone architecture

Before devices can be managed by 5620 SAM, commissioning configuration is 
necessary on the devices, as described in section 8.3. Once pre-configurations are 
complete, the devices can be discovered and managed in-band or out-of-band, as 
described in chapters 9 and 10.
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8.2 Changing 5620 SAM configurations

You can change the configuration of the 5620 SAM database, server, and client 
workstations using the 5620 SAM installation software, as described in the 
5620 SAM Installation and Upgrade Guide.

Change the configuration when:

• NOC topology changes
• a new PC or workstation is brought online as a database, server, or client

You may need to change the license key, based on the number of managed device 
MDAs in the network or the addition of new modules.

Procedure 8-1  To change the license key

1 Go to the install directory/nms/config directory or folder and locate the 
nms-server.xml file.

2 Open the nms-server.xml file using a text editor. Search on the XML tag <license>.

Contact your Alcatel support representative to verify that your license enables the 
5620 SAM-O server.

3 Type or cut-and-paste the updated license key in the file, if required, in the format: 
XXXXX-XXXXX-XXXXX-XXXXX-XXXXX-XXXXX-XXXXX-XXXXX-XXXXX-XXXXX
-XXXXX-XXXXX-XXXXX-XXXXX-XXXXX-XXXXX-XXXXX-XXXXX-XXXXX-XXXX
X-XXXXX-XXXXX-XXXXX-XXXXX

Include the dashes when you type the key.

4 Update the customer name, exactly as written when the license key was applied for.

5 Save the changes.

6 Open a shell or window.

7 Go to the install directory bin directory or folder.

8 Type:

nmsserver.bash read_config ↵

The changes to the nms-server.xml file are read, and the license count for managed 
cards (MDAs) is updated. Any additional licensed software modules are also 
enabled.
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8.3 Commissioning devices before managing 5620 SAM using 
CLI

Complete the following procedures for managed devices and read the following 
information before you use the 5620 SAM.

Firewalls and FTP

The 5620 SAM uses FTP to transfer data from managed devices. You can use FTP 
without any impact to the 5620 SAM. As well, ports between 5620 SAM 
applications and managed devices, such as between the 5620 SAM server and the 
managed devices, such as a 7750 SR, must be open across firewalls to allow for 
proper operation of the software.

See the 5620 SAM Planning Guide for more information about the requirements for:

• firewalls and open ports
• FTP recommendations

Procedure 8-2  To enable 7750 SR and 7450 ESS functionality before 
using the 5620 SAM

See the appropriate router documentation for more information about using the CLI, 
including the correct order of CLI strings, and the strings necessary to save changes.

1 Enable the system ID of the 7750 SRs to be managed by the 5620 SAM:

i Run the following CLI command on the 7750 SRs, in sequence:

configure router interface system

address <a.b.c.d>/32

where <a.b.c.d> is the system ID and /32 is the bitmask

ii Close the CLI.

2 Run the following CLI command to enable FTP and telnet on the managed device. 
FTP is used for accounting statistics and device backup and restore functionality. 
By default, the devices use SSH:

configure system security telnet-server

configure system security ftp-server

configure system security user user_account access ftp

where user_account is the appropriate user account for FTP, for example, admin

admin save
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3 Run the following CLI command to set time zones, set the time, and to use SNTP, 
if required.

configure system time zone time_zone -offset_from_UCT

admin set-time YYYY/MM/DD hh:mm:ss

configure system time sntp server-address sntp_server_IP_address

configure system time sntp no shutdown

where

time_zone is the appropriate time zone, for example, EST

offset_from_UCT is the offset from the universal time coordinate (also known as Greenwich Mean 
Time), for example, to use EST, the offset_from_UCT would be -5, as EST is minus five hours from 
UCT

sntp_server_IP_address is the IP address of the SNTP server

admin save

4 Run the following CLI command to enable the SNMP engine and configure at least 
one SNMPv2 community on all 7750 SRs to be managed by the 5620 SAM:

configure system snmp no shutdown

configure system security snmp community name of community rwa 
version both

where name of community is the SNMPv2 community name

admin save

5 Run the following CLI command on all 7750 SRs to be managed by the 5620 SAM 
to ensure that all get SNMP PDU commands are properly run:

configure system snmp packet-size 9216

admin save

6 Run the following CLI command to ensure persistent SNMP indices are used:

bof

persist on

save

back

admin save

admin synchronize boot-env

admin reboot

Are you sure you want to reboot? (y/n) y

Note —  The command is used for the 5620 SAM write mediation policy. 
If you are using SNMPv2, you must use this mediation policy for read as 
well, or create another mediation policy that is also configured for rwa.
Alcatel 5620 Service Aware Manager, Release 3.0 R1 8-5
October 2005 3HE00214 CA



8 —  Device commissioning configurations
If the router was already managed, unmanage (delete) the router and rediscover the 
router.

7 Now that SNMP communication is enabled, ensure that SNMP trap configuration is 
running using the following CLI command:

configure log

info

Check the output for the following information.

• a configured SNMP trap group, likely with ID 98
• that the SNMP trap group ID is associated with the IP address of the 5620 SAM 

server

8 Verify that the completed CLI configurations now allow you to perform network 
management tasks using 5620 SAM:

• open a Telnet session to a managed device, as described in chapter 7
• configure a device backup using the client GUI, as described in chapter 14

Procedure 8-3  To enable Telco functionality before using the 
5620 SAM

See the appropriate Telco device documentation for more information about using the 
CLI.

1 Set the hostname and IP address for the managed Telco devices

i Run the following CLI command on the Telco devices:

configure hostname name ↵

interface sw0 ↵

ip address A.B.C.D/M ↵

where
name is the hostname ID
sw0 is the management interface
A.B.C.D/ M is the IP address and bitmask

ii Close the CLI.

2 Set and enable passwords:

configure password name password ↵

enable password name password ↵

where

name is the user name

password is the password for the user name
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3 Enable the web server for BiNOS element management:

config web-server ↵

admin save ↵

4 The Telco device uses in-band management. The IP address of the sw0 interface 
is used for CLI, Telnet, and SNMP communication.

5 By default, access ports on the Telco devices belong to a VLAN. Remove them from 
the default VLAN:

config vlan ↵

config default ↵

remove ports 1/1/1-1/1/# ↵

where # is the number of ports on the card, for example, 24

6 Set static routes from the Telco device to the 5620 SAM network management 
domain:

config ip route A.B.C.D/M A.B.Y.Z/L ↵

where

A.B.C.D/M is the IP address and bitmask of the management port on the Telco device

A.B.Y.Z/L is the IP address and bitmask of the management port on the 5620 SAM server in the 
network management domain

7 Configure SNMP users, for example, for an SNMPv2c user:

config ↵

snmp-server enable ↵

snmp-server view viewALL 1.3 included ↵

snmp-server group nmsv3 v2c priv read viewALL write viewALL notify 
viewALL ↵

snmp-server user name group nmsv3 v2c priv encpasswd auth md5 
authpasswd ↵

where name is the user name in step 2

8 Configure SNMP trap forwarding to 5620 SAM:

config ↵

snmp-server enable ↵

snmp-server view viewALL 1.3 included ↵

snmp-server group group1 v2c read viewALL write viewALL notify 
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viewALL ↵

snmp-server user private group group1 v2c ↵

snmp-server user privatetrap98 group group1 v2c ↵

snmp-server notify allTraps ↵

snmp-server target-param Target1 privatetrap98 v2c ↵

snmp-server target-addr SAM 1.2.3.4 port# Target1 AllTraps ↵

where

1.2.3.4 is the IP address of the 5620 SAM server

port# is the SNMP trap-receiving port on the 5620 SAM server, for example, the default of 98 for a 
standalone or primary server, or 97 for a standby server

9 Set the spanning tree protocol for Telco devices in a ring topology:

a For RSTP:

config protocol ↵

rapid-spanning-tree enable ↵

rapid-spanning-tree priority 4096 ↵

b For MSTP:

config protocol ↵

mstp enable ↵

mstp 0 priority 4096 ↵

Note —  When setting MSTP priority, ensure that Telco devices closest 
to the 7450 ESS are set with the lowest priority and use instance 0. This 
enables the spanning tree protocol on all Telco ports. When ports are 
used for access as SAPs, spanning tree protocol should be disabled.
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9.1 Network element discovery overview

The 5620 SAM simplifies network provisioning by allowing you to discover devices 
and reconcile them to the 5620 SAM database for management. 

Network element discovery is executed via SNMP. During the discovery process, the 
5620 SAM scans the network for devices according to user-defined IP addresses or 
IP address ranges. When the IP address used to discover the device is the system IP 
address, also known as the system ID, management is considered in-band. When the 
IP address used to discover the device is the IP address of the device management 
port, management is considered out-of-band. See chapter 10 for more information 
about in-band and out-of-band management.

When a device is discovered, the 5620 SAM sets the device in a managed state and 
reconciles device elements into the 5620 SAM database.

To discover devices, you use the Discovery Manager to create one or more discovery 
rules, choose a discovery rule, and scan the network as specified by the rule.

Discovery rules contain rule elements. Rule elements specify which devices or 
subnets are to be included in or excluded from the discovery process. A discovery 
rule can contain more than one rule element. For example, you can configure one rule 
element to discover a subnet, and configure another rule element to exclude specific 
IP addresses from the subnet.

Figure 9-1 shows a Discovery Manager form with the Discovery Rules tab button 
selected.
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Figure 9-1  Discovery Manager form - Discovery Rules

Discovery and SNMP packet size
The managed devices must be configured to send SNMP packets of up to 9216 bytes. 
Ensure devices located between the managed devices, such as the 7750 SR, and 
5620 SAM can handle an MTU size of 9216 bytes or can fragment large SNMP 
packets

Consider the following:

• When an intermediate network device, such as a router, receives the management 
traffic to and from 5620 SAM, it must be able to process packets of up to 9216 
bytes. If this exceeds the MTU for the intermediate device, and if the device 
cannot perform packet fragmentation, then large packets may be dropped and 
resynchronization may fail. 

• Verify that large packets can travel from the managed devices to the 5620 SAM 
by using CLI to ping the IP address of the 5620 SAM server, using a large packet. 
See the 5620 SAM Troubleshooting Guide server troubleshooting chapter for 
more information about using traceroute and ping to verify packet transport.

9.2 Discovery workflow

The following workflow outlines the high-level steps necessary to discover the network.

1 Using the CLI, ensure each device you want to discover and manage using 
SNMPv3 has an unique engine ID.
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2 Using the CLI, configure the SNMP security parameters on the devices that you 
want to discover, including the maximum transmission unit size of the SNMP 
packets at 9216.

3 Configure poller policies.

4 Discover devices.

• Create discovery rules
• Discover devices by scanning the network according to discovery rules
• Set discovered device in a managed state
• Reconcile device elements into the 5620 SAM database 
• Check discovery, management, and reconciliation status of the devices

5 Manage the device discovery.

• Edit discovery rules
• Add or edit rule elements
• Enable or disable discovery rules
• Remove discovery rules
• Rescan the network according to a discovery rule
• Manage or unmanage devices
• Reconcile device elements into the 5620 SAM database

9.3 Discovery menus

Table 9-1 lists the discovery menu items.

Table 9-1 5620 SAM discovery menus

9.4 Discovery procedures list

Table 9-2 lists the discovery procedures.

Menu item Task

Administration→Discovery Management Access the discovery manager form to discover 
and reconcile managed devices, such as routers 
and switches.

Administration→Poller Policies Configure the 5620 SAM to poll network 
elements at regular intervals.
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Table 9-2 5620 SAM discovery procedures list

9.5 Discovery procedures

This section provides discovery procedures.

Procedure 9-1  To configure poller policies

Perform this procedure to configure the 5620 SAM to poll network elements at regular 
rates and intervals.

1 Choose Administration→Poller Policies from the 5620 SAM main menu.

The Poller Manager (Edit) form appears with the General tab selected.

Procedure Purpose

To configure poller policies To configure the 5620 SAM to poll network 
elements at regular intervals

To configure polling policies and discovery to use 
SNMPv3

To configure the 5620 SAM to use SNMPv3 for 
secure network element polling

To switch from SNMPv2c management of a 
device to SNMPv3 management

To switch from SNMPv2c to SNMPv3 
management on devices.

To create MD5 or DES security keys To create MD5 or DES security keys using a 
5620 SAM server utility.

To discover devices • Create discovery rules
• Discover devices by scanning the network 

according to discovery rules
• Set discovered devices in a managed state
• Reconcile router elements into the 

5620 SAM database 
• Check discovery, management, and 

reconciliation status of router

To edit a discovery rule To edit a discovery rule to specify a change to the 
way devices are scanned

To delete an old discovery rule and create a new 
discovery rule for the same device

To remove an old discovery rule and create a 
new discovery rule when the managed device 
router ID changes.

To enable or disable a discovery rule To enable or disable a discovery rule

To remove a discovery rule To remove a discovery rule

To rescan the network according to a discovery 
rule

To rescan a the network according to a discovery 
rule, for example, if the initial discovery attempt 
fails

To manage or unmanage a device To manage or unmanage a device

To reconcile device elements in the 5620 SAM 
database

To reconcile router elements, for example if the 
initial reconciliation fails
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2 Configure the parameters. They include:

• Polling Synchronization Time
• Base Polling Interval
• Discovery Rule Scan Interval

3 Configure MIB polling ratios for different managed devices, as required.

i Click on the MIB Entry Policies tab button.

A list of MIBs appears, organized by the product name of the device that 
supports the MIB. Table 9-3 lists the SNMP MIBs.

ii Select one or more MIBs from the list.

iii Click on the Edit button.

The poller policy form for that MIB appears as shown in Figure 9-2.

Note —  Polling and scanning use system resources, and can increase 
the amount of management traffic. Consider your network needs and 
network management domain capabilities when setting these 
parameters.
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Figure 9-2  PollerPolicy form - General and PollerManager form - MIB Entry Policies

iv Configure the parameters. They include:

• Polling Ratio
• Administrative State

v Click on the OK button.

vi Confirm the action.

The MIB poller policy form closes and the Poller Manager (Edit) form 
reappears.

vii Click on the Apply button to save the changes, if required.

4 Use the Mediation Security tab to specify SNMP security settings. To configure 
SNMPv3 security, you must perform configurations on the 5620 SAM server, the 
managed devices, and using GUI configuration forms. See Procedure 9-2 for more 
information.

i Click on the Mediation Security tab button.

ii Click on the Add button to create a new SNMP mediation security policy, or 
click on the Edit button to change an existing SNMP mediation security policy.
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The Mediation Policy (Create) form appears.

iii Configure the parameters. They include:

• Displayed Name
• Security Model
• Community String

The community string should match the community string set of the 
managed element.

• Timeout (ms)
• Retry
• User Name

When you set the security model to SNMP v3 (USM), you are prompted to 
assign a user profile that has been configured with the SNMP v3 
authentication and privacy parameters, as described in Procedure 9-2.

• Click on the Select button to view a list of configured users. The Select 
Site User For SNMP Access form appears.

• Select a user from the list and click on the OK button. The user name 
appears.

• Click on the View button to view the configuration details of the user’s 
permissions and SNMP v3 security settings.

• User Password
The User Password parameter value must also be entered in the Confirm 
Password field.

5 Click on the OK button. A dialog box appears.

6 Click on the OK button. The The Mediation Policy (Create) form closes and the 
Poller Manager (Edit) form reappears.

7 Use the Ping tab to define how the management IP addresses of devices are 
checked using a ping. Each managed device may provide one or more of the 
following three IP addresses, each of which can be scheduled to be pinged, as 
configured during discovery rule creation:

• the system IP address, called an in-band management interface
• the management IP address on the management port, called an out-of-band 

management interface
• the IP address of the standby Control card, also called a CPM

i Click on the Ping tab button.

ii Click on the Add button to create a new ping policy, or click on the Edit button 
to change an existing ping policy.

Note —  When the device does not have one or two of the IP address, 
for example, there is no CPM IP address, ensure that you create a ping 
policy that does not have its schedule enabled. This allows the 
assignment of an inactive ping policy during discovery configuration. See 
Procedure 9-5 for more information.
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The ManagementPingPolicy (Create) form appears.

iii Specify the parameters. They include:

• Displayed Name
• Ping OS Command
• Ping Command Timeout
• Schedule Enabled

You must enable scheduling for the default ping policy to be performed. 
When scheduling is not enabled, and a managed device is not reachable, 
management connection alarms may not be raised.

• Ping Interval (minutes)
• Ping Interval (seconds)

The destination interface of the ping is determined during the creation of 
discovery rules for devices. You can also perform an unscheduled ping from 
the Managed State tab of the Discovery Manager configuration form. See 
Procedure 9-5 for more information.

iv Click on the Apply button to save the changes.

The 5620 SAM generates alarms if the ping fails:

• the PingPolicyMisconfigured alarm indicates that the ping command or the 
ping policy settings are invalid

• the ConnectionDown alarm indicates that the pinged management 
interface is unreachable

8 Click on the Apply button to save the changes.

Procedure 9-2  To configure polling policies and discovery to use 
SNMPv3

SNMPv3 security is designed for user-based security, comprised of secure 
authentication and communication. The access granted is restricted to the scope of the 
configured users and groups.

To enable SNMPv3 using the 5620 SAM GUI, the following high-level steps are required:

• setting up SNMPv3 users on the 5620 SAM
• setting up SNMPv3 groups and users on the managed devices

1 Create SNMPv3 users from the 5620 SAM GUI using the site user manager. See 
Procedure 12-4 in chapter 12 for more information about configuring site users. 
Ensure that the following is configured:

• give the user SNMP access
• from the SNMPv3 tab button, use MD5 as the authentication protocol and DES 

for the privacy protocol
• type in the appropriate MD5 authentication and DES privacy keys
Alcatel 5620 Service Aware Manager, Release 3.0 R1 9-9
October 2005 3HE00214 CA



9 —  Discovery manager
2 Create a new SNMPv3 mediation security policy, as described in Procedure 9-1.

3 Configure SNMPv3 groups and users on the managed devices. The following 
shows configuring a read-write user on the 7750 SR.

i Log in to the 7750 SR.

ii Create a read-write group:

configure system security snmp access group snmpv3_groupname 
security-model usm security-level privacy read iso write iso 
notify iso ↵

configure system security user snmpv3_username ↵

access snmp ↵

snmp group snmpv3_groupname ↵

authentication md5 insert_MD5_authentication_key privacy 
des-key insert_DES_privacy_key group snmpv3_groupname ↵

4 Create new discovery rules that uses the SNMPv3 mediation policy, and choose the 
SNMPv3 read-write user as both the read and write users when prompted.

5 Discover the devices, as required.

Procedure 9-3  To switch from SNMPv2c management of a device to 
SNMPv3 management

1 Create SNMPv3 users from the 5620 SAM GUI using the site user manager. See 
Procedure 12-4 in chapter 12 for more information about configuring site users. 
Ensure that the following is configured:

• give the user SNMP access
• from the SNMPv3 tab button, use MD5 as the authentication protocol and DES 

for the privacy protocol
• type in the appropriate MD5 authentication and DES privacy keys

2 Create a mediation policy that uses the SNMPv3 users created in step 1. See 
Procedure 9-1 for more information.

3 Configure SNMPv3 groups and users on the managed devices. The following 
shows configuring a read-write user on the 7750 SR.

i Log in to the 7750 SR.

ii Create a read-write group:

configure system security snmp access group snmpv3_groupname 

Note —  You can generate MD5 or DES security keys using the 
5620 SAM server. See Procedure 9-4 for more information.
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security-model usm security-level privacy read iso write iso 
notify iso ↵

configure system security user snmpv3_username ↵

access snmp ↵

snmp group snmpv3_groupname ↵

authentication md5 insert_MD5_authentication_key privacy 
des-key insert_DES_privacy_key group snmpv3_groupname↵

4 Manually resynchronize the device using the Resync button.

5 Change the mediation policy for the device using SNMPv3.

i Choose Administration→Discovery Management from the 5620 SAM main 
menu.

ii Click on the Managed State tab button. A list of managed devices appears.

iii Select the device from the list that you want to manage using SNMPv3.

iv Click on the Edit button.

v Click on the Mediation Security tab button.

vi Select the SNMPv3 mediation policy created in step 2.

6 Rediscover the devices, as required.

Procedure 9-4  To create MD5 or DES security keys

You can create MD5 or DES security keys using the password2key utility on the 
5620 SAM server.

1 Go to the install_directory/nms/bin directory or folder on the 5620 SAM server.

2 Run the password2key.bat or .bash utility:

password2key MD5 trial snmp_engine_ID_PE1 ↵

where

MD5 is either MD5 or SHA authentication

trial is an example of a password

snmp_engine_ID_PE1 is the SNMP engine ID of the managed device using SNMPv3

Note —  You can generate MD5 or DES security keys using the 
5620 SAM server. See Procedure 9-4 for more information.

Note —  You can also change the mediation policy for a discovery rule 
as well. Perform step 5, but choose a discovery rule from the Discovery 
Rules tab button.
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3 Repeat for the number of keys necessary for your security model.

4 Store the generated keys.

Procedure 9-5  To discover devices

Perform this procedure to complete the following tasks:

• Create discovery rules
• Ping the managed devices to test connectivity
• Discover devices by scanning the network according to discovery rules
• Set discovered devices in a managed state
• Reconcile router elements into the 5620 SAM database 
• Check discovery, management, and reconciliation status of device

1 Choose Administration→Discovery Management from the 5620 SAM main menu. 
The Discovery Manager form opens with the Discovery Rules tab displayed.

2 Configure a discovery rule.

i Click on the Add button to create a new discovery rule. The Create Discovery 
Rule - Specify General Attributes form opens, as shown in Figure 9-3.

Note —  After using the keyword SHA, you must use a key obtained from 
running the password2key using SHA. Keys after the keyword privacy 
must be done by running the same password2key command using the 
MD5 instead.

Note 1 — SNMP parameters must be correctly specified on the 
7750 SR. Contact your Alcatel support representative or see chapter 2 for 
more information.

Note 2 — Ensure in-band and out-of-band management is correctly 
configured to discover devices, as described in chapter 10.
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Figure 9-3  Create Discovery Rule form - Specify General Attributes step

ii Configure the parameters. They include:

• ID
• Auto-Assign ID
• Description
• Administrative State

When you set the administrative state to Up, the network is scanned 
according to the discovery rule when the discovery rule is saved. The 
network is also scanned according to the discovery rule as specified by the 
discovery rule scan interval parameter in the poller manager form. When 
you set the administrative state to Down, the network is not scanned as 
specified by these conditions.

iii Click the Next button. The Add Rule Elements form opens, as shown in 
Figure 9-4.
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Figure 9-4  Create Discovery Rule form - Add Rule Elements step

Click on the Add button to add a new rule element.

iv Configure the following parameters for the Add Rule Elements form. They 
include:

• IP Address
• Mask Bits
• Usage

v Click on the OK button. 

Note —  Ensure that you track the IP addresses used to discover 
devices. When the IP address used to discover the device is the system 
IP address, also known as the system ID, management is considered to 
be in-band. When the IP address used to discover the device is the IP 
address of the device management port, management is considered to 
be out-of-band.

The first IP address used to discover the device is the primary 
management interface. The second IP address discovered by 5620 SAM 
is the secondary management interface.

When the type of management is change — for example, from in-band to 
out-of-band — the administrator must know which IP address is primary 
and which IP address is secondary. See chapter 10 for more information 
about in-band and out-of-band management.
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The discovery rule is saved. When you click on the Apply button in the 
discovery manager form in step 3, the network is scanned according to the new 
or modified discovery rule.

vi Add more rule elements as required by performing substeps i to v.

vii Click on the Next button. The Configure Mediation Security form opens.

viii Specify the mediation policies for read access, write access, and SNMP trap 
access.

Click on the Select button if you want to specify mediation security policies 
specific to the discovery rule. Mediation policies are created or modified using 
the poller policies form, as described in Procedure 9-1.

If you do not specify a policy, the default policy is applied. Click on the Next 
button.

If you clicked the Select button, the Configure Mediation Security form 
appears. You can:

• Select an existing mediation security policy from the list and click on the OK 
button.

• Select an existing mediation security policy and click on the Edit button. 
The Mediation Policy (Edit) form opens.

• Configure the parameters, as described in step 4 in Procedure 9-1.

ix Click on the OK button to save the changes.

x Click on the Next button. The Configure Management Ping Policy form opens.

xi Specify the management ping policies for each of the following management 
IP addresses, if required:

• the management IP address on the management port, called an 
out-of-band management interface

• the system IP address, called an in-band management interface
• the IP address of the standby Control card, also called a CPM

Figure 9-5 shows the configure management ping policy parameters on the 
Create Discovery Rule form.

Note —  Management ping policies are created using the poller 
manager configuration form. These are the policies applied during 
discovery rule creation. You must apply a ping policy, even for interfaces 
that do not exist. For example, if there is no standby CPM or in-band 
management IP address, a ping policy should be created that has the 
Schedule Enabled parameter set to disabled. This allows an inactive ping 
policy to be applied for the in-band management interface and standby 
CPM interface, This ensures those non-existent interfaces are not 
pinged. In this example, a ping policy with the Schedule Enabled 
parameter enabled should be created using the poller manager 
configuration form and applied for an out-of-band interface, since the 
interface exists and can be pinged. See Procedure 9-1 for more 
information about creating ping policies.
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Figure 9-5  Create Discovery Rule form - Configure Management Ping Policy step

xii Click on the Select button for each ping policy ID parameter. The Configure 
Management Ping Policy list form opens.

xiii Choose a ping policy from the list. When there is no interface, choose a ping 
policy that has its Schedule Enabled parameter disabled.

xiv Click on the OK button. The ping policy ID appears in the Policy ID parameter.

xv Click on the Finish button. The Create Discovery Rule - Configure 
Management Ping Policy form closes and the Discovery Manager form 
reappears.

The 5620 SAM generates alarms if the ping fails:

• the PingPolicyMisconfigured alarm indicates that the ping command or the ping 
policy settings are invalid

• the ConnectionDown alarm indicates that the pinged management interface is 
unreachable

3 Save the discovery rule, and discover devices by scanning the network as specified 
by the discovery rule.

i Click on the Discovery Rules tab button on the Discovery Manager form.

ii Click on the Apply button.

New or modified discovery rules are saved. The 5620 SAM discovers devices 
by scanning the network as specified by the discovery rules. After a device is 
discovered, the 5620 SAM sets the device in a managed state and reconciles 
the device elements into its database.

Discovery rules that are disabled or shut down are not applied.
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4 Verify that the device is discovered and is managed by the 5620 SAM by clicking on 
the Managed State tab button on the Discovery Manager form. A list of managed 
devices appears.

The management state of the device is displayed in the Site State column. Managed 
is the default state. If the device is unmanaged, double-click on the device and set 
the site state parameter to Managed in the form that opens.

5 From the Managed State tab, you can also perform management IP address pings 
to ensure connectivity to all managed devices.

i Click on one of the managed devices in the list.

ii Click on the appropriate ping button. Do not ping devices without an interface.

• Click on the Ping Out-of-Band button to test the management IP address 
on the management port, called an out-of-band management interface

• Click on the Ping In-Band button to test the system IP address, called an 
in-band management interface

• Click on the Ping Stby CPM button to test the IP address of the standby 
Control card, also called a CPM

The appropriate ping command is performed.

iii Review the ping information to verify connectivity.

6 Verify that the device configuration has been reconciled into the 5620 SAM 
database by clicking on the Resync Status tab button.

The status is displayed in the Resync Status column.

• Done indicates the database has been successfully reconciled.
• Failed indicates the database has not been successfully reconciled. 

To initiate manual reconciliation of a device, select the device from the list and click 
on the Resync button. 

If the reconciliation fails: 

• View faults that are associated with a device by double-clicking on the device in 
the Discovery Manager form and clicking on the Faults tab button in the form that 
opens.

• Check your SNMP security parameters on a device using the CLI.
• Check your 5620 SAM poller policy settings by choosing Administration→Poller 

Policies from the 5620 SAM main menu.

Devices that have been successfully reconciled appear in 5620 SAM navigation tree 
and the Equipment Manager form.

Procedure 9-6  To edit a discovery rule

Edit discovery rules when new devices are added to the network.
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1 Choose Administration→Discovery Management from the 5620 SAM main menu. 
The Discovery Manager form opens.

2 Select a discovery rule from the list.

3 Click on the Edit button.

The appropriate TopologyDiscoveryRule edit form opens.

4 Configure the parameters as required. For example, to remove a rule element:

i Click on the Rule Elements tab button.

ii Select the rule from the list.

iii Click on the Remove button near the top of the TopologyDiscoveryRule form.

iv Confirm the action.

5 Click on the OK button to close the discovery rules editing form.

6 Perform steps 3 to 6 in Procedure 9-5.

Procedure 9-7  To delete an old discovery rule and create a new 
discovery rule for the same device

When you change the router ID on a managed device, for example, when you perform 
the CLI command system router id, you must delete existing discovery rules and create 
new discovery rules. Otherwise, the device that you want to unmanage continues to be 
polled by the discovery rules and rediscovered.

• Unmanage the device as described in Procedure 9-11
• Remove the device from any applicable discovery rules as described in this 

procedure.
• Create a new discovery rule to rediscover the device with the modified router ID, 

as described in Procedure 9-5.
• Rediscover the device.

1 Choose Administration→Discovery Management from the 5620 SAM main menu. 
The Discovery Manager form opens.

2 Select a discovery rule from the list.

3 Click on the Edit button.

The appropriate TopologyDiscoveryRule edit form opens.
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4 Configure the parameters as required. For example, to remove a rule element:

i Click on the Rule Elements tab button.

ii Select the rule from the list.

iii Click on the Remove button near the top of the TopologyDiscoveryRule form. 
The rule disappears from the list and a dialog box appears.

iv Click on the OK button.

5 Click on the OK button to close the discovery rules editing form.

6 Create a new discovery rule using the new router ID, as described in Procedure 9-5.

Procedure 9-8  To enable or disable a discovery rule

When a discovery rule is enabled, the network is scanned according to the discovery rule 
when the discovery rule is saved or rescanned. The network is also scanned according 
to the discovery rule as specified by the discovery rule scan interval parameter in the 
poller manager form. If you discovery rule is disabled, the network is not scanned as 
specified by these conditions.

1 Choose Administration→Discovery Manager from the main menu. The Discovery 
Manager form appears.

2 Select a discovery rule from the list.

3 Enable or disable the discovery rule.

a Click on the Turn Up button to enable the discovery rule.

b Click on the Shut Down button to disable the discovery rule.

Procedure 9-9  To remove a discovery rule

When you remove a discovery rule, only the rule is removed. Discovered routers are not 
removed from the 5620 SAM.

1 Choose Administration→Discovery Management from the 5620 SAM main menu. 
The Discovery Manager form appears.

2 Select a discovery rule from the list.

3 Click the Remove button.

4 Click the Apply button to delete the rule.
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Procedure 9-10  To rescan the network according to a discovery rule

Perform this procedure to discover devices by rescanning the network as specified by a 
discovery rule. 

1 Choose Administration→Discovery Management from the 5620 SAM main menu. 
The Discovery Manager form appears.

2 Select one or more discovery rules from the list.

3 Click on the Rescan button.

The 5620 SAM scans the network as specified by the discovery rules and discovers 
devices. After a device is discovered, the 5620 SAM sets the device in a managed 
state and reconciles the device elements into its database.

4 Perform steps 4 and 6 in Procedure 9-5 to verify that the device has been 
successfully discovered and reconciled.

Procedure 9-11  To manage or unmanage a device

1 Choose Administration→Discovery Management from the main menu. The 
Discovery Manager form appears.

2 Click on the Managed State tab button.

3 Select a device from the list.

4 Click on the Manage or Unmanage button as required.

5 Verify the action.

The device becomes managed or unmanaged by the 5620 SAM.

Procedure 9-12  To reconcile device elements in the 5620 SAM 
database

Perform this procedure to reconcile device elements in the 5620 SAM database, for 
example, if the initial reconciliation failed. 

1 Choose Administration→Discovery Management from the 5620 SAM main menu. 
The Discovery Manager form opens.

2 Click on the Resync Status tab button.

3 Select a device from the list.

4 Click on the Resync button. The Resync Site form opens.

5 Choose a resynchronization option.
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a Select Resync All MIB Entries to resync all MIBs for the device and click on the 
Next button. The Force Resync form opens. Go to step 6.

b Select Choose MIB Entries to resync some MIBs for the device.

i Click on the Next button.

The Choose MIB Entries form opens.

ii Choose one or more MIB entries from the list. Table 9-3 lists all the SNMP 
MIBs.

iii Click on the Next button. The Force Resync form opens. 

6 Select the Ignore Timestamps parameter to unconditionally resynchronize with the 
network device. When you do not ignore timestamps, MIBs are not resynchronized 
if the last change timestamp is unchanged.

7 Click on the Finish button. A message indicates when the reconciliation is 
successful.

8 Perform step 6 in Procedure 9-5 to verify that the router elements have been 
reconciled in the 5620 SAM database.

9.6 SNMP MIBs

Poller policies define the interval and ratio used by 5620 SAM to poll network 
elements for MIB configuration changes. You can use the poller manager and poller 
policy forms to view the network element information contained in the MIB. See 
Procedure 9-1 for more information.

Table 9-3 lists the available polling options for MIBs and MIB entries.

Table 9-3 MIBs and MIB entries

Device name MIB 
version

MIB name MIB entry name

Alcatel-ESS-7450 1.0.0 EtherLike-MIB dot3StatsEntry

Alcatel-ESS-7450 1.0.0 FRAME-RELAY-DTE-MIB frDlcmiEntry

Alcatel-ESS-7450 1.0.0 HC-RMON-MIB mediaIndependentEntry

Alcatel-ESS-7450 1.0.0 IEEE8023-LAG-MIB dot3adAggEntry

Alcatel-ESS-7450 1.0.0 dot3adAggPortEntry

Alcatel-ESS-7450 1.0.0 IF-MIB ifEntry

Alcatel-ESS-7450 1.0.0 ifXEntry

Alcatel-ESS-7450 1.0.0 linkDown

Alcatel-ESS-7450 1.0.0 linkUp

(1 of 92)
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Alcatel-ESS-7450 1.0.0 IP-MIB ipNetToMediaEntry

Alcatel-ESS-7450 1.0.0 ISIS-MIB isisAreaAddrEntry

Alcatel-ESS-7450 1.0.0 isisCircEntry

Alcatel-ESS-7450 1.0.0 isisCircLevelEntry

Alcatel-ESS-7450 1.0.0 isisISAdjAreaAddrEntry

Alcatel-ESS-7450 1.0.0 isisISAdjEntry

Alcatel-ESS-7450 1.0.0 isisManAreaAddrEntry

Alcatel-ESS-7450 1.0.0 isisPacketCountEntry

Alcatel-ESS-7450 1.0.0 isisSysEntry

Alcatel-ESS-7450 1.0.0 MPLS-LSR-MIB mplsInSegmentEntry

Alcatel-ESS-7450 1.0.0 mplsInterfaceConfEntry

Alcatel-ESS-7450 1.0.0 mplsOutSegmentEntry

Alcatel-ESS-7450 1.0.0 mplsXCDown

Alcatel-ESS-7450 1.0.0 mplsXCEntry

Alcatel-ESS-7450 1.0.0 mplsXCUp

Alcatel-ESS-7450 1.0.0 MPLS-TE-MIB mplsTunnelARHopEntry

Alcatel-ESS-7450 1.0.0 mplsTunnelDown

Alcatel-ESS-7450 1.0.0 mplsTunnelEntry

Alcatel-ESS-7450 1.0.0 mplsTunnelHopEntry

Alcatel-ESS-7450 1.0.0 mplsTunnelReoptimized

Alcatel-ESS-7450 1.0.0 mplsTunnelRerouted

Alcatel-ESS-7450 1.0.0 mplsTunnelUp

Device name MIB 
version

MIB name MIB entry name

(2 of 92)
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Alcatel-ESS-7450 1.0.0 OSPF-MIB ospfASBdrRtrStatus

Alcatel-ESS-7450 1.0.0 ospfAdminStat

Alcatel-ESS-7450 1.0.0 ospfAreaAggregateEntry

Alcatel-ESS-7450 1.0.0 ospfAreaBdrRtrStatus

Alcatel-ESS-7450 1.0.0 ospfAreaEntry

Alcatel-ESS-7450 1.0.0 ospfExitOverflowInterval

Alcatel-ESS-7450 1.0.0 ospfExtLsdbLimit

Alcatel-ESS-7450 1.0.0 ospfExternLsaCksumSum

Alcatel-ESS-7450 1.0.0 ospfExternLsaCount

Alcatel-ESS-7450 1.0.0 ospfIfEntry

Alcatel-ESS-7450 1.0.0 ospfIfMetricEntry

Alcatel-ESS-7450 1.0.0 ospfNbrEntry

Alcatel-ESS-7450 1.0.0 ospfOpaqueLsaSupport

Alcatel-ESS-7450 1.0.0 ospfRFC1583Compatibility

Alcatel-ESS-7450 1.0.0 ospfStubAreaEntry

Alcatel-ESS-7450 1.0.0 ospfTrafficEngineeringSupport

Alcatel-ESS-7450 1.0.0 ospfVirtIfEntry

Alcatel-ESS-7450 1.0.0 ospfVirtNbrEntry

Alcatel-ESS-7450 1.0.0 OSPF-TRAP-MIB ospfIfAuthFailure

Alcatel-ESS-7450 1.0.0 ospfIfConfigError

Alcatel-ESS-7450 1.0.0 ospfIfRxBadPacket

Alcatel-ESS-7450 1.0.0 ospfIfStateChange

Alcatel-ESS-7450 1.0.0 ospfLsdbApproachingOverflow

Alcatel-ESS-7450 1.0.0 ospfLsdbOverflow

Alcatel-ESS-7450 1.0.0 ospfNbrStateChange

Alcatel-ESS-7450 1.0.0 ospfNssaTranslatorStatusChange

Alcatel-ESS-7450 1.0.0 ospfTxRetransmit

Alcatel-ESS-7450 1.0.0 ospfVirtIfAuthFailure

Alcatel-ESS-7450 1.0.0 ospfVirtIfConfigError

Alcatel-ESS-7450 1.0.0 ospfVirtIfRxBadPacket

Alcatel-ESS-7450 1.0.0 ospfVirtIfStateChange

Alcatel-ESS-7450 1.0.0 ospfVirtIfTxRetransmit

Alcatel-ESS-7450 1.0.0 ospfVirtNbrStateChange

Alcatel-ESS-7450 1.0.0 RSVP-MIB rsvpIfEntry

Alcatel-ESS-7450 1.0.0 rsvpNbrEntry

Alcatel-ESS-7450 1.0.0 SNMP-USER-BASED-SM-MIB usmUserEntry

Device name MIB 
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Alcatel-ESS-7450 1.0.0 SNMP-VIEW-BASED-ACM-MIB vacmAccessEntry

Alcatel-ESS-7450 1.0.0 vacmSecurityToGroupEntry

Alcatel-ESS-7450 1.0.0 SNMPv2-MIB authenticationFailure

Alcatel-ESS-7450 1.0.0 coldStart

Alcatel-ESS-7450 1.0.0 sysDescr

Alcatel-ESS-7450 1.0.0 sysLocation

Alcatel-ESS-7450 1.0.0 sysUpTime

Alcatel-ESS-7450 1.0.0 SONET-MIB sonetFarEndLineCurrentEntry

Alcatel-ESS-7450 1.0.0 sonetFarEndLineIntervalEntry

Alcatel-ESS-7450 1.0.0 sonetFarEndPathCurrentEntry

Alcatel-ESS-7450 1.0.0 sonetFarEndPathIntervalEntry

Alcatel-ESS-7450 1.0.0 sonetLineCurrentEntry

Alcatel-ESS-7450 1.0.0 sonetLineIntervalEntry

Alcatel-ESS-7450 1.0.0 sonetPathCurrentEntry

Alcatel-ESS-7450 1.0.0 sonetPathIntervalEntry

Alcatel-ESS-7450 1.0.0 sonetSectionCurrentEntry

Alcatel-ESS-7450 1.0.0 sonetSectionIntervalEntry

Device name MIB 
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Alcatel-ESS-7450 1.0.0 TIMETRA-CHASSIS-MIB tSyncIfTimingAdmEntry

Alcatel-ESS-7450 1.0.0 tmnxCardEntry

Alcatel-ESS-7450 1.0.0 tmnxChassisEntry

Alcatel-ESS-7450 1.0.0 tmnxChassisFanEntry

Alcatel-ESS-7450 1.0.0 tmnxChassisPowerSupplyEntry

Alcatel-ESS-7450 1.0.0 tmnxCpmCardEntry

Alcatel-ESS-7450 1.0.0 tmnxCpmFlashEntry

Alcatel-ESS-7450 1.0.0 tmnxEnvTempTooHigh

Alcatel-ESS-7450 1.0.0 tmnxEqCardFailure

Alcatel-ESS-7450 1.0.0 tmnxEqCardInserted

Alcatel-ESS-7450 1.0.0 tmnxEqCardRemoved

Alcatel-ESS-7450 1.0.0 tmnxEqFanFailure

Alcatel-ESS-7450 1.0.0 tmnxEqFlashDataLoss

Alcatel-ESS-7450 1.0.0 tmnxEqFlashDiskFull

Alcatel-ESS-7450 1.0.0 tmnxEqPowerSupplyFailure

Alcatel-ESS-7450 1.0.0 tmnxEqPowerSupplyInserted

Alcatel-ESS-7450 1.0.0 tmnxEqPowerSupplyRemoved

Alcatel-ESS-7450 1.0.0 tmnxEqSyncIfTimingBITSAlarm

Alcatel-ESS-7450 1.0.0 tmnxEqSyncIfTimingBITSAlarmClear

Alcatel-ESS-7450 1.0.0 tmnxEqSyncIfTimingHoldover

Alcatel-ESS-7450 1.0.0 tmnxEqSyncIfTimingHoldoverClear

Alcatel-ESS-7450 1.0.0 tmnxEqSyncIfTimingRef1Alarm

Alcatel-ESS-7450 1.0.0 tmnxEqSyncIfTimingRef1AlarmClear

Alcatel-ESS-7450 1.0.0 tmnxEqSyncIfTimingRef2Alarm

Alcatel-ESS-7450 1.0.0 tmnxEqSyncIfTimingRef2AlarmClear

Alcatel-ESS-7450 1.0.0 tmnxEqWrongCard

Alcatel-ESS-7450 1.0.0 tmnxFabricEntry

Alcatel-ESS-7450 1.0.0 tmnxHwEntry

Alcatel-ESS-7450 1.0.0 tmnxMDAEntry

Alcatel-ESS-7450 1.0.0 tmnxPeBootloaderVersionMismatch

Alcatel-ESS-7450 1.0.0 tmnxPeBootromVersionMismatch

Alcatel-ESS-7450 1.0.0 TIMETRA-CHASSIS-MIB continued tmnxPeFPGAVersionMismatch

Alcatel-ESS-7450 1.0.0 tmnxPeSoftwareLoadFailed

Alcatel-ESS-7450 1.0.0 tmnxPeSoftwareVersionMismatch

Alcatel-ESS-7450 1.0.0 tmnxRedPrimaryCPMFail

Alcatel-ESS-7450 1.0.0 tmnxSyncIfTimingEntry

Device name MIB 
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Alcatel-ESS-7450 1.0.0 TIMETRA-FILTER-MIB tIPFilterEntry

Alcatel-ESS-7450 1.0.0 tIPFilterParamsEntry

Alcatel-ESS-7450 1.0.0 tMacFilterEntry

Alcatel-ESS-7450 1.0.0 tMacFilterParamsEntry

Alcatel-ESS-7450 1.0.0 TIMETRA-ISIS-MIB vRtrIsisAdjacencyChange

Alcatel-ESS-7450 1.0.0 vRtrIsisAreaMismatch

Alcatel-ESS-7450 1.0.0 vRtrIsisAutTypeFail

Alcatel-ESS-7450 1.0.0 vRtrIsisAuthFail

Alcatel-ESS-7450 1.0.0 vRtrIsisEntry

Alcatel-ESS-7450 1.0.0 vRtrIsisISAdjEntry

Alcatel-ESS-7450 1.0.0 vRtrIsisIfEntry

Alcatel-ESS-7450 1.0.0 vRtrIsisIfLevelEntry

Alcatel-ESS-7450 1.0.0 vRtrIsisLevelEntry

Alcatel-ESS-7450 1.0.0 vRtrIsisManualAddressDrops

Alcatel-ESS-7450 1.0.0 vRtrIsisRejectedAdjacency

Alcatel-ESS-7450 1.0.0 vRtrIsisStatsEntry

Alcatel-ESS-7450 1.0.0 TIMETRA-LAG-MIB tLagConfigEntry

Alcatel-ESS-7450 1.0.0 tLagDynamicCostOff

Alcatel-ESS-7450 1.0.0 tLagDynamicCostOn

Alcatel-ESS-7450 1.0.0 tLagOperationEntry

Alcatel-ESS-7450 1.0.0 tLagPortAddFailed

Alcatel-ESS-7450 1.0.0 TIMETRA-LDP-MIB vRtrLdpGeneralEntry

Alcatel-ESS-7450 1.0.0 vRtrLdpHelloAdjEntry

Alcatel-ESS-7450 1.0.0 vRtrLdpIfEntry

Alcatel-ESS-7450 1.0.0 vRtrLdpIfStateChange

Alcatel-ESS-7450 1.0.0 vRtrLdpIfStatsEntry

Alcatel-ESS-7450 1.0.0 vRtrLdpInstanceStateChange

Alcatel-ESS-7450 1.0.0 vRtrLdpPeerParamsEntry

Alcatel-ESS-7450 1.0.0 vRtrLdpSessionEntry

Alcatel-ESS-7450 1.0.0 vRtrLdpSessionStatsEntry

Alcatel-ESS-7450 1.0.0 vRtrLdpStateChange

Alcatel-ESS-7450 1.0.0 vRtrLdpStatsEntry

Alcatel-ESS-7450 1.0.0 TIMETRA-LOG-MIB tmnxLogApEntry

Alcatel-ESS-7450 1.0.0 tmnxLogFileIdEntry

Alcatel-ESS-7450 1.0.0 tmnxLogFileRollover

Device name MIB 
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Alcatel-ESS-7450 1.0.0 TIMETRA-MPLS-MIB vRtrMplsAdminGroupEntry

Alcatel-ESS-7450 1.0.0 vRtrMplsGeneralEntry

Alcatel-ESS-7450 1.0.0 vRtrMplsGeneralStatEntry

Alcatel-ESS-7450 1.0.0 vRtrMplsIfEntry

Alcatel-ESS-7450 1.0.0 vRtrMplsIfStatEntry

Alcatel-ESS-7450 1.0.0 vRtrMplsIfStateChange

Alcatel-ESS-7450 1.0.0 vRtrMplsLspDown

Alcatel-ESS-7450 1.0.0 vRtrMplsLspEntry

Alcatel-ESS-7450 1.0.0 vRtrMplsLspPathDown

Alcatel-ESS-7450 1.0.0 vRtrMplsLspPathEntry

Alcatel-ESS-7450 1.0.0 vRtrMplsLspPathStatEntry

Alcatel-ESS-7450 1.0.0 vRtrMplsLspPathUp

Alcatel-ESS-7450 1.0.0 vRtrMplsLspStatEntry

Alcatel-ESS-7450 1.0.0 vRtrMplsLspUp

Alcatel-ESS-7450 1.0.0 vRtrMplsStateChange

Alcatel-ESS-7450 1.0.0 vRtrMplsTunnelCHopEntry

Alcatel-ESS-7450 1.0.0 vRtrMplsXCEntry

Device name MIB 
version

MIB name MIB entry name

(7 of 92)
Alcatel 5620 Service Aware Manager, Release 3.0 R1 9-27
October 2005 3HE00214 CA



9 —  Discovery manager
Alcatel-ESS-7450 1.0.0 TIMETRA-OAM-TEST-MIB tmnxOamLspPingCtlEntry

Alcatel-ESS-7450 1.0.0 tmnxOamLspTrCtlEntry

Alcatel-ESS-7450 1.0.0 tmnxOamLspTrDSLabelEntry

Alcatel-ESS-7450 1.0.0 tmnxOamLspTrMapEntry

Alcatel-ESS-7450 1.0.0 tmnxOamMacPingCtlEntry

Alcatel-ESS-7450 1.0.0 tmnxOamMacPingHistoryEntry

Alcatel-ESS-7450 1.0.0 tmnxOamMacTrCtlEntry

Alcatel-ESS-7450 1.0.0 tmnxOamMacTrL2MapEntry

Alcatel-ESS-7450 1.0.0 tmnxOamPingCtlEntry

Alcatel-ESS-7450 1.0.0 tmnxOamPingHistoryEntry

Alcatel-ESS-7450 1.0.0 tmnxOamPingProbeFailed

Alcatel-ESS-7450 1.0.0 tmnxOamPingResultsEntry

Alcatel-ESS-7450 1.0.0 tmnxOamPingTestCompleted

Alcatel-ESS-7450 1.0.0 tmnxOamPingTestFailed

Alcatel-ESS-7450 1.0.0 tmnxOamTrCtlEntry

Alcatel-ESS-7450 1.0.0 tmnxOamTrPathChange

Alcatel-ESS-7450 1.0.0 tmnxOamTrProbeHistoryEntry

Alcatel-ESS-7450 1.0.0 tmnxOamTrResultsEntry

Alcatel-ESS-7450 1.0.0 tmnxOamTrTestCompleted

Alcatel-ESS-7450 1.0.0 tmnxOamTrTestFailed

Device name MIB 
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Alcatel-ESS-7450 1.0.0 TIMETRA-OSPF-MIB vRtrOspfAreaEntry

Alcatel-ESS-7450 1.0.0 vRtrOspfAvgSpfRunTime

Alcatel-ESS-7450 1.0.0 vRtrOspfBackBoneRouter

Alcatel-ESS-7450 1.0.0 vRtrOspfBaseRefCost

Alcatel-ESS-7450 1.0.0 vRtrOspfExportPolicy1

Alcatel-ESS-7450 1.0.0 vRtrOspfExportPolicy2

Alcatel-ESS-7450 1.0.0 vRtrOspfExportPolicy3

Alcatel-ESS-7450 1.0.0 vRtrOspfExportPolicy4

Alcatel-ESS-7450 1.0.0 vRtrOspfExportPolicy5

Alcatel-ESS-7450 1.0.0 vRtrOspfExtSpfRunTime

Alcatel-ESS-7450 1.0.0 vRtrOspfExtSpfRuns

Alcatel-ESS-7450 1.0.0 vRtrOspfExternalPreference

Alcatel-ESS-7450 1.0.0 vRtrOspfIfEntry

Alcatel-ESS-7450 1.0.0 vRtrOspfIfMD5KeyEntry

Alcatel-ESS-7450 1.0.0 vRtrOspfInOverflowState

Alcatel-ESS-7450 1.0.0 vRtrOspfIncrementalExtSpfRuns

Alcatel-ESS-7450 1.0.0 vRtrOspfIncrementalInterSpfRuns

Alcatel-ESS-7450 1.0.0 vRtrOspfLastEnabledTime

Alcatel-ESS-7450 1.0.0 vRtrOspfLastExtSpfRunTime

Alcatel-ESS-7450 1.0.0 vRtrOspfLastOverflowEnteredTime

Alcatel-ESS-7450 1.0.0 vRtrOspfLastOverflowExitTime

Alcatel-ESS-7450 1.0.0 vRtrOspfLsaAgingInterval

Alcatel-ESS-7450 1.0.0 vRtrOspfMaxLsaAgingCount

Alcatel-ESS-7450 1.0.0 vRtrOspfMaxSpfRunTime

Alcatel-ESS-7450 1.0.0 vRtrOspfMinSpfRunTime

Alcatel-ESS-7450 1.0.0 vRtrOspfNbrEntry

Alcatel-ESS-7450 1.0.0 vRtrOspfPreference

Alcatel-ESS-7450 1.0.0 vRtrOspfSpfHoldDown

Alcatel-ESS-7450 1.0.0 vRtrOspfSpfSpacing

Alcatel-ESS-7450 1.0.0 vRtrOspfTransmitInterval

Alcatel-ESS-7450 1.0.0 vRtrOspfType11LsaChecksumSum

Alcatel-ESS-7450 1.0.0 TIMETRA-OSPF-MIB continued vRtrOspfType11LsaCount

Alcatel-ESS-7450 1.0.0 vRtrOspfVirtIfEntry

Alcatel-ESS-7450 1.0.0 vRtrOspfVirtIfMD5KeyEntry

Alcatel-ESS-7450 1.0.0 vRtrOspfVirtNbrEntry

Device name MIB 
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Alcatel-ESS-7450 1.0.0 TIMETRA-PORT-MIB tmnxEqPortError

Alcatel-ESS-7450 1.0.0 tmnxEqPortSFPCorrupted

Alcatel-ESS-7450 1.0.0 tmnxEqPortSFPInserted

Alcatel-ESS-7450 1.0.0 tmnxEqPortSFPRemoved

Alcatel-ESS-7450 1.0.0 tmnxEqPortSonetAlarm

Alcatel-ESS-7450 1.0.0 tmnxEqPortSonetAlarmClear

Alcatel-ESS-7450 1.0.0 tmnxEqPortSonetPathAlarm

Alcatel-ESS-7450 1.0.0 tmnxEqPortSonetPathAlarmClear

Alcatel-ESS-7450 1.0.0 tmnxEqPortWrongSFP

Alcatel-ESS-7450 1.0.0 tmnxFRDlcmiEntry

Alcatel-ESS-7450 1.0.0 tmnxPortEntry

Alcatel-ESS-7450 1.0.0 tmnxPortEtherEntry

Alcatel-ESS-7450 1.0.0 tmnxPortIngrMdaQosStatEntry

Alcatel-ESS-7450 1.0.0 tmnxPortToChannelEntry

Alcatel-ESS-7450 1.0.0 tmnxQosPoolAppEntry

Alcatel-ESS-7450 1.0.0 tmnxSonetEntry

Alcatel-ESS-7450 1.0.0 tmnxSonetPathEntry

Alcatel-ESS-7450 1.0.0 TIMETRA-PPP-MIB tmnxPppCpDown

Alcatel-ESS-7450 1.0.0 tmnxPppCpEntry

Alcatel-ESS-7450 1.0.0 tmnxPppCpUp

Alcatel-ESS-7450 1.0.0 tmnxPppEntry

Alcatel-ESS-7450 1.0.0 tmnxPppKeepaliveFailure

Alcatel-ESS-7450 1.0.0 tmnxPppLqmFailure

Alcatel-ESS-7450 1.0.0 tmnxPppNcpDown

Alcatel-ESS-7450 1.0.0 tmnxPppNcpUp

Device name MIB 
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Alcatel-ESS-7450 1.0.0 TIMETRA-QOS-MIB tNetworkEgressFCEntry

Alcatel-ESS-7450 1.0.0 tNetworkIngressDSCPEntry

Alcatel-ESS-7450 1.0.0 tNetworkIngressDot1pEntry

Alcatel-ESS-7450 1.0.0 tNetworkIngressLSPEXPEntry

Alcatel-ESS-7450 1.0.0 tNetworkPolicyEntry

Alcatel-ESS-7450 1.0.0 tNetworkQueueEntry

Alcatel-ESS-7450 1.0.0 tNetworkQueueFCEntry

Alcatel-ESS-7450 1.0.0 tNetworkQueuePolicyEntry

Alcatel-ESS-7450 1.0.0 tSapEgressEntry

Alcatel-ESS-7450 1.0.0 tSapEgressFCEntry

Alcatel-ESS-7450 1.0.0 tSapEgressQueueEntry

Alcatel-ESS-7450 1.0.0 tSapIngressDSCPEntry

Alcatel-ESS-7450 1.0.0 tSapIngressDot1pEntry

Alcatel-ESS-7450 1.0.0 tSapIngressEntry

Alcatel-ESS-7450 1.0.0 tSapIngressFCEntry

Alcatel-ESS-7450 1.0.0 tSapIngressIPCriteriaEntry

Alcatel-ESS-7450 1.0.0 tSapIngressMacCriteriaEntry

Alcatel-ESS-7450 1.0.0 tSapIngressPrecEntry

Alcatel-ESS-7450 1.0.0 tSapIngressQueueEntry

Alcatel-ESS-7450 1.0.0 tSchedulerPolicyEntry

Alcatel-ESS-7450 1.0.0 tSlopePolicyEntry

Alcatel-ESS-7450 1.0.0 tVirtualSchedulerEntry

Alcatel-ESS-7450 1.0.0 TIMETRA-RIP-MIB vRtrRipAuthFailure

Alcatel-ESS-7450 1.0.0 vRtrRipAuthTypeMismatch

Alcatel-ESS-7450 1.0.0 vRtrRipGroupEntry

Alcatel-ESS-7450 1.0.0 vRtrRipIfEntry

Alcatel-ESS-7450 1.0.0 vRtrRipIfStatEntry

Alcatel-ESS-7450 1.0.0 vRtrRipInstanceEntry

Alcatel-ESS-7450 1.0.0 vRtrRipInstanceRestarted

Alcatel-ESS-7450 1.0.0 vRtrRipInstanceShuttingDown
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Alcatel-ESS-7450 1.0.0 TIMETRA-ROUTE-POLICY-MIB tRPAdminPSAcceptActionParamsEn
try

Alcatel-ESS-7450 1.0.0 tRPAdminPSDefaultActionParamsEn
try

Alcatel-ESS-7450 1.0.0 tRPAdminPSFromCriteriaEntry

Alcatel-ESS-7450 1.0.0 tRPAdminPSParamsEntry

Alcatel-ESS-7450 1.0.0 tRPAdminPSToCriteriaEntry

Alcatel-ESS-7450 1.0.0 tRPAdminPolicyStatementEntry

Alcatel-ESS-7450 1.0.0 tRPAdminPrefixListEntry

Alcatel-ESS-7450 1.0.0 TIMETRA-RSVP-MIB vRtrRsvpGeneralEntry

Alcatel-ESS-7450 1.0.0 vRtrRsvpIfEntry

Alcatel-ESS-7450 1.0.0 vRtrRsvpIfNbrStateDown

Alcatel-ESS-7450 1.0.0 vRtrRsvpIfNbrStateUp

Alcatel-ESS-7450 1.0.0 vRtrRsvpIfStatEntry

Alcatel-ESS-7450 1.0.0 vRtrRsvpIfStateChange

Alcatel-ESS-7450 1.0.0 vRtrRsvpSessionEntry

Alcatel-ESS-7450 1.0.0 vRtrRsvpSessionStatEntry

Alcatel-ESS-7450 1.0.0 vRtrRsvpStateChange
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Alcatel-ESS-7450 1.0.0 TIMETRA-SECURITY-MIB tmnxMafEntry

Alcatel-ESS-7450 1.0.0 tmnxMafMatchEntry

Alcatel-ESS-7450 1.0.0 tmnxPasswordAging

Alcatel-ESS-7450 1.0.0 tmnxPasswordAttemptsCount

Alcatel-ESS-7450 1.0.0 tmnxPasswordAttemptsLockoutPerio
d

Alcatel-ESS-7450 1.0.0 tmnxPasswordAttemptsTime

Alcatel-ESS-7450 1.0.0 tmnxPasswordAuthenOrder1

Alcatel-ESS-7450 1.0.0 tmnxPasswordAuthenOrder2

Alcatel-ESS-7450 1.0.0 tmnxPasswordAuthenOrder3

Alcatel-ESS-7450 1.0.0 tmnxPasswordComplexity

Alcatel-ESS-7450 1.0.0 tmnxPasswordMinLength

Alcatel-ESS-7450 1.0.0 tmnxRadiusAccounting

Alcatel-ESS-7450 1.0.0 tmnxRadiusAdminStatus

Alcatel-ESS-7450 1.0.0 tmnxRadiusAuthorization

Alcatel-ESS-7450 1.0.0 tmnxRadiusPort

Alcatel-ESS-7450 1.0.0 tmnxRadiusRetryAttempts

Alcatel-ESS-7450 1.0.0 tmnxRadiusServerEntry

Alcatel-ESS-7450 1.0.0 tmnxRadiusSourceAddress

Alcatel-ESS-7450 1.0.0 tmnxRadiusTimeout

Alcatel-ESS-7450 1.0.0 tmnxTacPlusAccounting

Alcatel-ESS-7450 1.0.0 tmnxTacPlusAcctRecType

Alcatel-ESS-7450 1.0.0 tmnxTacPlusAdminStatus

Alcatel-ESS-7450 1.0.0 tmnxTacPlusAuthorization

Alcatel-ESS-7450 1.0.0 tmnxTacPlusServerEntry

Alcatel-ESS-7450 1.0.0 tmnxTacPlusSingleConnection

Alcatel-ESS-7450 1.0.0 tmnxTacPlusSourceAddress

Alcatel-ESS-7450 1.0.0 tmnxTacPlusTimeout

Alcatel-ESS-7450 1.0.0 tmnxUserEntry

Alcatel-ESS-7450 1.0.0 tmnxUserProfileEntry

Alcatel-ESS-7450 1.0.0 tmnxUserProfileMatchEntry

Device name MIB 
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Alcatel-ESS-7450 1.0.0 TIMETRA-SERV-MIB custInfoEntry

Alcatel-ESS-7450 1.0.0 custMultiServiceSiteEntry

Alcatel-ESS-7450 1.0.0 higherPriorityBridge

Alcatel-ESS-7450 1.0.0 iesIfEntry

Alcatel-ESS-7450 1.0.0 iesIfStatusChanged

Alcatel-ESS-7450 1.0.0 newRootBridge

Alcatel-ESS-7450 1.0.0 newRootVcpState

Alcatel-ESS-7450 1.0.0 receivedTCN

Alcatel-ESS-7450 1.0.0 sapBaseInfoEntry

Alcatel-ESS-7450 1.0.0 sapEncapDot1d

Alcatel-ESS-7450 1.0.0 sapEncapPVST

Alcatel-ESS-7450 1.0.0 sapStatusChanged

Alcatel-ESS-7450 1.0.0 sapTlsInfoEntry

Alcatel-ESS-7450 1.0.0 sdpBindBaseStatsEntry

Alcatel-ESS-7450 1.0.0 sdpBindEntry

Alcatel-ESS-7450 1.0.0 sdpBindStatusChanged

Alcatel-ESS-7450 1.0.0 sdpBindTlsEntry

Alcatel-ESS-7450 1.0.0 sdpInfoEntry

Alcatel-ESS-7450 1.0.0 sdpStatusChanged

Alcatel-ESS-7450 1.0.0 svcBaseInfoEntry

Alcatel-ESS-7450 1.0.0 svcStatusChanged

Alcatel-ESS-7450 1.0.0 svcTlsFdbTableFullAlarmCleared

Alcatel-ESS-7450 1.0.0 svcTlsFdbTableFullAlarmRaised

Alcatel-ESS-7450 1.0.0 svcTlsInfoEntry

Alcatel-ESS-7450 1.0.0 tlsFdbInfoEntry

Alcatel-ESS-7450 1.0.0 topologyChangeSapMajorState

Alcatel-ESS-7450 1.0.0 topologyChangeSapState

Alcatel-ESS-7450 1.0.0 topologyChangeVcpState

Alcatel-ESS-7450 1.0.0 unacknowledgedTCN
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Alcatel-ESS-7450 1.0.0 TIMETRA-SYSTEM-MIB sbiBootConfig

Alcatel-ESS-7450 1.0.0 sbiBootSnmpd

Alcatel-ESS-7450 1.0.0 sbiConfigStatus

Alcatel-ESS-7450 1.0.0 sbiPersist

Alcatel-ESS-7450 1.0.0 sbiPersistStatus

Alcatel-ESS-7450 1.0.0 sbiStandbyIpAddr

Alcatel-ESS-7450 1.0.0 sgiCpuUsage

Alcatel-ESS-7450 1.0.0 sgiMemoryUsed

Alcatel-ESS-7450 1.0.0 ssiSaveConfigFailed

Alcatel-ESS-7450 1.0.0 ssiSaveConfigSucceeded

Alcatel-ESS-7450 1.0.0 ssiSyncBootEnvFailed

Alcatel-ESS-7450 1.0.0 ssiSyncBootEnvOK

Alcatel-ESS-7450 1.0.0 ssiSyncConfigFailed

Alcatel-ESS-7450 1.0.0 ssiSyncConfigOK

Alcatel-ESS-7450 1.0.0 ssiSyncMode

Alcatel-ESS-7450 1.0.0 ssiSyncStatus

Alcatel-ESS-7450 1.0.0 stiDateAndTime

Alcatel-ESS-7450 1.0.0 sysLACPSystemPriority

Alcatel-ESS-7450 1.0.0 tmnxConfigCreate

Alcatel-ESS-7450 1.0.0 tmnxConfigDelete

Alcatel-ESS-7450 1.0.0 tmnxConfigModify

Alcatel-ESS-7450 1.0.0 tmnxModuleMallocFailed

Alcatel-ESS-7450 1.0.0 tmnxSnmpdError

Alcatel-ESS-7450 1.0.0 tmnxStateChange

Alcatel-ESS-7450 1.0.0 tmnxTrapDropped

Alcatel-ESS-7450 1.0.0 TIMETRA-VRTR-MIB vRtrConfEntry

Alcatel-ESS-7450 1.0.0 vRtrIfEntry

Alcatel-ESS-7450 1.0.0 vRtrIpAddrEntry

Alcatel-ESS-7450 1.0.0 vRtrStatEntry

Alcatel-ESS-7450 1.0.0 vRtrStaticRouteEntry

Alcatel-ESS-7450 1.0.0 vRtrSvcIpRangeEntry

Alcatel-ESS-7450 2.0.0 ALCATEL-IEEE8021-PAE-MIB alxDot1xAuthConfigEntry

Alcatel-ESS-7450 2.0.0 alxDot1xRadiusServerEntry

Alcatel-ESS-7450 2.0.0 alxDot1xRadiusServerPlcyEntry
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Alcatel-ESS-7450 2.0.0 ALCATEL-IGMP-SNOOPING-MIB sapIgmpSnpgConfigEntry

Alcatel-ESS-7450 2.0.0 sapIgmpSnpgStaticGrpSrcEntry

Alcatel-ESS-7450 2.0.0 sapIgmpSnpgStatsEntry

Alcatel-ESS-7450 2.0.0 sdpBindIgmpSnpgConfigEntry

Alcatel-ESS-7450 2.0.0 sdpBindIgmpSnpgStatGrpSrcEntry

Alcatel-ESS-7450 2.0.0 sdpBindIgmpSnpgStatsEntry

Alcatel-ESS-7450 2.0.0 tlsIgmpSnpgConfigEntry

Alcatel-ESS-7450 2.0.0 EtherLike-MIB dot3StatsEntry

Alcatel-ESS-7450 2.0.0 FRAME-RELAY-DTE-MIB frDlcmiEntry

Alcatel-ESS-7450 2.0.0 HC-RMON-MIB etherStatsHighCapacityEntry

Alcatel-ESS-7450 2.0.0 mediaIndependentEntry

Alcatel-ESS-7450 2.0.0 IEEE8021-PAE-MIB dot1xAuthConfigEntry

Alcatel-ESS-7450 2.0.0 dot1xAuthDiagEntry

Alcatel-ESS-7450 2.0.0 dot1xAuthSessionStatsEntry

Alcatel-ESS-7450 2.0.0 dot1xAuthStatsEntry

Alcatel-ESS-7450 2.0.0 dot1xPaePortEntry

Alcatel-ESS-7450 2.0.0 dot1xPaeSystemAuthControl

Alcatel-ESS-7450 2.0.0 IEEE8023-LAG-MIB dot3adAggEntry

Alcatel-ESS-7450 2.0.0 dot3adAggPortEntry

Alcatel-ESS-7450 2.0.0 IF-MIB ifEntry

Alcatel-ESS-7450 2.0.0 ifXEntry

Alcatel-ESS-7450 2.0.0 linkDown

Alcatel-ESS-7450 2.0.0 linkUp

Alcatel-ESS-7450 2.0.0 IP-MIB ipNetToMediaEntry

Alcatel-ESS-7450 2.0.0 ISIS-MIB isisAreaAddrEntry

Alcatel-ESS-7450 2.0.0 isisCircEntry

Alcatel-ESS-7450 2.0.0 isisCircLevelEntry

Alcatel-ESS-7450 2.0.0 isisISAdjAreaAddrEntry

Alcatel-ESS-7450 2.0.0 isisISAdjEntry

Alcatel-ESS-7450 2.0.0 isisManAreaAddrEntry

Alcatel-ESS-7450 2.0.0 isisPacketCountEntry

Alcatel-ESS-7450 2.0.0 isisSysEntry
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Alcatel-ESS-7450 2.0.0 MPLS-LSR-MIB mplsInSegmentEntry

Alcatel-ESS-7450 2.0.0 mplsInterfaceConfEntry

Alcatel-ESS-7450 2.0.0 mplsOutSegmentEntry

Alcatel-ESS-7450 2.0.0 mplsXCDown

Alcatel-ESS-7450 2.0.0 mplsXCEntry

Alcatel-ESS-7450 2.0.0 mplsXCUp

Alcatel-ESS-7450 2.0.0 MPLS-TE-MIB mplsTunnelARHopEntry

Alcatel-ESS-7450 2.0.0 mplsTunnelDown

Alcatel-ESS-7450 2.0.0 mplsTunnelEntry

Alcatel-ESS-7450 2.0.0 mplsTunnelHopEntry

Alcatel-ESS-7450 2.0.0 mplsTunnelReoptimized

Alcatel-ESS-7450 2.0.0 mplsTunnelRerouted

Alcatel-ESS-7450 2.0.0 mplsTunnelUp

Alcatel-ESS-7450 2.0.0 OSPF-MIB ospfASBdrRtrStatus

Alcatel-ESS-7450 2.0.0 ospfAdminStat

Alcatel-ESS-7450 2.0.0 ospfAreaAggregateEntry

Alcatel-ESS-7450 2.0.0 ospfAreaBdrRtrStatus

Alcatel-ESS-7450 2.0.0 ospfAreaEntry

Alcatel-ESS-7450 2.0.0 ospfExitOverflowInterval

Alcatel-ESS-7450 2.0.0 ospfExtLsdbLimit

Alcatel-ESS-7450 2.0.0 ospfExternLsaCksumSum

Alcatel-ESS-7450 2.0.0 ospfExternLsaCount

Alcatel-ESS-7450 2.0.0 ospfIfEntry

Alcatel-ESS-7450 2.0.0 ospfIfMetricEntry

Alcatel-ESS-7450 2.0.0 ospfNbrEntry

Alcatel-ESS-7450 2.0.0 ospfOpaqueLsaSupport

Alcatel-ESS-7450 2.0.0 ospfRFC1583Compatibility

Alcatel-ESS-7450 2.0.0 ospfStubAreaEntry

Alcatel-ESS-7450 2.0.0 ospfTrafficEngineeringSupport

Alcatel-ESS-7450 2.0.0 ospfVirtIfEntry

Alcatel-ESS-7450 2.0.0 ospfVirtNbrEntry

Device name MIB 
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Alcatel-ESS-7450 2.0.0 OSPF-TRAP-MIB ospfIfAuthFailure

Alcatel-ESS-7450 2.0.0 ospfIfConfigError

Alcatel-ESS-7450 2.0.0 ospfIfRxBadPacket

Alcatel-ESS-7450 2.0.0 ospfIfStateChange

Alcatel-ESS-7450 2.0.0 ospfLsdbApproachingOverflow

Alcatel-ESS-7450 2.0.0 ospfLsdbOverflow

Alcatel-ESS-7450 2.0.0 ospfNbrStateChange

Alcatel-ESS-7450 2.0.0 ospfNssaTranslatorStatusChange

Alcatel-ESS-7450 2.0.0 ospfTxRetransmit

Alcatel-ESS-7450 2.0.0 ospfVirtIfAuthFailure

Alcatel-ESS-7450 2.0.0 ospfVirtIfConfigError

Alcatel-ESS-7450 2.0.0 ospfVirtIfRxBadPacket

Alcatel-ESS-7450 2.0.0 ospfVirtIfStateChange

Alcatel-ESS-7450 2.0.0 ospfVirtIfTxRetransmit

Alcatel-ESS-7450 2.0.0 ospfVirtNbrStateChange

Alcatel-ESS-7450 2.0.0 RMON-MIB etherStatsEntry

Alcatel-ESS-7450 2.0.0 RSVP-MIB rsvpIfEntry

Alcatel-ESS-7450 2.0.0 rsvpNbrEntry

Alcatel-ESS-7450 2.0.0 SNMP-USER-BASED-SM-MIB usmUserEntry

Alcatel-ESS-7450 2.0.0 SNMP-VIEW-BASED-ACM-MIB vacmAccessEntry

Alcatel-ESS-7450 2.0.0 vacmSecurityToGroupEntry

Alcatel-ESS-7450 2.0.0 SNMPv2-MIB authenticationFailure

Alcatel-ESS-7450 2.0.0 coldStart

Alcatel-ESS-7450 2.0.0 sysDescr

Alcatel-ESS-7450 2.0.0 sysLocation

Alcatel-ESS-7450 2.0.0 sysUpTime

Alcatel-ESS-7450 2.0.0 SONET-MIB sonetFarEndLineCurrentEntry

Alcatel-ESS-7450 2.0.0 sonetFarEndLineIntervalEntry

Alcatel-ESS-7450 2.0.0 sonetFarEndPathCurrentEntry

Alcatel-ESS-7450 2.0.0 sonetFarEndPathIntervalEntry

Alcatel-ESS-7450 2.0.0 sonetLineCurrentEntry

Alcatel-ESS-7450 2.0.0 sonetLineIntervalEntry

Alcatel-ESS-7450 2.0.0 sonetPathCurrentEntry

Alcatel-ESS-7450 2.0.0 sonetPathIntervalEntry

Alcatel-ESS-7450 2.0.0 sonetSectionCurrentEntry

Alcatel-ESS-7450 2.0.0 sonetSectionIntervalEntry
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Alcatel-ESS-7450 2.0.0 TIMETRA-CHASSIS-MIB tSyncIfTimingAdmEntry

Alcatel-ESS-7450 2.0.0 tmnxCardEntry

Alcatel-ESS-7450 2.0.0 tmnxChassisEntry

Alcatel-ESS-7450 2.0.0 tmnxChassisFanEntry

Alcatel-ESS-7450 2.0.0 tmnxChassisPowerSupplyEntry

Alcatel-ESS-7450 2.0.0 tmnxCpmCardEntry

Alcatel-ESS-7450 2.0.0 tmnxCpmFlashEntry

Alcatel-ESS-7450 2.0.0 tmnxEnvTempTooHigh

Alcatel-ESS-7450 2.0.0 tmnxEqCardFailure

Alcatel-ESS-7450 2.0.0 tmnxEqCardInserted

Alcatel-ESS-7450 2.0.0 tmnxEqCardRemoved

Alcatel-ESS-7450 2.0.0 tmnxEqFanFailure

Alcatel-ESS-7450 2.0.0 tmnxEqFlashDataLoss

Alcatel-ESS-7450 2.0.0 tmnxEqFlashDiskFull

Alcatel-ESS-7450 2.0.0 tmnxEqPowerSupplyFailure

Alcatel-ESS-7450 2.0.0 tmnxEqPowerSupplyInserted

Alcatel-ESS-7450 2.0.0 tmnxEqPowerSupplyRemoved

Alcatel-ESS-7450 2.0.0 tmnxEqSyncIfTimingBITSAlarm

Alcatel-ESS-7450 2.0.0 tmnxEqSyncIfTimingBITSAlarmClear

Alcatel-ESS-7450 2.0.0 tmnxEqSyncIfTimingHoldover

Alcatel-ESS-7450 2.0.0 tmnxEqSyncIfTimingHoldoverClear

Alcatel-ESS-7450 2.0.0 tmnxEqSyncIfTimingRef1Alarm

Alcatel-ESS-7450 2.0.0 tmnxEqSyncIfTimingRef1AlarmClear

Alcatel-ESS-7450 2.0.0 tmnxEqSyncIfTimingRef2Alarm

Alcatel-ESS-7450 2.0.0 tmnxEqSyncIfTimingRef2AlarmClear

Alcatel-ESS-7450 2.0.0 tmnxEqWrongCard

Alcatel-ESS-7450 2.0.0 tmnxFabricEntry

Alcatel-ESS-7450 2.0.0 tmnxHwEntry

Alcatel-ESS-7450 2.0.0 tmnxMDAEntry

Alcatel-ESS-7450 2.0.0 tmnxPeBootloaderVersionMismatch

Alcatel-ESS-7450 2.0.0 tmnxPeBootromVersionMismatch

Alcatel-ESS-7450 2.0.0 TIMETRA-CHASSIS-MIB continued tmnxPeFPGAVersionMismatch

Alcatel-ESS-7450 2.0.0 tmnxPeSoftwareLoadFailed

Alcatel-ESS-7450 2.0.0 tmnxPeSoftwareVersionMismatch

Alcatel-ESS-7450 2.0.0 tmnxRedPrimaryCPMFail

Alcatel-ESS-7450 2.0.0 tmnxSyncIfTimingEntry

Device name MIB 
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Alcatel-ESS-7450 2.0.0 TIMETRA-FILTER-MIB tIPFilterEntry

Alcatel-ESS-7450 2.0.0 tIPFilterParamsEntry

Alcatel-ESS-7450 2.0.0 tMacFilterEntry

Alcatel-ESS-7450 2.0.0 tMacFilterParamsEntry

Alcatel-ESS-7450 2.0.0 TIMETRA-ISIS-MIB vRtrIsisAdjacencyChange

Alcatel-ESS-7450 2.0.0 vRtrIsisAreaMismatch

Alcatel-ESS-7450 2.0.0 vRtrIsisAutTypeFail

Alcatel-ESS-7450 2.0.0 vRtrIsisAuthFail

Alcatel-ESS-7450 2.0.0 vRtrIsisEntry

Alcatel-ESS-7450 2.0.0 vRtrIsisISAdjEntry

Alcatel-ESS-7450 2.0.0 vRtrIsisIfEntry

Alcatel-ESS-7450 2.0.0 vRtrIsisIfLevelEntry

Alcatel-ESS-7450 2.0.0 vRtrIsisLevelEntry

Alcatel-ESS-7450 2.0.0 vRtrIsisManualAddressDrops

Alcatel-ESS-7450 2.0.0 vRtrIsisRejectedAdjacency

Alcatel-ESS-7450 2.0.0 vRtrIsisStatsEntry

Alcatel-ESS-7450 2.0.0 TIMETRA-LAG-MIB tLagConfigEntry

Alcatel-ESS-7450 2.0.0 tLagDynamicCostOff

Alcatel-ESS-7450 2.0.0 tLagDynamicCostOn

Alcatel-ESS-7450 2.0.0 tLagOperationEntry

Alcatel-ESS-7450 2.0.0 tLagPortAddFailed

Alcatel-ESS-7450 2.0.0 TIMETRA-LDP-MIB vRtrLdpGeneralEntry

Alcatel-ESS-7450 2.0.0 vRtrLdpHelloAdjEntry

Alcatel-ESS-7450 2.0.0 vRtrLdpIfEntry

Alcatel-ESS-7450 2.0.0 vRtrLdpIfStateChange

Alcatel-ESS-7450 2.0.0 vRtrLdpIfStatsEntry

Alcatel-ESS-7450 2.0.0 vRtrLdpInstanceStateChange

Alcatel-ESS-7450 2.0.0 vRtrLdpPeerParamsEntry

Alcatel-ESS-7450 2.0.0 vRtrLdpSessionEntry

Alcatel-ESS-7450 2.0.0 vRtrLdpSessionStatsEntry

Alcatel-ESS-7450 2.0.0 vRtrLdpStateChange

Alcatel-ESS-7450 2.0.0 vRtrLdpStatsEntry

Alcatel-ESS-7450 2.0.0 TIMETRA-LOG-MIB tmnxLogApEntry

Alcatel-ESS-7450 2.0.0 tmnxLogFileIdEntry

Alcatel-ESS-7450 2.0.0 tmnxLogFileRollover
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Alcatel-ESS-7450 2.0.0 TIMETRA-MPLS-MIB vRtrMplsAdminGroupEntry

Alcatel-ESS-7450 2.0.0 vRtrMplsGeneralEntry

Alcatel-ESS-7450 2.0.0 vRtrMplsGeneralStatEntry

Alcatel-ESS-7450 2.0.0 vRtrMplsIfEntry

Alcatel-ESS-7450 2.0.0 vRtrMplsIfStatEntry

Alcatel-ESS-7450 2.0.0 vRtrMplsIfStateChange

Alcatel-ESS-7450 2.0.0 vRtrMplsLspDown

Alcatel-ESS-7450 2.0.0 vRtrMplsLspEntry

Alcatel-ESS-7450 2.0.0 vRtrMplsLspPathDown

Alcatel-ESS-7450 2.0.0 vRtrMplsLspPathEntry

Alcatel-ESS-7450 2.0.0 vRtrMplsLspPathStatEntry

Alcatel-ESS-7450 2.0.0 vRtrMplsLspPathUp

Alcatel-ESS-7450 2.0.0 vRtrMplsLspStatEntry

Alcatel-ESS-7450 2.0.0 vRtrMplsLspUp

Alcatel-ESS-7450 2.0.0 vRtrMplsStateChange

Alcatel-ESS-7450 2.0.0 vRtrMplsTunnelCHopEntry

Alcatel-ESS-7450 2.0.0 vRtrMplsXCEntry
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Alcatel-ESS-7450 2.0.0 TIMETRA-OAM-TEST-MIB tmnxOamLspPingCtlEntry

Alcatel-ESS-7450 2.0.0 tmnxOamLspTrCtlEntry

Alcatel-ESS-7450 2.0.0 tmnxOamLspTrDSLabelEntry

Alcatel-ESS-7450 2.0.0 tmnxOamLspTrMapEntry

Alcatel-ESS-7450 2.0.0 tmnxOamMacPingCtlEntry

Alcatel-ESS-7450 2.0.0 tmnxOamMacPingHistoryEntry

Alcatel-ESS-7450 2.0.0 tmnxOamMacTrCtlEntry

Alcatel-ESS-7450 2.0.0 tmnxOamMacTrL2MapEntry

Alcatel-ESS-7450 2.0.0 tmnxOamPingCtlEntry

Alcatel-ESS-7450 2.0.0 tmnxOamPingHistoryEntry

Alcatel-ESS-7450 2.0.0 tmnxOamPingProbeFailed

Alcatel-ESS-7450 2.0.0 tmnxOamPingResultsEntry

Alcatel-ESS-7450 2.0.0 tmnxOamPingTestCompleted

Alcatel-ESS-7450 2.0.0 tmnxOamPingTestFailed

Alcatel-ESS-7450 2.0.0 tmnxOamTrCtlEntry

Alcatel-ESS-7450 2.0.0 tmnxOamTrPathChange

Alcatel-ESS-7450 2.0.0 tmnxOamTrProbeHistoryEntry

Alcatel-ESS-7450 2.0.0 tmnxOamTrResultsEntry

Alcatel-ESS-7450 2.0.0 tmnxOamTrTestCompleted

Alcatel-ESS-7450 2.0.0 tmnxOamTrTestFailed

Device name MIB 
version

MIB name MIB entry name

(22 of 92)
9-42 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



9 —  Discovery manager
Alcatel-ESS-7450 2.0.0 TIMETRA-OSPF-MIB vRtrOspfAreaEntry

Alcatel-ESS-7450 2.0.0 vRtrOspfAvgSpfRunTime

Alcatel-ESS-7450 2.0.0 vRtrOspfBackBoneRouter

Alcatel-ESS-7450 2.0.0 vRtrOspfBaseRefCost

Alcatel-ESS-7450 2.0.0 vRtrOspfExportPolicy1

Alcatel-ESS-7450 2.0.0 vRtrOspfExportPolicy2

Alcatel-ESS-7450 2.0.0 vRtrOspfExportPolicy3

Alcatel-ESS-7450 2.0.0 vRtrOspfExportPolicy4

Alcatel-ESS-7450 2.0.0 vRtrOspfExportPolicy5

Alcatel-ESS-7450 2.0.0 vRtrOspfExtSpfRunTime

Alcatel-ESS-7450 2.0.0 vRtrOspfExtSpfRuns

Alcatel-ESS-7450 2.0.0 vRtrOspfExternalPreference

Alcatel-ESS-7450 2.0.0 vRtrOspfIfEntry

Alcatel-ESS-7450 2.0.0 vRtrOspfIfMD5KeyEntry

Alcatel-ESS-7450 2.0.0 vRtrOspfInOverflowState

Alcatel-ESS-7450 2.0.0 vRtrOspfIncrementalExtSpfRuns

Alcatel-ESS-7450 2.0.0 vRtrOspfIncrementalInterSpfRuns

Alcatel-ESS-7450 2.0.0 vRtrOspfLastEnabledTime

Alcatel-ESS-7450 2.0.0 vRtrOspfLastExtSpfRunTime

Alcatel-ESS-7450 2.0.0 vRtrOspfLastOverflowEnteredTime

Alcatel-ESS-7450 2.0.0 vRtrOspfLastOverflowExitTime

Alcatel-ESS-7450 2.0.0 vRtrOspfLsaAgingInterval

Alcatel-ESS-7450 2.0.0 vRtrOspfMaxLsaAgingCount

Alcatel-ESS-7450 2.0.0 vRtrOspfMaxSpfRunTime

Alcatel-ESS-7450 2.0.0 vRtrOspfMinSpfRunTime

Alcatel-ESS-7450 2.0.0 vRtrOspfNbrEntry

Alcatel-ESS-7450 2.0.0 vRtrOspfPreference

Alcatel-ESS-7450 2.0.0 vRtrOspfSpfHoldDown

Alcatel-ESS-7450 2.0.0 vRtrOspfSpfSpacing

Alcatel-ESS-7450 2.0.0 vRtrOspfTransmitInterval

Alcatel-ESS-7450 2.0.0 vRtrOspfType11LsaChecksumSum

Alcatel-ESS-7450 2.0.0 TIMETRA-OSPF-MIB continued vRtrOspfType11LsaCount

Alcatel-ESS-7450 2.0.0 vRtrOspfVirtIfEntry

Alcatel-ESS-7450 2.0.0 vRtrOspfVirtIfMD5KeyEntry

Alcatel-ESS-7450 2.0.0 vRtrOspfVirtNbrEntry
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Alcatel-ESS-7450 2.0.0 TIMETRA-PORT-MIB tmnxEqPortError

Alcatel-ESS-7450 2.0.0 tmnxEqPortSFPCorrupted

Alcatel-ESS-7450 2.0.0 tmnxEqPortSFPInserted

Alcatel-ESS-7450 2.0.0 tmnxEqPortSFPRemoved

Alcatel-ESS-7450 2.0.0 tmnxEqPortSonetAlarm

Alcatel-ESS-7450 2.0.0 tmnxEqPortSonetAlarmClear

Alcatel-ESS-7450 2.0.0 tmnxEqPortSonetPathAlarm

Alcatel-ESS-7450 2.0.0 tmnxEqPortSonetPathAlarmClear

Alcatel-ESS-7450 2.0.0 tmnxEqPortWrongSFP

Alcatel-ESS-7450 2.0.0 tmnxFRDlcmiEntry

Alcatel-ESS-7450 2.0.0 tmnxPortEntry

Alcatel-ESS-7450 2.0.0 tmnxPortEtherEntry

Alcatel-ESS-7450 2.0.0 tmnxPortIngrMdaQosStatEntry

Alcatel-ESS-7450 2.0.0 tmnxPortToChannelEntry

Alcatel-ESS-7450 2.0.0 tmnxQosPoolAppEntry

Alcatel-ESS-7450 2.0.0 tmnxSonetEntry

Alcatel-ESS-7450 2.0.0 tmnxSonetPathEntry

Alcatel-ESS-7450 2.0.0 TIMETRA-PPP-MIB tmnxPppCpDown

Alcatel-ESS-7450 2.0.0 tmnxPppCpEntry

Alcatel-ESS-7450 2.0.0 tmnxPppCpUp

Alcatel-ESS-7450 2.0.0 tmnxPppEntry

Alcatel-ESS-7450 2.0.0 tmnxPppKeepaliveFailure

Alcatel-ESS-7450 2.0.0 tmnxPppLqmFailure

Alcatel-ESS-7450 2.0.0 tmnxPppNcpDown

Alcatel-ESS-7450 2.0.0 tmnxPppNcpUp
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Alcatel-ESS-7450 2.0.0 TIMETRA-QOS-MIB tNetworkEgressFCEntry

Alcatel-ESS-7450 2.0.0 tNetworkIngressDSCPEntry

Alcatel-ESS-7450 2.0.0 tNetworkIngressDot1pEntry

Alcatel-ESS-7450 2.0.0 tNetworkIngressLSPEXPEntry

Alcatel-ESS-7450 2.0.0 tNetworkPolicyEntry

Alcatel-ESS-7450 2.0.0 tNetworkQueueEntry

Alcatel-ESS-7450 2.0.0 tNetworkQueueFCEntry

Alcatel-ESS-7450 2.0.0 tNetworkQueuePolicyEntry

Alcatel-ESS-7450 2.0.0 tSapEgressEntry

Alcatel-ESS-7450 2.0.0 tSapEgressFCEntry

Alcatel-ESS-7450 2.0.0 tSapEgressQueueEntry

Alcatel-ESS-7450 2.0.0 tSapIngressDSCPEntry

Alcatel-ESS-7450 2.0.0 tSapIngressDot1pEntry

Alcatel-ESS-7450 2.0.0 tSapIngressEntry

Alcatel-ESS-7450 2.0.0 tSapIngressFCEntry

Alcatel-ESS-7450 2.0.0 tSapIngressIPCriteriaEntry

Alcatel-ESS-7450 2.0.0 tSapIngressMacCriteriaEntry

Alcatel-ESS-7450 2.0.0 tSapIngressPrecEntry

Alcatel-ESS-7450 2.0.0 tSapIngressQueueEntry

Alcatel-ESS-7450 2.0.0 tSchedulerPolicyEntry

Alcatel-ESS-7450 2.0.0 tSlopePolicyEntry

Alcatel-ESS-7450 2.0.0 tVirtualSchedulerEntry

Alcatel-ESS-7450 2.0.0 TIMETRA-RIP-MIB vRtrRipAuthFailure

Alcatel-ESS-7450 2.0.0 vRtrRipAuthTypeMismatch

Alcatel-ESS-7450 2.0.0 vRtrRipGroupEntry

Alcatel-ESS-7450 2.0.0 vRtrRipIfEntry

Alcatel-ESS-7450 2.0.0 vRtrRipIfStatEntry

Alcatel-ESS-7450 2.0.0 vRtrRipInstanceEntry

Alcatel-ESS-7450 2.0.0 vRtrRipInstanceRestarted

Alcatel-ESS-7450 2.0.0 vRtrRipInstanceShuttingDown
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Alcatel-ESS-7450 2.0.0 TIMETRA-ROUTE-POLICY-MIB tRPAdminPSAcceptActionParamsEn
try

Alcatel-ESS-7450 2.0.0 tRPAdminPSDefaultActionParamsEn
try

Alcatel-ESS-7450 2.0.0 tRPAdminPSFromCriteriaEntry

Alcatel-ESS-7450 2.0.0 tRPAdminPSParamsEntry

Alcatel-ESS-7450 2.0.0 tRPAdminPSToCriteriaEntry

Alcatel-ESS-7450 2.0.0 tRPAdminPolicyStatementEntry

Alcatel-ESS-7450 2.0.0 tRPAdminPrefixListEntry

Alcatel-ESS-7450 2.0.0 TIMETRA-RSVP-MIB vRtrRsvpGeneralEntry

Alcatel-ESS-7450 2.0.0 vRtrRsvpIfEntry

Alcatel-ESS-7450 2.0.0 vRtrRsvpIfNbrStateDown

Alcatel-ESS-7450 2.0.0 vRtrRsvpIfNbrStateUp

Alcatel-ESS-7450 2.0.0 vRtrRsvpIfStatEntry

Alcatel-ESS-7450 2.0.0 vRtrRsvpIfStateChange

Alcatel-ESS-7450 2.0.0 vRtrRsvpSessionEntry

Alcatel-ESS-7450 2.0.0 vRtrRsvpSessionStatEntry

Alcatel-ESS-7450 2.0.0 vRtrRsvpStateChange
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Alcatel-ESS-7450 2.0.0 TIMETRA-SECURITY-MIB tmnxMafEntry

Alcatel-ESS-7450 2.0.0 tmnxMafMatchEntry

Alcatel-ESS-7450 2.0.0 tmnxPasswordAging

Alcatel-ESS-7450 2.0.0 tmnxPasswordAttemptsCount

Alcatel-ESS-7450 2.0.0 tmnxPasswordAttemptsLockoutPerio
d

Alcatel-ESS-7450 2.0.0 tmnxPasswordAttemptsTime

Alcatel-ESS-7450 2.0.0 tmnxPasswordAuthenOrder1

Alcatel-ESS-7450 2.0.0 tmnxPasswordAuthenOrder2

Alcatel-ESS-7450 2.0.0 tmnxPasswordAuthenOrder3

Alcatel-ESS-7450 2.0.0 tmnxPasswordComplexity

Alcatel-ESS-7450 2.0.0 tmnxPasswordMinLength

Alcatel-ESS-7450 2.0.0 tmnxRadiusAccounting

Alcatel-ESS-7450 2.0.0 tmnxRadiusAdminStatus

Alcatel-ESS-7450 2.0.0 tmnxRadiusAuthorization

Alcatel-ESS-7450 2.0.0 tmnxRadiusPort

Alcatel-ESS-7450 2.0.0 tmnxRadiusRetryAttempts

Alcatel-ESS-7450 2.0.0 tmnxRadiusServerEntry

Alcatel-ESS-7450 2.0.0 tmnxRadiusSourceAddress

Alcatel-ESS-7450 2.0.0 tmnxRadiusTimeout

Alcatel-ESS-7450 2.0.0 tmnxTacPlusAccounting

Alcatel-ESS-7450 2.0.0 tmnxTacPlusAcctRecType

Alcatel-ESS-7450 2.0.0 tmnxTacPlusAdminStatus

Alcatel-ESS-7450 2.0.0 tmnxTacPlusAuthorization

Alcatel-ESS-7450 2.0.0 tmnxTacPlusServerEntry

Alcatel-ESS-7450 2.0.0 tmnxTacPlusSingleConnection

Alcatel-ESS-7450 2.0.0 tmnxTacPlusSourceAddress

Alcatel-ESS-7450 2.0.0 tmnxTacPlusTimeout

Alcatel-ESS-7450 2.0.0 tmnxUserEntry

Alcatel-ESS-7450 2.0.0 tmnxUserProfileEntry

Alcatel-ESS-7450 2.0.0 tmnxUserProfileMatchEntry
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Alcatel-ESS-7450 2.0.0 TIMETRA-SERV-MIB custInfoEntry

Alcatel-ESS-7450 2.0.0 custMultiServiceSiteEntry

Alcatel-ESS-7450 2.0.0 higherPriorityBridge

Alcatel-ESS-7450 2.0.0 iesIfEntry

Alcatel-ESS-7450 2.0.0 iesIfStatusChanged

Alcatel-ESS-7450 2.0.0 newRootBridge

Alcatel-ESS-7450 2.0.0 newRootVcpState

Alcatel-ESS-7450 2.0.0 receivedTCN

Alcatel-ESS-7450 2.0.0 sapBaseInfoEntry

Alcatel-ESS-7450 2.0.0 sapEncapDot1d

Alcatel-ESS-7450 2.0.0 sapEncapPVST

Alcatel-ESS-7450 2.0.0 sapStatusChanged

Alcatel-ESS-7450 2.0.0 sapTlsInfoEntry

Alcatel-ESS-7450 2.0.0 sapTlsManagedVlanListEntry

Alcatel-ESS-7450 2.0.0 sdpBindBaseStatsEntry

Alcatel-ESS-7450 2.0.0 sdpBindEntry

Alcatel-ESS-7450 2.0.0 sdpBindStatusChanged

Alcatel-ESS-7450 2.0.0 sdpBindTlsEntry

Alcatel-ESS-7450 2.0.0 sdpInfoEntry

Alcatel-ESS-7450 2.0.0 sdpStatusChanged

Alcatel-ESS-7450 2.0.0 svcBaseInfoEntry

Alcatel-ESS-7450 2.0.0 svcStatusChanged

Alcatel-ESS-7450 2.0.0 svcTlsFdbTableFullAlarmCleared

Alcatel-ESS-7450 2.0.0 svcTlsFdbTableFullAlarmRaised

Alcatel-ESS-7450 2.0.0 svcTlsInfoEntry

Alcatel-ESS-7450 2.0.0 svcTlsMfibTableFullAlarmCleared

Alcatel-ESS-7450 2.0.0 svcTlsMfibTableFullAlarmRaised

Alcatel-ESS-7450 2.0.0 tlsFdbInfoEntry

Alcatel-ESS-7450 2.0.0 tlsMFibGrpSrcStatsEntry

Alcatel-ESS-7450 2.0.0 tlsMFibInfoEntry

Alcatel-ESS-7450 2.0.0 tlsShgInfoEntry

Alcatel-ESS-7450 2.0.0 TIMETRA-SERV-MIB continued topologyChangeSapMajorState

Alcatel-ESS-7450 2.0.0 topologyChangeSapState

Alcatel-ESS-7450 2.0.0 topologyChangeVcpState

Alcatel-ESS-7450 2.0.0 unacknowledgedTCN
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Alcatel-ESS-7450 2.0.0 TIMETRA-SYSTEM-MIB sbiBootConfig

Alcatel-ESS-7450 2.0.0 sbiBootSnmpd

Alcatel-ESS-7450 2.0.0 sbiConfigStatus

Alcatel-ESS-7450 2.0.0 sbiPersist

Alcatel-ESS-7450 2.0.0 sbiPersistStatus

Alcatel-ESS-7450 2.0.0 sbiStandbyIpAddr

Alcatel-ESS-7450 2.0.0 sgiCpuUsage

Alcatel-ESS-7450 2.0.0 sgiMemoryUsed

Alcatel-ESS-7450 2.0.0 ssiSaveConfigFailed

Alcatel-ESS-7450 2.0.0 ssiSaveConfigSucceeded

Alcatel-ESS-7450 2.0.0 ssiSyncBootEnvFailed

Alcatel-ESS-7450 2.0.0 ssiSyncBootEnvOK

Alcatel-ESS-7450 2.0.0 ssiSyncConfigFailed

Alcatel-ESS-7450 2.0.0 ssiSyncConfigOK

Alcatel-ESS-7450 2.0.0 ssiSyncMode

Alcatel-ESS-7450 2.0.0 ssiSyncStatus

Alcatel-ESS-7450 2.0.0 stiDateAndTime

Alcatel-ESS-7450 2.0.0 sysLACPSystemPriority

Alcatel-ESS-7450 2.0.0 tmnxConfigCreate

Alcatel-ESS-7450 2.0.0 tmnxConfigDelete

Alcatel-ESS-7450 2.0.0 tmnxConfigModify

Alcatel-ESS-7450 2.0.0 tmnxModuleMallocFailed

Alcatel-ESS-7450 2.0.0 tmnxSnmpdError

Alcatel-ESS-7450 2.0.0 tmnxStateChange

Alcatel-ESS-7450 2.0.0 tmnxTrapDropped

Alcatel-ESS-7450 2.0.0 TIMETRA-VRTR-MIB vRtrConfEntry

Alcatel-ESS-7450 2.0.0 vRtrIfDHCPEntry

Alcatel-ESS-7450 2.0.0 vRtrIfDHCPRelayStatsEntry

Alcatel-ESS-7450 2.0.0 vRtrIfEntry

Alcatel-ESS-7450 2.0.0 vRtrIpAddrEntry

Alcatel-ESS-7450 2.0.0 vRtrStatEntry

Alcatel-ESS-7450 2.0.0 vRtrStaticRouteEntry

Alcatel-ESS-7450 2.0.0 vRtrSvcIpRangeEntry

Alcatel-ESS-7450 2.0.2 ALCATEL-IEEE8021-PAE-MIB alxDot1xAuthConfigEntry

Alcatel-ESS-7450 2.0.2 alxDot1xRadiusServerEntry

Alcatel-ESS-7450 2.0.2 alxDot1xRadiusServerPlcyEntry
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Alcatel-ESS-7450 2.0.2 ALCATEL-IGMP-SNOOPING-MIB sapIgmpSnpgConfigEntry

Alcatel-ESS-7450 2.0.2 sapIgmpSnpgStaticGrpSrcEntry

Alcatel-ESS-7450 2.0.2 sapIgmpSnpgStatsEntry

Alcatel-ESS-7450 2.0.2 sdpBindIgmpSnpgConfigEntry

Alcatel-ESS-7450 2.0.2 sdpBindIgmpSnpgStatGrpSrcEntry

Alcatel-ESS-7450 2.0.2 sdpBindIgmpSnpgStatsEntry

Alcatel-ESS-7450 2.0.2 tlsIgmpSnpgConfigEntry

Alcatel-ESS-7450 2.0.2 EtherLike-MIB dot3StatsEntry

Alcatel-ESS-7450 2.0.2 FRAME-RELAY-DTE-MIB frDlcmiEntry

Alcatel-ESS-7450 2.0.2 HC-RMON-MIB etherStatsHighCapacityEntry

Alcatel-ESS-7450 2.0.2 mediaIndependentEntry

Alcatel-ESS-7450 2.0.2 IEEE8021-PAE-MIB dot1xAuthConfigEntry

Alcatel-ESS-7450 2.0.2 dot1xAuthDiagEntry

Alcatel-ESS-7450 2.0.2 dot1xAuthSessionStatsEntry

Alcatel-ESS-7450 2.0.2 dot1xAuthStatsEntry

Alcatel-ESS-7450 2.0.2 dot1xPaePortEntry

Alcatel-ESS-7450 2.0.2 dot1xPaeSystemAuthControl

Alcatel-ESS-7450 2.0.2 IEEE8023-LAG-MIB dot3adAggEntry

Alcatel-ESS-7450 2.0.2 dot3adAggPortEntry

Alcatel-ESS-7450 2.0.2 IF-MIB ifEntry

Alcatel-ESS-7450 2.0.2 ifXEntry

Alcatel-ESS-7450 2.0.2 linkDown

Alcatel-ESS-7450 2.0.2 linkUp

Alcatel-ESS-7450 2.0.2 IP-MIB ipNetToMediaEntry

Alcatel-ESS-7450 2.0.2 ISIS-MIB isisAreaAddrEntry

Alcatel-ESS-7450 2.0.2 isisCircEntry

Alcatel-ESS-7450 2.0.2 isisCircLevelEntry

Alcatel-ESS-7450 2.0.2 isisISAdjAreaAddrEntry

Alcatel-ESS-7450 2.0.2 isisISAdjEntry

Alcatel-ESS-7450 2.0.2 isisManAreaAddrEntry

Alcatel-ESS-7450 2.0.2 isisPacketCountEntry

Alcatel-ESS-7450 2.0.2 isisSysEntry
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Alcatel-ESS-7450 2.0.2 MPLS-LSR-MIB mplsInSegmentEntry

Alcatel-ESS-7450 2.0.2 mplsInterfaceConfEntry

Alcatel-ESS-7450 2.0.2 mplsOutSegmentEntry

Alcatel-ESS-7450 2.0.2 mplsXCDown

Alcatel-ESS-7450 2.0.2 mplsXCEntry

Alcatel-ESS-7450 2.0.2 mplsXCUp

Alcatel-ESS-7450 2.0.2 MPLS-TE-MIB mplsTunnelARHopEntry

Alcatel-ESS-7450 2.0.2 mplsTunnelDown

Alcatel-ESS-7450 2.0.2 mplsTunnelEntry

Alcatel-ESS-7450 2.0.2 mplsTunnelHopEntry

Alcatel-ESS-7450 2.0.2 mplsTunnelReoptimized

Alcatel-ESS-7450 2.0.2 mplsTunnelRerouted

Alcatel-ESS-7450 2.0.2 mplsTunnelUp

Alcatel-ESS-7450 2.0.2 OSPF-MIB ospfASBdrRtrStatus

Alcatel-ESS-7450 2.0.2 ospfAdminStat

Alcatel-ESS-7450 2.0.2 ospfAreaAggregateEntry

Alcatel-ESS-7450 2.0.2 ospfAreaBdrRtrStatus

Alcatel-ESS-7450 2.0.2 ospfAreaEntry

Alcatel-ESS-7450 2.0.2 ospfExitOverflowInterval

Alcatel-ESS-7450 2.0.2 ospfExtLsdbLimit

Alcatel-ESS-7450 2.0.2 ospfExternLsaCksumSum

Alcatel-ESS-7450 2.0.2 ospfExternLsaCount

Alcatel-ESS-7450 2.0.2 ospfIfEntry

Alcatel-ESS-7450 2.0.2 ospfIfMetricEntry

Alcatel-ESS-7450 2.0.2 ospfNbrEntry

Alcatel-ESS-7450 2.0.2 ospfOpaqueLsaSupport

Alcatel-ESS-7450 2.0.2 ospfRFC1583Compatibility

Alcatel-ESS-7450 2.0.2 ospfStubAreaEntry

Alcatel-ESS-7450 2.0.2 ospfTrafficEngineeringSupport

Alcatel-ESS-7450 2.0.2 ospfVirtIfEntry

Alcatel-ESS-7450 2.0.2 ospfVirtNbrEntry
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Alcatel-ESS-7450 2.0.2 OSPF-TRAP-MIB ospfIfAuthFailure

Alcatel-ESS-7450 2.0.2 ospfIfConfigError

Alcatel-ESS-7450 2.0.2 ospfIfRxBadPacket

Alcatel-ESS-7450 2.0.2 ospfIfStateChange

Alcatel-ESS-7450 2.0.2 ospfLsdbApproachingOverflow

Alcatel-ESS-7450 2.0.2 ospfLsdbOverflow

Alcatel-ESS-7450 2.0.2 ospfNbrStateChange

Alcatel-ESS-7450 2.0.2 ospfNssaTranslatorStatusChange

Alcatel-ESS-7450 2.0.2 ospfTxRetransmit

Alcatel-ESS-7450 2.0.2 ospfVirtIfAuthFailure

Alcatel-ESS-7450 2.0.2 ospfVirtIfConfigError

Alcatel-ESS-7450 2.0.2 ospfVirtIfRxBadPacket

Alcatel-ESS-7450 2.0.2 ospfVirtIfStateChange

Alcatel-ESS-7450 2.0.2 ospfVirtIfTxRetransmit

Alcatel-ESS-7450 2.0.2 ospfVirtNbrStateChange

Alcatel-ESS-7450 2.0.2 RMON-MIB etherStatsEntry

Alcatel-ESS-7450 2.0.2 RSVP-MIB rsvpIfEntry

Alcatel-ESS-7450 2.0.2 rsvpNbrEntry

Alcatel-ESS-7450 2.0.2 SNMP-USER-BASED-SM-MIB usmUserEntry

Alcatel-ESS-7450 2.0.2 SNMP-VIEW-BASED-ACM-MIB vacmAccessEntry

Alcatel-ESS-7450 2.0.2 vacmSecurityToGroupEntry

Alcatel-ESS-7450 2.0.2 SNMPv2-MIB authenticationFailure

Alcatel-ESS-7450 2.0.2 coldStart

Alcatel-ESS-7450 2.0.2 sysDescr

Alcatel-ESS-7450 2.0.2 sysLocation

Alcatel-ESS-7450 2.0.2 sysUpTime

Alcatel-ESS-7450 2.0.2 SONET-MIB sonetFarEndLineCurrentEntry

Alcatel-ESS-7450 2.0.2 sonetFarEndLineIntervalEntry

Alcatel-ESS-7450 2.0.2 sonetFarEndPathCurrentEntry

Alcatel-ESS-7450 2.0.2 sonetFarEndPathIntervalEntry

Alcatel-ESS-7450 2.0.2 sonetLineCurrentEntry

Alcatel-ESS-7450 2.0.2 sonetLineIntervalEntry

Alcatel-ESS-7450 2.0.2 sonetPathCurrentEntry

Alcatel-ESS-7450 2.0.2 sonetPathIntervalEntry

Alcatel-ESS-7450 2.0.2 sonetSectionCurrentEntry

Alcatel-ESS-7450 2.0.2 sonetSectionIntervalEntry
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Alcatel-ESS-7450 2.0.2 TIMETRA-CHASSIS-MIB tSyncIfTimingAdmEntry

Alcatel-ESS-7450 2.0.2 tmnxCardEntry

Alcatel-ESS-7450 2.0.2 tmnxChassisEntry

Alcatel-ESS-7450 2.0.2 tmnxChassisFanEntry

Alcatel-ESS-7450 2.0.2 tmnxChassisPowerSupplyEntry

Alcatel-ESS-7450 2.0.2 tmnxCpmCardEntry

Alcatel-ESS-7450 2.0.2 tmnxCpmFlashEntry

Alcatel-ESS-7450 2.0.2 tmnxEnvTempTooHigh

Alcatel-ESS-7450 2.0.2 tmnxEqCardFailure

Alcatel-ESS-7450 2.0.2 tmnxEqCardInserted

Alcatel-ESS-7450 2.0.2 tmnxEqCardRemoved

Alcatel-ESS-7450 2.0.2 tmnxEqFanFailure

Alcatel-ESS-7450 2.0.2 tmnxEqFlashDataLoss

Alcatel-ESS-7450 2.0.2 tmnxEqFlashDiskFull

Alcatel-ESS-7450 2.0.2 tmnxEqPowerSupplyFailure

Alcatel-ESS-7450 2.0.2 tmnxEqPowerSupplyInserted

Alcatel-ESS-7450 2.0.2 tmnxEqPowerSupplyRemoved

Alcatel-ESS-7450 2.0.2 tmnxEqSyncIfTimingBITSAlarm

Alcatel-ESS-7450 2.0.2 tmnxEqSyncIfTimingBITSAlarmClear

Alcatel-ESS-7450 2.0.2 tmnxEqSyncIfTimingHoldover

Alcatel-ESS-7450 2.0.2 tmnxEqSyncIfTimingHoldoverClear

Alcatel-ESS-7450 2.0.2 tmnxEqSyncIfTimingRef1Alarm

Alcatel-ESS-7450 2.0.2 tmnxEqSyncIfTimingRef1AlarmClear

Alcatel-ESS-7450 2.0.2 tmnxEqSyncIfTimingRef2Alarm

Alcatel-ESS-7450 2.0.2 tmnxEqSyncIfTimingRef2AlarmClear

Alcatel-ESS-7450 2.0.2 tmnxEqWrongCard

Alcatel-ESS-7450 2.0.2 tmnxFabricEntry

Alcatel-ESS-7450 2.0.2 tmnxHwEntry

Alcatel-ESS-7450 2.0.2 tmnxMDAEntry

Alcatel-ESS-7450 2.0.2 tmnxPeBootloaderVersionMismatch

Alcatel-ESS-7450 2.0.2 tmnxPeBootromVersionMismatch

Alcatel-ESS-7450 2.0.2 TIMETRA-CHASSIS-MIB continued tmnxPeFPGAVersionMismatch

Alcatel-ESS-7450 2.0.2 tmnxPeSoftwareLoadFailed

Alcatel-ESS-7450 2.0.2 tmnxPeSoftwareVersionMismatch

Alcatel-ESS-7450 2.0.2 tmnxRedPrimaryCPMFail

Alcatel-ESS-7450 2.0.2 tmnxSyncIfTimingEntry
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Alcatel-ESS-7450 2.0.2 TIMETRA-FILTER-MIB tIPFilterEntry

Alcatel-ESS-7450 2.0.2 tIPFilterParamsEntry

Alcatel-ESS-7450 2.0.2 tMacFilterEntry

Alcatel-ESS-7450 2.0.2 tMacFilterParamsEntry

Alcatel-ESS-7450 2.0.2 TIMETRA-ISIS-MIB vRtrIsisAdjacencyChange

Alcatel-ESS-7450 2.0.2 vRtrIsisAreaMismatch

Alcatel-ESS-7450 2.0.2 vRtrIsisAutTypeFail

Alcatel-ESS-7450 2.0.2 vRtrIsisAuthFail

Alcatel-ESS-7450 2.0.2 vRtrIsisEntry

Alcatel-ESS-7450 2.0.2 vRtrIsisISAdjEntry

Alcatel-ESS-7450 2.0.2 vRtrIsisIfEntry

Alcatel-ESS-7450 2.0.2 vRtrIsisIfLevelEntry

Alcatel-ESS-7450 2.0.2 vRtrIsisLevelEntry

Alcatel-ESS-7450 2.0.2 vRtrIsisManualAddressDrops

Alcatel-ESS-7450 2.0.2 vRtrIsisStatsEntry

Alcatel-ESS-7450 2.0.2 TIMETRA-LAG-MIB tLagConfigEntry

Alcatel-ESS-7450 2.0.2 tLagDynamicCostOff

Alcatel-ESS-7450 2.0.2 tLagDynamicCostOn

Alcatel-ESS-7450 2.0.2 tLagOperationEntry

Alcatel-ESS-7450 2.0.2 tLagPortAddFailed

Alcatel-ESS-7450 2.0.2 TIMETRA-LDP-MIB vRtrLdpGeneralEntry

Alcatel-ESS-7450 2.0.2 vRtrLdpHelloAdjEntry

Alcatel-ESS-7450 2.0.2 vRtrLdpIfEntry

Alcatel-ESS-7450 2.0.2 vRtrLdpIfStateChange

Alcatel-ESS-7450 2.0.2 vRtrLdpIfStatsEntry

Alcatel-ESS-7450 2.0.2 vRtrLdpInstanceStateChange

Alcatel-ESS-7450 2.0.2 vRtrLdpPeerParamsEntry

Alcatel-ESS-7450 2.0.2 vRtrLdpSessionEntry

Alcatel-ESS-7450 2.0.2 vRtrLdpSessionStatsEntry

Alcatel-ESS-7450 2.0.2 vRtrLdpStateChange

Alcatel-ESS-7450 2.0.2 vRtrLdpStatsEntry

Alcatel-ESS-7450 2.0.2 TIMETRA-LOG-MIB tmnxLogApEntry

Alcatel-ESS-7450 2.0.2 tmnxLogFileIdEntry

Alcatel-ESS-7450 2.0.2 tmnxLogFileRollover
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Alcatel-ESS-7450 2.0.2 TIMETRA-MPLS-MIB vRtrMplsAdminGroupEntry

Alcatel-ESS-7450 2.0.2 vRtrMplsGeneralEntry

Alcatel-ESS-7450 2.0.2 vRtrMplsGeneralStatEntry

Alcatel-ESS-7450 2.0.2 vRtrMplsIfEntry

Alcatel-ESS-7450 2.0.2 vRtrMplsIfStatEntry

Alcatel-ESS-7450 2.0.2 vRtrMplsIfStateChange

Alcatel-ESS-7450 2.0.2 vRtrMplsLspDown

Alcatel-ESS-7450 2.0.2 vRtrMplsLspEntry

Alcatel-ESS-7450 2.0.2 vRtrMplsLspPathDown

Alcatel-ESS-7450 2.0.2 vRtrMplsLspPathEntry

Alcatel-ESS-7450 2.0.2 vRtrMplsLspPathStatEntry

Alcatel-ESS-7450 2.0.2 vRtrMplsLspPathUp

Alcatel-ESS-7450 2.0.2 vRtrMplsLspStatEntry

Alcatel-ESS-7450 2.0.2 vRtrMplsLspUp

Alcatel-ESS-7450 2.0.2 vRtrMplsStateChange

Alcatel-ESS-7450 2.0.2 vRtrMplsTunnelCHopEntry

Alcatel-ESS-7450 2.0.2 vRtrMplsXCEntry
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Alcatel-ESS-7450 2.0.2 TIMETRA-OAM-TEST-MIB tmnxOamLspPingCtlEntry

Alcatel-ESS-7450 2.0.2 tmnxOamLspTrCtlEntry

Alcatel-ESS-7450 2.0.2 tmnxOamLspTrDSLabelEntry

Alcatel-ESS-7450 2.0.2 tmnxOamLspTrMapEntry

Alcatel-ESS-7450 2.0.2 tmnxOamMacPingCtlEntry

Alcatel-ESS-7450 2.0.2 tmnxOamMacPingHistoryEntry

Alcatel-ESS-7450 2.0.2 tmnxOamMacTrCtlEntry

Alcatel-ESS-7450 2.0.2 tmnxOamMacTrL2MapEntry

Alcatel-ESS-7450 2.0.2 tmnxOamPingCtlEntry

Alcatel-ESS-7450 2.0.2 tmnxOamPingHistoryEntry

Alcatel-ESS-7450 2.0.2 tmnxOamPingProbeFailed

Alcatel-ESS-7450 2.0.2 tmnxOamPingResultsEntry

Alcatel-ESS-7450 2.0.2 tmnxOamPingTestCompleted

Alcatel-ESS-7450 2.0.2 tmnxOamPingTestFailed

Alcatel-ESS-7450 2.0.2 tmnxOamTrCtlEntry

Alcatel-ESS-7450 2.0.2 tmnxOamTrPathChange

Alcatel-ESS-7450 2.0.2 tmnxOamTrProbeHistoryEntry

Alcatel-ESS-7450 2.0.2 tmnxOamTrResultsEntry

Alcatel-ESS-7450 2.0.2 tmnxOamTrTestCompleted

Alcatel-ESS-7450 2.0.2 tmnxOamTrTestFailed

Device name MIB 
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Alcatel-ESS-7450 2.0.2 TIMETRA-OSPF-MIB vRtrOspfAreaEntry

Alcatel-ESS-7450 2.0.2 vRtrOspfAvgSpfRunTime

Alcatel-ESS-7450 2.0.2 vRtrOspfBackBoneRouter

Alcatel-ESS-7450 2.0.2 vRtrOspfBaseRefCost

Alcatel-ESS-7450 2.0.2 vRtrOspfExportPolicy1

Alcatel-ESS-7450 2.0.2 vRtrOspfExportPolicy2

Alcatel-ESS-7450 2.0.2 vRtrOspfExportPolicy3

Alcatel-ESS-7450 2.0.2 vRtrOspfExportPolicy4

Alcatel-ESS-7450 2.0.2 vRtrOspfExportPolicy5

Alcatel-ESS-7450 2.0.2 vRtrOspfExtSpfRunTime

Alcatel-ESS-7450 2.0.2 vRtrOspfExtSpfRuns

Alcatel-ESS-7450 2.0.2 vRtrOspfExternalPreference

Alcatel-ESS-7450 2.0.2 vRtrOspfIfEntry

Alcatel-ESS-7450 2.0.2 vRtrOspfIfMD5KeyEntry

Alcatel-ESS-7450 2.0.2 vRtrOspfInOverflowState

Alcatel-ESS-7450 2.0.2 vRtrOspfIncrementalExtSpfRuns

Alcatel-ESS-7450 2.0.2 vRtrOspfIncrementalInterSpfRuns

Alcatel-ESS-7450 2.0.2 vRtrOspfLastEnabledTime

Alcatel-ESS-7450 2.0.2 vRtrOspfLastExtSpfRunTime

Alcatel-ESS-7450 2.0.2 vRtrOspfLastOverflowEnteredTime

Alcatel-ESS-7450 2.0.2 vRtrOspfLastOverflowExitTime

Alcatel-ESS-7450 2.0.2 vRtrOspfLsaAgingInterval

Alcatel-ESS-7450 2.0.2 vRtrOspfMaxLsaAgingCount

Alcatel-ESS-7450 2.0.2 vRtrOspfMaxSpfRunTime

Alcatel-ESS-7450 2.0.2 vRtrOspfMinSpfRunTime

Alcatel-ESS-7450 2.0.2 vRtrOspfNbrEntry

Alcatel-ESS-7450 2.0.2 vRtrOspfPreference

Alcatel-ESS-7450 2.0.2 vRtrOspfSpfHoldDown

Alcatel-ESS-7450 2.0.2 vRtrOspfSpfSpacing

Alcatel-ESS-7450 2.0.2 vRtrOspfTransmitInterval

Alcatel-ESS-7450 2.0.2 vRtrOspfType11LsaChecksumSum

Alcatel-ESS-7450 2.0.2 TIMETRA-OSPF-MIB continued vRtrOspfType11LsaCount

Alcatel-ESS-7450 2.0.2 vRtrOspfVirtIfEntry

Alcatel-ESS-7450 2.0.2 vRtrOspfVirtIfMD5KeyEntry

Alcatel-ESS-7450 2.0.2 vRtrOspfVirtNbrEntry

Device name MIB 
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Alcatel-ESS-7450 2.0.2 TIMETRA-PORT-MIB tmnxEqPortError

Alcatel-ESS-7450 2.0.2 tmnxEqPortSFPCorrupted

Alcatel-ESS-7450 2.0.2 tmnxEqPortSFPInserted

Alcatel-ESS-7450 2.0.2 tmnxEqPortSFPRemoved

Alcatel-ESS-7450 2.0.2 tmnxEqPortSonetAlarm

Alcatel-ESS-7450 2.0.2 tmnxEqPortSonetAlarmClear

Alcatel-ESS-7450 2.0.2 tmnxEqPortSonetPathAlarm

Alcatel-ESS-7450 2.0.2 tmnxEqPortSonetPathAlarmClear

Alcatel-ESS-7450 2.0.2 tmnxEqPortWrongSFP

Alcatel-ESS-7450 2.0.2 tmnxFRDlcmiEntry

Alcatel-ESS-7450 2.0.2 tmnxPortEntry

Alcatel-ESS-7450 2.0.2 tmnxPortEtherEntry

Alcatel-ESS-7450 2.0.2 tmnxPortIngrMdaQosStatEntry

Alcatel-ESS-7450 2.0.2 tmnxPortToChannelEntry

Alcatel-ESS-7450 2.0.2 tmnxQosPoolAppEntry

Alcatel-ESS-7450 2.0.2 tmnxSonetEntry

Alcatel-ESS-7450 2.0.2 tmnxSonetPathEntry

Alcatel-ESS-7450 2.0.2 TIMETRA-PPP-MIB tmnxPppCpDown

Alcatel-ESS-7450 2.0.2 tmnxPppCpEntry

Alcatel-ESS-7450 2.0.2 tmnxPppCpUp

Alcatel-ESS-7450 2.0.2 tmnxPppEntry

Alcatel-ESS-7450 2.0.2 tmnxPppKeepaliveFailure

Alcatel-ESS-7450 2.0.2 tmnxPppLqmFailure

Alcatel-ESS-7450 2.0.2 tmnxPppNcpDown

Alcatel-ESS-7450 2.0.2 tmnxPppNcpUp

Device name MIB 
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Alcatel-ESS-7450 2.0.2 TIMETRA-QOS-MIB tNetworkEgressFCEntry

Alcatel-ESS-7450 2.0.2 tNetworkIngressDSCPEntry

Alcatel-ESS-7450 2.0.2 tNetworkIngressDot1pEntry

Alcatel-ESS-7450 2.0.2 tNetworkIngressLSPEXPEntry

Alcatel-ESS-7450 2.0.2 tNetworkPolicyEntry

Alcatel-ESS-7450 2.0.2 tNetworkQueueEntry

Alcatel-ESS-7450 2.0.2 tNetworkQueueFCEntry

Alcatel-ESS-7450 2.0.2 tNetworkQueuePolicyEntry

Alcatel-ESS-7450 2.0.2 tSapEgressEntry

Alcatel-ESS-7450 2.0.2 tSapEgressFCEntry

Alcatel-ESS-7450 2.0.2 tSapEgressQueueEntry

Alcatel-ESS-7450 2.0.2 tSapIngressDSCPEntry

Alcatel-ESS-7450 2.0.2 tSapIngressDot1pEntry

Alcatel-ESS-7450 2.0.2 tSapIngressEntry

Alcatel-ESS-7450 2.0.2 tSapIngressFCEntry

Alcatel-ESS-7450 2.0.2 tSapIngressIPCriteriaEntry

Alcatel-ESS-7450 2.0.2 tSapIngressMacCriteriaEntry

Alcatel-ESS-7450 2.0.2 tSapIngressPrecEntry

Alcatel-ESS-7450 2.0.2 tSapIngressQueueEntry

Alcatel-ESS-7450 2.0.2 tSchedulerPolicyEntry

Alcatel-ESS-7450 2.0.2 tSlopePolicyEntry

Alcatel-ESS-7450 2.0.2 tVirtualSchedulerEntry

Alcatel-ESS-7450 2.0.2 TIMETRA-RIP-MIB vRtrRipAuthFailure

Alcatel-ESS-7450 2.0.2 vRtrRipAuthTypeMismatch

Alcatel-ESS-7450 2.0.2 vRtrRipGroupEntry

Alcatel-ESS-7450 2.0.2 vRtrRipIfEntry

Alcatel-ESS-7450 2.0.2 vRtrRipIfStatEntry

Alcatel-ESS-7450 2.0.2 vRtrRipInstanceEntry

Alcatel-ESS-7450 2.0.2 vRtrRipInstanceRestarted

Alcatel-ESS-7450 2.0.2 vRtrRipInstanceShuttingDown
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Alcatel-ESS-7450 2.0.2 TIMETRA-ROUTE-POLICY-MIB tRPAdminPSAcceptActionParamsEn
try

Alcatel-ESS-7450 2.0.2 tRPAdminPSDefaultActionParamsEn
try

Alcatel-ESS-7450 2.0.2 tRPAdminPSFromCriteriaEntry

Alcatel-ESS-7450 2.0.2 tRPAdminPSParamsEntry

Alcatel-ESS-7450 2.0.2 tRPAdminPSToCriteriaEntry

Alcatel-ESS-7450 2.0.2 tRPAdminPolicyStatementEntry

Alcatel-ESS-7450 2.0.2 tRPAdminPrefixListEntry

Alcatel-ESS-7450 2.0.2 TIMETRA-RSVP-MIB vRtrRsvpGeneralEntry

Alcatel-ESS-7450 2.0.2 vRtrRsvpIfEntry

Alcatel-ESS-7450 2.0.2 vRtrRsvpIfNbrStateDown

Alcatel-ESS-7450 2.0.2 vRtrRsvpIfNbrStateUp

Alcatel-ESS-7450 2.0.2 vRtrRsvpIfStatEntry

Alcatel-ESS-7450 2.0.2 vRtrRsvpIfStateChange

Alcatel-ESS-7450 2.0.2 vRtrRsvpSessionEntry

Alcatel-ESS-7450 2.0.2 vRtrRsvpSessionStatEntry

Alcatel-ESS-7450 2.0.2 vRtrRsvpStateChange
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Alcatel-ESS-7450 2.0.2 TIMETRA-SECURITY-MIB tmnxMafEntry

Alcatel-ESS-7450 2.0.2 tmnxMafMatchEntry

Alcatel-ESS-7450 2.0.2 tmnxPasswordAging

Alcatel-ESS-7450 2.0.2 tmnxPasswordAttemptsCount

Alcatel-ESS-7450 2.0.2 tmnxPasswordAttemptsLockoutPerio
d

Alcatel-ESS-7450 2.0.2 tmnxPasswordAttemptsTime

Alcatel-ESS-7450 2.0.2 tmnxPasswordAuthenOrder1

Alcatel-ESS-7450 2.0.2 tmnxPasswordAuthenOrder2

Alcatel-ESS-7450 2.0.2 tmnxPasswordAuthenOrder3

Alcatel-ESS-7450 2.0.2 tmnxPasswordComplexity

Alcatel-ESS-7450 2.0.2 tmnxPasswordMinLength

Alcatel-ESS-7450 2.0.2 tmnxRadiusAccounting

Alcatel-ESS-7450 2.0.2 tmnxRadiusAdminStatus

Alcatel-ESS-7450 2.0.2 tmnxRadiusAuthorization

Alcatel-ESS-7450 2.0.2 tmnxRadiusPort

Alcatel-ESS-7450 2.0.2 tmnxRadiusRetryAttempts

Alcatel-ESS-7450 2.0.2 tmnxRadiusServerEntry

Alcatel-ESS-7450 2.0.2 tmnxRadiusSourceAddress

Alcatel-ESS-7450 2.0.2 tmnxRadiusTimeout

Alcatel-ESS-7450 2.0.2 tmnxTacPlusAccounting

Alcatel-ESS-7450 2.0.2 tmnxTacPlusAcctRecType

Alcatel-ESS-7450 2.0.2 tmnxTacPlusAdminStatus

Alcatel-ESS-7450 2.0.2 tmnxTacPlusAuthorization

Alcatel-ESS-7450 2.0.2 tmnxTacPlusServerEntry

Alcatel-ESS-7450 2.0.2 tmnxTacPlusSingleConnection

Alcatel-ESS-7450 2.0.2 tmnxTacPlusSourceAddress

Alcatel-ESS-7450 2.0.2 tmnxTacPlusTimeout

Alcatel-ESS-7450 2.0.2 tmnxUserEntry

Alcatel-ESS-7450 2.0.2 tmnxUserProfileEntry

Alcatel-ESS-7450 2.0.2 tmnxUserProfileMatchEntry

Device name MIB 
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Alcatel-ESS-7450 2.0.2 TIMETRA-SERV-MIB custInfoEntry

Alcatel-ESS-7450 2.0.2 custMultiServiceSiteEntry

Alcatel-ESS-7450 2.0.2 higherPriorityBridge

Alcatel-ESS-7450 2.0.2 iesIfEntry

Alcatel-ESS-7450 2.0.2 iesIfStatusChanged

Alcatel-ESS-7450 2.0.2 newRootBridge

Alcatel-ESS-7450 2.0.2 newRootVcpState

Alcatel-ESS-7450 2.0.2 receivedTCN

Alcatel-ESS-7450 2.0.2 sapBaseInfoEntry

Alcatel-ESS-7450 2.0.2 sapEncapDot1d

Alcatel-ESS-7450 2.0.2 sapEncapPVST

Alcatel-ESS-7450 2.0.2 sapStatusChanged

Alcatel-ESS-7450 2.0.2 sapTlsInfoEntry

Alcatel-ESS-7450 2.0.2 sapTlsManagedVlanListEntry

Alcatel-ESS-7450 2.0.2 sdpBindBaseStatsEntry

Alcatel-ESS-7450 2.0.2 sdpBindEntry

Alcatel-ESS-7450 2.0.2 sdpBindStatusChanged

Alcatel-ESS-7450 2.0.2 sdpBindTlsEntry

Alcatel-ESS-7450 2.0.2 sdpInfoEntry

Alcatel-ESS-7450 2.0.2 sdpStatusChanged

Alcatel-ESS-7450 2.0.2 svcBaseInfoEntry

Alcatel-ESS-7450 2.0.2 svcStatusChanged

Alcatel-ESS-7450 2.0.2 svcTlsFdbTableFullAlarmCleared

Alcatel-ESS-7450 2.0.2 svcTlsFdbTableFullAlarmRaised

Alcatel-ESS-7450 2.0.2 svcTlsInfoEntry

Alcatel-ESS-7450 2.0.2 svcTlsMfibTableFullAlarmCleared

Alcatel-ESS-7450 2.0.2 svcTlsMfibTableFullAlarmRaised

Alcatel-ESS-7450 2.0.2 tlsFdbInfoEntry

Alcatel-ESS-7450 2.0.2 tlsMFibGrpSrcStatsEntry

Alcatel-ESS-7450 2.0.2 tlsMFibInfoEntry

Alcatel-ESS-7450 2.0.2 tlsShgInfoEntry

Alcatel-ESS-7450 2.0.2 TIMETRA-SERV-MIB continued topologyChangeSapMajorState

Alcatel-ESS-7450 2.0.2 topologyChangeSapState

Alcatel-ESS-7450 2.0.2 topologyChangeVcpState

Alcatel-ESS-7450 2.0.2 unacknowledgedTCN

Device name MIB 
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Alcatel-ESS-7450 2.0.2 TIMETRA-SYSTEM-MIB sbiBootConfig

Alcatel-ESS-7450 2.0.2 sbiBootSnmpd

Alcatel-ESS-7450 2.0.2 sbiConfigStatus

Alcatel-ESS-7450 2.0.2 sbiPersist

Alcatel-ESS-7450 2.0.2 sbiPersistStatus

Alcatel-ESS-7450 2.0.2 sbiStandbyIpAddr

Alcatel-ESS-7450 2.0.2 sgiCpuUsage

Alcatel-ESS-7450 2.0.2 sgiMemoryUsed

Alcatel-ESS-7450 2.0.2 ssiSaveConfigFailed

Alcatel-ESS-7450 2.0.2 ssiSaveConfigSucceeded

Alcatel-ESS-7450 2.0.2 ssiSyncBootEnvFailed

Alcatel-ESS-7450 2.0.2 ssiSyncBootEnvOK

Alcatel-ESS-7450 2.0.2 ssiSyncConfigFailed

Alcatel-ESS-7450 2.0.2 ssiSyncConfigOK

Alcatel-ESS-7450 2.0.2 ssiSyncMode

Alcatel-ESS-7450 2.0.2 ssiSyncStatus

Alcatel-ESS-7450 2.0.2 stiDateAndTime

Alcatel-ESS-7450 2.0.2 sysLACPSystemPriority

Alcatel-ESS-7450 2.0.2 tmnxConfigCreate

Alcatel-ESS-7450 2.0.2 tmnxConfigDelete

Alcatel-ESS-7450 2.0.2 tmnxConfigModify

Alcatel-ESS-7450 2.0.2 tmnxModuleMallocFailed

Alcatel-ESS-7450 2.0.2 tmnxSnmpdError

Alcatel-ESS-7450 2.0.2 tmnxStateChange

Alcatel-ESS-7450 2.0.2 tmnxTrapDropped

Alcatel-ESS-7450 2.0.2 TIMETRA-VRTR-MIB vRtrConfEntry

Alcatel-ESS-7450 2.0.2 vRtrIfDHCPEntry

Alcatel-ESS-7450 2.0.2 vRtrIfDHCPRelayStatsEntry

Alcatel-ESS-7450 2.0.2 vRtrIfEntry

Alcatel-ESS-7450 2.0.2 vRtrIpAddrEntry

Alcatel-ESS-7450 2.0.2 vRtrStatEntry

Alcatel-ESS-7450 2.0.2 vRtrStaticRouteEntry

Alcatel-ESS-7450 2.0.2 vRtrSvcIpRangeEntry

Alcatel-SR-7750 2.0.0 BGP4-MIB bgpBackwardTransition

Alcatel-SR-7750 2.0.0 bgpEstablished

Alcatel-SR-7750 2.0.0 bgpPeerEntry

Device name MIB 
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Alcatel-SR-7750 2.0.0 DS1-MIB dsx1CurrentEntry

Alcatel-SR-7750 2.0.0 dsx1FarEndCurrentEntry

Alcatel-SR-7750 2.0.0 dsx1FarEndIntervalEntry

Alcatel-SR-7750 2.0.0 dsx1FarEndTotalEntry

Alcatel-SR-7750 2.0.0 dsx1IntervalEntry

Alcatel-SR-7750 2.0.0 dsx1TotalEntry

Alcatel-SR-7750 2.0.0 DS3-MIB dsx3CurrentEntry

Alcatel-SR-7750 2.0.0 dsx3FarEndCurrentEntry

Alcatel-SR-7750 2.0.0 dsx3FarEndIntervalEntry

Alcatel-SR-7750 2.0.0 dsx3FarEndTotalEntry

Alcatel-SR-7750 2.0.0 dsx3IntervalEntry

Alcatel-SR-7750 2.0.0 dsx3TotalEntry

Alcatel-SR-7750 2.0.0 EtherLike-MIB dot3StatsEntry

Alcatel-SR-7750 2.0.0 FRAME-RELAY-DTE-MIB frDlcmiEntry

Alcatel-SR-7750 2.0.0 HC-RMON-MIB mediaIndependentEntry

Alcatel-SR-7750 2.0.0 IEEE8023-LAG-MIB dot3adAggEntry

Alcatel-SR-7750 2.0.0 dot3adAggPortEntry

Alcatel-SR-7750 2.0.0 IF-MIB ifEntry

Alcatel-SR-7750 2.0.0 ifXEntry

Alcatel-SR-7750 2.0.0 linkDown

Alcatel-SR-7750 2.0.0 linkUp

Alcatel-SR-7750 2.0.0 IP-MIB ipNetToMediaEntry

Alcatel-SR-7750 2.0.0 ISIS-MIB isisAreaAddrEntry

Alcatel-SR-7750 2.0.0 isisCircEntry

Alcatel-SR-7750 2.0.0 isisCircLevelEntry

Alcatel-SR-7750 2.0.0 isisISAdjAreaAddrEntry

Alcatel-SR-7750 2.0.0 isisISAdjEntry

Alcatel-SR-7750 2.0.0 isisManAreaAddrEntry

Alcatel-SR-7750 2.0.0 isisPacketCountEntry

Alcatel-SR-7750 2.0.0 isisSysEntry

Alcatel-SR-7750 2.0.0 MPLS-LSR-MIB mplsInSegmentEntry

Alcatel-SR-7750 2.0.0 mplsInterfaceConfEntry

Alcatel-SR-7750 2.0.0 mplsOutSegmentEntry

Alcatel-SR-7750 2.0.0 mplsXCDown

Alcatel-SR-7750 2.0.0 mplsXCEntry

Alcatel-SR-7750 2.0.0 mplsXCUp
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Alcatel-SR-7750 2.0.0 MPLS-TE-MIB mplsTunnelARHopEntry

Alcatel-SR-7750 2.0.0 mplsTunnelDown

Alcatel-SR-7750 2.0.0 mplsTunnelEntry

Alcatel-SR-7750 2.0.0 mplsTunnelHopEntry

Alcatel-SR-7750 2.0.0 mplsTunnelReoptimized

Alcatel-SR-7750 2.0.0 mplsTunnelRerouted

Alcatel-SR-7750 2.0.0 mplsTunnelUp

Alcatel-SR-7750 2.0.0 OSPF-MIB ospfASBdrRtrStatus

Alcatel-SR-7750 2.0.0 ospfAdminStat

Alcatel-SR-7750 2.0.0 ospfAreaAggregateEntry

Alcatel-SR-7750 2.0.0 ospfAreaBdrRtrStatus

Alcatel-SR-7750 2.0.0 ospfAreaEntry

Alcatel-SR-7750 2.0.0 ospfExitOverflowInterval

Alcatel-SR-7750 2.0.0 ospfExtLsdbLimit

Alcatel-SR-7750 2.0.0 ospfExternLsaCksumSum

Alcatel-SR-7750 2.0.0 ospfExternLsaCount

Alcatel-SR-7750 2.0.0 ospfIfEntry

Alcatel-SR-7750 2.0.0 ospfIfMetricEntry

Alcatel-SR-7750 2.0.0 ospfNbrEntry

Alcatel-SR-7750 2.0.0 ospfOpaqueLsaSupport

Alcatel-SR-7750 2.0.0 ospfRFC1583Compatibility

Alcatel-SR-7750 2.0.0 ospfStubAreaEntry

Alcatel-SR-7750 2.0.0 ospfTrafficEngineeringSupport

Alcatel-SR-7750 2.0.0 ospfVirtIfEntry

Alcatel-SR-7750 2.0.0 ospfVirtNbrEntry
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Alcatel-SR-7750 2.0.0 OSPF-TRAP-MIB ospfIfAuthFailure

Alcatel-SR-7750 2.0.0 ospfIfConfigError

Alcatel-SR-7750 2.0.0 ospfIfRxBadPacket

Alcatel-SR-7750 2.0.0 ospfIfStateChange

Alcatel-SR-7750 2.0.0 ospfLsdbApproachingOverflow

Alcatel-SR-7750 2.0.0 ospfLsdbOverflow

Alcatel-SR-7750 2.0.0 ospfNbrStateChange

Alcatel-SR-7750 2.0.0 ospfNssaTranslatorStatusChange

Alcatel-SR-7750 2.0.0 ospfTxRetransmit

Alcatel-SR-7750 2.0.0 ospfVirtIfAuthFailure

Alcatel-SR-7750 2.0.0 ospfVirtIfConfigError

Alcatel-SR-7750 2.0.0 ospfVirtIfRxBadPacket

Alcatel-SR-7750 2.0.0 ospfVirtIfStateChange

Alcatel-SR-7750 2.0.0 ospfVirtIfTxRetransmit

Alcatel-SR-7750 2.0.0 ospfVirtNbrStateChange

Alcatel-SR-7750 2.0.0 RSVP-MIB rsvpIfEntry

Alcatel-SR-7750 2.0.0 rsvpNbrEntry

Alcatel-SR-7750 2.0.0 SNMP-USER-BASED-SM-MIB usmUserEntry

Alcatel-SR-7750 2.0.0 SNMP-VIEW-BASED-ACM-MIB vacmAccessEntry

Alcatel-SR-7750 2.0.0 vacmSecurityToGroupEntry

Alcatel-SR-7750 2.0.0 SNMPv2-MIB authenticationFailure

Alcatel-SR-7750 2.0.0 coldStart

Alcatel-SR-7750 2.0.0 sysDescr

Alcatel-SR-7750 2.0.0 sysLocation

Alcatel-SR-7750 2.0.0 sysUpTime

Alcatel-SR-7750 2.0.0 SONET-MIB sonetFarEndLineCurrentEntry

Alcatel-SR-7750 2.0.0 sonetFarEndLineIntervalEntry

Alcatel-SR-7750 2.0.0 sonetFarEndPathCurrentEntry

Alcatel-SR-7750 2.0.0 sonetFarEndPathIntervalEntry

Alcatel-SR-7750 2.0.0 sonetLineCurrentEntry

Alcatel-SR-7750 2.0.0 sonetLineIntervalEntry

Alcatel-SR-7750 2.0.0 sonetPathCurrentEntry

Alcatel-SR-7750 2.0.0 sonetPathIntervalEntry

Alcatel-SR-7750 2.0.0 sonetSectionCurrentEntry

Alcatel-SR-7750 2.0.0 sonetSectionIntervalEntry
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Alcatel-SR-7750 2.0.0 TIMETRA-BGP-MIB tBgpConfederationEntry

Alcatel-SR-7750 2.0.0 tBgpInstanceEntry

Alcatel-SR-7750 2.0.0 tBgpMaxPrefix100

Alcatel-SR-7750 2.0.0 tBgpMaxPrefix90

Alcatel-SR-7750 2.0.0 tBgpPeerEntry

Alcatel-SR-7750 2.0.0 tBgpPeerGroupEntry

Alcatel-SR-7750 2.0.0 tBgpPeerOperEntry
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Alcatel-SR-7750 2.0.0 TIMETRA-CHASSIS-MIB tSyncIfTimingAdmEntry

Alcatel-SR-7750 2.0.0 tmnxCardEntry

Alcatel-SR-7750 2.0.0 tmnxChassisEntry

Alcatel-SR-7750 2.0.0 tmnxChassisFanEntry

Alcatel-SR-7750 2.0.0 tmnxChassisPowerSupplyEntry

Alcatel-SR-7750 2.0.0 tmnxCpmCardEntry

Alcatel-SR-7750 2.0.0 tmnxCpmFlashEntry

Alcatel-SR-7750 2.0.0 tmnxEnvTempTooHigh

Alcatel-SR-7750 2.0.0 tmnxEqCardFailure

Alcatel-SR-7750 2.0.0 tmnxEqCardInserted

Alcatel-SR-7750 2.0.0 tmnxEqCardRemoved

Alcatel-SR-7750 2.0.0 tmnxEqFanFailure

Alcatel-SR-7750 2.0.0 tmnxEqFlashDataLoss

Alcatel-SR-7750 2.0.0 tmnxEqFlashDiskFull

Alcatel-SR-7750 2.0.0 tmnxEqPowerSupplyFailure

Alcatel-SR-7750 2.0.0 tmnxEqPowerSupplyInserted

Alcatel-SR-7750 2.0.0 tmnxEqPowerSupplyRemoved

Alcatel-SR-7750 2.0.0 tmnxEqSyncIfTimingBITSAlarm

Alcatel-SR-7750 2.0.0 tmnxEqSyncIfTimingBITSAlarmClear

Alcatel-SR-7750 2.0.0 tmnxEqSyncIfTimingHoldover

Alcatel-SR-7750 2.0.0 tmnxEqSyncIfTimingHoldoverClear

Alcatel-SR-7750 2.0.0 tmnxEqSyncIfTimingRef1Alarm

Alcatel-SR-7750 2.0.0 tmnxEqSyncIfTimingRef1AlarmClear

Alcatel-SR-7750 2.0.0 tmnxEqSyncIfTimingRef2Alarm

Alcatel-SR-7750 2.0.0 tmnxEqSyncIfTimingRef2AlarmClear

Alcatel-SR-7750 2.0.0 tmnxEqWrongCard

Alcatel-SR-7750 2.0.0 tmnxFabricEntry

Alcatel-SR-7750 2.0.0 tmnxHwEntry

Alcatel-SR-7750 2.0.0 tmnxMDAEntry

Alcatel-SR-7750 2.0.0 tmnxPeBootloaderVersionMismatch

Alcatel-SR-7750 2.0.0 tmnxPeBootromVersionMismatch

Alcatel-SR-7750 2.0.0 TIMETRA-CHASSIS-MIB continued tmnxPeFPGAVersionMismatch

Alcatel-SR-7750 2.0.0 tmnxPeSoftwareLoadFailed

Alcatel-SR-7750 2.0.0 tmnxPeSoftwareVersionMismatch

Alcatel-SR-7750 2.0.0 tmnxRedPrimaryCPMFail

Alcatel-SR-7750 2.0.0 tmnxSyncIfTimingEntry
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Alcatel-SR-7750 2.0.0 TIMETRA-FILTER-MIB tIPFilterEntry

Alcatel-SR-7750 2.0.0 tIPFilterParamsEntry

Alcatel-SR-7750 2.0.0 tMacFilterEntry

Alcatel-SR-7750 2.0.0 tMacFilterParamsEntry

Alcatel-SR-7750 2.0.0 TIMETRA-ISIS-MIB vRtrIsisAdjacencyChange

Alcatel-SR-7750 2.0.0 vRtrIsisAreaMismatch

Alcatel-SR-7750 2.0.0 vRtrIsisAutTypeFail

Alcatel-SR-7750 2.0.0 vRtrIsisAuthFail

Alcatel-SR-7750 2.0.0 vRtrIsisEntry

Alcatel-SR-7750 2.0.0 vRtrIsisISAdjEntry

Alcatel-SR-7750 2.0.0 vRtrIsisIfEntry

Alcatel-SR-7750 2.0.0 vRtrIsisIfLevelEntry

Alcatel-SR-7750 2.0.0 vRtrIsisLevelEntry

Alcatel-SR-7750 2.0.0 vRtrIsisManualAddressDrops

Alcatel-SR-7750 2.0.0 vRtrIsisRejectedAdjacency

Alcatel-SR-7750 2.0.0 vRtrIsisStatsEntry

Alcatel-SR-7750 2.0.0 TIMETRA-LAG-MIB tLagConfigEntry

Alcatel-SR-7750 2.0.0 tLagDynamicCostOff

Alcatel-SR-7750 2.0.0 tLagDynamicCostOn

Alcatel-SR-7750 2.0.0 tLagOperationEntry

Alcatel-SR-7750 2.0.0 tLagPortAddFailed

Alcatel-SR-7750 2.0.0 TIMETRA-LDP-MIB vRtrLdpGeneralEntry

Alcatel-SR-7750 2.0.0 vRtrLdpHelloAdjEntry

Alcatel-SR-7750 2.0.0 vRtrLdpIfEntry

Alcatel-SR-7750 2.0.0 vRtrLdpIfStateChange

Alcatel-SR-7750 2.0.0 vRtrLdpIfStatsEntry

Alcatel-SR-7750 2.0.0 vRtrLdpInstanceStateChange

Alcatel-SR-7750 2.0.0 vRtrLdpPeerParamsEntry

Alcatel-SR-7750 2.0.0 vRtrLdpSessionEntry

Alcatel-SR-7750 2.0.0 vRtrLdpSessionStatsEntry

Alcatel-SR-7750 2.0.0 vRtrLdpStateChange

Alcatel-SR-7750 2.0.0 vRtrLdpStatsEntry

Alcatel-SR-7750 2.0.0 TIMETRA-LOG-MIB tmnxLogApEntry

Alcatel-SR-7750 2.0.0 tmnxLogFileIdEntry

Alcatel-SR-7750 2.0.0 tmnxLogFileRollover
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Alcatel-SR-7750 2.0.0 TIMETRA-MPLS-MIB vRtrMplsAdminGroupEntry

Alcatel-SR-7750 2.0.0 vRtrMplsGeneralEntry

Alcatel-SR-7750 2.0.0 vRtrMplsGeneralStatEntry

Alcatel-SR-7750 2.0.0 vRtrMplsIfEntry

Alcatel-SR-7750 2.0.0 vRtrMplsIfStatEntry

Alcatel-SR-7750 2.0.0 vRtrMplsIfStateChange

Alcatel-SR-7750 2.0.0 vRtrMplsLspDown

Alcatel-SR-7750 2.0.0 vRtrMplsLspEntry

Alcatel-SR-7750 2.0.0 vRtrMplsLspPathDown

Alcatel-SR-7750 2.0.0 vRtrMplsLspPathEntry

Alcatel-SR-7750 2.0.0 vRtrMplsLspPathStatEntry

Alcatel-SR-7750 2.0.0 vRtrMplsLspPathUp

Alcatel-SR-7750 2.0.0 vRtrMplsLspStatEntry

Alcatel-SR-7750 2.0.0 vRtrMplsLspUp

Alcatel-SR-7750 2.0.0 vRtrMplsStateChange

Alcatel-SR-7750 2.0.0 vRtrMplsTunnelCHopEntry

Alcatel-SR-7750 2.0.0 vRtrMplsXCEntry
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Alcatel-SR-7750 2.0.0 TIMETRA-OAM-TEST-MIB tmnxOamLspPingCtlEntry

Alcatel-SR-7750 2.0.0 tmnxOamLspTrCtlEntry

Alcatel-SR-7750 2.0.0 tmnxOamLspTrDSLabelEntry

Alcatel-SR-7750 2.0.0 tmnxOamLspTrMapEntry

Alcatel-SR-7750 2.0.0 tmnxOamMacPingCtlEntry

Alcatel-SR-7750 2.0.0 tmnxOamMacPingHistoryEntry

Alcatel-SR-7750 2.0.0 tmnxOamMacTrCtlEntry

Alcatel-SR-7750 2.0.0 tmnxOamMacTrL2MapEntry

Alcatel-SR-7750 2.0.0 tmnxOamPingCtlEntry

Alcatel-SR-7750 2.0.0 tmnxOamPingHistoryEntry

Alcatel-SR-7750 2.0.0 tmnxOamPingProbeFailed

Alcatel-SR-7750 2.0.0 tmnxOamPingResultsEntry

Alcatel-SR-7750 2.0.0 tmnxOamPingTestCompleted

Alcatel-SR-7750 2.0.0 tmnxOamPingTestFailed

Alcatel-SR-7750 2.0.0 tmnxOamTrCtlEntry

Alcatel-SR-7750 2.0.0 tmnxOamTrPathChange

Alcatel-SR-7750 2.0.0 tmnxOamTrProbeHistoryEntry

Alcatel-SR-7750 2.0.0 tmnxOamTrResultsEntry

Alcatel-SR-7750 2.0.0 tmnxOamTrTestCompleted

Alcatel-SR-7750 2.0.0 tmnxOamTrTestFailed

Alcatel-SR-7750 2.0.0 tmnxOamVprnPingCtlEntry

Alcatel-SR-7750 2.0.0 tmnxOamVprnTrCtlEntry

Alcatel-SR-7750 2.0.0 tmnxOamVprnTrL3MapEntry

Alcatel-SR-7750 2.0.0 tmnxOamVprnTrNextHopEntry

Alcatel-SR-7750 2.0.0 tmnxOamVprnTrRTEntry
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Alcatel-SR-7750 2.0.0 TIMETRA-OSPF-MIB vRtrOspfAreaEntry

Alcatel-SR-7750 2.0.0 vRtrOspfAvgSpfRunTime

Alcatel-SR-7750 2.0.0 vRtrOspfBackBoneRouter

Alcatel-SR-7750 2.0.0 vRtrOspfBaseRefCost

Alcatel-SR-7750 2.0.0 vRtrOspfExportPolicy1

Alcatel-SR-7750 2.0.0 vRtrOspfExportPolicy2

Alcatel-SR-7750 2.0.0 vRtrOspfExportPolicy3

Alcatel-SR-7750 2.0.0 vRtrOspfExportPolicy4

Alcatel-SR-7750 2.0.0 vRtrOspfExportPolicy5

Alcatel-SR-7750 2.0.0 vRtrOspfExtSpfRunTime

Alcatel-SR-7750 2.0.0 vRtrOspfExtSpfRuns

Alcatel-SR-7750 2.0.0 vRtrOspfExternalPreference

Alcatel-SR-7750 2.0.0 vRtrOspfIfEntry

Alcatel-SR-7750 2.0.0 vRtrOspfIfMD5KeyEntry

Alcatel-SR-7750 2.0.0 vRtrOspfInOverflowState

Alcatel-SR-7750 2.0.0 vRtrOspfIncrementalExtSpfRuns

Alcatel-SR-7750 2.0.0 vRtrOspfIncrementalInterSpfRuns

Alcatel-SR-7750 2.0.0 vRtrOspfLastEnabledTime

Alcatel-SR-7750 2.0.0 vRtrOspfLastExtSpfRunTime

Alcatel-SR-7750 2.0.0 vRtrOspfLastOverflowEnteredTime

Alcatel-SR-7750 2.0.0 vRtrOspfLastOverflowExitTime

Alcatel-SR-7750 2.0.0 vRtrOspfLsaAgingInterval

Alcatel-SR-7750 2.0.0 vRtrOspfMaxLsaAgingCount

Alcatel-SR-7750 2.0.0 vRtrOspfMaxSpfRunTime

Alcatel-SR-7750 2.0.0 vRtrOspfMinSpfRunTime

Alcatel-SR-7750 2.0.0 vRtrOspfNbrEntry

Alcatel-SR-7750 2.0.0 vRtrOspfPreference

Alcatel-SR-7750 2.0.0 vRtrOspfSpfHoldDown

Alcatel-SR-7750 2.0.0 vRtrOspfSpfSpacing

Alcatel-SR-7750 2.0.0 vRtrOspfTransmitInterval

Alcatel-SR-7750 2.0.0 vRtrOspfType11LsaChecksumSum

Alcatel-SR-7750 2.0.0 TIMETRA-OSPF-MIB continued vRtrOspfType11LsaCount

Alcatel-SR-7750 2.0.0 vRtrOspfVirtIfEntry

Alcatel-SR-7750 2.0.0 vRtrOspfVirtIfMD5KeyEntry

Alcatel-SR-7750 2.0.0 vRtrOspfVirtNbrEntry
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Alcatel-SR-7750 2.0.0 TIMETRA-PORT-MIB tmnxDS0ChanGroupEntry

Alcatel-SR-7750 2.0.0 tmnxDS1Entry

Alcatel-SR-7750 2.0.0 tmnxDS3ChannelEntry

Alcatel-SR-7750 2.0.0 tmnxDS3Entry

Alcatel-SR-7750 2.0.0 tmnxEqPortDS1Alarm

Alcatel-SR-7750 2.0.0 tmnxEqPortDS1AlarmClear

Alcatel-SR-7750 2.0.0 tmnxEqPortDS3Alarm

Alcatel-SR-7750 2.0.0 tmnxEqPortDS3AlarmClear

Alcatel-SR-7750 2.0.0 tmnxEqPortError

Alcatel-SR-7750 2.0.0 tmnxEqPortSFPCorrupted

Alcatel-SR-7750 2.0.0 tmnxEqPortSFPInserted

Alcatel-SR-7750 2.0.0 tmnxEqPortSFPRemoved

Alcatel-SR-7750 2.0.0 tmnxEqPortSonetAlarm

Alcatel-SR-7750 2.0.0 tmnxEqPortSonetAlarmClear

Alcatel-SR-7750 2.0.0 tmnxEqPortSonetPathAlarm

Alcatel-SR-7750 2.0.0 tmnxEqPortSonetPathAlarmClear

Alcatel-SR-7750 2.0.0 tmnxEqPortWrongSFP

Alcatel-SR-7750 2.0.0 tmnxFRDlcmiEntry

Alcatel-SR-7750 2.0.0 tmnxPortEntry

Alcatel-SR-7750 2.0.0 tmnxPortEtherEntry

Alcatel-SR-7750 2.0.0 tmnxPortToChannelEntry

Alcatel-SR-7750 2.0.0 tmnxQosPoolAppEntry

Alcatel-SR-7750 2.0.0 tmnxSonetEntry

Alcatel-SR-7750 2.0.0 tmnxSonetPathEntry

Alcatel-SR-7750 2.0.0 TIMETRA-PPP-MIB tmnxPppCpDown

Alcatel-SR-7750 2.0.0 tmnxPppCpEntry

Alcatel-SR-7750 2.0.0 tmnxPppCpUp

Alcatel-SR-7750 2.0.0 tmnxPppEntry

Alcatel-SR-7750 2.0.0 tmnxPppKeepaliveFailure

Alcatel-SR-7750 2.0.0 tmnxPppLqmFailure

Alcatel-SR-7750 2.0.0 tmnxPppNcpDown

Alcatel-SR-7750 2.0.0 tmnxPppNcpUp
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Alcatel-SR-7750 2.0.0 TIMETRA-QOS-MIB tNetworkEgressFCEntry

Alcatel-SR-7750 2.0.0 tNetworkIngressDSCPEntry

Alcatel-SR-7750 2.0.0 tNetworkIngressDot1pEntry

Alcatel-SR-7750 2.0.0 tNetworkIngressLSPEXPEntry

Alcatel-SR-7750 2.0.0 tNetworkPolicyEntry

Alcatel-SR-7750 2.0.0 tNetworkQueueEntry

Alcatel-SR-7750 2.0.0 tNetworkQueueFCEntry

Alcatel-SR-7750 2.0.0 tNetworkQueuePolicyEntry

Alcatel-SR-7750 2.0.0 tSapEgressEntry

Alcatel-SR-7750 2.0.0 tSapEgressFCEntry

Alcatel-SR-7750 2.0.0 tSapEgressQueueEntry

Alcatel-SR-7750 2.0.0 tSapIngressDSCPEntry

Alcatel-SR-7750 2.0.0 tSapIngressDot1pEntry

Alcatel-SR-7750 2.0.0 tSapIngressEntry

Alcatel-SR-7750 2.0.0 tSapIngressFCEntry

Alcatel-SR-7750 2.0.0 tSapIngressIPCriteriaEntry

Alcatel-SR-7750 2.0.0 tSapIngressMacCriteriaEntry

Alcatel-SR-7750 2.0.0 tSapIngressPrecEntry

Alcatel-SR-7750 2.0.0 tSapIngressQueueEntry

Alcatel-SR-7750 2.0.0 tSchedulerPolicyEntry

Alcatel-SR-7750 2.0.0 tSlopePolicyEntry

Alcatel-SR-7750 2.0.0 tVirtualSchedulerEntry

Alcatel-SR-7750 2.0.0 TIMETRA-RIP-MIB vRtrRipAuthFailure

Alcatel-SR-7750 2.0.0 vRtrRipAuthTypeMismatch

Alcatel-SR-7750 2.0.0 vRtrRipGroupEntry

Alcatel-SR-7750 2.0.0 vRtrRipIfEntry

Alcatel-SR-7750 2.0.0 vRtrRipIfStatEntry

Alcatel-SR-7750 2.0.0 vRtrRipInstanceEntry

Alcatel-SR-7750 2.0.0 vRtrRipInstanceRestarted

Alcatel-SR-7750 2.0.0 vRtrRipInstanceShuttingDown
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Alcatel-SR-7750 2.0.0 TIMETRA-ROUTE-POLICY-MIB tRPAdminASPathEntry

Alcatel-SR-7750 2.0.0 tRPAdminCommunityEntry

Alcatel-SR-7750 2.0.0 tRPAdminDampingEntry

Alcatel-SR-7750 2.0.0 tRPAdminPSAcceptActionParamsEn
try

Alcatel-SR-7750 2.0.0 tRPAdminPSDefaultActionParamsEn
try

Alcatel-SR-7750 2.0.0 tRPAdminPSFromCriteriaEntry

Alcatel-SR-7750 2.0.0 tRPAdminPSParamsEntry

Alcatel-SR-7750 2.0.0 tRPAdminPSToCriteriaEntry

Alcatel-SR-7750 2.0.0 tRPAdminPolicyStatementEntry

Alcatel-SR-7750 2.0.0 tRPAdminPrefixListEntry

Alcatel-SR-7750 2.0.0 TIMETRA-RSVP-MIB vRtrRsvpGeneralEntry

Alcatel-SR-7750 2.0.0 vRtrRsvpIfEntry

Alcatel-SR-7750 2.0.0 vRtrRsvpIfNbrStateDown

Alcatel-SR-7750 2.0.0 vRtrRsvpIfNbrStateUp

Alcatel-SR-7750 2.0.0 vRtrRsvpIfStatEntry

Alcatel-SR-7750 2.0.0 vRtrRsvpIfStateChange

Alcatel-SR-7750 2.0.0 vRtrRsvpSessionEntry

Alcatel-SR-7750 2.0.0 vRtrRsvpSessionStatEntry

Alcatel-SR-7750 2.0.0 vRtrRsvpStateChange
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Alcatel-SR-7750 2.0.0 TIMETRA-SECURITY-MIB tmnxMafEntry

Alcatel-SR-7750 2.0.0 tmnxMafMatchEntry

Alcatel-SR-7750 2.0.0 tmnxPasswordAging

Alcatel-SR-7750 2.0.0 tmnxPasswordAttemptsCount

Alcatel-SR-7750 2.0.0 tmnxPasswordAttemptsLockoutPerio
d

Alcatel-SR-7750 2.0.0 tmnxPasswordAttemptsTime

Alcatel-SR-7750 2.0.0 tmnxPasswordAuthenOrder1

Alcatel-SR-7750 2.0.0 tmnxPasswordAuthenOrder2

Alcatel-SR-7750 2.0.0 tmnxPasswordAuthenOrder3

Alcatel-SR-7750 2.0.0 tmnxPasswordComplexity

Alcatel-SR-7750 2.0.0 tmnxPasswordMinLength

Alcatel-SR-7750 2.0.0 tmnxRadiusAccounting

Alcatel-SR-7750 2.0.0 tmnxRadiusAdminStatus

Alcatel-SR-7750 2.0.0 tmnxRadiusAuthorization

Alcatel-SR-7750 2.0.0 tmnxRadiusPort

Alcatel-SR-7750 2.0.0 tmnxRadiusRetryAttempts

Alcatel-SR-7750 2.0.0 tmnxRadiusServerEntry

Alcatel-SR-7750 2.0.0 tmnxRadiusSourceAddress

Alcatel-SR-7750 2.0.0 tmnxRadiusTimeout

Alcatel-SR-7750 2.0.0 tmnxTacPlusAccounting

Alcatel-SR-7750 2.0.0 tmnxTacPlusAcctRecType

Alcatel-SR-7750 2.0.0 tmnxTacPlusAdminStatus

Alcatel-SR-7750 2.0.0 tmnxTacPlusAuthorization

Alcatel-SR-7750 2.0.0 tmnxTacPlusServerEntry

Alcatel-SR-7750 2.0.0 tmnxTacPlusSingleConnection

Alcatel-SR-7750 2.0.0 tmnxTacPlusSourceAddress

Alcatel-SR-7750 2.0.0 tmnxTacPlusTimeout

Alcatel-SR-7750 2.0.0 tmnxUserEntry

Alcatel-SR-7750 2.0.0 tmnxUserProfileEntry

Alcatel-SR-7750 2.0.0 tmnxUserProfileMatchEntry
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Alcatel-SR-7750 2.0.0 TIMETRA-SERV-MIB custInfoEntry

Alcatel-SR-7750 2.0.0 custMultiServiceSiteEntry

Alcatel-SR-7750 2.0.0 higherPriorityBridge

Alcatel-SR-7750 2.0.0 iesIfEntry

Alcatel-SR-7750 2.0.0 iesIfStatusChanged

Alcatel-SR-7750 2.0.0 newRootBridge

Alcatel-SR-7750 2.0.0 newRootSap

Alcatel-SR-7750 2.0.0 newRootVcpState

Alcatel-SR-7750 2.0.0 receivedTCN

Alcatel-SR-7750 2.0.0 sapBaseInfoEntry

Alcatel-SR-7750 2.0.0 sapEncapDot1d

Alcatel-SR-7750 2.0.0 sapEncapPVST

Alcatel-SR-7750 2.0.0 sapStatusChanged

Alcatel-SR-7750 2.0.0 sapTlsInfoEntry

Alcatel-SR-7750 2.0.0 sdpBindBaseStatsEntry

Alcatel-SR-7750 2.0.0 sdpBindEntry

Alcatel-SR-7750 2.0.0 sdpBindStatusChanged

Alcatel-SR-7750 2.0.0 sdpBindTlsEntry

Alcatel-SR-7750 2.0.0 sdpInfoEntry

Alcatel-SR-7750 2.0.0 sdpStatusChanged

Alcatel-SR-7750 2.0.0 svcBaseInfoEntry

Alcatel-SR-7750 2.0.0 svcStatusChanged

Alcatel-SR-7750 2.0.0 svcTlsFdbTableFullAlarmCleared

Alcatel-SR-7750 2.0.0 svcTlsFdbTableFullAlarmRaised

Alcatel-SR-7750 2.0.0 svcTlsInfoEntry

Alcatel-SR-7750 2.0.0 tlsFdbInfoEntry

Alcatel-SR-7750 2.0.0 topologyChangeSapMajorState

Alcatel-SR-7750 2.0.0 topologyChangeSapState

Alcatel-SR-7750 2.0.0 topologyChangeVcpState

Alcatel-SR-7750 2.0.0 unacknowledgedTCN
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Alcatel-SR-7750 2.0.0 TIMETRA-SYSTEM-MIB sbiBootConfig

Alcatel-SR-7750 2.0.0 sbiBootSnmpd

Alcatel-SR-7750 2.0.0 sbiConfigStatus

Alcatel-SR-7750 2.0.0 sbiPersist

Alcatel-SR-7750 2.0.0 sbiPersistStatus

Alcatel-SR-7750 2.0.0 sbiStandbyIpAddr

Alcatel-SR-7750 2.0.0 sgiCpuUsage

Alcatel-SR-7750 2.0.0 sgiMemoryUsed

Alcatel-SR-7750 2.0.0 ssiSaveConfigFailed

Alcatel-SR-7750 2.0.0 ssiSaveConfigSucceeded

Alcatel-SR-7750 2.0.0 ssiSyncBootEnvFailed

Alcatel-SR-7750 2.0.0 ssiSyncBootEnvOK

Alcatel-SR-7750 2.0.0 ssiSyncConfigFailed

Alcatel-SR-7750 2.0.0 ssiSyncConfigOK

Alcatel-SR-7750 2.0.0 ssiSyncMode

Alcatel-SR-7750 2.0.0 ssiSyncStatus

Alcatel-SR-7750 2.0.0 stiDateAndTime

Alcatel-SR-7750 2.0.0 sysLACPSystemPriority

Alcatel-SR-7750 2.0.0 tmnxConfigCreate

Alcatel-SR-7750 2.0.0 tmnxConfigDelete

Alcatel-SR-7750 2.0.0 tmnxConfigModify

Alcatel-SR-7750 2.0.0 tmnxModuleMallocFailed

Alcatel-SR-7750 2.0.0 tmnxSnmpdError

Alcatel-SR-7750 2.0.0 tmnxStateChange

Alcatel-SR-7750 2.0.0 tmnxTrapDropped

Alcatel-SR-7750 2.0.0 TIMETRA-VRTR-MIB vRtrConfEntry

Alcatel-SR-7750 2.0.0 vRtrIfEntry

Alcatel-SR-7750 2.0.0 vRtrIpAddrEntry

Alcatel-SR-7750 2.0.0 vRtrPolicyEntry

Alcatel-SR-7750 2.0.0 vRtrStatEntry

Alcatel-SR-7750 2.0.0 vRtrStaticRouteEntry

Alcatel-SR-7750 2.0.0 vRtrSvcIpRangeEntry

Alcatel-SR-7750 2.0.10 BGP4-MIB bgpBackwardTransition

Alcatel-SR-7750 2.0.10 bgpEstablished

Alcatel-SR-7750 2.0.10 bgpPeerEntry
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Alcatel-SR-7750 2.0.10 DS1-MIB dsx1CurrentEntry

Alcatel-SR-7750 2.0.10 dsx1FarEndCurrentEntry

Alcatel-SR-7750 2.0.10 dsx1FarEndIntervalEntry

Alcatel-SR-7750 2.0.10 dsx1FarEndTotalEntry

Alcatel-SR-7750 2.0.10 dsx1IntervalEntry

Alcatel-SR-7750 2.0.10 dsx1TotalEntry

Alcatel-SR-7750 2.0.10 DS3-MIB dsx3CurrentEntry

Alcatel-SR-7750 2.0.10 dsx3FarEndCurrentEntry

Alcatel-SR-7750 2.0.10 dsx3FarEndIntervalEntry

Alcatel-SR-7750 2.0.10 dsx3FarEndTotalEntry

Alcatel-SR-7750 2.0.10 dsx3IntervalEntry

Alcatel-SR-7750 2.0.10 dsx3TotalEntry

Alcatel-SR-7750 2.0.10 EtherLike-MIB dot3StatsEntry

Alcatel-SR-7750 2.0.10 FRAME-RELAY-DTE-MIB frDlcmiEntry

Alcatel-SR-7750 2.0.10 HC-RMON-MIB etherStatsHighCapacityEntry

Alcatel-SR-7750 2.0.10 mediaIndependentEntry

Alcatel-SR-7750 2.0.10 IEEE8023-LAG-MIB dot3adAggEntry

Alcatel-SR-7750 2.0.10 dot3adAggPortEntry

Alcatel-SR-7750 2.0.10 IF-MIB ifEntry

Alcatel-SR-7750 2.0.10 ifXEntry

Alcatel-SR-7750 2.0.10 linkDown

Alcatel-SR-7750 2.0.10 linkUp

Alcatel-SR-7750 2.0.10 IP-MIB ipNetToMediaEntry

Alcatel-SR-7750 2.0.10 ISIS-MIB isisAreaAddrEntry

Alcatel-SR-7750 2.0.10 isisCircEntry

Alcatel-SR-7750 2.0.10 isisCircLevelEntry

Alcatel-SR-7750 2.0.10 isisISAdjAreaAddrEntry

Alcatel-SR-7750 2.0.10 isisISAdjEntry

Alcatel-SR-7750 2.0.10 isisManAreaAddrEntry

Alcatel-SR-7750 2.0.10 isisPacketCountEntry

Alcatel-SR-7750 2.0.10 isisSysEntry

Device name MIB 
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Alcatel-SR-7750 2.0.10 MPLS-LSR-MIB mplsInSegmentEntry

Alcatel-SR-7750 2.0.10 mplsInterfaceConfEntry

Alcatel-SR-7750 2.0.10 mplsOutSegmentEntry

Alcatel-SR-7750 2.0.10 mplsXCDown

Alcatel-SR-7750 2.0.10 mplsXCEntry

Alcatel-SR-7750 2.0.10 mplsXCUp

Alcatel-SR-7750 2.0.10 MPLS-TE-MIB mplsTunnelARHopEntry

Alcatel-SR-7750 2.0.10 mplsTunnelDown

Alcatel-SR-7750 2.0.10 mplsTunnelEntry

Alcatel-SR-7750 2.0.10 mplsTunnelHopEntry

Alcatel-SR-7750 2.0.10 mplsTunnelReoptimized

Alcatel-SR-7750 2.0.10 mplsTunnelRerouted

Alcatel-SR-7750 2.0.10 mplsTunnelUp

Alcatel-SR-7750 2.0.10 OSPF-MIB ospfASBdrRtrStatus

Alcatel-SR-7750 2.0.10 ospfAdminStat

Alcatel-SR-7750 2.0.10 ospfAreaAggregateEntry

Alcatel-SR-7750 2.0.10 ospfAreaBdrRtrStatus

Alcatel-SR-7750 2.0.10 ospfAreaEntry

Alcatel-SR-7750 2.0.10 ospfExitOverflowInterval

Alcatel-SR-7750 2.0.10 ospfExtLsdbLimit

Alcatel-SR-7750 2.0.10 ospfExternLsaCksumSum

Alcatel-SR-7750 2.0.10 ospfExternLsaCount

Alcatel-SR-7750 2.0.10 ospfIfEntry

Alcatel-SR-7750 2.0.10 ospfIfMetricEntry

Alcatel-SR-7750 2.0.10 ospfNbrEntry

Alcatel-SR-7750 2.0.10 ospfOpaqueLsaSupport

Alcatel-SR-7750 2.0.10 ospfRFC1583Compatibility

Alcatel-SR-7750 2.0.10 ospfStubAreaEntry

Alcatel-SR-7750 2.0.10 ospfTrafficEngineeringSupport

Alcatel-SR-7750 2.0.10 ospfVirtIfEntry

Alcatel-SR-7750 2.0.10 ospfVirtNbrEntry

Device name MIB 
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Alcatel-SR-7750 2.0.10 OSPF-TRAP-MIB ospfIfAuthFailure

Alcatel-SR-7750 2.0.10 ospfIfConfigError

Alcatel-SR-7750 2.0.10 ospfIfRxBadPacket

Alcatel-SR-7750 2.0.10 ospfIfStateChange

Alcatel-SR-7750 2.0.10 ospfLsdbApproachingOverflow

Alcatel-SR-7750 2.0.10 ospfLsdbOverflow

Alcatel-SR-7750 2.0.10 ospfNbrStateChange

Alcatel-SR-7750 2.0.10 ospfNssaTranslatorStatusChange

Alcatel-SR-7750 2.0.10 ospfTxRetransmit

Alcatel-SR-7750 2.0.10 ospfVirtIfAuthFailure

Alcatel-SR-7750 2.0.10 ospfVirtIfConfigError

Alcatel-SR-7750 2.0.10 ospfVirtIfRxBadPacket

Alcatel-SR-7750 2.0.10 ospfVirtIfStateChange

Alcatel-SR-7750 2.0.10 ospfVirtIfTxRetransmit

Alcatel-SR-7750 2.0.10 ospfVirtNbrStateChange

Alcatel-SR-7750 2.0.10 RMON-MIB etherStatsEntry

Alcatel-SR-7750 2.0.10 RSVP-MIB rsvpIfEntry

Alcatel-SR-7750 2.0.10 rsvpNbrEntry

Alcatel-SR-7750 2.0.10 SNMP-USER-BASED-SM-MIB usmUserEntry

Alcatel-SR-7750 2.0.10 SNMP-VIEW-BASED-ACM-MIB vacmAccessEntry

Alcatel-SR-7750 2.0.10 vacmSecurityToGroupEntry

Alcatel-SR-7750 2.0.10 SNMPv2-MIB authenticationFailure

Alcatel-SR-7750 2.0.10 coldStart

Alcatel-SR-7750 2.0.10 sysDescr

Alcatel-SR-7750 2.0.10 sysLocation

Alcatel-SR-7750 2.0.10 sysUpTime

Alcatel-SR-7750 2.0.10 SONET-MIB sonetFarEndLineCurrentEntry

Alcatel-SR-7750 2.0.10 sonetFarEndLineIntervalEntry

Alcatel-SR-7750 2.0.10 sonetFarEndPathCurrentEntry

Alcatel-SR-7750 2.0.10 sonetFarEndPathIntervalEntry

Alcatel-SR-7750 2.0.10 sonetLineCurrentEntry

Alcatel-SR-7750 2.0.10 sonetLineIntervalEntry

Alcatel-SR-7750 2.0.10 sonetPathCurrentEntry

Alcatel-SR-7750 2.0.10 sonetPathIntervalEntry

Alcatel-SR-7750 2.0.10 sonetSectionCurrentEntry

Alcatel-SR-7750 2.0.10 sonetSectionIntervalEntry
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Alcatel-SR-7750 2.0.10 TIMETRA-BGP-MIB tBgpConfederationEntry

Alcatel-SR-7750 2.0.10 tBgpInstanceEntry

Alcatel-SR-7750 2.0.10 tBgpMaxPrefix100

Alcatel-SR-7750 2.0.10 tBgpMaxPrefix90

Alcatel-SR-7750 2.0.10 tBgpPeerEntry

Alcatel-SR-7750 2.0.10 tBgpPeerGroupEntry

Alcatel-SR-7750 2.0.10 tBgpPeerOperEntry
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Alcatel-SR-7750 2.0.10 TIMETRA-CHASSIS-MIB tSyncIfTimingAdmEntry

Alcatel-SR-7750 2.0.10 tmnxCardEntry

Alcatel-SR-7750 2.0.10 tmnxChassisEntry

Alcatel-SR-7750 2.0.10 tmnxChassisFanEntry

Alcatel-SR-7750 2.0.10 tmnxChassisPowerSupplyEntry

Alcatel-SR-7750 2.0.10 tmnxCpmCardEntry

Alcatel-SR-7750 2.0.10 tmnxCpmFlashEntry

Alcatel-SR-7750 2.0.10 tmnxEnvTempTooHigh

Alcatel-SR-7750 2.0.10 tmnxEqCardFailure

Alcatel-SR-7750 2.0.10 tmnxEqCardInserted

Alcatel-SR-7750 2.0.10 tmnxEqCardRemoved

Alcatel-SR-7750 2.0.10 tmnxEqFanFailure

Alcatel-SR-7750 2.0.10 tmnxEqFlashDataLoss

Alcatel-SR-7750 2.0.10 tmnxEqFlashDiskFull

Alcatel-SR-7750 2.0.10 tmnxEqPowerSupplyFailure

Alcatel-SR-7750 2.0.10 tmnxEqPowerSupplyInserted

Alcatel-SR-7750 2.0.10 tmnxEqPowerSupplyRemoved

Alcatel-SR-7750 2.0.10 tmnxEqSyncIfTimingBITSAlarm

Alcatel-SR-7750 2.0.10 tmnxEqSyncIfTimingBITSAlarmClear

Alcatel-SR-7750 2.0.10 tmnxEqSyncIfTimingHoldover

Alcatel-SR-7750 2.0.10 tmnxEqSyncIfTimingHoldoverClear

Alcatel-SR-7750 2.0.10 tmnxEqSyncIfTimingRef1Alarm

Alcatel-SR-7750 2.0.10 tmnxEqSyncIfTimingRef1AlarmClear

Alcatel-SR-7750 2.0.10 tmnxEqSyncIfTimingRef2Alarm

Alcatel-SR-7750 2.0.10 tmnxEqSyncIfTimingRef2AlarmClear

Alcatel-SR-7750 2.0.10 tmnxEqWrongCard

Alcatel-SR-7750 2.0.10 tmnxFabricEntry

Alcatel-SR-7750 2.0.10 tmnxHwEntry

Alcatel-SR-7750 2.0.10 tmnxMDAEntry

Alcatel-SR-7750 2.0.10 tmnxPeBootloaderVersionMismatch

Alcatel-SR-7750 2.0.10 tmnxPeBootromVersionMismatch

Alcatel-SR-7750 2.0.10 TIMETRA-CHASSIS-MIB continued tmnxPeFPGAVersionMismatch

Alcatel-SR-7750 2.0.10 tmnxPeSoftwareLoadFailed

Alcatel-SR-7750 2.0.10 tmnxPeSoftwareVersionMismatch

Alcatel-SR-7750 2.0.10 tmnxRedPrimaryCPMFail

Alcatel-SR-7750 2.0.10 tmnxSyncIfTimingEntry

Device name MIB 
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Alcatel-SR-7750 2.0.10 TIMETRA-FILTER-MIB tIPFilterEntry

Alcatel-SR-7750 2.0.10 tIPFilterParamsEntry

Alcatel-SR-7750 2.0.10 tMacFilterEntry

Alcatel-SR-7750 2.0.10 tMacFilterParamsEntry

Alcatel-SR-7750 2.0.10 TIMETRA-ISIS-MIB vRtrIsisAdjacencyChange

Alcatel-SR-7750 2.0.10 vRtrIsisAreaMismatch

Alcatel-SR-7750 2.0.10 vRtrIsisAutTypeFail

Alcatel-SR-7750 2.0.10 vRtrIsisAuthFail

Alcatel-SR-7750 2.0.10 vRtrIsisEntry

Alcatel-SR-7750 2.0.10 vRtrIsisISAdjEntry

Alcatel-SR-7750 2.0.10 vRtrIsisIfEntry

Alcatel-SR-7750 2.0.10 vRtrIsisIfLevelEntry

Alcatel-SR-7750 2.0.10 vRtrIsisLevelEntry

Alcatel-SR-7750 2.0.10 vRtrIsisManualAddressDrops

Alcatel-SR-7750 2.0.10 vRtrIsisRejectedAdjacency

Alcatel-SR-7750 2.0.10 vRtrIsisStatsEntry

Alcatel-SR-7750 2.0.10 TIMETRA-LAG-MIB tLagConfigEntry

Alcatel-SR-7750 2.0.10 tLagDynamicCostOff

Alcatel-SR-7750 2.0.10 tLagDynamicCostOn

Alcatel-SR-7750 2.0.10 tLagOperationEntry

Alcatel-SR-7750 2.0.10 tLagPortAddFailed

Alcatel-SR-7750 2.0.10 TIMETRA-LDP-MIB vRtrLdpGeneralEntry

Alcatel-SR-7750 2.0.10 vRtrLdpHelloAdjEntry

Alcatel-SR-7750 2.0.10 vRtrLdpIfEntry

Alcatel-SR-7750 2.0.10 vRtrLdpIfStateChange

Alcatel-SR-7750 2.0.10 vRtrLdpIfStatsEntry

Alcatel-SR-7750 2.0.10 vRtrLdpInstanceStateChange

Alcatel-SR-7750 2.0.10 vRtrLdpPeerParamsEntry

Alcatel-SR-7750 2.0.10 vRtrLdpSessionEntry

Alcatel-SR-7750 2.0.10 vRtrLdpSessionStatsEntry

Alcatel-SR-7750 2.0.10 vRtrLdpStateChange

Alcatel-SR-7750 2.0.10 vRtrLdpStatsEntry

Alcatel-SR-7750 2.0.10 TIMETRA-LOG-MIB tmnxLogApEntry

Alcatel-SR-7750 2.0.10 tmnxLogFileIdEntry

Alcatel-SR-7750 2.0.10 tmnxLogFileRollover
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Alcatel-SR-7750 2.0.10 TIMETRA-MPLS-MIB vRtrMplsAdminGroupEntry

Alcatel-SR-7750 2.0.10 vRtrMplsGeneralEntry

Alcatel-SR-7750 2.0.10 vRtrMplsGeneralStatEntry

Alcatel-SR-7750 2.0.10 vRtrMplsIfEntry

Alcatel-SR-7750 2.0.10 vRtrMplsIfStatEntry

Alcatel-SR-7750 2.0.10 vRtrMplsIfStateChange

Alcatel-SR-7750 2.0.10 vRtrMplsLspDown

Alcatel-SR-7750 2.0.10 vRtrMplsLspEntry

Alcatel-SR-7750 2.0.10 vRtrMplsLspPathDown

Alcatel-SR-7750 2.0.10 vRtrMplsLspPathEntry

Alcatel-SR-7750 2.0.10 vRtrMplsLspPathStatEntry

Alcatel-SR-7750 2.0.10 vRtrMplsLspPathUp

Alcatel-SR-7750 2.0.10 vRtrMplsLspStatEntry

Alcatel-SR-7750 2.0.10 vRtrMplsLspUp

Alcatel-SR-7750 2.0.10 vRtrMplsStateChange

Alcatel-SR-7750 2.0.10 vRtrMplsTunnelCHopEntry

Alcatel-SR-7750 2.0.10 vRtrMplsXCEntry
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Alcatel-SR-7750 2.0.10 TIMETRA-OAM-TEST-MIB tmnxOamLspPingCtlEntry

Alcatel-SR-7750 2.0.10 tmnxOamLspTrCtlEntry

Alcatel-SR-7750 2.0.10 tmnxOamLspTrDSLabelEntry

Alcatel-SR-7750 2.0.10 tmnxOamLspTrMapEntry

Alcatel-SR-7750 2.0.10 tmnxOamMacPingCtlEntry

Alcatel-SR-7750 2.0.10 tmnxOamMacPingHistoryEntry

Alcatel-SR-7750 2.0.10 tmnxOamMacTrCtlEntry

Alcatel-SR-7750 2.0.10 tmnxOamMacTrL2MapEntry

Alcatel-SR-7750 2.0.10 tmnxOamPingCtlEntry

Alcatel-SR-7750 2.0.10 tmnxOamPingHistoryEntry

Alcatel-SR-7750 2.0.10 tmnxOamPingProbeFailed

Alcatel-SR-7750 2.0.10 tmnxOamPingResultsEntry

Alcatel-SR-7750 2.0.10 tmnxOamPingTestCompleted

Alcatel-SR-7750 2.0.10 tmnxOamPingTestFailed

Alcatel-SR-7750 2.0.10 tmnxOamTrCtlEntry

Alcatel-SR-7750 2.0.10 tmnxOamTrPathChange

Alcatel-SR-7750 2.0.10 tmnxOamTrProbeHistoryEntry

Alcatel-SR-7750 2.0.10 tmnxOamTrResultsEntry

Alcatel-SR-7750 2.0.10 tmnxOamTrTestCompleted

Alcatel-SR-7750 2.0.10 tmnxOamTrTestFailed

Alcatel-SR-7750 2.0.10 tmnxOamVprnPingCtlEntry

Alcatel-SR-7750 2.0.10 tmnxOamVprnTrCtlEntry

Alcatel-SR-7750 2.0.10 tmnxOamVprnTrL3MapEntry

Alcatel-SR-7750 2.0.10 tmnxOamVprnTrNextHopEntry

Alcatel-SR-7750 2.0.10 tmnxOamVprnTrRTEntry
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Alcatel-SR-7750 2.0.10 TIMETRA-OSPF-MIB vRtrOspfAreaEntry

Alcatel-SR-7750 2.0.10 vRtrOspfAvgSpfRunTime

Alcatel-SR-7750 2.0.10 vRtrOspfBackBoneRouter

Alcatel-SR-7750 2.0.10 vRtrOspfBaseRefCost

Alcatel-SR-7750 2.0.10 vRtrOspfExportPolicy1

Alcatel-SR-7750 2.0.10 vRtrOspfExportPolicy2

Alcatel-SR-7750 2.0.10 vRtrOspfExportPolicy3

Alcatel-SR-7750 2.0.10 vRtrOspfExportPolicy4

Alcatel-SR-7750 2.0.10 vRtrOspfExportPolicy5

Alcatel-SR-7750 2.0.10 vRtrOspfExtSpfRunTime

Alcatel-SR-7750 2.0.10 vRtrOspfExtSpfRuns

Alcatel-SR-7750 2.0.10 vRtrOspfExternalPreference

Alcatel-SR-7750 2.0.10 vRtrOspfIfEntry

Alcatel-SR-7750 2.0.10 vRtrOspfIfMD5KeyEntry

Alcatel-SR-7750 2.0.10 vRtrOspfInOverflowState

Alcatel-SR-7750 2.0.10 vRtrOspfIncrementalExtSpfRuns

Alcatel-SR-7750 2.0.10 vRtrOspfIncrementalInterSpfRuns

Alcatel-SR-7750 2.0.10 vRtrOspfLastEnabledTime

Alcatel-SR-7750 2.0.10 vRtrOspfLastExtSpfRunTime

Alcatel-SR-7750 2.0.10 vRtrOspfLastOverflowEnteredTime

Alcatel-SR-7750 2.0.10 vRtrOspfLastOverflowExitTime

Alcatel-SR-7750 2.0.10 vRtrOspfLsaAgingInterval

Alcatel-SR-7750 2.0.10 vRtrOspfMaxLsaAgingCount

Alcatel-SR-7750 2.0.10 vRtrOspfMaxSpfRunTime

Alcatel-SR-7750 2.0.10 vRtrOspfMinSpfRunTime

Alcatel-SR-7750 2.0.10 vRtrOspfNbrEntry

Alcatel-SR-7750 2.0.10 vRtrOspfPreference

Alcatel-SR-7750 2.0.10 vRtrOspfSpfHoldDown

Alcatel-SR-7750 2.0.10 vRtrOspfSpfSpacing

Alcatel-SR-7750 2.0.10 vRtrOspfTransmitInterval

Alcatel-SR-7750 2.0.10 vRtrOspfType11LsaChecksumSum

Alcatel-SR-7750 2.0.10 TIMETRA-OSPF-MIB continued vRtrOspfType11LsaCount

Alcatel-SR-7750 2.0.10 vRtrOspfVirtIfEntry

Alcatel-SR-7750 2.0.10 vRtrOspfVirtIfMD5KeyEntry

Alcatel-SR-7750 2.0.10 vRtrOspfVirtNbrEntry
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Alcatel-SR-7750 2.0.10 TIMETRA-PORT-MIB tmnxDS0ChanGroupEntry

Alcatel-SR-7750 2.0.10 tmnxDS1Entry

Alcatel-SR-7750 2.0.10 tmnxDS3ChannelEntry

Alcatel-SR-7750 2.0.10 tmnxDS3Entry

Alcatel-SR-7750 2.0.10 tmnxEqPortDS1Alarm

Alcatel-SR-7750 2.0.10 tmnxEqPortDS1AlarmClear

Alcatel-SR-7750 2.0.10 tmnxEqPortDS3Alarm

Alcatel-SR-7750 2.0.10 tmnxEqPortDS3AlarmClear

Alcatel-SR-7750 2.0.10 tmnxEqPortError

Alcatel-SR-7750 2.0.10 tmnxEqPortSFPCorrupted

Alcatel-SR-7750 2.0.10 tmnxEqPortSFPInserted

Alcatel-SR-7750 2.0.10 tmnxEqPortSFPRemoved

Alcatel-SR-7750 2.0.10 tmnxEqPortSonetAlarm

Alcatel-SR-7750 2.0.10 tmnxEqPortSonetAlarmClear

Alcatel-SR-7750 2.0.10 tmnxEqPortSonetPathAlarm

Alcatel-SR-7750 2.0.10 tmnxEqPortSonetPathAlarmClear

Alcatel-SR-7750 2.0.10 tmnxEqPortWrongSFP

Alcatel-SR-7750 2.0.10 tmnxFRDlcmiEntry

Alcatel-SR-7750 2.0.10 tmnxPortEntry

Alcatel-SR-7750 2.0.10 tmnxPortEtherEntry

Alcatel-SR-7750 2.0.10 tmnxPortToChannelEntry

Alcatel-SR-7750 2.0.10 tmnxQosPoolAppEntry

Alcatel-SR-7750 2.0.10 tmnxSonetEntry

Alcatel-SR-7750 2.0.10 tmnxSonetPathEntry

Alcatel-SR-7750 2.0.10 TIMETRA-PPP-MIB tmnxPppCpDown

Alcatel-SR-7750 2.0.10 tmnxPppCpEntry

Alcatel-SR-7750 2.0.10 tmnxPppCpUp

Alcatel-SR-7750 2.0.10 tmnxPppEntry

Alcatel-SR-7750 2.0.10 tmnxPppKeepaliveFailure

Alcatel-SR-7750 2.0.10 tmnxPppLqmFailure

Alcatel-SR-7750 2.0.10 tmnxPppNcpDown

Alcatel-SR-7750 2.0.10 tmnxPppNcpUp
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Alcatel-SR-7750 2.0.10 TIMETRA-QOS-MIB tNetworkEgressFCEntry

Alcatel-SR-7750 2.0.10 tNetworkIngressDSCPEntry

Alcatel-SR-7750 2.0.10 tNetworkIngressDot1pEntry

Alcatel-SR-7750 2.0.10 tNetworkIngressLSPEXPEntry

Alcatel-SR-7750 2.0.10 tNetworkPolicyEntry

Alcatel-SR-7750 2.0.10 tNetworkQueueEntry

Alcatel-SR-7750 2.0.10 tNetworkQueueFCEntry

Alcatel-SR-7750 2.0.10 tNetworkQueuePolicyEntry

Alcatel-SR-7750 2.0.10 tSapEgressEntry

Alcatel-SR-7750 2.0.10 tSapEgressFCEntry

Alcatel-SR-7750 2.0.10 tSapEgressQueueEntry

Alcatel-SR-7750 2.0.10 tSapIngressDSCPEntry

Alcatel-SR-7750 2.0.10 tSapIngressDot1pEntry

Alcatel-SR-7750 2.0.10 tSapIngressEntry

Alcatel-SR-7750 2.0.10 tSapIngressFCEntry

Alcatel-SR-7750 2.0.10 tSapIngressIPCriteriaEntry

Alcatel-SR-7750 2.0.10 tSapIngressMacCriteriaEntry

Alcatel-SR-7750 2.0.10 tSapIngressPrecEntry

Alcatel-SR-7750 2.0.10 tSapIngressQueueEntry

Alcatel-SR-7750 2.0.10 tSchedulerPolicyEntry

Alcatel-SR-7750 2.0.10 tSlopePolicyEntry

Alcatel-SR-7750 2.0.10 tVirtualSchedulerEntry

Alcatel-SR-7750 2.0.10 TIMETRA-RIP-MIB vRtrRipAuthFailure

Alcatel-SR-7750 2.0.10 vRtrRipAuthTypeMismatch

Alcatel-SR-7750 2.0.10 vRtrRipGroupEntry

Alcatel-SR-7750 2.0.10 vRtrRipIfEntry

Alcatel-SR-7750 2.0.10 vRtrRipIfStatEntry

Alcatel-SR-7750 2.0.10 vRtrRipInstanceEntry

Alcatel-SR-7750 2.0.10 vRtrRipInstanceRestarted

Alcatel-SR-7750 2.0.10 vRtrRipInstanceShuttingDown

Device name MIB 
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Alcatel-SR-7750 2.0.10 TIMETRA-ROUTE-POLICY-MIB tRPAdminASPathEntry

Alcatel-SR-7750 2.0.10 tRPAdminCommunityEntry

Alcatel-SR-7750 2.0.10 tRPAdminDampingEntry

Alcatel-SR-7750 2.0.10 tRPAdminPSAcceptActionParamsEn
try

Alcatel-SR-7750 2.0.10 tRPAdminPSDefaultActionParamsEn
try

Alcatel-SR-7750 2.0.10 tRPAdminPSFromCriteriaEntry

Alcatel-SR-7750 2.0.10 tRPAdminPSParamsEntry

Alcatel-SR-7750 2.0.10 tRPAdminPSToCriteriaEntry

Alcatel-SR-7750 2.0.10 tRPAdminPolicyStatementEntry

Alcatel-SR-7750 2.0.10 tRPAdminPrefixListEntry

Alcatel-SR-7750 2.0.10 TIMETRA-RSVP-MIB vRtrRsvpGeneralEntry

Alcatel-SR-7750 2.0.10 vRtrRsvpIfEntry

Alcatel-SR-7750 2.0.10 vRtrRsvpIfNbrStateDown

Alcatel-SR-7750 2.0.10 vRtrRsvpIfNbrStateUp

Alcatel-SR-7750 2.0.10 vRtrRsvpIfStatEntry

Alcatel-SR-7750 2.0.10 vRtrRsvpIfStateChange

Alcatel-SR-7750 2.0.10 vRtrRsvpSessionEntry

Alcatel-SR-7750 2.0.10 vRtrRsvpSessionStatEntry

Alcatel-SR-7750 2.0.10 vRtrRsvpStateChange
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Alcatel-SR-7750 2.0.10 TIMETRA-SECURITY-MIB tmnxMafEntry

Alcatel-SR-7750 2.0.10 tmnxMafMatchEntry

Alcatel-SR-7750 2.0.10 tmnxPasswordAging

Alcatel-SR-7750 2.0.10 tmnxPasswordAttemptsCount

Alcatel-SR-7750 2.0.10 tmnxPasswordAttemptsLockoutPerio
d

Alcatel-SR-7750 2.0.10 tmnxPasswordAttemptsTime

Alcatel-SR-7750 2.0.10 tmnxPasswordAuthenOrder1

Alcatel-SR-7750 2.0.10 tmnxPasswordAuthenOrder2

Alcatel-SR-7750 2.0.10 tmnxPasswordAuthenOrder3

Alcatel-SR-7750 2.0.10 tmnxPasswordComplexity

Alcatel-SR-7750 2.0.10 tmnxPasswordMinLength

Alcatel-SR-7750 2.0.10 tmnxRadiusAccounting

Alcatel-SR-7750 2.0.10 tmnxRadiusAdminStatus

Alcatel-SR-7750 2.0.10 tmnxRadiusAuthorization

Alcatel-SR-7750 2.0.10 tmnxRadiusPort

Alcatel-SR-7750 2.0.10 tmnxRadiusRetryAttempts

Alcatel-SR-7750 2.0.10 tmnxRadiusServerEntry

Alcatel-SR-7750 2.0.10 tmnxRadiusSourceAddress

Alcatel-SR-7750 2.0.10 tmnxRadiusTimeout

Alcatel-SR-7750 2.0.10 tmnxTacPlusAccounting

Alcatel-SR-7750 2.0.10 tmnxTacPlusAcctRecType

Alcatel-SR-7750 2.0.10 tmnxTacPlusAdminStatus

Alcatel-SR-7750 2.0.10 tmnxTacPlusAuthorization

Alcatel-SR-7750 2.0.10 tmnxTacPlusServerEntry

Alcatel-SR-7750 2.0.10 tmnxTacPlusSingleConnection

Alcatel-SR-7750 2.0.10 tmnxTacPlusSourceAddress

Alcatel-SR-7750 2.0.10 tmnxTacPlusTimeout

Alcatel-SR-7750 2.0.10 tmnxUserEntry

Alcatel-SR-7750 2.0.10 tmnxUserProfileEntry

Alcatel-SR-7750 2.0.10 tmnxUserProfileMatchEntry
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Alcatel-SR-7750 2.0.10 TIMETRA-SERV-MIB custInfoEntry

Alcatel-SR-7750 2.0.10 custMultiServiceSiteEntry

Alcatel-SR-7750 2.0.10 higherPriorityBridge

Alcatel-SR-7750 2.0.10 iesIfEntry

Alcatel-SR-7750 2.0.10 iesIfStatusChanged

Alcatel-SR-7750 2.0.10 newRootBridge

Alcatel-SR-7750 2.0.10 newRootSap

Alcatel-SR-7750 2.0.10 newRootVcpState

Alcatel-SR-7750 2.0.10 receivedTCN

Alcatel-SR-7750 2.0.10 sapBaseInfoEntry

Alcatel-SR-7750 2.0.10 sapEncapDot1d

Alcatel-SR-7750 2.0.10 sapEncapPVST

Alcatel-SR-7750 2.0.10 sapStatusChanged

Alcatel-SR-7750 2.0.10 sapTlsInfoEntry

Alcatel-SR-7750 2.0.10 sdpBindBaseStatsEntry

Alcatel-SR-7750 2.0.10 sdpBindEntry

Alcatel-SR-7750 2.0.10 sdpBindStatusChanged

Alcatel-SR-7750 2.0.10 sdpBindTlsEntry

Alcatel-SR-7750 2.0.10 sdpInfoEntry

Alcatel-SR-7750 2.0.10 sdpStatusChanged

Alcatel-SR-7750 2.0.10 svcBaseInfoEntry

Alcatel-SR-7750 2.0.10 svcStatusChanged

Alcatel-SR-7750 2.0.10 svcTlsFdbTableFullAlarmCleared

Alcatel-SR-7750 2.0.10 svcTlsFdbTableFullAlarmRaised

Alcatel-SR-7750 2.0.10 svcTlsInfoEntry

Alcatel-SR-7750 2.0.10 tlsFdbInfoEntry

Alcatel-SR-7750 2.0.10 topologyChangeSapMajorState

Alcatel-SR-7750 2.0.10 topologyChangeSapState

Alcatel-SR-7750 2.0.10 topologyChangeVcpState

Alcatel-SR-7750 2.0.10 unacknowledgedTCN
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Alcatel-SR-7750 2.0.10 TIMETRA-SYSTEM-MIB sbiBootConfig

Alcatel-SR-7750 2.0.10 sbiBootSnmpd

Alcatel-SR-7750 2.0.10 sbiConfigStatus

Alcatel-SR-7750 2.0.10 sbiPersist

Alcatel-SR-7750 2.0.10 sbiPersistStatus

Alcatel-SR-7750 2.0.10 sbiStandbyIpAddr

Alcatel-SR-7750 2.0.10 sgiCpuUsage

Alcatel-SR-7750 2.0.10 sgiMemoryUsed

Alcatel-SR-7750 2.0.10 ssiSaveConfigFailed

Alcatel-SR-7750 2.0.10 ssiSaveConfigSucceeded

Alcatel-SR-7750 2.0.10 ssiSyncBootEnvFailed

Alcatel-SR-7750 2.0.10 ssiSyncBootEnvOK

Alcatel-SR-7750 2.0.10 ssiSyncConfigFailed

Alcatel-SR-7750 2.0.10 ssiSyncConfigOK

Alcatel-SR-7750 2.0.10 ssiSyncMode

Alcatel-SR-7750 2.0.10 ssiSyncStatus

Alcatel-SR-7750 2.0.10 stiDateAndTime

Alcatel-SR-7750 2.0.10 sysLACPSystemPriority

Alcatel-SR-7750 2.0.10 tmnxConfigCreate

Alcatel-SR-7750 2.0.10 tmnxConfigDelete

Alcatel-SR-7750 2.0.10 tmnxConfigModify

Alcatel-SR-7750 2.0.10 tmnxModuleMallocFailed

Alcatel-SR-7750 2.0.10 tmnxSnmpdError

Alcatel-SR-7750 2.0.10 tmnxStateChange

Alcatel-SR-7750 2.0.10 tmnxTrapDropped

Alcatel-SR-7750 2.0.10 TIMETRA-VRTR-MIB vRtrConfEntry

Alcatel-SR-7750 2.0.10 vRtrIfEntry

Alcatel-SR-7750 2.0.10 vRtrIpAddrEntry

Alcatel-SR-7750 2.0.10 vRtrPolicyEntry

Alcatel-SR-7750 2.0.10 vRtrStatEntry

Alcatel-SR-7750 2.0.10 vRtrStaticRouteEntry

Alcatel-SR-7750 2.0.10 vRtrSvcIpRangeEntry

Alcatel-SR-7750 2.1.0 ATM-MIB aal5VccEntry

Alcatel-SR-7750 2.1.0 atmInterfaceConfEntry

Alcatel-SR-7750 2.1.0 atmVclEntry
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Alcatel-SR-7750 2.1.0 BGP4-MIB bgpBackwardTransition

Alcatel-SR-7750 2.1.0 bgpEstablished

Alcatel-SR-7750 2.1.0 bgpPeerEntry

Alcatel-SR-7750 2.1.0 DS1-MIB dsx1CurrentEntry

Alcatel-SR-7750 2.1.0 dsx1FarEndCurrentEntry

Alcatel-SR-7750 2.1.0 dsx1FarEndIntervalEntry

Alcatel-SR-7750 2.1.0 dsx1FarEndTotalEntry

Alcatel-SR-7750 2.1.0 dsx1IntervalEntry

Alcatel-SR-7750 2.1.0 dsx1TotalEntry

Alcatel-SR-7750 2.1.0 DS3-MIB dsx3CurrentEntry

Alcatel-SR-7750 2.1.0 dsx3FarEndCurrentEntry

Alcatel-SR-7750 2.1.0 dsx3FarEndIntervalEntry

Alcatel-SR-7750 2.1.0 dsx3FarEndTotalEntry

Alcatel-SR-7750 2.1.0 dsx3IntervalEntry

Alcatel-SR-7750 2.1.0 dsx3TotalEntry

Alcatel-SR-7750 2.1.0 EtherLike-MIB dot3StatsEntry

Alcatel-SR-7750 2.1.0 FRAME-RELAY-DTE-MIB frDlcmiEntry

Alcatel-SR-7750 2.1.0 HC-RMON-MIB etherStatsHighCapacityEntry

Alcatel-SR-7750 2.1.0 mediaIndependentEntry

Alcatel-SR-7750 2.1.0 IEEE8023-LAG-MIB dot3adAggEntry

Alcatel-SR-7750 2.1.0 dot3adAggPortEntry

Alcatel-SR-7750 2.1.0 IF-MIB ifEntry

Alcatel-SR-7750 2.1.0 ifXEntry

Alcatel-SR-7750 2.1.0 linkDown

Alcatel-SR-7750 2.1.0 linkUp

Alcatel-SR-7750 2.1.0 IP-MIB ipNetToMediaEntry

Alcatel-SR-7750 2.1.0 ISIS-MIB isisAreaAddrEntry

Alcatel-SR-7750 2.1.0 isisCircEntry

Alcatel-SR-7750 2.1.0 isisCircLevelEntry

Alcatel-SR-7750 2.1.0 isisISAdjAreaAddrEntry

Alcatel-SR-7750 2.1.0 isisISAdjEntry

Alcatel-SR-7750 2.1.0 isisManAreaAddrEntry

Alcatel-SR-7750 2.1.0 isisPacketCountEntry

Alcatel-SR-7750 2.1.0 isisSysEntry
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Alcatel-SR-7750 2.1.0 MPLS-LSR-MIB mplsInSegmentEntry

Alcatel-SR-7750 2.1.0 mplsInterfaceConfEntry

Alcatel-SR-7750 2.1.0 mplsOutSegmentEntry

Alcatel-SR-7750 2.1.0 mplsXCDown

Alcatel-SR-7750 2.1.0 mplsXCEntry

Alcatel-SR-7750 2.1.0 mplsXCUp

Alcatel-SR-7750 2.1.0 MPLS-TE-MIB mplsTunnelARHopEntry

Alcatel-SR-7750 2.1.0 mplsTunnelDown

Alcatel-SR-7750 2.1.0 mplsTunnelEntry

Alcatel-SR-7750 2.1.0 mplsTunnelHopEntry

Alcatel-SR-7750 2.1.0 mplsTunnelReoptimized

Alcatel-SR-7750 2.1.0 mplsTunnelRerouted

Alcatel-SR-7750 2.1.0 mplsTunnelUp

Alcatel-SR-7750 2.1.0 OSPF-MIB ospfASBdrRtrStatus

Alcatel-SR-7750 2.1.0 ospfAdminStat

Alcatel-SR-7750 2.1.0 ospfAreaAggregateEntry

Alcatel-SR-7750 2.1.0 ospfAreaBdrRtrStatus

Alcatel-SR-7750 2.1.0 ospfAreaEntry

Alcatel-SR-7750 2.1.0 ospfExitOverflowInterval

Alcatel-SR-7750 2.1.0 ospfExtLsdbLimit

Alcatel-SR-7750 2.1.0 ospfExternLsaCksumSum

Alcatel-SR-7750 2.1.0 ospfExternLsaCount

Alcatel-SR-7750 2.1.0 ospfIfEntry

Alcatel-SR-7750 2.1.0 ospfIfMetricEntry

Alcatel-SR-7750 2.1.0 ospfNbrEntry

Alcatel-SR-7750 2.1.0 ospfOpaqueLsaSupport

Alcatel-SR-7750 2.1.0 ospfRFC1583Compatibility

Alcatel-SR-7750 2.1.0 ospfStubAreaEntry

Alcatel-SR-7750 2.1.0 ospfTrafficEngineeringSupport

Alcatel-SR-7750 2.1.0 ospfVirtIfEntry

Alcatel-SR-7750 2.1.0 ospfVirtNbrEntry
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Alcatel-SR-7750 2.1.0 OSPF-TRAP-MIB ospfIfAuthFailure

Alcatel-SR-7750 2.1.0 ospfIfConfigError

Alcatel-SR-7750 2.1.0 ospfIfRxBadPacket

Alcatel-SR-7750 2.1.0 ospfIfStateChange

Alcatel-SR-7750 2.1.0 ospfLsdbApproachingOverflow

Alcatel-SR-7750 2.1.0 ospfLsdbOverflow

Alcatel-SR-7750 2.1.0 ospfNbrStateChange

Alcatel-SR-7750 2.1.0 ospfNssaTranslatorStatusChange

Alcatel-SR-7750 2.1.0 ospfTxRetransmit

Alcatel-SR-7750 2.1.0 ospfVirtIfAuthFailure

Alcatel-SR-7750 2.1.0 ospfVirtIfConfigError

Alcatel-SR-7750 2.1.0 ospfVirtIfRxBadPacket

Alcatel-SR-7750 2.1.0 ospfVirtIfStateChange

Alcatel-SR-7750 2.1.0 ospfVirtIfTxRetransmit

Alcatel-SR-7750 2.1.0 ospfVirtNbrStateChange

Alcatel-SR-7750 2.1.0 RMON-MIB etherStatsEntry

Alcatel-SR-7750 2.1.0 RSVP-MIB rsvpIfEntry

Alcatel-SR-7750 2.1.0 rsvpNbrEntry

Alcatel-SR-7750 2.1.0 SNMP-USER-BASED-SM-MIB usmUserEntry

Alcatel-SR-7750 2.1.0 SNMP-VIEW-BASED-ACM-MIB vacmAccessEntry

Alcatel-SR-7750 2.1.0 vacmSecurityToGroupEntry

Alcatel-SR-7750 2.1.0 SNMPv2-MIB authenticationFailure

Alcatel-SR-7750 2.1.0 coldStart

Alcatel-SR-7750 2.1.0 sysDescr

Alcatel-SR-7750 2.1.0 sysLocation

Alcatel-SR-7750 2.1.0 sysUpTime
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Alcatel-SR-7750 2.1.0 SONET-MIB sonetFarEndLineCurrentEntry

Alcatel-SR-7750 2.1.0 sonetFarEndLineIntervalEntry

Alcatel-SR-7750 2.1.0 sonetFarEndPathCurrentEntry

Alcatel-SR-7750 2.1.0 sonetFarEndPathIntervalEntry

Alcatel-SR-7750 2.1.0 sonetFarEndVTCurrentEntry

Alcatel-SR-7750 2.1.0 sonetFarEndVTIntervalEntry

Alcatel-SR-7750 2.1.0 sonetLineCurrentEntry

Alcatel-SR-7750 2.1.0 sonetLineIntervalEntry

Alcatel-SR-7750 2.1.0 sonetPathCurrentEntry

Alcatel-SR-7750 2.1.0 sonetPathIntervalEntry

Alcatel-SR-7750 2.1.0 sonetSectionCurrentEntry

Alcatel-SR-7750 2.1.0 sonetSectionIntervalEntry

Alcatel-SR-7750 2.1.0 sonetVTCurrentEntry

Alcatel-SR-7750 2.1.0 sonetVTIntervalEntry

Alcatel-SR-7750 2.1.0 TIMETRA-ATM-MIB tAal5VccStatisticsEntry

Alcatel-SR-7750 2.1.0 tAtmIntfAal5StatsEntry

Alcatel-SR-7750 2.1.0 tAtmIntfConfEntry

Alcatel-SR-7750 2.1.0 tAtmIntfStatsEntry

Alcatel-SR-7750 2.1.0 tAtmOamVclStatisticsEntry

Alcatel-SR-7750 2.1.0 tAtmVclInfoEntry

Alcatel-SR-7750 2.1.0 tAtmVclStatisticsEntry

Alcatel-SR-7750 2.1.0 TIMETRA-BGP-MIB tBgpConfederationEntry

Alcatel-SR-7750 2.1.0 tBgpInstanceEntry

Alcatel-SR-7750 2.1.0 tBgpInstanceParamsEntry

Alcatel-SR-7750 2.1.0 tBgpMaxPrefix100

Alcatel-SR-7750 2.1.0 tBgpMaxPrefix90

Alcatel-SR-7750 2.1.0 tBgpPeerEntry

Alcatel-SR-7750 2.1.0 tBgpPeerGroupEntry

Alcatel-SR-7750 2.1.0 tBgpPeerGroupParamsEntry

Alcatel-SR-7750 2.1.0 tBgpPeerOperEntry

Alcatel-SR-7750 2.1.0 tBgpPeerParamsEntry
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Alcatel-SR-7750 2.1.0 TIMETRA-CHASSIS-MIB tSyncIfTimingAdmEntry

Alcatel-SR-7750 2.1.0 tmnxCardEntry

Alcatel-SR-7750 2.1.0 tmnxChassisEntry

Alcatel-SR-7750 2.1.0 tmnxChassisFanEntry

Alcatel-SR-7750 2.1.0 tmnxChassisPowerSupplyEntry

Alcatel-SR-7750 2.1.0 tmnxCpmCardEntry

Alcatel-SR-7750 2.1.0 tmnxCpmFlashEntry

Alcatel-SR-7750 2.1.0 tmnxEnvTempTooHigh

Alcatel-SR-7750 2.1.0 tmnxEqCardFailure

Alcatel-SR-7750 2.1.0 tmnxEqCardInserted

Alcatel-SR-7750 2.1.0 tmnxEqCardRemoved

Alcatel-SR-7750 2.1.0 tmnxEqFanFailure

Alcatel-SR-7750 2.1.0 tmnxEqFlashDataLoss

Alcatel-SR-7750 2.1.0 tmnxEqFlashDiskFull

Alcatel-SR-7750 2.1.0 tmnxEqPowerSupplyFailure

Alcatel-SR-7750 2.1.0 tmnxEqPowerSupplyInserted

Alcatel-SR-7750 2.1.0 tmnxEqPowerSupplyRemoved

Alcatel-SR-7750 2.1.0 tmnxEqSyncIfTimingBITSAlarm

Alcatel-SR-7750 2.1.0 tmnxEqSyncIfTimingBITSAlarmClear

Alcatel-SR-7750 2.1.0 tmnxEqSyncIfTimingHoldover

Alcatel-SR-7750 2.1.0 tmnxEqSyncIfTimingHoldoverClear

Alcatel-SR-7750 2.1.0 tmnxEqSyncIfTimingRef1Alarm

Alcatel-SR-7750 2.1.0 tmnxEqSyncIfTimingRef1AlarmClear

Alcatel-SR-7750 2.1.0 tmnxEqSyncIfTimingRef2Alarm

Alcatel-SR-7750 2.1.0 tmnxEqSyncIfTimingRef2AlarmClear

Alcatel-SR-7750 2.1.0 tmnxEqWrongCard

Alcatel-SR-7750 2.1.0 tmnxFabricEntry

Alcatel-SR-7750 2.1.0 tmnxHwEntry

Alcatel-SR-7750 2.1.0 tmnxMDAEntry

Alcatel-SR-7750 2.1.0 tmnxPeBootloaderVersionMismatch

Alcatel-SR-7750 2.1.0 tmnxPeBootromVersionMismatch

Alcatel-SR-7750 2.1.0 TIMETRA-CHASSIS-MIB continued tmnxPeFPGAVersionMismatch

Alcatel-SR-7750 2.1.0 tmnxPeSoftwareLoadFailed

Alcatel-SR-7750 2.1.0 tmnxPeSoftwareVersionMismatch

Alcatel-SR-7750 2.1.0 tmnxRedPrimaryCPMFail

Alcatel-SR-7750 2.1.0 tmnxSyncIfTimingEntry
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Alcatel-SR-7750 2.1.0 TIMETRA-FILTER-MIB tIPFilterEntry

Alcatel-SR-7750 2.1.0 tIPFilterParamsEntry

Alcatel-SR-7750 2.1.0 tMacFilterEntry

Alcatel-SR-7750 2.1.0 tMacFilterParamsEntry

Alcatel-SR-7750 2.1.0 TIMETRA-IGMP-MIB vRtrIgmpGeneralEntry

Alcatel-SR-7750 2.1.0 vRtrIgmpGrpSrcEntry

Alcatel-SR-7750 2.1.0 vRtrIgmpIfCModeRxQueryMismatch

Alcatel-SR-7750 2.1.0 vRtrIgmpIfEntry

Alcatel-SR-7750 2.1.0 vRtrIgmpIfGroupEntry

Alcatel-SR-7750 2.1.0 vRtrIgmpIfGrpSrcEntry

Alcatel-SR-7750 2.1.0 vRtrIgmpIfRxQueryVerMismatch

Alcatel-SR-7750 2.1.0 vRtrIgmpIfStaticGrpSrcEntry

Alcatel-SR-7750 2.1.0 vRtrIgmpIfStatsEntry

Alcatel-SR-7750 2.1.0 vRtrIgmpSSMTranslateEntry

Alcatel-SR-7750 2.1.0 TIMETRA-ISIS-MIB vRtrIsisAdjacencyChange

Alcatel-SR-7750 2.1.0 vRtrIsisAreaMismatch

Alcatel-SR-7750 2.1.0 vRtrIsisAutTypeFail

Alcatel-SR-7750 2.1.0 vRtrIsisAuthFail

Alcatel-SR-7750 2.1.0 vRtrIsisEntry

Alcatel-SR-7750 2.1.0 vRtrIsisISAdjEntry

Alcatel-SR-7750 2.1.0 vRtrIsisIfEntry

Alcatel-SR-7750 2.1.0 vRtrIsisIfLevelEntry

Alcatel-SR-7750 2.1.0 vRtrIsisLevelEntry

Alcatel-SR-7750 2.1.0 vRtrIsisManualAddressDrops

Alcatel-SR-7750 2.1.0 vRtrIsisRejectedAdjacency

Alcatel-SR-7750 2.1.0 vRtrIsisSpfLogEntry

Alcatel-SR-7750 2.1.0 vRtrIsisStatsEntry

Alcatel-SR-7750 2.1.0 vRtrIsisSummaryEntry

Alcatel-SR-7750 2.1.0 TIMETRA-LAG-MIB tLagConfigEntry

Alcatel-SR-7750 2.1.0 tLagDynamicCostOff

Alcatel-SR-7750 2.1.0 tLagDynamicCostOn

Alcatel-SR-7750 2.1.0 tLagOperationEntry

Alcatel-SR-7750 2.1.0 tLagPortAddFailed
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Alcatel-SR-7750 2.1.0 TIMETRA-LDP-MIB vRtrLdpGeneralEntry

Alcatel-SR-7750 2.1.0 vRtrLdpHelloAdjEntry

Alcatel-SR-7750 2.1.0 vRtrLdpIfEntry

Alcatel-SR-7750 2.1.0 vRtrLdpIfStateChange

Alcatel-SR-7750 2.1.0 vRtrLdpIfStatsEntry

Alcatel-SR-7750 2.1.0 vRtrLdpInstanceStateChange

Alcatel-SR-7750 2.1.0 vRtrLdpPeerParamsEntry

Alcatel-SR-7750 2.1.0 vRtrLdpSessionEntry

Alcatel-SR-7750 2.1.0 vRtrLdpSessionStatsEntry

Alcatel-SR-7750 2.1.0 vRtrLdpStateChange

Alcatel-SR-7750 2.1.0 vRtrLdpStatsEntry

Alcatel-SR-7750 2.1.0 TIMETRA-LOG-MIB tmnxLogApEntry

Alcatel-SR-7750 2.1.0 tmnxLogFileIdEntry

Alcatel-SR-7750 2.1.0 tmnxLogFileRollover

Alcatel-SR-7750 2.1.0 TIMETRA-MPLS-MIB vRtrMplsAdminGroupEntry

Alcatel-SR-7750 2.1.0 vRtrMplsGeneralEntry

Alcatel-SR-7750 2.1.0 vRtrMplsGeneralStatEntry

Alcatel-SR-7750 2.1.0 vRtrMplsIfEntry

Alcatel-SR-7750 2.1.0 vRtrMplsIfStatEntry

Alcatel-SR-7750 2.1.0 vRtrMplsIfStateChange

Alcatel-SR-7750 2.1.0 vRtrMplsLspDown

Alcatel-SR-7750 2.1.0 vRtrMplsLspEntry

Alcatel-SR-7750 2.1.0 vRtrMplsLspPathDown

Alcatel-SR-7750 2.1.0 vRtrMplsLspPathEntry

Alcatel-SR-7750 2.1.0 vRtrMplsLspPathStatEntry

Alcatel-SR-7750 2.1.0 vRtrMplsLspPathUp

Alcatel-SR-7750 2.1.0 vRtrMplsLspStatEntry

Alcatel-SR-7750 2.1.0 vRtrMplsLspUp

Alcatel-SR-7750 2.1.0 vRtrMplsStateChange

Alcatel-SR-7750 2.1.0 vRtrMplsTunnelCHopEntry

Alcatel-SR-7750 2.1.0 vRtrMplsXCEntry
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Alcatel-SR-7750 2.1.0 TIMETRA-OAM-TEST-MIB tmnxOamAtmPingCtlEntry

Alcatel-SR-7750 2.1.0 tmnxOamLspPingCtlEntry

Alcatel-SR-7750 2.1.0 tmnxOamLspTrCtlEntry

Alcatel-SR-7750 2.1.0 tmnxOamLspTrDSLabelEntry

Alcatel-SR-7750 2.1.0 tmnxOamLspTrMapEntry

Alcatel-SR-7750 2.1.0 tmnxOamMacPingCtlEntry

Alcatel-SR-7750 2.1.0 tmnxOamMacPingHistoryEntry

Alcatel-SR-7750 2.1.0 tmnxOamMacTrCtlEntry

Alcatel-SR-7750 2.1.0 tmnxOamMacTrL2MapEntry

Alcatel-SR-7750 2.1.0 tmnxOamPingCtlEntry

Alcatel-SR-7750 2.1.0 tmnxOamPingHistoryEntry

Alcatel-SR-7750 2.1.0 tmnxOamPingProbeFailed

Alcatel-SR-7750 2.1.0 tmnxOamPingResultsEntry

Alcatel-SR-7750 2.1.0 tmnxOamPingTestCompleted

Alcatel-SR-7750 2.1.0 tmnxOamPingTestFailed

Alcatel-SR-7750 2.1.0 tmnxOamTrCtlEntry

Alcatel-SR-7750 2.1.0 tmnxOamTrPathChange

Alcatel-SR-7750 2.1.0 tmnxOamTrProbeHistoryEntry

Alcatel-SR-7750 2.1.0 tmnxOamTrResultsEntry

Alcatel-SR-7750 2.1.0 tmnxOamTrTestCompleted

Alcatel-SR-7750 2.1.0 tmnxOamTrTestFailed

Alcatel-SR-7750 2.1.0 tmnxOamVprnPingCtlEntry

Alcatel-SR-7750 2.1.0 tmnxOamVprnTrCtlEntry

Alcatel-SR-7750 2.1.0 tmnxOamVprnTrL3MapEntry

Alcatel-SR-7750 2.1.0 tmnxOamVprnTrNextHopEntry

Alcatel-SR-7750 2.1.0 tmnxOamVprnTrRTEntry
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Alcatel-SR-7750 2.1.0 TIMETRA-OSPF-MIB vRtrOspfAreaEntry

Alcatel-SR-7750 2.1.0 vRtrOspfAvgSpfRunTime

Alcatel-SR-7750 2.1.0 vRtrOspfBackBoneRouter

Alcatel-SR-7750 2.1.0 vRtrOspfBaseRefCost

Alcatel-SR-7750 2.1.0 vRtrOspfExportPolicy1

Alcatel-SR-7750 2.1.0 vRtrOspfExportPolicy2

Alcatel-SR-7750 2.1.0 vRtrOspfExportPolicy3

Alcatel-SR-7750 2.1.0 vRtrOspfExportPolicy4

Alcatel-SR-7750 2.1.0 vRtrOspfExportPolicy5

Alcatel-SR-7750 2.1.0 vRtrOspfExtSpfRunTime

Alcatel-SR-7750 2.1.0 vRtrOspfExtSpfRuns

Alcatel-SR-7750 2.1.0 vRtrOspfExternalPreference

Alcatel-SR-7750 2.1.0 vRtrOspfIfEntry

Alcatel-SR-7750 2.1.0 vRtrOspfIfMD5KeyEntry

Alcatel-SR-7750 2.1.0 vRtrOspfInOverflowState

Alcatel-SR-7750 2.1.0 vRtrOspfIncrementalExtSpfRuns

Alcatel-SR-7750 2.1.0 vRtrOspfIncrementalInterSpfRuns

Alcatel-SR-7750 2.1.0 vRtrOspfLastEnabledTime

Alcatel-SR-7750 2.1.0 vRtrOspfLastExtSpfRunTime

Alcatel-SR-7750 2.1.0 vRtrOspfLastOverflowEnteredTime

Alcatel-SR-7750 2.1.0 vRtrOspfLastOverflowExitTime

Alcatel-SR-7750 2.1.0 vRtrOspfMaxSpfRunTime

Alcatel-SR-7750 2.1.0 vRtrOspfMinSpfRunTime

Alcatel-SR-7750 2.1.0 vRtrOspfNbrEntry

Alcatel-SR-7750 2.1.0 vRtrOspfOverloadStubs

Alcatel-SR-7750 2.1.0 vRtrOspfPreference

Alcatel-SR-7750 2.1.0 vRtrOspfSpfHoldDown

Alcatel-SR-7750 2.1.0 vRtrOspfSpfSpacing

Alcatel-SR-7750 2.1.0 vRtrOspfTransmitInterval

Alcatel-SR-7750 2.1.0 vRtrOspfType11LsaChecksumSum

Alcatel-SR-7750 2.1.0 vRtrOspfType11LsaCount

Alcatel-SR-7750 2.1.0 TIMETRA-OSPF-MIB continued vRtrOspfVirtIfEntry

Alcatel-SR-7750 2.1.0 vRtrOspfVirtIfMD5KeyEntry

Alcatel-SR-7750 2.1.0 vRtrOspfVirtNbrEntry
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Alcatel-SR-7750 2.1.0 TIMETRA-PIM-MIB vRtrPimBSRStateChange

Alcatel-SR-7750 2.1.0 vRtrPimCRPGrpPrefixEntry

Alcatel-SR-7750 2.1.0 vRtrPimGenPolicyEntry

Alcatel-SR-7750 2.1.0 vRtrPimGenStatsEntry

Alcatel-SR-7750 2.1.0 vRtrPimGeneralEntry

Alcatel-SR-7750 2.1.0 vRtrPimGrpInSSMRange

Alcatel-SR-7750 2.1.0 vRtrPimGrpSrcEntry

Alcatel-SR-7750 2.1.0 vRtrPimGrpSrcStatsEntry

Alcatel-SR-7750 2.1.0 vRtrPimIfEntry

Alcatel-SR-7750 2.1.0 vRtrPimIfNeighborEntry

Alcatel-SR-7750 2.1.0 vRtrPimIfNeighborLoss

Alcatel-SR-7750 2.1.0 vRtrPimIfNeighborUp

Alcatel-SR-7750 2.1.0 vRtrPimIfStatsEntry

Alcatel-SR-7750 2.1.0 vRtrPimInvalidJoinPrune

Alcatel-SR-7750 2.1.0 vRtrPimInvalidRegister

Alcatel-SR-7750 2.1.0 vRtrPimRPSetEntry

Alcatel-SR-7750 2.1.0 vRtrPimSSMGroupEntry

Alcatel-SR-7750 2.1.0 vRtrPimStaticGrpToRPEntry

Alcatel-SR-7750 2.1.0 vRtrPimStaticRPEntry

Device name MIB 
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Alcatel-SR-7750 2.1.0 TIMETRA-PORT-MIB tmnxATMIntfEntry

Alcatel-SR-7750 2.1.0 tmnxBundleEntry

Alcatel-SR-7750 2.1.0 tmnxBundleMemberEntry

Alcatel-SR-7750 2.1.0 tmnxDS0ChanGroupEntry

Alcatel-SR-7750 2.1.0 tmnxDS1Entry

Alcatel-SR-7750 2.1.0 tmnxDS3ChannelEntry

Alcatel-SR-7750 2.1.0 tmnxDS3Entry

Alcatel-SR-7750 2.1.0 tmnxEqPortBndlBadEndPtDiscr

Alcatel-SR-7750 2.1.0 tmnxEqPortBndlRedDiffExceeded

Alcatel-SR-7750 2.1.0 tmnxEqPortBndlYellowDiffExceeded

Alcatel-SR-7750 2.1.0 tmnxEqPortDS1Alarm

Alcatel-SR-7750 2.1.0 tmnxEqPortDS1AlarmClear

Alcatel-SR-7750 2.1.0 tmnxEqPortDS3Alarm

Alcatel-SR-7750 2.1.0 tmnxEqPortDS3AlarmClear

Alcatel-SR-7750 2.1.0 tmnxEqPortError

Alcatel-SR-7750 2.1.0 tmnxEqPortSFPCorrupted

Alcatel-SR-7750 2.1.0 tmnxEqPortSFPInserted

Alcatel-SR-7750 2.1.0 tmnxEqPortSFPRemoved

Alcatel-SR-7750 2.1.0 tmnxEqPortSonetAlarm

Alcatel-SR-7750 2.1.0 tmnxEqPortSonetAlarmClear

Alcatel-SR-7750 2.1.0 tmnxEqPortSonetPathAlarm

Alcatel-SR-7750 2.1.0 tmnxEqPortSonetPathAlarmClear

Alcatel-SR-7750 2.1.0 tmnxEqPortWrongSFP

Alcatel-SR-7750 2.1.0 tmnxFRDlcmiEntry

Alcatel-SR-7750 2.1.0 tmnxPortEntry

Alcatel-SR-7750 2.1.0 tmnxPortEtherEntry

Alcatel-SR-7750 2.1.0 tmnxPortIngrMdaQosStatEntry

Alcatel-SR-7750 2.1.0 tmnxPortToChannelEntry

Alcatel-SR-7750 2.1.0 tmnxQosPoolAppEntry

Alcatel-SR-7750 2.1.0 tmnxSonetEntry

Alcatel-SR-7750 2.1.0 tmnxSonetGroupEntry

Alcatel-SR-7750 2.1.0 TIMETRA-PORT-MIB continued tmnxSonetPathEntry

Device name MIB 
version

MIB name MIB entry name

(84 of 92)
9-104 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



9 —  Discovery manager
Alcatel-SR-7750 2.1.0 TIMETRA-PPP-MIB tmnxPppCpDown

Alcatel-SR-7750 2.1.0 tmnxPppCpEntry

Alcatel-SR-7750 2.1.0 tmnxPppCpUp

Alcatel-SR-7750 2.1.0 tmnxPppEntry

Alcatel-SR-7750 2.1.0 tmnxPppKeepaliveFailure

Alcatel-SR-7750 2.1.0 tmnxPppLqmFailure

Alcatel-SR-7750 2.1.0 tmnxPppNcpDown

Alcatel-SR-7750 2.1.0 tmnxPppNcpUp

Alcatel-SR-7750 2.1.0 TIMETRA-QOS-MIB tAtmTdpEntry

Alcatel-SR-7750 2.1.0 tNetworkEgressFCEntry

Alcatel-SR-7750 2.1.0 tNetworkIngressDSCPEntry

Alcatel-SR-7750 2.1.0 tNetworkIngressDot1pEntry

Alcatel-SR-7750 2.1.0 tNetworkIngressLSPEXPEntry

Alcatel-SR-7750 2.1.0 tNetworkPolicyEntry

Alcatel-SR-7750 2.1.0 tNetworkQueueEntry

Alcatel-SR-7750 2.1.0 tNetworkQueueFCEntry

Alcatel-SR-7750 2.1.0 tNetworkQueuePolicyEntry

Alcatel-SR-7750 2.1.0 tSapEgressEntry

Alcatel-SR-7750 2.1.0 tSapEgressFCEntry

Alcatel-SR-7750 2.1.0 tSapEgressQueueEntry

Alcatel-SR-7750 2.1.0 tSapIngressDSCPEntry

Alcatel-SR-7750 2.1.0 tSapIngressDot1pEntry

Alcatel-SR-7750 2.1.0 tSapIngressEntry

Alcatel-SR-7750 2.1.0 tSapIngressFCEntry

Alcatel-SR-7750 2.1.0 tSapIngressIPCriteriaEntry

Alcatel-SR-7750 2.1.0 tSapIngressMacCriteriaEntry

Alcatel-SR-7750 2.1.0 tSapIngressPrecEntry

Alcatel-SR-7750 2.1.0 tSapIngressQueueEntry

Alcatel-SR-7750 2.1.0 tSchedulerPolicyEntry

Alcatel-SR-7750 2.1.0 tSharedQueueEntry

Alcatel-SR-7750 2.1.0 tSharedQueueFCEntry

Alcatel-SR-7750 2.1.0 tSharedQueuePolicyEntry

Alcatel-SR-7750 2.1.0 tSlopePolicyEntry

Alcatel-SR-7750 2.1.0 tVirtualSchedulerEntry
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Alcatel-SR-7750 2.1.0 TIMETRA-RIP-MIB vRtrRipAuthFailure

Alcatel-SR-7750 2.1.0 vRtrRipAuthTypeMismatch

Alcatel-SR-7750 2.1.0 vRtrRipGroupEntry

Alcatel-SR-7750 2.1.0 vRtrRipIfEntry

Alcatel-SR-7750 2.1.0 vRtrRipIfStatEntry

Alcatel-SR-7750 2.1.0 vRtrRipInstanceEntry

Alcatel-SR-7750 2.1.0 vRtrRipInstanceRestarted

Alcatel-SR-7750 2.1.0 vRtrRipInstanceShuttingDown

Alcatel-SR-7750 2.1.0 TIMETRA-ROUTE-POLICY-MIB tRPAdminASPathEntry

Alcatel-SR-7750 2.1.0 tRPAdminCommunityEntry

Alcatel-SR-7750 2.1.0 tRPAdminDampingEntry

Alcatel-SR-7750 2.1.0 tRPAdminPSAcceptActionParamsEn
try

Alcatel-SR-7750 2.1.0 tRPAdminPSDefaultActionParamsEn
try

Alcatel-SR-7750 2.1.0 tRPAdminPSFromCriteriaEntry

Alcatel-SR-7750 2.1.0 tRPAdminPSParamsEntry

Alcatel-SR-7750 2.1.0 tRPAdminPSToCriteriaEntry

Alcatel-SR-7750 2.1.0 tRPAdminPolicyStatementEntry

Alcatel-SR-7750 2.1.0 tRPAdminPrefixListEntry

Alcatel-SR-7750 2.1.0 TIMETRA-RSVP-MIB vRtrRsvpGeneralEntry

Alcatel-SR-7750 2.1.0 vRtrRsvpIfEntry

Alcatel-SR-7750 2.1.0 vRtrRsvpIfNbrStateDown

Alcatel-SR-7750 2.1.0 vRtrRsvpIfNbrStateUp

Alcatel-SR-7750 2.1.0 vRtrRsvpIfStatEntry

Alcatel-SR-7750 2.1.0 vRtrRsvpIfStateChange

Alcatel-SR-7750 2.1.0 vRtrRsvpSessionEntry

Alcatel-SR-7750 2.1.0 vRtrRsvpSessionStatEntry

Alcatel-SR-7750 2.1.0 vRtrRsvpStateChange
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Alcatel-SR-7750 2.1.0 TIMETRA-SECURITY-MIB tmnxCpmPerPeerQueuing

Alcatel-SR-7750 2.1.0 tmnxCpmQueuesInUse

Alcatel-SR-7750 2.1.0 tmnxCpmQueuesTotal

Alcatel-SR-7750 2.1.0 tmnxEnableServers

Alcatel-SR-7750 2.1.0 tmnxMafEntry

Alcatel-SR-7750 2.1.0 tmnxMafMatchEntry

Alcatel-SR-7750 2.1.0 tmnxPasswordAging

Alcatel-SR-7750 2.1.0 tmnxPasswordAttemptsCount

Alcatel-SR-7750 2.1.0 tmnxPasswordAttemptsLockoutPerio
d

Alcatel-SR-7750 2.1.0 tmnxPasswordAttemptsTime

Alcatel-SR-7750 2.1.0 tmnxPasswordAuthenOrder1

Alcatel-SR-7750 2.1.0 tmnxPasswordAuthenOrder2

Alcatel-SR-7750 2.1.0 tmnxPasswordAuthenOrder3

Alcatel-SR-7750 2.1.0 tmnxPasswordComplexity

Alcatel-SR-7750 2.1.0 tmnxPasswordMinLength

Alcatel-SR-7750 2.1.0 tmnxRadiusAccounting

Alcatel-SR-7750 2.1.0 tmnxRadiusAdminStatus

Alcatel-SR-7750 2.1.0 tmnxRadiusAuthorization

Alcatel-SR-7750 2.1.0 tmnxRadiusPort

Alcatel-SR-7750 2.1.0 tmnxRadiusRetryAttempts

Alcatel-SR-7750 2.1.0 tmnxRadiusServerEntry

Alcatel-SR-7750 2.1.0 tmnxRadiusSourceAddress

Alcatel-SR-7750 2.1.0 tmnxRadiusTimeout

Alcatel-SR-7750 2.1.0 tmnxTacPlusAccounting

Alcatel-SR-7750 2.1.0 tmnxTacPlusAcctRecType

Alcatel-SR-7750 2.1.0 tmnxTacPlusAdminStatus

Alcatel-SR-7750 2.1.0 tmnxTacPlusAuthorization

Alcatel-SR-7750 2.1.0 tmnxTacPlusServerEntry

Alcatel-SR-7750 2.1.0 tmnxTacPlusSingleConnection

Alcatel-SR-7750 2.1.0 tmnxTacPlusSourceAddress

Alcatel-SR-7750 2.1.0 tmnxTacPlusTimeout

Alcatel-SR-7750 2.1.0 TIMETRA-SECURITY-MIB continued tmnxUserEntry

Alcatel-SR-7750 2.1.0 tmnxUserProfileEntry

Alcatel-SR-7750 2.1.0 tmnxUserProfileMatchEntry
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Alcatel-SR-7750 2.1.0 TIMETRA-SERV-MIB custInfoEntry

Alcatel-SR-7750 2.1.0 custMultiServiceSiteEntry

Alcatel-SR-7750 2.1.0 higherPriorityBridge

Alcatel-SR-7750 2.1.0 iesIfEntry

Alcatel-SR-7750 2.1.0 iesIfStatusChanged

Alcatel-SR-7750 2.1.0 newRootBridge

Alcatel-SR-7750 2.1.0 newRootSap

Alcatel-SR-7750 2.1.0 newRootVcpState

Alcatel-SR-7750 2.1.0 receivedTCN

Alcatel-SR-7750 2.1.0 sapAtmInfoEntry

Alcatel-SR-7750 2.1.0 sapBaseInfoEntry

Alcatel-SR-7750 2.1.0 sapEncapDot1d

Alcatel-SR-7750 2.1.0 sapEncapPVST

Alcatel-SR-7750 2.1.0 sapStatusChanged

Alcatel-SR-7750 2.1.0 sapTlsInfoEntry

Alcatel-SR-7750 2.1.0 sdpBindBaseStatsEntry

Alcatel-SR-7750 2.1.0 sdpBindEntry

Alcatel-SR-7750 2.1.0 sdpBindStatusChanged

Alcatel-SR-7750 2.1.0 sdpBindTlsEntry

Alcatel-SR-7750 2.1.0 sdpInfoEntry

Alcatel-SR-7750 2.1.0 sdpStatusChanged

Alcatel-SR-7750 2.1.0 svcBaseInfoEntry

Alcatel-SR-7750 2.1.0 svcStatusChanged

Alcatel-SR-7750 2.1.0 svcTlsFdbTableFullAlarmCleared

Alcatel-SR-7750 2.1.0 svcTlsFdbTableFullAlarmRaised

Alcatel-SR-7750 2.1.0 svcTlsInfoEntry

Alcatel-SR-7750 2.1.0 tlsFdbInfoEntry

Alcatel-SR-7750 2.1.0 tlsShgInfoEntry

Alcatel-SR-7750 2.1.0 topologyChangeSapMajorState

Alcatel-SR-7750 2.1.0 topologyChangeSapState

Alcatel-SR-7750 2.1.0 topologyChangeVcpState

Alcatel-SR-7750 2.1.0 TIMETRA-SERV-MIB continued unacknowledgedTCN
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Alcatel-SR-7750 2.1.0 TIMETRA-SYSTEM-MIB sbiBootConfig

Alcatel-SR-7750 2.1.0 sbiBootSnmpd

Alcatel-SR-7750 2.1.0 sbiConfigStatus

Alcatel-SR-7750 2.1.0 sbiPersist

Alcatel-SR-7750 2.1.0 sbiPersistStatus

Alcatel-SR-7750 2.1.0 sbiStandbyIpAddr

Alcatel-SR-7750 2.1.0 sgiCpuUsage

Alcatel-SR-7750 2.1.0 sgiMemoryUsed

Alcatel-SR-7750 2.1.0 ssiRedCpmActive

Alcatel-SR-7750 2.1.0 ssiRedSingleCpm

Alcatel-SR-7750 2.1.0 ssiRedStandbyReady

Alcatel-SR-7750 2.1.0 ssiRedStandbySyncLost

Alcatel-SR-7750 2.1.0 ssiRedStandbySyncing

Alcatel-SR-7750 2.1.0 ssiRedSwitchover

Alcatel-SR-7750 2.1.0 ssiSaveConfigFailed

Alcatel-SR-7750 2.1.0 ssiSaveConfigSucceeded

Alcatel-SR-7750 2.1.0 ssiSyncBootEnvFailed

Alcatel-SR-7750 2.1.0 ssiSyncBootEnvOK

Alcatel-SR-7750 2.1.0 ssiSyncConfigFailed

Alcatel-SR-7750 2.1.0 ssiSyncConfigOK

Alcatel-SR-7750 2.1.0 ssiSyncMode

Alcatel-SR-7750 2.1.0 ssiSyncStatus

Alcatel-SR-7750 2.1.0 stiDateAndTime

Alcatel-SR-7750 2.1.0 sysLACPSystemPriority

Alcatel-SR-7750 2.1.0 tmnxConfigCreate

Alcatel-SR-7750 2.1.0 tmnxConfigDelete

Alcatel-SR-7750 2.1.0 tmnxConfigModify

Alcatel-SR-7750 2.1.0 tmnxModuleMallocFailed

Alcatel-SR-7750 2.1.0 tmnxSnmpdError

Alcatel-SR-7750 2.1.0 tmnxSsiMismatch

Alcatel-SR-7750 2.1.0 tmnxStateChange

Alcatel-SR-7750 2.1.0 TIMETRA-SYSTEM-MIB continued tmnxTrapDropped
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Alcatel-SR-7750 2.1.0 TIMETRA-VRTR-MIB tmnxVRtrMcastMaxRoutesCleared

Alcatel-SR-7750 2.1.0 tmnxVRtrMcastMaxRoutesTCA

Alcatel-SR-7750 2.1.0 tmnxVRtrMcastMidRouteTCA

Alcatel-SR-7750 2.1.0 vRtrConfEntry

Alcatel-SR-7750 2.1.0 vRtrIfDHCPEntry

Alcatel-SR-7750 2.1.0 vRtrIfDHCPRelayStatsEntry

Alcatel-SR-7750 2.1.0 vRtrIfEntry

Alcatel-SR-7750 2.1.0 vRtrIfProxyArpEntry

Alcatel-SR-7750 2.1.0 vRtrIpAddrEntry

Alcatel-SR-7750 2.1.0 vRtrPolicyEntry

Alcatel-SR-7750 2.1.0 vRtrStatEntry

Alcatel-SR-7750 2.1.0 vRtrStaticRouteEntry

Alcatel-SR-7750 2.1.0 vRtrSvcIpRangeEntry

telco-batm 5.10.1 ACCESS-GROUP-CLI ip access-group

telco-batm 5.10.1 mac access-group

telco-batm 5.10.1 ACL-CLI access-list {ext-ip}

telco-batm 5.10.1 access-list {igmp-ip}

telco-batm 5.10.1 access-list {mac}

telco-batm 5.10.1 access-list {remark}

telco-batm 5.10.1 access-list {std-ip}

telco-batm 5.10.1 no access-list

telco-batm 5.10.1 BATM-SWITCH-MIB configL2IfaceEntry

telco-batm 5.10.1 cpuTemperatureExceeded

telco-batm 5.10.1 fanStatusChange

telco-batm 5.10.1 portSecurityViolation

telco-batm 5.10.1 powerSupplyStatusChange

telco-batm 5.10.1 reportsHardwareFanStatus

telco-batm 5.10.1 reportsHardwarePSStatus

telco-batm 5.10.1 reportsHardwareTemperature

telco-batm 5.10.1 reportsL2IfaceEntry

telco-batm 5.10.1 BATM-SYS-MON-MIB portErrorsExceeded

telco-batm 5.10.1 CONFIG-DUMP-CLI config file

telco-batm 5.10.1 GLOBAL-CLI show mac

telco-batm 5.10.1 show manufacturing-details

telco-batm 5.10.1 show temperature high-limit

telco-batm 5.10.1 show version

Device name MIB 
version

MIB name MIB entry name
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telco-batm 5.10.1 IF-MIB ifEntry

telco-batm 5.10.1 linkDown

telco-batm 5.10.1 linkUp

telco-batm 5.10.1 IGMP-CLI ip igmp snooping

telco-batm 5.10.1 ip igmp snooping for-all

telco-batm 5.10.1 ip igmp snooping forbidden

telco-batm 5.10.1 ip igmp snooping 
query-source-ip-zero

telco-batm 5.10.1 ip igmp snooping router-timers

telco-batm 5.10.1 ip igmp snooping vlan {immediate}

telco-batm 5.10.1 INTERFACE-CLI interface

telco-batm 5.10.1 ip access-group {option}

telco-batm 5.10.1 mac access-group {option}

telco-batm 5.10.1 mstp disable

telco-batm 5.10.1 no mvr

telco-batm 5.10.1 rapid-spanning-tree disable

telco-batm 5.10.1 show interface {id}

telco-batm 5.10.1 spanning-tree disable

telco-batm 5.10.1 MVR-CLI mvr

telco-batm 5.10.1 mvr group

telco-batm 5.10.1 mvr mode

telco-batm 5.10.1 mvr querytime

telco-batm 5.10.1 mvr vlan

telco-batm 5.10.1 QOS-CLI no qos mac secure

telco-batm 5.10.1 no qos mac static

telco-batm 5.10.1 qos drop-level priority

telco-batm 5.10.1 qos map

telco-batm 5.10.1 qos priority

telco-batm 5.10.1 qos remark

telco-batm 5.10.1 qos scheduling

telco-batm 5.10.1 qos scheduling

telco-batm 5.10.1 qos tx

telco-batm 5.10.1 qos tx shaper

telco-batm 5.10.1 qos tx shaper queue

telco-batm 5.10.1 QOSMACSECURE-CLI qos mac secure

telco-batm 5.10.1 QOSMACSTATIC-CLI qos mac static

telco-batm 5.10.1 ROOT-CLI qos traffic-class

Device name MIB 
version

MIB name MIB entry name
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telco-batm 5.10.1 SNMPv2-MIB authenticationFailure

telco-batm 5.10.1 sysLocation

telco-batm 5.10.1 sysName

telco-batm 5.10.1 sysObjectID

telco-batm 5.10.1 sysUpTime

telco-batm 5.10.1 SUPERVLAN-CLI no super-vlan

telco-batm 5.10.1 TLS-CLI tls

telco-batm 5.10.1 tls ethertype

telco-batm 5.10.1 tls jumbo-frame

telco-batm 5.10.1 VLAN-CLI add ports

telco-batm 5.10.1 add ports default

telco-batm 5.10.1 config

telco-batm 5.10.1 create

telco-batm 5.10.1 delete

telco-batm 5.10.1 remove ports

telco-batm 5.10.1 show vlan

Device name MIB 
version

MIB name MIB entry name
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10 — In-band and out-of-band 
management

10.1 Network element in-band and out-of-band management 
overview 10-2

10.2 In-band and out-of-band management workflow 10-3

10.3 In-band and out-of-band management menu 10-4

10.4 In-band and out-of-band management procedure list 10-4

10.5 In-band and out-of-band management procedure 10-4
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10.1 Network element in-band and out-of-band management 
overview

There are two ways for the 5620 SAM to send management traffic to the managed 
network:

• using in-band management of devices which sends management traffic to the 
system IP address of the device

• using out-of-band management of devices which sends management traffic to the 
management port of the device

When you set up both types of management, network elements can be managed using 
alternate routes if a link fails.

In-band management traffic is sent in-band along with the customer payload traffic. 
The destination address is the system IP address of the device, also known as the 
system ID. Out-of-band management traffic is sent to the management port of the 
device. The destination address is the management IP address of the management 
port of the device. The management traffic is separated from the customer payload 
traffic.

Figure 10-1 shows an example of in-band and out-of-band management.

Figure 10-1  Example of in-band and out-of-band management

The type of management is determined when devices are discovered using the 
5620 SAM discovery manager. When the device is discovered using its system IP 
address, management is in-band. When the device is discovered using its 
management port, management is out-of-band. In both cases, a route to forward 
packets to the device must exist. See chapter 9 for more information about discovery.

When the 5620 SAM discovers a device, the IP address first used to discover the 
device is considered the primary address. The second IP address used to discover the 
device is considered the secondary address. For example, if the system IP address 
was used to initially discover the device, then the primary connection is in-band.

Management Network

10.10.10.1

(sysIP = 1.1.1.1)
Router 1

Port X using system
IP address 1.1.1.2

Device management
port with IP address

10.10.10.2

(sysIP = 1.1.1.2)
Router 2

5620 SAM server

192.168.10.11 192.168.10.11

Out-of band connection

In-band connection
through any

device port, except
the management port

Management
port

Management port

17266
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In Figure 10-1, there needs to be an out-of-band management route that allows a ping 
from the 5620 SAM to the management port IP address of router 1 (192.168.10.1). 
The in-band connection sends management packets to the system IP address on 
router 2 (1.1.1.2) on port X.

Figure 10-2 shows the Network Element Polling form for configuring in-band and 
out-of-band polling using the 5620 SAM GUI. The Active Management IP address 
is set to primary, indicating that the first address discovered by the 5620 SAM is the 
primary connection. This primary connection can be in-band or out-of-band, 
depending on whether the system IP address (in-band) or management port IP 
address (out-of-band) was used to discover the device.

Figure 10-2  Network Element - Polling

10.2 In-band and out-of-band management workflow

1 Using the CLI, configure the SNMP security parameters on the devices that you 
want to discover.

2 Install and configure network interface cards on the 5620 SAM: one for in-band and 
one for out-of-band networks.

3 Configure each device for in-band and out-of-band management: in-band 
management uses the system IP (loopback) address of the device. Out-of-band 
management uses the management (network) port of the device.
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4 Configure a second trap destination log on the device to ensure that the 5620 SAM 
receives SNMP traps in-band. On the device, type:

configure log log-id log_ID_number from main security

configure log log-id log_ID_number to snmp snmp_port_number

configure log snmp-trap-group snmp_trap_group_number 
trap-destination <ip_address> "version_of_snmp" notify-community 
"name_of_community"

5 Configure a route for in-band traffic, for example, a static route or by OSPF learning 
through being a neighbor.

6 Configure in-band or out-of band polling policies.

10.3 In-band and out-of-band management menu

Use the equipment or network views in the navigation tree, and select the icon 
representing the managed device.

10.4 In-band and out-of-band management procedure list

Table 10-1 lists the in-band and out-of-band management polling procedure.

Table 10-1 5620 SAM in-band and out-of-band procedure list

10.5 In-band and out-of-band management procedure

This section provides the in-band and out-of-band management procedure.

Procedure 10-1  To configure in-band or out-of-band polling policies

Perform this procedure to configure the 5620 SAM to use in-band, out-of-band, or 
in-band and out-of-band polling in the intervals specified in the poller policies 
configuration, as described in chapter 9.

1 Choose Equipment or Network from the drop-down menu on the navigation tree.

Note —  You can discover devices using an out-of-band or an in-band 
connection. Ensure that all devices in the network have routing enabled 
to reach the in-band and out-of-band addresses, then configure the 
discovery rules appropriately, as described in Procedure 9-5.

Procedure Purpose

To configure in-band or out-of-band polling 
policies

To configure the 5620 SAM to use in-band, 
out-of-band, or both in-band and out-of-band 
management functionality.
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2 Open the Network icon. The managed devices are displayed.

3 Click on one or more icons that represent managed devices.

4 Right-click and choose Properties from the contextual menu. The Network Element 
(Edit) form opens with the General tab displayed.

5 From the General tab, note the IP address of the System Id (the system IP address) 
and the Management Ip Address (the management port IP address).

6 Click on the Polling tab button.

7 Configure the parameters:

i Specify whether scheduled polling is enabled or disabled using the Scheduled 
Polling parameter. Scheduled polling is configured using the Poller Policies 
configuration form. See Procedure 9-1 in chapter 9 for more information.

ii Specify the Active Management IP parameter. By default, this is set to primary. 
The parameter specifies the currently used management method. You can 
change the management method by changing the parameter.

iii Specify the Auto Revert to Primary parameter to ensure that primary 
management is used after a failed switch to secondary management.

iv Specify the Management IP Selection parameter to determine whether to use 
Primary Only, Secondary Only, or Primary and Secondary as the management 
method. When you choose Primary and Secondary, you can use the other 
parameters to control and regulate the management switch-over process.

v Specify the Redundant Synchronization Mode parameter.

vi Ensure the Persistent SNMP Indices parameter to is set to true to ensure 
persistent SNMP indices are used.

8 View the read-only parameters to determine the current polling status:

• Resync Status indicates whether the last polling interval was successfully 
completed.

• Last Resync Start Time and Last Resync End Time indicate the start and finish 
of the last polling interval.

9 Click on the OK button. A confirmation dialog box appears.

10 Click on the Yes button to confirm the action. The Network Element (Edit) form 
closes.
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Network system administration tasks

11 — Security management for 5620 SAM client GUI users and user 
groups

12 — Security management for managed device access, including 
RADIUS or TACACS+

13 — SSL configuration for secure messaging

14 — Deployment and site backup/upgrade management

15 — 5620 SAM database manager

16 — 5620 SAM redundancy

17 — Service template administration

18 — 5620 SAM and 5750 SSC integration configurations

19 — 5620 SAM and network management software interworking
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11.1 Security management for 5620 SAM users and user 
groups overview

The system administrator uses security management forms to control:

• initial login to present users with company-specific proprietary login information
• expiry periods for user accounts, passwords, and GUI inactivity checks
• user and user group privileges; users are assigned to a user group that is 

configured with permissions for one or more functional areas of the 5620 SAM
• the number of active client sessions and details about each active client session
• view logs that list the actions taken performed across a 5620 SAM application, 

for example, logged changes for database updates, or user activity logs for a 
specific user account

The system administrator, using an account with admin privileges, can perform the 
following tasks:

• create an initial user login screen
• specify expiry periods for user accounts, passwords, and GUI inactivity checks
• set authentication failure actions
• create user groups and configure user group permissions
• create users and assign users to user groups
• modify users and user groups
• modify user passwords
• suspend and reinstate users
• shut down GUI or 5620 SAM-O JMS client sessions on a per-client basis
• view user logs
• specify the maximum number of admin sessions

Figure 11-1 shows a User admin security management form.
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Figure 11-1  User admin security management form

User and user group permissions

Users have no access, view access, or read-write access to 5620 SAM functional 
areas based on the user group permissions for the group to which they belong.

The following general rules apply to users and user groups:

• There are no system-wide limits as to the number of users and user groups that 
can be created. The only limit on the number of users created is database space.

• A user cannot belong to more than one user group.
• User groups can be configured to allow access to one or more functional areas.
• All users can choose all 5620 SAM main menu options except the 

Administration→Security→5620 SAM User Security menu option. Not all users 
can choose sub-menu options.

• Only users with the appropriate user group permissions can configure parameters 
in the forms that appear when a main menu option is chosen.

Table 11-1 describes general user group permissions.

Note —  The term user applies to personnel who require system 
access to perform tasks. The term user does not apply to a subscriber.
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Table 11-1 User group permissions

Table 11-2 describes user group access to 5620 SAM main menu and sub-menu 
options.

Table 11-2 User group access to menu options

Permission 
user group

Functional area access Use to

Admin All 5620 SAM functional 
areas

Perform all 5620 SAM tasks, including administering users and groups.

Device Mgmt Equipment management Configure and manage equipment operations and inventory.

Interface Mgmt Interface management Configure interface properties.

Topology Mgmt Topology management Monitor and manage network elements from maps, for example, from the 
Application menu.

Subscriber Mgmt Subscriber management Configure and manage subscriber accounts.

Service Mgmt Service management Configure and manage service distribution paths and services.

QoS Mgmt QoS policies Configure and manage QoS and filter policies, counters, and manage DSCP 
and FC resources.

Fault Mgmt Fault policies Monitor and manage outstanding alarms, acknowledge and perform severity 
alterations, manage the alarm history database, and modify fault policies.

Operator Read-only access to all 
functional areas, except 
the Security Manager

Monitor applications and faults.

Operations System maintenance Perform system maintenance functions such as managing logs, database 
backups and restores, and software downloads, adding and removing 
network nodes, and specifying mediation policies.

OSS Mgmt User group for 
5620 SAM-O OSS 
users.

User group for 5620 SAM-O OSS users.

CLI CLI Start a CLI session to the chosen network element.

User group Use to

Admin Access to all menus and functions

Device Mgmt • Access to all listing functions , for example, from the Manage menu
• View services, read-write for FIBs, no access to create services
• Read-write access to service and LSP topologies, view all other topologies
• View all policies
• View equipment manager from Application menu
• View Administration mediation menus
• Change password from security menus, view site security settings, no access to manage security
• No CLI access

(1 of 3)
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Interface Mgmt • Access to all listing functions , for example, from the Manage menu
• View services, no access to create services
• Read-write access to service and LSP topologies, view all other topologies
• Read-write access to routing policy, view all other policies
• Read-write access to equipment manager from Application menu
• View mediation menus
• Change password from security menus, view site security settings, no access to manage security
• No CLI access

Topology Mgmt • Access to all listing functions , for example, from the Manage menu
• View services, read-write for FIBs, no access to create services
• Read-write access to all topologies
• Read-write access to MPLS policies, view all other policies
• View equipment manager from Application menu
• View Administration mediation menus
• Change password from security menus, view site security settings, no access to manage security
• No CLI access

Subscriber Mgmt • Access to all listing functions , for example, from the Manage menu
• Read-write access to browse service menu, no access to create services, view existing services and 

FIBs
• Read-write access to service and LSP topologies, view all other topologies
• Read-write access to all QoS policies, for example, access, network, slope, filter, and accounting; 

view all other policies
• View equipment manager from Application menu
• View all Administration mediation menus
• Change password from security menus, view site security settings, no access to manage security
• No CLI access

Service Mgmt • Access to all listing functions , for example, from the Manage menu
• Read-write access to all service creation menus. To create L3 services, such as IES, you need to 

have both Service Mgmt and Interface Mgmt privileges, 
• Read-write access to service and LSP topologies, view all other topologies
• Read-write access to all QoS policies, for example, access, network, slope, and filter; view all other 

policies
• View equipment manager from Application menu
• View all Administration mediation menus
• Change password from security menus, view site security settings, no access to manage security
• No CLI access

QoS Mgmt • Access to all listing functions , for example, from the Manage menu
• View services from the Manage menu, no access to create services
• Read-write access to service and LSP topologies, view all other topologies
• Read-write access to all QoS policies, for example, access, network, slope, and filter; view all other 

policies
• View equipment manager from Application menu
• View all Administration mediation menus
• Change password from security menus, view site security settings, no access to manage security
• No CLI access

User group Use to

(2 of 3)
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Fault Mgmt • Access to all listing functions , for example, from the Manage menu
• View services from the Manage menu, no access to create services
• Read-write access to service and LSP topologies, view all other topologies
• Read-write access to alarm policies from the Administration menu, view all other policies
• View equipment manager from Application menu
• Read-write access to Administration poller policies, view all other mediation sub-menus
• Change password from security menus, view site security settings, no access to manage security
• No CLI access

Operator • Access to all listing functions , for example, from the Manage menu
• View services, no access to create services
• Read-write access to service and LSP topologies, view all other topologies
• View all policies
• View equipment manager from Application menu
• View Administration mediation menus
• Change password from security menus, view site security settings, no access to manage security
• No CLI access

Operations • Access to all listing functions , for example, from the Manage menu
• View services, no access to create services.
• Read-write access to service and LSP topologies, view all other topologies
• Read-write access to alarm settings from the Administration menu and routing policy management 

from the Policies menu, view all other policies
• View equipment manager from Application menu
• Read-write access to Administration mediation menu functions
• Change password from security menus, view site security settings, no access to manage security
• No CLI access

OSS Mgmt • Access to all listing functions , for example, from the Manage menu
• View services, no access to create services.
• Read-write access to service and LSP topologies, view all other topologies
• View access to alarm settings from the Administration menu and all other policies
• View equipment manager from Application menu, no write access to equipment.
• View access to Administration mediation menu functions
• Change password from security menus, view site security settings, no access to manage security
• No CLI access
• Use for OSS connections to 5620 SAM server from an OSS client

CLI • Access to all listing functions , for example, from the Manage menu
• View services, no access to create services.
• Read-write access to service and LSP topologies, view all other topologies
• View all policies
• View equipment manager from Application menu
• View Administration mediation menus
• Change password from security menus, view site security settings, no access to manage security
• CLI access

User group Use to

(3 of 3)
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Password policy

The following general rules apply to planning and creating user passwords:

• Must be between 8 and 100 characters.
• Contain at least one of the following:

• lower-case character
• upper-case character
• special character
• numeric character

• Cannot be a repeat or reverse of the user account name.
• Cannot repeat the same character more than three times in a row.
• Must be changed regularly according to a configurable schedule, or user accounts 

associated with the password are locked out.
• Cannot use the same password within the same user account.

Users and user accounts when combined local and remote 
authentication is used

Many organizations already have existing TACACS+ or RADIUS authentication of 
users, based on long standing TACACS+ and RADIUS user accounts and 
passwords. You can incorporate new 5620 SAM client user accounts for local 
authentication on the 5620 SAM server with existing TACACS+ or RADIUS system 
and users.

Consider the following:

• system administrators can use existing TACACS+ or RADIUS user accounts
• you can create 5620 SAM client user accounts that match the exact TACACS+ or 

RADIUS user account, for example, if the RADIUS user account is jane, you can 
create a 5620 SAM user jane

• the 5620 SAM user name can be 1 to 80 characters, flexible enough to match most 
remote authentication user accounts

• 5620 SAM users already authenticated remotely can log in to 5620 SAM using 
their RADIUS or TACACS+ passwords

• for 5620 SAM users to be authenticated locally, their account passwords must 
meet 5620 SAM password requirements, described in this section

For example, for user jane:

• RADIUS user name is jane and password is accessforjane
• 5620 SAM user name is jane and password is LetJane1In!

When jane is authenticated by RADIUS, she can log in to the 5620 SAM client by 
typing in jane and accessforjane. If the RADIUS server was down, and she couldn’t 
be authenticated remotely, to be authenticated locally jane would have to log in to 
the 5620 SAM client by typing jane and LetJane1In!
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Client session control
5620 SAM clients create 5620 SAM sessions, either from a GUI client or a 
5620 SAM-O client running JMS. A list of the currently active 5620 SAM client 
sessions can be viewed from the Sessions tab on the 5620 SAM User Security - 
Security Management form. On this form, an admin user can also terminate client 
sessions if appropriate. When a GUI client session is closed, the session is 
terminated. When a 5620 SAM-O JMS client session is closed, a notification is sent 
to the 5620 SAM-O client and it is up to the client software to terminate the session.

11.2 Sample configuration for 5620 SAM users and user groups

Figure 11-2 shows an example of how 5620 SAM user and user group authentication 
is performed.
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Figure 11-2  Sample 5620 SAM user and user group authentication

Table 11-3 lists the high-level tasks necessary to configure this sample.

Administrator
Configures 5620 SAM
user authentication
for all users
Configures user group
privileges per user
other security configurations

user Joe C
  belongs to
  user group
  with CLI access

Authentication order
1) RADIUS
2) TACACS+
3) Local

Authentication failures
before email = 1

User Joe C
  CLI access
  1) Logs in at 9 a.m.
  2) Authenticated by
      RADIUS server 1
  3) CLI access

User Jane D
  no CLI access
  1) Logs in at 9:30 a.m.
  2) Authentication fails for RADIUS/TACACS
  3) Local authentication successed
  4) Logs in again at 9:40 a. m.
  5) Authenticated by TACACS and server 1
  6) Administrator receives
      email notification of 9:30 login failure
  7) No CLI access

RADIUS server 1
goes down at
9:15 a.m.

user Jane D
  does not belong
  to user group
  with CLI access

5620 SAM
client A

5620 SAM
client B

Network

LoginLogin

SSLSSL

Joe C
Jane D

Jane D
9:30 a.m.

3
DB

Local
authentication

CLI

5620 SAM
server

1a

RADIUS server 2
goes down at
9:15 a.m.

1b

TACACS and server 1
    Jane D at 9:40 a.m.

2a

TACACS and server 22c

    Joe C

Connection
fails at

9:25 a.m.
Back up at
9:35 a.m.

X

17770
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Table 11-3 Sample 5620 SAM user and user group security management configuration

Note the following:

• The 5620 SAM server acts as a network access server. A network access service 
is considered a RADIUS or TACACS+ client, which is served by the RADIUS 
or TACACS+ server.

• The sequence of activity between the authentication client (5620 SAM server) 
and the authentication and accounting server (RADIUS or TACACS+ server).

• 1. Start authentication
• 2. Reply to authentication request
• 3. Logout request from 5620 SAM and authentication stops

• When only one authentication method is used for a 5620 SAM client user, and 
that user fails authentication, then access is not granted.

• When the remote authentication server is down, and local authentication is used, 
the client user must log in using proper 5620 SAM credentials, as described 
in “Users and user accounts when combined local and remote authentication is 
used” in section 11.1.

11.3 Workflow to manage security for 5620 SAM users and user 
groups

1 Create an initial, company-specific proprietary login screen for all users.

2 Set expiry periods for user accounts, passwords, and GUI inactivity timeouts.

3 Create user groups according to types of tasks performed.

4 Create users that will perform the kind of tasks assigned to that user group.

Task Description

Pre configurations Ensure proper RADIUS or TACACS+ server configuration, according to your company 
requirements. PAP authentication is supported for RADIUS and TACACS+. 5620 SAM server must 
be able to communicate with the authentication servers to validate users. All configuration tasks 
should be done with admin access.

1. Configure the 
remote authentication 
order for all users

From the Administration→Security→5620 SAM RADIUS/TACACS+ User Authentication menu.

Set the authentication order parameters to:

• radius
• tacplus
• local

2. Create and 
configure user group 
privileges

From the Administration→Security→5620 SAM User Security menu.

Create a CLI user group and at least one user group that does not allow CLI access. Specify 
permissions for the group by checking the appropriate group permission check mark boxes.

3. Create and 
configure user 
accounts

From the Administration→Security→5620 SAM User Security menu.

Create users.

Assign appropriate user groups to users, one with CLI access and one without.

4.Configure 
notification

From the Administration→Security→5620 SAM User Security menu.

Configure the authentication failure action parameters, including the parameters that would allow 
the administrator email account to be notified after one login failure.
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5 Manage the user groups:

• modify user groups
• delete user groups

6 Manage the users:

• modify users
• delete users
• suspend or re-instate users
• configure GUI inactivity timeout values
• change user passwords as system administrator

7 Specify 5620 SAM RADIUS and TACACS+ authentication for 5620 SAM user 
accounts, as required.

8 Monitor active client sessions, as required.

9 Change the user password as user.

10 View user and system logs, as required.

11.4 5620 SAM user and user group configuration menus

Table 11-4 lists the 5620 SAM user and user group menus.

Table 11-4 5620 SAM user and user group menus

11.5 5620 SAM user and user group configuration procedures 
list

Table 11-5 lists the procedures necessary to create and manage users and user 
groups.

Menu option Function

Administration→Security→5620 SAM User 
Security

To open security management configuration 
forms

Administration→Security→Change Password To allow users to change their user account 
passwords

Administration→Security→5620 SAM 
RADIUS/TACACS+ User Authentication

To open security configuration forms for RADIUS 
and TACACS+ authentication for 5620 SAM 
users

Administration→Security→5620 SAM Usage 
and Activity Records

To view user logs to determine the types of 
actions performed across the 5620 SAM 
applications, for example, changes to the 
database captured in the database log, or the log 
of actions during a user session
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Table 11-5 5620 SAM user and user group procedures list

11.6 5620 SAM user and user group configuration procedures

This section provides procedures to create and manage users and user groups.

Procedure 11-1  To create a proprietary 5620 SAM initial login screen

1 As admin, choose Administration→Security→5620 SAM User Security from the 
5620 SAM main menu. The Security Management (Edit) form appears with the 
General tab button selected.

2 Configure the security statement parameters. They include:

• Enabled
• Statement

Procedure Purpose

To create a proprietary 5620 SAM initial login 
screen

Present users with a proprietary initial login 
screen.

To set expiry periods for user accounts, 
passwords, and GUI inactivity checks

Specify the expiry values for user accounts, 
including the number of days that the accounts 
are active, how often passwords need to be 
changed, and the GUI inactivity check timeout 
value.

To configure authentication failure actions Specify the action to perform if a user account 
authentication fails.

To configure suspended account actions Specify the message to send to a user when the 
user’s account is suspended.

To configure email parameters Specify email notification parameters.

To create 5620 SAM user groups Create a group of users that have common 
privileges.

To create 5620 SAM user accounts Create individual users accounts.

To create RADIUS and TACACS+ authentication 
policies for 5620 SAM user accounts

Create RADIUS and TACACS+ authentication 
rules to validate 5620 SAM users.

To delete 5620 SAM user groups Delete user groups.

To delete 5620 SAM user accounts Delete users.

To suspend or re-instate 5620 SAM users Suspend or re-instate users.

To change 5620 SAM user passwords as system 
administrator

Change user passwords as system 
administrator.

To change a 5620 SAM user password as user Change user passwords as user.

To view active 5620 SAM client sessions View active client sessions and, if required, shut 
down the client session.

To view activity logs View database, deployment, user session, and 
user requests logs.
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The statement is up to 1024 characters. You must select the Enabled parameter to 
create a proprietary message on the initial login screen.

3 Click on the Apply button.

4 Confirm the action.

5 Save the changes and close the form.

The next time a user logs on to the client GUI, they are presented with an initial 
proprietary login statement on the login screen.

Procedure 11-2  To set expiry periods for user accounts, passwords, 
and GUI inactivity checks

1 As admin, choose Administration→Security→5620 SAM User Security the 
5620 SAM main menu. The Security Management (Edit) form appears with the 
General tab button selected.

2 Configure the expiry period parameters. They include:

• Account Expiry (days) 
• Password Expiry (days)
• Client Timeout (minutes)
• Advance Password Expiry Notification (days)

If you set any of the parameters to 0, the corresponding expiry period check is 
disabled.

3 Click on the Apply button.

4 Confirm the action.

5 Save the changes and close the form.

Procedure 11-3  To configure authentication failure actions

You can specify an authentication message or a lockout for a user account that exceeds 
the configured number of login authentication attempts.

1 As admin, choose Administration→Security→5620 SAM User Security the 
5620 SAM main menu. The Security Management (Edit) form appears with the 
General tab button selected.
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2 Configure the authentication failure action parameters. They include:

• Attempts Before Lockout
• Attempts Before Email
• Email Subject
• Email Text

If you set the Attempts Before Lockout parameter to 0, the lockout function is 
disabled.

3 Click on the Apply button.

4 Confirm the action.

5 Save the changes and close the form.

Procedure 11-4  To configure suspended account actions

You can specify a suspended account message for a user account when you suspend 
the user account using the User State parameter.

1 As admin, choose Administration→Security→5620 SAM User Security the 
5620 SAM main menu. The Security Management (Edit) form appears with the 
General tab button selected.

2 Configure the suspended account parameters. They include:

• Email Subject
• Email Text

3 Click on the Apply button.

4 Confirm the action.

5 Save the changes and close the form.

Procedure 11-5  To configure email parameters

You can specify email server parameters to allow outgoing messages for informing users 
and administrators, for example, when locking out a user account that exceeds the 
configured number of login authentication attempts.

1 As admin, choose Administration→Security→5620 SAM User Security the 
5620 SAM main menu. The Security Management (Edit) form appears with the 
General tab button selected.
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2 Configure the mail server SMTP parameters. They include:

• Server Name
• Mail User Name
• Mail User Password
• Email Address

3 Click on the Apply button.

4 Confirm the action.

5 Save the changes and close the form.

Procedure 11-6  To create 5620 SAM user groups

1 As admin, choose Administration→Security→5620 SAM User Security from the 
5620 SAM main menu. The Security Management (Edit) form appears.

2 Click on the User Groups tab button.

3 Specify:

a The creation of a new group by clicking on the Create button. The User Group 
configuration form appears with the General tab button selected. Go to step 4.

b The modification of an existing group:

i Set the filter criteria.

ii Click on the Search button.

A list of configured groups appears.

iii Choose a group from the list.

iv Click on the Edit button.

The User Group form appears with the General tab button selected.

4 Configure the parameters. They include:

• User Group
• Description
• Group Permission
• Account Expiry
• Password Expiry

Specify permissions for the group by checking the appropriate group permission 
check mark boxes. You must specify at least one group permission to allow users 
who are assigned to that group to have access to a functional area.

5 Click on the Apply button to save the changes.

6 Validate the action.
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7 Click on the OK button to close the form.

When you change group permissions, the permissions of all users in the group are 
altered immediately when you click on the OK button.

Procedure 11-7  To create 5620 SAM user accounts

1 As admin, choose Administration→Security→5620 SAM User Security from the 
5620 SAM main menu. The Security Management (Edit) form appears.

2 Click on the Users tab button.

3 Specify:

a The creation of a new user by clicking on the Create button. The User 
configuration form appears. Go to step 4.

b The modification of an existing user:

i Set the filter criteria.

ii Click on the Search button.

A list of configured users appears.

iii Choose a user from the list.

iv Click on the Edit button.

The User type_of_user configuration form appears.

4 Configure the parameters. They include:

• User Name
Specify a user name, if applicable. You cannot use spaces. User names are 
case sensitive. 

• Security Group
• User State
• Email Address
• User Password

Specify the password to be at least 5 characters. You cannot use spaces. 
Passwords are case sensitive. The password is the user default password. The 
user can modify the password by choosing Administration→Security→Change 
Password from the 5620 SAM main menu.

• Confirm Password

5 Choose the appropriate user group that the user should belong to.

i Click on the Select button, next to the Security Group parameter.
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The groupName list form appears.

ii Select a group from the list.

iii Click on the OK button.

The groupName list form closes and the selected group appears in the 
Security Group parameter.

6 Click on the OK button to save the changes.

7 Verify the action.

8 Click on the Close button to close the form.

Procedure 11-8  To create RADIUS and TACACS+ authentication 
policies for 5620 SAM user accounts

1 As admin, choose Administration→Security→5620 SAM RADIUS/TACACS+ User 
Authentication from the 5620 SAM main menu. The remote authentication manager 
form appears with the General tab button selected.

2 Configure the parameters. They include:

• Authentication Order 1
• Authentication Order 2
• Authentication Order 3

3 Click on the RADIUS tab button to configure RADIUS authentication server 
parameters.

4 Click on the RADIUS Servers tab button.

5 Click on the Add button. The 5620 SAM RADIUS authentication server form 
appears.

6 Configure the parameters. They include:

• Displayed Name
• Description
• Address
• Port
• Retry Attempts
• Timeout (seconds)
• Secret

7 Click on the OK button to save the changes.

8 Verify the action.

9 Click on the TACACS tab button configure TACACS+ authentication server 
parameters.
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10 Click on the TACACS Servers tab button.

11 Click on the Add button. The 5620 SAM TACACS authentication server form 
appears.

12 Configure the parameters. They include:

• Displayed Name
• Description
• Address
• Single Connection
• Timeout (seconds)
• Secret

13 Click on the OK button to save the changes.

14 Verify the action.

15 Click on the Faults tab to view alarms, as required.

16 Click on the Apply button to save the changes and verify the action.

17 Close the form.

Procedure 11-9  To delete 5620 SAM user groups

1 Choose Administration→Security→5620 SAM User Security from the 5620 SAM 
main menu. The Security Management (Edit) form appears.

2 Click on the User Groups tab button.

3 Specify a filter to create a filtered list of groups.

4 Choose a group from the Group List.

5 Click on the Remove button.

6 Verify the action.

The group is deleted.

7 Click on the Close button to close the form.

Procedure 11-10  To delete 5620 SAM user accounts

1 Choose Administration→Security→5620 SAM User Security from the 5620 SAM 
main menu. The Security Management (Edit) form appears.

2 Click on the Users tab button.

3 Specify a filter to create a filtered list of users and click on the Search button.
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4 Choose a user from the User List.

5 Click on the Remove button.

6 Verify the action.

The user account is deleted.

7 Click on the Close button to close the form.

Procedure 11-11  To suspend or re-instate 5620 SAM users

1 Choose Administration→Security→5620 SAM User Security from the 5620 SAM 
main menu. The Security Management (Edit) form appears.

2 Click on the Users tab.

3 Specify a filter to create a filtered list of users and click on the Search button.

4 Choose a user from the user list.

5 Click on the Edit button.

The user account configuration form appears.

6 Suspend or re-instate the user.

a To suspend the user, set the User State parameter to suspended.

b To re-instate the user, set the User State parameter to active.

7 Click on the Apply button to save the changes.

8 Verify the action.

9 Close the form.

Procedure 11-12  To change 5620 SAM user passwords as system 
administrator

The system administrator uses the Security Management form to maintain user accounts. 
The user can change their password in a separate form. If a user forgets their password, 
the system administrator can change the password and inform the user of the new 
password. 

1 Choose Administration→Security→5620 SAM User Security from the 5620 SAM 
main menu. The Security Management (Edit) form appears.

2 Click on the Users tab button.

3 Specify a filter to create a filtered list of users and click on the Search button.
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4 Choose a user from the user list.

5 Click on the Edit button.

The user account configuration form appears.

6 Configure the User Password parameter and the Confirm Password parameter.

7 Click on the Apply button to save the changes.

8 Verify the action.

9 Close the form.

Procedure 11-13  To change a 5620 SAM user password as user

Users change their password in the Change Password form. 

1 Start the 5620 SAM and login using your user name and password.

2 Choose Administration→Security→Change Password from the 5620 SAM main 
menu. The Password Change form appears.

3 Verify that the Login Name matches your user account name.

4 Configure the parameters. They include:

• Old Password
• New Password
• Confirm Password

5 Click on the OK button to save the changes.

6 Confirm the action, as required.

7 Close the form.

Procedure 11-14  To view active 5620 SAM client sessions

1 As admin, choose Administration→Security→5620 SAM User Security from the 
5620 SAM main menu. The Security Management (Edit) form opens.

2 Click on the Sessions tab button.

3 Specify a filter to create a filtered list of GUI or 5620 SAM-O JMS client sessions and 
click on the Search button. The list of currently active client sessions opens.
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4 Review the following session information:

• user name logged in for the client GUI session
• ID of the session
• time and date that the session started
• user group privileges for the session
• type of client, either a GUI (5620 SAM) or 5620 SAM-O JMS (SAMOSS) client
• IP address of the client

5 You can:

a Click on the OK button to close the form.

b Choose a session from the list and click on the Close Sessions button to shut 
down the client session. Go to step 6.

6 Validate the action.

7 Close the form.

Procedure 11-15  To view activity logs

1 As admin, choose Administration→Security→5620 SAM Usage and Activity 
Records from the 5620 SAM main menu. The 5620 SAM Usage and Activity 
Records form opens.

2 Specify a type of user log from the top-left pane.

• Database Log to view information about changes to the database due to actions 
performed by the client.

• Deployment Log to view information about deployment requests sent from the 
client.

• Session Log to view information about the current client session, including 
operations performed and permissions for the logged in user account.

• User Read Log to view information about data viewed by users of the client.
• User Request Log to view information about user requests sent from the client.

3 Enable logging for the log type selected in step 2.

i Click on the Edit Policy button. The appropriate logger configuration form 
appears.

ii Set the Administrative State parameter to Up.

iii Click on the Apply button.

iv Confirm the action. The log entries for the selected log type appear, if any 
loggable actions have occurred.

Note —  How a 5620 SAM-O session is closed depends on the OSS 
application. See the Alcatel 5620 SAM-O OSS Interface Developer 
Guide for more information.
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4 Specify a filter to create a filtered list of logs and click on the Search button. The list 
of logs appears.

5 To edit the log, select a log from the list and click on the Edit button. The log 
appears. Review the log information. See the 5620 SAM Troubleshooting Guide for 
more information about reading and interpreting logs. 

The information displayed depends on the type of log. For example, user read logs 
display:

• user name logged in for the client session
• timestamp information
• type of operation performed, for example, configuration 
• user account name that performed the operation
• target class against which the operation was performed
• details about the actions performed, based on the log type

When you are finished editing the log, click on the Close button to close the log.

6 To edit the log policy, click on the Edit Policy button to specify how much data to 
collect and store in the log. The appropriate logger configuration form opens. You 
can:

i Configure the parameters. They include:

• Max Log Records
• Clear Window
• Administrative State

Click on the Apply button to save the changes.

ii Click on the Purge Log Records button to delete log records. Log records that 
meet storage specifications are stored and can be viewed. See chapter 41 for 
more information.

iii Click on the OK or Cancel button to close the Edit Policy form.

7 Click on the Close button to close the 5620 SAM Usage and Activity Records form.

Note —  The entries in the Activity Log Manager can assist you in 
identifying the user and action associated with a network problem. See 
the 5620 SAM Troubleshooting Guide for more information.
11-22 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



12 — Security management for managed 
device access, including RADIUS or 
TACACS+

12.1 Security management for managed devices, including RADIUS 
or TACACS+ overview 12-2

12.2 Workflow to manage security for managed device access and 
RADIUS or TACACS+ 12-5

12.3 Managed device user access and RADIUS or TACACS+ 
menus 12-6

12.4 Managed device user access and RADIUS or TACACS+ 
configuration procedures list 12-6

12.5 Managed device security configuration procedures 12-7
Alcatel 5620 Service Aware Manager, Release 3.0 R1 12-1
October 2005 3HE00214 CA



12 —  Security management for managed device access, including RADIUS or TACACS+
12.1 Security management for managed devices, including 
RADIUS or TACACS+ overview

The 5620 SAM provides security support for accessing managed devices, such as the 
7750 SR, as follows:

• create and manage users, profiles and passwords to access the managed devices
• configure RADIUS or TACACS+ authentication to control access to the 

managed devices using 5620 SAM user accounts

RADIUS is an access server AAA protocol. It provides a standardized method of 
exchanging information between a RADIUS client, which is located on the 7750 SR 
and managed by the 5620 SAM, and a RADIUS server, which is located externally 
from the 7750 SR and the 5620 SAM.

RADIUS functionality provides an extra layer of login security. The RADIUS client 
relays user account information to the RADIUS server. The server authenticates the 
user and returns user privilege information to the RADIUS client. This determines 
the level of access that the user has to the device. For example, the user may not be 
able to FTP information to the device.

TACACS+ provides functionality that is similar to RADIUS using a different 
protocol.

Figure 12-1 shows a Site RADIUS policy manager form with the General tab button 
selected.
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Figure 12-1  Site RADIUS policy manager form - General

User and group permissions on managed devices

The following general rules apply to managed device users, such as 7750 SR users 
and groups:

• The authentication settings on the device override any configured and distributed 
authentication settings on the 5620 SAM. For example, if you configure a user 
account with SHA authentication, and distribute the account to a device 
configured to use MD5 authentication, authentication is changed to MD5 for that 
account.

• The management access filters applied to the managed device apply globally, not 
per user.

• The system administrator can limit the type of access per managed device, for 
example, allowing FTP access, but denying console, Telnet, and SNMP access.

• User profiles exist independently of users, and are not in effect until they are 
linked to a user.

• Create device user accounts as a backup to RADIUS or TACACS+ 
authentication. If the RADIUS or TACACS+ server fails, or there are user issues 
on the servers, the 7750 SR user account can be used to access the managed 
device.
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User and user accounts when combined local and remote 
authentication is used

Many organizations already have existing TACACS+ or RADIUS authentication of 
users, based on long standing TACACS+ and RADIUS user accounts and 
passwords. You can incorporate new 5620 SAM client GUI user accounts for local 
authentication on the 5620 SAM server with existing TACACS+ or RADIUS system 
and users.

Consider the following:

• system administrators can use existing TACACS+ or RADIUS user accounts
• you can create 5620 SAM client user accounts that match the exact TACACS+ or 

RADIUS user account, for example, if the RADIUS user account is jane, you can 
create a 5620 SAM user jane

• the 5620 SAM user name can be 1 to 80 characters, flexible enough to match most 
remote authentication user accounts

• 5620 SAM users already authenticated remotely can log in to 5620 SAM using 
their RADIUS or TACACS+ passwords

• for 5620 SAM users to be authenticated locally, their account passwords must 
meet 5620 SAM password requirements, described in this section

For example, for user jane:

• RADIUS user name is jane and password is accessforjane
• 5620 SAM user name is jane and password is LetJane1In!

When jane is authenticated by RADIUS, she can log in to the 5620 SAM client by 
typing in jane and accessforjane. If the RADIUS server was down, and she couldn’t 
be authenticated remotely, to be authenticated locally jane would have to log in to 
the 5620 SAM client by typing jane and LetJane1In!

RADIUS and TACACS+ policies and permissions

See the appropriate RADIUS and TACACS+ documentation for information about 
installing, configuring, maintaining lists of users, and managing these authentication 
servers.

CPM filters and traffic management
Device CPM modules provide traffic management and queuing hardware for 
protecting the control plane. The feature provides a dedicated 10 Gbps hardware 
protection for the control planes. You can create CPM filters for the following traffic 
management functions:

• drop traffic
• accept traffic
• allocate dedicated hardware shaping queues for traffic directed to the control 

processors

Users can allocate dedicated CPM hardware queues for certain traffic designated to 
the CPUs and can set the corresponding rate-limit for the queues.
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The 5620 SAM supports the following CPM traffic management features:

• Traffic classification using CPM filters:
• Packets going to the CPM are first classified by the IOM into forwarding classes 

before recognition by the CPM hardware. You can use CPM filters to further 
classify the packets using L3/L4 information, for example, destination IP, DSCP 
value, and TCP SYN/ACK

• Queue allocation:
• Queues 1 — 8 are default queues. They cannot be modified or deleted. Unclassified 

traffic is directed to default queues
• Queues 9 — 32 are reserved for future use
• Queues 33 — 2000 are 
• Queues 2001 — 8000 are used for per-peer queuing

• PIR, CIR, CBS, and MBS configuration for the queues
• The queuing scheduler works in such a way that the queues within their CIR will 

be scheduled first in a round-robin fashion, followed by the queues above their 
CIR.

12.2 Workflow to manage security for managed device access 
and RADIUS or TACACS+

1 Specify the type of authentication used on the device, for example SHA or MD5.

2 Specify the types of access to be granted to each device from the 5620 SAM.

3 Create filter policies for device CPM modules.

4 Create site user profiles based on job classifications and the access needed to the 
managed devices.

5 Create individual site user accounts based on the configured profiles.

6 Specify password policies for access to managed devices and for users.

7 Manage the user profiles and users:

• modify profiles and users
• delete profiles and users
• change passwords as specified in the password policy

8 Create RADIUS or TACACS+ policies for user authentication.

9 Configure managed devices system security, including:

• peer queuing for hardware CPM queues
• enabling or disabling FTP, Telnet, or SSH servers on the managed device

10 Create subscriber authentication policies for DHCP sessions, as required.

11 Distribute the policies to the managed devices.
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12 Delete policies, as required.

12.3 Managed device user access and RADIUS or TACACS+ 
menus

Table 12-1 lists the device security menu options and their functions.

Table 12-1 Device security menu options

12.4 Managed device user access and RADIUS or TACACS+ 
configuration procedures list

Table 12-2 lists the procedures necessary to create and manage groups and users for 
managed device access.

Note —  Before distributing policies to managed devices, ensure the 
management access filter Action parameter is not set to deny. Shut down 
the filter, distribute the policies, then turn the filter back up.

Menu option Function

Administration→Security→NE Management 
Access Filters

Specify the type of access, for example, FTP or 
Telnet, allowed on the managed devices. These 
specifications apply to all users that access the 
device.

Administration→Security→NE CPM IP Filter Create filter policies for device CPM modules.

Administration→Security→NE User Profiles Create profiles of job descriptions and the type of 
access needed to the managed devices.

Administration→Security→NE User 
Configuration

Create user accounts to specify the types of 
access to the managed devices.

Administration→Security→NE Password Policy Create password policies for users

Administration→Security→NE RADIUS 
Authentication

Create policies for RADIUS authentication

Administration→Security→NE TACACS+ 
Authentication

Create policies for TACACS+ authentication

Administration→Security→NE System Security Specify:

• separate CPM hardware queues on the 
managed devices for peers, such as BGP or 
T-LDP peers

• enable or disable FTP, Telnet, or SSH 
servers on the managed device

Administration→Security→Subscriber 
Authentication Policy Manager

Create policies for RADIUS authentication of 
DHCP subscriber sessions
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Table 12-2 Device security procedures list

12.5 Managed device security configuration procedures

This section provides procedures to create and manage security on the managed 
devices.

Procedure 12-1  To create or modify site management access filter 
policies for managed devices

Site management access filters:

• restrict the type of management access allowed
• specify strict underlying connection protocol usage, and the accepted IP 

addresses and ports that can access the device

1 As admin, choose Administration→Security→NE Management Access Filters from 
the 5620 SAM main menu. The NE Management Access Filter form opens.

2 Specify

a A filter to search for and edit and existing site management access filter. Use 
the filters to search for and open an existing policy by choosing a policy in the 
filtered list and clicking on the Edit button.

Procedure Purpose

To create or modify site management access 
filter policies for managed devices

Specify the level of access allowed on each 
managed device.

To create or modify CPM filter policies for 
managed devices

Create CPM IP filter policies.

To create user profiles for managed device 
access

Specify profiles, based on job classifications, for 
the types of users that need access to the 
managed devices.

To create, modify, and manage user accounts for 
access to managed devices

Create users, based on the created profiles, that 
the managed device can use to authenticate 
Telnet, SNMPv3, FTP, and console access.

To specify or modify password policies Specify the password policies to create, manage, 
and modify user passwords.

To create RADIUS access policies Create RADIUS policies.

To create TACACS+ access policies Create TACACS+ policies.

To configure system security policies Configure system security.

To create subscriber authentication policies Create subscriber authentication policies for 
DHCP sessions

To edit security policies Modify existing security policies.

To distribute security policies Distribute created policies to one or more 
managed devices.

To delete security policies Delete created policies.
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b Click on the Create button.

The Site Management Access Filter (Create) form opens.

3 From the General tab, configure the parameters. They include:

• Displayed Name
• Configuration Action
• Description
• Default Filter Action

4 Click on the Entries tab button.

5 Click on:

a The Add button to add a new site entry.

b An entry in the list and click on the Edit button to modify an existing entry.

The Site MAF Match Entry (Create) form opens when you create a new entry.

6 Specify the parameters. They include:

When you set the Action parameter to deny, you cannot distribute the policy to the 
managed device. Before setting the parameter to deny, set the parameter to permit, 
distribute the configuration to the managed devices, then reconfigure the parameter 
to deny.

7 Click on the Apply button to save the changes.

The new site MAF match entry appears in the list form.

8 Click on the Apply button to save the changes.

9 Verify the action.

10 Repeat for each site management access filter you want to create or modify.

11 Click on the Apply button to save the changes.

You must distribute policies to specific devices, as described in Procedure 12-11.

• Auto-Assign ID
• Displayed Name
• Description
• Action
• Source IP

• Source IP Mask
• Source Port Type
• Destination Port
• Destination Port Mask
• Protocol
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Procedure 12-2  To create or modify CPM filter policies for managed 
devices

Device CPM modules provide traffic management and queuing hardware for protecting 
the control plane. The device provides dedicated 10 Gb/s hardware protection for the 
control planes. You can create CPM filters for the following traffic management functions:

• drop traffic
• accept traffic
• allocate dedicated hardware shaping queues for traffic directed to the control 

processors

1 As admin, choose Administration→Security→NE CPM IP Filter from the 5620 SAM 
main menu. The NE CPM IP Filter form opens.

2 Perform one of the following actions.

a Specify a filter to search for and edit and existing site management access 
filter. Use the filters to search for and open an existing policy by choosing a 
policy in the filtered list and clicking on the Edit button.

b Click on the Create button.

The CPM IP Filter (Create) form opens.

3 Click on the General tab button.

4 Configure the parameters. They include:

• Configuration Action
• Displayed Name
• Description
• Default Filter Action
• Administrative State

5 Click on the Entries tab button.

6 Perform one of the following actions.

a Click on the Add button to add a new site entry.

b Click on an entry in the list and click on the Edit button to modify an existing 
entry.

The CPM IP Filter Entry (Create) form opens with the General tab button displayed 
when you create a new entry.

7 Configure the parameters. They include:

• Entry ID
• Auto-Assign ID
• Displayed Name
• Description

8 Click on the Filter Properties tab button.
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9 Configure the parameters. They include:

10 Click on the Apply button to save the changes.

The new CPM IP filter entry appears in the list.

11 Click on the Queues tab button.

12 Perform one of the following actions.

a Click on the Add button to add a new CPM filter queue.

The CPM Filter Queue (Create) form opens with the General tab button 
displayed.

b Click on an entry in the list and click on the Edit button to modify an existing 
CPM filter queue.

13 Configure the parameters. They include:

• ID
• Displayed Name
• Description

14 Click on the CIR/PIR tab button.

15 Configure the parameters. They include:

• CIR (kb/s)
• PIR (kb/s)
• MAX

Ensure that the CIR value is lower than the PIR value.

16 Click on the Burst Size tab button.

17 Configure the parameters. They include:

• Committed Burst Size (kb)
• Maximum Burst Size (kb)

The parameters are configurable when the Default check box above each is 
deselected.

• Action
• Protocol
• Queue ID
• DSCP
• Source IP
• Destination IP
• Destination Mask
• Destination Port
• Fragment
• IP Option

• IP Option Mask
• Option Present
• Multiple Option
• ICMP Code
• ICMP Type
• Source Port
• Source Mask
• TCP Ack
• TCP Syn
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Ensure that the Committed Burst Size value is lower than the Maximum Burst Size 
value.

18 Click on the OK button. A confirmation dialog box opens.

19 Click on the OK button to close the dialog box. The CPM IP Filter (Create) form 
reappears. 

20 Repeat for each CPM filter that you want to create or modify.

21 Click on the Apply button to save the changes.

You must distribute policies to specific devices, as described in Procedure 12-11.

Procedure 12-3  To create user profiles for managed device access

Site user profiles are used to specify which commands or command groups are permitted 
or denied on the managed device from the 5620 SAM.

1 As admin, choose Administration→Security→NE User Profiles from the 5620 SAM 
main menu. The NE User Profiles form opens.

2 Specify:

a A filter to search for and edit and existing site user profiles. Choose a site user 
profile from the list and click on the Edit button.

b Click on the Create button.

The Site User Profile (Create) form opens.

3 From the General tab, configure the parameters. They include:

• Displayed Name
• Description
• Default Profile Action

4 Click on the Entries tab button.

5 Click on:

a The Add button to add a new site entry.

b An entry in the table and click on the Edit button to modify an existing entry.

The Site User Profile Match Entry (Create) form opens when you create a new entry.

6 Configure the parameters. They include:

• Displayed Name
• Description
• Action
• Match String
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Specify the Match String parameter. A match string is a CLI command prefix, 
which defines the scope of the user profile. For example, when you set the match 
string to “config” and specify a deny action, this user profile cannot use any CLI 
commands that begin with the word “config”.

7 Click on the Apply button to save the changes. The site user profile match entry 
appears in the list form.

8 Verify the action.

9 Click on the OK button to close the form.

10 Repeat for each required site user profile.

You must distribute policies to specific devices, as described in Procedure 12-11.

Procedure 12-4  To create, modify, and manage user accounts for 
access to managed devices

Create user accounts:

• to create an user account on the device
• as a backup for managed device access when the authentication servers are 

offline or cannot be used
• to specify the types of access allowed on the managed devices, for example, 

Telnet, SNMPv3, FTP, or console

1 As admin, choose Administration→Security→NE User Configuration from the 
5620 SAM main menu. The NE User Configuration form appears.

2 Specify:

a A filter to search for and edit and existing site user account.

b A new site user account by clicking on the Create button.

When you create a new site user account, the Site User (Create) form appears with 
the General tab button selected. Figure 12-2 shows the form with all permissions 
enabled.
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Figure 12-2  Site User (Create) form - General

3 Configure the parameters. They include:

• User Name
• Description
• Configuration Action
• Access

Additional parameters appear when you choose snmp, ftp, and console as the 
access methods
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4 Specify the permissions for the user.

i Specify the console and ftp password parameters:

• Password
• Confirm Password

ii Specify the file system permissions:

• Specify the Home Directory parameter to determine where the user first 
goes when accessing the device.

• Specify the Restrict to Home parameter to determine whether the user can 
access other directories.

iii Specify the console parameters:

• Console Login Exec File
• Console Cannot Change Password
• Console New Password At Login

5 When a user has console permission, you can configure the parameters in the 
Console Profile tab.

i Click on the Console Profile tab button. The list of profiles numbered one 
through eight appears.

Each user can have up to eight profiles.

ii Click on the Select button next to Profile 1 and Profile 2 to 8 parameters. Profile 
1 is automatically configured to use the system-generated default profile.

The Select Site User Profile form appears.

Default profiles and the profiles created in Procedure 12-3 are listed.

iii Choose a profile from the list.

iv Click on the OK button.

The profile name appears next to the profile number.
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6 When a user has SNMPv3 permissions, you can configure the authentication 
parameters.

i Click on the SNMP v3 tab button.

ii Specify the Authentication Protocol parameter.

iii Specify the Privacy Protocol parameter.

iv Configure the additional parameters, if required. They include:

• New Authentication Password
• Confirm New Auth Password
• New Privacy Password
• Confirm New Priv Password

v Click on the OK button to save the changes.

vi Verify the action.

7 Click on the Apply button to save the changes.

8 Close the form.

You must distribute policies to specific devices, as described in Procedure 12-11.

Procedure 12-5  To specify or modify password policies

Create password policies:

• to define rules that passwords must conform to on the devices where access 
policies are in effect

• specify the details of the passwords

1 As admin, choose Administration→Security→NE Password Policy from the 
5620 SAM main menu. The NE Password Policy form appears.

2 Specify:

a A filter to search for and edit and existing password policy.

b A new password policy by clicking on the Create button.

When you create a new password policy, the Site Password Policy (Create) form 
appears.
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3 Configure the parameters. They include:

If the password can expire, specify the expiration parameter to indicate the number 
of days that the password can be active before the old password expires and a new 
password must be set.

Use the Maximum Attempts and Maximum Attempts Time (minutes) parameters to 
specify the number of attempts allowed within a specified time.

If the maximum number of password attempts in the specified time is exceeded, set 
how long the account is locked out using the Lockout Time (minutes) parameter.

4 Specify the types and order of password authentication that will be used to verify the 
user account password using the Authentication Order 1 through 3 parameters. Set 
the order from the most preferred method of authentication to the least preferred 
method of authentication.

5 Click on the OK button to save the changes.

You must distribute policies to specific devices, as described in Procedure 12-11.

Procedure 12-6  To create RADIUS access policies

See to the appropriate RADIUS documentation for more information about configuring 
RADIUS servers.

1 Choose Administration→Security→NE RADIUS Authentication from the 5620 SAM 
main menu. The NE RADIUS Authentication form appears.

2 Specify:

a A filter to search for and edit and existing RADIUS access policy.

b A new RADIUS access policy by clicking on the Create button.

When you create a new RADIUS access policy, the Site RADIUS Policy (Create) 
form appears with the General tab selected, as shown in Figure 12-1.

3 Configure the parameters. They include:

• Name
• Description
• Minimum Length
• Password Never Expires
• Days Before Expiration

• Maximum Attempts
• Maximum Attempts Time (minutes)
• Lockout Time (minutes) 
• Complexity
• Authentication Order 1

• Displayed Name
• Administrative State
• Enable Accounting
• Enable Authorization

• Retry Attempts
• Timeout (seconds)
• Port
• Source Address
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Specify the TCP port of the RADIUS server that will be contacted using the Port 
parameter.

4 Click on the Servers tab button to configure a connection to the RADIUS servers. 
You can configure up to five RADIUS servers.

i Click on the Add button.

The Site RADIUS Server (Create) form appears.

ii Configure the parameters. They include:

• ID
• Displayed Name
• Address

Specify the IP address of the RADIUS server using the Address parameter. 
Each RADIUS server must have its own IP address.

• Secret
The parameter value must match the secret password value on the 
RADIUS server.

iii Click on the OK button to save the changes.

5 Click on the Apply button to save the changes.

You must distribute policies to specific devices, as described in Procedure 12-11.

Procedure 12-7  To create TACACS+ access policies

1 Choose Administration→Security→NE TACACS+ Authentication from the 
5620 SAM main menu. The NE TACACS+ Authentication form appears.

2 Specify:

a A filter to search for and edit an existing TACACS+ access policy.

b A new TACACS+ access policy by clicking on the Create button.

When you create a new TACACS+ access policy, the Site TACACS+ Policy 
(Create) form appears with the General tab button selected.

3 Configure the parameters. They include:

Select the Single Connection check box to specify a single connection. This allows 
a single connection to the TACACS+ server to stay up, rather than set up a new 
connection for each authentication event.

• Displayed Name
• Administrative State
• Enable Accounting
• Accounting Type

• Enable Authorization
• Timeout (seconds)
• Single Connection
• Source Address
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Specify the IP address of the TACACS+ server using the Source Address 
parameter.

4 Click on the Servers tab button to configure a connection to the TACACS+ servers. 
You can configure up to 5 TACACS+ servers.

i Click on the Add button.

The Site TACACS+ Server (Create) form appears.

ii Configure the parameters. They include:

• ID
• Displayed Name
• Address

Specify the IP address of the TACACS+ server using the Address 
parameter. Each TACACS+ server must have its own IP address.

• Secret
The parameter value must match the secret password value on the 
TACACS+ server.

iii Click on the OK button to save the changes.

5 Click on the Apply button to save the changes.

You must distribute policies to specific devices, as described in Procedure 12-11.

Procedure 12-8  To configure system security policies

1 Choose Administration→Security→NE System Security from the 5620 SAM main 
menu. The Select Site form appears.

2 Choose a managed device from the list. You can choose 7750 SRs.

3 Click on the Edit button.

The Site System Security form appears with the General tab button selected.

4 Click on the Servers Configuration tab button to configure the type of servers that 
you want to configure on the managed device, for example, FTP servers.

5 Configure the Servers Enabled parameters.

6 Click on the CPM-Per-Peer-Queuing tab button to ensure that the managed device 
allocates a separate CPM hardware queue for the peer, for example, a BGP or 
T-LDP peer.

7 Configure the Cpm-Per-Peer-Queuing parameter.

8 Click on the Faults tab button to view alarm information, as required.

9 Click on the Apply button to save the changes.

10 Confirm the action.
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11 Close the form.

You must distribute policies to specific devices, as described in Procedure 12-11.

Procedure 12-9  To create subscriber authentication policies

The 5620 SAM provides security support for creating DHCP subscriber sessions on 
7450 ESS, Release 3.0. The 5620 SAM allows you to create a policy that uses RADIUS 
authentication to grant 7450 ESS access to a dynamic host. The policy can be applied to 
the SAP of a VPLS or IES. Authentication is not performed for statically provisioned 
hosts, since DHCP is likely not running for those hosts.

Create DHCP subscriber authentication policies to: 

• define the parameters for dynamically created subscriber sessions
• authenticate dynamically created subscriber sessions

The 5620 SAM supports a maximum of 32 subscriber authentication policies.

See chapter 31 for information about configuring a VPLS and chapter 32 for information 
about configuring an IES.

1 From the 5620 SAM main menu, select Administration→Security→Subscriber 
Authentication Policy Manager. The Subscriber Authentication Policy Manager form 
opens.

2 Click on the Create button. The Subscriber Authentication Policy (Create) form 
opens with the General tab displayed, as shown in Figure 12-3.
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Figure 12-3  Subscriber Authentication Policy (Create) form - General

3 Configure the parameters. They include:

4 Click on the RADIUS Servers tab button, if required. Otherwise, go to step 9.

5 Click on the Add button. The RadiusEntry (Create) form appears.

6 Configure the parameters. They include:

• ID
• Auto-Assign ID
• Description
• Server IP Address
• Port
• Secret Key

7 Click on the OK button. A warning dialog box appears.

• Displayed Name
• Description
• Source Address
• Password
• Retry Attempts

• Timeout (seconds)
• Re-Authenticate when DHCP lease 

expired
• User Name Format
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8 Click on the OK button. The RadiusEntry (Create) form closes and the Subscriber 
Authentication Policy (Create) form refreshes with the RADIUS server information 
displayed in a list in the RADIUS Servers tab.

9 Click on the Apply button. The Subscriber Authentication Policy (Create) form 
refreshes with additional buttons and tab buttons.

10 Click on the Distribute button to manually distribute the policy to the selected local 
devices.

See Procedure 12-11 for information about distributing security policies. Policies are 
also automatically distributed to devices when they are used by resources on the 
device.

11 Close the Subscriber Authentication Policy (Create) form. The Subscriber 
Authentication Policy Manager form refreshes with the policy information displayed 
in a list.

Procedure 12-10  To edit security policies

1 Create policies, as described in Procedures 12-1 to 12-9.

2 Choose the appropriate policy from the Administration→Security→option 
5620 SAM main menu. The appropriate form appears.

3 Set the filter criteria, if applicable. You can filter or local or global policies by using 
the Policy Scope parameter. When you set the parameter to local, you can search 
on a specific managed device by clicking on the Select button next to the Local Node 
IP Address parameter.

4 Click on the Search button.

A policy list appears.

5 Specify whether to modify the global or the local instance of the policy.

a Local policies have a check mark for the Local column.

b Global policies do not have a check mark for the Local column.

6 Choose a policy from the list.

7 Click on the Edit button.

8 Configure the policy parameters, as required.

From either a local or global policy, you can click on the Local Definitions or Global 
Definitions tab button to view the local instances of policies, or the global policy used 
to define the local instance.

9 Save the changes and close the file. You must distribute global policies to the 
managed devices. You do not distribute modified local policies.
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Procedure 12-11  To distribute security policies

1 Create policies, as described in Procedures 12-1 to 12-9.

2 Choose the appropriate policy from the Administration→Security→option 
5620 SAM main menu. The appropriate form appears.

3 Set the filter criteria, if applicable.

4 Click on the Search button.

A policy list appears.

5 When:

a A management access filter is configured to deny access to managed devices, 
ensure the following:

i List the applicable management access filters. A list of management 
access filters appears.

ii Shut down the management access filter.

iii Distribute the policies. Complete steps 6 to 9.

iv Turn up the management access filter.

b No management access filter is configured, go to step 6.

6 Choose a policy from the list.

7 Click on the Distribute button. The Distribute form appears.

8 Specify which devices to distribute the policy to.

i Click on one or more devices in the left hand available nodes column.

ii Click on the right-facing arrow.

The selected device(s) move to the right-hand column.

9 Click on the Distribute button.

The policy is distributed to the selected device(s).

Procedure 12-12  To delete security policies

1 Create policies, as described in Procedures 12-1 to 12-9.

2 Choose the appropriate policy from the Administration→Security→option 
5620 SAM main menu. The appropriate form opens.

3 Set the filter criteria, if applicable.

4 Click on the Search button.
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A policy list appears.

5 Choose a policy from the list.

6 Click on the Remove button.

7 Verify the action.

The policy is deleted.

Note —  When you delete site management access filter policies when 
the Action parameter is set to deny, ensure that you edit the policy to set 
the parameter to permit before it is deleted, otherwise, the 5620 SAM 
may be isolated.

You cannot remove a site management access filter if its administrative 
state is up and the default action of the filter is set to deny or deny host 
unreachable.
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13.1 SSL configuration overview

SSL is used for data encryption, server authentication, and message integrity 
between the 5620 SAM server and clients. SSL can be configured for 5620 SAM 
GUI clients for their EJB and JMS interfaces or for 5620 SAM-O clients for their 
JMS or HTTP interfaces. When SSL is used with HTTP, it is called HTTPS. 
Figure 13-1 shows the messaging interfaces between the 5620 SAM server and its 
clients.

Figure 13-1  5620 SAM Security

13.2 Workflow to configure SSL for 5620 SAM server-to-client 
messaging

1 Become familiar with SSL and PKI certificates. Certificates must be created and 
signed by a Certification Authority or autosigned for local use. Server code sends 
the certificate to client code, which accepts the certificate if it is trusted. To configure 
SSL the server must be configured to reference a certificate KeyStore file containing 
the certificate and a KeyStore pass file containing the password. The client must be 
configured to reference the certificate KeyStore file only if the certificate is 
autosigned, that is, not signed by a Certification Authority. For information about 
creating a KeyStore file using Java’s keytool, see the Java web site at: 
http://java.sun.com/

2 Configure the 5620 SAM server for SSL by modifying the jboss-service.xml file to 
reference the KeyStore and KeyStore pass files. The jboss-service.xml file can also 
be configured for EJB over SSL if required.

OSS Application

JMS/SSL HTTPS
HTTP
user id/password

5620 SAM Client GUI

user id/
password

SNMPv3 USM/VACM
SNMPv1, v2 community string

SSH or Telnet
user id/password

FTP user id/password

FirewallFirewall

JMS/SSL

EJB/SSL

user id/
password

user id/password
User authorization and

authentication
requests

Radius or
TACACS+

Database

Managed
network

18083

5620 SAM
Server

Local
security

data
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3 Configure the 5620 SAM server for JMS over SSL by modifying the uil2-service.xml 
configuration file and nsmserver file.

4 If the 5620 SAM server certificate is autosigned, configure the 5620 SAM clients to 
trust the security certificate. This is not necessary if the certificate has been signed 
by a Certification Authority.

5 Configure the 5620 SAM server to use HTTPS for messaging to 5620 SAM-O 
clients by modifying the server.xml file on the 5620 SAM server.

6 See the 5620 SAM Troubleshooting Guide for information about SSL error 
messages that may occur during configuration.

13.3 SSL configuration procedures list

Table 13-1 lists the procedures to configure SSL for 5620 SAM GUI clients and 
5620 SAM-O clients.

Table 13-1 5620 SAM SSL configuration procedures list

13.4 SSL configuration procedures

The following procedures describe SSL configurations.

Procedure 13-1  To configure the 5620 SAM server security domain 
for SSL

This procedure is required to configure the 5620 SAM server to use a security certificate 
referenced by the KeyStore filenames. 

Procedure Purpose

To configure the 5620 SAM server security 
domain for SSL

Configure the 5620 SAM server to use a security 
certificate for secure messaging to and from 
clients.

To configure the 5620 SAM server for EJB over 
SSL

To configure the 5620 SAM server for EJB over 
SSL.

To configure the 5620 SAM server for JMS over 
SSL

To configure the 5620 SAM server for JMS over 
SSL.

To configure 5620 SAM GUI or 5620 SAM-O 
clients for SSL

Configure the 5620 SAM GUI or 5620 SAM-O 
clients to trust the server certificate.

To configure the 5620 SAM server for HTTPS or 
HTTP to the 5620 SAM-O clients

Configure the 5620 SAM server for secure HTTP 
messaging to and from clients.
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1 Configure the 5620 SAM server security domain settings in the jboss-service.xml 
file.

i Back up the jboss-service.xml file. The file is located in the C: or / 
server_installation\nms\jboss\server\default\conf\ directory.

ii Open the jboss-service.xml file in a text editor.

iii Ensure that the JassSecurity Domain fields are uncommented by removing the 
<! -- and --> tags surrounding the <mbean code> and </mbean> tags.

Code 13-1:  JassSecurity Domain code
<!-- Please uncomment this section and specify the keystore path for 
SSL to be enabled-->
<!--
<mbean code= �org.jboss.security.plugins.JaasSecurityDomain� 
name=�jboss.security:service=JaasSecurityDomain,domain=RMI+SSL�> 
<constructor> <arg type=�java.lang.String� value=�RMI+SSL� /> 
</constructor> <attribute 
name=�KeyStoreURL�>samserver.keystore</attribute> <attribute 
name=�KeyStorePass�>mainstreet</attribute> </mbean>

iv Update the KeyStoreURL and KeyStorePass information from the default 
values of samserver.keystore and mainstreet. The URL should be the path to 
the KeyStore file (PKI certificate), and the KeyStorePass should provide the 
appropriate password.

v Save the changes to the file.

2 If there are no further server configuration changes required (see Procedure 13-2 
and Procedure 13-3), restart the 5620 SAM server.

Procedure 13-2  To configure the 5620 SAM server for EJB over SSL

This procedure is required on the 5620 SAM server to send messages to 5620 SAM GUI 
clients using EJB over SSL.

1 Perform Procedure 13-1 if not already done.

2 Configure the SSL socket factory settings in the jboss-service.xml file.

i Back up the jboss-service.xml file. The file is located in the C: or / 
server_installation\nms\jboss\server\default\config\ directory

ii Open the jboss-service.xml file and search for the RMI/JRMP invoker code in 
the file.

iii Uncomment the three lines, as indicated in the file, by removing the 
<! -- and --> tags surrounding the attribute tags. Also comment out the line with 
the depends tag.
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Code 13-2:  RMI/JRMP invoker code
<!-- Please uncomment the next three lines to enable SSL-->
<!--
<attribute name=�RMIClientSocketFactory�> 
org.jboss.security.ssl.RMISSLClientSocketFactory</attribute> 
<attribute name=�RMIServerSocketFactory�> 
org.jboss.security.ssl.RMISSLServerSocketFactory</attribute> 
<attribute name=�SecurityDomain�>java:/jaas/RMI+SSL</attribute> 
-->
<!-- Please comment the following line to enable SSL -->
<depends>jboss:service=TransactionManager</depends>

iv If there are no further server configuration changes required, save the changes 
to the file and restart the 5620 SAM server.

Procedure 13-3  To configure the 5620 SAM server for JMS over SSL

1 Perform Procedure 13-1 if not already done.

2 If JMS over SSL is required for messaging to either 5620 SAM GUI clients or 
5620 SAM-O clients, configure the socket factory settings in the uil2-service.xml file.

i Back up the uil2-service.xml file. The file is located in the C: or / 
server_installation\nms\jboss\server\default\deploy\jms directory.

ii Open the uil2-service.xml file in a text editor and search for “SSL Socket 
Factories” in the file.

iii Ensure that the SSL attribute fields are uncommented by removing the 
<! -- and --> tags surrounding the <attribute> and </attribute> tags.

Code 13-3:  JMS code
<!-- SSL Socket Factories for JMS connection     -->
    <!�uncomment the following three  attributes to enable SSL -->
    <!--
       <attribute name="ClientSocketFactory">
            org.jboss.security.ssl.ClientSocketFactory
       </attribute>
       <attribute name="ServerSocketFactory">
            org.jboss.security.ssl.DomainServerSocketFactory
       </attribute>
       <attribute name="SecurityDomain">java:/jaas/RMI+SSL</attribute>
-->

iv Save the changes to the file.
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3 Configure the 5620 SAM server to accept the security certificate only if it is 
autosigned. In the case of JMS, the 5620 SAM server acts as a client to the JMS 
server and may have to be configured to trust the certificate during the SSL 
handshake. If required, trust store can be configured as follows: 

i On the 5620 SAM server, modify the file 
<install_dir>\client\nms\bin\nmsclient.bat on a PC workstation or 
nmsclient.bash on a Solaris workstation by adding the javax.net.ssl.trustStore 
option as shown in the following example:

Code 13-4:  Set JVM options
set JVM_OPTIONS_OTHER=%JVM_OPTIONS_OTHER% 
-Djavax.net.ssl.trustStore=<absolute path of the KeyStore file>

ii Save the changes to the file.

4 Restart the 5620 SAM server.

Procedure 13-4  To configure 5620 SAM GUI or 5620 SAM-O clients 
for SSL

This procedure is performed on a 5620 SAM GUI or 5620 SAM-O client workstation to 
configure the client to trust the server certificate. This procedure is only required if the 
certificate is not signed by a Certification Authority. 

1 Add the JVM option to reference the KeyStore file.

On the client workstation, modify the file <install dir>\client\nms\bin\nmsclient.bat on 
a PC workstation or nmsclient.bash on a Solaris workstation by adding the 
javax.net.ssl.trustStore option as shown in the following example:

Code 13-5:  set JVM options
set JVM_OPTIONS_OTHER=%JVM_OPTIONS_OTHER% 
-Djavax.net.ssl.trustStore=<absolute path of the KeyStore file>

2 Save the change to the file and restart the client workstation.

Procedure 13-5  To configure the 5620 SAM server for HTTPS or 
HTTP to the 5620 SAM-O clients

1 HTTP and HTTPS processes running on the 5620 SAM server are used for 
5620 SAM-O OSS Interface application communication. By default:

• HTTP is enabled on the default port
• HTTPS (on a different port) is disabled
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To enable or disable HTTP or HTTPS communication, it is necessary to activate or 
comment out the relevant configuration code in the configuration file server.xml. 
Back up the server configuration file server.xml before making any changes. The file 
is located in the C: or / 
server_installation\nms\jboss\server\default\deploy\jbossweb-tomcat55.sar 
directory.

2 To configure the 5620 SAM server for HTTP, perform the following:

i Open the server.xml file in a text editor and search for “HTTP/1.1 Connector” 
in the file.

ii Ensure that the Connector field is uncommented by removing the <! -- and --> 
tags surrounding the <Connector> and </Connector> tags.

iii If necessary, change the port parameter in the Connector field to the desired 
port.

iv Save the changes to the file.

v Go to step 5

3 To configure the 5620 SAM server for HTTPS, perform the following:

i Open the server.xml file in a text editor and search for “SSL/TLS Connector 
configuration” in the file.

ii Ensure that the Connector field is uncommented by removing the <! -- and --> 
tags surrounding the <Connector> and </Connector> tags.

Code 13-6:  HTTPS example code
<!� SSL/TLS Connector configuration using the admin devl guide 
keystore 
<Connector port=�8443� address=�${jboss.bind.address}� 
maxThreads=�100� strategy=�ms� maxHttpHeaderSize=�8192� 
emptySessionPath=�true� scheme=�https� secure=�true� 
clientAuth=�false� 
keystoreFile=�${jboss.server.home.dir}/conf/chap8.keystore� 
keystorePass=�rmi+ssl� sslProtocol = �TLS� /> �>

iii Update the keystoreFile parameter to the full path and name of the KeyStore 
file.

iv Update the keystorePass parameter to the KeyStore password.

v Change the port parameter in the Connector field to the desired port.

vi Save the changes to the file.

4 Perform Procedure 13-1 if not already done.

Note —  For greater security, Alcatel recommends disabling HTTP if 
HTTPS is used. To disable HTTP, comment out the Connector field for 
HTTP/1/1 in the server.xml file using the <!-- and --> comment tags. 
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5 Restart the 5620 SAM server.
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14.1 Deployment and site backup/upgrade overview

The 5620 SAM Deployment and Site Backup/Upgrade form is used by system 
administrators to:

• configure a 5620 SAM deployment policy
• troubleshoot the status of a configuration deployment
• schedule a backup or restore of a node database
• upgrade the node software image
• view the status of a backup, restore, or upgrade

When you apply a node configuration change using the 5620 SAM—for example, by 
clicking on OK or Apply after changing a service parameter—the 5620 SAM 
deploys the configuration change to the node according to the 5620 SAM 
deployment policy. The 5620 SAM deployment policy also specifies when the node 
saves its configuration to a local storage device. The deployment policy parameters 
include the:

• number of deployment retries that the 5620 SAM performs
• frequency of the deployment retries
• conditions under which the 5620 SAM initiates a save of the node configuration
• frequency of the node configuration saves

The 5620 SAM backup/restore policy ensures that the node configuration is not lost 
when a device failure or similar event occurs. The backup/restore policy specifies the 
conditions under which the 5620 SAM performs a node backup. The backup/restore 
policy parameters include the:

• FTP credentials that are required for a backup
• frequency of backups
• files that a backup collects and the type of file compression
• number and age of the backup files that the 5620 SAM retains

Example deployment policy configuration
The following describes an example 5620 SAM deployment policy configuration 
and its operation. The deployment policy example uses the default parameter values, 
which are appropriate for most applications. See Figure 14-4 for the parameters and 
values described in the list below. See procedure 14-1 for the configuration details.

The example deployment policy specifies that after a configuration deployment 
failure, the 5620 SAM retries the deployment until it is successful. The policy also 
specifies that the 5620 SAM initiates a save of the node configuration file to a storage 
device on the node after every configuration change. As an extra precaution, the 
policy specifies that the node saves its configuration once per hour regardless of 
whether the 5620 SAM deploys a configuration change in the interim. The node 
saves the configuration information for only the configuration parameters that are 
not at their default values.
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The deployment policy parameters and their values for this example are:

• Deployment Mode—Deployed through SNMP
This parameter setting specifies that the 5620 SAM deploys configuration 
changes to the node rather than keeping the changes only in the 5620 SAM 
database.

• Auto Save Scheme—Every Deployment
This parameter specifies when the 5620 SAM initiates a configuration save, 
depending on or regardless of deployment success or after a prescribed number 
of deployments. In this example, the parameter specifies that the 5620 SAM 
initiates a configuration save on the node after every deployment.

• Auto Save Threshold—0
This parameter specifies the number of deployments after which the 5620 SAM 
performs a configuration save. The parameter works in conjunction with the Auto 
Save Scheme parameter, and has no effect in this example.

• Scheduled Save Scheme—Scheduled Always
You can configure the 5620 SAM to initiate a node configuration save at regular 
intervals depending on or regardless of deployment activity. In this example, the 
5620 SAM always initiates a configuration save at regular intervals regardless of 
deployment activity. This ensures that the node saves configuration changes from 
sources other than the 5620 SAM; for example, CLI.

• Scheduled Save Interval—1 hour
This parameter specifies the interval for the Scheduled Save Scheme parameter.

• Save Details—disabled
Enabling this parameter causes the node to save all node parameters in the 
configuration file, including those with default values. This setting creates a much 
larger file and can cause problems when parameters or their defaults change after 
a node software upgrade. Alcatel recommends the default, disabled, for this 
parameter.

• Retry Scheme—Retry Forever
This parameter determines the conditions under which the 5620 SAM attempts to 
redeploy a configuration change after a deployment failure. The example value 
specifies that the 5620 SAM redeploys the configuration change until successful.

• Retry Interval—5 minutes
This parameter works in conjunction with the Retry Scheme parameter to specify 
how often the 5620 SAM attempts to redeploy after a deployment failure.

• Retry Threshold—0
This parameter works in conjunction with the Retry Scheme parameter to specify 
how many times the 5620 SAM attempts to redeploy after a deployment failure. 
The setting has no effect in this example.

Example backup/restore policy configuration
The following describes an example 5620 SAM backup/restore policy configuration 
and its operation. See Figure 14-1 for the parameters and values described in the list 
below. Refer to Procedure 14-3 for the configuration details.
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The example backup/restore policy specifies that the 5620 SAM obtains the backup 
files by FTP from the node once every hour regardless of configuration activity, and 
after every 25 node configuration changes. The policy also specifies that the 
5620 SAM backs up the node configuration file and BOF only when a newer file 
version exists on the node. The policy specifies the use of gzip file compression, the 
retention of at least 30 backup versions, and the purging of versions that are more 
than 30 days old.

Figure 14-1  Deployment and Site Backup/Upgrade form - Backup/Restore Policy tab
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The backup/restore policy parameters and their values are:

• Backup Mode—Uploaded by 5620 SAM Server through FTP
This setting specifies that the 5620 SAM obtains backup files from the node using 
FTP.

• Auto Reboot After Successful Restore—enabled
This setting specifies that a node restarts after its configuration file or BOF is 
restored from backup. The restored node configuration is then in effect.

• User Name—admin
This parameter specifies the user name that the 5620 SAM uses to obtain FTP 
access to the node.

• User Password—******** (concealed for security)
This parameter specifies the password that the 5620 SAM uses in conjunction 
with the User Name parameter for FTP access to the node.

• Connect Timeout (sec)—10
This parameter specifies how long the 5620 SAM waits for the establishment of 
an FTP session after initiating the FTP session.

• Read Timeout (sec)—50
This parameter specifies how long the 5620 SAM waits for a file from the node 
after sending a backup file request.

• Scheduled Backup Scheme—Every Scheduled Interval
This setting specifies that node backups occur regularly, as specified by the 
Scheduled Backup Interval parameter.

• Scheduled Backup Interval—1 hour
This parameter is used in conjunction with the Scheduled Backup Scheme 
parameter to specify how often the 5620 SAM performs a node backup.

• Scheduled Backup Threshold (operations)—5
This parameter specifies the number of times that a backup retry occurs if a 
backup fails.

• Auto Backup Scheme—Every Nth 5620 SAM Server Initiated Save
This setting specifies that the 5620 SAM performs a node backup after it initiates 
a number of configuration saves as specified by the Auto Backup Threshold 
(operations) parameter.

• Auto Backup Threshold (operations)—50
This parameter works in conjunction with the Auto Backup Scheme parameter to 
specify the number of configuration saves that occur before the 5620 SAM 
performs a node backup.

• CLI Config File Mode—New Version Only
This setting specifies that the 5620 SAM backs up the node configuration file 
only when a new version is detected.

• CLI Config Save Details—disabled
This setting specifies that the 5620 SAM backs up only the basic CLI 
configuration file, not the detailed file.

• 5620 SAM Server Repository Root Path—./sr-backup/
This parameter specifies the absolute or relative file path for the backups stored 
on the 5620 SAM server. The leading period indicates that the path is relative to 
the 5620 SAM server installation directory, which is typically 
5620sam/server/nms/bin.
Alcatel 5620 Service Aware Manager, Release 3.0 R1 14-5
October 2005 3HE00214 CA



14 —  Deployment and site backup/upgrade management
• Boot Option File Mode—New Version Only
This setting specifies that the 5620 SAM backs up the BOF only when a new 
version is detected.

• Boot Option File Path—cf1:/bof.cfg
This setting specifies the location of the BOF on the node.

• File Compression—GZIP
This setting specifies that the 5620 SAM uses gzip file compression when storing 
backups.

• Purge Mode—By Age But Retain A Minimum Number Of Backups
This setting specifies that the 5620 SAM deletes backup files older than the 
Maximum Backup Age (days) parameter specifies, if the number of backups 
specified by the Number of Backups parameter is reached.

• Number of Backups—30
This parameter works in conjunction with the Purge Mode parameter. It specifies 
how many node backups the 5620 SAM keeps.

• Maximum Backup Age (days)—30
This parameter works in conjunction with the Purge Mode parameter. It specifies 
the number of days that the 5620 SAM keeps a node backup before deleting it.

Figure 14-2  5620 SAM backup process

Figure 14-2 illustrates the activities of the 5620 SAM backup/restore process. The 
labels correspond to the following sequence of events.

1 At the interval specified—every hour in this example—the 5620 SAM issues an 
FTP request to all nodes for a backup.
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2 The nodes use FTP to send the BOF and configuration files that match the 
backup/restore policy criteria to the 5620 SAM server.

3 The 5620 SAM server creates the depl/sr-backup directory and within sr-backup 
creates a directory for each node using the node system ID as the name. In each 
node directory, the 5620 SAM uses the timestamp of a backup as the 
subdirectory name for each backup instance. Within each backup subdirectory, 
the node paths for the BOF and the configuration file are preserved. See 
Figure 14-3 for a representation of the 5620 SAM backup directory structure. In 
this example, the backup BOF is stored in the cf1 directory and the backup node 
configuration file is in the cf2/cfgs directory.

4 The 5620 SAM client uses the Backup/Restore Status tab of the Deployment and 
Site Backup/Upgrade form to view the backup status.

5  The 5620 SAM client uses the Backup/Restore Status tab of the Deployment and 
Site Backup/Upgrade form to perform on-demand node backups, restores, and 
configuration saves,

6 A third-party application periodically sends a copy of the backup files from the 
5620 SAM server to a remote storage facility for safekeeping.

Figure 14-3  5620 SAM backup directory structure
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14.2 Workflow for deployment and site backup/upgrade

1 Use the 5620 SAM to configure a deployment policy. The deployment policy 
specifies the parameters that determine how often the 5620 SAM tries to send 
configurations to the node.

2 Troubleshoot a configuration deployment, as required.

3 Use the CLI to configure the Boot Option File (BOF) persist parameter.

4 Configure the backup and restore parameters for the node.

5 Upgrade the node software image.

6 View the status of the backup, restore, or upgrade.

14.3 Deployment and site backup/upgrade menu

Table 14-1 lists the mediation menu that you use to open the Deployment and Site 
Backup/Upgrade form.

Table 14-1 5620 SAM mediation menu

14.4 Deployment and site backup/upgrade procedures list

Table 14-2 lists the procedures that you can perform from the Deployment and Site 
Backup/Upgrade form.

Table 14-2 Deployment and site backup/upgrade procedures list

Menu option Function

Administration→Deployment and Site 
Backup/Upgrade

Open the mediation policy form and configure a 
mediation policy

Procedure Purpose

To configure a 5620 SAM deployment policy Configure a deployment policy.

To troubleshoot a configuration deployment Troubleshoot a configuration deployment.

To schedule a device backup Configure backup and restore parameters.

To start an immediate backup or restore Start an immediate backup or restore.

To restore an older backup Restore an older device backup.

To upgrade the node software image Upgrade the node software image.

To view the status of the backup, restore, or 
upgrade

View the status of the backup, restore or 
upgrade.
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14.5 Deployment and site backup/upgrade procedures

Use the following procedures to perform deployment and site backup/upgrade tasks.

Procedure 14-1  To configure a 5620 SAM deployment policy

1 Choose Administration→Deployment and Site Backup/Upgrade from the 5620 SAM 
main menu. The Deployment and Site Backup/Upgrade form appears.

2 Click on the Deployment Policy tab button. Figure 14-4 displays the Deployment and 
Site Backup/Upgrade form with the Deployment Policy tab button selected.

Figure 14-4  Deployment and Site Backup/Upgrade form - Deployment Policy tab

3 Configure the parameters. They include:

• Deployment Mode
• Auto Save Scheme
• Auto Save Threshold
• Scheduled Save Scheme
• Scheduled Save Interval
• Save Details
• Retry Scheme
• Retry Interval
• Retry Threshold
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A configuration file of the changes made to the devices using the 5620 SAM can be 
generated on the devices every time the changes are made to the devices. You can 
perform an autosave of the ongoing configuration changes to the device using the 
Auto Save parameters, or a scheduled save using the Schedule Save parameters. 
The retry parameters specify how often the 5620 SAM tries to redeploy to the 
device.

4 Click on the Apply button to save the deployment policy. A confirmation dialog box 
appears.

5 Click on the Yes button to confirm the action.

6 Close the Deployment and Site Backup/Upgrade form.

Procedure 14-2  To troubleshoot a configuration deployment

The 5620 SAM continues to retry deployments after a failed or incomplete deployment 
attempt, based on the configuration for the device, as described in Procedure 14-1.

The Deployers tab displays configuration deployments that failed, and allows you to view 
information about the deployment. From the Deployers tab, you can clear the 
configuration, override the error to force the configuration to be downloaded to the node, 
or suspend or resume deployment retries to the node. 

1 Choose Administration→Deployment and Site Backup/Upgrade from the 5620 SAM 
main menu. The Deployment and Site Backup/Upgrade form opens with the 
Deployers tab displayed.

2 Double-click on a deployer in the list for more information about the configuration 
deployment. The deployer form opens with the deployer name displayed.

3 Review the deployer information, including the state value, which gives information 
about deployer fault conditions. Information about the configuration being attempted 
by the deployer is shown in the objects list.

i Choose an object in the Objects list. The Object Change form for the 
configuration change being attempted by the deployer opens.

ii Click on the Edit button.

iii Review the additional information in the Attributes list.

The action to be taken depends on how deployers are employed in the network:

• See the 5620 SAM Troubleshooting Guide for information about deployment 
state troubleshooting using the client GUI.

• See the Alcatel 5620 SAM-O OSS Interface Developer Guide for more 
information about troubleshooting deployer issues using OSS applications 
created using the 5620 SAM-O XML interface.

Note —  Alcatel recommends that you set the Deployment Mode 
parameter to the Deployed through SNMP option. When you set the 
Deployment Mode parameter to the No Deployment option, 5620 SAM 
configurations remain on the 5620 SAM, and are not sent to the device.
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For example, if there was a deployment error changing the mode of a port from 
network to access, a number of problems could occur:

• the 5620 SAM database may not be synchronized with the device database
• configuration changes requested using the client GUI may clash with 

configuration changes, retries, and recovery applications developed by an OSS 
system using the 5620 SAM-O

Procedure 14-3  To schedule a device backup

When the 5620 SAM performs a backup of node configurations, the 5620 SAM FTPs to 
the node and gets the:

• node bof file (bof.cfg)
• primary-config specified in the bof
• index file (primary-config with a .ndx extension)

Before you schedule a backup, you must:

• have admin user access on the 5620 SAM
• have a user account with FTP access on the managed device
• ensure the BOF persist parameter is set by typing the command: <show bof>. 

The parameter should be set to <persist on>.

1 Choose Administration→Deployment and Site Backup/Upgrade from the 5620 SAM 
main menu. The Deployment and Site Backup/Upgrade form appears.

2 Click on the Backup/Restore Policy tab button.

3 Configure the parameters.

i Specify the Backup Mode parameter. Since the 5620 SAM opens an FTP 
session with the device, the User Name parameter and the User Password 
parameters must match the credentials for a user account on the device for 
which FTP access is enabled. Enter your FTP user name and password. See 
chapter 8 for information about enabling FTP access for a device user account.

Failed FTP sessions can unnecessarily use 5620 SAM system resources. To 
prevent FTP problems caused by slow network connections, or when network 
connections cause frequent time outs, you can modify the Connect Timeout 
(sec) and Read Timeout (sec) parameters.

ii Specify whether to perform a reboot after the database is restored to the 
device by specifying the Auto Reboot After Successful Restore parameter.

iii You can perform scheduled backups based on a time interval or perform 
automatic backups based on the number of router configurations performed 
from the 5620 SAM server.
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Specify the backup triggering parameters.

• Scheduled Backup Scheme
• Scheduled Backup Interval
• Scheduled Backup Threshold (operations)
• Auto Backup Scheme
• Auto Backup Threshold (operations)

iv Specify the backup settings.

Configure the Boot Option File Path parameter to specify the location of the 
BOF. A BOF specifies where the system searches for runtime images, 
configuration files, and other operational parameters during system 
initialization. BOF parameters can be modified. Changes can be saved to a 
specified compact flash. The BOF must be located in the root directory of either 
an internal or external compact flash local to the system and have the 
mandatory filename of bof.cfg.

Specify both the BOF settings and the repository on the 5620 SAM where the 
backed-up database is stored. The default directory is on the 5620 SAM 
server, in the ..\bin\sr-backup\system-id directory, where system-id is the 
system ID of the router. The backups are located farther down within that 
directory, organized first by timestamp, then by drive.

v Specify the other parameters, as required.

• 5620 SAM Server Repository Root Path
• CLI Config File Mode
• CLI Config Save Details
• Boot Option File Mode
• Boot Option File Path
• File Compression

vi Specify the Backup Purging settings, which allow you to automatically control 
the number of backup files kept. These settings allow you to eliminate manual 
monitoring and deletion of backup files. The purge criteria can be the number 
of files or the age of the files or both. 

• Purge Mode
• Number of Backups
• Maximum Backup Age (days)

4 Click on the OK button to save the backup and restore configuration. A confirmation 
dialog box appears.

5 Click on the Yes button to confirm the action. The Deployment and Site 
Backup/Upgrade form closes.
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Procedure 14-4  To start an immediate backup or restore

When you start an immediate backup, you back up the device database based on the 
backup configuration that you specified in Procedure 14-3.

When you restore a database, it is restored based on the last configuration file that you 
backed up.

1 Choose Administration→Deployment and Site Backup/Upgrade from the 5620 SAM 
menu. The Deployment and Site Backup/Upgrade form appears.

2 Click on the Backup/Restore Status tab button.

All managed devices are listed.

3 Choose a device from the list.

4 Click on the View button. Information about the backed-up or restored router 
databases is displayed.

5 Close the form.

6 The Deployment and Site Backup/Upgrade form reappears.

7 Click on the Backup button or Restore button, depending on the function that you 
want to perform. A confirmation dialog box appears.

8 Click on the Yes button to confirm the action.

Procedure 14-5  To restore an older backup

When you restore an older backup, you back up the device database based on the 
backup configuration that you specified in Procedure 14-3.

You can choose to restore an older version of the backup, based on network needs.

1 Choose Administration→Deployment and Site Backup/Upgrade from the 5620 SAM 
menu. The Deployment and Site Backup/Upgrade form appears.

2 Click on the Backup/Restore Status tab.

All managed devices are listed.

3 Double-click on a device from the list. The backup and restore form for the selected 
device appears.

4 Click on the Backup Folders tab button. A list of backup files for the selected device 
appears, ordered from the oldest backup to the most recent backup.

5 Select a backup from the list.

Caution —   Older backups do not have the most recent network 
information. Services may be adversely affected if you restore an older 
backup.
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6 Click on the Restore button.

7 Confirm the prompt, indicating that site boot configuration will be restored, and the 
device will be rebooted.

8 Click on the Resync button to ensure the latest network information is available, if 
required.

9 Close the Deployment and Site Backup/Upgrade form.

Procedure 14-6  To upgrade the node software image

The node software image that you use for the upgrade depends on the type of device. 
For example:

• 7750 SR-1 and 7450 ESS-1 nodes require a both.tim file, which must be stored 
in a separate directory below the root (by default, the sr-images) directory

• 7750 SR-7 and 7750 SR-12 nodes require a 7750 SR-specific cpm.tim and 
iom.tim file, which are stored in 7750 SR-specific below the root (by default, the 
sr-images) directory

• 7450 ESS-7 and 7450 ESS-12 nodes require a 7450 ESS-specific cpm.tim and 
iom.tim file, which are stored in 7450 ESS-specific directories below the root (by 
default, the sr-images) directory

• Nodes require appropriate boot.ldr files

You must plan separate directories for each node type based on the following factors:

• software load, for example, Release 3.0 R1 of the node software
• simplex one-slot chassis types compared to redundant seven or 12 multi-slot 

chassis
• node type, for example, 7450 ESS or 7750 SR

Caution —  Although a node software upgrade can be performed using 
a remote terminal session, Alcatel recommends that the upgrade be 
performed at the system console device, where there is physical access 
to the managed devices, such as the 7750 SR. Otherwise, remote 
connectivity may not be possible in the event that there is a problem with 
the software upgrade.

Performing the upgrade at the console, with physical access to the 
managed device, is the best situation for troubleshooting any upgrade 
problems with the help of your Alcatel support representative.

Warning —  Devices such as the 7450 ESS and the 7750 SR may 
require a firmware upgrade before you perform a node software upgrade. 
To avoid a service outage, ensure that the node firmware version 
supports the software upgrade. See the device Software Release Notes 
to obtain information about firmware and software version compatibility 
and about firmware upgrade procedures in conjunction with a software 
upgrade.
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For example, assuming a network with a combination of single- and multi-slot 7750 SRs 
and 7450 ESSs, you would need to create the following directory types containing the 
following file types:

• x.x_Ry_for_SR1 (boot.ldr and both.tim)
• x.x_Ry_for_SR7_or_SR12 (boot.ldr, cpm.tim, and iom.tim)
• x.x_Ry_for_ESS1 (boot.ldr and both.tim)
• x.x_Ry_for_ESS7 (boot.ldr, cpm.tim, and iom.tim)

where x.x_Ry represents the software load, for example, 3.0_R1

If the network contains different node software releases, you need to create a directory 
for each specific release and node type.

1 Choose Administration→Deployment and Site Backup/Upgrade from the 5620 SAM 
main menu. The Deployment and Site Backup/Upgrade form appears.

2 Click on the Software Upgrade Policy tab button.

3 Configure the Repository Root on 5620 SAM Server parameter by typing the full 
path of the directory on the 5620 SAM that contains the image. For example:

c:\sr-images\3.0_R1_for_SR7

In this example, the directory name identifies the storage location for node software 
image files for a Release 3.0 R1 version of the seven-slot 7750 SR.

4 Click on the Apply button.

5 Configure the CFlash Image Root Path parameter and the CFlash Backup Root 
Path parameter, where the image is to be downloaded to the device and where the 
image is backed up, using the following format:

cf3:/<directory name>

6 Specify whether to reboot the device after the updated image is downloaded using 
the Auto-Reboot After Successful Upgrade parameter.

7 Click on the Software Images tab button.

8 Click on the Refresh button.

9 Click on the View button to check the location of the CPM and IOM software image 
files directory names. For example, the 3.0_R1_for_SR7 would be listed under the 
CPM and IOM card software version tabs, and the applicable *.tim files would be 
listed under the CPM and IOM Image File Path list headings.

10 Click on the Upgrade Site button.  A list of sites appears.  For 7450 ESS and 
7750 SR, Release 3.0 and later, the list of sites is filtered to present only the node 
type that is appropriate for the chosen software image.

11 Choose a site from the list.

Note —  When you perform a device software upgrade, ensure that the 
correct device software image directory is selected, for example, 
3.0_R1_for_SR7 for a Release 3.0 R1 version of the seven-slot 7750 SR.
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12 Click on the OK button.

The upgrade starts. See Procedure 14-7 for information about viewing the status of 
an upgrade.

Procedure 14-7  To view the status of the backup, restore, or 
upgrade

1 Choose Administration→Deployment and Site Backup/Upgrade from the 5620 SAM 
menu. The Deployment and Site Backup/Upgrade form appears.

2 Click on the Backup/Restore Status tab button.

A list of the backups and restores appears. The Restore State column of the backup 
or restore may be: Transferring Files, Pending, Reboot, CMP Sync and Reboot, 
Success, Not Attempted, Save Config, or Failure. The timestamp of an upgrade is 
also displayed.

3 Double-click on a row to view the backup and restore configuration information.

Click on the appropriate tab button for more information about:

• backup and restore status
• the software images stored in backup folders
• configuration or upgrade states
• statistics retrieval state and time
• alarms raised because of backups, restores, or mediation configurations

Backup time and state refer to the back up time and state of the back up performed 
using the 5620 SAM. The backup time and state followed by (node) refer to the back 
up time and state of the back up performed on the device.

Restore time and state refer to the restore time and state of the restoration 
performed using the 5620 SAM. The restore time and state followed by (node) refer 
to the restore time and state of the restoration performed on the device.

Note —  The amount of time to perform the upgrade depends on the 
shelf size of the device. The CPM Sync and Reboot status indicates that 
the update is occurring and may take many minutes to complete, and 
does not indicate a problem.
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15.1 5620 SAM database manager overview

The 5620 SAM database manager is used by system administrators to perform 
traditional database management system tasks on the PC or workstation being used 
as the 5620 SAM standalone, primary, or standby database. You need to have the 
clearance to update the database, as either an admin or Oracle SYS_DBA user, to:

• view the Oracle primary and standby, or standalone, database data and statistics 
used by the 5620 SAM

• perform database analysis
• backup a 5620 SAM database
• view the results of a 5620 SAM database analysis or backup

15.2 Workflow to manage the 5620 SAM database

1 Autodiscover the network. The database of the managed devices is stored in the 
5620 SAM database.

2 Perform regular database management according to company policy:

i Monitor the database as required.

ii Analyze the database as required. Alcatel recommends that as the database 
grows, tablespaces should be analyzed with increasing frequency.

iii Back up the database as required. Alcatel recommends that you back up the 
database at least once a day.

15.3 5620 SAM database menu

Table 15-1 lists the database menu and its function.

Table 15-1 5620 SAM database menu

15.4 5620 SAM database procedures list

Table 15-2 lists the procedures to execute database management tasks.

Menu option Function

Administration→Database Set database policies using the Database 
Manager form.
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Table 15-2 Database management procedures list

15.5 5620 SAM database procedures

Use the following procedures to perform database management tasks.

Procedure 15-1  To view general database statistics

Database statistics provide general information about the Oracle database that stores 
5620 SAM data.

1 Choose Administration→Database from the 5620 SAM main menu. The Database 
Manager form appears with the General tab selected. Figure 15-1 shows the 
database manager form for a redundant database. The form for a standalone 
database is similar, but contains less configuration information.

Procedure Purpose

To view general database statistics View general details about the database.

To analyze the database Perform a database analysis to troubleshoot a 
database problem.

To back up the database Perform a scheduled backup of the database and 
store the latest version of the database for 
analysis or for future use

To perform a switchover Perform a switchover from the primary to standby 
database
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Figure 15-1  Database manager form for a redundant database

2 View the following information from the General tab button:

• Database Name and Instance Name, created using the DBconfig installer, for 
example, samdb as recommended in the 5620 SAM Installation and Upgrade 
Guide

• Primary or standalone DBID, which is the database ID of the Oracle database
• Creation Time of the standalone or primary database using the DBconfig 

installer
• Version of the installed Oracle standalone or primary database, for example, 

Oracle 10G
• Standalone, primary, or standby DB Server IP address of the PC or workstation 

containing the database
• Open Mode for the primary or standalone database, which specifies the type of 

access available to the database, either read or read and write
• Archive Log Mode, either to archive the log or not to archive the log as specified 

during installation
• Standby database parameters for redundant configurations, including 

switchover state, last attempted switchover time, failover state, and last 
attempted failover time
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Procedure 15-2  To analyze the database

You can analyze the database to check the integrity of the database. Clean tablespaces 
in the database are essential for quick and efficient queries to the database. Analyze the 
tables more frequently as more data is added to the database.

1 Choose Administration→Database from the 5620 SAM main menu. The Database 
Manager form opens.

2 Click on the Analysis tab button.

a Click on the Schedule analysis button to schedule an analysis and define the 
analysis parameters. The Define Analysis parameters form opens.

i Configure the parameters. They include:

• Analysis Interval
• Interval Unit

ii Click on the Next button. The Choose Tables form opens.

iii Specify the database tables that need analysis.

Shift-click to select multiple adjacent rows. CTRL-click rows to select 
multiple non-adjacent rows. 

iv Click on the Finish button. An operation status message appears.

b Click on the Unschedule Analysis button to unschedule the currently 
scheduled analysis.

c Click on the Analyze button. The Choose Tables form appears.

i Choose the tables to be analyzed, if applicable.

ii Click on the Finish button. An operation status message opens.

iii Click on the Close button. The Database Manager form reappears.

3 Analysis status information is shown on the Analysis tab of the Database Manager 
form.

Table analysis provides information such as:

• whether an analysis schedule has been configured
• whether the last analysis succeeded or failed
• the next scheduled analysis time
• when the last successful analysis was completed

Note —  Contact your Alcatel support representative for more 
information about the types of data stored in each database table type.

Note —  Contact your Alcatel support representative for more 
information about the types of data stored in each database table type.
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Details about the analysis, such as the number of tablespaces analyzed and the 
state of those tablespaces, are stored in Oracle catalog tables. See the Oracle 
documentation for information about querying the Oracle database to view the 
results, and to perform other database management tasks.

Procedure 15-3  To back up the database

Back up the 5620 SAM database as a preventive measure in case there is a problem with 
network management system or the database. A database backup provides a snapshot 
of the database. You can use the backup to restore network data:

• if you want to move a database from one workstation to another
• to recover from hardware or software errors
• to provide a clean copy of the database before performing an new installation or 

upgrade
• as a preventative measure before making major changes to the network, or 

deploying a large number of new network devices

1 Choose Administration→Database from the 5620 SAM main menu. The Database 
Manager form opens.

2 Click on the Backup tab button.

3 Specify how to perform backups, either using a scheduled or an unscheduled 
method.

a Click on the Schedule backup button to schedule a backup. The Define Backup 
Schedule form opens.

i Configure the parameters. They include:

• Backup Interval
• Interval Unit
• Number to Keep

ii Click on the Next button. The Define Root Backup Directory form opens.

iii Configure the Backup Directory parameter.

Caution —  There must be sufficient hard disk space to store database 
backups. Alcatel recommends that a separate database backup directory 
is created to store backup files. This backup directory should be at least 
five times larger than the expected database backup size. Contact your 
Alcatel support representative or read the 5620 SAM Planning Guide for 
more information.

Note 1 — The database must be in ARCHIVELOG mode to perform a 
backup.

Note 2 — During a database backup, the performance of 
database-related operations from the GUI or the XML OSS interface may 
be affected. Alcatel recommends performing database backups during 
low-activity windows.
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iv Click on the Finish button. An operation status message opens.

b Click on the Unschedule backup button to unschedule a previously scheduled 
backup.

c Click on the Backup button to perform a backup without a schedule. The Define 
Backup Directory form opens.

i Configure the Backup Directory parameter.

ii Click on the Finish button. An operation status message opens.

4 Backup status information is shown on the backup tab of the Database Manager 
form.

Backup status provides information such as:

• whether a backup schedule has been configured
• whether the last backup succeeded or failed
• the next scheduled backup time
• when the last successful and attempted backup was completed
• directory of the last successful backup

5 Close the form.

Procedure 15-4  To perform a switchover

Switchovers from the primary to the standby database are performed using the 
Switchover button on the database manager form. You must understand the implications 
of performing a switchover. See chapter 16 for more information about redundancy and 
switchovers

Note —  Ensure that the backup location is not tampered with, 
overwritten, and has enough space to contain the database. For regularly 
scheduled backups, ensure that there is enough space for numerous 
backup copies of the database.

Note —  After backing up and restoring a database, you must perform a 
full resync of the network to discover any changes to the managed 
devices, or any new managed devices.
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16.1 5620 SAM redundancy overview

Redundancy is only supported on Solaris workstations. In typical installations, 
redundancy between the 5620 SAM server and database is used to ensure network 
visibility in case of NMS domain LAN errors or workstation problems.

The current state of each server and database determines whether it is primary or 
standby. The primary server actively manages the network and the primary database 
is open in read/write mode.

Two redundancy configurations are supported: co-located and distributed. In a 
co-located installation, both the 5620 SAM server and database are on the same 
workstation. In a distributed installation, the 5620 SAM server and the 5620 SAM 
database are on separate workstations. The servers and databases are considered to 
be four separate entities regardless of physical or geographical deployment. For 
example, in a co-located installation, the primary server is on one workstation and 
the primary database can be on a separate workstation.

The 5620 SAM servers provide redundancy by each server sending pings to one 
another periodically at the application level. If the standby server cannot reach the 
primary server for 60 seconds, the standby server activates and becomes the primary 
server.

The 5620 SAM databases provide redundancy using Oracle DataGuard. The primary 
database records all transactions to a redo log. When the redo log reaches 1 GB in 
size, the data is transferred to an archive log. The archive log is transferred and 
applied to the standby database. Therefore, at any point in time, the standby database 
can become unsynchronized with the primary database by 1 GB of data.

The 5620 SAM client GUIs are connected to the primary server, even in the case of 
a server activity switch. Server activity switches are transparent to the 5620 SAM 
client. OSS clients can only connect to the primary server. OSS clients need to know 
which server is the primary server. Both the primary and standby servers have 
visibility of the redundant databases.

You can use the 5620 SAM GUI to:

• check the status of redundant 5620 SAM servers and databases
• perform a switchover from the primary to the standby 5620 SAM database

You can use scripts on the server to:

• perform a server activity switch from the primary to the standby 5620 SAM 
server

• perform failovers from the primary to the standby 5620 SAM database
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Consider the following:

• Only 5620 SAM or system administrators with appropriate workstation and user 
privileges on the server workstation, or client GUI users with admin user group 
privileges, can perform the server activity switch, database switchover, or 
database failover functions.

• Server and database redundancy must be used together. For example, you cannot 
have redundant servers and a standalone database.

• The terms active and secondary may be used instead of the terms primary and 
standby.

• Ensure NMS domain configuration is sufficient to handle latency and bandwidth 
requirements, as indicated in the 5620 SAM Planning Guide.

Redundancy is configured during the installation of each 5620 SAM application. See 
the 5620 SAM Installation and Upgrade Guide for more information about 
configuring the 5620 SAM applications for redundancy.

5620 SAM co-located redundancy
Figure 16-1 shows co-located redundancy.

Figure 16-1  Co-located 5620 SAM redundancy

Consider the following:

• The operating systems installed on the co-located primary and co-located standby 
5620 SAM server/database workstations must be of the same versions and at the 
same patch levels.

• The layout and partitioning of the disks containing the 5620 SAM software, the 
Oracle software and the database data must be identical on the co-located primary 
and co-located standby 5620 SAM server/database workstations.

• The workstation that is initially used as the co-located primary 5620 SAM 
server/database must be installed or upgraded before the workstation that is 
initially used as the co-located standby.
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5620 SAM distributed redundancy
Figure 16-2 shows distributed redundancy.

Figure 16-2  Distributed 5620 SAM redundancy

Consider the following:

• The operating systems installed on the primary and standby 5620 SAM server as 
well as the primary and standby 5620 SAM database workstations must be of the 
same versions and at the same patch levels.

• The layout and partitioning of the disks containing the 5620 SAM software, the 
Oracle software, and the database data must be identical on the primary and 
standby 5620 SAM database workstations.

• The machines that are intended to be used as primary 5620 SAM server and 
5620 SAM database should be installed on the same LAN as one another with 
high quality network connectivity.

General information about 5620 SAM redundancy activity switches, 
switchovers, and failovers

Figure 16-3 shows the three types of redundant activities: server activity switches, 
database switchovers, and database failovers.
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Figure 16-3  Redundancy examples

Table 16-1 describes activity switches, switchovers, and failovers in more detail.

Primary
database 1

Standby
database 2

Primary
server 1

Standby
server 2OSS or GUI

client
Activity Switch
1) Server 1 goes down
2) Server 2 comes up
3) Server 2 connects to database 1

A) database switchover
     Can be initiated by the server
     during an activity switch

B) Database failover
     Can be initiated by the server when
     primary database connectivity is lost,
     or initiated manually
     Should check which database
     is still available
     No automatic recovery

Managed
network

17701
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Table 16-1 Redundancy descriptions for activity switches, switchovers, and failovers

5620 SAM server activity switches
A 5620 SAM server activity switch can be performed to:

• recover from subnet failures or errors
• test redundancy in case of a catastrophic failure
• prepare workstations for a software upgrade

Type Description Notes

Server activity 
switch

An automatic activity switch occurs when the 
standby 5620 SAM server detects a 
communication failure, it assumes that the 
primary 5620 SAM server is unable to manage 
the network. The standby 5620 SAM server 
attempts to take over management of the 
network by establishing a connection to the 
primary 5620 SAM database.

Manual activity switches can be performed as 
required, for example, planned server 
maintenance.

 A successful connection attempt results in the 
standby 5620 SAM server taking over 
management of the network.

If a communication failure is detected by the 
primary 5620 SAM server, a message informs 
5620 SAM client GUI operators that the standby 
server is no longer visible.

An activity switch occurs automatically if the 
primary server is unreachable for more than one 
minute.

After the problem that caused the failure is 
resolved, client GUIs are informed that 
redundancy is operational.

You can perform a manual activity switch by 
executing the nmsserver.bash file with the 
force_restart option on the primary server 
machine.

Database 
switchover

A switchover is used to reverse roles between 
the primary and standby databases, for 
example, during planned maintenance of the 
primary database or when a server activity 
switch is performed.

A switchover can be initiated to have the primary 
and standby databases exchange roles, so that 
the primary becomes standby and the standby 
becomes primary.

For a switchover to occur, both the primary and 
standby databases must be functioning 
correctly and communicating with one another.

A user with admin privileges can perform a 
database switchover by clicking on the 
Switchover button on the 5620 SAM Database 
Manager form.

If the primary 5620 SAM server detects a 
communication failure to the standby 5620 SAM 
database, it informs client GUIs that the standby 
5620 SAM database is not reachable.

Once the problem that caused the 
communication failure is restored, client GUIs 
are informed that database redundancy is 
operational.

If the primary 5620 SAM server detects a 
communication failure to the primary 5620 SAM 
database, client GUIs are informed that the 
primary 5620 SAM database is not reachable.

A failover occurs automatically if the primary 
server cannot communicate with the primary 
database.

Following a failover, the previous primary 
database is considered unusable and must be 
manually reinstalled as the current standby 
database. Database redundancy is offline until 
the reinstallation occurs.

A failover can result in a loss of data up to 1 GB.

Database failover A failover is the transition of a standby database 
to the primary database role, for example, when 
there is a catastrophic failure of the primary 
database.

 A failover can be initiated to force the standby 
database to become the primary database, or it 
can be automatic.

If it is not possible to quickly resolve a failure 
where the primary and standby servers cannot 
access the primary database, then a failover 
should be triggered manually. This enables the 
standby 5620 SAM database to become 
operational.

You can manually perform a failover by 
executing the failoverdb.bash file.
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There are two types of activity switches for servers:

• automatic
• manual

During a server activity switch, the server does not process SNMP traps from the 
network, and all regularly scheduled resynchronizations do not occur. For example, 
if a statistics polling interval passes during an activity switch, statistics for that 
interval are not collected.

Figures 16-4 and 16-5 shows the sequence of events for a server activity switch.

Figure 16-4  Before a server activity switch

Figure 16-5  After a server activity switch

During the sequences described in Figures 16-4 and 16-5:

• Alarms are raised.
• Client GUIs are notified of server redundancy changes.
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Activity switch effects on clients

After an activity switch:

• GUI clients communicate with the new primary server and are aware of the status 
of the switches.

• OSS clients must reconnect to the primary server, as described in the 
Alcatel 5620 SAM-O OSS Interface Developer Guide.

If a deployment request from a client was not completed by the primary server before 
the activity switch, the new primary server attempts to redeploy the requests.

5620 SAM database switchovers
 Figures 16-6 and 16-7 show the before and after state of a successful database 
switchover.

Figure 16-6  Before a switchover example

Figure 16-7  After a switchover example

When the switchover is successful:

• database roles are switched from primary to standby
• the primary server can establish connections to the new primary database
• archive logging starts on the new primary database
• the former primary database becomes the standby database
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When a switchover is not successful, the server reverts the databases back to their 
original primary and standby configuration.

5620 SAM database failovers
Failovers are a transition of a standby database to the primary database role, for 
example, when there is a catastrophic failure of the primary database. Once a failover 
is performed, database redundancy is inactive. Manual intervention is required. See 
Procedure 16-4 and the 5620 SAM Installation and Upgrade Guide for more 
information.

A database failover is strictly a disaster recovery mechanism. A failover can only 
occur if both the primary server and standby database have lost visibility of the 
primary database.

Failovers can be:

• automatic
• manual

A database failover occurs automatically in the following scenarios:

• the primary database machine loses power
• the primary database machine becomes unreachable
• the primary database instance crashes or otherwise ceases to communicate with 

the primary server

The following conditions must be in place for failovers of either type to occur:

• standby database is configured and reachable
• primary database is unavailable

In addition, for automatic failovers to occur, the dbAutoFailOver must be configured 
in the nms-server.xml file on the 5620 SAM server.

Figures 16-8 and 16-9 show the before and after states of a successful failover.

Figure 16-8  Before a failover example
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Figure 16-9  After a failover example

When a failover is not successful, the server retries its connection to the former 
primary database. If the former primary database is not available, and automatic 
failover is configured, the failover is attempted again.

Communication between the primary server and the primary database must fail for a 
minimum of five minutes before an automatic failover occurs. If the type of failure 
also triggers a server activity switch, the time increases to a minimum of 15 minutes. 
Table 16-2 lists the minimum failure periods for specific scenarios that can lead to a 
database failover.

Table 16-2 Minimum lengths of communication failures before a failover is triggered

Redundancy scenarios in the NMS LAN
Figure 16-10 shows the effect of a primary server disconnection from the network.

Caution —  After a successful failover, database redundancy is not 
available. You must reconfigure the former primary database as the 
new standby. See Procedure 16-4 for more information.

Configuration Scenario Minimum length of 
communication failure

Co-located Primary database instance crashes, or 
otherwise ceases to communicate

5 minutes

Primary database machine loses power 15 minutes

Primary database machine becomes 
unreachable

15 minutes

Distributed Primary database instance crashes, or 
otherwise ceases to communicate

5 minutes

Primary database machine loses power 5 minutes

Primary database machine becomes 
unreachable

5 minutes
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Figure 16-10  Primary server disconnection from the network in a redundant 
configuration

If the primary server is disconnected from the rest of the network:

1 The standby server becomes the new primary server.

2 Standby down and activity switch alarms are raised.

After the server is reconnected to the network, one server becomes the primary and 
one becomes the standby.

Figure 16-11 shows the effect of a collocated redundant configuration when the 
primary server and database are down.
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Figure 16-11  Co-located primary database/server down

In this case:

• collocated standby becomes the primary 
• no redundancy exists until the former collocated primary is rebuilt as the new 

collocated standby

Figure 16-12 shows primary and standby components on separate, now 
disconnected, subnets.
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Figure 16-12  Subnet disconnection failure with redundant configurations

When the primary and standby servers run in separate subnet, and the two subnets 
cannot communicate:

1 The standby server becomes a primary server. The original primary server 
remains active.

2 On the active side, alarms cannot be raised because the new primary server 
cannot access the primary database. A standby down alarm and an activity switch 
alarm is raised.

3 Clients display the activity status of the servers.

4 If the failover is set for the database, then the database fails over.

The new primary server is not operational until the connection between two subnets 
is fixed or a database failover is performed. Failovers are enabled by default.

16.2 Workflow for 5620 SAM redundancy

1 Install the 5620 SAM for redundancy. See the 5620 SAM Installation and Upgrade 
Guide for more information.

Note —  You can eliminate the single point of failure between the two 
subnets by using two different physical routes. See the 5620 SAM 
Planning Guide for more information.
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2 Perform manual switches, as required.

a For 5620 SAM servers:

i Check the redundancy status of the 5620 SAM software.

ii Perform a manual activity switch on the primary 5620 SAM server.

iii Validate the updated redundancy status.

b For 5620 SAM databases:

i Check the redundancy status of the 5620 SAM software.

ii Perform a switchover or failover, as required.

iii Validate the updated redundancy status.

iv After a failover, re-establish redundancy between the standby and 
primary.

16.3 5620 SAM redundancy menus

Table 16-3 lists the menus related to redundancy and its functions.

Table 16-3 5620 SAM redundancy menus

16.4 5620 SAM redundancy procedures list

Table 16-4 lists the procedures to perform redundancy tasks.

Table 16-4 Redundancy procedures list

Menu option Function

Help→5620 SAM License Information Details about server redundancy status

Administration→Database Performing switchovers for the 5620 SAM 
database applications, as required, and view 
details of database redundancy status.

Procedure Purpose

To check redundancy status View the redundancy status for the 5620 SAM 
server and database.

To perform an activity switch on 5620 SAM 
servers

Perform an activity switch from the primary 
server to the standby server.

To perform a manual switchover on 5620 SAM 
databases

Perform a switch in roles from the primary 
database to the standby database.

(1 of 2)
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16.5 5620 SAM redundancy procedures

Use the following procedures to perform redundancy tasks.

Procedure 16-1  To check redundancy status

The redundancy status of all 5620 SAM software applications is available on client GUIs 
and from relevant application logs. To ensure that the redundancy status is as expected, 
the information on the client GUI and in the application logs must match.

1 To check server redundancy status

i Choose Help→5620 SAM License Information from the 5620 SAM main 
menu. The License form appears.

ii Review the server redundancy status. The information includes:

• whether redundancy is enabled for the servers
• the IP addresses of the primary and standby servers
• the status of each server

• Up
• Down in the case of an internal problem or subnet problem

• NotApplicable when redundancy is not enabled

iii Retrieve and open the server_console.log file for each server from the 
server_install_directory/nms directory.

For the primary server, the server_console.log file displays a message similar 
to the following:

2005.07.22 10:09:15 [STDOUT] It is started as a Primary Server 
2005.07.22 10:09:15 [STDOUT] 5620 SAM SERVER is 
pre-initializing

.....

.....

2005.07.22 10:41:51 [STDOUT]

++++++++++++++++++++++++++++++++++++++++++++++++++++++++++
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++
+++++++++++++++ 5620 SAM Service becomes Active +++++++++
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++

To perform a manual failover on 5620 SAM 
databases

Perform an failover from the primary database to 
the standby database.

To recover from a database failover Re-establish redundancy following a failover 
from the primary database to the standby 
database.

Procedure Purpose

(2 of 2)
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For the standby server, if redundancy is enabled, the server_console.log file 
displays a message similar to the following:

2005.07.22 10:09:15 [STDOUT] It is started as a Standby Server 
2005.07.22 10:09:15 [STDOUT] 5620 SAM SERVER is 
pre-initializing

.....

.....

2005.07.22 10:41:51 [STDOUT]

++++++++++++++++++++++++++++++++++++++++++++++++++++++++++
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++
+++++++++++++++ 5620 SAM Service becomes Standby +++++++++
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++

iv On the primary server machine, and the standby server machine if applicable, 
type:

ps -ef|grep java -server ↵

If the server status is Up, 1 process is displayed.

If the server status is Down, no processes are displayed.

2 To check database redundancy status

i Choose Administration→Database from the 5620 SAM main menu. The 
database manager form appears.

ii Review database redundancy status. The information includes:

• primary and standby database names, which should be identical
• primary and standby database instance names, which are unique
• the switchover and failover state of the standby database

• Up

• Down

• creation time of the primary database
• the IP addresses of the primary and standby databases
• time of the last performed switchover or failover

iii Retrieve and open the alert_database_instance.log file for each database from 
the database_install_directory/admin/database_instance/bdump directory.

For the primary database, the alert_database_instance.log file displays the 
following message:

DB Instance:
"fal_client = %INST_NAME%"
DB State (Primary):
"LGWR: Primary database is in CLUSTER CONSISTENT mode"
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For the standby database, if redundancy is enabled, the 
alert_database_instance.log file displays the following message:

DB Instance:
"fal_client = %INST_NAME%"
DB State (Standby):
"RFS[3]: Identified database type as 'physical standby'"

iv On the primary database machine, and the standby database machine if 
applicable, type:

ps -ef|grep ora ↵

If the database status is Up, more than 10 processes are displayed.

If the database status is Down, no processes are displayed.

v Verify the database proxy status on both databases. On the primary database 
machine, and the standby database machine if applicable, type:

ps -ef|grep databasermi.jar ↵

If the database proxy status is Up, one process is displayed.

If the database proxy status is Down, no processes are displayed.

3 To check ongoing redundancy status from the client GUI, view redundancy status in 
the taskbar.

Procedure 16-2  To perform an activity switch on 5620 SAM servers

Consider the following for redundant servers and performing a manual activity switch:

• When there are internal failures on a primary server, the server processes may 
not be able to shut down. A manual activity switch is necessary.

• For security purposes, you cannot perform a server activity switch from the GUI 
or an OSS.

• An activity switch from a primary to a standby server is visible to any connected 
client GUI. After an activity switch, the new primary server continues to try and 
deploy changes to network elements.

1 Log in to the primary server workstations as the user that installed the server.

2 Open a command or shell tool.

3 Type:

install_dir/nms/bin/nmsserver.bash force_restart ↵

where install_dir is the installation directory of the 5620 SAM server

The primary server is restarted as the standby server. The previous standby server 
becomes the primary server.
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4 Close the command or shell tool.

5 Clear alarms, as required. The activity switch alarms must be cleared manually.

6 Check that GUI and OSS clients are connected to the new primary server.

Procedure 16-3  To perform a manual switchover on 5620 SAM 
databases

1 Log in to the client GUI with 5620 SAM admin privileges.

2 Choose Administration→Database from the 5620 SAM main menu. The database 
manager form appears.

3 Click on the General tab button.

4 Review the current switchover status.

5 To perform a switchover, click on the Switchover button.

6 Respond to the prompt, and ensure you know the implications of performing a 
switchover:

• database roles are switched from primary to standby
• the primary server can establish connections to the new primary database
• archive logging starts on the new primary database
• the former primary database becomes the standby database

7 Confirm the action. The switchover is performed.

Procedure 16-4  To perform a manual failover on 5620 SAM 
databases

1 Log in to the primary server workstations as the user that installed the server.

2 Open a command line or shell tool.

3 Navigate to the install_dir/bin directory, where install_dir is the server installation 
directory.

4 Run the following command to perform a failover:

failover.bash ↵

Ensure you know the implications of a failover:

• the standby database is activated as the new primary database and the old 
primary database is no longer usable

• the primary server can establish connections to the new primary database
• archive logging starts on the new primary database
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5 Answer the prompts:

i Enter the system (sys) password for the standby database, as configured 
using the DBconfig installer.

ii Identify the IP address of the standby database, as configured using the 
DBconfig installer.

The failover is performed.

6 To re-establish redundancy, perform Procedure 16-5

Procedure 16-5  To recover from a database failover

Use this procedure to re-establish redundancy after a database failover. When a 
database fails over, the former standby database becomes the primary database, and 
redundancy is no longer active.

You must be familiar with the DBconfig installer to perform this procedure, and you must 
have oracle and root permissions on the database workstations.

On the primary database workstation

1 As oracle user, log in to the primary database workstation. Ensure that the DISPLAY 
variable is set.

2 As oracle user, launch DBconfig.bin.

3 Confirm the prompts until you reach the Choose Installation Type form. Select the 
Backup or Restore a Database option, and click on the Next button.

4 Choose the Backup a Database option, and click on the Next button.

5 Choose a directory with enough space to store the temporary Oracle files, and click 
on the Next button. Ensure that oracle user has write permissions to this directory.

6 Verify the directory in which Oracle is installed, and click on the Next button.

7 Verify the details of the primary database workstation, and click on the Next button. 
Specify the IP address of the primary database, a database name (samdb), the 
primary instance name (usually samdb1), a username (samuser), and password 
(Alcatel5620). Retain this information.

8 Ensure that “Backup is for standby” is selected and click on the Next button.

Caution —  Once the failover is performed, the former primary database 
is not configured as the standby, and redundancy is not active.

Note —  When the DBconfig installer instructs you to reboot or restart 
listener, perform the action.
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9 Specify an empty directory as the backup directory, and click on the Next button. 
The exact directory path and content must be re-created on the standby database 
workstation.

10 Click on the Start Backup button. The backup database is created in the empty 
directory.

11 As oracle user, FTP the backup files created in step 10 to the standby database 
workstation, ensuring that the files are copied into a directory with the exact 
directory path indicated in step 9.

On the standby database workstation

12 As oracle user, log in to the standby database workstation. Ensure that the 
DISPLAY variable is set.

13 As oracle user, uninstall the existing database by running the following command:

cd 
/opt/5620sam/samdb/install/Uninstaller/Uninstall_5620_SAM_Databa
se_Configurator ↵

14 Respond to the prompts to uninstall the existing database.

15 Delete all files in the /opt/5620sam/samdb/tablespaces directory.

16 As oracle user, launch DBconfig.bin.

17 Confirm the prompts until you reach the Choose Installation Type form. Select the 
Install & Configure Primary/Standby Databases option, and click on the Next button.

18 Choose the Standby Database Install option, and click on the Next button.

19 Choose the Do Not Install Oracle Software option, and click on the Next button.

20 Specify the directory in which the 5620 SAM database files are located (usually 
/opt/5620sam/samdb/install).

21 Verify the directory in which Oracle is installed (the same location as indicated in 
step 6), and click on the Next button.

22 Verify the details of the standby database workstation, and click on the Next button. 
Specify the IP address of the standby database workstation, a database name 
(samdb), and the instance name (usually samdb2).

23 Verify the default TCP port of 9002, and click on the Next button.

24 Verify the archive log directory (usually /opt/5620sam/samdb/archivelog), and click 
on the Next button.

25 Verify the details of the new primary database workstation (as configured in step 7), 
and click on the Next button. Specify the IP address of the new primary database 
workstation, the primary instance name (usually samdb1), passwords 
(Alcatel5620), the primary Oracle home directory (where Oracle is installed on the 
new primary database workstation), the primary archive log (where the 5620 SAM 
database files are installed on the new primary database workstation, usually 
/opt/5620sam/samdb/install), and the primary database proxy port (usually 9002).
16-20 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



16 —  5620 SAM redundancy
26 Specify the directory that contains the backup database that you sent by FTP from 
the primary database, as specified in step 9 and recreated on the standby in 
step 11, and click on the Next button. The files and directory must be accessible to 
oracle user.

You may be prompted to copy additional files from the primary to the standby if new 
archivelogs are created on the primary database workstation before the standby 
database is restored. If you receive this error message, copy the files indicated in 
the error message, using oracle permissions, from the primary workstation to the 
standby workstation.

27 Click on the Start Process button.

28 Run the indicated install_oracle_proxy_daemon.sh script as root, and click on the 
Next button.

29 Run the solaris_root.sh script as root.
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17.1 Service template overview

The 5620 SAM supports the configuration of VLL, VPLS, IES, and VPRN services 
using service-based templates. The templates allow a user with service management 
user group privileges to define common characteristics for a service, and the 
parameter values that must be changed. For example, the service management user 
can configure the requirement that all template users rename the template before the 
template is used to create a service in the network. See “Parameter configuration 
options” in section 17.1. The service management user can also apply a text mask to 
parameters that a user can or must modify. See “Text masks” in section 17.1.

Templates simplify service creation by reducing the number of steps required to 
create a service. Alcatel recommends using an existing valid service as a starting 
point for the creation of a template.

If a network object that is associated with a template is deleted from the managed 
network, the 5620 SAM raises an alarm against the template. The 5620 SAM clears 
the alarm when you open and save the template.

A service template uses secondary templates to further define the configuration 
details for the created service. The templates for sites, circuits, and interfaces are 
considered secondary templates. See “Secondary template binding” in section 17.1 
for more information.

You can create, modify, or delete service templates using the Template Manager 
form. The form allows you view all templates for services, sites, SDP bindings 
(service tunnels), and L2 and L3 interfaces. You can also use the form to bind site, 
SDP binding, and interface templates to a service template.

The template can specify the minimum and maximum number of times that a site, 
SDP binding, or interface template is used by a service template. For example, the 
template can specify that only two sites can be created from a site template.

You can use the edit version of the template binding form to configure support for 
the automatic creation and deletion of template objects. The objects are created when 
they meet the defined pre-creation conditions. For example, the Default Number of 
Bound Templated Objects To Pre-create parameter specifies the default number of 
child templates that can be automatically created from the parent template. For 
example, you can specify that a VPLS must use two site templates. The site templates 
are bound to the service template.

Parameter configuration options

Table 17-1 list the options for some of the parameters in service template 
configuration forms. The menus allow a user with service management privileges to 
configure the requirement for a template user to configure the parameter.
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Table 17-1 Parameter configuration options

Text masks

You can apply a text mask to string parameters that are set to Must Be Modified and 
May Be Modified. The text mask allows you to define the portion of the string 
parameter that must or can be configured by the user. The text mask used by service 
templates follows the conventions defined by the Java MaskFormatter class. 
Table 17-2 describes the text mask characters for the MaskFormatter class.

Table 17-2 Text mask characters

The text mask must be enclosed by ! symbols. For example, the text mask 
configuration in Figure 17-1 produces the parameter display in Figure 17-2.

Figure 17-1  Text mask configuration in a template form

Figure 17-2  Text mask display in a service form

Menu option Description

Frozen The template user cannot configure the parameter. A lock icon appears 
beside the corresponding parameter in the Service form for creating a 
service.

Must Be Modified The template user must configure the parameter. An exclamation mark icon 
appears beside the corresponding parameter in the form for creating a 
service. An exclamation mark also appears on the tabs with parameters that 
require configuration. Parameters set to Must Be Modified have a yellow data 
entry field.

May Be Modified The template user can, but is not required to, configure the parameter. 
Parameters set to May Be Modified have a white data entry field.

Mask character Description

# Any number

U Any character. Lowercase characters are mapped to uppercase characters

L Any character. Uppercase characters are mapped to lowercase characters

A Any character or number

— Use the underscore to represent any character

% Any number, character, or symbol

H Any hexidecimal character:

• 0 to 9
• a to f
• A to F
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You can use multiple pairs of ! symbols to create a multiple component text mask for 
a string parameter. The maximum character length for the string parameter is the 
only limit to the number of ! pairs used for the text mask.

Secondary template binding

You can bind a service template to site, SDP (service tunnel), L2 interface, or L3 
interface templates. The template binding creates a composite template for the 
service creation. You cannot change the binding policy after you bind a service 
template with secondary templates.

Subscriber association

You can associate a template with a subscriber, which allows you to create services 
for a specific subscriber. The following rules apply to the subscriber ID for service 
templates with secondary template bindings:

• You can change the subscriber ID if the secondary template bindings are not 
associated with any other service templates.

• The 5620 SAM propagates changes to the subscriber ID for a service template to 
all secondary template bindings.

• You can only change the subscriber ID for secondary template bindings by 
changing the subscriber ID in the service template.

• You can associate secondary templates with multiple subscribers when the 
template is not bound to a service.

• You can associate service templates with multiple subscribers when the template 
is not bound to a secondary template.

• You cannot modify the template binding policy after the association of the service 
and secondary template.

• You can associate a service template with a subscriber when you create the 
service.

17.2 Workflow to create a service template

1 Create a site template.

2 Create an SDP binding (service tunnel) template.

3 Create an L2 or L3 interface template.

4 Create a service template.

5 Bind a service template to a site, SDP (service tunnel), L2 interface, or L3 interface 
template, if required.

Note —  You must enter a two digit value for the ## symbols in 
Figure 17-2 before you can use the template.
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17.3 Service template menus

Table 17-3 lists and describes the 5620 SAM service template menus.

Table 17-3 Service template menus

17.4 Service template procedures list

Table 17-4 lists the procedures necessary to perform service template management 
tasks.

Table 17-4 Service template procedures list

17.5 Service template management procedures

This section contains procedures about how to create site, SDP, L2 interface, L3 
interface, and service templates.

Procedure 17-1  To create a site template

1 Choose Manage→Service Templates from the 5620 SAM main menu. The Manage 
Templates form appears.

2 You can:

a Create a site template using a blank Site Template form:

i Select the type of template you want to create from the top-left window of 
the Manage Templates form.

Menu item Description

Manage→Service Templates Create and bind service, site, SDP binding, and 
interface templates.

Create→Service from Template Create a service based on an existing template.

Procedure Purpose

To create a site template Create a site template.

To create an SDP binding (circuit) template Create a SDP binding (service tunnel) template.

To create an L2 access interface template Create an L2 interface template.

To create an L3 access interface template Create an L3 interface template.

To create a service template Create a service template and bind site, SDP 
(service tunnel), and interface templates.
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ii Click on the Create→Type of Template button. The appropriate Site 
Template form appears, as shown in Figure 17-3.

iii Configure the parameters in the appropriate tabs, if required. See the 
5620 SAM Parameter Guide for all applicable descriptions of parameters.

b Create a site template using the parameter values from a previously created 
site template:

i Use the filters to generate a list of appropriate templates.

ii Choose an existing site template.

iii Click on the Edit button. The Site Template form appears. Figure 17-3 
shows a blank version of the form.

iv Click on the Copy button. A second Site Template form appears.

v Enter a name for the template using the Template Description parameter.

vi Configure the parameters, if required.

Figure 17-3  Site Template form

3 Configure the requirement for a template user to configure the parameter using the 
associated drop-down menu, if available. The menu options are: Frozen, May Be 
Modified, or Must Be Modified. See “Parameter configuration options” in 
section 17.1 for more information.

4 Configure a text mask for the parameters that are set to the Must Be Modified or May 
Be Modified option, if required. See “Text masks” in section 17.1 for more 
information.
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5 Click on the OK button in the Site Template form.

6 Click on the OK button in the Template Manager form.

Procedure 17-2  To create an SDP binding (circuit) template

1 Choose Manage→Service Templates from the 5620 SAM main menu. The Manage 
Templates form appears.

2 You can:

a Create a SDP binding (formerly called a circuit) template using a blank SDP 
Binding Template form. SDPs are also called service tunnels:

i Select the type of template you want to create from the top-left window of 
the Manage Templates form.

ii Click on the Create→Type of Template button. The appropriate SDP 
binding template form appears, as shown in Figure 17-4.

iii Configure the parameters in the appropriate tabs, if required. See the 
5620 SAM Parameter Guide for all applicable descriptions of parameters.

b Create an SDP binding template using the parameter values from a previously 
created SDP binding template:

i Use the filters to generate a list of appropriate templates.

ii Choose an existing SDP binding template.

iii Click on the Edit button. The SDP binding template form appears. 
Figure 17-4 shows a blank version of the form.

iv Click on the Copy button. A second SDP binding template form appears.

v Enter a name for the template using the Template Description parameter.

vi Configure the parameters in the appropriate tabs, if required.
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Figure 17-4  SDP binding template form

3 Configure the requirement for a template user to configure the parameter using the 
associated drop-down menu, if available. The menu options are: Frozen, May Be 
Modified, or Must Be Modified. See “Parameter configuration options” in 
section 17.1 for more information.

4 Configure a text mask for the parameters that are set to the Must Be Modified or May 
Be Modified option, if required. See “Text masks” in section 17.1 for more 
information.

5 Click on the OK button in the SDP binding template form.

6 Click on the OK button in the Template Manager form.

Procedure 17-3  To create an L2 access interface template

1 Choose Manage→Service Templates from the 5620 SAM main menu. The Manage 
Templates form appears.

2 You can:

a Create a L2 access interface template using a blank L2 interface Template 
form:

i Select the type of template you want to create from the top-left window of 
the Manage Templates form.
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ii Click on the Create→Type of Template button. The appropriate L2 
access interface template form appears, as shown in Figure 17-5.

iii Configure the parameters in the appropriate tabs, if required. See the 
5620 SAM Parameter Guide for all applicable descriptions of parameters.

b Create an L2 access interface template using the parameter values from a 
previously created L2 access interface template:

i Use the filters to generate a list of appropriate templates.

ii Choose an existing L2 access interface template.

iii Click on the Edit button. The L2 Access Interface Template form appears. 
Figure 17-5 shows a blank version of the form.

iv Click on the Copy button. A second L2 Access Interface Template form 
appears.

v Enter a name for the template using the Template Description parameter.

vi Configure the parameters in the appropriate tabs, if required.

Figure 17-5  L2 Access Interface Template form

3 Configure the requirement for a template user to configure the parameter using the 
associated drop-down menu, if available. The menu options are: Frozen, May Be 
Modified, or Must Be Modified. See “Parameter configuration options” in 
section 17.1 for more information.

4 Configure a text mask for the parameters that are set to the Must Be Modified or May 
Be Modified option, if required. See “Text masks” in section 17.1 for more 
information.

5 Click on the OK button in the L2 Access Interface Template form.
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6 Click on the OK button in the Template Manager form.

Procedure 17-4  To create an L3 access interface template

1 Choose Manage→Service Templates from the 5620 SAM main menu. The Manage 
Templates form appears.

2 You can:

a Create a L3 access interface template using a blank L3 interface Template 
form:

i Select the type of template you want to create from the top-left window of 
the Manage Templates form.

ii Click on the Create→Type of Template button. The appropriate L3 
access interface template form appears, as shown in Figure 17-6.

iii Configure the parameters in the appropriate tabs, if required. See the 
5620 SAM Parameter Guide for all applicable descriptions of parameters.

b Create an L3 access interface template using the parameter values from a 
previously created L3 access interface template:

i Use the filters to generate a list of appropriate templates.

ii Choose an existing L3 access interface template.

iii Click on the Edit button. The L3 Access Interface Template form appears. 
Figure 17-6 shows a blank version of the form.

iv Click on the Copy button. A second L3 Access Interface Template form 
appears.

v Enter a name for the template using the Template Description parameter.

vi Configure the parameters in the appropriate tabs, if required.
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Figure 17-6  L3 Access Interface Template form

3 Configure the requirement for a template user to configure the parameter using the 
associated drop-down menu, if available. The menu options are: Frozen, May Be 
Modified, or Must Be Modified. See “Parameter configuration options” in 
section 17.1 for more information.

4 Configure a text mask for the parameters that are set to the Must Be Modified or May 
Be Modified option, if required. See “Text masks” in section 17.1 for more 
information.

5 Click on the OK button in the L3 Access Interface Template form.

6 Click on the OK button in the Template Manager form.

Procedure 17-5  To create a service template

1 Choose Manage→Service Templates from the 5620 SAM main menu. The Manage 
Templates form appears.

2 You can:

a Create a service template using a blank service template form:

i Select the type of template you want to create from the top-left window of 
the Manage Templates form.

ii Click on the Create→Type of Template button. The appropriate service 
template form appears, as shown in Figure 17-7.

iii Configure the parameters in the appropriate tabs, if required. See the 
5620 SAM Parameter Guide for all applicable descriptions of parameters.
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b Create a service template using the parameter values from a previously 
created service template:

i Use the filters to generate a list of appropriate templates.

ii Choose an existing service template.

iii Click on the Edit button. The Service Template form appears. Figure 17-7 
shows a blank version of a form.

iv Click on the Copy button. A second Service Template form appears.

v Enter a name for the template using the Template Description parameter.

vi Configure the parameters in the General and Transport tabs, if required. 
See chapter 63 for information about the parameters that are used to 
create a service template.

Figure 17-7  Service Template form

3 Configure the requirement for a template user to configure the parameter using the 
associated drop-down menu, if available. The menu options are: Frozen, May Be 
Modified, or Must Be Modified. See “Parameter configuration options” in 
section 17.1 for more information.

4 Configure a text mask for the parameters that are set to the Must Be Modified or May 
Be Modified option, if required. See “Text masks” in section 17.1 for more 
information.
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5 Bind preconfigured templates for sites, SDP bindings, L2 access interfaces, and L3 
access interfaces to the service template, if required.

i Click on the appropriate tab button in the Service Template form.

ii Click on the Bind button. The related binding form appears, as shown in 
Figure 17-8.

Figure 17-8  Add SDP binding Template Binding form

iii Choose a template.

iv Click on the OK button. The service template name appears in the Service 
Template form under the appropriate tab — Site templates, Type of SDP 
binding templates, L2 access interface templates, or L3 access interfaces 
templates tabs.

6 Define the details of the template bound to the service.

i Click on the appropriate tab button in the Service Template form.

ii Choose the template that is bound to the service.

iii Click on the Edit Binding button. Figure 17-9 shows an example of a binding 
form.

Figure 17-9  Edit SDP binding template binding form

iv Configure the parameters for the bound template.

v Click on the OK button.

Note —  The templates that appear in the binding form are dependant on 
subscriber associations, if any. See “Subscriber association” in 
section 17.1 for more information.
Alcatel 5620 Service Aware Manager, Release 3.0 R1 17-13
October 2005 3HE00214 CA



17 —  Service template administration
7 Click on the OK button in the Service Template form.

8 Click on the OK button in the Template Manager form.

You can then use the service templates to create services, as described in the 
appropriate service configuration chapter.
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18.1 5620 SAM and 5750 SSC integration overview

The 5620 SAM can be configured to interwork with the 5750 Subscriber Services 
Controller. The 5750 SSC provides centralized control of subscriber access services 
for triple play service delivery, for example, DHCP to identify subscribers and 
trigger service configuration or on-demand service profile changes made by the 
customer.

Configuration of 5750 SSC is performed using 5750 SSC application GUIs, as 
described in the appropriate 5750 SSC user documentation, including the 5750 SSC 
Service Manager User Guide and the 5750 SSC User Guide. To ensure 5750 SSC 
management of subscribers and services, you must configure the 5620 SAM to allow 
interworking, as shown in Figure 18-1.

Figure 18-1  5750 SSC and 5620 SAM interworking

You use the 5750 SSC Service Manager to create and manage subscriber services, 
including user account information and quality of service levels. 5750 SSC user 
accounts represent the residential subscribers of triple play services. Information 
configured in the 5750 SSC Service Manager is used to build the subscriber web 
portal for user self-management. Figure 18-2 shows a subscriber web portal and how 
its component pieces are built based on 5750 SSC subscriber management 
configurations.
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Figure 18-2  Subscriber web portal

When DHCP relay is used by subscriber’s to obtain IP addresses and other network 
information necessary for triple play service delivery, you can use the 5620 SAM to 
configure the managed devices to act as DHCP relay agents, which allows 
interworking with the 5750 SSC DHCP solution. Figure 18-3 shows how DHCP is 
used.
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Figure 18-3  DHCP relay and the 5750 SSC
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18.2 Workflow for 5620 SAM network management 
interworking

1 Install and configure all 5750 SSC components, as described in the appropriate 
5750 SSC user documentation.

2 Ensure that the 5620 SAM server is configured to support OSS navigation from the 
5750 SSC.

3 Configure the necessary 5750 SSC service manager objects to prepare for 
importing 5620 SAM VPLS SAP data into the 5750 SSC service manager database.

• Create an EDPS cluster. 
• Create an organization and an organization profile set.
• Create a domain and associate it with the organization.
• Create account profiles for users and add bandwidth services to the user profile.
• Create user profiles that represent the subscribers.
• Create service profiles that associate 5750 SSC DBM bandwidth service QoS 

with 5620 SAM QoS and filtering policies and metering services with 5620 SAM 
statistics policies, to determine the level of service that can be offered to 
subscribers.

• Create service catalogs, which consist of numerous service packages, and 
ensure the service package assigned to a subscriber account is what appears in 
the subscriber web portal when the subscriber logs on for self-service 
management.

4 Configure the necessary 5620 SAM and managed device settings and parameters 
to ensure interworking with the 5750 SSC.

• The plug-in servlet is configured on 5620 SAM and 5750 SSC templates are 
installed and available on the 5620 SAM server.

• At least one 7450 ESS is configured and managed.
• FTP enabled on the 5620 SAM server.
• A VPLS is configured with SAPs on the managed 7450 ESS and 7750 SR.
• OSS metadata fields are configured for all managed SAPs that will be 

associated with 5750 SSC user accounts.
• A 5620 SAM-O user account is configured.
• All necessary QoS, accounting, and ACL policies are configured on 5620 SAM.
• A 5750 SSC subscriber is created using 5620 SAM. 

5 Continuing configuring the 5750 SSC service manager software and auto discover 
the VPLS SAP data in the 5620 SAM-managed network.

• Ensure the EDPS and 5620 SAM plug-ins are installed.
• Create an EMS that connects the 5750 SSC to the 5620 SAM and reconciles 

OSS metadata associated with subscriber VPLS SAPs.
• Create two sets of credentials for the user account, one for the subscriber and 

one for the administrator.

6 Search for and modify existing user account data, or create new user accounts, as 
required.
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7 Manage the services and subscribers using the 5750 SSC, as described in the 
5750 SSC user documentation.

8 Configure the service L2 or L3 interface SAPs, using the 5620 SAM, to allow the 
managed devices to act as DHCP relay agents, when the 5750 SSC is configured 
as a DHCP server.

18.3 5620 SAM and 5750 SSC interworking menus

The menus that are used to enable functions are described in the appropriate user 
documentation for the 5750 SSC software. See the appropriate documentation for 
more information about how to use the 5750 SSC.

18.4 5620 SAM and 5750 SSC interworking procedure list

Table 18-1 lists the procedures to use interworking functionality between the 
5620 SAM and the 5750 SSC.

Table 18-1 5620 SAM and 5750 SSC interworking procedures list

Procedure Purpose

To configure the 5750 SSC Service Manager to 
interwork with the 5620 SAM

Necessary 5750 SSC pre-configurations before 
adding VPLS SAPs from the 
5620 SAM-managed network and creating user 
accounts based on the data.

To verify 5620 SAM plug-in installation Ensure that all software necessary for 
interworking is installed in the correct directories.

To create a 5620 SAM-O user account Necessary to retrieve VPLS SAP information 
from 5620 SAM and to create accounts in 
5750 SSC based on those SAPs.

To create a 5750 SSC system subscriber on the 
5620 SAM

Necessary to perform interworking between 
5750 SSC and 5620 SAM.

To configure managed devices for 5750 SSC 
management

Necessary preconditions in the 
5620 SAM-managed domain before 5750 SSC 
management is possible.

To enable and configure FTP on the 5620 SAM 
server

To configure VPLS SAP metadata using option 
82

Preparation of SAP metadata for use by the 
5750 SSC.

To configure policies in 5620 SAM for use by 
5750 SSC Service Manager bandwidth 
management

Creation of necessary 5620 SAM policies, used 
to create 5750 SSC bandwidth (QoS) services 
and metering (statistics) services, for use by 
subscribers.

To discover 5620 SAM VPLS SAP data and add 
accounts to the 5750 SSC Service Manager

Necessary 5750 SSC configurations to create, 
incorporate, and manage subscribers of triple 
play services.

To rediscover VPLS SAP information When VPLS SAP data changes in the 
5620 SAM-managed network, use the 5750 SSC 
service manager to rediscover the changes, and 
update or create new user accounts.

(1 of 2)
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18.5 5620 SAM network management interworking procedures

The following procedures describe how to interwork with the 5750 SSC.

Procedure 18-1  To configure the 5750 SSC Service Manager to 
interwork with the 5620 SAM

1 Launch the 5750 SSC from the desktop service manager icon

2 Log in using your account.

3 Associate EDPS clusters with the credential that represents the DSL user account 
subscriber. This must be created before residential users can log in to their 
self-service web portals.

i Click on the System tab button at the bottom of the service manager form.

ii Double-click on the SAP folder.

iii Select the EDPS Cluster folder.

iv Right-click and choose New EDPS Cluster from the contextual menu. The new 
EDPS cluster form appears as shown in Figure 18-4.

To search for 5750 SSC users and user accounts Use the 5750 SSC service manager user search 
tool to filter and find user accounts.

To create new accounts in the 5750 SSC service 
manager

Use the 5750 SSC service manager to create 
new accounts.

To configure L2 and L3 SAPs as DHCP relay 
agents

Use the 5620 SAM to configure managed device 
L2 and L3 SAPs to act as DHCP relay agents, 
enabling the forwarding of DHCP requests for IP 
address allocation and other network information 
details from subscribers to DHCP servers.

Procedure Purpose

(2 of 2)
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Figure 18-4  New EDPS cluster form

v Configure the EDPS parameters. Table 18-2 lists the parameters that need to 
be configured.
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Table 18-2 EDPS parameters

vi Type the attribute names and required attribute values using the information in 
Table 18-2. Click on the Add button to add each attribute.

vii Click on the OK button to save the changes.

viii Verify that the EDPS server is correctly configured. Check the following:

/WideSpan/plug-ins/rms/rmsedps/rmsedps-conf.xml ↵

Verify the configuration.

....

<rmsedps-conf session-add-name="SSC:SessionAdd" 
session-del-name="SSC:SessionRemove" 
send-condition="always">

<edps-server ip="138.120.111.112:8070" port="Value from 
Table" secret="EDPSSECRET" timeout="10">

.....

Parameter value added to 5750 SSC Notes Sample

EdpsCluEdpsClusterSecondaryUrl The secondary EDPS server IP address 
and port number

http://138.120.111.111:8070

EdpsClusterPrimaryConnTimeout The timeout value for the primary EDPS 
server, in seconds

10

EdpsClusterPrimarySecret The password for the primary EDPS 
server

EDPSSECRET

EdpsClusterPrimaryTimeout The timeout value for the primary EDPS 
server, in seconds

10

EdpsClusterPrimaryUrl The primary EDPS server IP address 
and port number

http://138.120.111.112:8070

EdpsClusterSecondaryConnTimeout The timeout value for the secondary 
EDPS server, in seconds

10

EdpsClusterSecondarySecret The password for the secondary EDPS 
server

EDPSSECRET

EdpsClusterSecondaryTimeout The timeout value for the secondary 
EDPS server, in seconds

10

RMSCluster The RMS cluster ID 0
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4 Create profile sets for an organization. An organization profile set is required to 
configure organization-specific services.

i Click on the root organization icon.

ii Choose File→New→Profile Set from the menu.

iii Click on the Organization radio button.

iv Configure the organization profile set.

• create a name for the profile set
• choose whether inheritance is used

v Click on the Create button to create the profile set.

vi Click on the OK button to save the changes.

5 From under the root organization, create a new organization. The root organization 
represents the company or ISP that owns the 5750 SSC. Child sub-organizations 
are logical groupings of organizations or subscribers, for example, regional groups 
or residential groups using the same network.

i Choose File→New→Organization from the menu. Figure 18-5 shows the 
organization form.
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Figure 18-5  Organization form

ii Configure the organization.

• create a domain for the organization
• choose the organization profile set created in step 4.

iii Click on the Create button to create the organization.

iv Click on the OK button to save the organization. The new organization icon 
appears.
Alcatel 5620 Service Aware Manager, Release 3.0 R1 18-11
October 2005 3HE00214 CA



18 —  5620 SAM and 5750 SSC integration configurations
6 Create profile sets for accounts. The 5620 SAM plug-in will create the accounts 
automatically later, so only account profiles are required.

i Click on the organization icon created in step 5.

ii Choose File→New→Profile Set from the menu.

iii Click on the Account radio button to create an account profile set.

iv Configure the account profile set.

• create a name for the profile set
• verify that inheritance is set to Yes

v Click on the Create button to create the profile set.

vi Click on the OK button. The profile set is added to the Service Manager, under 
the folder structure Profiles Sets→User Profile Sets→Name of profile set.

7 Create profile sets for users. This will set the credentials to exist within each account 
that will be automatically created by the 5620 SAM plug-in. Two user profiles are 
created: AccountAdmin and DSL. The AccountAdmin credential is required for login 
authorization when the subscriber uses their self-service web portal. The DSL 
credential is required for DHCP authorization and service configuration.

i Click on the organization icon created in step 5.

ii Choose File→New→Profile Set from the menu. Figure 18-6 shows the new 
profile set form.
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Figure 18-6  New profile set form

iii Click on the User radio button to create a user profile set for the AccountAdmin 
credential.

iv Configure the AccountAdmin user profile set.

• create a name for the user profile set, for example, training organization 
admin user profile set

• choose whether inheritance is used

v Click on the Create button to create the profile set.

vi Click on the OK button to save the profile set.

vii Create two user profile sets for the DSL credential. Name one user profile set 
no service for DSL credential, and the other express service for DSL 
credential.

viii For each DSL credential, click on the DBM→Metering Service icon.

The managing profile set form appears, as shown in Figure 18-7.
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Figure 18-7  Managing profile set form

ix Click on the Add button. The metering service icon is added to the list of 
assigned service profiles.

x Click on the DBM→Bandwidth Service icon.

xi Click on the Add button. The bandwidth service icon is added to the list of 
assigned service profiles.

xii Click on the OK button. The profile set is added to the Service Manager, under 
the folder structure Profiles Sets→User Profile Sets→Name of profile set.

8 Configure bandwidth services that will be available for all organizations and 
credentials for the DSL user profile.

i Click on the root organization in the 5750 SSC Service Manager navigation 
tree.

ii Select the Service Profiles→DBM→Bandwidth Service icon.

iii Right-click on the icon and choose Edit from the contextual menu.

iv Configure the bandwidth service profile. This bandwidth service profile is 
associated with user profile sets, created in step 7. The sets of bandwidth 
profiles will determine the types of QoS that can be offered to residential or 
other users.

v Click on the Attribute Information tab button. A list of available QoSs appears. 
You can configure new bandwidth QoS service levels, based on your 
5620 SAM-managed network QoS policies, such as access ingress or 
scheduler policies.

vi Click on the Create New QoS button to create a new QoS. Figure 18-8 shows 
the attribute information form.
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Figure 18-8  Attribute information form

vii Configure the QoS:

• Specify the name, caption, and description. The name should reflect the 
service types you want residential subscribers to see, as that is the 
information they will view from the self-service web portal.

• Specify the weight. Weight is used to determine the possible upgrades for 
a residential subscriber. Any service type of a greater weight than the 
current service for the residential subscriber can be chosen as an upgrade, 
as shown in Figure 18-2.

• Specify any or all of the available attributes. These are the seven QoS 
levels associated with 5620 SAM policies, such as access ingress. See 
Table 18-3 for the attribute-to-5620 SAM policy mapping list.

• When you have chosen a an attribute name, specify the value. This value 
is the ID of the 5620 SAM policy.

viii Click on the Add button to add the attribute name and value to the new QoS. 
The attribute and value are added to the provisioned attributes table.

ix Click on the Create button to create the new QoS.

x Repeat for all the bandwidth QoS types required.

xi Create a new user profile for each bandwidth QoS type created in this step, as 
described in step 7. For example, if you created a QoS titled Elite Video, create 
a user profile called Elite Video.
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xii Choose Metering Service and Bandwidth Service from the left hand window 
and click the Add button. The icons move to the right window.

xiii Click on the Bandwidth Service icon in the right window. A new Service Profile 
(Bandwidth Service) tab button appears.

xiv Click on the Service Profile (Bandwidth Service) tab button.

xv Choose the Assigned QoS Level option that matches the profile name. For 
example, if the new user profile is Elite Video, choose the Elite Video option.

xvi Click on the OK button to save the changes.

9 Create a service catalog. Service catalogs list all service packages available to 
residential users (subscribers). After all user profiles are created, they are assigned 
to service packages within the service catalog.

i Choose File→New→Service→Catalogue from the menu. The new catalogue 
form appears with the User Types tab button selected.

ii Configure the user types. Two users types are required: one to allow 
residential users to log in using their subscriber web portal (for example, 
AccountAdmin) and another to link the subscriber to the 5750 SSC 
provisioning server (for example, DSL). Figure 18-9 shows the two user types 
created.

Figure 18-9  User types in service catalog
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A blank user type is required to save the two other accounts to the database.

iii Click on the Add button to create accounts.

iv Set the user type (account name) and caption (description).

v Click on the Service Packages tab button. Figure 18-10 shows the form with 
completed service package types added.
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Figure 18-10  Service package in user catalog

vi Configure service packages. Create a service package name for each user 
profile created. For example, For the Elite Video QoS and user profile, there 
should be a service package called Elite Video.

• The package name and description will appear on the residential 
subscriber web portal.

• Weight determines the service package’s place in the hierarchy. A lower 
number places the service package lower in the service upgrade path. 
Residential users can use their web portal to upgrade to services higher in 
the service upgrade hierarchy.

• Associate the user profile set (for example, AccountAdmin) created in 
step 6 with the user types created earlier in this step. One user profile set 
is required for AccountAdmin. The DSL user should have the Max Allowed 
Users that corresponds with the number of remote gateways and set top 
boxes the subscriber uses.

• The maximum allowed users parameter for AccountAdmin specifies how 
many concurrent log-ins a home user is allowed through their self-service 
web portal. This is usually one.

• The maximum allowed users parameter for DSL specifies the maximum 
number of residential gateways each home user is allowed.

vii Click on the Add button to add the new service packages.

viii Click on the OK button to save the changes.
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10 Begin configuring the 5620 SAM.

Procedure 18-2  To verify 5620 SAM plug-in installation

The 5620 SAM plug-in is available on the product DVD-ROM. It is used for 
communication between the EDPS server and the servlet on the 5620 SAM. Contact your 
Alcatel support representative for more information about installing the plug-in 
executables.

1 Verify that the 5620 SAM plug-in is installed on the 5750 SSC server:

i As root, open a command tool on the 5750 SSC server.

ii Type:

pkginfo | grep BWSssc ↵

The following output should appear.

application BWSsscpi

application BWSsscs

2 FTP a copy of the ssc.war.zip file from the 5750 SSC server to the 5620 SAM server 
and install the file in the correct directory.

i As root, open a command tool on the 5620 SAM server.

ii Type:

unzip ssc.war.zip ↵

iii Type:

mv ssc.war 
/opt/5620sam/server/nms/jboss/server/default/deploy ↵

Procedure 18-3  To create a 5620 SAM-O user account

The plug-in for the 5620 SAM and the 5750 SSC provisioning server communicates 
directly through the 5620 SAM-O interface.
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1 Create a new 5620 SAM-O user account and user group, as described in 
chapter 11.

i As admin, choose Security→5620 SAM Security Manager from the 5620 SAM 
main menu. The Security Management (Edit) form appears.

ii Click on the User Groups tab button.

iii Create a new group by clicking on the Create button. The User Group 
configuration form appears with the General tab button selected. 

iv Configure the parameters.

Ensure the following during account creation:

• the name of the account is adminsamo
• the user state is active
• all group permissions are granted except admin

v Click on the Apply button to save the changes. Validate the action.

vi Click on the OK button to close the form.

When you change group permissions, the permissions of all users in the group 
are altered immediately when you click on the OK button.

2 Use the account for 5620 SAM-O.

Procedure 18-4  To create a 5750 SSC system subscriber on the 
5620 SAM

The 5750 SSC system subscriber created on the 5620 SAM is used to manage those 
services in 5620 SAM that are to be reconciled with the 5750 SSC, and subsequently 
managed by the 5750 SSC. This subscriber is not associated with 5750 SSC user 
accounts or subscribers.

1 Create a new 5750 SSC system subscriber. Subscriber creation is described in 
chapter 29.

2 Ensure the following during subscriber creation:

• the name of the subscriber is ssc
• note the ID of the subscriber, which is used when creating the EMS element 

management system (5620 SAM) using the 5750 SSC Service Manager

Procedure 18-5  To configure managed devices for 5750 SSC 
management

1 Perform device commissioning, as described in chapter 8.
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2 Discover and begin to manage the devices, as described in chapter 9.

3 Configure the VPLS service, as described in chapter 31.

Procedure 18-6  To enable and configure FTP on the 5620 SAM 
server

1 Perform device commissioning, as described in chapter 8, and ensure that ftp is 
enabled on the managed devices.

2 Ensure FTP is enabled between the server and the managed network, as described 
in chapter 14.

3 Ensure user access to FTP functions, as described in chapter 12.

Procedure 18-7  To configure VPLS SAP metadata using option 82

1 Ensure the 5620 SAM-O user account is created, as described in Procedure 18-3.

2 You can:

a Create a 5620 SAM-O OSS script to populate the OSS metadata field of SAPs 
within the VPLS service being managed by the 5620 SAM. Contact your 
Alcatel support representative for more information about OSS scripts. The 
syntax for the option 82 metadata is ssc(string), where string can be:

• The MAC address of the subscriber’s residential gateway, in the form 
ssc(0030:1b:b0:03:04)

• The DHCP option 82 string circuit ID value associated with the 
7330 ISAM FTTN, or other ISAM family of nodes in the form 
ssc(SSL-7330-1 atm 1/1/04/06:8.35).
The device port_type rack/shelf/slot/port: VPI:VCI identifier on the 
7330 ISAM FTTN indicates that this is the connection configured for 
subscriber use, which is connected to the subscriber’s residential gateway.

• The DHCP option 82 string remote ID value associated with the 
7330 ISAM FTTN, or other ISAM family of nodes in the form ssc(remote 
ID).

You must use the exact syntax indicated. To map a SAP to an account, there 
must be one credential with the same log in name as used in the OSS 
metadata field. For example, a credential is created for ssc as described in 
Procedure 18-1 to match the metadata field.

b Use the 5620 SAM client GUI to populate the date, per L2 interface that will be 
used as the VPLS SAP.

i Open the nms-client.xml file from the 
/client_installation_directory/nms/config directory.

ii Modify the line <ossMetaData show=”false” /> to “true”.
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iii Save the file.

iv Restart the client GUI.

v Open a L2 access interface properties form on the client GUI. The OSS 
Meta Data tab button appears.

vi Configure the OSS Meta Data parameter using the exact syntax indicated 
in step 2a.

When the 5750 SSC Service Manager is used to connected to the EMS 
(5620 SAM), all 5620 SAM-managed SAPs for a VPLS that meet the criteria of 
having valid OSS metadata to ensure creation of new accounts on the 5750 SSC.

Procedure 18-8  To configure policies in 5620 SAM for use by 
5750 SSC Service Manager bandwidth management

1 Create the following policies in 5620 SAM. These policies will be applied to a user 
in the 5750 SSC Service Manager and are then applied to the user SAP:

• accounting
• access ingress
• access egress
• schedulers for ingress and egress
• IP ACL filters for ingress and egress

Accounting policies are associated with 5750 SSC metering services, using 
statistics to track usage information. QoS and filter policies are associated with 
5750 SSC QoS bandwidth services, used to determine the quality of service offered 
to residential customers, for example, gold, silver, or bronze. See chapter 28 for 
more information about configuring 5620 SAM policies.

2 Use the 5750 SSC Service Manager to edit the bandwidth service within the service 
profiles and associate the 5620 SAM policies with the QoS attribute in 5750 SSC. 
You need:

• the policy name
• the policy ID

Table 18-3 shows the mapping of bandwidth QoS parameters to 5620 SAM policies 
and sample IDs, where an ID is a generated ID value in 5620 SAM, for example, 
500. The values you enter in the 5750 SSC Service Manager must match exactly 
the values in the second column.
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Table 18-3 5750 SSC bandwidth QoS parameters mapping to 5620 SAM policies and 
sample IDs

Note
(1) Scheduler policies use the policy name, not an ID.

Once the bandwidth QoS settings are associated and applied to a user using the 
5750 SSC Service Manager, the policies are applied to the user VPLS SAP, as 
modified on the managed devices by the 5620 SAM.

Procedure 18-9  To discover 5620 SAM VPLS SAP data and add 
accounts to the 5750 SSC Service Manager

1 Launch the 5750 SSC from the desktop service manager icon

2 Log in using your account.

3 Ensure that the EDPS plug-in for 5620 SAM is installed correctly.

i As root, open a command tool on the 5750 SSC server.

ii Type:

pkginfo | grep BWSsscpi ↵

The following output should appear.

application BWSsscpi SSC RMS, EDPS and RADIUS Plug-ins

5750 SSC bandwidth QoS parameters Matching 5620 SAM policies and IDs

Accounting Policy ID Accounting:50

Egress Filter ID IP ACL Filter:600

Egress Policy ID Access Egress:400

Egress Scheduler Policy ID Scheduler:No Service (1)

Ingress Filter ID IP ACL Filter:200

Ingress Policy ID Access Ingress:800

Ingress Scheduler ID Scheduler:Service (1)
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4 Configure EDPS to use the same DSL bandwidth user configured in the service 
catalog, as described in Procedure 18-1.

i Ensure that the /WideSpan/plug-ins/ssc-config.xml file is configured correctly 
for DSL user accounts.

<ssc-config>

<bandwidth-user-type>DSL</bandwidth-user-type>

</ssc-config>

ii Restart EDPS if the file is changed.

/etc/init.d/wsEDPS.stop ↵

/etc/init.d/wsEDPS.start ↵

5 Ensure that the Perversive plug-in for 5620 SAM is installed correctly.

i As root, open a command tool on the 5750 SSC server.

ii Type:

pkginfo | grep BWSssc ↵

The following output should appear.

application BWSssc SSC Provisioning Server (Provserver 
plug-in)

6 Configure the Perversive to use the same user types that were defined in the service 
catalog, as described in Procedure 18-1.

i Ensure that the /WideSpan/config/Provserver/dbmprov-service.xml file is 
configured correctly for DSL and AccountAdmin user accounts.

<component class=....>

.....

<admin-user-type>AccountAdmin</admin-user-type>

<device-user-type>DSL</device-user-type>

....

</component>

ii Restart the Provserver if the file is changed.

/etc/init.d/wsprovs.stop ↵

/etc/init.d/wsprovs.start ↵
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7 Create an EMS on 5750 SSC and reconcile the VPLS SAP information from the 
5620 SAM-managed network:

i Click on the System tab button at the bottom of the 5750 SSC service manager 
form.

ii Choose File→New→Element Management System from the menu. The new 
EMS form appears, as shown in Figure 18-11.

Figure 18-11  New EMS form

iii Configure the EMS parameters, as listed in Table 18-4. These are values to 
connect the 5750 SSC to 5620 SAM.
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Table 18-4 EMS (5620 SAM) parameters

iv Type the attribute names and required attribute values using the information in 
Table 18-4. Click on the Add button to add each attribute.

v Click on the OK button to save the changes.

The 5750 SSC provisioning server (Provserver) starts discovering the new 
EMS, so it reconciles with the 5620 SAM to discover and retrieve information 
about all SAPs that have the OSS MetaData field configured, as specified in 
Procedure 18-7.

Parameter value added to 
5750 SSC

Mandatory? Notes Sample

DefaultServicePackage Yes The default service package for all user 
accounts, generally no service until a 
service is purchased from the provider. 
The service packages were created in 
Procedure 18-1.

/Root organization 
name/Sub-organization 
name/Service catalog 
name/Service Package Name

For example, 
/RootOrganization/Alcatel/SSC/N
o Service

Discovered No Specifies whether the 5750 SSC has 
reconciled with the 5620 SAM. It is 
created after initial discovery by the 
provisioning server.

true

EMSHostName Yes The 5620 SAM server port number 8080 is the default

EMSPort The IP address of the 5620 SAM 
server.

IP address in dotted decimal 
notation

EMSLoginname Yes The name of the 5620 SAM-O user 
account created in Procedure 18-3

adminsamo

EMSPassword Yes The 5620 SAM-O user account 
password

5620Sam!

EMSUseSSL No Specifies whether the 5620 SAM server 
uses secured SSL communications. 
SSL is not supported.

no

XmlApiPath No Specifies the 5620 SAM-O OSSI path. /xmlapi/invoke is the default path

PolicyApiPath No Specifies the path to the specific 
5620 SAM 5750 SSC servlet

FTPLoginname Yes The FTP credentials required on 
5620 SAM to FTP VPLS SAP data

FTP account name

FTPPassword Yes FTP account password

home userId Yes Specifies the subscriber ID for the 
subscriber created in Procedure 18-4

5

EMSConcurrentReads No Specifies the number of 5620 SAM 
servers performing the read/write tasks

1 is the default

EMSConcurrentWrites No

EMSTimeout No — 60 s is the default

EMSConnTimeout No 10 s is the default
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During reconciliation:

• Each discovered SAP is given a unique user account
• The user account is identified by an account number, which cannot be 

changed.
• Credentials for the user account are determined by the value retrieved from 

the OSS metadata field.

vi Figure 18-12 shows a 5750 SSC view of user account details, with information 
reconciled from the 5620 SAM.

Figure 18-12  5620 SAM information in a 5750 SSC account

vii To manually perform 5750 SSC reconciliation with the 5620 SAM, run the 
following script from the 5750 SSC Service Manager:

/WideSpan/utilities/bpapi/examples/alcatel/resyncEMS.xml ↵

New SAPs are discovered and new user accounts are created. If a SAPs OSS 
MetaData field has changed, a new account is created rather than the old 
account being updated.
Alcatel 5620 Service Aware Manager, Release 3.0 R1 18-27
October 2005 3HE00214 CA



18 —  5620 SAM and 5750 SSC integration configurations
8 Create credentials for accounts. Credentials are automatically populated when 
reconciled from the 5620 SAM. You only have to create credentials if you want to 
offer residential self-management through web portals. You can create credentials 
one at a time for each account, or by using the API as described in the 5750 SSC 
OSSI Guide.

i From the organization created below the root organization, choose the Users 
folder.

ii Double-click to open the folder. When there are too many user accounts to list, 
a search users icon appears.

iii Double-click on the search users icon. A search users form appears.

iv Create a filter to search on existing accounts.

v Use the search where drop-down menu to search by user name, user account, 
or another filter. For example, search by user account number, where number 
is a number automatically assigned to the user account when reconciliation of 
5750 SSC has retrieved VPLS SAP information from the 5620 SAM-managed 
network.

vi Enter the account number for the “is like” parameter.

vii Click on the Search button. A list of matching user accounts appears.

viii Click on the user account, right-click, and choose Add Credential from the 
contextual menu. The add credential form appears.

Figure 18-13 shows the add credential form with the User tab button selected.
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Figure 18-13  Add credential form - User tab

Configure the user credentials:

• the Username is the name displayed in the service manager for the account
• the Login Name and Password parameters specify the name and password 

used by the subscriber to log in to their self-service web portal
• the Profile Set parameter is already configured the provisioning server 

(Provserver)

ix Click on the Account tab button. Figure 18-14 shows the add credential form 
with the Account tab button selected.
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Figure 18-14  Add credential form -- Account tab

x Configure the Associated User Type parameter as AccountAdmin, as created 
in step 7 in Procedure 18-1. This allows residential users to log in using their 
self-service web portal.

and another to link the subscriber to the 5750 SSC provisioning server (for 
example, DSL). The AccountAdmin credentials are configured from the User 
tab button. The DSL credentials are configured from the Account tab button.

xi Click on the Create button to save the changes.
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9 Add EDPS to the metering service and bandwidth service for the DSL credential.

i Set the Associated User Type to DSL. The DBM icon appears in the navigation 
tree, with two icons below it; one for Metering Service and one for Bandwidth 
Service.

ii Select the Metering Service icon. The right-hand window shows two tab 
buttons.

iii Click on the Dependencies tab button.

iv Set the Select an End Point parameter to ssc, which is the EDPS cluster 
created in Procedure 18-1.

v Click on the OK button to save the changes.

10 Add EDPS to the bandwidth service for the metering credential.

i Open a user account. The user account form appears.

ii From the navigation tree, choose DBM→Bandwidth Service.

iii Select the Bandwidth Attributes tab button. Figure 18-15 shows the form.

Figure 18-15  Add EDPS cluster information from a bandwidth service form

iv Set the Available Endpoints parameter to the EDPS cluster created in 
Procedure 18-1, for example, ssc.

v Click on the OK button to save the changes.
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11 Activate the account. Newly created accounts have a pending state. You can use 
OSS scripts or use the service manger GUI.

i Open a user account. The user account form appears.

ii From the navigation tree, choose Information Profiles→User Profiles.

iii Click on the Status tab button.

iv Change the status to Active using the radio button.

v Click on the OK button to save the changes.

Procedure 18-10  To rediscover VPLS SAP information

You can use the 5750 SSC to rediscover new VPLS SAPs in the 5620 SAM-managed 
network, or to discover changes to VPLS SAPs.

1 Launch the 5750 SSC from the desktop service manager icon

2 Log in using your account. The 5750 SSC service manager window appears.

3 Click on the System tab button at the bottom of the window.

4 Double-click on the SAP folder.

5 Double-click on the Element Management System folder. The sam icon appears, as 
configured when the EMS was created, as described in Procedure 18-9.

6 Right-click on the sam icon and choose Edit from the contextual menu. The sam edit 
form appears.

7 Select the Discovered attribute from the attribute list.

8 Set the Attribute Value parameter to false for the Discovered attribute. Figure 18-16 
shows the EMS edit form.
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Figure 18-16  EMS edit form

9 Click on the Modify button.

10 Click on the OK button.

How rediscovery occurs depends on the state of VPLS SAP data, as configured 
using the OSS metadata filed.

• when a SAP OSS metadata field has changed, the SAP is treated as a new 
account, and a new account is created

• when other information about the SAP has changed, the existing accounts are 
updated

Procedure 18-11  To search for 5750 SSC users and user accounts

When you use the 5750 SSC service manager to discover VPLS SAPs in the 
5620 SAM-managed network, hundreds or thousands of account may be created in the 
5750 SSC database. You can use the search tool to find individual accounts.
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1 Launch the 5750 SSC from the desktop service manager icon

2 Log in using your account. The 5750 SSC service manager window appears.

3 Click on the sub-organization in the navigation tree that was created in 
Procedure 18-1.

4 Double-click on the Users folder. If more than 500 accounts are available, you must 
use the Search Users function to filter on and list individual user accounts.

i Double-click on the Search Users binoculars icon. A search users form 
appears.

ii Create a filter to search on existing accounts.

iii Use the search where drop-down menu to search by user name, user account, 
or another filter. For example, search by user account number, where number 
is a number automatically assigned to the user account when reconciliation of 
5750 SSC has retrieved VPLS SAP information from the 5620 SAM-managed 
network.

To search based on VPLS SAP OSS metadata, set the Search where 
parameter to “login name”

iv Enter the OSS metadata string for an individual account, as created in 
Procedure 18-7. You can use a wildcard character (*) to widen the search.

v Click on the Search button. A list of matching user accounts appears. 
Figure 18-17 shows the results of a search.
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Figure 18-17  Search results list

vi Right-click on the selected user account credential from the list of matching 
user accounts and choose Find All In Account from the contextual menu. All 
credentials associated with the user account are listed.

vii Right-click on the user account credentials and choose Add to Control Form 
from the contextual menu. The credential and user account are added to the 
hierarchy tree display.

Procedure 18-12  To create new accounts in the 5750 SSC service 
manager

1 You can create account manually. Accounts represent the residential subscriber 
buying a service. You can manually create subscriber service accounts, write OSS 
applications to populate accounts, or use the reconciliation of 5750 SSC retrieving 
VPLS SAP information from the 5620 SAM-managed network.

a To retrieve VPLS SAP information from the 5620 SAM, see step 7.

b To use OSS applications to populate accounts, contact your Alcatel support 
representative.

c To manually create an account:

i Choose File→New→Account from the menu. The add account form 
appears with the Account tab button selected, as shown in Figure 18-18.
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Figure 18-18  New account form

ii Name the account. The account name can be used for searching and is 
displayed on the residential user’s web self-service portal.

iii Set the Associated Service Package parameter for the account. This is 
the default service package for a residential subscriber, as displayed on 
the user web portal. All service packages with a greater weight than the 
selected package can become upgrade options, selectable from the web 
portal.

2 Click on the Create button to create the account. The account is saved to the list of 
accounts in the Users folder.

3 Click on the OK button to close the form.

Procedure 18-13  To configure L2 and L3 SAPs as DHCP relay agents

When the 5750 SSC is configured for DHCP server functions, you must configure the L2 
and L3 interfaces for VPLSs and IESs associated with the subscriber. When DHCP 
requests come from the residential subscriber (client), the devices containing the service 
SAPs are configured to forward those requests to the DHCP server.
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You can use the 5620 SAM-O OSS interface to create applications to configure the 
managed devices. See the Alcatel 5620 SAM-O OSS Interface Developer Guide for 
more information.

1 Using the client GUI, choose Manage→Services from the main menu. The Manage 
Services form opens.

2 Create a filter and search on the VPLSs or IESs you want to modify and click on the 
Search button. The list of filtered services appears.

3 Click on the Edit button to open the service configuration form.

4 Click on the appropriate tab button.

a For IES L3 services, click on the L3 Access Interfaces tab button. A list of L3 
SAPs appears.

i Select the L3 SAPs that need to have DHCP enabled and click on the Edit 
button. The L3 Access Interface form appears.

ii Click on the DHCP tab button. Figure 18-19 shows the configuration form.

Figure 18-19  L3 SAP configuration form - DHCP tab
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iii Configure the parameters.

b For VPLS L2 services, click on the L2 Access Interfaces tab button. A list of L2 
SAPs appears.

i Select the L2 SAPs that need to have DHCP enabled and click on the Edit 
button. The L2 Access Interface form appears.

ii Click on the DHCP tab button. Figure 18-20 shows the configuration form.

Figure 18-20  L2 SAP configuration form - DHCP tab

iii Configure the parameters. They include:

• Enable DHCP Relay
• Description
• Snooping

5 Save the changes and confirm the action.

6 Close the form.

• Enable DHCP Relay
• Description
• Enable Info Option
• Remote Id
• Trusted

• Lease Populate
• Action
• Circuit Id
• Server 1
• Server 2 through Server 8
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19.1 5620 SAM and network management software 
interworking and integration overview

The 5620 SAM can be configured to interwork with the following network 
management software applications:

• 5620 NM
• 1354 BM
• HP OpenView NNM

Table 19-1 lists the uses of non-5620 SAM network management software functions. 
See the appropriate 5620 SAM release notice for compatibility information.

Table 19-1 5620 SAM network management interworking software functions

Figure 19-1 shows how navigation to other network managers and AS tools for alarm 
management is handled.

Non-5620 SAM software Function

5620 NM • Navigate to the 5620 NM GUI using X-terminal software on the 5620 SAM 
client GUI

• Forward alarms from the 5620 SAM to the 5620 NM AS tool IM
• Display 5620 SAM alarms on the 5620 NM AS tool USM
• Monitor end-to-end services using supported network manager integration

1354 BM • Navigate from the 1354 BM AS tool USM to the 5620 SAM client GUI
• Forward alarms from the 5620 SAM to the 1354 BM AS tool IM
• Display 5620 SAM alarms on the 1354 BM AS tool USM
• Monitor the 5620 SAM server status from 1354 BM TMN OS desktops
• Monitor end-to-end services using supported network manager integration

HP OpenView NNM • Discover 5620 SAM-managed devices, such as the 7750 SR, from the HP 
OpenView NNM client GUI

• Launch the 5620 SAM client GUI from HP OpenView NNM
• Monitor end-to-end services using supported network manager integration
• Manage configuration, performance, and alarms
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Figure 19-1  Alarm navigation

5620 SAM client GUI startup and navigation rules
The following rules apply when you navigate to the 5620 SAM client GUI.

• When the client GUI is starting, any navigation requests from other network 
management applications are blocked.

• After the client GUI user logs in, additional navigation requests are handled by 
the client.

• The login time out is used to prevent a situation in which another network 
management application user requests client access, and then cancels the login, 
as described in the 5620 SAM Installation and Upgrade Guide.

• The following navigation rules apply when multiple client GUIs are running.
• Each client GUI tries to handle the navigation request by registering as the 

navigation from external GUI client, as described in the 5620 SAM Installation and 
Upgrade Guide.

• The navigation request is canceled if the client GUI is shut down.
• All navigation requests are handled by the first registered client GUI.
• If no client GUI is registered, a new client GUI is launched when a navigation 

request is received.
• If the currently registered client GUI shuts down, another client GUI registers to 

handle the navigation requests. If the request is from a 1354 BM, another client GUI 
is started.

5620 SAM server

5620 SAM client 5620NM or 1354BM system

Alarm
agent Alarms forwarded from 5620 SAM

Alarm
display

AS tool USM
alarm monitor

AS tool IM
alarm handling

5620
SAM GUI
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GUI

17559

Navigate to alarm source
on 5620 SAM client GUI
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19.2 Workflow for 5620 SAM network management 
interworking

1 Ensure that the appropriate 5620 SAM integration software is installed and 
appropriately configured on the other network management platform. See the 
5620 SAM Installation and Upgrade Guide for more information.

2 Ensure that the 5620 SAM client and server are configured to support GUI 
navigation and alarm agent configuration. See the 5620 SAM Installation and 
Upgrade Guide for more information.

3 Launch the 5620 SAM client GUI and other NMS GUIs.

4 Perform the required network management function from the appropriate GUI, as 
described in Table 19-1.

19.3 5620 SAM network management interworking menus

The menus that are used to enable functions on non-5620 SAM network 
management platforms are described in the appropriate user documentation for the 
software. See the appropriate documentation for more information on how to use 
other network management systems.

19.4 5620 SAM network management interworking procedures 
list

Table 19-2 lists the procedures to use interworking functionality between the 
5620 SAM and other network management software applications.

Table 19-2 5620 SAM network management interworking procedures list

Procedure Purpose

To display the 1354 BM GUI on a 5620 SAM 
client GUI

Navigate to and from network management 
software applications.

To display the 5620 NM GUI on a 5620 SAM 
client GUI

To display the 5620 SAM GUI from HP 
OpenView NNM

To navigate from an AS tool USM to the 
5620 SAM client GUI

View 5620 SAM alarm information from another 
network management software application, and 
then navigate back to the source of the alarm on 
the 5620 SAM

To display 5620 SAM server status from a TMN 
OS on the 1354 BM

Monitor the status of the server from another 
network management software application.

To discover devices on an HP OpenView NNM Discover, monitor, and manage devices, such as 
the 7450 ESS and 7750 SR using another 
network management software applicationTo manage devices discovered using HP 

OpenView NNM
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19.5 5620 SAM network management interworking procedures

The following procedures describe how to interwork using other network manager 
software.

Procedure 19-1  To display the 1354 BM GUI on a 5620 SAM client 
GUI

1 Log in to the PC or workstation where the 5620 SAM client GUI is running.

2 Start the X-terminal software.

3 Use the X-terminal software to start the TMN OS desktop on the platform where the 
1354 BM GUI is installed.

Procedure 19-2  To display the 5620 NM GUI on a 5620 SAM client 
GUI

1 Log in to the PC or workstation where the 5620 SAM client GUI is running.

2 Start the X-terminal software.

3 Use the X-terminal software to start the 5620 NM GUI on the Solaris platform where 
the 5620 NM Operator Position is installed.

Procedure 19-3  To display the 5620 SAM GUI from HP OpenView 
NNM

Ensure the 5620 SAM client GUI software is installed on the HP OpenView NNM 
platform, as described in the 5620 SAM Installation and Upgrade Guide.

1 Log in to the HP OpenView NNM workstation where the 5620 SAM integration 
software is installed.

2 Ensure that the registration file is available on the HP OpenView NNM workstation 
in the /$OV_REGISTRATION/Vendor/Alcatel directory.

3 To:

a Open from a managed device, double-click on a managed device icon, for 
example, the 7750 SR icon. The 5620 SAM client GUI login screen appears.

b Open the client GUI, use the application registration file to launch 5620 SAM. 
The 5620 SAM client GUI login screen appears.

4 Start the 5620 SAM client GUI, as described in Procedure 3-2.
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Procedure 19-4  To navigate from an AS tool USM to the 5620 SAM 
client GUI

1 Choose a counter summary window or alarm sublist from the AS tool USM.

2 Choose a sublist or an alarm in a sublist. 5620 SAM alarms are preceded by SAM 
in the Friendly Name field of the alarm sublist, as shown in Figure 19-2.

Figure 19-2  5620 SAM alarm in the AS tool USM

3 From the AS tool USM menu:

a For the 5620 NM, choose Navigation→External Equipment→Show Equipment 
to navigate to the property form that lists the alarm on the 5620 SAM client 
GUI. The appropriate form is displayed. When the 5620 SAM client GUI is 
already running, a new object properties form is displayed. When the client 
GUI is not running:

i Log in to the 5620 SAM client GUI. The client GUI appears.

ii View the object property form that is displayed.

b For the 1354 BM, choose Navigation→External Application→5620 SAM to 
navigate to the property form that lists the alarm on the 5620 SAM client GUI. 
The appropriate form is displayed. When the 5620 SAM client GUI is already 
running, a new object properties form is displayed. When the client GUI is not 
running:

i Log in to the 5620 SAM client GUI. The client GUI appears.

ii View the object property form that is displayed.

Note —  When you choose Navigation→External 
Application→5620 SAM for a non-5620 SAM alarm, a problem 
encountered form opens on the 5620 SAM.
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See the 5620 SAM Troubleshooting Guide for more information about 
troubleshooting alarms.

4 After the alarm issue is resolved, close the alarm using the 5620 SAM client GUI. 
Changes to the status of the alarm are reflected in the appropriate AS tool USM on 
the non-5620 SAM platforms.

Procedure 19-5  To display 5620 SAM server status from a TMN OS 
on the 1354 BM

1 Log in to the TMN OS on the 1354 BM. The TMN OS desktop is displayed.

2 View the status of the 5620 SAM server. Figure 19-3 shows the 5620 SAM server 
icon on a TMN OS desktop.

Figure 19-3  5620 SAM server icon on a TMN OS desktop

The colors used to indicate 5620 SAM server status are:

• green when the server is up
• yellow when the server status is unknown
• red when the 5620 SAM is not operating properly, and the problem is affecting 

the server
• blue when server monitoring has stopped
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Procedure 19-6  To discover devices on an HP OpenView NNM

You can discover devices, such as the 7750 SR, using HP OpenView NNM. See the:

• appropriate HP OpenView NNM user documentation for more detailed 
procedural information

• Alcatel Application Note describing HP OpenView NNM integration and MIB 
support. Contact your Alcatel support representative for more information.

Procedure 19-7  To manage devices discovered using HP OpenView 
NNM

You can manage devices, such as the 7750 SR, that are discovered using HP OpenView 
NNM. See the appropriate HP OpenView NNM user documentation for more detailed 
management information.

Depending on which managed device MIBs are used, such as MIBs for the 7750 SR, 
affects the management capabilities of HP OpenView NNM, including which SNMP traps 
are supported. You can load and unload specific MIBs for specific devices to provide a 
full range of management capabilities. See the Alcatel Application Note describing HP 
OpenView NNM integration and MIB support, which is available in the User 
Documentation directory on the 5620 SAM application DVD-ROM, for more information.

You can:

• view managed device information, such as system settings
• configuration management by launching a CLI session via Telnet
• discovery of IP topology, with icons representing managed devices on a map
• display routing tables for the device, including route destinations, gateways, 

masks, and associated interfaces
• poll status and fault management information
• collect data for performance management
• browse SNMP MIBs
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20.1 Equipment management overview

This chapter covers general equipment management information. The 5620 SAM 
equipment management interface consists of:

• a main menu
• contextual menus
• a navigation tree
• managed objects
• an equipment manager
• property forms to configure object parameters

The 5620 SAM is used to create, configure, and manage a device with the various 
children objects required to be part of a network. Equipment such as the routers, 
which are at the top of the hierarchy, have properties that are configured using the 
CLI and discovered when the 5620 SAM discovery process is run. 

After the device is discovered, you use properties forms to configure specific 
parameters for the child objects of the discovered device. The properties forms are 
opened from the contextual menus available for each created object in the equipment 
view of the navigation tree or from the equipment manager display tab after you 
choose an object and click an Edit button, a Create button, or when you double-click 
an object.

Figure 20-1 shows the 5620 SAM GUI used to manage equipment. 

• The navigation tree on the left side has the Equipment view chosen and a daughter 
card from shelf 1, and card slot 4 is expanded to show the available ports.

• The equipment manager form on the right side displays the shelf and associated 
equipment parameters for the managed device under various tabs.

• The physical port configuration form is open for port 4/1/1 on the left side of the 
working pane. The form displays parameter information under each tab that can 
be configured for the managed equipment from the General tab.
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Figure 20-1  GUI with equipment management drawings and forms

The 5620 SAM allows you to create and manage the following objects in the 
equipment view of the navigation tree:

• network — containing all routers and devices
• router and device — the next level in the hierarchy
• CCAG, LAG, and shelf — each is at the third highest level in the hierarchy
• card — the highest level under the shelf, considered the parent object
• daughter card — a child object of the card object
• bundles — to group DS0 channel groups on a TDM-capable daughter card
• port — automatically created under each daughter card, a child object of the 

daughter card
• channel, sub-channel, and timeslot — child objects of the port

20.2 Working with objects

Objects in the 5620 SAM are considered to have parent/child relationships that are 
contained within a hierarchy. For example, a card in a card slot is the parent object 
of a daughter card. The behavior of each object is defined using parameters that are 
specific to the function required. Those parameters can be managed to suit the needs 
of the service required. Objects are created and managed using the properties forms 
found in the contextual menus of the equipment view and in the forms of the 
equipment manager. 
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The network is the top object in the navigation tree. The device object is the 
discovered device at the top of the hierarchy in the navigation tree, directly below the 
network icon. The following children objects of the router are created automatically 
in the navigation tree after the device is discovered.

• CCAG
• LAG 
• shelf
• card slot
• card slot A for the CPM and switch fabric
• card slot B for the redundant CPM and switch fabric

The following objects must be created using property forms or create forms from the 
contextual menus of the equipment view or the ring group view, or the equipment 
manager.

• individual CCAGs with VSM-CCA members.
• individual LAGs with LAG members
• cards
• ring groups
• daughter cards

Ports are automatically created when the daughter card is created.
• channels

Configuring an object is accomplished in two steps. First the object must exist or be 
created, second, the object parameters are modified. The following procedure is used 
to create objects using the navigation tree.

Procedure 20-1  To create an object

1 Right-click on an empty object in the navigation tree or in the Display tab of the 
equipment manager to open the contextual menu.

2 Choose Properties or, when available, Create <objectname>.

The properties form or the create form, as applicable, appears.

3 Configure the parameters as required. 

Certain object parameters are available for configuration. Configuring these 
parameters creates the object, however, after the object is created you may need to 
edit it using properties or equipment manager forms.

20.3 Working with network objects

The network icon in the navigation tree is the parent object of all managed devices. 
When you expand the network icon, all managed devices are shown as children of 
the network parent.
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20.4 Working with device objects

The device icons in the navigation tree represent device objects. Most of the 
configured properties for this object are inherited from the device. The Properties 
contextual menu option from the navigation tree allows you to configure or modify 
parameters for the object. These parameters are found on the respective tab buttons 
of the properties form and include the following:

See chapter 21 for information about configuring device objects. See chapter 10 for 
in-band and out-of-band management using parameters from the Polling tab button.

Multiple device support

The 5620 SAM supports the following devices:

• 7750 SR
• 7450 ESS
• Telco

The 5620 SAM supports up to three different releases of the devices. For example, 
the 5620 SAM can manage a 7750 SR, Release 3.0, and two older releases (7750 SR, 
Release 2.1 and 7750 SR Release 2.0). 

The 5620 SAM supports the minor releases of a device when the major release is 
supported.

7750 SR support

The 7750 SR is an IP/MPLS service router designed to support the delivery of 
advanced Internet and VPN services.

5620 SAM management of the 7750 SR provides element and network management 
functions. Table 20-1 lists the supported functions:

Table 20-1 7750 SR support

• General
• Polling
• Protocols
• Load Balancing

• PAE Site
• Groups
• SAS Agent
• Faults

Note —  There may be restrictions if a device does not follow the 
basic rules for MIB changes. When a device introduces maintenance 
releases, you may need to upgrade the 5620 SAM to a release that 
supports the changes on the device.

Functional area Supported Special information

Summary of functionality

Full FCAPS support ✓ The 5620 SAM was designed to support the 
7750 SR.

(1 of 2)
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7450 ESS support

The 7450 ESS supports metro Ethernet and service-aware Ethernet aggregation 
across IP/MPLS networks.

5620 SAM management of the 7450 ESS provides element and network 
management functions. When a function or feature is not supported by the 7450 ESS, 
the feature or function cannot be selected from the GUI, or does not appear on the 
GUI.

Table 20-2 lists the supported functions.

Table 20-2 7450 ESS support

5620 SAM client GUI main menu

Application→Submenus ✓ —

Create→Submenus ✓ All services are supported.

Manage→Submenus ✓ —

Policies→Submenus ✓ —

Tools→Submenus ✓ —

Window→Submenus ✓ —

Administration→Submenus ✓ —

Help→Submenus ✓ —

5620 SAM client GUI navigation tree

Equipment ✓ —

OSPF ✓ —

ISIS ✓ —

Network ✓ —

Ring group ✓ —

Functional area Supported Special information

(2 of 2)

Functional area Supported Special information

Summary of functionality

Releases ✓ See the appropriate release notice for compatible 
and supported device releases.

Equipment management ✓ Supported in a similar fashion to 7750 SRs, with an 
additional Ethernet port parameter to enable 
oversubscription of the port.

Spanning tree protocols ✓ Supported multiple types of spanning tree protocols, 
compliant with IEEE 802.d-2004, IEEE 802.1w, and 
backwards compatibility with dot1.w.

(1 of 2)
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Oversubscribed daughter card ports ✓ Additional statistics for ports to indicate how many 
packets or octets are dropped because the daughter 
card port is oversubscribed.

MAC addressing for VPLS ✓ —

MVR VPLS ✓ Users can configure:

• MVR on a VPLS instance
• source MVR VPLS on the SAPs of a user VPLS
• MVR by proxy on the SAPs of a user VPLS

Unsupported functionality

Global cflowd configuration and collection — Can specify IP interface, filter, and SAP statistics 
collection. When you configure the ACL IP filter 
policy, the cflowd-related parameters are not 
distributed to 7450 ESSs.

BGP — —

VPRN service — —

5620 SAM client GUI main menu

Application→Submenus ✓ Shelf drawings are displayed for the one- and 
seven-slot version using the equipment manager.

Create→Submenus ✓ The VPRN service is not configurable for 
7450 ESSs.

There are different configurations available for 
VPLS creation when a VPLS site is a 7450 ESS.

• three additional spanning tree protocol options 
and hold count values for BPDUs on the site 
forwarding tab

• edge-related parameters on the SAP and spoke 
SDP forwarding tab

• clear spanning tree protocol detected for 
specific encapsulation values on the SAP and 
spoke SDP forwarding tab

Manage→Submenus ✓

Policies→Submenus ✓ —

Tools→Submenus ✓ —

Window→Submenus ✓ —

Administration→Submenus ✓ Poller manager MIB entry tables have been modified 
to indicate the type of device and the release version 
of the MIB.

Help→Submenus ✓ The number of supported cards is indicated in the 
license.

5620 SAM client GUI navigation tree

Equipment ✓ Supports the 20G I/O module.

OSPF ✓ —

ISIS ✓ —

Network ✓ BGP is not supported.

Ring group ✓ —

Functional area Supported Special information

(2 of 2)
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Telco device support

The Telco and Ethernet devices support Ethernet and service-aware Ethernet 
aggregation across IP/MPLS networks. Typically, Telco devices are connected in 
rings or trees to 7450 ESSs to distribute L2 VPN or BTV services in VLANs.

The 5620 SAM provides element and network management functions for Telco 
devices using CLI and SNMP. When a function or feature is not supported by the 
Telco device, the function or feature cannot be selected from the GUI, or does not 
appear on the GUI.

Table 20-3 lists the supported functions.

Table 20-3 Telco device support

Functional area Supported Special information

Summary of functionality

Releases ✓ Release 6.3 for Telco T5C-24T, T5C-48T, T5C-24G, 
T5C-24F, T5C-24GT, and BiNOS

Number of devices ✓ Up to 512 devices.

Equipment management ✓ Similar to other devices using the navigation tree 
and equipment manager.

Licensing ✓ Based on the number of managed devices and the 
type of managed device (optical or copper), not the 
number of daughter cards

Pre configuration ✓ You must perform CLI preconfigurations, as 
described in chapter 2. These are necessary before 
the 5620 SAM manages the Telco devices.

• set hostname and IP address for the Telco 
devices

• set and enable passwords
• enable web server for BiNOS
• set in-band management on sw0 interface
• remove ports from the default VLAN
• set static routes to the NMS domain
• set SNMPv2c or v3 users
• configure the Telco devices to forward SNMP 

traps

Unsupported functionality

L2 topology maps — —

Routing protocols — —

Spanning tree protocols ✓ Spanning tree is not configurable from the 
5620 SAM. You can use CLI to configure spanning 
trees. Bridging is used to represent the connections 
between end customers (subscribers) and the L2 
service devices, such as the 7450 ESS.

Statistics — —

5620 SAM client GUI main menu

Application→Submenus ✓ Shelf, slot, card, and port drawings are displayed 
using the BiNOS element manager, which is 
launched from the equipment manager.

(1 of 2)
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20.5 Working with CCAG objects

CCAGs are navigation tree objects located below device icons. CCAGs are 
configured manually using the CCAG object navigation tree menu and subsequent 
forms. For proper CCAG configuration, a VSM-CCA card must be present in the 
node.

You must configure the following in the CCAG configuration forms:

• General properties such as CCAG ID, Description, CCA Rate Enabled, CCA 
Rate, Access Adapt QoS, and Administrative State

• CCAG MDA Members which are compatible ports that can belong to a CCAG.

Create→Submenus ✓ Only VLAN services are configurable.

You must preconfigure VPLS and VLL services on 
the 7450 ESS and join the VLAN services. The 
SAPs of the services on the 7450 ESS are 
encapsulated with the same VLAN ID used in the 
ring.

Manage→Submenus ✓ Perform finds and searches based on device 
parameters. If the 5620 SAM does not support the 
device function, for example, statistics 
management, then the menu option should not be 
used.

You cannot view specific L2 VPN, Internet, or BTV 
services maps, however, you can view services on 
devices from the services map.

Policies→Submenus ✓ Multicast Package Policy manager and the 
sub-menu options under Telco are the supported 
policy options.

Tools→Submenus ✓ —

Window→Submenus ✓ —

Administration→Submenus ✓ Poller manager MIB entry tables indicate the type of 
device and the release version of the MIB.

Help→Submenus ✓ The number of supported devices by type (optical or 
copper) is indicated in the license.

5620 SAM client GUI navigation tree

Equipment ✓ Supports viewing equipment properties to the port 
level.

OSPF — —

ISIS — —

Network ✓ Routing protocols are not supported. You can open 
the device icon to view and configure bridging 
information.

Ring group ✓ —

Functional area Supported Special information

(2 of 2)
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When you create a CCAG, the 5620 SAM creates virtual paths to be used as 
interconnections to bind services together. Two unidirectional paths are created: 
Alpha and Beta. For each path, three virtual ports are created: one for SAP-SAP 
connections, one for SAP-NET connections, and one for NET-SAP connections. The 
last two virtual ports are used to bind a service and a network interface together. 

A maximum of eight cards can be added to a CCAG, with a maximum of eight 
CCAGs per node.

20.6 Working with LAG objects

LAGs are navigation tree objects located below the device icon. LAGs are 
configured manually using the configuration forms available when you choose 
Create LAG from the LAG object navigation tree contextual menu.

The following minimum configuration is required to enable LACP:

• Enable LACP at either end of the LAG group.
• Set one end of the LAG group as LACP active.

You must configure the following in the LAG configuration forms:

• General properties such as the LAG description, configured address, 
encapsulation type, and administrative state

• Link aggregation group parameters such as port threshold, port threshold action, 
and dynamic cost

• LACP parameters such as LACP mode, LACP transmit interval, and the actor 
administration key

• LAG members, which are the compatible ports that can belong to a LAG

Because all ports can have their own MAC address, when ports are part of a LAG, 
the LAG must have an MAC address.

The port configuration of the first port added to the LAG is used to compare with 
subsequently added ports. If a discrepancy is found with a newly added port, that port 
is not added to the LAG. Only ports configured in network mode can belong to 
LAGs.

Up to eight ports can be added or removed from the LAG. All ports added to a LAG 
must have the same parameter settings.
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20.7 Working with shelf objects

Shelf objects represent the hardware that is configured in the router shelf. When you 
choose the shelf object in the navigation tree and click on Properties in the contextual 
menu, you can view the states and conditions of the shelf including:

• general information
• fan tray state and speed
• power supply tray statuses
• LED statuses
• card slots
• hardware environment information
• timing
• statistics 
• faults

20.8 Working with card and card slot objects

When you click on the plus sign beside the shelf object, all the card slots contained 
in the shelf become visible in the navigation tree. They appear as empty card slots if 
a card is not provisioned for the slot. If a card is provisioned for the slot, it will be 
identified. Choose Configure Card from the contextual menu of the object and assign 
a supported card type for the slot. The following card types can be assigned to the 
card slots:

• 1 x 10-Gig MDA IOM for one daughter card
• 2 x 10-Gig MDA IOM for two daughter cards
• 2 x 10-Gig MDA IOM Card, B for two daughter cards

A card type can be pre-provisioned in a slot before the card is installed in the chassis. 
A card and daughter card must be provisioned before a port can be configured.

When a card is first configured, the administrative state can be down. The resource 
is not operationally up until the card is equipped and the administrative state is up. A 
card can only be provisioned in a slot that is vacant, and no other card can be 
provisioned (configured) for that particular slot.

To reconfigure a slot position, delete the card currently in the slot and configure the 
new card type added to the slot. A card can only be provisioned in a slot when the 
card type is allowed in the slot.

20.9 Working with daughter card objects

After the card is created in the card slot you can create and configure the daughter 
card object in the daughter card slot that appears when you click on the plus sign 
beside the card object. The daughter card slots in the card appear in the navigation 
tree. They appear as empty daughter card slots when a daughter card is not 
provisioned for the slot. When a daughter card is provisioned for the slot, it is 
identified. Choose Configure Daughter Card from the contextual menu of the object 
and assign a supported daughter card type for the slot. 
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Table 20-4 lists the supported daughter card types.

Table 20-4 Supported daughter cards

Each daughter card object contains a number of ports that are specific to the type of 
service required. The port objects are created automatically under the daughter card 
but they must be configured based on the function served by the port, for example as 
an access interface for a VPRN service. 

You can associate policies to daughter cards. Network buffer policies are used to 
create and edit QoS buffer pool resources on egress network ports, channels, and 
ingress ports. Ingress and egress network ports and channels have a dedicated buffer 
pool for egress queuing. The ingress and egress network traffic is handled by a buffer 
pool at the ingress and a buffer pool at the egress.

Managed device Ethernet SONET/SDH Channelized

7750 SR • 10/100 Ethernet with 60 ports
• 10/100FX Ethernet with 20 ports
• Gigabit Ethernet with 5- and 

10-port configurations
• 10 Gigabit Ethernet with 1 port
• VSM-CCA

• OC-3 and 16-port 
configurations

• OC-12 and 16-port 
configurations

• OC-48 and 4-port 
configurations

• OC-192 with 1 port

• 4 × OC-3 Deep 
Channel has four ports 
channelized to the DS0 
level

• 1 × OC-12 Deep 
Channel has one port 
channelized to the DS0 
level 

• 12 × DS3/E3 Deep 
Channel has 12 ports 
channelized to the DS0 
level and can also be 
used for DS3 clear 
channel applications

• 4 × DS3/E3 Deep 
Channel has four ports 
channelized to the DS0 
level and can also be 
used for DS3 clear 
channel applications

7450 ESS • 10/100 Ethernet with 60 ports
• 10/100/1000 Ethernet with 20 

ports
• 10/100FX Ethernet with 20 ports
• 20 Gb/s I/O module
• Gigabit Ethernet with 10- and 

20-port configurations
• 10 Gigabit Ethernet XFP with 

2 ports LAN/WAN physical card
• VSM-CCA

• OC-3 and OC-12 
16-port configurations

• OC-48 and 4-port 
configurations

• OC-192 with 1 port

—

Telco • RJ-45 10/100T/TX access with 
24 or 48 ports

• RJ-45 100BaseT/TX uplink with 
24 ports (20 copper and 4 dual 
copper and optical)

SFP 1Gb/s uplink with four 
ports (2 optical and 2 
copper)

—
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20.10 Working with port and channel objects

The types of ports available depend on the daughter cards that are configured in the 
chassis. Ethernet ports cannot be channelized. SONET/SDH and TDM ports can be 
channelized. The following types of ports are supported:

• Fast Ethernet (10/100/1000 Base-T)
• Gigabit Ethernet (1000Base-T)
• 10 Gigabit Ethernet (10000Base-T)
• 10 Gigabit Ethernet (10GBase-T)
• OC-3/STM-1, OC-12/STM-4, OC-48/STM-16, and OC-192/STM-64 

SONET/SDH 
• channelized OC-12, OC-3, and DS3/E3 

The port syntax is card slot/daughtercard/port. For example, Port 1/1/1 represents 
port 1 of daughter card 1 in slot 1 for any service. In every case, ports are created 
automatically when the daughter card is created. You must select one port object at 
a time and configure the properties of that port for the service you want it to provide. 
The properties vary depending on whether the port type is one of the Ethernet type 
ports, SONET/SDH ports, or TDM ports. Channel objects are created on 
SONET/SDH or TDM ports for any type of channelization on the port whether it is 
a clear-channel application or a sub-channel application.

Use the properties forms available from the contextual menus in the navigation tree 
or the equipment manager to configure port and channel parameters. You can 
configure ports as network or access. 

• Network ports connect and pass network-facing traffic. 
• Access ports connect and pass customer-facing traffic for which services are 

configured. 

Clear channel ports (OC-192/OC-48c/OC-12c/OC-3c) are either network or access 
ports. Channelized ports (CHOC-12/CHOC-3c/ DS3) are always in access mode.

Network ports are used in the service provider transport or infrastructure network, 
such as an IP/MPLS-enabled backbone network. Network ports can be assigned IP 
addresses and act as Layer 3 interfaces. When network ports act as Layer 3 
interfaces, they can pass IP traffic to other devices and communicate using routing 
protocols, such as MPLS and OSPF. 

Access ports are associated with a SAP, a subscriber, and a service to provide 
connectivity services to the subscriber, for example, a VLL service. Access ports and 
channels are configured for encapsulation, to differentiate the service on the port or 
channel. After a port is configured for access, one or more services can be configured 
for that port. All channelized ports that are configured as endpoints must be 
configured as access mode. Those that are not endpoints cannot be configured.

When working with a TDM port, you must specify the Line Buildout as either short 
or long. That is, for a DS3 port the Line Buildout parameter must be configured. If 
the TDM port is in the context of a SONET STS-1 sub-channel, for example, the DS3 
channel is built on the STS-1 channel of a SONET port, the line buildout parameter 
is not required.
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At the connection termination points, you are required to configure the Encap Type 
as required, the MTU size as required, and the configured MAC address as required 
when configuring the port or channel. 

Policies can be added or deleted as required using the equipment manager.

You can associate policies to ingress and egress access and network ports. Buffer 
policies are used to create and edit QoS buffer pool resources on network ports, 
access ports, and access channels. Egress network ports, access ports, and access 
channels have a dedicated buffer pool for queuing. The traffic is handled by a single 
buffer pool, one at the ingress, and one at the egress.

You can configure the amount of egress buffer space to be allocated to the port or 
channel. By default, all egress buffers are allocated fairly among the egress ports and 
channels based on their relative egress bandwidth.

The egress buffers for egress network ports and channels are put into per-port or 
per-channel egress buffer pools and are used by the egress network forwarding class 
queues on that port or channel. The ingress buffers allocated to network ports and 
channels are summed into a single pool and are used by the ingress network 
forwarding class queues (defined by the network ingress buffer policy).

The egress and ingress buffers allocated to access ports and channels are put into an 
egress buffer pool and ingress buffer pool for the port or channel. The access buffer 
pools are used by egress and ingress service queues created by the SAP-egress and 
SAP-ingress policies in use by services on the port or channel.

Changing the size of an egress buffer pool should be carefully planned. By default, 
there are no free buffers to increase the size of a pool. In order to increase a pool on 
one port or channel, the same amount of buffers must be freed from other egress 
buffer pools on the same daughter card.

Connection termination points for services and interfaces

Connection termination points are objects that represent terminating endpoints for a 
service, for example the endpoint of a VLL service. Connection termination points 
can be Layer 2 or Layer 3 interfaces, depending on the type of service being created. 
At the connection termination points you must configure the mode as Access or 
Network, the Encap Type as required, the MTU size as required, and the configured 
MAC address as required when configuring the port or channel. The following 
objects can be used for connection termination points:

• STS-3 to STS-192 clear-channels
• DS3 clear channel
• DS0 groups
• ports
• bundle

STS-3 to STS-192 clear channel

STS-3 to STS-192 clear channel SONET/SDH ports can be used to create SAPs or 
IP interfaces with one clear channel on each port that operates at the rate of the parent 
object. Clear channel SONET applications can be performed on any OCx card. 
See “SONET clear-channel applications” in this section for more information.
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DS3 clear channel

A DS3 clear channel can be a connection termination point when it is explicitly 
configured as unchannelized, that is, when the Configuration Type is set to None, 
which is the default setting for a DS3. DS3 clear channel connections cannot be 
channelized to a lower level than the one full DS3 channel. See “TDM 
channelization and clear channel applications” in this section for more information.

DS0 channel groups
Only the DS0 group level can be used as a connection termination point for SONET 
STS-1 sub-channels. Channelization on the 1 × OC12 can be used to create up to 12 
SONET STS-1 sub-channels. Each of these STS-1 channels can be used to create a 
DS3 frame on which you can build DS1 or E1 channels that can be configured to the 
DS0 channel group level. You can configure the DS0s of a DS0 group in any 
sequence and you do not need to use all of them. For example, you may use DS0 1, 
3, 5, and 9 only, or anther combination. See “SONET VT1.5 and VT2 payloads” in 
this section for more information.

Only the DS0 group level can be used as an endpoint on the channelized 12 × DS3 
card. Channelization can be used on each DS3 port of this card to create independent 
TDM channels in the form of DS1 or E1 data channels that handle DS0 groups. As 
with SONET sub-channels, the DS0s of a DS0 group can be configured in any 
sequence and you do not need to use all of them. For example, you may use DS0 1, 
3, 5, and 9 only, or another combination. See “SONET and SDH sub-channel 
applications and structure” in this section for more information.

Ethernet ports

Ethernet ports can be configured as connection termination points in SAPs and IP 
interfaces. They cannot be channelized.

An access Ethernet port is used for customer-facing traffic on which services are 
configured. SAPs can only use an access port. When a port is configured for access 
mode, the appropriate encapsulation type must be specified to distinguish the 
services on the port. 

You must configure the class of port that will be part of the Ethernet connection. For 
example, the Ethernet port Class parameter options are Fast Ethernet, Gigabit 
Ethernet, or 10G Ethernet. You must also configure the Encap Type parameter from 
the General tab at the connection termination point. Ethernet access ports use:

• Dot1 Q — Supports multiple services on the port. The outer encapsulation ID 
used to distinguish services is the VLAN ID in the IEEE 802.1Q header.

• Q in Q — Supports multiple services on the port/channel. The inner and outer 
encapsulation ID used to distinguish services is the VLAN ID in the IEEE 802.1Q 
header. 

• Null — Supports a single service on the port.

You must specify the MTU size for an Ethernet port using the MTU (bytes) 
parameter on the General tab at the connection termination endpoint.
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Consider the following when you configure MTU parameters:

• The 7750 SR must handle MTU limitations at many service points. The physical 
(access and network) ports, service, and service tunnel MTU values must be 
individually defined.

• Identify the ports to be designated as network ports and the ports to be designated 
as access ports intended to carry service traffic.

• MTU values should not be modified frequently.
• Service MTU values must be less than or equal to the service tunnel MTU.
• Service MTU values must be less than or equal to the access port MTU.

The Ethernet port MTU parameter indirectly defines the largest physical packet that 
the port can transmit or the far-end Ethernet port can receive. Packets received that 
are larger than the MTU are discarded. Packets that cannot be fragmented at egress 
and exceed the MTU are discarded.

The parameters specified for MTU configuration include the destination MAC 
address, source MAC address, Ethernet encapsulation type, length field, and the 
complete Ethernet payload. 

You must configure the duplex parameter from the Ethernet tab if the port will be 
added to a LAG. Configure the Dot1 Q Ethertype and Q in Q Ethertype parameters 
from the Ethernet tab, if required. The range is 1536 to 65 535.

You must also configure the speed parameter from the General tab. The options are 
10, 100, 1000, or 10 000 option depending on the speed of the Ethernet interface.

SONET/SDH and TDM port encapsulation

SONET/SDH and TDM ports can be configured as connection termination points in 
SAPs and IP interfaces. They can be channelized.

An access port is used for customer-facing traffic on which services are configured. 
SAPs can only use an access port. When a port is configured for access mode, the 
appropriate encapsulation type must be specified to distinguish the services on the 
port. 

You must configure the Encap Type parameter from the General tab at the 
connection termination point. SONET/SDH or TDM ports or channels use:

• BCP Null
• IPCP
• BCP Dot1 Q
• FR — Support multiple services using the DLCI header to distinguish services
• ATM — Support multiple services using the VCI or VPI of the PVC

SONET clear-channel applications
Ports on OCx cards can be used for SONET clear channel applications. SONET or 
TDM clear channel applications allow you to create a full channel on a port which 
can be configured as access or network mode for SONET and access only for TDM. 
For example, when you create a 16 × OC3 SFP card, 16 ports are created. On each 
of these ports, you can create one full channel.
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STS-192/48/12/3 clear channel applications use the following syntax:

card slot/daughtercard/port.STSType

For example, the clear channel STS-12 on slot 4, MDA 1, port 1 is named 4/1/1.sts12 

Table 20-5 lists available SONET channel applications and parameters for clear 
channel, sub-channel, and TDM applications.

Table 20-5 SONET channel parameters

TDM channelization and clear channel applications

When you create a 12 × DS3/E3 card, 12 DS3/E3 ports are created. You can then 
create DS3/E3 channels using the 5620 SAM, one per port. Each DS3/E3 channel 
can be channelized into 28 independent DS1 or 21 independent E1 data channels or, 
in clear channel applications, the DS3 can be the connection termination point. For 
channelized DS3 connections, each DS1 channel can be channelized to 24 DS0 
groups and each E1 channel can be channelized to 31 DS0 groups. To use a DS1 or 
E1, you must create at least one DS0 group for the DS1 or E1. 

By default, DS3 ports are automatically created for clear channel connections. To 
create a channelized DS3, you must configure the DS3 channel type as E3 or DS3 on 
the port. To channelize the DS3 to the DS0 level, you must set the Channelization 
Type to Channelized DS1 or E1. Figure 20-2 shows the channelized DS3 port 
structure for DS1 channels.

Figure 20-2  Channelized 12 × DS3 port structure for DS1 Channels

Applications Channel ranges

STS-19
2
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8
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SONET Clear channel 1 1 1 1
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The channelized DS3 port structure for E1 channels has the following parameter 
values:

• each DS3 port supports 21 E1 channels
• each E1 channel supports 31 DS0 channel groups

TDM-based DS3 channelization uses the following syntax:

DS3 channel configured for TDM:

card slot/daughtercard/port.DS3-

DS1 channel from a TDM-based DS3 channel:

slot/daughtercard/port.DS1-[DS3#].[DS1#]

E1 channel from a TDM-based DS3 channel:

slot/daughtercard/port.DS1-[DS3#].[E1#]

DS0 group channel from the DS1 channel:

slot/daughtercard/port.DS0Grp-[STS3#].[STS1#].[DS1#/E1#].[Group#]

Table 20-6 provides an example of the naming conventions for a 12 × DS3 port.

Table 20-6 Example of TDM channel naming convention

Syntax Description Notes

Channel 1/1/1.ds3 1/1/1 is the slot number/daughtercard 
number/port number

.ds3 identifies the channel as DS3 

Because DS3s are unchannelized by 
default, you must configure the 
Channelization Type as Channelized.

Channel 1/1/1.ds1-1.2 .ds1 identifies the channel as DS1

1 is the DS3 number

.2 is the DS1 number (1 to 28) 

Identifies the DS1 channel and shows how 
the DS3 level acts as a place holder for the 
DS1s.

Channel 1/1/1.e1-1.2 .e1 identifies the channel as E1

1 is the DS3 number

.2 is the E1 number (1 to 21) 

Identifies the E1 channel and shows how 
the DS3 level acts as a place holder for the 
E1s.

Channel 1/1/1.ds0Grp-1.2.23 .ds0Grp- identifies the channel as a 
DS0 group

1 is the DS3 number

.2 is the DS1 number (1 to 28) or E1 
number (1 to 21)

.23 identifies the DS0 channel group 
(1 to 24) on the DS1 or (2 to 32) on the 
E1

The DS0 group is configured on the DS1 or 
E1 channel. Only a DS0 can be used as a 
CTP.
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ATM encapsulation

SONET/SDH clear channels can be provisioned so that ATM cells are encapsulated 
in SONET/SDH frames. The entire SONET/SDH path of the port is then used to 
carry ATM cells. The channel of the port becomes the ATM interface. ATM 
encapsulation is supported on the following daughter cards:

• 16 × ATM OC3 SFP
• 4 × ATM OC12/OC3 SFP

SONET/SDH clear channel applications with ATM encapsulation use the following 
syntax:

Daughter Card Slot - 3 (16 x ATMOC3), OK

Port 3/1/1 - Speed: OC3, State: OK

Channel 3/1/1.sts3, Mode: Access, Encap: ATM, State: Ok

Customer devices with ATM interfaces are connected directly or via the ATM access 
network to a 7750 SR, Release 2.1 or later, that offers IES or VPRN services. 

A SONET/SDH clear channel with ATM encapsulation can carry multiple ATM 
PVCs. ATM PVCs cannot be created from the 5620 SAM. They are created 
automatically by the router when a new Layer 3 interface over ATM is created. 
Figure 20-3 shows an example of ATM PVCs on a SONET/SDH clear channel.

Figure 20-3  ATM PVCs on a SONET/SDH clear channel

20.11 SONET and SDH sub-channel applications and structure

SONET sub-channel applications allow you to create multiple STS-1 channels on 
deep channelized OC-12 and OC-3 ports, and to configure multiple DS0 connection 
termination points.
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An STS-1 sub-channel is configured, or channelized, to carry one of the following 
payload types:

• DS3
• VT1.5
• VT2

Because of the differences between SONET and SDH in multiplexing and mapping 
of tributary payloads into higher digital levels, some building blocks of SDH have no 
SONET equivalent and therefore the containment hierarchy and terminology for 
SDH is different from SONET. See “Comparison of SONET and SDH hierarchies” 
and “SDH AU-4 and AU-3 sub-channel applications” in this section. 

SONET DS3 payload
 The following example, illustrated in Figure 20-4, shows the channelization 
sequence for a DS3 payload on a 1 × OC12 Deep Channel card.

1 One OC12 port is created when you create a channelized 1 × OC12 Deep 
Channel card. 

2 This port can be channelized into 12 SONET STS-1 sub-channels from the four 
STS-3s available on the port.

3 You can then configure each of these STS-1s to carry a DS3 frame

4 Each DS3 frame can be channelized into 28 independent DS1 data channels or 
21 independent E1 data channels. Each channel must be created one at a time.

Figure 20-4  Channelized 1 × OC-12 port structure using STS-1/DS3 sub-channels
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SONET VT1.5 and VT2 payloads
The following example, illustrated in Figure 20-5, shows the channelization 
sequence for a VT1.5 or VT2 payload on a 1 × OC12 Deep Channel card.

1 One OC12 port is created when you create a channelized 1 × OC12 Deep 
Channel card. 

2 This port can be channelized into 12 SONET STS-1 sub-channels from the four 
STS-3s available on the port.

3 You can then configure each of these STS-1s to be channelized to carry up to 28 
DS1. For SONET sub-channel configuration you must select payload type 
VT1.5 or VT2. When you choose VT1.5 payload type, seven VTG are implicitly 
created.

4 Each VTG is channelized into four independent VT1.5 channels or three VT2 
channels, each of which can carry an independent DS1 data channel. Each 
channel must be created one at a time. 

5 Each VT1.5 DS1 channel can be configured to handle up to 24 DS0 groups. Each 
VT2 DS1 channel can be configured to handle up to 32 DS0 groups. To use a 
DS1, you must create at least one DS0 group for the DS1 or E1.

Figure 20-5  Channelized 4 × OC-3 port structure using VT sub-channels
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SONET sub-channel syntax
The 5620 SAM uses the following SONET syntax for the STS-1 sub-channel:

card slot/daughtercard/port.STS1-[STS3#].[STS1#]

DS3 channels from an STS-1 sub-channel use the following syntax: 

slot/daughtercard/port.DS3-[STS3#].[STS1#] 

DS1 channels from a DS3 channel use the following syntax:

slot/daughtercard/port.DS1-[STS3#].[STS1#].[DS1#]

E1 channels from a DS3 channel use the following syntax:

slot/daughtercard/port.DS1-[STS3#].[STS1#].[E1#]

VT15 or VT2 from a VT group use the following syntax:

slot/daughtercard/port.VTG#-[STS3#].[STS1#]

DS1 channels from a VT15 or VT2 use the following syntax:

slot/daughtercard/port.DS1-[STS3#].[STS1#].[VT15#] or 
[VT2#}.[VTG#].[DS1#]

Table 20-7 shows an example of the sub-SONET syntax.

Table 20-7 Example of SONET sub-channel syntax for an OC-12 port

Syntax Description Notes

Channel 1/1/1.sts1-2.2 1/1/1 is the slot number/daughtercard 
number/port number

2 is the STS-3 number (1 to 4) 

.2 is the STS-1 number (1 to 3) 

The sts1 parameter is 2.2 which means that it 
is the fifth STS-1. There are four STS-3s for 
an OC-12 and each STS-3 has three STS-1s 
such that the fifth STS-1 is the second STS-1 
of the second STS-3.

Channel 1/1/1.ds3-2.2 .ds3-2 is the STS3 number (1 to 4) 

.2 identifies the STS-1 number (1 to 3)

Identifies the DS3 channel and shows how 
the sts1 level acts as a place holder for the 
DS3

Channel 1/1/1.ds1 2.2.25 .ds1-2.2.25 identifies a DS1 channel 
(1 to 28) on the DS3

The DS1 is configured on the DS3.

Channel 1/1/1.e1 2.2.21 .e1-2.2.21 identifies a E1 channel (1 to 
21) on the DS3

The E1 is configured on the DS3.

Channel 1/1/1.DS0Grp-2.2.20.5 .DS0Grp-2.2.20.5 identifies one of the 
DS0 channel groups: 1 to 28 for DS1; 
2 to 32 for E1

The DS0 is configured on the DS1 or E1 
channel. 

Channel 1/1/1.ds1 2.2.3.18 ds1 2.2.3.18 identifies a DS1 channel 
on the VT15 or VT2 payload, where 3 
is the VT group.

—
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Comparison of SONET and SDH hierarchies
SONET and SDH are compatible digital hierarchies that support identical 
transmission rates with similar framing structures. However, SONET and SDH 
standards differ in the way they multiplex and map tributary payloads into higher 
digital levels. Because of these differences, some SDH framing blocks do not have 
equivalent blocks in SONET.

SONET provides one STS sub-channel, the STS-1, for mapping lower-capacity, 
deep-channel payloads while SDH provides two alternative sub-channels, the AU3 
and the AU4. Once an AU3 sub-channel is created, an AU4 cannot be created on that 
port in the case where the port is an OC-3 (STM-1). Conversely, if an AU4 
sub-channel is created, an AU3 cannot be created on that port in the case where the 
port is an OC-3 (STM-1).

SONET and SDH transmission rates converge at 155.520 Mb/s where the SONET 
STS-3c is equivalent to the SDH STM-1 bit rate. For lower-capacity payloads, such 
as DS1, E1, DS3, and E3, SONET provides one unique mapping path for each 
payload while SDH permits two alternative paths for each payload as shown 
Figure 20-6.

Figure 20-6  Supported SONET/SDH multiplexing structures
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TUG-3 is channelized to carry one of the following payload types:

• TU3
• TU11
• TU12
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Once an AU-3 sub-channel is created, it is channelized to carry one of the following 
payload types:

• DS3, E3
• TU11
• TU12

SDH TU3 payload
 The following example, illustrated in Figure 20-7, shows the channelization 
sequence for a TU3 payload on a 4 × OC3 Deep Channel card.

1 Four OC-3 ports are created when you create a channelized 4 × OC3 Deep 
Channel card. 

2 The user creates each required AU4 sub-channel.

3 Each AU4 sub-channel implicitly contains three TUG3 groups.

4 You can then configure each TUG3 to carry a TU3 frame

5 Each TU3 frame is channelized into an independent E3 data channel and cannot 
be changed. 

Figure 20-7  Channelized 4 × OC-3 port structure using AU4/TU3 sub-channels

SDH E3 or DS3 payload
 The following example, illustrated in Figure 20-8, shows the channelization 
sequence for an E3 or DS3 payload on a 4 × OC3 Deep Channel card using AU3 
sub-channels.

1 Four OC-3 ports are created when you create a channelized 4 × OC3 Deep 
Channel card. 

2 Each port can be channelized into up to three AU3 sub-channel.

3 Each AU3 frame can be channelized into an independent E3 or DS3 data 
channel. 
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Figure 20-8  Channelized 4 × OC-3 port structure using AU3/E3 sub-channels

SDH TU11 and TU12 payloads
TU11 and TU12 payloads can be channelized via an AU4 sub-channel or an AU-3 
sub-channel. An AU4 sub-channel implicitly contains three TUG3 groups. A TUG3 
and an AU3 channelized to carry TU11 or TU12 payloads implicitly contain seven 
TUG2 tributary groups.

 The following example, illustrated in Figure 20-9, shows the channelization 
sequence for a TU11or a TU12 payload on a 4 × OC3 Deep Channel card.

1 Four OC-3 ports are created when you create a channelized 4 × OC3 Deep 
Channel card. 

2 Each port can be channelized into one AU4 sub-channel or three AU3 
sub-channels.

3 Each AU4 sub-channel implicitly contains three TUG3 groups.

4 You can then configure each TUG3 group or each AU3 sub-channel to carry a 
TU11 or TU12 payload.

5 Each TUG3 group or AU3 sub-channel implicitly contains seven TUG2 tributary 
groups.

6 Each TUG2 group can be channelized into three independent TU12 channels or 
four independent TU11 channels. 

7 Each TU12 can contain an E1 or DS1 data signal. Each TU11 can contain a DS1 
data signal. Each E1 can be configured to handle up to 31 DS0 groups. Each DS1 
can be configured to handle up to 24 DS0 groups. To use an E1 or a DS1, you 
must create at least one DS0 group for the DS1 or E1.
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Figure 20-9  Channelized 4 × OC-3 port structure using AU4/TU sub-channels

20.12 Working with ring group objects

The 5620 SAM allows you to create and manage ring groups in the ring group view 
of the navigation tree. Ring groups are used to group devices logically.

In the ring group view of the navigation tree, the network icon provides the 
contextual menu option Create Ring Group to create ring group icons. Using the 
properties form of a ring group, you can group devices logically in the ring group. 
See chapter 21 for more information about creating and managing ring groups. 
Figure 20-10 shows a sample navigation tree ring group view.
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Figure 20-10  Sample navigation tree ring group view
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21.1 Navigation tree overview

The view selector in the 5620 SAM navigation tree is a drop-down menu that lists 
the view options that you can choose. The available views are:

• Equipment
• OSPF
• ISIS
• Network
• Ring Group

The equipment view in the navigation tree contains the physical objects that the 
5620 SAM manages and that can be created in a hierarchical order for the managed 
device. There can be more than one managed device object in the navigation tree. In 
the navigation tree, you can use the contextual menu choices to create, configure, and 
manage specific parameters for the children objects of the discovered device.

The ring group view in the navigation tree contains the ring group objects that the 
5620 SAM manages and that can be created in a hierarchical order for the managed 
network. There can be more than one managed ring group object in the navigation 
tree. In the navigation tree, you can use the contextual menu choices to create, 
configure, and manage specific parameters for the ring group objects of the managed 
network.

The navigation tree displays information about the status of managed devices, 
including the alarm status of an object, and the aggregated alarm status of an object, 
based on the alarms raised against child objects of the parent objects. As well, the 
state of the object, for example the operational state or the administrative state, is 
displayed following the icon, object type, and description of the object, as shown in 
Figure 21-1.

The 5620 SAM allows you to manage and create the following objects in the 
equipment view of the navigation tree:

• network — to contain all routers and devices
• router and device — the next level in the hierarchy
• CCAG, LAG, and shelf — each is at the third highest level in the hierarchy
• APS Groups — located under the shelf, used to contain all APS groups for the 

device
• card — located under the shelf, considered the parent object
• daughter card — a child object of the card object
• bundles — to group DS0 channel groups on a TDM-capable daughter card
• port — automatically created under each daughter card, a child object of the 

daughter card
• channel, sub-channel, and timeslot — child objects of the port

The 5620 SAM allows you to create and manage ring groups in the ring group view 
of the navigation tree. Ring groups are used to group Telco and other devices, such 
as a 7450 ESS, logically.
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To access objects in the navigation tree from the 5620 SAM:

• Click on an object in either the equipment view or the ring group view of the 
navigation tree and use the + and - icons to navigate the hierarchy of network 
equipment or ring group objects. In the equipment view, for example, you can 
navigate from the device to the ports and channels.

• Right-click on each object to open the contextual menu and choose a function. 
The functions available from the contextual menu are specific to each object in 
the hierarchy. 

Figure 21-1 shows some of the navigation tree objects that you can view from the 
equipment view.

Figure 21-1  Navigation tree objects - equipment view
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Contextual menus for objects in the navigation tree

The contextual menus reside on each object and are a right-click function in both the 
navigation tree and the equipment manager Display tab. They are used to create 
objects, configure properties for objects, perform maintenance duties, change states 
on object parameters, provide another management interface, and redefine the root 
of the navigation tree. See chapter 24 for routing menu information.

Equipment view contextual menus

The following describes the contextual menu options for each object in the 
navigation tree hierarchy of the equipment view:

• The contextual menu options for a device include:
• Add to Ring Group

The Add to Ring Group menu option specifies whether to add the device to 
a group.

• Resync
The Resync menu option specifies that SNMP MIB and CLI information 
bases are re-read to resynchronize them with the 5620 SAM, which also 
resynchronizes the network management settings with the router. 
Resynchronization does not impact the contents of the historical statistics 
database.

• Equipment Manager
The Equipment Manager option launches the 5620 SAM equipment 
manager. 

• External Element Manager
The External Element Manager option launches the BiNOS element 
manager for the selected Telco device. 

• CLI Session
The CLI Session option opens a Telnet Session or an SSH Session with the 
selected device in the equipment view of the navigation tree.

• Make Root In New Tree
The Make Root In New Tree option opens another navigation tree window 
with the selected device as the root of the tree.

• Properties
The Properties option opens the property form for the chosen object. This 
form displays read-only information and configurable parameters.

• The contextual menu options for CCAGs include:
• Create CCAG
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The Create CCAG option opens the Create CCAG configuration form, 
which allows you to create a cross-connect aggregation group. You define 
CCAG properties, configure CCAG parameters, and configure CCAG 
members.

• The contextual menu options for LAGs include:
• Resync

The Resync menu option specifies that MIB tables are re-read to 
resynchronize them with the 5620 SAM, which also resynchronizes the 
network management settings with the router. Resynchronization does not 
impact the contents of the historical statistics database.

• Create LAG
The Create LAG option opens the Create LAG configuration form that 
allows you to create a link aggregation group. You define LAG properties, 
configure LAG parameters, configure LACP, and configure LAG members.

• Make Root In New Tree
The Make Root In New Tree option opens another navigation tree window 
with the selected LAG as the root of the tree.

• Make Root
The Make Root option makes the selected LAG the root of the navigation 
tree. The default root is the network.

• Properties
The Properties option opens the properties form where you configure LACP 
System priority parameter. 

• The contextual menu options for a shelf include:
• Resync

The Resync menu option specifies that MIB tables are re-read to 
resynchronize them with the 5620 SAM, which also resynchronizes the 
network management settings with the router. Resynchronization does not 
impact the contents of the historical statistics database.

• Reboot
The Reboot option specifies that all cards in the chassis are re-initialized.

• Force Mode
The Force Mode menu option forces an upgrade of the hardware.

• Make Root In New Tree
The Make Root In New Tree option opens another navigation tree window 
with the selected shelf as the root of the tree.

• Make Root 
The Make Root option makes the selected shelf the root of the navigation 
tree. The default root is the network.

• Properties
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The Properties option opens the properties form where you can view and edit 
properties contained in the shelf. You can view general properties for the 
shelf, such as fan trays, power supply trays, and LED panels, and view and 
change the properties for objects contained in the shelf, such as hardware 
environment, card slots, statistics policies, and faults.

• The contextual menu options for the APS Groups object include:
• Add

The Add menu option opens the Aps Group (Create) form that allows you to 
create and manage APS groups on the shelf.

• Resync
The Resync menu option specifies that MIB tables are re-read to 
resynchronize them with the 5620 SAM, which also resynchronizes the 
network management settings with the router. Resynchronization does not 
impact the contents of the historical statistics database.

• Make Root In New Tree
The Make Root In New Tree option opens another navigation tree window 
with the selected APS group object as the root of the tree.

• Make Root
The Make Root option makes the selected APS group object the root of the 
navigation tree. The default root is the network.

• The contextual menu options for a card slot include:
• Resync

The Resync menu option specifies that MIB tables are re-read to 
resynchronize them with the 5620 SAM, which also resynchronizes the 
network management settings with the router. Resynchronization does not 
impact the contents of the historical statistics database.

• Configure Card
The Configure Card option opens the Create Card properties form that 
allows you to create a card configuration for the slot. You assign a supported 
card type to the slot. The options available are displayed with check marks 
beside them in the Supported Card Types parameter. The Equipped Card 
Type displays the card type that is physically in the slot. When there is a 
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mismatch between the Equipped Card Type and the Assigned Card Type, a 
check mark appears in the Mismatch box. When the configured card types 
are correct, you can change the Administrative State as required.

• Shut Down 
The Shut Down option specifies that the card slot is changed to 
administratively down. 

• Turn Up
The Turn Up option specifies that the card slot is changed to administratively 
up. 

• Remove Card
The Remove Card option deletes the card from the slot when the slot and 
everything contained in the slot is changed to administratively down. 

• Reboot
The Reboot option specifies that all cards in the chassis are re-initialized.

• Make Root In New Tree
The Make Root In New Tree option opens another navigation tree window 
with the selected card as the root of the tree.

• Make Root
The Make Root option makes the selected card the root of the navigation 
tree. The default root is the network.

• Properties
The Properties option opens the properties form where you can view and 
change properties contained in the card slot. After the card object is created, 
you can use the properties option on the slot to view, edit, and create all the 
properties that can be contained in the card slot, for example daughter cards 
and ports.

• The contextual menu options for a daughter card slot include:
• Resync

The Resync menu option specifies that MIB tables are re-read to 
resynchronize them with the 5620 SAM, which also resynchronizes the 
network management settings with the device. Resynchronization does not 
impact the contents of the historical statistics database.

• Configure Daughter Card
The Configure Daughter Card option opens the Create Daughter Card 
properties form that allows you to create a daughter card configuration for 
the slot. You assign a supported daughter card type to the daughter card slot. 
The options are displayed with check marks beside them in the Supported 
Daughter Card Types and Allowed Daughter Card Types areas of the form. 
The Equipped Daughter Card Type displays the daughter card type that is 
physically in the slot. When there is a mismatch between the Equipped 
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Daughter Card Type and the Assigned Daughter Card Type, a check mark 
appears in the Mismatch box. When the configured card types are correct, 
you can change the Administrative State as required.

• Shut Down 
The Shut Down option specifies that the daughter card slot is changed to 
administratively down. 

• Turn Up
The Turn Up option specifies that the daughter card slot is changed to 
administratively up. 

• Remove 
The Remove option deletes the daughter card from the slot when the slot and 
everything contained in the slot is changed to administratively down. 

• Make Root In New Tree
The Make Root In New Tree option opens another navigation tree window 
with the selected daughter card as the root of the tree.

• Make Root
The Make Root option makes the selected daughter card the root of the 
navigation tree. The default root is the network.

• Properties
The Properties option opens the properties form. You can view and change 
properties in the daughter card slot. After the daughter card object is created, 
you can use the properties option on the slot to view, modify, and create all 
the properties that can be contained in the slot, for example daughter cards 
and the QoS Pool for the daughter card slot.

• The contextual menu options for the Bundles object include:
• Create Bundle

The Create Bundle option opens the Create Multilink Bundle configuration 
form that allows you to create a group of DS0 channel groups on a 
channelization-capable MDA. Creating a multilink bundle provides a 
mechanism to distribute data across multiple links to achieve higher 
bandwidth on a SAP. You configure bundle parameters and add bundle 
members.

• Resync
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The Resync menu option specifies that MIB tables are re-read to 
resynchronize them with the 5620 SAM, which also resynchronizes the 
network management settings with the device. Resynchronization does not 
impact the contents of the historical statistics database.

• The contextual menu options for bundles include:
• Resync

The Resync menu option specifies that MIB tables are re-read to 
resynchronize them with the 5620 SAM, which also resynchronizes the 
network management settings with the device. Resynchronization does not 
impact the contents of the historical statistics database.

• Create Bundle Members
The Create Bundle Members option opens the Add Bundle Member 
configuration form that allows you to add members to a multilink bundle.

• Remove
The Remove option deletes the bundle when everything contained in the port 
is changed to administratively down. 

• Shut Down
The Shut Down option specifies that the bundle is changed to 
administratively down.

• Turn Up
The Turn Up option specifies that the bundle is changed to administratively 
up.

• Make Root
The Make Root option makes the selected bundle the root of the navigation 
tree. The default root is the network.

• Properties
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The Properties option opens the properties form. You can view and change 
properties for the bundle, or view and modify bundle members.

• The contextual menu options for ports include:
• Resync

The Resync menu option specifies that MIB tables are re-read to 
resynchronize them with the 5620 SAM, which also resynchronizes the 
network management settings with the device. Resynchronization does not 
impact the contents of the historical statistics database.

• Create Channel
The Create Channel option allows you to create channels on ports with 
available channels. 

• Shut Down 
The Shut Down option specifies that the port is changed to administratively 
down. 

• Turn Up
The Turn Up option specifies that the port is changed to administratively up. 

• Remove 
The Remove option deletes the port when everything contained in the port is 
changed to administratively down. 

• Make Root In New Tree
The Make Root In New Tree option opens another navigation tree window 
with the selected port as the root.

• Make Root
The Make Root option makes the selected port the root of the navigation 
tree. The default root is the network.

• Properties
The Properties option opens the properties form. You can view and change 
properties contained in the port. Port objects are automatically created when 
the daughter card object is created. Use the properties option on the slot to 
view, change, and create all the properties that can be contained in the slot, 
for example, SONET channels.

• The contextual menu options for channels include:
• Resync

The Resync menu option specifies that MIB tables are re-read to 
resynchronize them with the 5620 SAM, which also resynchronizes the 
network management settings with the device. Resynchronization does not 
impact the contents of the historical statistics database.

• Remove
The Remove option deletes the channel when all objects contained in the 
channel are changed to administratively down. 

• Shut Down
The Shut Down option specifies that the channel is changed to 
administratively down. 

• Turn Up
The Turn Up option specifies that the channel is changed to administratively 
up. 

• Make Root In New Tree
The Make Root In New Tree option opens another navigation tree window 
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with the selected channel as the root.
• Make Root

The Make Root option makes the selected channel the root of the navigation 
tree. The default root is the network.

• Properties
The Properties option opens the properties form. You can view and change 
properties contained in the channel.

Ring group view contextual menus

The following describes the contextual menu options for each object in the 
navigation tree hierarchy of the ring group view:

• The contextual menu option for a network is Create Ring Group, which is used to 
group Telco and other devices, such as 7450 ESSs, in order to create Ethernet 
rings that connect VLANs to services.

• The contextual menu options for a ring group include:
• Remove Ring Group

The Remove Ring Group option removes the specified ring group. The 
devices contained in the ring group are not deleted; they remain in the 
equipment view of the navigation tree.

• Properties
The Properties option opens the property form. You can view and modify 
properties for the ring group, or view and modify ring group members.

• The contextual menu options for a device in a ring group include:
• Remove From Ring Group

The Remove From Ring Group option removes the specified device from the 
ring group. The devices are not deleted; they remain in the equipment view 
of the navigation tree.

• Resync
The Resync menu option specifies that SNMP MIB and CLI information are 
re-read to resynchronize them with the 5620 SAM, which also 
resynchronizes the network management settings with the router. 
Resynchronization does not impact the contents of the historical statistics 
database.

• Equipment Manager
The Equipment Manager option launches the 5620 SAM equipment 
manager.

• External Element Manager
The External Element Manager option launches the BiNOS element 
manager for the selected Telco device.

• CLI Session
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The CLI Session option opens a Telnet Session or an SSH Session with the 
selected device in the ring group view of the navigation tree.

• Properties
The Properties option opens the property form. You can view and modify 
properties for the device.

21.2 Workflow to manage equipment using the navigation tree

1 Discover the device.

2 Right-click on the object in the navigation tree to open the contextual menu.

3 Choose an option. See section 21.1 for a list of contextual menu options.

4 Configure the parameters, as required.

i Edit the device parameters as required using the Properties forms from the 
contextual menu.

ii Create card objects in the shelf using the Properties forms from the contextual 
menu in the equipment view.

iii Create daughter card objects in the card objects using the Properties forms 
from the contextual menu in the equipment view.

iv View the parameters of the port objects that were created automatically with 
the daughter card object using the Properties forms from the contextual menu 
in the equipment view.

v Edit the parameters of the created objects as required using the Properties 
forms from the contextual menu in the equipment view.

vi Create channel objects on the SONET/SDH and TDM ports using the 
Properties forms from the contextual menu in the equipment view.

vii Edit the channel parameters as required using the Properties forms from the 
contextual menu in the equipment view.

viii Group DS0 channel groups together on an MDA to achieve higher bandwidth 
using the Create Multilink Bundle configuration form from the contextual menu 
in the equipment view.

5 Save the configuration, as required. 

21.3 Navigation tree equipment management menus

Table 21-1 lists the menu items to manage and configure equipment using the 
navigation tree.
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Table 21-1 5620 SAM navigation tree equipment management menus

21.4 Navigation tree equipment management procedures list

Table 21-2 lists the procedures to configure equipment using the navigation tree.

Table 21-2 5620 SAM navigation tree equipment management procedures list

Menu option Task

Contextual menu for equipment view objects in 
the navigation tree

View, open, create, and configure properties or 
start a Telnet or SSH session.

Contextual menu for ring group view objects in 
the navigation tree

Procedure Purpose

To group Telco and other devices in a ring group Create and configure devices, including the 
router, chassis, card slots, cards, daughter card 
slots, daughter cards, ports, channels, multilink 
bundles, CCAGs, and LAGs.

To change device properties

To enable or disable 802.1X

To create and configure a CCAG

To create and configure a LAG

To create a card type

To create daughter cards

To configure Ethernet ports

To configure SONET ports

To configure TDM ports

To configure SONET clear channels

To configure SONET sub-channels

To configure SDH sub-channels

To create VT1.5 (TU11) or VT2 (TU12) 
sub-channels

To create TDM channels

To configure a PVC

To create a multilink bundle

To configure properties of TDM channels

To make a selected object the root of the 
navigation tree

Redefine the root of the navigation tree, including 
opening multiple navigation tree windows with 
different roots.

To make a selected object the root of another 
navigation tree

To restore the default navigation tree root

To delete network equipment See 7750 SR OS System Guide for more 
information.
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21.5 Navigation tree equipment management procedures

Use the following procedures to manage equipment using the navigation tree.

Procedure 21-1  To group Telco and other devices in a ring group

You can use the ring group creation function to:

• indicate a VLAN ring topology, for example, by grouping Telco devices and 
7450 ESSs that operate in the same spanning tree or Ethernet ring

• configure the properties of the ring group to provide VLAN Internet, BTV (MVR), 
and L2 VPN (TLS) services

• group devices by geographic region

Consider the following when you create ring groups:

• The VLAN ID for Telco devices must be unique within a ring group.
• Services on a Telco device are not resynchronized or managed until the device 

is added to a ring group.

1 Choose Ring Group from the view selector in the navigation tree. The navigation 
tree refreshes to display the ring group view.

2 Right-click on the network object and choose Create Ring Group from the contextual 
menu. The Ring Group (Create) form opens with the General tab button selected.

3 Configure the General parameters:

• Group Name
• Description

4 Click on the TLS tab button to configure L2 VPN parameters.

5 Configure the TLS parameters:

• Enabled
• Ethertype
• Jumbo Frame

You must enable the Enabled parameter to display the Ethertype and Jumbo Frame 
parameters.

6 Click on the OK button. The Ring Group (Create) form closes. The Ring 
Group:name_of_group object appears in the navigation tree.
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7 Add Telco and other devices to a ring group.

i Right-click on the ring group object to which you want to add a device and 
choose Properties from the contextual menu. The Ring Group (Edit) form 
opens.

ii Click on the Group Members tab button to add a device.

iii Click on the Add button. The Select Network Elements form appears.

iv Choose one or more devices, as required, from the list of available devices and 
click on the OK button. A warning dialog box appears.

v Click on the OK button. The Select Network Elements form closes and the 
selected device information is displayed in the Group Members tab.

vi Click on the OK button. A confirmation dialog box appears.

vii Click on the Yes button. The Ring Group (Edit) form closes and the device 
objects appear in the navigation tree under the selected Ring 
Group:name_of_group object.

Alternatively, you can add a device to a ring group by right-clicking on the device 
object in the equipment view and choosing Add To Ring Group from the contextual 
menu. The Select Group form opens. Choose a ring group from the list and click on 
the OK button. The Select Group form closes and the device object appears under 
the Ring Group:name_of_group object in the ring group view.

8 To remove a device from a group:

i Right-click on the device object in a ring group that you want to remove in the 
ring group view.

ii Choose Remove From Ring Group from the contextual menu. The device is 
removed from the ring group.

9 To remove a ring group:

i Right-click on the Ring Group:name_of_group object that you want to remove 
in the ring group view.

ii Choose Remove Ring Group from the contextual menu. A confirmation dialog 
box appears.

iii Click on the Yes button to confirm the action. The ring group is removed from 
the navigation tree.

10 To view network-level alarms from a Telco or other device within a ring group, click 
on the Faults tab button in the Ring Group (Edit) form.

Procedure 21-2  To change device properties

1 Right-click on a discovered device in the navigation tree and choose Properties from 
the contextual menu.
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The properties form for the device is displayed.

2 Use the properties form to view or modify the parameters, as required. See the 
following chapters for more information. For example, you can configure supported 
protocols using the following tabs.

• The General tab button displays the Location parameter.
• The Polling tab button displays polling parameters. See chapter 10 for more 

information about configuring in-band or out-of-band polling policies.
• The Protocols tab button displays the routing protocols configured for the device. 

See chapter 24 for more information about configuring protocols.
• The Load Balancing tab button displays the L4 Load Balancing parameter.
• The PAE Site tab displays the Administrative State parameter.
• The Groups tab button displays the ring groups associated with the device. See 

Procedure 21-1 for more information.
• The Faults tab button displays the network-level alarms for the device.

Procedure 21-3  To enable or disable 802.1X

You can view the status of 802.1X authentication on a device in a managed network.

1 Enable 802.1X on a managed device:

i Right-click on a managed 7450 ESS or 7750 SR in the equipment view of the 
navigation tree.

ii Choose Properties from the contextual menu. The properties form for the 
device appears.

iii Click on the PAE Site tab button.

iv Set the Administrative State parameter to Up.

v Click on the OK or Apply button.

vi Repeat step 1 for each device for which you want to enable 802.1X.

To create and distribute 802.1X policies to the devices that use 802.1X, see 
Procedure 28-7.

To configure 802.1X on Ethernet access ports, see Procedure 21-8.

2 To disable 802.1X on a managed device, repeat step 1 but set the Administrative 
State to Down.

Note —  Before you can create an 802.1X policy, 802.1X must be 
enabled on the device. Before you can configure 802.1X on an Ethernet 
access port, 802.1X must be enabled on the device and an 802.1X policy 
must be created and distributed to the device.
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Procedure 21-4  To create and configure a CCAG

1 From the navigation tree, select Equipment from the view selector.

2 Locate and expand the device on which you want to create a CCAG.

3 Right-click on the CCAG icon and choose Create CCAG. The CCAG (create) form 
opens.

4 Select the General tab button.

5 Configure the parameters. They include:

• CCAG ID
• Description
• CCA Rate Enabled
• CCA Rate (Kb/s)
• Access Adapt QoS
• Administrative State

6 Select the CCAG MDA Members tab button. This tab displays any CCAG MDA 
members associated with this CCAG.

7 Click on the Add button. The CCAG MDA Member (Create) form opens.

8 Click on the Select button. The Select Member MDA form opens. This form lists any 
available VSM-CCA cards.

9 Select the MDA to add to this CCAG and click the OK button. The Select MDA 
Member form closes and returns the CCAG MDA Member (Create) form reappears. 
The information of the selected MDA appears in the Member MDA panel.

10 The CCAG MDA Members tab is now populated with the selected MDA.

11 Click on the Apply button. The Faults tab is added to the form.

12 Click on the CCAG Paths tab button. The Alpha and Beta paths are displayed. If 
either path requires editing, continue to step 13. Otherwise, go to step 25.

13 Select a path and click Edit if required. The CCAG Internal Path (edit) form opens.

14 Click on the General tab button.

15 Configure the parameters. They include:

• Path Rate Enabled
• Path Rate (Kb/s)
• Path Rate Option
• Path Weight (%)

16 Click on the Path Cross Connects tab button. This tab will display the cross- 
connects associated with the path.

17 Select a cross-connect to be configured and click Edit. The Cross Connect (Edit) 
form opens.

18 Click on the General tab button.
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19 Configure the parameters. They include:

• Description
• Configured MAC
• MTU

20 Click on the States tab button.

21 Configure the Administrative State, if required.

22 Click on the Policies tab button.

23 Configure the parameters. They include:

• Egress Slope Policy
• Egress Reserved CBS (%)
• Ingress Slope Policy
• Ingress Reserved CBS (%)

24 Click on the OK button. The Cross Connect (Edit) form closes and the CCAG (Edit) 
form reappears.

25 Click OK.

Procedure 21-5  To create and configure a LAG

1 Right-click on the LAG object in the navigation tree and choose Create LAG from 
the contextual menu.

2 Configure the parameters. They include:

• LAG ID
• Auto-Assign ID
• Description
• Configured Address
• Mode
• Encap Type
• Administrative State

3 Click on the Next button. The Configure LAG Parameters form opens.

4 Configure the parameters. They include:

• Port Threshold
• Port Threshold Action
• Dynamic Cost

5 Click on the Next button.

a If you set the Mode parameter to Network, The Configure LACP form opens. 
Go to step 8.
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b If you set the Mode parameter to Access, The Configure Access Parameters 
form opens. Go to step 6.

6 Configure the QoS Adaptation parameter.

7 Click on the Next button. The Configure LACP Parameters form opens.

8 Configure the parameters. They include:

• Administrative State
• LACP Mode

One end of the LAG group must be configured as active for LACP to work 
properly.

• LACP Transmit Interval
• Actor Administration Key

9 Click on the Next button. The Configure LAG Members form opens.

10 Click on the Add button to add network ports to LAGs. The Only show compatible 
ports screen appears.

11 Configure the parameters. They include:

• Show Only Compatible Ports
• Class

12 Click on the Next button.

The Select Ports form opens.

13 Select compatible ports from the list to construct the LAG.

Add ports to an LAG as follows:

• Choose up to eight ports from the list of ports.
• Click on the Next button. The Define the Priority form opens.
• Define the priority of the LAG.

14 Click on the Finish button.

The Create LAG Member form closes and the Create LAG form re-opens.

15 Click on the Finish button to save the configuration.

Note 1 — If there are no compatible ports to choose from and you have 
decided that you want to edit some of the existing ports that are not 
compatible to be compatible, disable the Show compatible ports only 
parameter. Click on the Next button. Choose ports to edit from the list and 
click on the Edit button.

Note 2 — For all ports in an LAG, you must disable auto-negotiation, 
configure the same speed, and set the ports to full duplex.

Note 3 — You must use the same load balance algorithm for the ports 
associated with the LAG.
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16 Use the Properties contextual menu to view information about the created LAG, or 
modify LAG parameters.

• The General tab displays the LAG ID, the description, and the configured MAC 
address.

• The Link Aggregation Group tab displays the threshold parameters, cost 
information, and the primary port in the LAG, along with all the other LAG 
member ports.

• Statistics, terminations, and fault information is available from the appropriate 
tabs.

Procedure 21-6  To create a card type

1 Choose Configure Card from the contextual menu on any one of the empty Card 
Slot objects in the navigation tree.

The Card Slot (Create) configuration form appears.

The number of slots depends on how many configured cards there are, and how 
many slots are on the managed router. Empty slots and configured slots are listed.

2 Configure the Assigned Card Type parameter. The options are:

• 1 x 10-Gig MDA IOM for one daughter card
• 2 x 10-Gig MDA IOM for two daughter cards
• 2 x 10-Gig MDA IOM Card, B for two daughter cards

3 Click on the OK button to save the changes.

The card and slot appear in the navigation tree and in the inventory list of the 
equipment manager.

Procedure 21-7  To create daughter cards

1 Choose Configure Daughter Card from the contextual menu on a Card Slot object 
in the navigation tree. Different cards can have different numbers of daughter card 
slots, some have one daughter card slot and some have two daughter card slots. If 
there is a plus sign beside the Card object, click on it to expand the tree then choose 
a daughter card slot for the daughter card.

The Daughter Card Slot (Create) configuration form appears.
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2 Configure the Assigned Daughter Card Type parameter. The options that appear 
depend on the type of device and include the following:

3 Click on the QoS Pool tab button.

4 Choose a QoS pool from the available list of QoS policies, such as network ingress 
and access ingress.

5 Click on the OK button.

The daughter card and all its ports appear in the navigation tree and in the inventory 
list of the equipment manager.

Procedure 21-8  To configure Ethernet ports

Perform the steps in this procedure as required depending on the daughter card and port 
type that you are configuring. Different card types will display different port configuration 
parameters.

1 Right-click on the port object in the navigation tree and choose Properties from the 
contextual menu.

The properties form appears. Figure 21-2 shows the port configuration form for an 
Ethernet port with the General tab selected. 

• 60 × 10/100 Ethernet
• 16 × OC12/OC3 SFP
• 16 × OC3 SFP
• 4 × OC48 SFP
• 5 × 1-Gig Ethernet SFP
• 1 × OC12 Deep Channel 
• 4 × OC3 Deep Channel
• 20 × 10/100 Ethernet Fx
• 2 × 10-Gig Ethernet XFP
• 16 × ATM OC3 SFP
• 4 × DS3/E3 Deep Channel
• 24 × Fast Ethernet 10/100 TX
• 4 × Gig Ethernet (2 TX, 2 FX)
• 24 × Gig Ethernet (20 FX, 4 Dual 

TX/FX)
• VSM Cross-Connect Adaptor 
• 10 × 10/100/1000 Ethernet SFP

• 10 × 1-Gig Ethernet SFP
• 8 × OC12/OC3 SFP
• 8 × OC3 SFP
• 1 × OC192
• 12 × DS3/E3 Deep Channel
• 1 × 10-Gig Ethernet
• 2 × OC48 SFP
• 20 × 10/100/1000 Ethernet Tx
• 4 × ATM OC12/OC3 SFP
• 20 × 10/100/1000 Ethernet SFP
• 1 × 10-Gig Ethernet XFP
• 48 × Fast Ethernet 10/100 TX
• 24 × Gig Ethernet (20 TX, 4 Dual 

TX/FX)
• 24 × Gig Ethernet 10/100 TX 
• 5 × 10/100/1000 SFP

Note —  Before you can configure 802.1X on an Ethernet access port, 
802.1X must be enabled on the device and an 802.1X policy must be 
created and distributed to the device.

See Procedure 21-3 for information about enabling 802.1X on a device. 
See Procedure 28-7 for information about creating and distributing 
802.1X policies.
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Figure 21-2  Ethernet port configuration form - General

2 Click on the General tab button.
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3 Configure the parameters. They include:

• Description
• Configured MAC

Only one MAC address can be assigned to a port. When a new MAC address is 
configured while the port is operational, IP issues an ARP, if appropriate, and 
BPDUs are sent with the new MAC address. A default MAC address is assigned 
by the system.

• Mode
An access port is used for customer-facing traffic on which services are 
configured. SAPs can only use an access port or channel. When a port is 
configured for access mode, the appropriate encapsulation type must be 
specified to distinguish the services on the port. The appropriate Encap Type 
can be configured on the terminating port. 
A network port or channel configured for network access participates in the 
service provider transport or infrastructure network. When the network option is 
configured, the encapsulation type cannot be configured. When network ports 
are configured, the appropriate control protocols are activated when necessary.

• Encap Type
• Speed
• MTU (bytes)
• Hold Time Up
• Hold Time Down
• Load Balance Algorithm

4 Click on the States tab button.

5 Configure the Administrative State parameter.

6 Click on the Ethernet tab button.

7 Configure the parameters. They include:

• Auto-negotiate
• Duplex
• Dot1 Q Ethertype
• Q in Q Ethertype

8 Click on the 802.1x Port tab button, as required.

Configure the parameters. They include:

• Initialize 
• Reauthenticate Control

9 Click on the 802.1x Port Authenticator tab button, as required.
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Configure the parameters. They include:

• Controlled Port Control
• Quiet Period
• Tx Period
• Supplicant Timeout
• Server Timeout
• Max Req
• Reauth Period
• Reauth Enabled
• Radius Server Policy Name

10 Click on the other tab buttons in the properties form to view and edit additional port 
information.

Procedure 21-9  To configure SONET ports

Perform the steps in this procedure as required depending on the daughter card and port 
type that you are configuring. 

1 Right-click on the port object in the navigation tree and choose Properties from the 
contextual menu.

The properties form appears.

2 Configure port parameters as appropriate. Figure 21-3 shows the port configuration 
form for a SONET port with the General tab selected. 
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Figure 21-3  SONET port configuration form - General

3 Configure the parameters. They include:

• Description
• Speed

4 Click on the States tab button.

5 Configure the Administrative State parameter.

6 Click on the Channels tab button to configure the SONET/SDH channel.

a Click on the Add button to create a new channel.

b Choose a channel from the list and click on the Edit button to view and edit the 
channel parameters.

c Choose a channel from the list and click on the Remove button to remove a 
channel from the port.

7 Click on the SONET tab button.
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8 Configure the parameters. They include:

• Framing
• Clock Source
• Loopback
• Single Fiber
• Hold Time Down (100s of ms)
• Hold Time Up (100s of ms)

9 Click on the SONET Monitoring tab button.

10 Configure the parameters. They include:

• BER Signal Degradation Threshold
• BER Signal Failure Threshold
• Report Alarms

11 Click on the SONET Overhead tab button.

12 Configure the parameters. They include:

• Sonet Section Trace Mode
• J0 Byte

Enter a J0 byte that identifies the circuit. This byte is inserted continuously at 
source. This can be checked against the expected value by the receiver. If no 
byte is entered, then null is used.

• J0 String

13 Click on the other tab buttons in the properties form to view and edit additional port 
information.

Procedure 21-10  To configure TDM ports

Perform the steps in this procedure as required depending on the port type that you are 
configuring. 

1 Right-click on the port object in the navigation tree and choose Properties from the 
contextual menu.

The properties form appears. Figure 21-4 shows the port configuration form for a 
TDM port with the General tab selected.
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Figure 21-4  TDM port configuration form - General

2 Configure the General tab parameters. They include:

• Description
• Speed

3 Click on the States tab button.

4 Configure the Administrative State parameter.

5 Click on the DS3/E3 tab button.

6 Configure the Line Buildout parameter.

7 Click on the other tab buttons in the properties form to view and edit additional port 
information.

Procedure 21-11  To configure SONET clear channels

Perform this procedure to configure SONET clear channels on OC3 to OC192 ports that 
provide clear-channel services. Each port supports one clear channel. 

1 In the navigation tree, locate a daughter card with clear channel ports (any card that 
is not designated Deep Channelized) and view the available ports.
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2 Right-click on a clear channel port and choose Properties from the contextual menu.

The Physical Port Edit form appears with the General tab button selected as shown 
in Figure 21-5. SONET is the default framing scheme.

Figure 21-5  Editing port properties

3 Configure the parameters. They include:

• Description
• Speed

In this example, you can choose OC3 or OC12. 

4 Click on:

a The Apply button if you configured the parameters.

b The Cancel button if you did not configure the parameters.

5 In the Navigation tree, right-click on the port and choose Create Channel. The 
Create Channel form appears with the General tab button selected as shown in 
Figure 21-6. If there are no channels available on that port, the Create Channel 
menu option menu is dimmed.
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Figure 21-6  Create clear channel configuration form - General

The Local Channel ID is automatically configured to 1 for clear channel ports.

6 Configure the parameters. They include:

• Description
• Configured MAC
• Mode
• Encap Type 
• MTU (bytes)
• Load Balance Algorithm

The Encap Type field is dimmed when the type is set to ATM.

7 Click on the Apply button to save the changes. In the example in Figure 21-5, the 
port speed is configured to OC3, which results in the creation of an sts3 clear 
channel. The STSn clear channel appears in the navigation tree under the port of 
the daughter card. 

a If the Encap Type parameter of the port is ATM, the form is refreshed. 

b If the Encap Type parameter of the port is not ATM, go to step 12.

8 Click on the Edit ATM button to configure the ATM interface. The ATM interface form 
opens with the General tab selected.

9 Configure the parameters. They include:

• ATM Interface Cell Format

10 Click on:
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a The Apply button if you configured the parameters.

b The Cancel button if you did not configure the parameters.

11 Click on the Cancel button to close the ATM Interface form.

12 Click on the Cancel button to close the channel form.

Right-click on the channel and choose Properties from the contextual menu to view 
or edit the clear channel parameters.

Procedure 21-12  To configure SONET sub-channels

SONET sub-channels are available on deep channelized OC12 and OC3 ports. SONET 
STS1 channels support the following payload types:

• DS3
• VT1.5
• VT2

Perform this procedure to configure SONET STS-1 sub-channels on ports that provide 
channelized services. 

1 Right-click on the port and choose Create Channel. 

The Create Channel form appears with the General tab button selected as shown 
in Figure 21-7. If there are no channels available on that port, the Create Channel 
menu option menu is dimmed.

The Channel Type is set to Sonet Sts1 (Sdh Au3).
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Figure 21-7  Create SONET STS1 Channel form - General

2 Configure the Local Channel ID parameter by typing a value as follows:

• For an OC3 port, use a value from 1 to 3.
• For an OC12 port, use a value in the format <1 to 4>.<1 to 3>

When you enter a valid number, the color of the field changes from yellow to white.

3 Choose one of the following payload types and click on the Apply button to apply the 
changes on this form.

• Sonet Vt15 (Sdh Tu11).
• Sonet Vt2 (Sdh Tu12)
• Pdh Ds3
• Pdh E3 (for SDH framing only)

The STS1 (AU3) channel appears in the navigation tree under the port of the 
daughter card.

4 Create the STS1 (AU3) sub-channels according to the payload type configured:

a To create VT1.5 (Sdh TU11) sub-channels, go to Procedure 21-14.

b To create VT2 (Sdh TU12) sub-channels, go to Procedure 21-14.

c To create a DS3 or E3 (SDH framing only) clear channel, continue with step 5.
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5 To create a DS3 or E3 clear channel, compete these steps:

i From the navigation tree, select an STS1 or AU3 channel and choose Create 
Channel from the contextual menu.The Create DS3/E3 form opens. 

• For AU3 channels, DS3 and E3 channelization is available.
• For STS1 channels, only DS3 channelization is available, as shown in 

Figure in 21-8.

Figure 21-8  Configuring a DS3 clear channel

ii Configure the DS3 or E3 Channelization Type parameter:

• Choose None to create a DS3 or E3 clear channel. Configure the following 
parameters as required:

• Description

• Configured MAC
• Speed

• Encap Type

• MTU (bytes)

• Choose Ds1 to channelize the DS3 to carry up to 28 DS1 channelized to 
the DS0 level.

• Choose E1 to channelize the DS3 to carry up to 21 E1 channelized to the 
DS0 level.

iii Click on the Apply button to apply the change.
21-32 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



21 —  Equipment management using the navigation tree
If you chose channelization None, a DS3 clear channel in Access mode is 
created under the STS1 or the AU3 in the navigation tree.

If you chose channelization DS1, a DS3 channelized for DS1 is created under 
the STS1 (AU3). Go to step 7 in Procedure 21-15 to create the DS1 channels.

If you chose channelization E1, a DS3 channelized for E1 is created under the 
STS1 (AU3) in the navigation tree. Go to step 7 in Procedure 21-15 to create 
the E1 channels.

Procedure 21-13  To configure SDH sub-channels

SDH sub-channels are available on deep channelized OC12 and OC3 ports. SDH AU4 
channels support the following payload types:

• TU3
• TU11
• TU12

SDH AU3 channels support the following payload types:

• DS3
• E3
• TU11
• TU12

Perform this procedure to configure SDH sub-channels on ports that provide channelized 
services. You must first configure port framing to SDH since default framing on 
SONET/SDH ports is SONET. 

1 In the navigation tree, right-click on a deep channelized port and choose Properties 
from the contextual menu. The Physical Port form appears with the General tab 
selected.

2 Click on the SONET tab button and set the Framing parameter to SDH.

3 Click on the Apply button.

4 Right-click on the port again and choose Create Channel from the contextual menu. 

5 Choose one of the following Channel Types and click on the OK button:

a Sonet Sts1 (Sdh Au3).

SONET STS1 channelization and SDH AU3 channelization are equivalent. Go 
to step 2, Procedure 21-12.

b Sonet Sts3 (Sdh Stm1).

The Payload Type for SDH STM1 (AU4) is set to TUG3. There is no SONET 
framing equivalent. Continue with step 7.
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The SONET Channel (Create) form appears with the General tab button 
selected. If there are no channels available on that port, the Create Channel 
menu option menu is dimmed.

6 Configure the parameters. They include:

• Local Channel ID
• Descriptions

7 Click on the OK or Apply button. The STM1 (AU4) channel appears in the navigation 
tree under the port of the daughter card. It contains three TUG3 groups.

8 Right-click on a TUG3 group and choose Properties from the contextual menu. The 
Edit SDH Tug3 form opens as shown in Figure 21-9.

Figure 21-9  Configuring SDH TUG3 payload type

9 Choose one of the following TUG3 Payload Types and click on the Apply button:

a Pdh Tu3. Continue with step 10 to create a TU3 channel.

b Sonet Vt15 (Sdh Tu11). Go to Procedure 21-14.

c Sonet Vt2 (Sdh Tu12). Go to Procedure 21-14.

10 To create a TU channel, right-click on a TUG3 group and choose Create Channel 
from the contextual menu. The TU3 Channel (Create) form opens.
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11 Configure the parameters. They include:

• Description
• Configured MAC
• Encap Type
• Speed
• MTU (bytes)
• Load Balance Algorithm

12 Click on the Apply button to apply the change. A TU3 channel is created under the 
TUG3 in the navigation tree.

13 Right-click on the Tu3 and choose Create Channel from the contextual menu. The 
DS3/E3 Channel (Create) form opens with the General tab button displayed.

The E3 is the only payload type available.

14 Click on the Apply button to apply the change. An E3 clear channel is created under 
the AU4/TUG3 in the navigation tree.

Procedure 21-14  To create VT1.5 (TU11) or VT2 (TU12) sub-channels

A SONET VTG and an SDH TUG2 are equivalent groups. A VTG contains four VT1.5 
channels or three VT2. A TUG2 contains four TU11 channels or three TU12. An SDH 
TUG 3 has no SONET equivalent, however, it contains seven TUG2. (An STM1/AU4 
contains three TUG3). See “Comparison of SONET and SDH hierarchies” in 
section 20.10.

An STS1 channelized to carry a VT1.5 or VT2 payload type contains seven VTG. An AU3 
or a TUG3 channelized to carry a TU11 or TU12 payload type contain seven TUG2. STS1 
and AU3 channelization are shown in Figure 21-10.
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Figure 21-10  SONET VTG and SDH TUG2 in navigation tree

Each VTG (TUG2) supports up to four VT1.5 (TU11) channels or three VT2 (TU12) 
channels. Create each VTG/TUG2 channel one at time. 

1 Complete Procedure 21-12 or Procedure 21-13 to carry a VT1.5 (TU11) or VT2 
(TU12) payload types. 

a Go to step 2 to create a VT1.5 (TU11) channel.

b Go to step 3 to create a VT2 (TU12) channel.

2 To create a VT1.5 (TU11) channel, complete these steps:

i From the navigation tree, select a VTG or TUG2 channel to carry a VT1.5 
(TU11) payload and choose Create Channel from the contextual menu.The 
Create Sonet vt (Sdh Tu) form opens as shown in Figure 21-11.
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Figure 21-11  Configuring a VT1.5 (TU11) channel

ii Configure the parameters. They include:

• Local Channel ID
Set the Local Channel ID to a value in the range 1 to 4 since there are four 
VT1.5 (TU11) in a VTG (TU2).

• Description

The default payload type for a VT1.5 (TU11) channel is DS1. There is no other 
available payload type.

iii Click on the Apply button to apply the change. A VT15 channel is created under 
the VTG or a TU11 channel is created under the TUG2 in the navigation tree.

iv Right-click on a VT15 or TU11 channel and choose Create Channel from the 
contextual menu. The Create DS1/E1 form opens. 

The Local Channel ID is equal to the VT15 channel Local Channel ID 
parameter and the channelization type is set to DS1 since a VT1.5 or TU11 
channel supports one DS1.

v Click on the Apply button to apply the change. A DS1 channel is created under 
the VT15 or the TU11 in the navigation tree.

You can create up to 28 VT1.5 (TU11) channels on a VTG (TUG2). 

vi Repeat steps 1 and 2 for each VT1.5 (TU11) channel that you want to create.

vii Since a DS1 channel is not used as a service access point, create a DS0 group 
for each DS1 channel created. Go to step 8 of Procedure 21-15.
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3 To create a VT2/TU12 channel, complete these steps:

i From the navigation tree, select a VTG or TUG2 channel to carry a VT2 (TU12) 
payload and choose Create Channel from the contextual menu.The Create 
Sonet vt (Sdh Tu) form opens as shown in Figure 21-12. 

Figure 21-12  Configuring a VT2 (TU12) channel

ii Configure the parameters. They include:

• Local Channel ID
Set the Local Channel ID to a value in the range 1 to 3 since there are three 
VT2 (TU12) in a VTG (TUG2).

• Description
• Payload

E1 is not available for SONET framing

iii Click on the Apply button to apply the change. A VT2 channel is created under 
the VTG or a TU12 channel is created under the TUG2 in the navigation tree.

iv Right-click on the VT2 or TU12 channel and choose Create Channel from the 
contextual menu. The Create DS1/E1 form opens. 
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The Local Channel ID is equal to the VT2 channel Local Channel ID 
parameter, since a VT2 channel supports one E1 or DS1.

v Configure the parameters. They include:

• Administrative State
• Payload

For a channelized AU3 or STM1 (AU 4), an E1 or DS1 is supported on the 
VT2 (TU12). For a channelized STS1, only a DS1 payload type is 
supported for the VT2.

vi Click on the Apply button to apply the change. A DS1 channel is created under 
the VT2 in the navigation tree. An E1 or DS1 is created under the TU12. You 
can create up to 21 VT2 (TU12) channels on a VTG (TUG2).

vii Repeat steps 1 and 2 for each VT2 (TU12) that you want to create.

viii Since a DS1/E1 channel is not used as a service access point, create a DS0 
group for each DS1 or E1 channel created. Go to step 8 of Procedure 21-15.

Procedure 21-15  To create TDM channels

Perform this procedure to create DS3 channel and children objects from a channelized 
DS3 port. 

1 In the navigation tree, right-click on the port that you want to configure and choose 
Properties from the contextual menu.

The Physical Port Edit form appears with the General tab button selected.

2 Select the DS3/E3 tab and configure the following parameters: 

• Line Buildout
• Type. Choose DS3.

3 Click on the OK or Apply button.

4 Right-click on the port again and choose Create Channel from the contextual menu. 
The DS3/E3 Channel (Create) form appears. If there are no channels available on 
that port, the Create Channel menu option is dimmed.

5 To configure the DS3/E3 channel, complete these steps:

a Configure the Channelized parameter to DS1 or E1, if you want to channelize 
to the DS0 level.

b Configure the Channelized parameter to None if this is a clear channel 
application. 
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Configure the following parameters as required:

• Description
• Configured MAC
• Encap Type
• Speed
• MTU (bytes)
• Load Balance Algorithm

The Local Channel ID parameter is configured automatically and the mode is 
always Access for TDM.

6 Click on the Apply button to apply the change.

If this is a Channelized DS1 or E1 application, continue to step 7.

7 To create Ds1 or E1 channels, complete these steps:

i From the navigation tree, select a Ds3 channel and choose Create Channel 
from the contextual menu. The Create DS1/E1 Channel form opens. 

ii Configure the Local Channel ID parameter.

• For DS1 choose from 1 to 28.
• For E1 choose from 1 to 21.

iii Click on the Apply button to apply the change. The DS1 or E1 channels are 
created under the DS3 in the navigation tree. 

8 To create DS0 channel groups, complete these steps:

i From the navigation tree, select a DS1 or E1 channel and choose Create 
Channel from the contextual menu to create DS0 groups. 

ii Configure the parameters. They include: parameter.

• Local Channel ID
For a DS0 group from a DS1 choose from 1 to 24. For a DS0 group from 
an E1, choose from 2 to 32.

• Description
• Configured MAC
• Encap Type
• Speed
• MTU (bytes)
• Load Balance Algorithm

iii Click on the Apply button to apply the change. The DS0 group is created under 
the DS1 or E1 in the navigation tree.
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9 To select timeslots for DS0 channel groups, complete these steps:

i Right-click on a DS0 channel group in the navigation tree and choose 
properties from the contextual menu. The DS0 Channel Group (Edit) form 
opens.

ii Click on the Channel Group tab button to view the available timeslots as shown 
in the example in Figure 21-13 for an E1 channel.

Figure 21-13  Selecting timeslots for DS0 channel groups

iii Choose an available timeslot and click on the Apply button. The selected 
timeslot is assigned to the DS0 channel group in the navigation tree.

Procedure 21-16  To configure a PVC

PVCs are automatically created by the node when a new L3 interface over ATM is 
created on the 5620 SAM. 

1 Choose a SONET/SDH ATM clear channel in the navigation tree and choose 
Properties from the contextual menu. The property form for the channel opens with 
the General tab selected.

2 Click on the L3 Interfaces tab button.
Alcatel 5620 Service Aware Manager, Release 3.0 R1 21-41
October 2005 3HE00214 CA



21 —  Equipment management using the navigation tree
3 Choose the appropriate interface from the list and click on the Edit button. The L3 
Interface form appears. 

4 Click on the ATM tab button.

5 Configure the parameters. They include:

• AAL5 Encapsulation
• ATM OAM Alarm Cell Handling

6 Click on the Apply button to save the changes.

7 To view more information about the PVC:

i Click on the View PVC Connection button. The ATM PVC Connection form 
opens.

ii Click on the tab buttons to view information for the ATM PVC connection.

8 Click on the Cancel button to close the ATM PVC Connection form, the L3 Interface 
form, and the channel form.

Procedure 21-17  To create a multilink bundle

You can create multilink bundles to:

• bundle DS0 channel groups together to be used as a SAP
• provide a mechanism to distribute data across multiple links to achieve higher 

bandwidth

The following general rules apply to multilink bundles:

• up to 56 bundles can be created per MDA
• the DS0 channel groups must be on the same MDA
• up to 8 members can be added to a bundle
• the Encap Type parameter of a member cannot be set to FR
• once a DS0 channel group has been added to a bundle, it can no longer be used 

as a SAP
• if a DS0 channel is being used as a SAP, it cannot be added to a bundle

1 Right-click on the Bundles object in the navigation tree and choose Create Bundle 
from the contextual menu. The Create Multilink Bundle form opens.

2 Configure the parameters. They include:

• Bundle ID
• Auto-Assign ID
• Description

3 Click on the Next button. The Configure Bundle Parameters form opens.
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4 Configure the parameters. They include:

• Fragment Threshold (bytes)
• Short Sequence
• Yellow Diff Delay (milliseconds)
• Red Diff Delay (milliseconds)
• Red Diff Delay Action
• Bundle MRRU (bytes)
• Minimum Links
• Link Fragmentation and Interleaving

5 Click on the Next button. The Configure Bundle Members form opens.

6 Click on the Add button to add DS0 channel groups to the bundle. 

The Add Bundle Member series of configuration steps appears.

7 Configure the Show Only Compatible Channels parameter.

8 Click on the Next button.

The Select Channels form opens.

9 Select compatible channels from the list to construct the bundle.

Add channels to a bundle as follows:

• Choose up to eight channel groups from the list of channels.

10 Click on the Finish button.

The Configure Bundle Members form closes and the Create Multilink Bundle form 
re-opens.

11 Click on the Finish button to save the configuration.

Note 1 — If there are no compatible channels to choose from and you 
have decided that you want to edit some of the existing channels that are 
not compatible to be compatible, click on the Back button and disable the 
Show Only Compatible Channels parameter. Click on the Next button. 
Choose channels to edit from the list and click on the Edit button.

Note 2 — The channel group with the lowest Port ID is chosen as the 
primary member for the bundle. The Encap Type of the primary member 
is used for all other members. When adding members to a bundle at a 
later time, the Encap Type must be the same as the primary member in 
order to be selectable as a compatible member.
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12 Use the Properties contextual menu to view information about the created bundle, 
or modify bundle parameters.

• The General tab displays the Bundle ID, CLI name, MTU (bytes), Mode, and the 
Encap Type.

• The MultiLink Bundle tab displays the bundle type, bundle parameters, and link 
information.

• The L2 Interfaces and L3 Interfaces tab lists the interfaces that the bundle is 
assigned to.

• The States tab displays information about the operational and administrative 
state of the bundle.

• The Bundle Members tab lists the bundle members. From this form you can view 
member information and add or remove members from the bundle.

• Statistics and fault information is available from the available tabs.

Procedure 21-18  To configure properties of TDM channels

Perform this procedure to edit properties of a DS3 channel and children objects from a 
channelized DS3 port.

1 Choose a DS3 channel in the navigation tree and choose Properties from the 
contextual menu. The property form for the channel opens with the General tab 
button selected.

2 Configure the following parameters:

• Description
• Channelized

3 Click on the States tab button.

4 Configure the Administrative State parameter.

5 Click on the SubChannels tab to configure the DS1 and DS0 channels.

6 Click on the Channel tab button.
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7 Configure the parameters. They include:

• Channel Framing
• CRC Precision
• Clock Source
• Idle Cycle Flags
• Loopback
• Subrate CSU Mode
• Subrate Range
• Loop Respond
• Report Alarms
• Bit Error Insertion Rate (E3 only)
• Pattern (E3 only)
• Duration (seconds) E3 only

8 Click on the Message Data Link tab button.

9 Configure the parameters. They include:

The MDL Message Type parameter specifies the Line Message Data Link message 
for a DS3 and specifies the transmission method of a message over a channelized 
interface. The parameter is only applicable if the DS3 is using C-bit framing. The 
default is disabled. Click on the check boxes to enable transmission methods and 
enter text strings to choose the message options for this parameter as required. The 
transmission options are:

• Test Signal
• DS3 Path
• Idle Signal

Table 21-3 describes the MDL message options.

Table 21-3 MDL message options

10 Click on the Terminations tab button to view channel termination information.

11 Click on the Cisco HDLC tab button if you set the Encap Type parameter to Cisco 
HDLC.

Option String Length Description

Port Number String 0 to 38 characters specifies the port ID code 

Generator Number String 0 to 38 characters specifies the generator number to send in the 
MDL test signal message 

Equipment ID Code 0 to 10 characters specifies the Equipment ID code 

Location ID Code 0 to 11 characters specifies the Location ID code 

Frame ID Code 0 to 10 characters specifies the Frame ID code

Unit ID Code 0 to 6 characters specifies the unit ID code 

Facility ID Code 0 to 38 characters specifies the facility ID code
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12 Configure the parameters. They include:

• Keep Alive (seconds)
• Up Count
• Down Count

13 Click on the Statistics tab button to view statistical information.

14 Click on the Faults tab button to view information about alarms.

15 Click on the Apply button to save the changes.

16 Click on the OK button to close the form.

17 Choose a DS1 channel in the navigation tree and choose Properties from the 
contextual menu.

The property form for the channel opens with the General tab button selected.

18 Click on the States tab button.

19 Configure the Administrative State parameter.

20 Click on the SubChannels tab to configure the DS0 parameters.

21 Click on the Channel tab button.

22 Configure the parameters. They include:

• Channel Framing
• Clock Source
• Idle Cycle Flags
• Loopback
• Bit Error Insertion Rate (E3 only)
• Pattern (E3 only)
• Duration (seconds) E3 only

23 Click on the Statistics tab button to view statistical information.

24 Click on the Faults tab button to view information about alarms.

25 Click on the Apply button to save the changes.

26 Click on the OK button to close the form.

27 Choose a DS0 channel in the navigation tree and choose Properties from the 
contextual menu.

The property form for the channel opens with the General tab button selected.
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28 Configure the parameters. They include:

• Description
• Configured MAC
• Encap Type
• Speed
• MTU (bytes)
• Load Balance Algorithm

29 Click on the States tab button.

30 Configure the Administrative State parameter.

31 Click on the Channel Group tab button.

32 Configure the following parameters:

• CRC Precision
• Time Slots

You can configure the PPP for the timeslot from the Channel Groups tab button.

i Choose one or more timeslots. You can use the Select All and Deselect All 
buttons.

ii Click on the Edit PPP button.

The PPP Interface form appears with the General tab button selected.

iii Configure the following parameters:

• Period
• Drop Count

iv Click on the PPP Control Protocol tab button.

v Select a protocol from the list, for example, Bridge, Link, or MPLS

vi Click on the Faults tab to view alarm information.

vii Click on the Statistics tab to view statistics.

viii Click on the OK button to save the changes.

ix Confirm the action.

The PPP Interface form closes and the DS0 Channel Group form reappears in 
the foreground.

33 Click on the Statistics tab button to view statistical information.

34 Click on the Faults tab button to view information about alarms.

35 Click on the OK button to save the changes and close the form.
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36 Confirm the action.

Procedure 21-19  To make a selected object the root of the 
navigation tree

Use the Make Root option of the contextual menu to make a selected object the root of 
the navigation tree. The Make Root option is only available in the equipment view. See 
section 21.1 for information about the navigation tree objects that support the menu 
option.

The Make Root option of the contextual menu is not available for an object that is 
positioned one object level below the root of the tree. For example, in a navigation tree 
where the device is the root of the tree, the LAG object and the shelf object do not support 
the Make Root option.

Right-click on the navigation tree object that you want to make the root of the tree and 
choose Make Root from the contextual menu. The navigation tree is refreshed with the 
selected object as the root of the tree. The Make Root At Top Level button is enabled.

See Procedure 21-21 for information about restoring the default root of the navigation 
tree.

Procedure 21-20  To make a selected object the root of another 
navigation tree

Use the Make Root In New Tree option of the contextual menu to make a selected object 
the root of another navigation tree.

The Make Root In New Tree menu option is only available in the equipment view. The 
Make Root In New Tree option is not available in the contextual menu for the root object 
of a tree. See section 21.1 for information about the navigation tree objects that support 
the menu option.

Right-click on the navigation tree object that you want to make the root of another 
navigation tree and choose Make Root In New Tree from the contextual menu. Another 
navigation tree window appears with the selected object as the root of the tree.

Procedure 21-21  To restore the default navigation tree root

The default root of the navigation tree is the network object. When the root is not the 
network object, the Make Root At Top Level button is enabled.

Note —   Up to five navigation tree windows can be open at one time and 
each tree must have a different root when it is first created.
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Click on the Make Root At Top Level button in the navigation tree toolbar to restore the 
default root of the tree. See chapter 3 for more information about the Make Root At Top 
Level button.
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22.1 Equipment manager overview

The 5620 SAM equipment manager allows network administrators and operators to 
do the following:

• filter different views and information for the managed devices using the 
equipment manager filter

• view and use a graphical representation of the shelf to configure equipment 
objects and get statistical information about the nodes in their administrative 
domain 

• view the services that traverse or terminate on equipment
• provision and pre-provision equipment to prepare the equipment for the creation 

of subscriber services
• view, configure, monitor the state of, and manage the following physical 

elements of the hardware:
• a managed device
• each device has one shelf, which is the physical shelf
• up to 12 card slots where cards are inserted into the device
• card slots contain cards
• cards contain up to two daughter card slots, also known as I/O modules
• each daughter card slot contains a daughter card
• daughter cards contain ports
• ports contain channels
• up to 64 LAGs per managed device, a logical object which joins multiple Ethernet 

ports into a single port to aggregate bandwidth
• up to 8 CCAGs per managed device
• internal and external storage devices (flash memory)

• configure network and access policies for network objects, such as ingress buffer 
policies for a port

• view and manage APS groups
• manage hardware fault conditions

Equipment Manager form

The equipment manager provides a tab for each equipment component. Choose 
Application→Equipment Manager from the 5620 SAM main menu to display the 
equipment component tabs.

Figure 22-1 shows an example of the Equipment Manager form displayed with the 
Card Slots tab button selected. The parameters displayed on each form are specific 
to the service that you are configuring. There are configurable and read-only 
parameters displayed from each tab. The read-only parameters are inherited from 
other configurations through device discovery.

Note —  You can access the same tabs by right-clicking on the shelf 
in the equipment navigation tree and selecting the Equipment 
Manager option in the contextual menu.
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Figure 22-1  Equipment Manager form - Card Slots

Display tab

The Display tab displays a graphical representation of the device’s shelf and its 
equipment components, such as the empty card slots and the cards that are installed 
on the device. You can double-click on an object under this tab to open its Properties 
configuration form. Right-click on the object and you have full access to the 
contextual menus for the object and any child objects, for example the ports of a card.

Shelf tab

The Shelf tab displays general information about the managed physical equipment.

The 7750 SR configurations that are managed include the following shelf types:

• 1-slot with 1 I/O slot that supports 2 cards
• 7-slots with 5 I/O slots that support 10 cards. The slots are numbered from top to 

bottom
• 12-slots with 10 I/O slots that support 20 cards. The slots are numbered from left 

to right.

The 7450 ESS configurations that are managed include the following shelf types:

• 1-slot with 1 I/O slot that supports 2 cards
• 7-slots with 6 I/O slots that support 12 cards. The slots are numbered from top to 

bottom.

Note —  When you display a Telco device, the BiNOS element 
manager is launched. See the appropriate BiNOS user guide for the 
Telco device for more information.
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The Shelf tab displays shelf information and chassis environment data, including the 
temperature, fans, power supplies, LEDs, storage, and fault information.

• The Fan Trays tab displays details about each fan tray. Double-click on a row in 
the fan tray list to view additional information, such as operational state and 
speed.

• The Power Supply Trays tab displays details about the router power supply, 
including voltage and temperature.

• The LED Panel tab displays the status of LEDs on the device, including the 
number of critical, major, and minor LEDs currently showing on the device.

• The Flash Memory tab displays details about the flash memory installed on the 
device. Double-click on a row representing the flash memory to view additional 
details, including the serial number, firmware revision, capacity, and percentage 
of flash memory used.

• The Card Slots tab displays all the cards in all the slots.
• The Hardware Environment tab displays the current and threshold temperature 

settings of the configured cards.
• The Statistics tab displays CPU and memory statistics.
• The Faults tab lists all alarms raised against objects in the shelf.

Card Slots tab

The Card Slots tab displays the cards that are installed on or provisioned for the node, 
the supported card type for each slot, and fault information. To pre-provision a slot, 
the allowed card types, and the line card must be specified.

• The Inventory tab displays cards configured in the slots.
• The Supported Card Types tab indicates the types of cards that can be configured 

for the slots.
• The Faults tab lists alarms raised against card slots.

Cards tab

The Cards tab has several tabs to display the line or system daughter cards, also 
called IOM cards, that are installed on, pre-provisioned, or provisioned for the node. 

• The Inventory tab displays the card type, serial number, revision number, and 
equipment state.

• The Processors tab displays information about the two processors Control cards, 
also called the CPM or switch fabric cards. Double-click on the A or B slot 
Control card for information about the control processors and switch fabric 
processors.

• The Software tab displays the card version, boot code information, and state.
• The Environment tab displays card environment information, for example, 

temperature thresholds.
• The Faults tab displays alarm information for card and card child objects, such as 

ports.
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Daughter Card Slots tab

The Daughter Card Slots tab displays the daughter cards that are provisioned for the 
node, the supported daughter card types, and fault information. To pre-provision a 
daughter card slot, the slot, and daughter card types must be specified before the 
daughter card is configured.

Choose a specific daughter card type for the slot. The daughter card can be 
pre-provisioned but a daughter card must be provisioned before ports can be 
configured. Ports can be configured when the daughter card is properly provisioned.

Up to two daughter cards can be provisioned on an IOM. Only one daughter card can 
be provisioned per IOM daughter card slot. To modify a daughter card slot, shut 
down all port associations.

The additional daughter card slots tabs include:

• The Inventory tab lists the daughter card slots and the daughter cards configured 
for the slots.

• The Supported Daughter Card Types tab lists the types of cards allowed and 
supported in each daughter card slot.

• The Faults tab displays alarm information for daughter card slots and daughter 
card slot children objects, such as ports.

Daughter Cards tab

The Daughter Cards tab displays daughter card information, including the daughter 
card slot ID, daughter card types, serial numbers, manufacture date, hardware 
revision, administrative and operational states, network ingress buffer policy ID, and 
fault information.

The additional daughter card tabs include:

• The Inventory tab lists the daughter cards configured for the slots. Double-click 
on a row representing the daughter card to view the properties form for the card, 
including ports configured on the daughter card

• The Environment tab lists temperature details for each daughter card.
• The Faults tab displays alarm information for daughter cards and daughter card 

children objects, such as ports.

Ports tab

The Ports tab displays information about physical ports, SONET or SDH channels, 
TDM channels, link aggregation groups, protocols, terminations, APS groups, and 
faults. Double-click on a row to open the properties form for the port.

Figure 22-2 shows an example of a port configuration form with the General tab 
selected.
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Figure 22-2  Example of a port configuration form - General
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For each network and access port, you can view and configure parameters using the 
tab buttons. See chapter 21 for more information about configuring properties.

• The Physical Ports tab lists all ports on the configured daughter card. 
Double-click on a row to open the properties form for the physical port.

• The SONET Channels tab lists all channels on the configured daughter card ports. 
Double-click on a row to open the properties form for the channel.

• The Link Aggregation Group tab lists all LAGs on the configured daughter card 
ports. Double-click on a row to open the properties form for the LAG.

• The Protocols tab lists the ID and the running protocols, for example, IPv4 or 
MPLS, on the configured daughter card ports.

• The Terminations tab lists the number of connections on each endpoint, the 
encapsulation type of the endpoint, and bandwidth usage information.

• The TDM Channels tab lists all channels on the configured daughter card port. 
Double-click on a row to open the properties form for the channel.

• The Multilink Bundles tab lists all multilink bundles on the configured daughter 
cards. Double-click on a row to open the properties form for the multilink bundle.

• The Aps Groups tab lists all the APS groups to which the ports belong.
• The Statistics tab lists interface, SONET or SDH, TDM, multilink bundle, and 

LAG statistics for the ports.
• The Faults tab lists the alarms raised against the port.

Interfaces tab

The Interfaces tab displays the interfaces that are configured for the port, including 
the device interfaces and the IP addresses. You can select the interface and click Edit 
to reconfigure the interface.

The interfaces tabs include:

• The Network Interfaces tab lists the ports configured for network access.
• The L2 Interfaces tab lists the ports and channels configured as Layer 2 

interfaces, and the services using those Layer 2 interfaces.
• The L3 Interfaces tab lists the ports and channels configured as Layer 3 

interfaces, and the services using those Layer 3 interfaces.
• The Address tab lists routing instance information for Layer 3 interfaces and 

other network interfaces, including the system IP address.

Faults tab

The Faults tab displays the following alarm information for the device:

• Object alarms, containing details of the alarm as viewed from the dynamic alarm 
list.

• Affecting alarms, containing details of the alarms on objects that are directly 
affecting this object.

• Aggregated alarms, containing details of all alarms for objects below the listed 
object in the containment hierarchy.

• Related alarms, containing details of all alarms that have an indirect relationship 
with the object.
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22.2 Workflow to manage equipment using the equipment 
manager

1 Ensure the routers are configured before they are discovered by the 5620 SAM.

2 Access the equipment and begin configuration and management.

i Choose Application→Equipment Manager from the 5620 SAM main menu.

ii Use the equipment manager to edit or view objects and configuration 
parameters.

iii Edit the properties of objects as required in equipment manager.

22.3 Equipment manager menu

Table 22-1 lists the menu item to use the equipment manager.

Table 22-1 5620 SAM equipment manager menu

22.4 Equipment manager procedures list

Table 22-2 lists the procedures to configure equipment using the equipment 
manager.

Table 22-2 5620 SAM equipment manager procedures list

22.5 Equipment manager procedures

Use the following procedures to manage equipment using the equipment manager.

Menu option Task

Application→Equipment Manager Open the Equipment Manager form to view and 
edit existing objects.

Procedure Purpose

To use the equipment manager filter To narrow the range of devices that you can view 
using the equipment manager.

To change the configuration of devices using the 
equipment manager

To configure an object using the equipment 
manager.
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Procedure 22-1  To use the equipment manager filter

The Equipment Manager Filter form filters the display of the Equipment Manager form 
based on device properties. You can use the Equipment Manager Filter form to quickly 
see a snapshot of various selected parameters, or click on the OK button of the Simple 
filter to view or edit all the forms and configured parameters in the equipment manager 
for the managed device.

1 Choose Application→Equipment Manager from the 5620 SAM main menu.

The Equipment Manager Filter and Equipment Manager Filter forms are displayed.

2 You can close the filter form or create a filter.

a Click on the OK button to close the filter form and access the Equipment 
Manager form.

The Equipment Manager Filter form closes and the Equipment Manager form 
is brought to the foreground.

b Set the Select Filter Type to Simple to perform a simple search of parameters 
for a snapshot of the state of the specified parameter.

i Choose a parameter in the Unused Properties box.

ii Click on the right-facing arrow.

The parameter moves to the Filtered Properties box.

iii Click on the OK button.

The Equipment Manager Filter form closes and the Equipment Manager 
form is brought to the foreground.

3 Select a managed device using the Network Element parameter.

Procedure 22-2  To change the configuration of devices using the 
equipment manager

An object must be created before it can be configured. A created object is seen in the 
navigation tree. See chapter 21 for more information about using the navigation tree.

1 Right-click on a discovered device in the navigation tree and choose Equipment 
Manager from the contextual menu.

The Equipment Manager Filter and Equipment Manager Filter forms are displayed.

2 Select the filter type and filtered properties, as described in Procedure 22-1.

Note —  When you display a Telco device, the BiNOS element manager 
is launched. See the appropriate BiNOS user guide for the Telco device 
for more information.
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3 Click on the OK button.

The 5620 SAM displays a graphical representation of the shelf under the Display 
tab.

4 Choose tabs to configure the equipment parameters in the sequence displayed.

a Double-click on any of the slots displayed under the Display tab to open the 
Properties form for the slot and create or edit the parameters of an object in the 
shelf.

b Select a parameter in any of the form lists and click on the Edit button to 
configure the parameter.

c Double-click on any object in any form to show the object Properties form.

5 Save the configuration changes, as required.
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23.1 Router configuration overview

The 5620 SAM allows you to view routing and router parameters and configure 
network interface parameters. You can use the network view in the 5620 SAM GUI 
navigation tree to view and configure parameters that set and manage the IP routing 
functionality of the managed devices.

Figure 23-1 shows the routing objects in the network view of the navigation tree.

Figure 23-1  Routing objects

Layer 3 interfaces, sometimes referred to as network interfaces, are logical IP objects 
defined on physical port, such as an Ethernet port. A Layer 3 interface:

• has an IP address and subnet mask
• is configured with QoS policy settings
• associates its IP address with a physical port or channel
• has its physical port or channel cabled to another device
• has enabled routing protocols 

The physical connection of one device to another device is through its port or 
channel. However, the Layer 3 interface determines its IP connectivity. The Layer 3 
interface passes both routing information using a routing protocol, such as OSPF, 
and passes IP traffic.
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The system interface is associated with a network entity, such as a specific device, 
not a specific interface. The system interface is also referred to as the loopback 
interface. The system interface is associated during the configuration of the 
following entities:

• the termination point of service tunnels
• the hops when configuring MPLS paths and LSPs
• the addresses on a target device for BGP and LDP peering

The system interface is used to preserve connectivity when an interface fails or is 
removed. A system interface must have an IP address with a 32-bit subnet mask. The 
system interface is used as the device identifier by higher-level protocols such as 
OSPF and BGP. See chapter 24 for more information about routing protocols.

When configuring devices, you configure the routing protocols used and the 
topology of how packets are handled between different devices in the network.

Networks can be grouped into areas. An area is a collection of network segments 
within an AS that have been administratively assigned to the same group. Area 
topology is concealed from the rest of the AS. This means a significant reduction in 
routing traffic. Routing in the AS takes place on two levels, depending on whether 
the source and destination of a packet reside in:

• the same area, known as intra-area routing
• different areas, knows as inter-area routing

In intra-area routing, the packet is routed based on information found within the area; 
no routing information from outside the area is used. This protects intra-area routing 
from the injection of bad routing information. Two devices, which are not area 
border routers, and belonging to the same area, have identical topological databases.

Devices that are aware of more than one area are called area border routers. In this 
case, all devices in an AS do not have an identical topological database. An area 
border router has a separate topological database for each area it is connected to. ASs 
share routing information, such as routes to each destination and information about 
the route or AS path, with other ASs using BGP.

Routing tables contain lists of next hops, reachable addresses, and associated path 
cost metrics to each device. Routing protocols uses the information and path 
parameters to compile a network topology. The information about routes that is used 
to update routing tables can be modified using routing policies.

Routing policies

Routing policies, also known as route redistribution policies, control the size and 
content of the routing tables, the routes that are advertised, and the best route to take 
to reach a destination.

There are no default routing policies. Each policy must be created and applied to an 
object, a routing protocol, or the forwarding table. Each set of rules that is associated 
with controlling routes are called routing policy statement entries on the client GUI.
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Use routing policies:

• to control routing protocols, such as BGP, to allow routes from another protocol, 
such as OSPF, into the routing table, which allows the routing table to redistribute 
packets into other protocols

• to control the import and export of learned active routes of a protocol
• to modify the characteristics of a route, for example, to change the community 

values of BGP AS path attributes
• prevent the routes for particular subscribers from being added to routing tables
• to control BGP route flapping

Routing policy statements and routing policy statement entries are compared against 
incoming route packets in the following sequence.

1 The route packets arrive.

2 The first routing policy is analyzed.

3 Each entry in the routing policy statement is analyzed.

If a match is found based on the first routing policy statement entry, the specified 
action is performed. You can use the Action parameter to specify the continued 
evaluation of route policy entries, or additional policy statements.

4 If no match is found, the packet is compared against the second routing policy 
statement entry. If a match is found based on the second routing policy statement 
entry, the specified action is performed.

5 If no match is found, the packet is compared sequentially against all remaining 
routing policy statements and routing policy statement entries. If a match is 
found, the specified action is performed.

6 If the packet does not match any routing policy statements or entries, the default 
action is performed.

Figure 23-2 shows how routes are analyzed using routing policies.
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Figure 23-2  Routing policy analysis workflow
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Careful planning is essential to implement route policies that can affect the flow of 
routing information or packets traversing managed devices. Before configuring and 
applying a route policy, consider the following:

• Develop an overall plan and strategy to accomplish your intended routing actions
• Analyze the effect of what happens to a packet that meets the specified criteria in 

a routing policy statement entry to ensure the proper action is executed and that 
no routing loops are created

• when possible, redistribute from a less router protocol to a greater routing 
protocol, for example from RIP to OSPF

• redistribute exported routes at a single device, when possible

When no action or default action in a routing policy is matched on a packet, then the 
routing protocols determine the default action for the packet. The action can be 
specified for the protocol. If the action is not specified, there is default routing 
protocol import and export actions performed, as described in Table 23-1.

Table 23-1 Default routing protocol actions

For importing routing, RIP and BGP learned routes can be altered using routing 
protocols. For example, for devices learning about routes from BGP, you can create 
an import route policy that can limit the number and types of routes accepted and 
added to the routing tables.

For exporting routes, some default behaviors exist:

• internally learned routes are redistributed using the same protocol
• externally learned routes are not automatically advertised to all neighbors or peers

In the case of externally learned routes, you can create an export policy to determine 
how the routes are advertised, for example, configuring something learned by BGP 
to be redistributed using OSPF. This is useful in cases:

• where legacy equipment does not support a particular protocol
• when companies merge and they use different routing protocols on the devices

Protocol Default import route action Default export route options

BGP All routes from BGP peers are accepted and 
forwarded to the BGP route selection process

All active internal BGP routes are advertised to 
BGP peers.

All non-BGP learned routes are not advertised 
to BGP peers.

ISIS ISIS route acceptance cannot be configured. All 
ISIS routes are accepted from ISIS neighbors.

All internal ISIS routes are advertised to all ISIS 
neighbors.

All non-ISIS learned routes are not advertised to 
ISIS neighbors.

OSPF OSPF route acceptance cannot be configured. 
All OSPF routes are accepted from OSPF 
neighbors.

All OSPF routes are advertised to all OSPF 
neighbors.

All non-OSPF learned routes are not advertised 
to OSPF neighbors.

RIP All RIP-learned routes are accepted from RIP 
peers.

All non-RIP learned routes are not advertised to 
RIP peers.
23-6 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



23 —  Router configuration
23.2 Workflow to configure routers

1 Use the CLI to configure or verify these parameters:

• system address (system ID)
• router ID

See the 7750 SR OS Router Guide for more information about the parameters to 
configure.

2 Configure L3 interfaces. The L3 interfaces will be associated with network ports. 
There are network and system interfaces.

• assign names
• associate IP addresses
• specify the interface as a network or system interface
• associate a network port with the Layer 3 interface
• configure appropriate routing protocols

Enable BGP, MPLS, RIP, LDP, OSPF, IS-IS, and RSVP on the interfaces as 
required.
See chapter 24 for more information about routing protocol configuration and 
parameters.

3 Cable the network ports on the devices to the network ports on other devices.

4 Configure these key device parameters using the 5620 SAM:

• Enable BGP, MPLS, RIP, LDP, OSPF, IS-IS, and RSVP routing protocols on the 
device, as required. If you plan to create signaled LSPs, then you must enable 
MPLS, and RSVP or LDP.

• IP address ranges for use by services, such as IES and VPLS.
Reserve IP addresses to provide a mechanism to reserve one or more address 
ranges for services. When services are defined, the address must be in the 
range specified as a service prefix. Addresses in the range of a service prefix 
can be allocated to a network port unless set to exclusive. Then, the address 
range is exclusively reserved for services.

• device-wide AS settings

5 Use the 5620 SAM to create static routes as required.

6 Use the 5620 SAM to configure a routing policy.

i Configure AS path expressions, as required.

ii Configure community lists, as required.

iii Configure damping parameters to control BGP route flapping, as required.

iv Configure prefix lists, as required.

7 Configure an AS and confederations for BGP (optional).
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Configuring confederations is optional and should only be implemented to reduce 
the IBGP mesh inside an AS. An AS can be logically divided into smaller groupings 
called sub-confederations. See chapter 24 for more information about BGP 
configuration.

8 Use the 5620 SAM to create MPLS administrative groups and assign the groups to 
MPLS interfaces and LSPs paths as required.

23.3 Router configuration menus

To configure managed equipment to perform routing, choose Network from the 
navigation tree view selector.

23.4 Router configuration procedures list

Table 23-2 lists the procedures necessary for routing configuration.

Table 23-2 5620 SAM routing configuration procedures list

23.5 Router configuration procedures

The following procedures describe how to configure routing.

Procedure 23-1  To configure routing instance parameters

1 Choose Network from the navigation tree view selector.

Procedure Purpose

To configure routing instance parameters To configure the routing instance parameters

To configure a Layer 3 interface To configure the following interfaces:

• network interface
• system interface
• interface ICMP
• management interface

To modify a Layer 3 interface To modify created interfaces

To configure an AS and confederations (optional) See the BGP information contained in 
chapter 24.

To configure a routing policy To control the size and content of the routing 
tables, the routes that are advertised, and the 
best route to a destination

To configure an MPLS administrative group 
policy

To configure MPLS administrative groups that 
can be assigned to MPLS interfaces, LSPs, and 
LSP paths.

To configure a static route To create static route entries for the network and 
access routes
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2 Navigate to a routing instance.

The navigation path is Network→Router→Routing Instance.

3 Right-click on the routing instance icon and choose Properties from the contextual 
menu. 

The 5620 SAM displays the Routing Instance form. Figure 23-3 shows the Routing 
Instance form with the Protocols tab button selected.

Figure 23-3  Routing Instance form - Protocols

4 Click on the General tab button.

5 Configure the Administrative State parameter.

6 Click on the Protocols tab button.

7 Configure the parameters. They include:

• BGP Enabled
• MPLS Enabled
• RIP Enabled
• IS-IS Enabled
• LDP Enabled
• OSPF Enabled
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The supported protocols are displayed in the navigation tree as sub-items in the 
routing instance. Click on the Edit button to configure the routing protocols. See 
chapter 24 for more information about routing protocol configuration using the GUI.

8 Click on the Multicast tab button.

9 Configure the parameters. They include:

• PIM Enabled
• IGMP Enabled

The supported multicast protocols are displayed in the navigation tree as sub-items 
in the routing instance. Click on the Edit button to configure the routing protocols. 
See chapter 24 for more information about multicast protocol configuration using the 
GUI.

10 Click on the Routing tab button.

11 Configure the parameters to specify AS and confederation parameters and to 
enable the re-evaluation of route policies. See chapter 24 for more information 
about AS and confederation parameters for BGP using the GUI.

12 Click on the Interfaces tab button. See Procedure 23-2 for more information about 
creating additional Layer 3 interfaces.

13 Click on the Address tab button.

14 Configure IP address parameters for Layer 3 interfaces.

i Choose an address in the list.

ii Click on the Edit button.

The IP address information form appears.

iii Configure the parameters. They include:

• IP Address
• Subnet Mask
• Broadcast Address Format
• IGP Inhibit

15 Click on the Static Routes tab button to view a list of static routes and to add static 
routes. See Procedure 23-6 for more information.

16 Click on the BGP Confederations tab button, if present, to view and create BGP 
confederations. See chapter 24 for more information about BGP confederation 
configuration.

17 Click on the Service Address Ranges tab button to provide a mechanism to reserve 
one or more IP address ranges for use by services, such as IES.

Note —  The IP Address, Subnet Mask, nor Broadcast Address Format 
can be changed for the System interface.
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18 Click on the following tab buttons to view information.

• Statistics
• Faults to view alarm information

19 Click on the Apply button to save the changes.

20 Verify the action.

21 Close the form.

Procedure 23-2  To configure a Layer 3 interface

This procedure describes how to configure Layer 3 interface parameters. The interfaces 
you configure include:

• Layer 3 interface
• ICMP interface
• system interface
• management interface

See the 7750 SR OS Router Guide for more information about using CLI to configure 
interfaces.

1 Choose Network from the navigation tree view selector.

2 Navigate to a routing instance.

The navigation path is Network→Router→Routing Instance.

3 Create a new Layer 3 interface by right-clicking on the routing instance icon and 
choose Create Interface from the right-click contextual menu.

The Create Network Interface form opens with the Define General Properties form, 
as shown in Figure 23-4.
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Figure 23-4  Create Network Interface - Routing Instance form - Define General Properties step

4 Configure the parameters. They include:

• Interface ID
• Auto-Assign ID
• Name
• Description
• Administrative State
• MAC Address
• Allow Directed Broadcasts
• Class

A numbered interface means the Layer 3 interface has its own IP address. 
Unnumbered means the router ID is advertised.

• Trusted
• Loopback Enabled
• Cflowd Type

5 Click on the Next button. The Configure IP Address form opens.
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Specify the IP address information for the Layer 3 interface:

i Click on the Add button. The IP Address, Routing Instance form appears.

ii Configure the parameters. They include:

• IP Address
• Subnet Mask
• Broadcast Address Format
• Primary
• IGP Inhibit

iii Click on the OK button to save the changes. The IP Address, Routing Instance 
form closes and the Configure IP Address for re-opens.

6 Click on the Next button. The Select Port form opens.

Associate the Layer 3 interface with a physical port.

i Click on the Select button. The Select Port form opens.

ii Choose a port from the list.

iii Click on the OK button. The port is associated with the Layer 3 interface. 

7 Click on the Next button. The Select Network Policy form opens.

Network policies are used to determine QoS settings based on the packet DSCP 
bits on the ingress and egress of the network. Click on the Select button to list and 
choose a network policy for the interface.

8 Click on the Next button. The Select ACL Filters form opens.

ACL filters are used to filter out IP traffic that matches user-defined criteria. Click on 
the Select buttons to list and choose an Ingress and Egress ACL for the interface.

9 Click on the Next button. The Configure ICMP form opens.

ICMP settings specify how ping commands work.

Configure the parameters. They include:

Note —  If the Loopback Enabled parameter is selected on the Define 
General Properties form, Select Port does not appear in the step menu 
for the 7750 SR. 

• Mask Reply
• Redirects
• Number of Redirects
• Redirects Time (seconds)
• Unreachables

• Number of Unreachables
• Unreachables Time (seconds)
• TTL Expired
• Number of TTL Expired
• TTL Expired Time (seconds)
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10 Click on the Next button. The Configure ARP form opens.

i Configure the Timeout parameter.

ii Click on the Add button to statically associate an IP or MAC address to the 
interface. The StaticArp, Routing Instance form opens.

Configure the parameters. They include:

• IP Address
• Physical Address

iii Click on the OK button. The Configure ARP form closes and the Configure 
ARP form re-opens.

iv You can add, edit, or remove sites as required using the buttons on the form.

11 Click on the Next button. The Configure Proxy ARP form opens.

Proxy ARP allows a device, such as a router, to answer ARP requests that are 
intended for another device. This allows a device to reach a remote subnet without 
configuring routes to the subnet or a default gateway device.

12 Configure the parameters. They include:

• Enable Proxy ARP
When you set the Enable Proxy ARP parameter to true, you can configure the 
Configure Proxy ARP Policies form, as described in step 13.

• Enable Local Proxy ARP

13 Click on the Next button. The Configure Proxy ARP Policies form opens if you 
configured the Enable Proxy ARP parameter to true in step 12.

14 Configure the parameters. They include:

• Proxy Arp Policy 1
• Proxy Arp Policy 2
• Proxy Arp Policy 3
• Proxy Arp Policy 4
• Proxy Arp Policy 5

15 Click on the Next button. The Configure NTP form opens.

16 Configure the Broadcast parameter.

17 Click on the Next button, if applicable. Otherwise, proceed to step 19. The Configure 
DHCP Relay form opens.

DHCP relay is supported for Layer 3 interfaces on the following devices:

• 7450 ESS Release 2.0
• 7750 SR Release 2.1
23-14 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



23 —  Router configuration
18 Configure the parameters. They include:

i If you set the Snooping parameter in the Configure DHCP Relay form to 
Disabled, proceed to step 19.

ii If you set the Snooping parameter in the Configure DHCP Relay form to 
Enabled, the Configure DHCP Relay Auto Filtering appears in the step menu.

iii Click on the Next button. The Configure DHCP Relay Auto Filtering form 
appears.

iv Configure the Enable Auto ACL Filters parameter.

19 Click on the Finish button if you are creating a new network interface, or click on the 
Apply button to save changes to an existing network interface.

20 Cable the network ports or channels of the device, with Layer 3 interfaces enabled, 
to other devices configured the same way.

21 Configure routing protocols, as described in chapter 24.

Procedure 23-3  To modify a Layer 3 interface

This procedure describes how to modify Layer 3 interface parameters. The interfaces you 
modify include:

• Layer 3 interface
• ICMP interface
• system interface
• management interface

See the 7750 SR OS Router Guide for more information about using CLI to configure 
interfaces.

1 Choose Network from the navigation tree view selector.

2 Navigate to a routing instance.

The navigation path is Network→Router→Routing Instance.

3 Select a Layer 3 interface and choose Properties from the right-click contextual 
menu.

Note —  DHCP relay is configurable on the 7750 SR only if Ethernet 
encapsulation is enabled at the port level, and if the Loopback Enabled 
parameter is not selected on the Define General Properties form.

• Enable DHCP Relay
• Description
• Enable Info Option

• Trusted
• Snooping
• Server 1 through Server 8
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The 5620 SAM displays the Network Interface configuration form. Figure 23-5 
shows the Network Interface configuration form with the Port tab selected.

Figure 23-5  Network Layer 3 interface configuration form - Port

4 Click on the appropriate tab button and configure the parameters, if required.

Table 23-3 describes the tabs to choose, as shown when you modify an existing 
routing interface.

Table 23-3 Description of Network Interface configuration form tabs

Tab Description

General Configure the parameters. They include:

• Description
• Administrative State
• MAC Address
• Allow Directed Broadcasts
• Class
• Cflowd Type
• Loopback Enabled
• Trusted

Port To create an association between the Layer 3 interface and a physical port or 
channel. The system interface is not associated with a port.

Policies To associate network policies and ingress or egress IP ACL filter policies with the 
network interface.

(1 of 2)
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5 Click on the Apply button to save the changes.

6 Close the form.

7 Cable the network ports or channels of the device, with Layer 3 interfaces enabled, 
to other devices configured the same way.

8 Configure routing protocols, as described in chapter 24.

Procedure 23-4  To configure a routing policy

See “Routing policies” in section 23.1 for more information about the use and purpose of 
routing policies.

1 Choose Network from the navigation tree view selector.

2 Navigate to a routing instance.

Protocols To view a list of protocols that are enabled on the interface, and to add protocols. 
The protocols are:

• MPLS
• OSPF
• LDP
• RSVP
• ISIS
• RIP

You then associate the Layer 3 interface with a protocol.

Multicast To view a list of protocols that are enabled on the interface, and to add protocols. 
The protocols are:

• PIM
• IGMP

You then associate the Layer 3 interface with a multicast protocol.

Address To assign an IP address, subnet and broadcast address format to a network 
interface. Only one primary IP address can be associated with a network 
interface.

ICMP To configure ICMP parameters related to mask replies and redirects, 
unreachable, and TTL properties.

ARP and Proxy 
ARP

To configure or view ARP and proxy ARP parameters.

Click on the General tab button to configure the minimum time, in seconds, that 
an ARP entry is stored in the ARP table. Click on the Add button to set static ARP 
IP and MAC address parameters.

Click on the Proxy ARP tab button to view parameter information.

NTP To enable SNTP broadcasts on the network interface

Statistics To view Layer 3 network interface statistics

Faults Alarms raised against the network interface, or related alarms that affect the 
network interface.

Tab Description

(2 of 2)
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The navigation path is Network→Router→Routing Instance.

3 Right-click on the routing instance icon and choose Properties from the contextual 
menu. 

The 5620 SAM displays the Routing Instance form.

4 From the General tab, click on the Edit Routing Policies button.

The 5620 SAM displays the Routing Policy Manager form with the General tab 
button selected, as shown in Figure 23-6.

Figure 23-6  Routing Policy Manager form - General

5 Configure the Triggered Re-evaluation of Route Policies parameter.

6 Click on the AS Paths tab button.

7 Configure the parameters. You can:

a Click on the Edit button to modify an existing AS path.

b Click on the Add button to create a new AS path.

In the AS path form that opens, configure the parameters. They include:

• Path Name
• Description
• Regular Expression
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8 Click on the Communities tab button.

9 Configure the parameters. You can:

a Click on the Edit button to modify an existing community.

b Click on the Add button to create a new community.

In the community form that opens, configure the Community Name parameter.

10 Click on the Dampings tab button.

11 Configure the parameters. You can:

a Click on the Edit button to modify existing dampings.

b Click on the Add button to create new dampings.

In the Dampings form that appears, configure the following parameters. They 
include:

• Damping Name
• Half Life
• Reuse
• Suppress
• Max Suppression

12 Click on the Policy Statements tab button.

13 Configure the parameters.

a Click on the Edit button to modify existing community statements.

b Click on the Add button to create new community statements. Go to substep i.
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The Create Routing Policy form appears.

i Configure the general parameters. They include:

• Policy Statement Name
• Description
• Default Action

ii Click on the Next button. The Configure policy entries form appears.

iii Click on the Add button to create policy entries, or click on the Edit button to 
modify existing policy entries. The Create Routing Policy Entry form or Edit 
Routing Policy Entry form appears.

iv Follow the series of configuration forms that appear and configure the 
parameters. They include:

• Entry ID
• Description
• Action
• From Criteria:

• AS Path Name

• Protocol

• Community List Name
• Origin

• Interface Name

• ISIS Route Level
• ISIS External Route

• OSPF Route Type

• OSPF Area
• OSPF Area Set

• Multicast Source IP Address

• Multicast Group Prefix List Name
• IGMP Host Prefix List Name

• Neighbor IP Address

• Neighbor Prefix List Name
• Prefix Lists. Enter up to five prefix lists.

• To Criteria:
• Protocol

• ISIS Route Level
• Neighbor IP Address

• Neighbor Prefix List Name

• Prefix Lists. Enter up to five prefix lists.

In the Multicast panel of the From Criteria form, configure the following 
parameters for an IGMP packet filter policy entry:

• Multicast Source IP Address
• Multicast Group Prefix List Name
• IGMP Host Prefix List Name
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In the Multicast panel of the From Criteria form, configure the Multicast Group 
Prefix List Name parameter for an MVR policy entry.

v Click on the Next button to go to the next step.

vi You can configure multiple policy statements by repeating substeps iii to v.

14 Click on the Prefix Lists tab button.

15 Configure the parameters. You can:

a Click on the Edit button to modify existing prefix lists.

b Click on the Add button to create new prefix lists.

In the Prefix list form that appears, configure the Prefix List Name parameter.

16 Click on the Prefix List Members tab button.

a Click on the Edit button to modify existing prefix list members.

b Click on the Add button to create new prefix list members.

In the Prefix List Member form that appears, configure the parameters. You can 
configure multiple prefix list members.

• Prefix. Enter an IP address in the format xxx.xxx.xxx.xxx
• Mask. Enter a network mask.
• Type

Depending on the option that you select for the Type parameter, you can configure 
the Begin Length parameter and the Through Length parameter.

17 Click on the Faults tab buttons to view alarm information.

18 Save the changes and close the form.

Procedure 23-5  To configure an MPLS administrative group policy

MPLS administrative group policies define administrative groups that can be assigned to 
MPLS interfaces, LSPs, and LSP paths. After you configure MPLS administrative groups, 
the administrative groups can be assigned to MPLS interfaces, LSPs, and LSP paths on 
their respective properties forms. Multiple administrative groups can be assigned to each 
of these objects.

When establishing LSP and LSP paths, devices will only consider MPLS interfaces which 
are associated with the same administrative group as the LSP or LSP path. MPLS 
interfaces advertise administrative group associations using CSPF. This is done using 
the 32 bit mask which you configure using the Value parameter on the MPLS 
administrative group policy form. 
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An administrative group can also be assigned to be explicitly excluded from LSPs and 
LSP paths. The device cannot use MPLS interfaces in the administrative group to 
establish LSPs or LSP paths. Administrative group exclusion takes priority over 
administrative group inclusion.

CSPF must be enabled on LSPs for administrative groups to be relevant. You can enable 
and configure CSPF on the LSP properties form. When CSPF is enabled on an LSP, it is 
automatically enabled on associated LSP paths. LSP paths can be configured on the LSP 
path properties form to inherit additional CSPF, administrative group, and other 
parameters from LSPs. 

See the 7750 SR OS Services Guide for more information about MPLS administrative 
groups and CSPF.

This procedure describes how to create MPLS administrative groups. Table 23-4 
describes where to find information about assigning MPLS administrative groups to 
MPLS interfaces, LSPs, and LSP paths.

Table 23-4 MPLS administrative group assignments

1 Choose Policies→MPLS Administration Groups from the 5620 SAM main menu. 
The Manage MPLS Administration Groups form opens.

2 Click on the Create button.

The MPLS administrative group policy form appears with the General tab button 
selected, as shown in Figure 23-7.

To assign groups to See procedure 

MPLS interfaces “To create MPLS interfaces” in chapter 25

LSPs “To create LSPs” in chapter 25

LSP paths “To configure LSP paths” in chapter 25
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Figure 23-7  MPLS administrative group form - General

Configure the parameters. They include:

• Displayed Name
• Value

3 Click on the Apply button to save the policy.

The MPLS administrative group policy form is refreshed and the tabs are selectable. 
Table 23-5 describes the tabs that you can choose to configure the parameters. 

Table 23-5 Description of MPLS administrative group form tabs

Tab Description

Local Definitions Lists MPLS administrative group policies and allows you to manage 
administrative group policy distribution.

LSPs Lists and allows you to manage LSPs to which the administrative group has been 
assigned.

LSP Paths Lists and allows you to manage LSP paths to which the administrative group has 
been assigned.

Interfaces Lists and allows you to manage MPLS interfaces to which the administrative 
group has been assigned.

Faults List and manage alarms related to the administrative group.
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4 Click on the Distribute button to manually distribute the administrative group policy 
locally to managed devices. Policies are also automatically distributed to managed 
devices when they are used by resources on the device.

Procedure 23-6  To configure a static route

1 Choose Network from the navigation tree view selector.

2 Navigate to the static routes icon.

The navigation path is Network→Router→Routing Instance→Static Routes.

3 Right-click on the static routes icon and choose Create Static Route from the 
contextual menu. 

The 5620 SAM displays the Static Route (Create) form, as shown in Figure 23-8.

Figure 23-8  Static Route (Create) form
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4 Configure the parameters. They include:

5 Click on the Apply button to save the changes.

6 Click on the OK button to close the form.

• Auto-Assign ID
• Static Route ID
• Destination
• Mask
• Type
• Unnumbered Interface
• Preference

• Metric
• Administrative State
• IGP Shortcut
• Disallow IGP
• IP Address
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24.1 Routing protocol configuration overview

The 5620 SAM allows you to configure routing protocols and navigate to the device 
parameters. One device can support multiple routing protocols. 

You use the network, ISIS, and OSPF views in the 5620 SAM GUI navigation tree 
to view and configure parameters that set and manage the routing protocol support 
of the 7750 SR. The routing protocols are enabled on the devices when you configure 
the devices. The Layer 3 interfaces are configured when you configure the routing 
instance on the device. You can then configure the routing protocols for the specific 
Layer 3 interfaces.

Configuration is done using configuration forms, as shown in example Figure 24-1.

Figure 24-1  Example BGP configuration form - General

Supported routing protocols include:

• BGP
• RIP
• OSPF
• RSVP
• LDP
• ISIS
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Routing protocols can be configured to import or export routes from other routing 
protocols using routing policies. See “Routing policies” in section 23.1 for more 
information.

In addition to routing protocols, the 5620 SAM supports the following multicast 
routing types:

• PIM
• IGMP

In addition to routing protocols and multicast routing, the 5620 SAM supports 
bridging on Telco T5C devices.

BGP

There are two types of BGP.

• BGP
• MP-BGP

BGP is an inter-AS routing protocol. An AS is a network or a group of devices 
logically organized and controlled by a common network administration. BGP 
enables devices to exchange network reachability information. AS paths are the 
routes to each destination. There are two types of BGP, IBGP and EBGP.

• Within an AS, IBGP is used to communicate with peers within an autonomous 
system. Routes received from a 7750 SR in the same autonomous system are not 
advertised to other devices in the same autonomous system but can be advertised 
to an EBGP peer.

• Outside of an AS or between ASs, EBGP is used to communicate with peers in 
different autonomous systems. Routes received from a device in a different AS 
can be advertised to both EBGP and IBGP peers.

You can use the 5620 SAM to enable BGP on the device and configure:

• set the AS values for the routing instance
• create confederations to group-managed devices 
• create BGP peer groups
• create neighbors within the BGP peer groups

A device can only belong to one AS. After the neighbor relationship is established 
between devices, they exchange BGP open messages, which contain information 
such as AS numbers, BGP versions, router IDs, hold-time values, and keepalive 
messages. This information determines the status of the BGP session. Peer 
relationships are defined by configuring the IP address of the devices that are peers 
of the local BGP system.

Figure 24-2 shows a simple BGP example using groups, subconfederations, and 
confederations.
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Figure 24-2  BGP example

In a standard BGP configuration, all BGP-enabled devices within an AS have a full 
mesh of BGP peerings to ensure all externally learned routes are redistributed 
through the entire AS. This is needed because IBGP does not re-advertise routes 
learned from one IBGP peer to another IBGP peer. However, as more devices are 
added, scaling the IBGP mesh can become an issue. To solve this scaling issue, you 
can use:

• confederations
• subconfederations
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Confederations are a way to subdivide a large AS into smaller ASs. 
Subconfederations further subdivide ASs. Within each smaller AS, or confederation, 
IBGP is still used, however EBGP is used between subconfederations. This means 
less meshing between peers is required.

Another method of subdividing an AS is route reflection. For route reflection, an AS 
is divided into groups called clusters. Each cluster contains at least one route 
reflector. The route reflector redistributes routing updates to all devices in its cluster. 
Because the route reflector provides all the routing updates, the other devices in the 
cluster do not maintain a BGP mesh.

As BGP was designed to distribute IPv4 routing information, the addition of VPN 
IPv4 addresses required an extension to BGP. The extension is MP-BGP. The new 
addressing now includes a 12-byte address, consisting of a eight-byte RD and the 
four-byte IPv4 address. To use MP-BGP:

• MP-BGP must be enabled on all PE devices from the VPN tab of the BGP 
configuration form

• all PE devices must be connected as peers

When PE devices learn routing information from CE devices in an IP VPN 
configuration, the routing information is shared using MP-BGP. The route 
distinguishing eight-byte address is used to associate the new routing information 
with an IP VPN instance.

The PE devices then distribute the routes to the customer edge devices of all other 
VPNs within the IP VPN instance. Each learned route is assigned an MPLS label, 
which is distributed to the other devices.

When customer packets arrive at the PE device, the packets are encapsulated with the 
MPLS label corresponding to the learned route that matches the customer packet 
destination address.

RIP

RIP is an IGP that uses a distance-vector algorithm to determine the best route to a 
destination, using hop count as the deciding factor. In order for the protocol to 
provide complete information about routing, every device in the domain must 
participate in the protocol. RIP, a UDP-based protocol, updates its neighbors, and the 
neighbors update their neighbors.

Unlike OSPF and other link-state protocols, RIP directly advertising reachability 
information to its neighbors. RIP advertises reachability information by sending 
prefix, mask, and either hop count or cost metric data. Each device running the RIP 
protocol advertises all RIP devices periodically by sending RIP update PDUs. The 
route with the lowest metric is advertised as the best route.

You can use the 5620 SAM to enable RIP on the device. Both RIPv1 and RIPv2 are 
supported on all IP interfaces, including network and access interfaces. Use the CLI 
for additional RIP configuration. See the 7750 SR OS Router Guide for more 
information.
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OSPF

OSPF is a hierarchical link state protocol. OSPF is an IGP used within large ASs. 
OSPF devices exchange the state, cost, and other relevant interface information with 
neighbors once the neighbors are discovered. The information exchange enables all 
participating devices to establish a network topology map. Each device applies the 
Dijkstra algorithm to calculate the shortest path to each destination in the network. 
The resulting OSPF forwarding table is submitted to the routing table manager to 
calculate the routing table.

Because OSPF is hierarchical, devices are configured in logical groups called areas. 
The topology of each area is hidden from devices outside the area, which limits 
protocol traffic and routing table sizes. There are two main types of areas:

• backbone area
• standard areas

The backbone area distributes routing information between areas. The backbone area 
consists of all ABRs, networks not wholly contained in any area, and the attached 
devices. Standard areas are connected to the backbone area by ABRs. Standard areas 
are further classified as stub, totally stubby, or not-so-stubby:

• Stub areas substitute a a default route for external routes, using a type 3 summary 
LSA. A stub area cannot have an ASBR, and all devices in the stub area are 
configured to ensure that each device knows its neighbors in the stub area belong 
to the stub area.

• Totally stubby areas are the same as stub areas, except a default route is injected 
into the area.

• Not-so-stubby areas allow external routes, using a type 7 LSA, to be injected into 
the area. However, external routes from other areas are not accepted by any 
device in the NSSA.

Figure 24-3 shows the OSPF topology.
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Figure 24-3  OSPF areas in an OSPF domain

Each device in Figure 24-3 has:

• OSPF enabled on the device
• been assigned to an area
• been configured as an OSPF area device or backbone area device
• been enabled the OSPF protocol on a Layer 3 interface

You can use the 5620 SAM to configure all these OSPF settings.

When there are changes in the network, for example new neighbors are added, all 
devices in the appropriate areas advertise the topology changes to other devices in 
their area. The changes advertised only include the changes, not the entire network 
topology, and only the devices that need to update their routing tables do so.

LDP

LDP is used to distribute labels in non-traffic-engineered MPLS applications. 
Routers can establish LSPs across a network by mapping network-layer routing 
information directly to the data link layer-switched paths. After LDP distributes the 
labels to the LSR, the LSR assigns the label to a FEC, and then informs all other 
LSRs in the path about the label and how the label will switch data accordingly.
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When a service tunnel is configured to another managed routers using LDP signaling 
in an MPLS environment, LDP sessions are set up based on the configured hello and 
other PDU values. If another service tunnel is created to the same destination, the 
LDP session is reused.

The LDP sessions between LSRs:

• find and establish LDP peers in the managed network
• exchange label mappings for each LSR
• exchange label bindings

After all the LSRs are LDP-aware and the LSP is created, forwarding can occur:

1 An FEC is associated with the LSP.

2 The FEC maps the packets to the LSP.

3 The next LSR that is part of the LSP splices incoming FEC labels to the outgoing 
FEC label of the next hop.

There are two types of LDP.

• T-LDP
• DU-LDP

T-LDP is used to distribute labels for VLL and VPLS services. T-LDP allows the 
targeting of remote devices that are not directly connected as targeted peers.

DU-LDP can be used to create tunnels between PEs for IP-VPN services.

Figure 24-4 shows an example of LDPs that are used in a simple Layer 2 and Layer 
3 service provider network.
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Figure 24-4  LDP sample network

• The solid straight lines between the devices indicate IP connectivity. These are 
directly connected peers.

• The dotted bidirectional curved lines indicate T-LDP sessions. These are targeted 
peers that are not directly connected.

• The solid bidirectional curved lines indicate DU-LDP sessions. This example 
only shows two instances, between M and Z, and Z and K. If there is IP 
connectivity between all the devices, then all the devices would have DU-LDP 
sessions.

Provider edge router Z advertises the labels for its address 1.1.10/32 to adjacent link 
state devices M and K. Routers M and K distribute the labels for that address to the 
rest of the network. If provider edge router A wants to send a VPN-labeled packet to 
router Z, it uses label 61 as the outer label. When the packet reaches router N, outer 
label 61 is swapped for outer label 52 and the packet continues downstream to router 
M. Router M then swaps out label 52 for either outer label 31 or 42, depending on 
router M’s label selection algorithm. If outer label 31 is selected, the packet reaches 
router Z directly, which then continues to route the packet to the customer site based 
on the VPN label.

ISIS

ISIS is a link-state interior gateway protocol that uses the shortest path first algorithm 
to determine a route. Routing decisions are made using the link-state information. 
ISIS entities include:

• networks, which are autonomous system routing domains
• intermediate systems, which are routers, such as the 7750 SRs
• end systems, which are network devices that send and receive PDUs
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End systems and intermediate system protocols allow devices and nodes to identify 
each other. The ISIS protocol sends link state updates periodically through the 
network, so each device can maintain current network topology information.

Large networks, or autonomous systems, are supported by the ISIS using a two-level 
hierarchy. This divides a large area into more manageable, smaller areas. The first 
level (level 1) of routing is performed within an area. The second level (level 2) of 
routing is performed between areas, as shown in Figure 24-5.

Figure 24-5  ISIS routing domains example

Level 2 areas are also called backbones, similar to an OSPF backbone area. All 
traffic traversing different areas must traverse the backbone.A device can be 
configured as level 1, level 2, or both level 1 and 2. In this example, routers A, B, M, 
H, and X form the level 2 ISIS backbone. The connection between routers A and B 
carries both level 1 and level 2 link-state PDUs. However, level 1 devices are only 
aware of their own area’s topology, and must forward traffic to a layer 1/2 device to 
forward the data to another area.

Two devices are in the same level 1 area when they have level 1 adjacency. Level 1 
adjacency occurs when the area IDs are common and there is a level 1 connection 
between the devices. Level 2 adjacency occurs when it has at least one level 1 or 2, 
or one level 2 interface configured.
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Note —  If two neighboring devices in the same level 1 area run both 
level 1 and 2, they establish both a level 1 and level 2 adjacency.
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After the ISIS is configured, routing occurs as follows:

1 Hello PDUs are sent to ISIS-enabled interfaces to discover neighbors and 
establish adjacencies.

2 ISIS neighbor relationships are formed.

3 Link-state PDUs are created based on local interfaces and prefixes that are 
learned from adjacent devices.

4 The devices flood LSPs to adjacent neighbors, and build a link-state database.

5 A shortest path tree is calculated by the ISIS and the routing table is built.

RSVP

RSVP is a network control protocol used by a host to request specific qualities of 
service from the network for particular application data streams or flows. RSVP is 
also used to deliver quality of service (QoS) requests to all devices along the path(s) 
of the flows and to establish and maintain state to provide the requested service.

RSVP requests generally result in resources reserved in each device along the data 
path. MPLS uses this RSVP mechanism to set up traffic engineered LSPs. RSVP 
requests resources for simplex flows. It requests resources only in one direction 
(unidirectional). RSVP treats a sender as logically distinct from a receiver, although 
the same application process may act as both a sender and a receiver at the same time. 
Bidirectional flows require two LSPs, to carry traffic in each direction.

RSVP is not a routing protocol. RSVP operates with unicast and multicast routing 
protocols. Routing protocols determine where packets are forwarded. RSVP consults 
local routing tables to relay RSVP messages. By default, RSVP is enabled on all 
devices that support RSVP.

Bridging on Telco devices

Bridging is used between a Telco device and a 7450 ESS to create a fast ring that 
bridges the subscriber devices (such as set top boxes for broadcast TV) and L2 
services (such as VPLS distributing multicast signals). If necessary, you can 
configure the Telco devices with MSTP or another spanning tree protocol as 
required.

On the 5620 SAM, the bridge is represented from the network view, similar to a 
routing instance on a 7450 ESS.

24.2 Workflow to configure routing protocols

1 Prior to configuring OSPF or BGP, the router ID must be available. The router ID is 
a 32-bit number assigned to each router running OSPF or BGP.

2 Prior to configuring BGP, an autonomous system number must be assigned to the 
device from the Routing tab of the Routing Instance configuration form.
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3 Enable the routing protocols to be supported on the devices. The options are:

4 Ensure the parameters to implement routing protocols on the Layer 3 interfaces are 
configured as needed. See chapter 23 for more information.

5 Configure routing policies for those routing protocols that use policies.

6 The procedures to follow depend on the type of routing protocols that you want to 
configure. See Table 24-1 for more information.

a For BGP:

i Determine whether BGP confederations are necessary. If BGP 
confederations are necessary:

• Configure the Confederation Autonomous System number on the 
Routing tab of the Routing Instance configuration form.

• Configure BGP confederation members from the BGP Confederations 
tab of the Routing Instance configuration form.

ii For MP-BGP, enable VPN IPv4 from the VPN tab button on the BGP 
configuration form.

iii Create at least one BGP peer group.

iv Create a BGP neighbor with which to peer.

v Create a BGP peer autonomous system that is associated with the 
neighbor peer.

b For RIP:

i Configure global-level RIP parameters.

ii Configure group-level RIP parameters.

iii Configure neighbor-level (also known as interface) RIP parameters.

c For OSPF:

i Create at least one OSPF area.

ii Assign routers to the OSPF area.

iii Assign Layer 3 interfaces to the routers in the OSPF area.

d For LDP:

i Configure global-level LDP parameters.

ii Create LDP interfaces for LDPs between adjacent devices (directly 
connected peers).

• LDP
• ISIS
• MPLS
• RSVP (enabled by default)
• BGP

• RIP
• OSPF
• PIM
• IGMP
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iii Create LDP targeted peers for LDPs between non-adjacent devices (non 
directly connected peers).

e For ISIS:

i Configure global-level ISIS parameters.

ii Configure at least one NET address.

iii Configure at least one ISIS interface.

iv Configure an operational LSP between routers.

f For RSVP:

i Configure MPLS, LSP, and MPLS and LSP path parameters, as required.

ii Configure the RSVP properties

iii Configure the interface properties

iv Enable LDP, as required.

g For PIM:

i Enable PIM on the router.

ii Configure PIM on the router. 

iii Configure a PIM interface. 

h For IGMP:

i Enable IGMP on the router.

ii Configure IGMP on the router. 

iii Configure an IGMP interface.

7 Configure the protocol for the remote device, if applicable.

24.3 Routing protocol configuration menus

To configure routing protocols, you choose Network, ISIS, or OSPF from the 
navigation tree view selector. You then use the contextual menus to configure or 
modify the network objects.

24.4 Routing protocol configuration procedures list

Table 24-1 lists the procedures to configure routing protocols.
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Table 24-1 Routing protocols configuration procedures list

Protocol Procedure Reference

BGP To enable BGP on a router See “BGP” in section 24.5 for more information.

To configure a BGP confederation

To configure global-level BGP

To configure peer group-level BGP

To configure peer-level BGP

RIP To configure global-level RIP See “RIP” in section 24.5 for more information.

To configure group-level RIP

To configure interface-level RIP

OSPF To enable OSPF on a router See “OSPF” in section 24.5 for more information.

To configure OSPF on a router

To configure an OSPF area and add Layer 3 
interfaces to the area

To add a router to an OSPF area

To create a virtual link

LDP To enable LDP on a router See “LDP” in section 24.5 for more information.

To configure global-level LDP parameters

To configure LDP interfaces

To configure LDP targeted peers

To configure LDP peers

ISIS To enable ISIS See “ISIS” in section 24.5 for more information.

To configure ISIS parameters

To configure ISIS NET addresses

To configure ISIS interfaces

RSVP To configure RSVP parameters See “RSVP” in section 24.5 for more information.

To edit RSVP interfaces

PIM To enable PIM on a router See “PIM” in section 24.5 for more information.

To configure PIM on a router

To create a PIM interface

IGMP To enable IGMP on a router See “IGMP” in section 24.5 for more information.

To configure IGMP on a router

To create an IGMP interface

Bridging To configure bridging —
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24.5 Routing protocol configuration procedures

Perform the appropriate procedures for the routing protocols you want to configure. 
See the 7750 SR OS Router Guide for more detailed information about routing 
protocol parameters.

BGP
The BGP command hierarchy consists of three levels:

• global
• peer group
• peer (also known as neighbor)

Figure 24-6 shows the network view open to show Confederations and BGP settings.

Figure 24-6  BGP in the navigation tree network view

BGP parameters are initially applied at the global level. These parameters are 
inherited by the group and peer levels. Parameters can be modified and overridden 
on a level-specific basis.

Many of the hierarchical BGP commands can be modified at different levels. BGP 
group-level parameters take precedence over BGP global-level parameters. BGP 
peer-level parameters take precedence over group- and global-level parameters.

Circle indicates aggregated
alarm status, square indicates

alarm status for the object

Network tab, showing IP router
object details, is selected

Context-sensitive
menu options
for this object

Routing protocols,
configured for this
routing instance

BGP confederation 8 is
configured for this routing instance,

and has these members
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Procedure 24-1  To enable BGP on a router

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to the routing instance icon.

The navigation path is Network→Router→Routing Instance.

3 Right-click on the routing instance icon and choose Properties from the contextual 
menu. The Routing Instance configuration form appears.

4 Enable BGP.

i Click on the Protocols tab button.

ii Choose the BGP Enabled parameter.

5 Click on the Apply button to save the changes.

BGP is listed in the configuration form of configured protocols and the BGP icon 
appears in the network view of the navigation tree.

Procedure 24-2  To configure global-level BGP

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to the BGP icon.

The navigation path is Network→Router→Routing Instance→BGP.

3 Right-click on the BGP icon and choose Properties from the contextual menu. The 
BGP configuration form appears with the General tab button selected.

4 Configure the general parameters. They include:

• Description
• Administrative State

5 Click on the Behavior tab button.

Note 1 — You must configure an AS number before enabling BGP. 
Configure an Autonomous System number from the Routing tab button 
on the Routing Instance configuration form.

Note 2 — If confederations are required, configure a number for the 
Confederation Autonomous System parameter from the Routing tab on 
the Routing Instance configuration form.
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6 Configure the parameters. They include:

• Router ID
• Cluster ID 
• Preference
• Multi Hop
• Loop Detect
• AS Path Ignore
• Aggregator ID Zero
• Damping
• Disable Client Reflect
• Min. Route Advertisement
• Disable Fast External Failover
• Disable Standard Communities
• Disable Extended Communities
• Advertise Inactive Routes

7 Click on the Time tab button.

8 Configure the parameters to specify how the duration and closeout of BGP sessions 
are handled. They include:

• Connect Retry Time
• Hold Time
• Keep Alive

9 Click on the AS Properties tab button.

10 Configure the parameters to specify the AS information that is advertised to peers. 
Some parameters are read-only. They include:

• Local AS
• Local AS Private
• Remove Private AS
• Min AS Origination

The Local AS parameters are used to configure a virtual AS. A virtual AS is used 
when a router (RTA) is moved from one AS (AS1) to another AS (AS2). However, 
the customer router (CR1) is configured to belong to the AS1. To avoid reconfiguring 
CR1 to belong to AS2, CR1 can continue to belong to AS1, but RTA has its local AS 
value set to AS1. Now RTA can advertise AS1 for routes advertised to CR1.

11 Click on the MultiPath tab button.

12 Configure the parameters. They include:

• MultiPath
Set to 1 to disable. When set to 2 to 16, multipath is enabled and BGP load 
shares traffic across the number of links specified. If the equal cost routes 
available are greater than the configured value, then routes with the lowest next 
hop IP address are chosen.

• IBGP MultiPath
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13 Click on the MED tab button.

14 Configure the parameters to advertise the MED. These parameters are used to find 
a way to exit the AS when there are multiple methods of leaving the AS. They 
include:

• MED Compare
• MED Source
• MED Value

15 If you are configuring BGP for a VPRN routing instance, go to step 20.

16 Click on the VPN tab button.

17 Configure the parameters. They include:

• Family
The parameter specifies the type of VPN, which is VPN IPv4 (used for route 
distinguishing for IP VPN services to enable MP-BGP) or IPv4

• Apply Import Route Policies
• Apply Export Route Policies

The apply route policies parameters specify whether to apply the existing import and 
export route policies configured on the Import Policies and Export Policies tabs.

18 Click on the IGP Shortcut tab button.

19 Configure the parameters. They include:

• IGP Shortcut
• Disallow IGP

20 Click on the Graceful Restart tab button.

21 Configure the following parameters:

• Graceful Restart
•  

22 Click on the Group tab button. To add a group:

a Click on the Add button

b Select the BGP icon from the navigation tree and choose Create Group from 
the contextual menu.

See Procedure 24-4 for more information.

23 Click on the Peer tab button. To add a peer.

a Click on the Add button

b Select the BGP icon from the navigation tree and choose Create Peer from the 
contextual menu.

See Procedure 24-5 for more information.

24 Click on the Import Policies tab button.
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25 Configure the parameters. They include:

• Policy 1
• Policy 2
• Policy 3
• Policy 4
• Policy 5

Configure the import route policy to determine which routes are accepted from 
peers. These policies should match the policies you set when configuring the 
Routing Policy Manager, as described in chapter 23. There is no validation 
performed by the router to ensure the policies match.

26 Click on the Export Policies tab button.

27 Configure the parameters. They include:

• Policy 1
• Policy 2
• Policy 3
• Policy 4
• Policy 5

Configure the export route policy to determine which routes are advertised to peers. 
These policies should match the policies you set when configuring the Routing 
Policy Manager, as described in chapter 23. There is no validation performed by the 
router to ensure the policies match.

28 Click on the Authentication tab button.

29 Configure the parameters that enable MD5 authentication and the authentication 
key to authenticate neighboring routers before a BPG session is set up. They 
include:

• Type
• Key

30 Click on the following tab buttons to view information.

• Statistics
• Faults to view alarm information

31 Click on the Apply button to save the changes.

32 Click on the OK button.

Procedure 24-3  To configure a BGP confederation

For BGP confederations, the following rules apply:

• A device can only belong to one confederation.
• Multiple devices can belong to one BGP confederation.
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You must configure BGP on the device and configure global-level BGP parameters 
before you configure BGP confederations, as described in Procedures 24-1 and 24-2.

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to the routing instance icon.

The navigation path is Network→Router→Routing Instance.

3 Right-click on the Routing Instance icon and choose Properties from the contextual 
menu.

The Routing Instance configuration form appears.

4 Click on the Routing tab button.

5 Enter the confederation number for the Confederation Autonomous System 
parameter and click on the Apply button.

6 Click on the BGP Confederations tab button.

7 Click on the Add button to add a BGP confederation, or click on the Edit button to 
configure an existing BGP confederation. The Confederation Routing Instance form 
appears.

You can only have one BGP confederation for each device.

8 From the General tab of the Confederation Routing Instance, you can view the 
Confederation Autonomous System number. Figure 24-7 shows the confederation 
form for the routing instance with the General tab button selected.

Figure 24-7  Routing instance confederation form - General
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To add new members to the confederation:

i Click on the Members tab button.

ii Click on the Add button. The Confederation Member configuration form 
appears. Figure 24-8 shows the confederation member configuration form with 
the General tab button selected.

Figure 24-8  Confederation member form - General

iii Specify the Member AS parameter as the number of ASs for the confederation. 
The member AS number represents the BGP instance of the device.

iv Click on the Apply button to save the changes.

A row is added to the list of confederation members, which indicates that the 
AS that is in the confederation.

v Repeat for each AS that you want in the confederation by specifying the 
Member AS parameter.

9 Click on the Apply button. The Confederation icon appears in the Navigation Tree 
below the Routing Instance icon.

Verify the confederation membership by opening the Confederation icon to view an 
icon that represents each member of the confederation, as specified in step 8.

From the Fault tab, you can view alarms raised against confederation members ASs, or 
faults raised against the confederation itself.

After the confederation is created, right-click on the confederation or the confederation 
member icons to perform maintenance tasks using the contextual menu:

• Resync to resynchronize the network management settings with the device
• Copy to create a member AS based on the existing configuration settings of the 

chosen object
• Properties to view the configuration settings
• Remove to remove a member AS from the confederation
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Procedure 24-4  To configure peer group-level BGP

1 From the 5620 SAM, choose Network from the navigation tree view selector.

2 Navigate to the BGP icon.

The navigation path is Network→Router→Routing Instance→BGP.

3 Right-click on the BGP icon and choose Create Group from the contextual menu. 
The Peer Group configuration form appears with the General tab selected.

4 Configure the parameters. They include:

• Name
• Description
• Administrative State
• Inherit Value

5 Click on the Behavior tab button.

6 Configure the parameters. They include:

7 Click on the AS Properties tab button.

8 Configure the parameters. They include:

• Peer AS
The parameter specifies the peer AS for this specific group, and the behavior, 
either internal or external. Multipath configurations are not supported at the BGP 
peer level.

• Inherit Value
• Local AS
• Local AS Private
• Remove Private AS
• Min AS Origination

If you choose not to inherit the value from the global-level parent BGP configuration, 
you can only choose the option(s) not set in the parent configuration. For example, 
if the Damping parameter is set to false on the global-level BGP configuration form, 
you can only set the Damping parameter to true on the group-level BGP.

• Cluster ID
• Peer Type
• Local Address
• Local Preference
• Multi Hop
• Damping
• Disable Client Reflect
• Min. Route Advertisement
• Prefix Limit
• Loop Detect

• Inherit Value
• Next Hop Self
• Passive
• Aggregator ID Zero
• Preference
• Disable Fast External Failover
• Disable Standard Communities
• Disable External Communities
• Minimum TTL Value
• Advertise Inactive Routes
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The parameters you configure for the BGP peer group take precedence over the 
parameters you configure for the BGP global-level.

9 Click on the other tab buttons to configure the parameters, if required.

10 Click on the Apply button to save the changes.

11 Click on the OK button.

Procedure 24-5  To configure peer-level BGP

1 From the 5620 SAM, choose Network from the navigation tree view selector.

2 Navigate to a peer group.

The navigation path is Network→Router→Routing Instance→BGP→Peer Group.

where Peer Group is the group that you created in Procedure 24-4

3 Right-click on the peer group icon and choose Create Peer from the contextual 
menu. 

The Peer, Peer Group configuration form appears with the General tab button 
selected.

4 Configure the peer parameters from the appropriate tab, if required. They include:

• Peer Address
• Description
• Administrative State
• Inherit Value

The parameters that you configure for the BGP peer (also known as the BGP 
neighbor) take precedence over the parameters that you configure for the BGP peer 
group and the BGP global-level.

5 Click on the Apply button to save the changes.

6 Click on the OK button.

7 Configure the protocol for the far-end device, if applicable. Use CLI for 
non-5620 SAM managed devices.

Note —  If you choose not to inherit the value from the global-level 
parent BGP configuration, you can only choose the option(s) not set in the 
parent configuration. For example, if the Damping parameter is set to 
false on the global-level BGP configuration form, you can only set the 
Damping parameter to true on the peer-level BGP.
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RIP
The RIP command hierarchy consists of three levels:

• global
• group
• interface (also known as neighbor)

For RIP configuration, you must define at least one group and one interface. The 
parameters that are configured on the global level are inherited by the group and 
interface levels. Parameters can be modified and overridden on a level-specific basis.

Many of the hierarchical RIP commands can be modified on different levels. RIP 
group-level parameters take precedence over BGP global-level parameters. RIP 
interface-level parameters take precedence over peer group- and global-level 
parameters.

Procedure 24-6  To configure global-level RIP

1 From the 5620 SAM, choose Network from the navigation tree view selector.

2 Navigate to the RIP icon.

The navigation path is Network→Router→Routing Instance→RIP.

3 Right-click on the RIP icon and choose Properties from the contextual menu.

The RIP configuration form appears with the General tab button selected.

4 Configure the parameters. They include:

• Description
• Administrative State

5 Click on the Behavior tab button.

6 Configure the parameters for RIP routing. They include:

• Check Zero
• Message Size
• Metric In
• Metric Out
• Preference
• Receive
• Send

The parameter specifies the type of messages received based on the RIP 
version, and the variation of RiPv2 messages sent, either broadcast or multicast.

• Split Horizon
• Flush
• Timeout
• Update

7 Click on the Authentication tab button.
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8 Configure the parameters. They include:

• Type
• Key

9 Click on the Import Policies tab button.

10 Configure the parameters. They include:

• Policy 1
• Policy 2
• Policy 3
• Policy 4
• Policy 5

Choose route policies that determine the routes that are accepted from RIP 
interfaces. You can choose up to five route policies. The route policies are enforced 
in order, from one to five.

11 Click on the Export Policies tab button.

12 Configure the parameters. They include:

• Policy 1
• Policy 2
• Policy 3
• Policy 4
• Policy 5

Choose route policies that determine the routes that are exported to RIP interfaces. 
You can choose up to five route policies. The route policies are enforced in order, 
from one to five.

13 Click on the Group tab button. To create a group:

i Click on the Add button.

ii Configure the parameters. See Procedure 24-7 for more information.

14 Click on the Interface tab button. To configure interface-level (also known as 
neighbor) RIP parameters:

i Click on the Add button.

The interface form appears.

ii Configure the parameters. See Procedure 24-8 for more information.

15 Click on the following tab buttons to view information.

• Statistics
• Faults to view alarm information
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Procedure 24-7  To configure group-level RIP

1 From the 5620 SAM, choose Network from the navigation tree view selector.

2 Navigate to the RIP icon.

The navigation path is Network→Router→Routing Instance→RIP.

3 Right-click on the RIP icon and choose Create Group from the contextual menu. 

The RIP Group configuration form appears with the General tab button selected.

4 Configure the parameters. They include:

• Name
• Description
• Administrative State

5 Configure the RIP group parameters, as described in Procedure 24-6.

You can choose to inherit values by choosing the Inherit Value parameter. The 
parameters that you configure for the RIP group take precedence over the 
parameters you configure for the RIP global-level.

6 Click on the Apply button to save the changes.

7 Click on the OK button.

Procedure 24-8  To configure interface-level RIP

1 From the 5620 SAM, choose Network from the navigation tree view selector.

2 Navigate to an RIP group.

The navigation path is Network→Router→Routing Instance→RIP→RIP Group.

where RIP Group is the group you created in Procedure 24-7

3 Right-click on the RIP group icon and choose Create Interface from the contextual 
menu. 

The RIP Interface, RIP Group configuration form appears with the General tab 
button selected.

4 Configure the interface-level RIP parameters, as described in Procedure 24-6.

You can choose to inherit values by choosing the Inherit Value parameter. The 
parameters that you configure for the RIP interface (also known as the RIP 
neighbor) take precedence over the parameters that you configure for the RIP 
group- and global-level parameters.

5 Click on the Apply button to save the changes.
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6 Click on the OK button.

OSPF

Configuration planning is essential to organize devices, backbone, non-backbone, 
stub, NSSA areas, and transit links. OSPF provides defaults for basic protocol 
operability. At a minimum:

• Create a single OSPF backbone area which contain the area border routers.
• For larger networks, create several areas containing the other routers.
• For smaller networks, place all routers in the OSPF backbone area.

Use the 5620 SAM to configure the OSPF parameters. Figure 24-9 shows the OSPF 
view in the navigation tree.

Figure 24-9  OSPF view

View all the protocols
enabled and their

configuration details

The Network view specifies
the routing protocols. Specific
OSPF protocol information is
available from the OSPF view

Configure the
routers to support
routing protocols

Assign routers to
areas, as required

Assign Layer 3
interfaces, associated
with a physical port,

to routers

View detailed configuration of the protocols,
routing instances, or Layer 3 interfaces
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The OSPF parameters that must be configured to deploy OSPF are:

• Router ID — Each device that runs OSPF must be configured with a unique router 
ID. The router ID is used by both OSPF and BGP routing protocols in the routing 
table manager. When you configure a new router ID, protocols are not 
automatically restarted with the new router ID. You must shut down and restart 
the protocol to initialize the new router ID.

• An area — At least one OSPF area must be created. An interface must be assigned 
to each OSPF area. The types of OSPF areas include a backbone area, stub area 
and NSSA.

• Layer 3 interfaces — A Layer 3 interface is the logical IP connection between a 
router and one of its attached networks. A physical interface is associated with the 
Layer 3 interface to provide the cabled connected to another device. A Layer 3 
interface has state information associated with it, which is obtained from the 
underlying lower-level protocols and the routing protocol. An interface to a 
network has an associated IP address and mask (unless the network is an 
unnumbered, point-to-point network). An interface is sometimes also referred to 
as a link or a routing instance.

Procedure 24-9  To enable OSPF on a router

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to the routing instance icon.

The navigation path is Network→Router→Routing Instance.

3 Right-click on the routing instance icon and choose Properties from the contextual 
menu.

The Routing Instance configuration form appears.

4 Enable OSPF.

i Click on the Protocols tab button.

ii Select the OSPF Enabled parameter.

5 Click on the Apply button to save the changes.

The OSPF is listed in the configuration form of configured protocols and the OSPF 
icon appears in the network view of the navigation tree.

Procedure 24-10  To configure OSPF on a router

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to the OSPF icon.

The navigation path is Network→Router→Routing Instance→OSPF.
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3 Right-click on the OSPF icon and choose Properties from the contextual menu. The 
OSPF configuration form appears.

4 Configure the OSPF parameters. Figure 24-10 shows the OSPF configuration form 
with the General tab button selected.

Figure 24-10  OSPF configuration form - General

5 From the General tab configure the parameters. They include:

• Autonomous System Border Router
• Administrative State

6 Click on the Behavior tab button.

7 Configure the parameters. They include:

8 Click on the Dijkstra tab button.

9 Configure the parameters. They include:

• Spacing
• Hold Down

• Traffic Engineering Support
• RFC1583-Compatible
• Interface Base Reference Cost
• Overload Stubs

• Exit Overflow Interval
• External LSA Limit
• Internal
• External
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10 Click on the Export Policies tab button.

11 Configure the parameters. They include:

• Policy 1
• Policy 2
• Policy 4
• Policy 3
• Policy 5

Configure the export route policies used to determine which routes are advertised 
to peers.

12 Click on the Area Site tab button.

13 Perform one of the following:

a Click on the Add button to add an area site.

b Click on the Edit button to edit an existing area site.

14 Configure the parameters. They include:

• Type
• Area ID
• Blackhole Range

Configure the area ID to define the OSPF area. The number is a 32-bit hexadecimal 
number in the form of an IP address or a single digit number to imply 0.0.0.x, where 
x identifies the area.

15 Click on the following tab buttons to view information related to OSPF routing.

• Interface
• Neighbor shows read-only information
• Virtual Neighbor shows read-only information
• Virtual Link
• Area Range
• Statistics
• Faults to view alarm information

16 Click on the Graceful Restart tab button.

17 Configure the parameters including:

• Graceful Restart
• Helper Mode

18 Click on the Apply button to save the changes.

19 Click on the OK button.
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Procedure 24-11  To configure an OSPF area and add Layer 3 
interfaces to the area

You must create at least one OSPF area.

1 From the 5620 SAM, choose OSPF from the navigation tree view selector.

2 Select the network icon.

3 Right-click and choose Create Area from the contextual menu. 

The Area (Create) configuration form appears.

4 Associate a routing instance on the router and add it to the area.

5 Configure the parameters. They include:

• Type
• Area ID
• Blackhole Range

Configure the area ID to define the OSPF area. The number is a 32-bit hexadecimal 
number in the form of an IP address or a single digit number to imply 0.0.0.x, where 
x identifies the area.

6 Click on the Stub/NSSA tab button, if applicable.

7 Configure the parameters. They include:

• Default Cost
• Redistribute External Routes
• Originate Default Route

8 Click on the OK button to save the changes.

The 5620 SAM updates the navigation tree to display the area that you have 
created.

9 Right-click on the area icon and choose Create Interface from the contextual menu. 
This action will assign an existing Layer 3 interface, rather than create a new Layer 
3 interface.

The Interface Area configuration form appears with the General tab button selected.

10 From the General tab, click on the Select button next to the Interface Name 
parameter.

The list of available Layer 3 interfaces appears.

11 Choose a Layer 3 interface from the list and click on the OK button.

The Layer 3 interface is added to the Interface Name.
Alcatel 5620 Service Aware Manager, Release 3.0 R1 24-31
October 2005 3HE00214 CA



24 —  Routing protocol configuration
12 Configure the remaining general parameters, if required. They include:

• Description
• Configured MTU (bytes)
• Administrative State

13 Click on the Protocol Properties tab.

14 Configure the Layer 3 interface protocol parameters. They include:

• Type
• broadcast to create a broadcast interface.

• Point to Point to create an PPP interface

• Priority
• Metric
• Hello Interval (seconds)
• Poll Interval (seconds)
• Router Dead Interval (seconds)
• Advertise Subnet
• Passive

15 Click on the OK button.

The Layer 3 interface is added to the router in the area.

The router will now begin to attempt reaching neighboring routers that may be 
connected on the interface. The routers will recognize links to the neighboring 
routers and share OSPF routing information.

Once this is complete, neighbor information appears in the navigation tree under the 
Layer 3 interface icon.

16 Configure the area that you created, select the area icon from the navigation tree.

17 Right-click and choose Properties from the contextual menu. 

The 5620 SAM displays the Area configuration form. Figure 24-11 shows the 
configuration form for a Standard (All LSAs) OSPF area with the General tab button 
selected.

Note —  To view area information, a router must be added to the area. 
See Procedure 24-12 to add a router to an OSPF area.
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Figure 24-11  OSPF area form - General

18 Configure the parameters for the area, if required. They include:

• Type
• Blackhole Range

Reconfigure the type of area, and to enable the area as a blackhole range to avoid 
routing loops.

19 Click on the Stub/NSSA tab button.

20 Configure the NSSA and stub parameters. This tab appears for stub, totally stub, 
and NSSA areas. For all other areas, the tab is dimmed. The parameters include:

• Default Cost
• Redistribute External Routes
• Originate Default Route

21 Click on the Interface tab button.

22 Associate a Layer 3 interface with the OSPF area.

i Click on the Add button.
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The Layer 3 interface configuration form appears with the General tab button 
selected.

ii Configure the parameters, as required. They include:

• Description
• Administrative State
• Configured MTU (bytes)

iii Click on the Protocol Properties tab button.

iv Configure the parameters. They include:

• Type
• Priority
• Metric
• Hello Interval (seconds)
• Poll Interval (seconds)
• Router Dead Interval (seconds)

v Assign the Layer 3 interface by clicking on the Apply button.

23 Click on the Virtual Link tab button.

24 Configure the parameters. To add a virtual link:

i Click on the Add button.

The virtual link configuration form appears with the General tab button 
selected.

ii Configure the parameters, as required. Virtual links are used to link remote 
areas that do not advertise their OSPF topology. The parameters include:

• Virtual Neighbor Router (Site) ID
• Transit Area

iii Click on the Apply button to save the changes.

iv Click on the OK button.

25 Click on the Area Range tab button.

26 Configure the parameters. To add an area range:

i Click on the Add button.

The area range configuration form appears.

ii Configure the parameters, as required. They include:

• Network
• Mask
• Link State DB Type
• Effect
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The area range minimizes the advertisements that are flooded by summarizing 
a range of IP addresses in an LSA.

iii Click on the Apply button to save the changes.

27 Click on the Faults tab to view alarm information and the Statistics tab button to view 
statistics information.

28 Click on the Apply button to save the changes.

29 Click on the OK button.

Procedure 24-12  To add a router to an OSPF area

1 From the 5620 SAM, choose OSPF from the navigation tree view selector.

2 Navigate to the area in which you want to add routers.

3 Right-click on the area icon and choose Add Router from the contextual menu. 

The 5620 SAM displays the Area configuration form. Figure 24-12 shows the Area 
configuration form from which you choose a router to add.

Figure 24-12  Area configuration form - General

4 Click on the Select button next to the Routing Instance Name parameter to choose 
the routing instance to add.

The Select Routing Instance form appears.

5 Choose a routing instance from the list.

6 Click on the OK button.

The routing instance is added to the Routing Instance Name parameter.
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7 Set the Stub and NSSA parameters when adding routers to the stub or NSSA OSPF 
areas.

For NSSA, choose whether to perform distribution of external routes. If you choose 
to distribute then distribute external routes, and set the default cost.

8 Click on the Apply button to save the changes.

9 Click on the OK button.

The router appears in the area.

10 Right-click on the router icon and choose Create Interface from the contextual 
menu.

The Interface Area configuration form appears.

11 Follow steps 10 in Procedure 24-11 to the end of Procedure 24-11 to associate the 
Layer 3 interfaces and area properties.

Procedure 24-13  To create a virtual link

1 From the 5620 SAM, choose OSPF from the navigation tree view selector.

2 Navigate to the area in which you want to add routers.

3 Right-click on the area icon and choose Create Virtual Link from the contextual 
menu. 

The 5620 SAM displays the Virtual Link (Create) configuration form.

4 Specify the Virtual Neighbor Router (Site) ID parameter and the Transit Area 
parameter.

5 Click on the Protocol Properties tab button.

6 Specify the OSPF virtual link hello interval parameters.

7 Click on the Apply button.

8 Click on the OK button.

LDP

T-LDP is supported on 7750 SRs and 7450 ESSs, DU-LDP and LDP are only 
supported on the 7750 SR.

From the network view routing instance, there are two trees for LDP: Interfaces and 
Targeted LDP Peers.

The Interfaces tree lists all the configured LDP interfaces for directly connected 
peers. As shown in Figure 24-4, there are 2 LDP interfaces for PE Z.
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The Targeted LDP tree lists indirect peers. As shown in Figure 24-4, PE A and PE B 
are indirect peers.

Procedure 24-14  To enable LDP on a router

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to the routing instance icon.

The navigation path is Network→Router→Routing Instance.

3 Right-click on the routing instance icon and choose Properties from the contextual 
menu.

The Routing Instance configuration form appears.

4 Enable LDP.

i Click on the Protocols tab button.

ii Select the LDP Enabled parameter.

LDP is listed in the configuration form of configured protocols and the LDP icon 
appears in the navigation tree.

5 Click on the Apply button to save the changes.

Procedure 24-15  To configure global-level LDP parameters

1 Enable LDP on the router, as described in Procedure 24-14.

2 You can:

a Select LDP from the list of protocols on the Routing Instance configuration form 
and click on the Edit button.

b Click on the LDP icon in the navigation tree. Choose Properties from the 
contextual menu.

The navigation path is Network→Router→Routing Instance→LDP.

3 The LDP (Edit) configuration form appears, as shown in Figure 24-13. The figure 
shows an LDP configuration form with the Common tab button selected.
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Figure 24-13  LDP configuration form - Common

4 Configure the General parameters. They include:

• Administrative State

5 Click on the Common tab button.

6 Configure the parameters. They include:

• Targeted Sessions Allowed
• Tunnel Down Damp Time

Configure the Targeted Sessions Allowed parameter to true to configure the router 
for T-LDP. Targeted sessions are LDP sessions to distribute labels between peers 
that are not directly connected.

You can view the following information about the LDP on the router:

• The LSR ID is the ID of the router as a label switched router.
• The distribution mode displays the method used to distribute labels.
• The remaining parameter values are determined by the router settings.

7 Click on the Interface Properties tab button.
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8 Configure the parameters. By default, these parameter values are inherited by all 
LDP interfaces. They include:

• Address Type
• Choose system to have the system IP address set up LDP sessions.

• Choose interface to have the IP interface address set up LDP sessions; but it 
cannot be used if there are multiple interfaces between the two neighbors.

• Keep Alive Factor
• Keep Alive Timeout
• Hello Factor
• Hello Timeout

9 Click on the Targeted Peers Properties tab button.

10 Configure the parameters. By default, these parameter values are inherited by all 
LDP targeted peers. They include:

• Keep Alive Factor
• Keep Alive Timeout
• Hello Factor
• Hello Timeout

11 Click on the Interfaces tab button. A list of interfaces you can view or configure 
appears. See Procedure 24-16 for more information about configuring LDP 
interfaces.

12 Click on the Peers tab button. A list of peers you can view or configure appears. See 
procedure 24-18 for more information about creating peers.

13 Click on the Targeted Peers tab button. A list of targeted peers you can view or 
configure appears. See Procedure 24-17 for more information about creating 
targeted peers.

14 Click on the Sessions tab button. A list of LDP sessions appears, showing 
information of the active LDP communication sessions between interfaces and 
targeted peers between the routers running LDP.

15 Click on the Import Policies and Export Policies tab buttons to configure up to five 
import and export policies for each LDP. You can configure the Policy 1 parameter 
to Policy 5 parameter.

16 Click on the following tab buttons to view information.

• Sessions for information about the LDP sessions
• Statistics to view performance statistics
• Faults to view alarm information

17 Click on the Apply button to save the changes.

Procedure 24-16  To configure LDP interfaces

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.
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2 Navigate to an LDP instance.

The navigation path is Network→Router→Routing Instance→LDP.

3 Right-click on the LDP instance and choose Create Interface from the contextual 
menu.

The Interface configuration form appears with the General tab button selected.

4 Configure the parameters and create the LDP interface.

i Click on the Select button next to the Interface Name parameter.

The select interface form appears.

ii Generate a search filter and list the interfaces or click on the OK button, as 
required.

iii Choose a Layer 3 interface from the list.

iv Click on the OK button.

v Configure the remaining parameters. They include:

• Description
• Administrative State

5 Click on the Protocol Properties tab button.

6 Configure the parameters. You can inherit the value(s) from the global-level LDP 
configuration settings using the Inherit Value parameter, or you can select the check 
mark in the inherit value box next to each parameter, and reconfigure the 
parameters specifically for the targeted peer. They include:

• Keep Alive Factor
• Keep Alive Timeout
• Hello Factor
• Hello Timeout
• Transport Address Type

7 Click on the Apply button to save the changes.

8 Click on the OK button.

9 Configure the protocol for the far-end device, if applicable. Use CLI for 
non-5620 SAM managed devices.

Procedure 24-17  To configure LDP targeted peers

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to an LDP interface.

The navigation path is Network→Router→Routing Instance→LDP.
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3 Right-click on the LDP icon and choose Create Targeted Peer from the contextual 
menu. The TargetedPeer (Create) configuration form appears with the General tab 
button selected.

4 Configure the parameters. They include:

• Peer Address
• Description
• Administrative State state

5 Click on the Protocol Properties tab button.

6 Configure the parameters. You can inherit the value(s) from the global-level LDP 
configuration settings using the Inherit Value parameter, or you can select the check 
mark in the inherit value box next to each parameter, and reconfigure the 
parameters specifically for the targeted peer. They include:

• Keep Alive Factor
• Keep Alive Timeout
• Hello Factor
• Hello Timeout

7 Click on the Apply button to save the changes.

8 Click on the OK button.

9 Configure the protocol for the far-end device, if applicable. Use CLI for 
non-5620 SAM managed devices.

Procedure 24-18  To configure LDP peers

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to an LDP interface.

3 Right-click on the LDP icon and choose Properties. The LDP (Edit) form opens.

4 Click on the Peers tab button.

5 Click on the Add button. The Peer (Create) form opens with the General tab 
displayed.

6 Configure the peer address parameter.

7 Select the TTL Security tab button.

8 Configure the Minimum TTL Value parameter.

9 Select the Authentication tab button.
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10 Configure the parameters. They include:

• Type
• Key
• Active

11 Click on the Apply or OK button to save changes.

ISIS

Configuration planning is essential to organize devices in level 1, level 2 and level 1 
and 2 areas. ISIS provides defaults for basic protocol operability. Use the 5620 SAM 
to configure the ISIS parameters. Figure 24-14 shows the ISIS view in the navigation 
tree

Figure 24-14  ISIS view
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The ISIS information displayed includes:

• backbone area and the devices in the backbone area
• a list of areas and the router(s) participating in the area
• a display of devices that lists the interface IP addresses and the configured level 

(1, 2, or 1 and 2) of each interface
• for each interface, ISIS adjacencies for that interface that represent the connection 

between two ISIS interfaces

Procedure 24-19  To enable ISIS

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to the routing instance icon.

The navigation path is Network→Router→Routing Instance.

3 Right-click on the routing instance icon and choose Properties from the contextual 
menu.

The Routing Instance configuration form appears.

4 Enable the ISIS protocol.

i Click on the Protocols tab.

ii Select the IS-IS Enabled parameter.

5 Click on the Apply button to save the changes.

ISIS is listed in the configuration form of configured protocols, the routing instance 
on which it is enabled, and the ISIS icon appears in the navigation tree.

Procedure 24-20  To configure ISIS parameters

Router-wide ISIS parameters can differ from the interface policies that are set in 
Procedure 24-22. Interface capabilities are compared to the outer-wide capabilities to 
determine the type of level 1, level 2, and level 1 and 2 adjacencies that can be created 
between routers to exchange ISIS routing information.

1 Enable the ISIS protocol on a router, as described in Procedure 24-19.

2 You can:

a Choose ISIS from the list of protocols on the Routing Instance configuration 
form and click on the Edit button.

b Click on the ISIS icon in the navigation tree and choose Properties from the 
contextual menu.

The navigation path is Network→Router→Routing Instance→ISIS.

The ISIS routing instance form appears with the General tab button selected,
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3 Configure the parameters. They include:

• Administrative State
• Level Capability

A level 1 adjacency can be established when there is at least one area address 
shared by this router and a neighboring router. A level 2 adjacency is established 
when another router is configured as a level 2 or a level 1 and 2 router with 
interfaces configured as level 2 or level 1 and 2.A level 1 and 2 adjacency is created 
when the neighboring router is also configured as a level 1 and 2 router and the 
routers have at least one area address in common.

4 Click on the Behavior tab button.

5 Configure the parameters. They include:

6 Click on the Authentication tab button.

7 Configure the parameters. They include:

• Enable Authentication
• Type
• Key

8 Click on the Level1 tab button.

9 Configure the parameters from the General tab button. They include:

•  External Preference
• Preference
• Wide Metrics Only

The External Preference and Preference (internal preference) parameters specify 
the route preference, which by default are as listed on the GUI. A route can be 
learned using different protocols:

• static route is 5
• OSPF internal route is 10
• ISIS level 1 internal route is 15
• ISIS level 2 internal route is 18
• OSPF external route is 150
• ISIS level 1 external route is 160
• ISIS level 2 external route is 165
• BGP route is 170

• Reference Bandwidth
• Traffic Engineering
• Overload On Boot
• Overload On Boot Timeout
• Overload
• Overload Timeout (seconds)
• LSP Lifetime (seconds)

• LSP Max Wait (seconds)
• LSP Initial Wait (seconds)
• LSP Second Wait (seconds)
• SPF Max Wait (seconds)
• SPF Initial Wait (milliseconds)
• SPF Second Wait (milliseconds)
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10 Click on the Authentication tab button to configure level 1 authentication.

11 Configure the parameters. They include:

• Type
• Key

Configure the authentication parameters to specify the MD5 key or password to 
verify PDUs that are sent by neighboring routers on the interface.

12 Click on the Level2 tab button.

13 Configure the parameters as specified in steps 8 to 11.

14 Click on the Export Policies tab button.

15 Configure the parameters. They include:

• Policy 1
• Policy 2

Specify up to five routing policies, in order of preference, to determine the routers 
exported from the routing table to ISIS. When multiple policies are specified, the 
policies are evaluated in order, from one to five.

16 Click on the NET addresses tab button. See Procedure 24-21 for more information.

17 Click on the Route Summarizations tab button. ISIS route summaries allow users to 
create aggregate IPv4 addresses that include multiple groups of IPv4 addresses for 
a specific ISIS summary level. This can help reduce the size of the link state 
database and the IPv4 routing table.

18 Click on the Add button. The route summarization form appears.

19 Configure the parameters.

• Network
• Mask
• Summary Level

20 Click on the Graceful Restart tab button.

21 Configure the parameters including:

• Graceful Restart
• Helper Mode

22 Click on the Apply button to save the changes. The route summaries appear in the 
list.

23 Click on the Interfaces tab button. See Procedure 24-22 for more information.
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24 Click on the following tab buttons to view information.

• Adjacencies to view a list of ISIS adjacencies, which represent a connection 
between two ISIS interfaces. Information listed for each adjacency includes the 
state of the adjacent interface, the interface ID, and the neighbor ID.

• Statistics
• SPF Logs
• Faults to view alarm information

25 Click on the Apply button to save the changes.

26 Click on the OK button.

Procedure 24-21  To configure ISIS NET addresses

1 Enable the ISIS protocol on a device, as described in Procedure 24-19.

2 You can:

a Click on the NET Addresses tab on the Routing Instance configuration form.

Click on the Add button.

b Click on the ISIS icon in the navigation tree.

Choose Add NET Address from the contextual menu.

The navigation path is Network→Router→Routing Instance→ISIS.

The Area ID configuration form appears.

3 Configure the NET address used by ISIS using the Area ID parameter. The NET 
address is exchanged in hello and LSP PDUs. Level 1 interfaces must have at least 
one area ID in common. Level 2 interfaces can have different area IDs. If all of the 
interfaces have different area IDs, they are considered level 2 interfaces only.

NET addresses are built from some non-configurable elements, including the router 
ID, the network service access point, and the network entity title, and from the 
configurable Area ID.

4 Click on the OK button to save the changes.

5 Close the form.
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Procedure 24-22  To configure ISIS interfaces

Interface ISIS parameters can differ from the global policies set in Procedure 24-20. 
Interface-level parameters specify the interface’s routing levels and information. Interface 
level capabilities are compared to the router-wide capabilities to determine the type of 
level 1, level 2, and level 1 and 2 adjacencies that can be created between devices to 
exchange ISIS routing information.

1 Enable the ISIS protocol on a router, as described in Procedure 24-19.

2 You can:

a Click on the Interfaces tab on the ISIS routing instance configuration form and 
click on the Add button.

b Click on the ISIS icon in the navigation tree and choose Create Interface from 
the right-click contextual menu.

The navigation path is Network→Router→Routing Instance→ISIS.

The Interface Routing Instance configuration form appears with the General tab 
button selected, as shown in Figure 24-15.

Figure 24-15  Interface routing instance form - General
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3 Configure the general parameters. They include:

• Administrative State
• Level Capability
• Type

• Choose Broadcast to configure the interface to maintain the link as a broadcast 
network. This is the default setting for IP interfaces on Ethernet ports, or for 
unknown port types.

• Choose Point-to-Point to configure the interface to maintain the link as a 
point-to-point link. This is the default setting for IP interfaces on SONET/SDH 
channels.

4 Click on the Behavior tab button.

5 Configure the parameters. They include:

• CSNP Interval (seconds)
• LSP Pacing Interval (seconds)
• Retransmit Interval (seconds)
• Mesh Group Status

To create a mesh group, specify the same mesh group number for all interfaces, 
and set the Mesh Group Status parameter to Enabled. The mesh group 
parameters specify the assigned mesh group for the interface. Mesh groups limit 
the amount of flooding when a new or changed LSP is advertised in an area.

• Mesh Group
• Passive

6 Click on the Authentication tab button.

7 Configure the parameters. They include:

• Type
• Key

You can enable authentication for any ISIS PDUs sent by the interface. Configure 
the authentication parameters to specify the MD5 key or password to verify PDUs 
that are sent by neighboring routers on the interface.

8 Click on the Level 1 tab button.

9 Configure the parameters from the General tab button. They include:

• Hello Interval (seconds)
• Hello Multiplier
• Metric
• Passive
• Priority

10 Click on the Authentication tab button.

11 Configure the parameters. They include:

• Type
• Key
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12 Click on the Level 2 tab button.

13 Configure the parameters as specified in steps 8 to 11.

14 Click on the:

• Adjacencies tab button to view connection information for ISIS interfaces
• Statistics tab button to view statistics.

15 Click on the OK button to save the changes.

16 Close the form.

RSVP
The RSVP hello protocol detects the loss of a neighbor node or the reset of a 
neighbor RSVP state information. In standard RSVP, neighbor monitoring occurs as 
part of the RSVP soft-state model. The reservation state is maintained as cached 
information that is first installed and then periodically refreshed by the ingress and 
egress LSRs.

If the state is not refreshed within a specified time interval, the LSR discards the state 
because it assumes that either the neighbor node has been lost or its RSVP state 
information has been reset.

Procedure 24-23  To configure RSVP parameters

1 You can:

a Choose RSVP from the list of protocols on the Routing Instance configuration 
form and click on the Edit button.

b Click on the RSVP icon in the navigation tree and choose Properties from the 
contextual menu.

The navigation path is Network→Router→Routing Instance→RSVP.

The RSVP routing instance form appears with the General tab button selected.

2 Configure the parameters. They include:

• Administrative State
• Keep Multiplier
• Refresh Time
• Message Pacing
• Max Burst
• Period (milliseconds)

3 Click on the Interfaces tab button to display RSVP-enabled interfaces.

4 Click on the Sessions tab button to display currently active RSVP sessions.

5 Click on the Neighbors tab button to list currently active RSVP neighbors.
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6 Click on the following tab buttons to view information.

• Statistics
• Faults to view alarm information

7 Click on the Apply button to save the changes.

8 Click on the OK button.

Procedure 24-24  To edit RSVP interfaces

1 Click on the Interfaces tab on the RSVP routing instance configuration form.

2 Choose the interface from the list and click on the Edit button.

The RSVP Interface configuration form appears with the General tab button 
selected.

3 Configure the parameters. They include:

• Administrative State
• Description

4 Click on the Protocol Properties tab button.

5 Configure the parameters. They include:

• Hello Interval (milliseconds)
• Subscription Ratio

6 Click on the following tab buttons to view information.

• Neighbors to list currently active RSVP neighbors
• Statistics
• Faults to view alarm information

7 Click on the OK button to save the changes.

8 Close the form.

PIM
The 5620 SAM supports PIM configuration for core router functionality and IP 
services. 

Procedure 24-25  To enable PIM on a router

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to the routing instance icon.
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The navigation path is Network→Router→Routing Instance.

3 Right-click on the routing instance icon and choose Properties from the contextual 
menu. The Routing Instance configuration form appears.

4 Enable PIM:

i Click on the Multicast tab button.

ii Set the PIM Enabled parameter to Enabled.

5 Click on the Apply button to save the changes. The PIM icon appears in the network 
view of the navigation tree.

Procedure 24-26  To configure PIM on a router

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to the PIM icon.

The navigation path is Network→Router→Routing Instance→PIM.

3 Right-click on the PIM icon and choose Properties from the contextual menu. The 
PIM configuration form appears with the General tab button selected, as shown in 
Figure 24-16.
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Figure 24-16  PIM configuration form - General

4 Configure the parameters. They include:

• Administrative State
• Apply To

5 Click on the BootStrap Router tab button.

6 Configure the parameters. They include:

• CBSR Address
• CBSR Priority
• CBSR Hash Mask Length
• CBSR Admin State

7 Click on the Candidate RP tab button.

8 Configure the parameters. They include:

• Administrative State
• C-RP Address
• C-RP Priority
• C-RP HoldTime (seconds)

9 Click on the Add button to add a new entry if required.
24-52 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



24 —  Routing protocol configuration
10 Configure the parameters. They include:

• Group IP Address
• Mask

11 Click on the Group-To-RP tab button.

12 Click on the Static RP tab button.

13 Click on the Add button to add a new entry if required. 

14 Click on the General tab button.

15 Configure the following parameters:

• Static RP IP Address
• RP Override

16 Click on the Static Group-To-RP tab button.

17 Click on the Add button to add a new entry if required. 

18 Configure the parameters. They include:

• Static Group IP Address
• Static Group Mask

19 Save the changes, as required.

20 Click on the Import Policies tab button.

21 Click on the BootStrap Import Policies tab button.

22 Configure the following parameters to filter bootstrap messages and to control the 
flow of bootstrap messages to the routing instance.

• Policy 1
• Policy 2
• Policy 3
• Policy 4
• Policy 5

23 Click on the Join/Prune Import Policies tab button.

24 Configure the following parameters to filter join/prune messages.

• Policy 1
• Policy 2
• Policy 3
• Policy 4
• Policy 5

25 Click on the Register Import Policies tab button.
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26 Configure the following parameters to filter PIM register messages.

• Policy 1
• Policy 2
• Policy 3
• Policy 4
• Policy 5

27 Click on the Export Policies tab button.

28 Click on the BootStrap Export Policies tab button.

29 Configure the following parameters to filter PIM-related export messages.

• Policy 1
• Policy 2
• Policy 3
• Policy 4
• Policy 5

30 If you are configuring PIM for a VPRN routing instance, go to step 34.

31 Click on the SSM Groups tab button.

32 Click on the Add button to add a new entry if required. 

33 Configure the parameters. They include:

• SSM Group IP Address
• SSM Group Mask

34 Click on the Interfaces tab button.

35 Click on the Add button to add a new entry, if required. 

See Procedure 24-27 for information about how to create a PIM interface.

36 Click on the following tab buttons to view and edit information.

• Groups
• Neighbor
• Statistics
• Faults

37 Click on the Apply button to save the changes.

38 Click on the OK button.

Procedure 24-27  To create a PIM interface

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to the PIM icon.
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The navigation path is Network→Router→Routing Instance→PIM.

3 Right-click on the PIM icon and choose Create Interface from the contextual menu. 
The Interface configuration form appears with the General tab button selected.

4 Click on the Select button to specify an interface name.

5 Select a filter or click on the Search button.

6 Choose an interface from the list and click on the OK button. The interface name 
appears.

7 Configure the other General parameters. They include:

• Description
• Administrative State

8 Click on the Behavior tab button.

9 Configure the parameters. They include:

• Hello Interval (seconds)
• Tracking Support
• BSM Check Router Alert
• Improved assert
• Sticky DR
• MultiCast Senders
• Hello Multiplier
• DR Priority
• Operational DR Priority

The Operational DR Priority parameter is configurable when the Sticky DR 
parameter is enabled.

10 Click on the Neighbor tab button, if present, to view and edit information. The 
Neighbor tab is present only when a neighbor PIM interface exists.

11 Click on the Apply button to save the changes.

12 Click on the OK button.

IGMP
The 5620 SAM supports IGMP configuration for core router functionality and IP 
services.

Procedure 24-28  To enable IGMP on a router

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to the routing instance icon.

The navigation path is Network→Router→Routing Instance.
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3 Right-click on the routing instance icon and choose Properties from the contextual 
menu.

The Routing Instance configuration form appears.

4 Enable IGMP.

i Click on the Multicast tab button.

ii Set the IGMP Enabled parameter to Enabled.

5 Click on the Apply button to save the changes. The IGMP icon appears in the 
network view of the navigation tree.

Procedure 24-29  To configure IGMP on a router

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to the IGMP icon.

The navigation path is Network→Router→Routing Instance→IGMP.

3 Right-click on the IGMP icon and choose Properties from the contextual menu. The 
IGMP configuration form appears with the General tab button selected, as shown in 
Figure 24-17.
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Figure 24-17  IGMP configuration form - General

4 Configure the parameters. They include:

• Administrative State
• Query Interval
• Last Member Interval
• Query Response Interval
• Robust Count

5 Click on the SSM Translation tab button.

6 Click on the Add button to add a new entry if required.

7 Configure the parameters. They include:

• Start Mcast Address 
• End Mcast Address 
• Configured Source 

8 Click on the Interfaces tab button.

9 Click on the Add button to add a new entry if required. See Procedure 24-30 for 
information about how to create an IGMP interface.
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10 Click on the following tab buttons to view and edit information.

• Multicast Group/Source
• Statistics
• Faults

11 Click on the Apply button to save the changes.

12 Click on the OK button.

Procedure 24-30  To create an IGMP interface

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Navigate to the IGMP icon.

The navigation path is Network→Router→Routing Instance→IGMP.

3 Right-click on the IGMP icon and choose Create Interface from the contextual 
menu. The Interface configuration form appears with the General tab button 
selected.

4 Click on the Select button to specify an interface name.

5 Select a filter or click on the Search button.

6 Choose an interface from the list and click on the OK button. The interface name 
appears.

7 Configure the remaining General parameters. They include:

• Description
• Administrative State
• Administrative Version

8 Click on the Behavior tab button.

9 Configure the Import Policy parameter.

10 Click on the Static/Group Source tab button.

11 Click on the Add button to add a new entry if required. 

12 Configure the parameters. They include:

• Static Multicast Group 
• Static Source

13 Click on the following tab buttons to view and edit information.

• Multicast Group
• Multicast Group/Source
• Statistics
24-58 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



24 —  Routing protocol configuration
14 Click on the Apply button to save the changes.

15 Click on the OK button.

Procedure 24-31  To configure bridging

1 From the 5620 SAM GUI, choose Network from the navigation tree view selector.

2 Click on an icon that represents a Telco device. The bridge instance icon appears.

3 Right-click on the bridge instance icon and choose Properties from the contextual 
menu. The Bridge form appears with the General tab button selected.

4 Click on the IGMP Snooping tab button. Figure 24-18 shows the Bridging 
configuration form with the IGMP Snooping tab button selected.

Figure 24-18  Bridging configuration form - IGMP Snooping
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5 Configure the following parameters. They include:

• IGMP Snooping
• Last Member Interval
• Query Interval (seconds)
• Response Time (seconds)
• Robustness (packets)
• Query Source IP Zero

You must set the IGMP Snooping parameter to Enabled to create a BTV VLAN and 
when MVR is used in the ring group to which the Telco device belongs.

6 Click on the L2 Network Interfaces tab button. The L2 interfaces list includes ports 
on the Telco device configured as network ports.

Select a port from the list and click on the Edit button to modify the L2 interface port 
parameters, if required.

7 Click on the TLS tab button to configure parameters associated with Telco devices 
that belong to ring groups which deliver L2 VPN services across a VLAN.

8 Configure the parameters. They include:

• TLS Admin Status
• Ethertype
• Jumbo Frame

9 Click on the MVR tab button to configure parameters associated with Telco devices 
that belong to ring groups which deliver BTV services across a VLAN.

10 Configure the parameters.

• MVR Admin Status
• Mode
• Querytime (seconds)

11 Click on the Multicast Groups tab button to list multicast group IP addresses for the 
specified VLAN.

12 Click on the QoS MAC Static tab button to configure a static MAC QoS policy for the 
bridge.

i Click on the Add button. The QoS MAC Static Entry form appears.

ii Configure the following parameters. They include:

• Displayed Name
• Description
• MAC Address
• VLAN ID
• CLI Name
• Priority
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13 Click on the QoS MAC Secure tab button to configure a secure MAC QoS policy for 
the bridge.

i Click on the Add button. The QoS MAC Secure Entry form appears.

ii Configure the parameters. They include:

• Displayed Name
• Description
• MAC Address
• VLAN ID
• CLI Name
• Priority

14 Click on the Faults tab button to view alarms that are related to the bridge instance.

15 Click on the Apply button to save the changes.

16 Click on the OK button to close the form.
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25.1 MPLS configuration overview

The 5620 SAM supports the configuration of MPLS paths and LSPs on managed 
routers, and the provisioning of MPLS paths and LSPs on managed and unmanaged 
devices. 

To configure MPLS-signaled LSPs, you must first create an MPLS path between two 
routers. An LSP can then be created between the two routers and be bound to an 
MPLS path. An LSP-MPLS path binding is called an LSP path. You can configure 
the LSP paths after the MPLS path and the LSP have been associated.

The 5620 SAM supports the configuration of related protocols such as RSVP and 
LDP on managed routers. MPLS uses RSVP to set up traffic engineered LSPs. LDP 
performs label distribution in MPLS networks.

MPLS, RSVP, and LDP are enabled on routing instances on routers. When they are 
enabled, an MPLS, RSVP, or LDP instance is created on the routing instance in the 
network view of the 5620 SAM navigation tree. Various functions can then be 
performed on the instance. For example, Layer 3 interfaces can be assigned to an 
MPLS instance.

Services are transported across a network using service tunnels, which can use GRE 
or MPLS as the underlying transport mechanism. For networks that use MPLS, an 
MPLS mesh and an LSP mesh should be created before you start associating LSPs 
with the service tunnels. LSPs and service tunnels are unidirectional, thus both LSPs 
and service tunnels must be created in both directions.

LSPs can be associated with service tunnels when you configure or modify service 
tunnels. See chapter 26 for more information about service tunnels.

To configure MPLS paths, choose Manage→MPLS Paths from the 5620 SAM main 
menu. To configure LSPs, choose Manage→LSPs from the 5620 SAM main menu. 

See the 7750 SR OS Services Guide for more information about MPLS, LSPs, RSVP, 
and LDP.

25.2 Workflow to configure MPLS

1 Enable MPLS and LDP on routing instances on all routers that will participate in the 
MPLS network. RSVP is enabled by default. When MPLS, LDP, or RSVP is enabled 
on a routing instance, an MPLS, LDP or RSVP instance is created on the routing 
instance.

2 Assign Layer 3 interfaces to MPLS instances and perform additional MPLS interface 
configurations as required.

3 Create a mesh of MPLS paths.

4 Create a mesh of LSPs.

25.3 MPLS menus

Table 25-1 lists the MPLS configuration menus.
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Table 25-1 5620 SAM MPLS menus

25.4 MPLS procedures list

Table 25-2 lists the procedures to configure MPLS and related protocols.

Table 25-2 5620 SAM MPLS procedures list

25.5 MPLS procedures

Use the following procedures to configure MPLS.

Procedure 25-1  To enable MPLS on a routing instance

1 From the 5620 SAM, select Network from the navigation tree view selector.

2 Navigate to a routing instance.

The navigation path is Network→Router→Routing Instance.

3 Right click on a routing instance and choose Properties from the contextual menu.

The Routing Instance form appears.

4 Click on the Protocols tab.

5 Select the MPLS Enabled parameter and the LDP Enabled parameter. RSVP is 
enabled by default and cannot be disabled using the 5620 SAM.

Menu option Task

Manage→LSPs Create and configure LSPs and LSP paths

Manage→MPLS Paths Create and configure MPLS paths

Application→LSP Topology View the LSP topology map

Procedure Purpose

To enable MPLS on a routing instance To enable MPLS on a routing instance

To create MPLS interfaces To assign the MPLS interfaces

To create MPLS paths To configure MPLS paths

To create LSPs To configure LSPs

To configure LSP paths To configure LSP paths

To list MPLS paths To list MPLS paths

To list LSPs To view LSPs

To view the LSP topology map To view the LSP topology map
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6 Click on the Apply button to save the changes.

An MPLS instance is created for the routing instance in the navigation tree.

Procedure 25-2  To create MPLS interfaces

Perform this procedure to create an MPLS interface by assigning a Layer 3 interface to 
an MPLS instance.

Create and configure Layer 3 interfaces prior to performing this procedure. See 
section 23.4 for more information about configuring routers and interfaces.

1 Select Network from the navigation tree view selector.

2 Navigate to the MPLS instance icon.

The navigation path is Network→Router→Routing Instance→MPLS.

3 Right-click on the MPLS icon and choose Create Interface from the contextual menu 
to choose a Layer 3 interface and assign it to the MPLS instance.

The MPLS Interface (Create) form appears.

4 Configure the parameters. 

i Click on the Select button next to the Interface Name parameter to select a 
Layer 3 interface.

The Select Interface form appears. Select an interface from the list and click 
on the OK button.

The interface is added to the Interface panel on the MPLS Interface (Create) 
form.

ii Set the Administrative State parameter to Up or Down.

5 Click on the OK button to save the changes.

The MPLS interface is created and added to the MPLS instance on the navigation 
tree. 

6 To view the interface configuration and configure some additional parameters, right 
click on the newly-created interface in the MPLS icon and choose Properties. The 
MPLS Interface properties form appears with the General tab button selected, as 
shown in Figure 25-1.
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Figure 25-1  MPLS Interface properties form - General

7 Configure the General parameters.

• Description
• Administrative State

8 Click on the Administrative Groups tab button and assign or unassign MPLS 
administrative groups to the interface. After you assign administrative groups to an 
MPLS interface, the total value of the groups is displayed in 32 bit mask format in 
the Administrative Groups: Groups Included parameter of the General tab.

9 Click on the following tab buttons to view information.

• In Labels
• CrossConnects 
• Out Labels
• Statistics
• Faults to view alarm information

10 Click on the Apply button to save changes, if required.

11 Click on the OK button to close the form.
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Procedure 25-3  To create MPLS paths

1 Select Manage→MPLS Paths from the 5620 SAM main menu. The Manage MPLS 
Paths filter form opens.

2 Click on the Create button. The Create MPLS Path form opens, as shown in 
Figure 25-2.

Figure 25-2  Create MPLS Path form - Name the MPLS Path step

Configure the parameters. They include:

• Name
• Description

3 Click on the Next button. The Define Source Site... form opens.

4 Define the source site using the Starting Network Element parameter. Specify a 
managed device by entering an IP address. You can also specify a managed device 
by clicking on the Select button and selecting a device from the list.

Click on the Next button. The Define Provisioned Path... form opens.

5 Define the provisioned path by inserting hops. The source site IP address is 
indicated, and the destination site is None by default. You can insert hops for the 
destination, if required.

i Click on the Insert Hop button. The Hop for New Tunnel form opens.

ii Specify a managed or unmanaged device by choosing the Specify Site: 
Manually parameter, and specifying the IP Address parameter.
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You can also specify a managed router by choosing the Specify Site: By 
Selection parameter by clicking on the Select button, and choosing a managed 
device for the Network Element parameter or the IP Address parameter.

iii Specify whether you want the hop type to be strict or loose by setting the Hop 
Type parameter. 

When you choose strict, LSPs must take a direct path from the previous hop 
device to the destination device. When you choose loose, the LSP can 
traverse other devices.

iv Click on the Apply button to save the configuration or click on the OK button to 
save the configuration and close the insert hop form. When you close the form, 
the hops appear in a list in the MPLS path configuration form. 

To add additional hops, click on the Insert Hop button. To change the hop 
sequence, choose a hop and click the Move Up or Move Down button. The first 
hop in the list is the first hop. The last hop in the list in the destination site, and 
is indicated in the Destination Site and Destination IP Address parameters.

Click on the Next button. The Set Initial State form opens.

6 Set the Administrative parameter for the MPLS path.

7 Click on the Finish Button to save the configuration. An operational message is 
displayed and you are prompted to view the MPLS path.

8 Select the check box to view the MPLS path configuration.

9 Click on the Close button. The MPLS Path form opens displaying information about 
the newly created path.

Procedure 25-4  To create LSPs

Create and configure a mesh of MPLS paths prior to performing this procedure.

1 Choose Manage→LSPs from the 5620 SAM main menu. The Manage LSP Paths 
form opens.

2 Click on the Create button. The Create LSP - Identification form opens as shown in 
Figure 25-3.
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Figure 25-3  Create LSP form - Identification step

Configure the parameters. They include:

• Name
• Description
• ID
• Auto-Assign ID

3 Click on the Next button. The Define Source Site... form opens. Configure the 
parameters.

i Click on the Source Site ID parameter Select button and choose a source 
device from the list. You can also manually specify an IP address.

ii If required, click on the Source Site IP Address parameter Select button and 
choose a source interface. You can also manually specify an IP address.

4 Click on the Next button. The Define Destination Site... form opens. 

5 Click on the Destination Site ID parameter Select button and choose a destination 
device from the list. You can also manually specify an IP address. The LSP must 
terminate on the system interface, whose IP address is the same IP address as that 
of the device.
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6 Click on the Next button. The Add MPLS Paths... form opens. 

i Set the Tunnel Destination Matching parameter to Destination Site or None.

ii Click on the Add button. The MPLS Path Wizard form opens.

iii Configure the Type parameter.

iv Click on the Next button. The Choose MPLS Path form opens. Choose an 
MPLS path to associate with the LSP. You can also create an MPLS Path by 
clicking on the Create MPLS Path button.

v Click on the Next button. The Set Traffic Options form opens.

vi Configure the parameters. They include:

• Reserved Bandwidth (Mbps)
• Inherit Value
• Hop Limit
• Record Actual Path

vii Click on the Next button. The Set Initial States form opens.

viii Configure the Administrative parameter.

ix Click on the Finish button.

The LSP path association form closes and the LSP path opens in the LSP path 
list in the Create LSP form. To configure additional LSP path parameters, 
choose the LSP path and click the Edit button. See Procedure 25-5 for more 
information about configuring LSP path parameters.

x Choose an LSP path from the list.

7 Click on the Next button. The Set Initial State form opens. 

Configure the Administrative parameter.

8 Click on the Finish Button to save the configuration. 

9 The 5620 SAM prompts you to view the LSP. Select the check box and click on the 
Close button in the Create LSP form to view the Manage LSP Paths form with a list 
of LSPs. You can select an LSP from the list and click on the Edit button. A dynamic 
LSP properties form opens, as shown in Figure 25-4.
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Figure 25-4  LSP properties form - General

10 Click on the General tab and configure the parameters. They include:

• Description
• Preference
• Administrative

11 Click on the Properties tab button.

12 Configure the Fast Reroute parameter.
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When you set the parameter to True, additional parameters appear.

i Configure the fast reroute parameters. They include:

• Backup Type
• Hop Limit
• Reserved Bandwidth (Mbps)
• Node Protect

ii Configure the additional LSP parameters. They include:

• Hop Limit
• Make Before Break
• Enable CSPF
• Retry Timer (seconds)
• Retry Limit
• RSVP Reserve Style
• Include ADSPEC in RSVP

13 Click on the Administrative Groups tab button and assign or unassign MPLS 
administrative groups to be included or excluded for the LSP.

14 After you assign administrative groups to an LSP, the total value of the groups is 
displayed in 32 bit mask format and the Administrative Groups: Groups Included 
and the Administrative Groups: Groups Excluded parameters of the General tab.

15 Click on the following tab buttons to view information.

• SDP Bindings
• Subscribers
• Service Tunnels
• RSVP Sessions
• CrossConnects
• LSP Paths
• Tests (for OAM diagnostics as described in chapter 39)
• Statistics
• Faults (to view alarm information)

16 Click on the OK button to save changes and close the form.

Procedure 25-5  To configure LSP paths

An LSP path is an LSP-MPLS path binding.

1 Choose Manage→LSPs from the 5620 SAM main menu. The Manage LSPs form 
appears.

2 Configure the search filter parameters and click on the Search button. A list of LSPs 
is displayed.
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3 From the General tab, choose an LSP and click the on Edit button. The LSP 
properties form appears.

4 Choose the LSP Paths tab button. A list of LSP paths is displayed.

5 Choose an LSP path and click on the Edit button. The LSP paths properties form 
appears with the General tab button selected, as shown in Figure 25-5.

Figure 25-5  LSP Path properties form - General

6 Configure the parameters. They include:

7 Click on the Administrative Groups tab button.

Assign MPLS administrative groups to be included or excluded for the LSP path, 
and you can unassign MPLS administrative groups.

After you assign administrative groups to an LSP path, the total value of the groups 
is displayed in 32 bit mask format and the Administrative Groups: Groups Included 
and the Administrative Groups: Groups Excluded parameters of the General tab.

• Hop Limit
• Inherit Value
• Record Actual Path
• Administrative

• Reserved Bandwidth (Mbps)
• Record Label
• Resignal
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8 Click on the Tests tab button. The supported test type tab buttons appear. See 
chapter 39 for more information about performing OAM tests.

9 Click on the following tab buttons to view information.

• Provisioned Path to view the LSP path
• Actual Path
• CPSF Path
• Faults to view alarm information

10 Click on the Apply button to save the changes, as required.

11 Click on the Topology View button to view the LSP path map, as required.

12 Close the form.

Procedure 25-6  To list MPLS paths

1 Choose Manage→MPLS Paths from the 5620 SAM main menu. The Manage MPLS 
Paths form appears.

2 Configure the search filter parameters.

3 Click on the Search button.

A list of MPLS paths is displayed.

You can create, edit, remove, turn up, or shut down MPLS paths, as required.

Procedure 25-7  To list LSPs

1 Choose Manage→LSPs from the 5620 SAM main menu. The Manage LSPs form 
appears.

2 Configure the search filter parameters.

3 Click on the Search button.

A list of LSPs is displayed.

You can click on the General and Properties tab buttons to view details about the 
LSP, or you can create, edit, remove, turn up, or shut down LSPs, as required.

Procedure 25-8  To view the LSP topology map

1 Choose Application→LSP Topology from the 5620 SAM main menu. The LSP 
Topology Filter form appears.
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2 Configure the filter parameters to specify the topology information required.

3 Click on the OK button.

The LSP topology map appears.
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26.1 Service tunnel overview

Distributed VLL service and VPLS traffic is transported between edge-managed 
routers by circuits aggregated in unidirectional service tunnels. Service tunnels 
originate on a source router and terminate on a destination router, which directs 
packets to the correct service egress access interface. 

The operational theory of a service tunnel is that the encapsulation of the data 
between the two managed edge routers appears like a Layer 2 path to the service data 
although it is really traversing an IP or IP/MPLS core. 

Service tunnels, also called SDPs, are not used for local VLL service or VPLS 
because the same router is the source and destination router.

Service tunnels can be configured to use GRE or MPLS. In the case of MPLS, a mesh 
of MPLS paths and LSPs must first be created in the network core. Service tunnels 
can then be associated with LSPs during service tunnel configuration or 
modification. In the case of GRE, the 5620 SAM can automatically create service 
tunnels between sites in the following case:

• GRE is the transport type
• no other service tunnel is available between the source and destination devices

Tunnel configuration for a VLL service or VPLS should be performed before you 
configure the service. If GRE transport is planned, the 5620 SAM automatically 
creates service tunnels if no tunnel currently exists. The tunnel, which is identified 
on a router by a unique ID, is bound to a service when you configure the service.

The 5620 SAM supports service tunnel configuration using a sequence of 
configuration forms and steps. For 5620 SAM to automatically create a tunnel, use 
the appropriate service configuration forms, such as a VLL or VPLS configuration 
form, and set the transport type to GRE. To create a service tunnel, choose 
Manage→Service Tunnels from the 5620 SAM main menu and click on the Create 
button. Figure 26-1 shows the Create Service Tunnel (SDP) form with the Name & 
Describe Service Tunnel (SDP) parameters displayed.
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Figure 26-1  Create Service Tunnel (SDP) form - Name & Describe Service Tunnel (SDP) step

 When you configure a service tunnel, consider the following:

• Service tunnels must be created in both directions: from the source edge router to 
a destination edge router, and from the destination edge router back to the source 
edge router.

• The tunnel is not specific to any one service or any type of service. Once a tunnel 
is created, multiple service circuits can be aggregated over the tunnel. The 
aggregated circuits can belong to different services and different subscribers.

• When a tunnel already exists, 5620 SAM will not automatically create a new 
tunnel, even if the only available tunnel is down. This prevents the creation of 
multiple broken tunnels.

• All services that are mapped to a tunnel use the same transport encapsulation type 
defined for the tunnel (either GRE or MPLS).

• Operations on the tunnel affect all the services that are associated with the tunnel. 
For example, the operational and administrative state of a tunnel controls the state 
of service circuits that are carried on the tunnel. In the case of LSP-based tunnels, 
an LSP can be replaced in the tunnel without reconfiguring each service or circuit 
carried by the tunnel.

• The tunnel is locally unique to a participating router. The same tunnel ID can 
appear on other routers.

• A tunnel uses the system IP address to identify the far-end edge router.

See the 7750 SR OS Services Guide for more detailed information about service 
tunnels.

26.2 Service tunnel menus

Table 26-1 lists and describes the 5620 SAM service tunnel menus.
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Table 26-1 Service tunnel menus

26.3 Service tunnel procedures list

Table 26-2 lists the procedure necessary to configure service tunnels.

Table 26-2 Service tunnel procedures list

26.4 Configuring service tunnels procedures

Procedure 26-1 describes how to configure service tunnels.

Procedure 26-1  To configure service tunnels

1 Choose Manage→Service Tunnels from the 5620 SAM main menu. The Manage 
Service Tunnels search form opens.

2 Configure a filter and search for existing service tunnels, as required.

3 Click on the Create button. The Create Service Tunnel (SDP) form opens, as shown 
in Figure 26-2.

Menu item Description

Application→Service Tunnel Topology View a map of the service tunnels that are 
managed by the 5620 SAM

Manage→Service Tunnels Create and manage service tunnels

Procedure Purpose

To configure service tunnels Create a service tunnel

To list service tunnels List service tunnels

To view the service tunnel topology map View a map of the service tunnels that are 
managed by the 5620 SAM

To manage service tunnels Manage service tunnels, for example, to change 
the configuration of an existing tunnel or set up 
and run OAM tests.
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Figure 26-2  Create Service Tunnel (SDP) form - Name & Describe Service Tunnel (SDP) step

4 Configure the parameters. They include:

• Name
• Description
• Auto-Assign ID
• ID

5 Click on the Next button. The Pick Source Node form opens.

Pick Source Node. Specify a source node by entering the IP address for the Source 
Site ID parameter. Alternately, you can click on the Select button and choose a 
source node from the Select Network Element list.

6 Click on the Next button. The Pick Destination Node form opens.

Specify a destination by entering the IP address for the Destination Site ID 
parameter. Alternately, you can click on the Select button and choose a destination 
node from the Select a Network Element list.

7 Click on the Next button. The Specify Transport form opens.

a Specify GRE for the Underlying Transport parameter. Go to step 10.

b Specify MPLS for the Underlying Transport parameter.

When you specify MPLS as the Underlying Transport parameter value, the Ldp 
Enabled parameter is configurable.

8 Click on the Next button.

9 If the Underlying Transport parameter value in step 7 is set to MPLS, the Associate 
LSPs form opens. Click on the Add button and follow the steps to bind LSPs to the 
service tunnel.
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10 Click on the Next button. The Specify Hello Parameters form opens.

11 Configure the parameters. They include:

• Keep-alive Enabled
• Hello Time
• Hello Request Timeout
• Max Drop Count
• Hello Message Length
• Hold Down Time 

12 Click on the Next button. The Specify Initial State form opens.

13 Configure the following parameters. They include:

• Administrative
• Administrative MTU

14 Click on the Finish button to save the configuration.

The 5620 SAM prompts you to view the service tunnel configuration.

15 Select the check box to view the service tunnel configuration.

16 Click on the Close button.

The 5620 SAM displays the service tunnel configuration.

To view the service tunnel map, choose Application→Service Tunnel Topology from 
the 5620 SAM main menu.

Procedure 26-2  To list service tunnels

1 Choose Manage→Service Tunnels from the 5620 SAM main menu. The Service 
Tunnel Manager form appears.

2 Configure the list filter parameters. 

3 Click on the Search button.

A list of service tunnels appears.

You can edit, remove, turn up, or shut down service tunnels, as required.

Procedure 26-3  To view the service tunnel topology map

1 Choose Application→Service Tunnel Topology from the 5620 SAM main menu. The 
Service Path Topology form appears.

2 Configure the map filter parameters.
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3 Click on the OK button.

The service tunnel topology map appears. See section 37.1 for more information 
about the service tunnel topology map.

Procedure 26-4  To manage service tunnels

1 Choose Manage→Service Tunnels from the 5620 SAM main menu. The Manage 
Service Tunnels form appears

2 Configure the search filter parameters and click on the Search button. A list of 
service tunnels is displayed.

3 Choose a service tunnel from the list and click on the Edit button. The tunnel 
properties form appears with the General tab displayed.

4 From the appropriate tab buttons, change the parameter configurations.

Click on the following tab buttons to view information or set diagnostics.

• Tests, for OAM diagnostics, as described in chapter 39
• Maintenance
• LSPs
• Circuits
• Subscribers
• Services
• Statistics
• Faults, to view alarm information

5 Save the changes and close the form.
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27.1 Service management overview

The 5620 SAM supports the configuration of the following network services:

The benefits of the 5620 SAM service model include:

• end-to-end service management on the 5620 SAM using configuration forms and 
a navigation tree. An example of the navigation tree is shown in Figure 27-1.

• the linking of services to create composite services that support complex 
subscriber applications

• template-based creation of policies that specify the classification, policing, 
shaping, and marking of traffic handled by the managed devices. Policies can be 
used by multiple services.

• traffic management capabilities to customize the delivery of different services 
according to the most stringent SLAs

• closely integrated fault-management capabilities
• the capability to make changes to a single service component (such as a service, 

service site, tunnel, circuit [service-tunnel binding], or interface) rather than 
multiple ports on multiple devices

• tunnel configurations and transport that are independent of the services that they 
carry

Figure 27-1  Navigation tree - service management form

• VLL service 
• VPLS / MVPLS / HVPLS
• IES
• VPRN service

• VLAN service
• composite service
• service mirror
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For distributed VLL service and VPLS, devices are deployed at the provider edge. 
Customer traffic is fed into the service via access interfaces. Traffic is transported 
across IP/MPLS-provider core networks in unidirectional service tunnels that are 
created using GRE or MPLS LSPs. Many services can use the same tunnel. 
Figure 27-2 shows a sample distributed VLL service.

You can also configure a local VLL service or a local VPLS. A local VLL service 
consists of two access interfaces on the same node. A local VPLS consists of multiple 
access interfaces on the same node.

Figure 27-2  Sample distributed VLL service

Figure 27-3 shows a sample distributed VPLS.

Figure 27-3  Sample distributed VPLS
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For IES, the managed devices are deployed at the provider edge and customer traffic 
enters the service via access interfaces. IES is a routed connectivity service where the 
subscriber communicates with an IP router interface to send and receive Internet 
traffic. Figure 27-4 shows a sample IES.

Figure 27-4  Sample IES

For VPRN services, the managed devices can be deployed as PE or provider core 
routers. Data and distribution of routing information are forwarded across an 
IP/MPLS service provider core network. Figure 27-5 shows a sample VPRN service.

Figure 27-5  Sample VPRN service
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27 —  Service management, triple play, QoS, and HQoS
VLAN ring groups are used to send traffic across an Ethernet ring using copper or 
fiber optic connections from the source traffic device, for example, a 7450 ESS, to 
all devices in the ring. Automatic STP configuration on the Telco devices ensures 
that there is a constant stream of traffic in either direction. Any breaks in the physical 
links between Telco devices are rerouted. Figure 27-6 shows a sample VLAN for L2 
VPNs.

Figure 27-6  Sample VLAN configuration for L2 VPNs

A composite service allows the interconnection of different service types to form a 
service delivery network that is tailored to a specific application. For example, 
VPRN, VPLS, and VLAN services can be joined to create a routed multicast TV 
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surveillance purposes.
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Depending on the encapsulation type, a physical port or channel can have more than 
one access interface associated with it. Using encapsulation or a SONET/SDH 
channel, devices can support multiple services for a subscriber or for multiple 
subscribers.

Access interfaces can only be created on ports or channels that are designated as 
access in the physical port configuration. Access interfaces cannot be created on 
ports designated as core-facing network ports because these ports have a different set 
of features enabled in software.

Access interfaces can participate in policies. Configuration of access interfaces can 
be performed during service configuration or modification. When you configure an 
access interface, consider the following:

• An access interface is owned by and associated with the service in which it is 
created.

• An access interface is a local entity and is locally unique to a given device. The 
same access interface ID value can be used on another device.

• There are no default access interfaces. All access interfaces must be created.
• The default administrative state for an access interface at creation time is 

administratively enabled. 
• If a port or channel is shut down (either administratively or operationally), access 

interfaces on that port/channel will be operationally out of service.

Lightweight SAPs

SAPs that are associated with residential split horizon groups on VPLS sites are 
called lightweight SAPs. An RSHG uses dual-pass queue optimization and does not 
support downstream broadcast or multicast traffic. Lightweight SAPs have fewer 
internal configuration settings than regular SAPs. Therefore, you can create more 
lightweight SAPs on a node. The SAP Lightweight property is automatically set at 
creation time, when the SAP is associated with an RSHG, and cannot be modified 
later.

Users can: 

• assign SAPs to residential split horizon groups
• list lightweight SAPs using the Lightweight filter property

27.2 5620 SAM and the triple play service delivery architecture

The TPSDA is based on three major components, as shown in Figure 27-7:

• broadband service aggregator
• broadband service router
• service and policy activation

Note —  To get the most recent state of a lightweight SAP, it is 
recommended that users perform a resynchronization by clicking on 
the Resync button in the SAP configuration window. 
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Figure 27-7  TPSDA components

Table 27-1 lists the Alcatel TPSDA product components.

Table 27-1 Product components of the TPSDA
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Product Role Notes

5620 SAM Provides network, service, and policy 
management across the TPSDA architecture, 
including a unified interface for element 
management and simple service activation and 
monitoring.

Create and configure QoS, filtering, and 
accounting templates that can then be reapplied 
to multiple L2 and L3 interfaces, and configure 
managed BSA and BSR devices to allow DHCP 
relay.

5750 SSC Provides centralized control of subscriber 
access services for triple play service delivery, 
for example, as a DHCP server to identify 
subscribers and trigger service configuration or 
on-demand service profile changes made by the 
customer. Interworks with the 5620 SAM to 
enable per-customer QoS and bandwidth 
changes in the network.

Provide a customer self-service web portal and 
manage subscriber information that determines 
the levels of service allowed for a subscriber.

7750 SR BSR Support per-service and per-content type 
differentiation of QoS levels and supports 
distribution of multicast traffic.

7450 ESS BSA Aggregate traffic from DSLAMs and other FTTx 
access devices that are connected to end-user 
subscriber residential gateways.
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DSLAMs or other access nodes are connected to Ethernet access ports on the 
broadband service aggregator. Typically, a single VLAN for each subscriber is set 
up between the access node and the BSA. This a configuration enables the 
application of consistent per-subscriber policies, such as QoS, filtering, and 
accounting, to be applied on the BSA.

Scaling of traffic and services is done by dividing L2 and L3 functions between the 
BSA and the BSR. The BSA aggregates traffic over Gigabit Ethernet ports and 
performs per-subscriber service queueing, scheduling, accounting and filtering, as 
described later in this chapter. The BSR terminates L2 access and routes over 
IP/MPLS with support for all protocols, including multicasting. QoS can be applied 
using 5620 SAM policy management.

Interconnectivity between BSAs and BSRs is provided by VPLS. VPLS instances 
can be automatically established using hub-and-spoke or ring topologies. Both can 
be configured and sites added to the VPLS using the 5620 SAM. Regardless of the 
fiber plant layout, VPLS enables a full mesh between all sites that are receiving and 
distributing customer traffic in the TPSDA, ensuring efficient transport and 
protection from node or fiber failures.

VPLS also provides mechanisms for traffic security, including residential split 
horizon groups in which direct user bridging is prohibited; ARP and broadcast 
suppression; DHCP-populated MAC and IP address filtering to prevent denial or 
service and theft of service using DHCP snooping, and RADIUS or TACACS+ 
authentication.

Service differentiation and QoS

This TPSDA approach provides a model based on call admission for video and VoIP, 
with the need to guarantee delay, jitter, and loss characteristics once the service 
connection is accepted. The architecture also meets the different QoS needs of HSI, 
namely per-subscriber bandwidth controls, including shaping and policing functions 
that have little or no value for video and VoIP service delivery.

In conjunction with the architecture's support for content differentiation, this 
approach enables differentiated service pricing within high-priority data packages, 
also known as HSI. The distribution of QoS policy and enforcement across BSA and 
BSR allows the service provider to implement meaningful per-subscriber service 
level controls. Sophisticated and granular QoS in the BSA allows the service 
provider to deliver truly differentiated IP services differentiation based on the 
subscriber as well as on the content.

In the BSR to BSA downstream direction, IP services rely on IP layer classification 
of traffic from the network to queue traffic appropriately towards the BSA. Under 
extreme loading (only expected to occur under network fault conditions), lower 
priority data services and/or HSI traffic will be compromised in order to protect 
video and voice traffic. Classification of HSI traffic based on source network address 
or IEEE 802.1p marking allows the QoS information to be propagated to upstream 
or downstream devices.

The BSR performs service distribution routing based on guarantees required to 
deliver the service and associated content, rather than on individual subscribers. The 
BSR only needs to classify content based on its forwarding class for a given BSA to 
ensure that traffic for each service receives the appropriate treatment towards the 
BSA.
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Figure 27-8 shows the downstream QoS configurations.

Figure 27-8  TPSDA downstream QoS configurations

In the BSA-to-BSR upstream direction, traffic levels are substantially lower. 
Class-based queuing is used on the BSA network interface to ensure that video traffic 
is forwarded with minimal delay and that preferred data or HSI high-priority data 
traffic services receive better treatment than for best-effort Internet traffic. The IP 
edge device (BSR) therefore does not need to enforce per-subscriber policies for 
hundreds of thousands of users. This function is distributed to the BSAs, and the 
per-subscriber policies can be implemented on the interfaces directly facing the 
access nodes.

The BSA is capable of scheduling and queuing functions on a per-service, 
per-subscriber basis, in addition to performing wire-speed packet classification and 
filtering based on both L2 and L3 interfaces. In addition to per-service rate limiting 
for Internet services, service traffic for each subscriber can be rate-limited as an 
aggregate using a bundled service policy created using the 5620 SAM. These 
functions allow different subscribers to receive different service levels 
independently and simultaneously.

Figure 27-9 shows the upstream QoS configurations.
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Figure 27-9  TPSDA upstream QoS configurations

When a home-subscriber client device, such as a residential gateway or a set-top box 
in the customer’s home, starts up, it requests network information, including the 
required IP address from a DHCP server. Figure 27-10 shows IP address assignment. 
See chapter 18 for more information about the role of 5750 SSC as a DHCP server. 
See Table 27-2 for more information about DHCP configuration options in the 
TPSDA.
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Figure 27-10  DHCP IP address assignment in the TPSDA

Table 27-2 lists the TPSDA features that you can configure using the 5620 SAM.

Table 27-2 TPSDA features
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Feature and use Notes Reference

Split horizon groups

For the TPSDA, there can be no user-to-user 
communication in the BSA; instead, all 
communication is done through the BSR. This 
residential bridging is done using split horizon 
groups, which ensures that traffic from different 
SAPs in the same service are not forwarded to 
other SAPs or spokes.

Traffic arriving on a spoke service tunnel or SAP 
within the split horizon group is not copied to 
other SAPs or spoke service tunnels. Traffic is 
copied to SAPs and spokes in other split horizon 
groups existing within the same service, such as 
a VPLS.

See chapter 31 for 
configuration of 
split horizon 
groups.

DHCP

(1 of 3)
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For the TPSDA, home-subscriber client devices, 
such as a residential gateway, SIP phone, or 
set-top box, use DHCP to obtain IP address and 
other network configuration information.

The client device sends a DHCP discover 
message to request an IP address. The 
sequence of events is shown in Figure 27-10.

Information added to the DHCP discover 
requests may include information added by the 
FTTx access node or the BSA, for example, the 
shelf, slot, port, VPI, VCI, or other identifier of the 
subscriber.

You can use the 5620 SAM to configure DHCP 
relay on the first IP interface in the upstream 
direction. The BSA or BSR relays the message to 
a DHCP server. The gateway (residential 
gateway) IP address indicates to the DHCP 
server which subnet an IP address should be 
allocated in for that subscriber.

See the 
appropriate 
service 
configuration 
chapter, as DHCP, 
option 82, and 
DHCP relay are 
configured at the 
service level.

DHCP relay

DHCP discover messages are broadcast packets 
that typically would not leave the IP subnet. 
DHCP relay agents are used to intercept the 
requests and forward them as unicast messages 
to a DHCP server.

DHCP request messages from subscribers are 
usually sent from the FTTx access node, with 
information appended to uniquely identify the 
residential gateway, either by MAC address of 
the residential gateway or by an option 82 string 
identifier that indicates the device, port type, 
rack, shelf, slot, port, and VLAN ID or VPI/VCI of 
the circuit connected to the residential gateway.

The DHCP relay agent sets the GIADDR in the 
packet to the IP address of the ingress interface 
(SAP).

You must configure the BSA and BSR devices as 
DHCP relay agents when the DHCP requests are 
going to be forwarded to a DHCP server, or a 
5750 SSC configured as a DHCP server.

The maximum DHCP relay packet size is 1500 
bytes.

See the 
appropriate L3 
service (IES and 
VPRN) or L2 
service (VPLS) 
configuration 
chapter.

See the 5750 SSC 
Service Manager 
User Guide and 
chapter 18 for 
more information 
about configuring 
the 5750 SSC as a 
DHCP relay agent.

DHCP lease state table

The BSA maintains the identities of hosts that are 
allowed network access for each SAP on each 
service.

The lease state information is collected by 
snooping DHCP acknowledge messages on the 
SAP, using DHCP snooping.

Entries in the DHCP lease state table remain 
valid for the duration of the IP address lease.

See chapter 21.

Feature and use Notes Reference

(2 of 3)
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BTV multicast

This section describes, through the use of examples, how the 5620 SAM can be used 
to configure and manage the delivery of BTV multicast traffic streams.

Optimizing for broadcast TV means implementing multicast packet replication 
throughout the network. Multicasting improves the efficiency of the network by 
reducing the bandwidth and fiber needed to deliver broadcast channels to the 
subscriber. A multicasting device can receive a single copy of a broadcast channel 
and replicate it to any downstream device that require it, thus substantially reducing 
the required network resources. This efficiency becomes increasingly important 
closer to the subscriber.

Multicast routing overview

Multicast routing delivers source traffic to multiple receivers without any additional 
burden to the source or the receivers, as is the case with increased bandwidth 
requirements in a unicast environment.

DHCP snooping

The BSA can copy DHCP packets and inspect 
them to help secure the system. For example, if 
malicious user A sends an IP packet requesting 
a video stream intended for user B. Any return 
packets sent to user B could jam B’s connection.

Use the 5620 SAM to configure DHCP for two 
purposes:

• Insert Option 82 information when the 
system is not configured for DHCP relay by 
enabling DHCP snooping on the SAP closest 
to the subscriber.

• Build a DHCP lease stable table by enabling 
snooping on the service tunnel nearest the 
network egress and on the SAP closest to 
the subscriber.

See the 
appropriate 
service chapters 
for configuration of 
the lease populate 
and snooping 
parameters.

Option 82

The DHCP relay option allows managed devices 
to append information to the DHCP request that 
identifies where the DHCP request originated. 
You can also independently insert Option 82 
information when DHCP snooping is enabled on 
a VPLS SAP.

The Option 82 information can be:

• The DHCP Option 82 string circuit ID value 
associated with the 7330 ISAM FTTN, or 
other ISAM family of nodes in the form 
ssc(SSL-7330-1 atm 1/1/04/06:8.35).
The device port_type rack/shelf/slot/port: 
VPI:VCI identifier on the 7330 ISAM FTTN 
indicates that this is the connection 
configured for subscriber use, which is 
connected to the subscriber’s residential 
gateway.

• The DHCP Option 82 string remote ID value 
associated with the 7330 ISAM FTTN, or 
other ISAM family of nodes in the form 
ssc(remote ID).

Using Option 82, you can identify either:

• the circuit ID (service tunnel binding) that is 
unique to the device relaying the circuit

• the remote ID (MAC address) of the host at 
the far end of the circuit

The maximum DHCP relay packet size is 1500 
bytes. If adding Option 82 information to the 
packet causes the packet to exceed 1500 bytes, 
the DHCP relay request is forwarded without 
including the Option 82 information.

See the 
appropriate 
service 
configuration 
chapter. For 
DHCP option 82 
information 
inserted because 
of 5750 SSC 
DHCP server 
authentication, 
see chapter 18.

Feature and use Notes Reference

(3 of 3)
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Multicast routing is based on an arbitrary group of receivers that expresses an interest 
in receiving a particular data stream. The group does not have physical 
boundaries—the hosts can be located anywhere on the Internet. The hosts must join 
the group using IGMP in order to receive the data stream.

A multicast-enabled device, such as a switch or router, distributes a data stream to 
multiple receivers. Multicast packets are replicated in the network by routers that are 
enabled with PIM, which results in the efficient delivery of data to multiple receivers 
using less bandwidth. 

1 A switch or router distributes a data stream to multiple receivers, such as 
mulitcast-enabled PE switches or routers.

2 The multicast-enabled switch or router replicates the data stream, when required, 
and transmits a copy to each downstream switch or router in the multicast tree.

3 Each client receives the data stream it has subscribed to from the downstream 
switch or router.

The NEs involved in delivering BTV multicast streams are first preconfigured 
through CLI for discovery and management by 5620 SAM. After discovery, routing 
protocols are applied to the NEs using 5620 SAM. Routing, QoS, and network queue 
policies are then created. On some devices, multicast package and ACL filter policies 
are created. These policies are applied to NEs during service creation through 
5620 SAM.

Content delivery

BTV source traffic consists of one IP multicast stream per broadcast channel. As a 
multicast stream enters the core network, it is directed by PIM to the RP, which 
replicates the multicast traffic to all DRs that have requested the particular multicast 
stream. DRs distribute the multicast stream directly to set-top receivers or through an 
M-VPLS to BTV VLAN rings to which customer set-top receivers are connected. 
Multicast streams are forwarded only to those set-top receivers that have requested 
them through IGMP and are entitled to them as subscribers.

Content management

Multicast package policies on some devices define the available multicast addresses 
(BTV channels) for subscribers in a BTV network. Typically, a root package policy 
which includes all BTV channels associated with a 5620 SAM subscriber service is 
created. Subsets of the root policy are then created as BTV content packages to which 
end customers can subscribe. ACL filter policies on CE devices ensure that only the 
channels to which an end customer has subscribed are delivered to the customer 
set-top receiver.

PIM

PIM uses a mechanism called Reverse Path Forwarding (RPF) to correctly forward 
multicast packets down a distribution tree. PIM does not build an independent 
multicast routing table, or send and receive multicast routing updates between 
routers. PIM uses any unicast routing protocol that populates the unicast routing 
table, such as OSPF, BGP, or static routes, and is, therefore, IP protocol independent.
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RPF uses the existing unicast routing table to determine the upstream sources of 
multicast streams. PIM forwards a multicast packet only if it is received on an 
upstream interface that is associated with a source. This RPF check assures that there 
are no loops in the distribution tree.

PIM uses a multicast domain to group receiver hosts on a router called the 
rendezvous point (RP). A bootstrap router (BSR) elects an RP from available 
candidates. The BSR manages RP information, disseminates it to all PIM routers in 
the multicast domain, and elects a new RP in the case of RP unavailability.

A receiver host becomes a member of a multicast domain by sending an IGMP join 
request for a multicast stream to a PIM designated router (DR). If the router does not 
currently receive the multicast stream, PIM updates the DR routing table with the 
receiver host IP address and requests the multicast stream from the RP. The RP adds 
the router to the distribution tree. Packets sent to the multicast IP address are 
propagated down the distribution tree to the receiver host. DRs use the RP as the 
source for a multicast stream unless a source with a lower path cost is available. 

PIM stops sending a multicast stream to a router when it determines that there are no 
active receiver hosts for the multicast stream in that branch of the distribution tree.

IGMP

IGMP is used to dynamically register individual hosts in a multicast group on a 
particular LAN. Hosts identify group memberships by sending IGMP messages to 
their local multicast router. Routers listen to IGMP messages and periodically send 
out queries to discover which groups are active or inactive on a particular subnet.

BTV multicast configuration examples
Figure 27-11 shows a simple BTV network and three methods of content delivery, 
examples A, B, and C. The sequence of specific configuration steps for each example 
follows general device, network and multicast configuration information common to 
all examples.

Device preconfiguration

A network device requires CLI preconfiguration before it can be managed by the 
5620 SAM. The primary CLI preconfiguration actions for a device are:

• Assigning a system ID to the device
• Enabling and configuring SNMP on the device
• Enabling Telnet access on the device

See chapter 2 and the specific device documentation for more information about 
enabling device functionality before using the 5620 SAM.
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Figure 27-11  BTV multicast delivery examples

After CLI preconfiguration, further actions are required:
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See chapter 9 for more information about device discovery and management using 
5620 SAM.

Network preconfiguration

The core network shown in Figure 27-11 represents a fully meshed group of devices. 
For simplicity, only the devices relevant to the BTV multicast examples are shown. 
Network preconfiguration consists of the following sequence of actions:

1 Configure network devices for in-band or out-of-band management. See 
chapter 10 for more information.

2 Configure a system interface on each device to serve as the identifier for the 
device. See chapter 23 for more information.

3 Configure network interfaces on each router to establish a full mesh of 
interconnectivity between devices. In Figure 27-11 the interfaces to be 
configured are PE A, ports 1/1/1, 2/2/2, 3/3/3, and 4/4/4; DR 1, port 2/2/2; RP, 
ports 1/1/1, 2/2/2, and 4/4/4; and DR 3, ports 1/1/1 and 4/4/4. See chapter 23 for 
more information.

4 Cable the network-interface ports between routers in the core network to 
establish the physical connectivity shown in Figure 27-11.

5 Use CLI ping commands to check IP connectivity between devices. See the 
device documentation for more information.

6 Enable IGPs such as RIP, OSPF, or ISIS on devices according to network size 
and complexity. See chapter 24 for information about enabling routing protocols.

7 Enable an inter-AS routing protocol such as BGP or OSPF to PE routers, if 
required. See chapter 24 for more information.

8 Create routing policies as required. Create one multicast group for each BTV 
multicast destination address during policy creation. See chapter 23 for more 
information.

9 Configure routing protocols and apply routing policies as required. See 
chapter 24 for more information.

10 Configure LDP and MPLS, if required. See chapter 24 for information about 
configuring LDP. See chapter 25 for information about configuring MPLS.

• Enable MPLS and LDP on the routing instance of each device that is participating 
in the MPLS network.

• Assign a Layer 3 interface to the MPLS instance on each MPLS-enabled device.
• Create a mesh of MPLS paths.
• Create a mesh of LSPs.
• Use the 5620 SAM to create MPLS administrative groups, and assign the groups to 

MPLS interfaces and LSP paths as required.

Multicast configuration common to all examples

The network connections shown between PE A and DR 1 and between PE A and DR 
3 represent redundant multicast routes used by PIM in the event of an RP failure. 
PIM dynamically adjusts to BSR or RP failure by electing a replacement BSR or RP 
or by using a previously defined backup BSR or RP. PIM chooses the most 
appropriate source for a multicast stream based on path cost and source availability 
and bypasses the RP if a better source for a multicast stream is found.
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For simplicity, Figure 27-11 does not show routes to PE C (DR 2) from DR 1 or DR 
3. As shown, PE C (DR 2) is isolated from multicast traffic in the event of RP failure.

Network multicast configuration common to all three examples involves the 
following sequence of actions:

1 Enable IGMP on routers DR 1, PE C (DR 2), and DR 3. See Procedure 24-28 for 
more information.

2 Configure IGMP on routers DR 1, PE C (DR 2), and DR 3. See Procedure 24-29 
for more information.

3 Enable PIM on routers PE A, RP, DR 1, PE C (DR 2), and DR 3. See 
Procedure 24-25 for more information.

4 Configure PIM on routers PE A, RP, DR 1, PE C (DR 2), and DR 3. See 
Procedure 24-26 for more information.

• Specify PE A as the candidate bootstrap router.
• Specify RP as the candidate rendezvous point. You can also specify it as a static RP 

for a multicast domain, if there are multiple BTV domains, and configure a second 
router as a redundant RP.

• Specify IES as the Apply to parameter value on routers PE A, DR 1, PE C (DR 2), 
and DR 3.

5 Create PIM interfaces at PE A, ports 1/1/1, 2/2/2, 3/3/3, and 4/4/4; RP, ports 
1/1/1, 2/2/2, 3/3/3 and 4/4/4; DR 1, ports 2/2/2 and 3/3/3; DR 2, port 1/1/1 and 
DR 3, ports 4/4/4 and 5/5/5. See Procedure 24-27 for more information.

6 Create QoS, scheduling, and accounting policies for the ingress BTV traffic. See 
chapter 28 for more information.

7 Create an IES from PE A, port 1/1/1, to the BTV multicast provider's network. 
See Procedure 32-1 for more information.

• Enable PIM on the IES SAP during IES creation.

Example A configuration

In Example A, IGMP join requests from subscribers ingress a VPLS SDP. IGMP 
snooping on the VPLS registers the join requests on the local switch. The switch 
sends the requests over the VPLS, which is physically cross-connected to an IGMP- 
and PIM-enabled IES SAP on the DR. PIM on the DR requests the desired multicast 
stream, if not present, from the RP. The requested stream then traverses the VPLS 
and is sent to subscribers.

1 Configure PE B, port 1/1/1 and DR 1, port 4/4/4 as network ports. See 
Procedure 21-8 for more information.

2 Configure PE B, port 2/2/2 and DR 1, port 1/1/1 as access ports. See 
Procedure 21-8 for more information.

3 Cable DR 1, port 3/3/3, and PE B, port 1/1/1 to establish physical connectivity.

4 Configure DR 1, port 5/5/5 as an access port. See Procedure 21-8 for more 
information.

5 Create an IES on DR 1, port 5/5/5. See Procedure 32-1 for more information.

• Enable IGMP on the IES SAP during IES creation.
• Enable PIM on the IES SAP during IES creation.
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6 Connect a cable between ports 1/1/1 and 5/5/5 on DR 1 as a service cross 
connect.

7 Create QoS, scheduling, filter, and accounting policies to apply to egress BTV 
traffic during service creation. See chapter 28 for information on policy creation.

8 Create a distributed VPLS with endpoints at PE B, port 2/2/2 and DR 1, port 
1/1/1. See Procedure 31-1 for more information.

• Enable IGMP snooping on the VPLS SDP at PE B, port 2/2/2.
• Apply previously defined QoS, scheduling, filter, and accounting policies to the 

VPLS SDP at PE B, port 2/2/2.

Example B configuration

In Example B, an IGMP join request ingresses an IES SAP on the DR. PIM on the 
DR requests the desired multicast stream, if not present, from the RP. The requested 
stream is then delivered over an IES to a subscriber.

1 Configure PE C (DR 2), ports 2/2/2, 3/3/3, and 4/4/4 as access ports. See 
Procedure 21-8 for more information.

2 Create QoS, scheduling, filter, and accounting policies to apply to egress BTV 
traffic during IES creation. See chapter 28 for information on policy creation.

3 Create IES services on PE C (DR 2), ports 2/2/2, 3/3/3, and 4/4/4 that terminate 
on the CE set-top devices. See Procedure 32-1 for more information.

• Enable IGMP on each IES SAP during IES creation.
• Apply previously defined QoS, scheduling, filter, and accounting policies to each 

IES, as required.

Example C configuration

In Example C, IGMP join requests from subscribers pass over an MVR VLAN to an 
VPLS. IGMP snooping on the VPLS registers the join requests on the local switch, 
which passes them over the VPLS to a spoke SDP on the DR. The spoke SDP's port 
is physically cross-connected to an IGMP- and PIM-enabled IES SAP on the DR. 
PIM on the DR requests the desired multicast stream, if not present, from the RP, 
then sends the stream over the VPLS and MVR VLAN to subscribers.

1 Create a BTV MVR VLAN of L3 switches, such as Telco devices, in a ring 
group with endpoints on Switch A, ports 2/2/2 and 3/3/3. See section 34.3 and 
Procedure 34-1 for more information. For redundancy, the MVR VLAN can be 
configured with endpoints on different switches. A VLL between the two 
switches acts as an unbreakable connection.

2 Enable and configure IGMP snooping on the bridge instances for the L3 switches 
included in the MVR VLAN. See “Bridging on Telco Devices” in section 24.1 
for related information specific to Telco devices, or refer to the specific device 
documentation if the L3 switch a type not managed by the 5620 SAM.

3 Create QoS, scheduling, filter, and accounting policies to apply to egress BTV 
traffic during service creation. See chapter 28 for information on policy creation.
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4 Configure the following as network ports:

• Switch A, ports 1/1/1, 2/2/2, and 3/3/3
• Switch B, ports 1/1/1 and 2/2/2
• Switch C, ports 1/1/1, 2/2/2, 3/3/3 and 4/4/4

See Procedure 21-8 for more information.
5 Create a distributed VPLS consisting of Switch A, Switch B, and Switch C. See 

Procedure 31-1 for more information.

• Apply previously defined QoS, scheduling, filter, and accounting policies to the 
VPLS SDPs.

• Enable and configure IGMP snooping on the VPLS SDPs that are part of the MVR 
VLAN.

• Ensure that the encapsulation value of the VPLS SDPs that are part of the MVR 
VLAN matches the MVR VLAN ID.

• Create a split horizon group during VPLS creation to allow later addition of a spoke 
circuit to the VPLS.

• Configure STP on the VPLS, as required.
6 Configure DR 3, port 2/2/2 as an access port. See Procedure 21-8 for more 

information.

7 Create an IES on DR 3, port 2/2/2. See Procedure 32-1 for more information.

• Enable IGMP on the IES SAP during IES creation.
• Enable PIM on the IES SAP during IES creation.

8 Connect a cable between ports 1/1/1 and 2/2/2 on DR 3 as a service cross 
connect.

9 Create a VPLS spoke SDP at DR 3, port 1/1/1. See Procedure 31-3 for more 
information.

27.3 QoS and HQoS overview

QoS provides the ability to rate limit across multiple queues from one or more access 
interfaces for a customer, and to differentiate service levels for different types of 
traffic. For higher priority traffic such as VoIP or video, you can specify reserved 
bandwidth. Lower priority applications, such as data traffic, may not have reserved 
bandwidth but can burst to use all the available bandwidth.

The main elements of QoS are:

• QoS markings
Customer traffic may be marked with QoS markings, such as DSCP, EXP, and 
dot1p, that are mapped to forwarding classes.
All forwarding classes support profile marking of packets as in-profile or 
out-of-profile. In-profile packets have a high enqueuing priority. Out-of-profile 
packets have a low enqueuing priority. Profile marking of packets can occur at 
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two points: when packets are classified into forwarding classes at access ingress 
and when packets are classified at service egress. Profile marking is only done on 
the internal header and not in an actual encapsulation.

• forwarding classes
Provide network elements with a method to weigh the relative importance of 
packets, only in relation to other forwarding classes. A forwarding class is also 
referred to as a Class of Service.

• queues
Location for buffering packets that are to be forwarded before they are scheduled.

• schedulers
Hardware scheduling (or single-tier scheduling) exists by default on a device and 
consists of a high-priority and a low-priority scheduler.
Scheduler policies (or multi-tier scheduling) provide a more complex, 
hierarchical structure of virtual schedulers that override the default hardware 
behavior for more flexible scheduling capabilities.

• slope policies
Define the WRED slope characteristics of hardware buffer space that is used by 
the ingress and egress queues

See chapter 28 for more information about policies on the 5620 SAM. See the 
7750 SR OS Services Guide for more detailed information about QoS.

27.4 Implementing QoS workflow

Planning and configuration

1 Perform network planning activities:

i Determine the required types of services or applications (For example, voice, 
video, and data).

ii Review SLAs.

iii Perform traffic engineering activities at the IP/MPLS core level to ensure that 
resources are available.

2 Configure IP and MAC ACL filters, as required.

3 Configure the slope policies.

i Configure the high slope parameters.

ii Configure the low slope parameters.

iii Configure the TAF (weight) parameter.

4 Configure the scheduler policies. Scheduler policies can be shared between ingress 
and egress policies, depending on your specific requirements.

5 Create the aggregation schedulers, if required.
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6 Configure the access ingress policies.

i Configure the forwarding classes.

ii Configure the queues.

iii Map QoS markings on ingress packets to the forwarding classes.

iv Map forwarding classes to the queue definitions.

v Map queue definitions to the scheduler policies.

7 Configure the access egress policies.

i Configure the queues.

ii Map forwarding classes to the queue definitions.

iii Map queue definitions to the schedulers policies.

8 Configure the network policies.

i Configure for ingress:

• Map QoS markings on ingress packets to the forwarding classes.
• Map forwarding classes to the queue definitions.

ii Configure for egress:

• Configure remarking, if required.
• Map QoS markings to the forwarding classes, if required.

9 Configure the network queue policies.

• Configure the queue parameters.
• Queue-to-forwarding class mapping is pre-defined and is not configurable.

Application of policies and schedulers to equipment and interfaces

10 Associate the slope policies with ports or daughter cards.

11 Associate the network queue policies with MDAs.

12 Assign the aggregation schedulers at the interface level, if required.

Configuration of subscribers and services

13 Configure the subscribers.

14 Create the subscriber services, and assign policies during the configuration.
27-22 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



27 —  Service management, triple play, QoS, and HQoS
27.5 5620 SAM QoS and HQoS policies

Policies group and manage the various QoS elements used to determine how traffic 
is routed.

• access ingress policies
Specify how QoS marking is interpreted, how subscriber traffic is mapped into 
queues, and how queues are classified.

• access egress policies
Specify how subscriber traffic is mapped into queues, specify queue 
classification, queue parameters, and QoS marking.

• network policies
Specify QoS marking to forwarding class mapping on ingress and QoS marking 
to forwarding class mapping on egress.

• network queue policies
Specify CIR, PIR, and burst sizes for each queue. Forwarding class to queue 
mapping is not configurable.

• scheduler policies
Specify custom settings and a hierarchical structure of virtual schedulers to 
replace the default hardware schedulers on the device.

• slope policies
Specify WRED settings to customize how in-profile and out-of-profile traffic is 
processed in hardware buffers, applied to daughter cards or ports.

• ATM QoS policies
Specify ATM QoS settings to customize ATM traffic parameters including 
service category and shaping. 

Figure 27-12 shows where QoS policies are applied at the service level.
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Figure 27-12  Service-level view of policies

Figure 27-13 shows where policies are applied on a device with respect to access and 
network ingress and egress traffic.

Figure 27-13  Types of traffic on a device and applied policies
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Access ingress policies

Access ingress policies are applied to access interfaces and specify QoS 
characteristics on ingress. Participation in access ingress policies is defined when 
access interfaces are configured or modified. Access ingress policies include:

• mapping of QoS marking, such as dot1p, DSCP, and precedence, and IP/MAC 
address information to forwarding classes

• forwarding class definitions and mapping to queues
• queue definitions and mapping to schedulers

Figure 27-14 shows the access ingress policy elements.

Figure 27-14  Access ingress policy elements
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ingress policies.
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Figure 27-15  Access egress policy elements
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Figure 27-16  Network and network queue policy elements on ingress

Figure 27-17 shows the sequence of how the elements of network and network queue 
policies are applied at egress.

Figure 27-17  Network and network queue policy elements on egress
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Scheduling

Scheduling defines the order and method for how packets which are enqueued in 
different queues, are dequeued. Ingress schedulers control the data transfer between 
the queues and the switch fabric. Egress schedulers control the data transfer between 
the egress queues and the switch fabric. Packets are not actually forwarded to 
schedulers, but are forwarded from the queues directly to ingress and egress 
interfaces. Participation in scheduler policies is defined when access interfaces are 
configured or modified. There are two types of scheduling:

• Single-tier scheduling is the hardware-based default method for scheduling 
queues on the device. There are no configurable parameters for single-tier 
schedulers. When a scheduler policy is not specified for an access interface, rate 
limiting is specified by the values specified in the queue and scheduling is 
performed by the default hardware scheduler on the device. Single-tier 
scheduling consists of a pair of scheduling priority loops in the 7750 SR and bases 
scheduling on the CIR and the PIR set in the queue policy. One loop is for 
scheduling high-priority (in-profile) traffic, and the other loop is for low-priority 
(out-of-profile) traffic.

• Virtual hierarchical (multi-tier) scheduling can provide more flexible scheduling 
for access ingress and egress interfaces, and determine how queues are scheduled. 
They are defined using a Scheduler policy, and can be configured to override 
default hardware scheduling. You can create up to three tiers of virtual 
schedulers.
Aggregation schedulers are used to share a scheduler policy across a number of 
ports or daughter cards. This can be useful when a number of ports or cards are 
dedicated to the same subscriber. See “Scheduler policies” in section 28.2 for 
more information about configuring aggregation schedulers.

Slope policies

Slope policies manage how shared buffers are utilized on the SR. When traffic is 
queued, the WRED slope parameters in the slope policy determine how the traffic is 
buffered for dequeuing, as shown in Figure 27-18.
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Figure 27-18  Slope policy characteristics

All queues are in contention for shared buffer space when they exceed their CBS, and 
can use their MBS, when space is available in the shared buffer space. The WRED 
parameters determine whether a packet is discarded or not, and, as a result, determine 
whether the packet is dequeued. When the shared buffer space exceeds or approaches 
the maximum percentage defined by the WRED configuration, packets are 
discarded.

By using two independent slope policy configurations, one for in-profile traffic and 
one for out-of-profile traffic, you can configure in-profile traffic to receive 
preferential treatment over out-of-profile traffic.

See “Slope policies” in section 28.2 for more information about configuring slope 
policies.

27.6 Sample network configuration using QoS

Figure 27-19 shows a sample service configuration using QoS.
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Figure 27-19  Sample service configuration using QoS

In this configuration, the following services are provisioned:

• Service 1: IES for Internet access, which requires a CIR of 10 Mb/s and a PIR of 
100 Mb/s

• Service 2: VLL service for FTP connectivity between Site A and Site B, which 
requires a CIR of 10 Mb/s and a PIR of 20 Mb/s

• Service 3: VPLS for video-conference service over sites A, B, and C, which 
requires a CIR of 20 Mb/s and a PIR of 50 Mb/s

• Service 4: VPLS for voice traffic, which requires a CIR of 10 Mb/s and a PIR of 
20 Mb/s

The cumulative rate at site A needs to be limited to 70 Mb/s.
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The following high-level steps are required to create the Figure 27-19 configuration 
with rate limiting using QoS at Site A. Similar steps are required to configure QoS 
for Subscriber 1 on Sites B and C:

1 Configure a scheduler policy.

2 Create Subscriber 1.

3 Create the aggregation scheduler for Subscriber 1 on site A and assign ingress 
and egress scheduler policies to the aggregation scheduler. 

4 Create IES, VLL, and VPLS for Subscriber 1.

• Specify sites for the services.
• Specify access interfaces for the sites.
• Specify the aggregation scheduler policy for the access interfaces.
• Bind the services to tunnels for transport through the IP/MPLS network.

Access interfaces 1/1/1:100, 1/1/1:101, 1/1/1:102, and 1/1/2:101 participate in the 
aggregation scheduler and are usually rate limited by the rate specified in the 
scheduler policy.

Access interface 1/1/2:333 does not participate in scheduler policy; rate limiting is 
specified by the queue values.

If one of the access interfaces does not participate in the scheduler aggregator, it may 
be managed by a separate scheduler policy. 

27.7 Sample HQoS configuration for use by a service SAP

You can use 5620 SAM HQoS configuration to enforce traffic rate limiting, based 
on the priority of the traffic entering the ingress SAP of a service. This configuration 
limits bandwidth, to ensure that SLAs are met and higher priority traffic is processed 
first.

Figure 27-20 shows traffic of different priorities from a customer site to an ingress 
SAP.

Figure 27-20  Sample ingress traffic to a service SAP
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Based on the example, use the 5620 SAM client GUI to perform the following 
actions:

• Configure a parent HQoS scheduler that handles scheduling for a child scheduler.
• Add a root tier 1 scheduler
• Add one child tier 2 scheduler with the root scheduler as a parent

• Create an access ingress policy named Premium service access ingress policy.
• Create 4 queues within the access ingress policy, one for each type of traffic from 

the customer site.
• Associate each queue with a forwarding class
• Classify the incoming customer site traffic to a forwarding class. For this sample, IP 

precedence is used to classify traffic. You could classify traffic other ways, for 
example, based on filters for IP address or DSCP marking.

• Associate each queue with the appropriate scheduler.
• Apply the schedulers and access ingress policy to the appropriate L2 or L3 

interface for the customer service, for example, a VPLS L2 interface.

Figure 27-21 shows how traffic is handled based on the ingress access policy and 
scheduler queue handling applied to the ingress service SAP.
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Figure 27-21  HQoS traffic handling based on ingress access policy and scheduler queue handling

In this sample:

• higher-priority video traffic, with IP precedence bit 3 set, goes into queue 4 with 
a PIR of 1000 Kb/s and a CIR of 100 Kb/s. This traffic is handled by the tier 1 
scheduler. The levels and weights associated with the video queue (forwarding 
class of ef, level of 6, PIR/CIR weights of 50/50) ensure this traffic gets all 
required bandwidth.

• all other traffic goes into its appropriate queues, based on the mapping of the IP 
precedence bit with the forwarding class.

• The voice, high-priority data, and Internet queues are serviced by the tier 2 
scheduler.

• Because the voice and high-priority data queues have higher PIR/CIR weight than 
the Internet queue, when there is contention for bandwidth, the voice and 
high-priority data queues are processed first.
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Procedure 27-1  To configure HQoS for a service SAP

You must have:

• the service ingress SAP configured as access
• all necessary cabling and network routing protocol configurations complete to 

handle routing packets to and from the CPE equipment

1 Choose Policies→QoS→Scheduler from the 5620 SAM main menu. The manage 
scheduler policies form appears.

2 Click on the Create button. The scheduler policy create form appears.

3 Configure the parameters. Set the displayed name to HQoS Scheduler

4 Click on the Schedulers tab button.

5 Click on the Add button. The scheduler entry form appears.

6 Create a root, tier 1 scheduler entry,

i Configure the parameters.

• Displayed name to root
• tier to 1
• Summed CIR to false
• PIR (kbps) to 1000
• CIR (kbps) to 1000

ii Click on the OK button. The root scheduler appears in the list of scheduler 
entries.

7 Create a child, tier 2 scheduler entry.

i Click on the Add button.

ii Configure the parameters.

• Displayed name to child
• tier to 2
• Summed CIR to false
• PIR (kbps) to 1000
• CIR (kbps) to 200
• Parent scheduler to root, using the Select button to choose root from the 

list.
• Level (PIR level) to 4
• Weight (PIR weight) to 50
• CIR Level to 4
• CIR Weight to 50

iii Click on the OK button. The child scheduler appears in the list of scheduler 
entries.

8 Click on the Apply button. Figure 27-22 shows the two scheduler entries under the 
Schedulers tab button.
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Figure 27-22  Two scheduler entries for HQoS Scheduler

9 Close the Scheduler form.

10 Choose Policies→QoS→Access Ingress from the 5620 SAM main menu. The 
manage access ingress policies form appears.

11 Click on the Create button. The access ingress policy create form appears.

12 Configure the parameters. Set the displayed name to Premium service access 
ingress policy.

13 Click on the Queues tab button. Create four queues. For this sample, default queue 
1 is modified, and three new queues are added. The default multicast queue 11 is 
unchanged.

14 Select queue 1 from the list.

i Click on the Edit button. The queue 1 edit form appears.

ii Configure the parameters.

• Displayed Name to Internet
• Scheduler to child by using the Select button and choosing child from the 

list
• Level (PIR level) to 4
• CIR Level to 4
• Weight (PIR weight) to 33
• CIR Weight to 0

Figure 27-23 shows the completed queue 1 form from the General tab button.
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Figure 27-23  Queue 1 form - General

iii Click on the CIR/PIR tab button.

iv Configure the parameters.

• deselect both MAX buttons
• Cir (kbps) to 0
• Pir (kbps) to 1000

Figure 27-24 shows the completed queue 1 form from the CIR/PIR tab button.
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Figure 27-24  Queue 1 form - CIR/PIR

v Click on the OK button.

15 Add queue 2.

i Click on the Add button. The queue create form appears.

ii Configure the parameters.

• ID to 2
• Displayed Name to High-priority traffic
• Scheduler to child by using the Select button and choosing child from the 

list
• Level (PIR level) to 4
• CIR Level to 4
• Weight (PIR weight) to 33
• CIR Weight to 50

iii Click on the CIR/PIR tab button.

iv Configure the parameters.

• deselect both MAX buttons
• Cir (kbps) to 100
• Pir (kbps) to 1000

v Click on the OK button. The queue is added to the list.
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16 Add queue 3.

i Click on the Add button. The queue create form appears.

ii Configure the parameters.

• ID to 3
• Displayed Name to Voice
• Scheduler to child by using the Select button and choosing child from the 

list
• Level (PIR level) to 4
• CIR Level to 4
• Weight (PIR weight) to 33
• CIR Weight to 50

iii Click on the CIR/PIR tab button.

iv Configure the parameters.

• deselect both MAX buttons
• Cir (kbps) to 100
• Pir (kbps) to 1000

v Click on the OK button. The queue is added to the list.

17 Add queue 4.

i Click on the Add button. The queue create form appears.

ii Configure the parameters.

• ID to 4
• Displayed Name to Video
• Scheduler to root by using the Select button and choosing root from the list
• Level (PIR level) to 6
• CIR Level to 6
• Weight (PIR weight) to 50
• CIR Weight to 50

iii Click on the CIR/PIR tab button.

iv Configure the parameters.

• deselect both MAX buttons
• Cir (kbps) to 100
• Pir (kbps) to 1000

v Click on the OK button. The queue is added to the list.

18 Figure 27-25 shows the four queues added to the Premium service access ingress 
policy. The fifth queue is the default multicast queue.
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Figure 27-25  Queues added to the Premium service access ingress policy

19 Click on the Apply button to save the changes. Confirm the action.

20 Associate each queue with a forwarding class. 

i Click on the Forwarding Classes tab button.

ii Click on the Add button. The forwarding class create form appears.

iii Configure the parameters.

• Forwarding class to be
• Queue ID to 1. This is the best-effort Internet traffic queue.

iv Click on the OK button. Confirm the action.

v Click on the Add button. The forwarding class create form appears.

vi Configure the parameters.

• Forwarding class to af
• Queue ID to 2. This is the high-priority data traffic queue.

vii Click on the OK button. Confirm the action.

viii Click on the Add button. The forwarding class create form appears.

ix Configure the parameters.

• Forwarding class to l1
• Queue ID to 3. This is the voice traffic queue.

x Click on the OK button. Confirm the action.

xi Click on the Add button. The forwarding class create form appears.

xii Configure the parameters.

• Forwarding class to ef
• Queue ID to 4. This is the highest priority, video traffic queue.

xiii Click on the OK button. Confirm the action.

Figure 27-26 shows the list of forwarding classes and associated queues.
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Figure 27-26  Forwarding class and queue list

21 Click on the Apply button. Confirm the action.

22 Associate the IP precedence bits of the incoming customer traffic with the 
forwarding class. The forwarding class is already associated with a queue. For this 
sample, IP precedence bits are used to associate different types of traffic with the 
forwarding class. You could classify traffic other ways, for example, based on filters 
for IP address or DSCP marking.

i Click on the Precedence tab button.

ii Click on the Add button. The precedence create form appears.

iii Configure the parameters to associate IP precedence 0 (Internet traffic from 
the customer site) with forwarding class be (the be forwarding class is 
associated with queue 1)

• Precedence is 0
• Forwarding Class is be

Figure 27-27 shows the precedence form for precedence 0.
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Figure 27-27  Precedence 0 form

iv Click on the OK button. Confirm the action. The association between 
precedence 0 and the be forwarding class is added to the list.

v Click on the Add button. The precedence create form appears.

vi Configure the parameters to associate IP precedence 1 (high-priority data 
traffic from the customer site) with forwarding class af (the af forwarding class 
is associated with queue 2)

• Precedence is 1
• Forwarding Class is af

vii Click on the OK button. Confirm the action. The association between 
precedence 1 and the af forwarding class is added to the list.

viii Click on the Add button. The precedence create form appears.

ix Configure the parameters to associate IP precedence 2 (voice traffic from the 
customer site) with forwarding class l1 (the l1 forwarding class is associated 
with queue 2)

• Precedence is 2
• Forwarding Class is l1

x Click on the OK button. Confirm the action. The association between 
precedence 2 and the l1 forwarding class is added to the list.

xi Click on the Add button. The precedence create form appears.

xii Configure the parameters to associate IP precedence 3 (video traffic from the 
customer site) with forwarding class ef (the ef forwarding class is associated 
with queue 3)

• Precedence is 3
• Forwarding Class is ef

xiii Click on the OK button. Confirm the action. The association between 
precedence 3 and the ef forwarding class is added to the list.

23 Click on the Apply button. Confirm the action. Figure 27-28 shows the list of IP 
precedences associated with forwarding classes.
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Figure 27-28  IP precedences and forwarding class associations

24 Click on the Relations tab button to view the associations between the IP 
precedence bit number, the forwarding class, and the queues. Figure 27-29 shows 
the relationships.
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Figure 27-29  Relationships between precedence, forwarding class, and queues
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25 Associate a service SAP with the created HQoS scheduler and the created 
Premium service access ingress policy. There are many ways to associate policies 
with L2 or L3 interfaces used as service SAPs, for example, from the service 
creation form or the port properties form. This sample modifies an existing L2 
interface for an existing VPLS.

i Choose Manage→Services from the 5620 SAM main menu. The manage 
services form appears.

ii Set the filters and click on the Search button. A list of filtered services appears.

iii Select the service and click on the Edit button. The service form appears.

iv Click on the L2 Access Interfaces tab button.

v Choose an interface and click on the Edit button. The L2 interface edit form 
appears.

vi Click on the QoS tab button.

vii Configure the parameter. Use the Select button to set the Ingress Policy to 
Premium service access ingress policy. The policy ID and displayed name 
appear.

viii Click on the Schedulers tab button.

ix Configure the parameter. Use the Select button to set the Ingress Scheduler 
to HQoS scheduler. The displayed name appears.

x Click on the Apply button to save the changes. Confirm the action. 
Figure 27-30 shows the highlighted L2 interface with the scheduler and access 
ingress policy applied.

Figure 27-30  L2 interface with scheduler and ingress access policy applied
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28.1 Policies overview

The 5620 SAM supports the template-based creation of rules. These rules are called 
policies. The types of policies are:

• service management
• routing management
• network management
• Telco

Policies are global or local. Global policies are policies that are created using the 
5620 SAM. Local policies are instances of global policies that are assigned to 
individual NEs. When you modify a global policy using the 5620 SAM, all local 
instances of the policy on the associated NEs are updated. This ensures that all 
instances of the policy in the network are synchronized. If a local policy differs from 
the corresponding global policy because of changes to the global policy, a warning 
alarm is raised against the local policy. After a global policy is updated and copied 
to all participating NEs, any mismatch alarms against local policies are cleared.

To identify mismatches between local and global policies, you can perform a policy 
audit to compare each local policy instance to the corresponding global policy. If 
there is a mismatch, an alarm is raised against the local policy. Any alarms raised 
during previous audits for which the mismatch condition no longer exists are cleared.

Service management policies specify how service traffic is handled by network 
resources such as interfaces, ports, daughter cards, and circuits. These policies can 
be used by multiple resources on multiple services. Examples of service management 
policies include access ingress, access egress, and network policies.

Routing management policies specify routing configuration according to specifically 
defined parameters. There are two routing management policies: routing policies and 
MPLS administrative group policies.

Service and routing management policies are globally and seamlessly distributed to 
devices when they are used by resources on the device. They can also be manually 
distributed to devices. Subsequent changes to policies are distributed and affect all 
participating resources. Policy configurations can also be changed locally when you 
configure a network resource, for example, during service configuration or 
modification. These changes do not affect the global policy.

Network management policies specify how the 5620 SAM communicates with 
network resources, handles alarms, manages statistics used for billing, and stores 
information. Examples of network management policies include alarm, mediation, 
and accounting policies.

Telco policies specify how the Telco devices are configured and used to provide 
BTV VLAN, L2 VPN VLANs, and super-VLAN Internet services. Examples of 
Telco policies include Multicast Package Policy Manager, Telco ACL IGMP Policy 
Manager, and Telco Node QoS Level Policy Manager.

Table 28-1 describes the policies that are configured using the 5620 SAM. Unless 
otherwise noted in the table, the policies are described in more detail in this chapter.
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Table 28-1 Policies

Policy type Policy Applied to Description Menu option

Service 
management

Access 
Ingress

Access interface Defines ingress classification, policing, 
shaping, and marking on the ingress side 
of the interface.

Policies→QoS→Access 
Ingress

Access 
Egress

Access interface Defines egress classification, policing, 
shaping, and marking on the egress side 
of the interface.

Policies→QoS→Access 
Egress

Network Network interface Defines egress QoS marking and ingress 
QoS interpretation for traffic on core 
network IP interfaces.

Policies→QoS→Network

Slope Access port

Network daughter 
card

Network port

Defines RED slope behavior. Policies→QoS→WRED 
Slope 

Network 
Queue

Network daughter 
card

Network port

Defines the default burst allocations for 
queues based on the queue’s forwarding 
class.

Policies→QoS→Network 
Queue

Shared 
Queue

Network daughter 
card

Defines distribution of traffic over core 
network.

Policies→QoS→Shared 
Queue

Scheduler Access ingress 
interface

Access egress 
interface

Defines hierarchical rate limiting and 
scheduling to govern queue scheduling.

Policies→QoS→Schedul
er

802_1X Ethernet ports Defines the RADIUS server 
authentication policy for Ethernet ports.

Policies→802_1x

ACL IP 
Filter 

Network interface

Access interface

Circuit

Controls network traffic into or out of an 
interface or circuit based on IP matching 
criteria.

Policies→Filter→ACL IP 
Filter

ACL MAC 
Filter 

Access interface

Circuit

Controls network traffic into or out of an 
interface or circuit based on MAC 
matching criteria.

Policies→Filter→ACL 
MAC Filter

ATM QoS Access interface Defines ATM ingress and egress 
classification, policing, shaping, and 
marking.

Policies→QoS→ATM 
QoS

Multicast 
Package

VPLS instances Assigns a common set of multicast 
groups for multiple MVR VLANs 
connected to a VPLS. See chapter 31 for 
more information.

Policies→Multicast 
Package

Routing 
management

Routing Routing instance Manages route policies. See chapter 23 
for more information.

Policies→Routing

Admin 
Group 
(MPLS)

MPLS interfaces

LSPs

LSP paths

Configures MPLS administrative groups 
and defines the groups to which an MPLS 
interface, LSP, or LSP path belongs. See 
chapter 23 for more information.

Policies→ MPLS 
Administration Groups

(1 of 2)
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The 5620 SAM supports the creation and modification of policies using 
configuration forms. For example, Figure 28-1 shows an Access Ingress Policy form 
with the General tab displayed.

Network 
management

Alarm Alarm logs

Alarms

Defines how the 5620 SAM handles 
individual incoming alarms, and how 
alarm logs are created and stored. See 
chapter 38 for more information.

Administration→Alarm 
Settings

File — Manages files on the device. See 
chapter 41 and the 5620 SAM Statistics 
Management Guide for more information.

Policies→File

Accounting Network interface

Access interface

Circuit

Manages accounting policies. See 
chapter 41 and the 5620 SAM Statistics 
Management Guide for more information.

Policies→Accounting

Mediation 5620 SAM Defines how the 5620 SAM 
communicates with the network. See 
chapter 14 for more information.

Administration→
Deployment and Site 
Backup/Upgrade

Poller 5620 SAM Defines how the 5620 SAM polls the 
network. See chapter 9 for more 
information.

Administration→Poller 
Policies

Telco 
management

Multicast 
Package

Broadcast TV 
VLAN services

Defines the set of broadcast channels that 
are multicast across a ring group in a BTV 
VLAN. See chapter 34 for more 
information.

Policies→Multicast 
Package

Telco Node 
QoS Level

Telco devices and 
ports

Defines QoS policies applied to a Telco 
device. See chapter 34 for more 
information.

Policies→QoS→
Telco QoS

Telco ACL 
Standard 
IP

Telco devices and 
ports

Controls network traffic on Telco VLANs 
based on IP address and subnet mask 
matching criteria. See chapter 34 for more 
information.

Policies→Filter→
Telco ACL Standard IP 
Filter

Telco ACL 
Extended 
IP

Telco devices and 
ports

Controls network traffic on Telco VLANs 
based on several IP matching criteria. 
See chapter 34 for more information.

Policies→Filter→
Telco ACL Extended IP 
Filter

Telco ACL 
IGMP

Telco devices and 
ports

Manages how BTV subscribers access 
multicast BTV streams. See chapter 34 
for more information.

Policies→Filter→
Telco ACL IGMP Filter

Telco ACL 
MAC

Telco devices and 
ports

Controls network traffic on Telco VLANs 
based on MAC matching criteria. See 
chapter 34 for more information.

Policies→Filter→
Telco ACL MAC Filter

Policy type Policy Applied to Description Menu option

(2 of 2)
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Figure 28-1  Access Ingress Policy form - General

Policies are applied to resources during service configuration or modification. 
Policies are also applied to resources before or after the service is configured by 
choosing and modifying the resource from the equipment manager or service 
manager forms. Figure 28-2 shows the Create L2 Interface form that appears during 
VLL service creation with the Select Site parameters displayed. Note the steps to 
specify policies for the interface.
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Figure 28-2  Create L2 Interface form - Select Site step

28.2 Service management policies

This section describes the service management policies.

Access ingress policies

Access ingress policies are applied to access interfaces and specify QoS on ingress. 
Figure 28-3 shows an Access Ingress Policy form with the General tab displayed.
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Figure 28-3  Access Ingress Policy form - General

Access ingress policies define ingress service forwarding class queues and map 
flows to those queues. When an access ingress policy is created, it always has two 
queues defined that cannot be deleted: one for the default unicast traffic and one for 
the default multipoint traffic. These queues exist within the definition of the policy. 
The queues only get instantiated in hardware when the policy is applied to an access 
interface. In the case where the service does not have multipoint traffic, the 
multipoint queue will not be instantiated.

In the simplest access ingress policy, all traffic is treated as a single flow and mapped 
to a single queue, and all flooded traffic is treated with a single multipoint queue.

The required access ingress policy elements include:

• a unique access ingress policy ID
• at least one default unicast forwarding class queue 
• at least one multipoint forwarding class queue

The optional access ingress policy elements include:

• additional unicast queues up to a total of 8 for each of the 8 forwarding classes
• additional multipoint queues up to 3 per forwarding class for each type of 

multipoint traffic (broadcast, multicast and destination unknown unicast)
• QoS policy match criteria to map packets to a forwarding class

Each queue can have unique queue parameters to allow individual policing and rate 
shaping of the flow mapped to the forwarding class. Mapping flows to forwarding 
classes is controlled by comparing each packet to the match criteria in the policy.
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There is one default access ingress policy. The default policy gives all traffic equal 
priority with the same chance of being sent or dropped during periods of congestion.

See the 7750 SR OS Services Guide for more detailed information about access 
ingress policies.

Forwarding classes

The 5620 SAM supports the configuration of eight forwarding classes and 
class-based queuing on the 7750 SR. Each forwarding class is only important in 
relation to other forwarding classes. A forwarding class provides network elements 
with a method to determine the relative importance of one packet over another packet 
in a different forwarding class. 

Queues are created for a specific forwarding class to determine how the queue output 
is scheduled into the switch fabric and the type of parameters that the queue accepts. 
The forwarding class of the packet, and the in-profile and out-of-profile states, 
determine how the packet is queued and handled at each hop along its path to a 
destination egress point. Eight forwarding classes are supported. Table 28-2 lists the 
default definitions for the supported forwarding classes.

Although all forwarding classes support profile marking, it is a good network 
engineering practise to ensure that all high priority forwarding classes are in-profile 
(CIR=PIR) and all low priority forwarding classes are out-of-profile (PIR > CIR=0). 
This way, distinguishing packets as in-profile or out-of-profile only occurs for 
assured class types.

Table 28-2 Forwarding classes

Note —  The 5620 SAM supports the configuration of HQoS 
scheduling mechanisms on the 7750 SR. HQoS provides the ability to 
rate limit across multiple queues from either single or multiple access 
interfaces for a given customer. The building blocks for HQoS 
include access ingress, access egress, and scheduler policies.

See section 27.6 for a sample service configuration using HQoS.

Forwarding 
class ID

Forwarding 
class name

Forwarding 
class 
designation

DiffServ 
name

Class 
type

Intended

7 Network 
control

nc nc2 High 
priority

For network control traffic

6 High-1 h1 nc1 For a second network control class or 
delay/jitter sensitive traffic

5 Expedited ef ef For delay/jitter sensitive traffic

4 High-2 h2 h2 For delay/jitter sensitive traffic

3 Low-1 l1 af2 Assured For assured traffic; default priority for network 
management traffic

2 Assured af af1 For assured traffic

1 Low-2 l2 cs1 Best effort For best effort traffic

0 be be
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Forwarding subclasses

You can use forwarding subclasses for additional access ingress packet 
classification. One or more subclasses can be associated with each forwarding class. 
The designations for forwarding subclasses are the same as those for the forwarding 
classes listed in Table 28-2. Each subclass assumes the behavior of its parent 
forwarding class. and in combination with the forwarding class provides a greater 
range of access ingress QoS classification possibilities.

Access egress policies

Access egress policies are applied to access egress interfaces and specify QoS on 
egress. Figure 28-4 shows an Access Egress Policy form with the General tab 
displayed.

Figure 28-4  Access Egress Policy form - General

Access egress policies define egress service queues and map forwarding class flows 
to queues. In the simplest access egress policy, all forwarding classes are treated like 
a single flow and mapped to a single queue. 

The required access egress policy elements include:

• a unique access egress policy ID
• at least one defined default queue. 
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The optional egress policy elements include:

• additional queues up to a total of 8 separate queues for each of the 8 supported 
forwarding classes.

• IEEE 802.1p priority value remarking based on forwarding class.

Each queue in a policy is associated with one or more of the supported forwarding 
classes. Each queue can have its individual queue parameters allowing individual 
rate shaping of the forwarding classes mapped to the queue. More complex service 
queuing models are supported in the 7750 SR where each forwarding class is 
associated with a dedicated queue.

The forwarding class determination per service egress packet is determined at 
ingress. If the packet ingressed the service on the same 7750 SR, the service ingress 
classification rules determine the forwarding class of the packet. If the packet was 
received over a service tunnel, the forwarding class is marked in the tunnel transport 
encapsulation.

There is one default access ingress policy. The default policy gives all traffic equal 
priority with the same chance of being sent or dropped during periods of congestion.

See the 7750 SR OS Services Guide for more detailed information about access 
egress policies.

Network policies

Network policies are applied to network interfaces and specify QoS on egress and 
ingress. Figure 28-5 shows a Network Policy form with the General tab displayed.
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Figure 28-5  Network Policy form - General

On ingress, a network policy maps incoming DSCP and EXP values to forwarding 
class and profile state for traffic received from the core network. On egress, the 
policy maps forwarding class and profile state to DSCP and EXP values for traffic to 
be transmitted into the core network.

See the 7750 SR OS Services Guide for more detailed information about network 
policies.

Network queue policies

Network queue policies are applied to network ports or daughter cards. Figure 28-6 
shows the Network Queue Policy form with the General tab displayed.
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Figure 28-6  Network Queue Policy form - General

Network queue policies determine:

• the default burst allocations for queues based on the queue’s forwarding class
• the CIR, PIR, and burst size parameters for the queue

For network egress, a network burst policy is associated with the network port buffer 
pool. For network ingress, the network burst policy is associated the network ingress 
buffer pool of the daughter card.

Network queue policies support multipoint queues and a variable number of 
forwarding classes. These features are not supported by some devices, including 
7750 SR, Release 2.0 or earlier. If you want to deploy a network queue policy to 
devices of different types, you may need to create an instance of the policy for each 
node type involved. Policies configured for multipoint queues and a variable number 
of forwarding classes are only deployed to devices that support this functionality. 
Modification of an existing policy results in automatic deployment to participating 
nodes, so must be done with consideration of the policy features and devices 
involved.

For example, if you use the 5620 SAM to create a network queue policy that includes 
multipoint queues, or add multipoint queue support to an existing network queue 
policy, a ninth network queue is created. One of the devices on your network is a 
7750 SR, Release 2.0. 7750 SR, Release 2.0 does not support more than eight 
queues, so deployment of the policy to this device does not occur.
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See the 7750 SR OS Services Guide for more information about network queue 
policies.

Slope policies

Slope policies are applied to access ports, network ports, and network daughter 
cards. Figure 28-7 shows a Slope Policy form with the General tab displayed.

Figure 28-7  Slope Policy form - General

Slope policies define weighted RED slope characteristics for buffer pools. 
Low-priority and high-priority slopes are specified when you configure a slope 
policy. If a slope policy is not explicitly specified, a default policy is applied.

Each buffer pool supports a high-priority and a low-priority RED slope. The 
high-priority RED slope manages access to the shared portion of the buffer pool for 
the high-priority or in-profile packets. The low-priority RED slope manages access 
to the shared portion of the buffer pool for low-priority or out-of-profile packets. By 
default, the high-priority and low-priority slopes are disabled.

Note —  A ninth queue is required to deploy a global policy for the 
following devices: 

• 7750 SR Release 2.1 and later 
• 7450 ESS Release 3.0 and later

If there is no ninth queue, then these devices do not appear in the list 
of nodes for deployment when the Distribute button is selected in the 
Network Queue Policy form.

Also note that the ninth queue can only be removed from a global 
policy. The ninth queue cannot be removed from the local policy 
definitions associated with the global policy.
Alcatel 5620 Service Aware Manager, Release 3.0 R1 28-13
October 2005 3HE00214 CA



28 —  Policies
A RED slope is a graph with an X (horizontal) and Y (vertical) axis. The X axis plots 
the percentage of shared buffer utilization, from 0 to 100%. The Y axis plots the 
probability of packet discard marked from 0 to 1. The slope is defined as four 
sections, as shown in Figure 28-8.

Figure 28-8  RED slope characteristics

Section A is (0, 0) to (start-avg, 0). For this part of the slope, the packet discard value 
is always zero, which prevents the RED function from discarding packets when the 
shared buffer average utilization falls between 1 and start-avg.

Section B is (start-avg, 0) to (max-avg, max-prob). This part of the slope is linear 
where packet discard probability increases from zero to max-prob.

Section C is (max-avg, max-prob) to (max-avg, 1). This part of the slope shows the 
instantaneous increase of packet discard probability from max-prob to one. A packet 
discard probability of one results in an automatic discard of the packet.

Section D is (max-avg, 1) to (100%, 1). On this part of the slope, the shared buffer 
average utilization value of max-avg to 100% results in a packet discard probability 
of one. 

See the 7750 SR OS Services Guide for more detailed information about slope 
policies.

Shared queue policies

A shared queue policy can be applied to daughter cards for optional use by SAPs. 
The 5620 SAM provides one shared queue policy which cannot be deleted or 
modified. You cannot create a shared queue policy.

max-avg

max-prob

Average utilization

Probability or
packet discard

start-avg

0% 25% 50% 75% 100%

1

.75

.50

.25

.0

C

B

A

D

17177
28-14 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



28 —  Policies
Scheduler policies

Scheduler policies determine the order in which queues are serviced. All ingress and 
egress queues operate within the context of a scheduler. Multiple queues share the 
same scheduler. Schedulers control the data transfer between the following queues 
and destinations:

• service ingress queues to switch fabric destinations
• service egress queues to access egress ports
• network ingress queues to switch fabric destinations
• network egress queues to network egress interfaces

The are two types of scheduler policies:

• single-tier, in which queues are scheduled based on the forwarding class of the 
queue and the operation state of the queue relative to the queue CIR and PIR

• hierarchical or multi-tier, which allow the creation of a hierarchy of schedules 
where queues or other schedulers are scheduled by superior schedulers

Scheduler policies are applied to access ingress and access egress interfaces. 
Figure 28-9 shows a Scheduler Policy form with the General tab displayed.

Figure 28-9  Scheduler Policy form - General
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Single tier schedulers

Single-tier scheduling is the default method of scheduling queues. Queues are 
scheduled with single-tier scheduler policies when no explicit hierarchical scheduler 
policy is defined or applied. In single-tier scheduling, queues are scheduled based on 
the forwarding class of the queue and the operational state of the queue relative to 
the queue CIR and PIR. 

Hierarchical schedulers

Hierarchical scheduler policies are used for access ingress and access egress queues. 
Hierarchical scheduler policies allow you to create a hierarchy of schedulers where 
queues and other schedulers are scheduled by superior schedulers.

Virtual schedulers are created within the context of a hierarchical scheduler policy. 
A hierarchical scheduler policy defines the hierarchy and parameters for each 
scheduler. A scheduler is defined in the context of a tier. The tier level determines 
the scheduler’s position in the hierarchy. Three tiers of virtual schedulers are 
supported, as shown in Figure 28-10. Tier 1 schedulers are defined without a parent 
scheduler. A scheduler can enforce a maximum rate of operation for all child queues 
and associated schedulers.

Figure 28-10  Hierarchical scheduler and queue association
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802.1X policies
The 5620 SAM implementation of the 802.1X protocol provides 802.1X 
authentication on an individual port basis. 

In an 802.1X environment, a user (the supplicant) requests access to an access point 
(the authenticator).The access point forces the supplicant into an unauthorized state, 
forcing them to send an EAP start message. 

The authenticator returns an EAP message to request the user identity. The user 
returns the identity, which is forwarded by the authenticator to the authentication 
server. The server authenticates the user and returns an accept or reject message to 
the authenticator.

If an accept message is received, the authenticator changes the user state to 
authorized and traffic can be processed.

Filter policies

IP and MAC filter policies, which are also called ACLs, specify a forward or drop 
action for packets based on information specified in the match criteria. You can 
create up to 2000 IP and 2000 MAC filter policies per node. You can create up to 
131 071 entries in each filter policy.

Filter entry matching criteria are either general or specific but all conditions must be 
met for the packet to be considered a match and the specified entry action performed. 
The process stops when the first complete match is found and the action defined in 
the entry is executed.

When an interface or circuit is not configured with a filter policy, all traffic is 
allowed on the ingress and egress interfaces. By default, there are no filters 
associated with services or interfaces. 

There are two types of filter policies:

• ACL IP filter policies
• ACL MAC filter policies

ACL IP filters are applied to network IP interfaces, access interfaces, and circuits. 
Figure 28-11 shows an ACL IP Filter Policy form with the General tab displayed.
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Figure 28-11  ACL IP Filter Policy form - General

ACL MAC filters are applied to access interfaces and circuits. Figure 28-12 shows 
an ACL MAC Filter Policy form with the General tab displayed.
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Figure 28-12  ACL MAC Filter Policy form - General

See the 7750 SR OS Router Guide for more detailed information about filter policies.

ATM QoS policies

ATM QoS policies are used to specify how ATM traffic is managed by using ATM 
traffic descriptors, such as service category and shaping. You can create up to 2000 
ATM QoS policies per router. ATM QoS policies are applied to access interfaces. 

Figure 28-13 shows an ATM QoS Policy form with the General tab displayed.
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Figure 28-13  ATM QoS Policy form - General

Multicast package policies

Multicast package policies are used to configure an MVR VPLS. Multicast package 
policies ensure that the multicast groups on the VPLS sites of one or more MVR 
VPLS are consistent. Multicast groups are distributed as part of the policy to the 
7450 ESS, Release 3.0 or later. A multicast package policy has zero or more 
multicast groups associated with it. Only root catalogue multicast packages are 
distributed to the devices.

A multicast routing policy can also be used to configure multicast groups, but each 
device must be configured individually using the routing policy manager. See 
chapter 23 for more information.

When a multicast package policy is distributed to a device, a routing policy is 
configured on the device with the appropriate multicast prefix list, which is based on 
the multicast groups in the multicast package policy, and the IP address of the source 
of the multicast traffic.

When you distribute a multicast package policy to a 7450 ESS, one multicast 
package policy is mapped to one routing policy entry.

If a multicast package policy is used by any MVR VPLS service, it cannot be 
removed from the 5620 SAM.
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Telco policies

Telco policies are used to:

• create multicast packages that group together BTV multicast streams which can 
be applied to Telco ring groups for distribution to subscribers

• create and apply QoS policies to Telco devices and ports

28.3 Workflow to create policies

1 Create policies as required.

2 Distribute policies. Note that policies do not have to be explicitly distributed — they 
are distributed to a device when assigned to a resource on the device.

3 Assign policies to resources during service configuration or modification.

28.4 Policies menu

Table 28-3 lists and describes the 5620 SAM policies menu options. 

For information about alarm policies, see chapter 38. For information about file and 
accounting policies, see chapter 41. For information about mediation policies, see 
chapter 14.

Table 28-3 Policies menu

Menu item Description

Tools→Policies Audit Audit policies to compare all local policies with 
corresponding global policies.

Policies→QoS→Access Ingress Create service ingress QoS policies to map ingress 
traffic to forwarding class queues. 

Policies→QoS→Access Egress Create service egress QoS policies to map forwarding 
classes to service egress queues.

Policies→QoS→Network Create network policies for ingress and egress to map 
incoming DSCP and EXP values to forwarding class and 
profile state and outgoing traffic from forwarding class 
and profile state to DSCP and EXP values.

Policies→QoS→WRED Slope Create slope parameters for access and network ports, 
and daughter cards.

Policies→QoS→Network Queue Define the default burst allocations for queues based on 
the queue’s forwarding class.

Policies→QoS→Shared Queue Display the default shared queue configuration.

Policies→QoS→Scheduler Create scheduler policies to determine the order in 
which queues are serviced.

Policies→802_1x Create 802.1X server authentication policies for 
Ethernet ports.

(1 of 2)
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28.5 Policies procedures list

Table 28-4 lists the procedures to perform service management policies tasks. 

For information about

• routing and MPLS administrative group policies, see chapter 23.
• alarm policies, see chapter 38.
• file and accounting policies, see chapter 41.
• mediation policies, see chapter 14.
• poller policies, see chapter 9.

Table 28-4 5620 SAM policies procedures list

Policies→Filter→ACL IP Filter Create ACL IP filter policies to set the forward or drop 
action, as defined by the match criteria for incoming 
packets.

Policies→Filter→ACL MAC Filter Create ACL MAC filter policies to set the forward or drop 
action, as defined by the match criteria for incoming 
packets. 

Policies→QoS→ATM QoS Define the traffic parameters for ATM connections.

Policies→Multicast Package Define the set of broadcast channels that are multicast 
across a ring group in a BTV VLAN.

Assign to a VPLS instance a common set of multicast 
groups for multiple MVR VLANs connected to the VPLS.

Policies→QoS→Telco QoS Define QoS policies applied to Telco devices.

Policies→Filter→Telco ACL Standard IP 
Filter

Create ACL filter policies based on IP address and 
subnet mask criteria to set the forward or drop action for 
incoming packets on Telco devices.

Policies→Filter→Telco ACL Extended IP 
Filter

Create ACL filter policies based on complex IP match 
criteria to set the forward or drop action for incoming 
packets on Telco devices.

Policies→Filter→Telco ACL IGMP Filter Define how BTV subscribers access multicast BTV 
streams.

Policies→Filter→Telco ACL MAC Filter Create ACL filter policies based on MAC match criteria 
to set the forward or drop action for incoming packets on 
Telco devices.

Menu item Description

(2 of 2)

Procedure Purpose

To create an access ingress policy Create one or more access ingress policies.

To create an access egress policy Create one or more access egress policies.

To create a network policy Create one or more network policies.

To create a WRED slope policy Create one or more slope policies.

To create a network queue policy Create one or more network queue policies.

(1 of 2)
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28.6 Policies procedures

Use the following procedures to perform 5620 SAM policies tasks.

Procedure 28-1  To create an access ingress policy

1 Choose Policies→QoS→Access Ingress from the 5620 SAM main menu. The 
Manage Access Ingress Policy form opens.

2 Perform one of the following tasks:

To create a scheduler policy Create one or more scheduler policies.

To create an 802.1X policy Create one or more 802.1X policies.

To create an aggregation scheduler Create one or more aggregation scheduler 
policies.

To create an ACL IP filter policy Create one or more ACL IP filter policies.

To create an ACL MAC filter policy Create one or more MAC IP filter policies.

To create an ATM QoS policy Create one or more ATM QoS policies.

To create a multicast package policy Create one or more multicast package policies 
for Telco devices or a 7450 ESS.

To create a Telco node QoS level policy Create one or more QoS policies for Telco 
devices.

To create a Telco ACL standard IP filter policy Create one or more ACL standard IP filter 
policies for Telco devices.

To create a Telco ACL extended IP filter policy Create one or more ACL extended IP filter 
policies for Telco devices.

To create a Telco ACL IGMP filter policy Create one or more Telco ACL IGMP policies for 
Telco devices.

To create a Telco ACL MAC filter policy Create one or more ACL MAC filter policies for 
Telco devices.

To distribute a policy Distribute a policy or policies to a device or 
devices.

To edit a policy Edit a policy or entries within a policy.

To delete a policy Delete a policy or entries within a policy. When 
you delete a policy it is removed from the device 
and 5620 SAM database. 

To copy or overwrite a policy Copy or overwrite a policy.

To synchronize a policy Synchronize a policy or policies across the 
network.

To remove an unassociated policy Remove an unassociated policy or policies from 
a device or devices. The policies remain in the 
5620 SAM database.

To perform a policy audit Compare all local policy instances with their 
corresponding global policies

Procedure Purpose

(2 of 2)
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a Specify a filter to search for and edit an existing policy. Use the filters to search 
for and open an existing policy by choosing a policy in the filtered list and 
clicking on the Edit button.

b Click on the Create button. The Access Ingress Policy (Create) form appears 
with the General tab displayed.

3 Configure the parameters. They include:

• Auto-Assign ID
• Configuration Action
• Displayed Name
• Default FC
• Priority

The packets that are received on an ingress SAP using this policy are classified to 
the specified default forwarding class. See Table 28-2 for more information about 
forwarding classes. 

4 Configure MAC or IP address matching criteria for the policy.

a Click on the MAC Match Criteria tab button to configure the MAC match 
criteria.

i Click on the Add button. The MAC Match form appears.

ii Configure the parameters. They include:

• Forwarding Class
• Frame Type
• Source MAC
• Destination MAC
• Dot1p
• Mask
• Snap Oui
• Snap Pid
• Ether Type

The Source MAC, Destination MAC, Dot1p parameters, and the Mask 
parameter associated with each, are configurable when the check box for 
each parameter is selected.

The Snap Oui and Snap Pid parameters appear only when the Frame 
Type parameter value is e802dot2SNAP.

The Ether Type parameter appears only when the Frame Type parameter 
value is Ethernet II.

iii Click on the OK button to save the changes. The MAC match criteria entry 
is added to the list.

b Click on the IP Match Criteria tab button to configure the IP match criteria.

i Click on the Add button. The IP Match form appears.
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ii Configure the parameters. They include:

• Forwarding Class
• Protocol
• Priority
• Fragment
• Source IP
• Destination IP
• Src Mask
• Dst Mask
• Dscp
• Source Port
• Destination Port

The Source Port and Destination Port parameters appear only when the 
Protocol parameter value is TCP or UDP.

iii Click on the OK button to save the changes. The IP match criteria entry 
is added to the list.

5 Click on the Queues tab button.

The two default queues that cannot be deleted are displayed in the form: the default 
unicast traffic queue (ID 1) and the default multipoint traffic queue (ID 11).

6 Click on the Add button. The Queue form opens with the General tab displayed.

7 Configure the parameters. They include:

• ID
• Multicast
• Scheduler
• Mode
• Expedite
• Policed

To set the queue to multicast, set the multicast parameter to true. To set the queue 
to unicast, set the parameter to false.

8 Click on the CIR/PIR tab button.

9 Configure the parameters. They include:

• Cir (kbps)
• Pir (kbps)
• MAX
• Cir Adaptation
• Pir Adaptation

Ensure that the CIR value is lower than the PIR value.

10 Click on the Burst Size tab button.
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11 Configure the parameters. They include:

• Committed Burst Size (KB)
• Maximum Burst Size (KB)
• High Priority Reserved

The parameters are configurable when the Default check box above each is 
deselected.

Ensure that the Committed Burst Size value is lower than the Maximum Burst Size 
value.

12 Click on the OK button. A confirmation dialog box appears.

13 Click on the OK button to close the dialog box. The Access Ingress Policy (Create) 
form reappears. 

14 To configure additional queues, return to step 6. You can add up to 32 queues. 

15 Click on the Forwarding Classes tab button.

16 Click on the Add button. The Forwarding Class (Create) form opens.

17 You can create one entry for each of the eight forwarding class types. The 
parameters include:

• Forwarding Class
• Queue ID

The parameter must be set to a unicast ID. Set the parameter to 0 if you want 
the default queue ID to be used. The default ID for unicast queues is 1.

• Multicast Queue ID
• Broadcast Queue ID
• Unknown Queue ID

Click on the Select button for each parameter to display a list of valid queues and to 
choose a queue. 

The Multicast, Broadcast, and Unknown IDs must be set to multicast IDs. The 
default ID for multicast, broadcast, and unknown queues is 11.

18 Configure the In Remark parameter for the forwarding class, if required:

a When the In Remark  parameter is set to dscp, configure the In Dscp 
parameter, if required.

b When the In Remark  parameter is set to precedence, configure the In 
Precedence parameter, if required.

19 Configure the Out Remark parameter for the forwarding class, if required:

a When the Out Remark parameter is set to dscp, configure the Out Dscp 
parameter, if required.

b When the Out Remark parameter is set to precedence, configure the Out 
Precedence parameter, if required.

20 Configure the Profile parameter for the forwarding class, if required.
28-26 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



28 —  Policies
21 Configure forwarding subclasses, if required.

a Click on the Sub Classes tab button. The Forwarding SubClasses (Create) 
form opens.

b Go to step 29.

22 Click on the Add button.

23 Enter a value for the Displayed Name parameter.

24 Configure the In Remark parameter for the forwarding subclass, if required:

a When the In Remark parameter is set to dscp, configure the In Dscp 
parameter, if required.

b When the In Remark parameter is set to precedence, configure the In 
Precedence parameter, if required.

25 Configure the Out Remark parameter for the forwarding subclass, if required:

a When the Out Remark parameter is set to dscp, configure the Out Dscp 
parameter, if required.

b When the Out Remark parameter is set to precedence, configure the Out 
Precedence parameter, if required.

26 Configure the Profile parameter for the forwarding subclass, if required.

27 Click on the OK button. A confirmation dialog box appears.

28 Click on the OK button to close the dialog box. The Forwarding SubClasses (Create) 
form closes, and the Forwarding Class (Create) form reappears.

29 Click on the OK button. A confirmation dialog box appears.

30 Click on the OK button to close the dialog box. The forwarding class form closes, 
and the Access Ingress Policy (Create) form reappears. 

31 Specify how you want to configure the mapping between the ingress traffic and 
ingress queue by choosing the appropriate tab button. Mapping is optional and can 
be based on combinations of customer QoS marking (Dot1p, DSCP, and 
precedence), and IP criteria or MAC criteria. Table 28-5 describes the options. 

Table 28-5 Access ingress policy traffic mapping configuration options

Tab button Use

Dot1p Maps the Dot1p value of the ingress traffic to the ingress queue ID.

Dscp Maps the DSCP value of the ingress traffic to the ingress queue ID.

Precedence Maps the precedence value of the ingress traffic to the ingress queue ID.

IP Match Criteria Maps the IP Match Criteria of the ingress traffic to the ingress queue ID.

This tab is only configurable if you chose IP in step 4.

MAC Match Criteria Maps the MAC Match Criteria of the ingress traffic and ingress queue ID.

This tab is only configurable if you chose MAC in step 4.
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To configure IP or MAC mapping, go to step 4 of this procedure.

Perform the following substeps for each Dot1p, Dscp, or Precedence mapping that 
you want to configure.

i Click on the appropriate tab button. 

ii Click on the Add button. A Create form opens.

iii Configure the parameters. They include:

• Dot1p
• Dscp
• Precedence
• Forwarding Class
• Priority

The Forwarding Class and Priority parameters appear on all forms. The Dot1p, 
Dscp, and Precedence parameters appear only on the form with the same 
name as the parameter.

iv Click on the OK button to close the form. A confirmation dialog box appears.

v Click on the OK button to close the dialog box. The form closes and the Access 
Ingress Policy (Create) form reappears.

32 Click on the Relations tab button to view a graphical representation of queue 
classification objects.

33 Click on the Apply button to save the policy. The Access Ingress Policy form is 
refreshed with additional buttons.

34 Click on the Distribute button to manually distribute the policy locally to devices. 
Policies are also automatically distributed to devices when they are used by 
resources on the device.

35 Close the Access Ingress Policy form. The Access Ingress Policy Manager form 
reappears. 

36 Click on the Search button to display the newly created policy or policies in the 
bottom panel of the form. 

Procedure 28-2  To create an access egress policy

1 Choose Policies→QoS→Access Egress from the 5620 SAM main menu. The 
Manage Access Egress Policy form opens.

2 Perform one of the following tasks:

a Specify a filter to search for and edit an existing policy. Use the filters to search 
for and open an existing policy by choosing a policy in the filtered list and 
clicking on the Edit button.
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b Click on the Create button. The Access Egress Policy (Create) form opens with 
the General tab displayed.

3 Configure the parameters. They include:

• Auto-Assign ID
• Configuration Action
• Displayed Name
• Description

4 Click on the Queues tab button. One default queue is displayed in the form. 

5 Click on the Add button. The Queue (Create) form opens with the General tab 
displayed.

6 Configure the parameters. They include:

• ID
• Displayed Name
• Description
• Scheduler
• Expedite

7 Click on the CIR/PIR tab button.

8 Configure the parameters. They include:

• Cir (kbps)
• Pir (kbps)
• MAX
• Cir Adaptation
• Pir Adaptation

Ensure that the CIR value is lower than the PIR value.

9 Click on the Burst Size tab button.

10 Configure the parameters. They include:

• Committed Burst Size (KB)
• Maximum Burst Size (KB)
• High Priority Reserved

Ensure that the Committed Burst Size value is lower than the Maximum Burst Size 
value.

11 Click on the OK button. A confirmation dialog box appears.

12 Click on the OK button to close the dialog box. The Access Egress Policy (Create) 
form reappears. 

13 To create additional queues, return to step 5. You can create up to 8 queues.

14 Click on the Forwarding Classes tab button.

15 Click on the Add button. The Forwarding Class (Create) form opens.
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16 Configure the parameters. You can create one entry for each of the eight forwarding 
class types. The parameters include:

• Forwarding Class
• Queue ID
• Dot1p

17 Click on the OK button to close the Forwarding Class (Create) form. A confirmation 
dialog box appears.

18 Click on the OK button to close the dialog box. The Forwarding Class (Create) form 
closes and the Access Egress Policy (Create) form reappears with a list of the newly 
created forwarding classes displayed. 

19 Click on the Apply button to save the policy. The Access Egress Policy form is 
refreshed with additional buttons.

20 Click on the Distribute button to manually distribute the policy locally to devices. 
Policies are also automatically distributed to devices when they are used by 
resources on the device.

21 Close the Access Egress Policy form. The Access Egress Policy Manager form 
reappears. 

22 Click on the Search button to display the newly created policy or policies in the 
bottom panel of the form. 

Procedure 28-3  To create a network policy

1 Choose Policies→QoS→Network from the 5620 SAM main menu. The Manage 
Network Policy form opens.

2 Perform one of the following tasks:

a Specify a filter to search for and edit an existing policy. Use the filters to search 
for and open an existing policy by choosing a policy in the filtered list and 
clicking on the Edit button.

b Click on the Create button. The Network Policy (Create) form appears with the 
General tab displayed.

3 Configure the parameters. They include:

• Configuration Action
• Auto-Assign ID
• Default FC
• Default FC Profile
• Ler Use Dscp
• Remark

4 Click on the Egress Forwarding Classes tab button. Eight default objects based on 
the eight forwarding classes, as described in Table 28-2, are displayed in the form. 
Configure the forwarding class parameters as required.
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5 Double-click on a forwarding class. The network forwarding class form opens.

6 Configure the parameters. They include:

• Dscp In Profile
• Lsp Exp In Profile
• Dot1p In Profile
• Dscp Out Profile
• Lsp Exp Out Profile
• Dot1p Out Profile

7 Click on the OK button to close the Forwarding Class (Create) form. A confirmation 
dialog box appears.

8 Click on the OK button to close the dialog box. The Forwarding Class (Create) form 
closes and the Network Policy (Create) form reappears.

9 Specify how you want to configure the mapping between the ingress traffic and 
ingress queue by clicking on the appropriate tab button. Mapping is optional and can 
be based on combinations of customer QoS marking for LSP EXP Bits and Ingress 
DCSP. Table 28-6 describes the options. 

Table 28-6 Network policy traffic-mapping configuration options

Perform the following substeps for each mapping that you want to configure.

i Click on the appropriate tab button.

ii Click on the Add button. A Create form opens.

iii Configure the parameters. They include:

• Lsp Exp
• Dscp
• Dot1p
• Forwarding Class
• Profile

The Forwarding Class and Profile parameters appear on all forms. The Lsp 
Exp, Dscp, and Dot1p parameters appear only on the form with the same 
name as the parameter.

iv Click on the OK button to close the form. The policy form reappears with the 
newly created object displayed.

10 Click on the Apply button to save the policy. The Network Policy form is refreshed 
with additional buttons.

Tab button Use

Ingress LSP EXP Bits Maps the LSP EXP Bits of the ingress traffic to the ingress queue ID.

Ingress DCSP Maps the DSCP of the ingress traffic to the ingress queue ID.

Ingress Dot1p Maps the Dot1p tag of the ingress traffic to the ingress queue ID.
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11 Click on the Distribute button to manually distribute the policy locally to devices. 
Policies are also automatically distributed to devices when they are used by 
resources on the device.

12 Close the Network Policy form. The Network Policy Manager form reappears. 

13 Click on the Search button to display the newly created policy or policies in the 
bottom panel of the form. 

Procedure 28-4  To create a WRED slope policy

1 Choose Policies→QoS→WRED Slope from the 5620 SAM main menu. The 
Manage Slope Policy form opens.

2 Perform one of the following tasks:

a Specify a filter to search for and edit an existing policy. Use the filters to search 
for and open an existing policy by choosing a policy in the filtered list and 
clicking on the Edit button.

b Click on the Create button. The Slope Policy (Create) form appears with the 
General tab displayed.

3 Configure the parameters. They include:

• Configuration Action
• Displayed Name
• Time Average Factor (weight)

When packets are queued, shared buffer average utilization is calculated using the 
Time Average Factor for the buffer pool. The time average factor specifies the 
weighting between the previous shared buffer average utilization result and the new 
shared buffer utilization to determine the new shared buffer average utilization.

4 Click on the Burst Size tab button. The Burst Size form appears, as shown in 
Figure 28-14.
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Figure 28-14  Slope policy form - Burst Size

Each buffer pool supports a high-priority RED slope and a low-priority RED slope. 
The high-priority RED slope manages access to the shared portion of the buffer pool 
for high-priority or in-profile packets. The low-priority RED slope manages access to 
the shared portion of the buffer pool for low-priority or out-of-profile packets. 
See “Slope policies” in section 28.2 for more information.

5 Configure the parameters for the Low Slope and the High Slope:

• Start Avg.
• Max Avg.
• Max Prob.

6 Click on the Apply button to save the policy. The Slope Policy form is refreshed with 
additional buttons.

7 Click on the Distribute button to manually distribute the policy locally to devices. 
Policies are also automatically distributed to devices when they are used by 
resources on the device.

8 Close the Slope Policy form. The Slope Policy Manager form reappears. 

9 Click on the Search button to display the newly created policy or policies in the 
bottom panel of the form. 
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Procedure 28-5  To create a network queue policy

1 Choose Policies→QoS→Network Queue from the 5620 SAM main menu. The 
Manage Network Queue Policy form opens.

2 Perform one of the following tasks:

a Specify a filter to search for and edit an existing policy. Use the filters to search 
for and open an existing policy by choosing a policy in the filtered list and 
clicking on the Edit button.

b Click on the Create button. The Network Queue Policy (Create) form appears 
with the General tab displayed, as shown in Figure 28-15.

Figure 28-15  Network Queue Policy form - General

3 Configure the parameters. They include:

• Configuration Action
• Displayed Name
• Description

4 Click on the Queues tab button. The Network Queue Policy (Create) with the 
Queues tab displayed appears, as shown in Figure 28-16.
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Figure 28-16  Network Queue Policy form - Queues

Eight default queues are displayed in the form. Configure the queues as required.

i Double-click on a queue in the list. The Queue configuration form with the 
General tab displayed appears, as shown in Figure 28-17.
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Figure 28-17  Queue configuration form - General

ii Configure the parameters. They include:

• ID
• Displayed Name
• Description
• Multicast
• Expedite

iii Click on the CIR/PIR tab button.

iv Configure the parameters. They include:

• Cir (%)
• Pir (%)

v Click on the Burst Size tab button.

vi Configure the parameters. They include:

• High Priority Reserved (%)
• Committed Burst Size (%)
• Maximum Burst Size (%)

vii Click on the OK button to close the queue configuration form. A confirmation 
dialog box appears.

viii Click on the OK button to close the dialog box. The Network Queue Policy 
(Create) form closes and the Network Queue Policy (Create) form reappears 
with a list of the network queues displayed. 

5 Click on the Forwarding Classes tab button. The Network Queue Policy (Create) 
form with the Forwarding Classes tab displayed appears, as shown in Figure 28-18.
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Figure 28-18  Network Queue Policy form - Forwarding Classes

Eight default objects based on the eight forwarding classes, as described in 
Table 28-2, are displayed in the form. Configure the forwarding class parameters as 
required.

i Double-click on a forwarding class in the list. The Forwarding Class 
configuration form appears, as shown in Figure 28-19.
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Figure 28-19  Forwarding Class form

ii Configure the parameters. They include:

• Forwarding Class
• Queue ID
• Multicast Queue ID

iii Click on the OK button to close the forwarding class configuration form. A 
confirmation dialog box appears.

iv Click on OK to close the dialog box.

6 Click on the Apply button to save the policy. The Network Queue Policy form is 
refreshed with additional buttons.

7 Click on the Distribute button to manually distribute the policy locally to devices. 
Policies are also automatically distributed to devices when they are used by 
resources on the device.

8 Close the Network Queue Policy form. The Network Queue Policy Manager form 
reappears. 

9 Click on the Search button to display the newly created policy or policies in the 
bottom panel of the form. 

Procedure 28-6  To create a scheduler policy

1 Choose Policies→QoS→Scheduler from the 5620 SAM main menu. The Manage 
Scheduler Policy form opens.

2 Perform one of the following tasks:

a Specify a filter to search for and edit an existing policy. Use the filters to search 
for and open an existing policy by choosing a policy in the filtered list and 
clicking on the Edit button.

b Click on the Create button. The Schedule Policy (Create) form appears with 
the General tab displayed.
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c Configure the parameters. They include:

• Configuration Action
• Displayed Name
• Description

3 Click on the Schedulers tab button.

The scheduler defines bandwidth control that limits each child (other schedulers and 
queues) that are associated with the scheduler.

4 Click on the Add button. The Entry form opens.

5 Configure the parameters. They include:

• Displayed Name
• Description
• Tier
• Summed CIR
• PIR (kbps)
• CIR (kbps)
• MAX
• Parent Scheduler

Click on the Select button to display a list of valid parent schedulers.
• Level
• CIR Level
• Weight
• CIR Weight

The Parent Scheduler, Level, CIR Level, Weight and CIR Weight parameters 
appear only when the Tier parameter is set to 2 or 3.

A tier identifies the level of hierarchy with which a group of schedulers is associated. 
A parent is tier 1. Children are tier 2. Grandchildren are tier 3. When creating 
children or grandchildren schedulers, you must specify tier 2 or tier 3 before 
choosing a parent scheduler.

6 Click on the OK button to close the Entry form. A confirmation dialog box appears.

7 Confirm the action by clicking on the OK button. The newly configured scheduler is 
added to the list of schedulers.

8 To add additional schedulers to the policy, repeat steps 4 to 7 of this procedure.

9 Click on the Graphical Schedulers tab button to view a graphical display of the 
scheduler hierarchy within the scheduler policy. An example of the graphical display 
is shown in Figure 28-20.
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Figure 28-20  Scheduler Policy form - Graphical Schedulers

10 Click on the Apply button to save the policy. The Scheduler Policy form is refreshed 
with additional buttons.

11 Click on the Distribute button to manually distribute the policy locally to devices. 
Policies are also automatically distributed to devices when they are used by 
resources on the device.

12 Close the Scheduler Policy form. The Scheduler Policy Manager form reappears. 

13 Click on the Search button to display the newly created policy or policies in the 
bottom panel of the form. 

Procedure 28-7  To create an 802.1X policy

1 Choose Policies→802_1x from the 5620 SAM main menu. The Manage 802_1x 
Policies form opens.

2 Perform one of the following tasks:

a Specify a filter to search for and edit an existing policy. Use the filters to search 
for and open an existing policy by choosing a policy in the filtered list and 
clicking on the Edit button.

b Click on the Create button. The 802_1x Policy (Create) form appears with the 
General tab displayed.

Note —  Before you can create an 802.1X policy, 802.1X must be 
enabled on the device. See procedure 21-3 for information about 
enabling 802.1X.
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3 Configure the parameters. They include:

4 Click on the Radius Servers tab button, if required. Otherwise, go to step 8.

5 Click on the Add button. The Radius Server (Create) form opens.

6 Configure the parameters. They include:

7 Click on the OK button. The Radius Server (Create) from closes and the 802_1x 
Policy (Edit) form refreshes with the server information displayed in the Radius 
Servers tab.

8 Click on the Apply button to save the policy. The 802_1x Policy form is refreshed 
with additional buttons and tab buttons.

9 Click on the Distribute button to manually distribute the policy locally to devices. See 
Procedure 28-18 for information about distributing a policy.

Policies are also automatically distributed to devices when they are used by 
resources on the device.

10 Close the 802_1x Policy form. The Manage 802_1x Policies form reappears. 

11 Click on the Search button to display the newly created policy or policies in the 
bottom panel of the form. 

Procedure 28-8  To create an aggregation scheduler

You can create an aggregation scheduler when you have created two or more scheduler 
policies. See “Hierarchical schedulers” in section 28.2 for more information.

1 Create two or more scheduler policies, as described in Procedure 28-6.

2 Choose Manage→Subscribers from the 5620 SAM main menu. The Manage 
Subscribers form opens.

3 Specify a filter to search for an existing subscriber and click on the Search button.

4 Choose a subscriber from the list of search results.

5 Click on the Edit button. The Subscriber (Edit) form opens.

6 Click on the Sites tab button. 

• Configuration Action
• Displayed Name
• Source Address
• Administrative Status 

• Description
• Retry Attempts
• Request Timeout

• Server Index
• IP Address
• Password

• Authorization Port
• Accounting Port
• Server Type
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7 Choose a site from the list of sites for the subscriber, and click on the Edit button. 
The Site (Edit) form appears.

8 Click on the Aggregation tab button.

9 Click on the Add button. The Create Aggregation Scheduler form opens.

10 Configure the parameters. They include:

• Scheduler Name
• Description

11 Click on the Next button. The Select Assignment Scope form opens.

12 Configure the Select Assignment Scope parameter.

13 Click on the Next button. The Select Card or the Select Port form opens, depending 
on the option chosen for the Select Assignment Scope parameter.

14 Click on the Select button to specify a card or port. The Select Card - Aggregation 
Scheduler form or the Select Site - Aggregation Scheduler form opens.

15 Select a card or port from the list and click on the OK button. The Select - 
Aggregation Scheduler form closes and the card or port information appears on the 
Select Card or Select Port form.

16 Click on the Next button. The Select Ingress and Egress Scheduler Policies form 
appears. 

17 Click on the Select buttons to choose ingress and egress scheduler policies. The 
Select Policy - Aggregation Scheduler form opens.

18 Set the filter criteria, if required, and click on the Search button. A list of policies 
appears.

19 Choose a policy from the list and click on the OK button. The Select Policy - 
Aggregation Scheduler form closes and the policy information appears in the Select 
Ingress and Egress Scheduler Policies form.

20 Click on the Finish button. The aggregation scheduler is listed in the Aggregation 
tab of the Site (Edit) form, and a warning dialog box appears.

21 Click on the OK button to close the dialog box.

22 Click on the OK button to close the Site (Edit) form. The Subscriber (Edit) form 
reappears.

23 Click on the OK button to save the changes and close the Subscriber (Edit) form. A 
confirmation dialog box appears.

24 Click on the Yes button to confirm the action. The Manage Subscribers form 
reappears.

25 Close the Manage Subscribers form.
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Procedure 28-9  To create an ACL IP filter policy

1 Choose Policies→Filter→ACL IP Filter from the 5620 SAM main menu. The 
Manage ACL IP Filter form opens.

2 Perform one of the following tasks:

a Specify a filter to search for and edit an existing policy. Use the filters to search 
for and open an existing policy by choosing a policy in the filtered list and 
clicking on the Edit button.

b Click on the Create button.

The ACL IP filter (Create) form appears with the General tab displayed.

3 Configure the parameters. They include:

• Configuration Action
• Auto-Assign ID
• Default Action

The default action specifies the action to be applied to packets when no action 
is specified in the IP filter entries or when the packets do not match the specified 
criteria.

4 Click on the Filter Entries tab button.

5 Click on the Add button. The ACL IP filter (Create) form opens.

6 Configure the parameters. They include:

• Auto-Assign ID
• Displayed Name
• Description
• Administrative State

7 Click on the Filter Properties tab button.
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8 Configure the parameters. They include:

• Action
If you specify Forward for the parameter, the Next Hop Routing tab button 
appears. Go to step 9.

• Protocol
If you specify ICMP, TCP, or UDP, additional parameters appear in the bottom 
portion of the form. Configure the additional parameters, if required.

• DSCP
• Source IP
• Destination IP
• Src Mask
• Dst Mask
• Fragment
• IP Option
• IP Opt Mask
• Option Present
• Multiple Option

9 Click on the Next Hop Routing tab button.

10 Configure the parameters. They include:

• Forward NH
• Is Indirect
• Forward NH Interface
• Remark DSCP
• Remark DSCP Mask
• Remark Dot1p

11 Click on the Cflowd tab button. 

12 Configure the parameters. They include:

• Cflowd Sample
• Cflowd If Sample

13 Click on the OK button. The ACL IP filter entry form closes and a confirmation dialog 
box appears.

14 Click on the OK button to close the dialog box. The ACL IP filter form reappears with 
the newly created filter entry or entries displayed. 

15 To add additional filter entries, repeat steps 5 to 14 of this procedure.

16 Click on the Apply button to save the policy. The ACL IP Filter form is refreshed with 
additional buttons. 

17 Click on the Distribute button to manually distribute the policy locally to devices. 
Policies are also automatically distributed to devices when they are used by 
resources on the device.

18 Close the ACL IP Filter form. The ACL IP Filter Manager form reappears. 
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19 Click on the Search button to display the newly created policy or policies in the 
bottom panel of the form. 

Procedure 28-10  To create an ACL MAC filter policy

1 Choose Policies→Filter→ACL MAC Filter from the 5620 SAM main menu. The 
Manage ACL MAC Filter form opens.

2 Perform one of the following tasks:

a Specify a filter to search for and edit an existing policy. Use the filters to search 
for and open an existing policy by choosing a policy in the filtered list and 
clicking on the Edit button.

b Click on the Create button. The ACL MAC Filter (Create) form appears with the 
General tab displayed.

3 Configure the parameters. They include:

• Configuration Action
• Auto-Assign ID
• Default Action

The Default Action parameter specifies the action to be applied to packets when no 
action is specified in the MAC filter entries or when the packets do not match the 
specified criteria.

4 Click on the Filter Entries tab button.

5 Click on the Add button. The ACL MAC Filter entry form opens.

6 Configure the parameters. They include:

• Auto-Assign ID
• Displayed Name
• Description
• Administrative State

7 Click on the Filter Properties tab button.
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8 Configure the parameters. They include:

• Action
• Frame Type

If you specify e802dot2LLC, e802dot2SNAP, or Ethernet II, additional 
parameters appear in the bottom portion of the form. Configure the additional 
frame type parameters, if required.

• Source MAC
• Src Mask
• Destination MAC
• Dst Mask
• Dot1p
• Dot1p Mask

9 Click on the OK button. The ACL MAC Filter entry form closes and a confirmation 
dialog box appears.

10 Click on the OK button to close the dialog box. The ACL MAC Filter form reappears 
with the newly created filter entry or entries displayed. 

11 To add additional filter entries, repeat steps 5 to 10 of this procedure.

12 Click on the Apply button to save the policy. The ACL MAC Filter form is refreshed 
with additional buttons.

13 Click on the Distribute button to manually distribute the policy locally to devices. 
Policies are also automatically distributed to devices when they are used by 
resources on the device.

14 Close the ACL MAC Filter form. The ACL MAC Filter Manager form reappears. 

15 Click on the Search button to display the newly created policy or policies in the 
bottom panel of the form. 

Procedure 28-11  To create an ATM QoS policy

1 Choose Policies→QoS→ATM QoS from the 5620 SAM main menu. The Manage 
ATM QoS Policy form opens.

2 Perform one of the following tasks:

a Specify a filter to search for and edit an existing policy. Use the filters to search 
for and open an existing policy by choosing a policy in the filtered list and 
clicking on the Edit button.

b Click on the Create button. The ATM QoS Policy (Create) form appears with 
the General tab displayed.
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3 Configure the parameters. They include:

• Auto-Assign ID
• Displayed Name
• Description

4 Click on the QoS tab button.

5 Configure the parameters. They include:

• Service Category
• MIR (kbps)
• PIR (kbps)
• Shaping
• Descriptor Type
• Policing

Additional parameters appear if you change the default Service Category parameter 
setting to CBR, rt-VBR, or nrt-VBR. 

6 Click on the Apply button to save the policy. The ATM QoS Policy form is refreshed 
with additional tabs.

7 Click on the Distribute button to manually distribute the policy locally to devices. The 
Distribute form appears. Policies are also automatically distributed to devices when 
they are used by resources on the device.

8 Close the ATM QoS Policy form. The ATM QoS Policy Manager form reappears. 

9 Click on the Search button to display the newly created policy or policies in the 
bottom panel of the form. 

Procedure 28-12  To create a multicast package policy

Use multicast package policies to :

• define a set of broadcast channels that are multicast across a ring group in a 
BTV VLAN

• assign to a VPLS instance a common set of multicast groups to ensure 
consistency among the VPLS sites of one or more MVR VPLS
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Consider the following when creating multicast package policies:

• one root multicast package policy should be created for a ring or multiple rings, 
which contains the multicast addresses of all BTV channels distributed in the ring

• specify this root multicast package policy for the ring group MVR
• create other multicast package policies from the root package using the Copy 

button on the configuration form
• use the child policies to differentiate the types of broadcast TV services offered, 

for example, basic service and premium service
• when you create Telco IGMP ACL filter policies, use these child policies to limit 

access for subscribers to specific types of services, for example, access to basic 
service, premium service, or both services

1 Choose Policies→Multicast Package from the 5620 SAM main menu. The Multicast 
Package Policy Manager form opens.

2 Perform one of the following tasks:

a Specify a filter to search for an existing policy. Choose a policy in the filtered 
list and click on the Edit button.

b Click on the Create button. The Multicast Package Policy (Create) form opens 
with the General tab displayed.

3 Configure the parameters. They include:

• Auto-Assign ID
• Name 
• Description
• Is Root Catalogue
• IGMP Option
• Loggable

4 Click on the Multicast Groups tab button.

5 Click on the Add button. The Multicast Group (Create) form appears.

6 Configure the parameters. They include:

• Multicast Address
• Name
• Description
• Channel
• Cost

7 Click on the Apply button to save the policy. The Multicast Package Policy (Create) 
form is refreshed with additional buttons.

8 Click on the Definitions tab, if applicable.

9 Click on the Distribute button to manually distribute the policy locally to devices in 
the ring. You can use the Distribute button when the Is Root Catalogue parameter 
is set to root. The Distribute form appears. Policies are also automatically distributed 
to devices when they are used by resources on the device.
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When any new devices are added to the ring, the policy is automatically distributed 
to any new MVR VLAN service or to any new MVR VLAN service sites in the ring.

10 Click on the Selected radio button to choose from the listed devices.

11 Choose one or more rows from the Available Nodes list.

12 Click on the right arrow button. The selected devices move to the list on the right 
side of the form.

13 Click on the Distribute button. The policy is distributed to the device or devices.

14 Close the Distribute form. The Multicast Package Policy form reappears. 

15 Close the Multicast Package Policy form. 

Create other multicast package policies from the root policy using the Copy button, as 
required. These child policies of the root policy can be used to help differentiate the types 
of BTV services being created, for example, basic services and premium services.

Procedure 28-13  To create a Telco node QoS level policy

1 Choose Policies→QoS→Telco QoS from the 5620 SAM main menu. The Manage 
Telco QoS Policy form opens.

2 Perform one of the following tasks:

a Specify a filter to search for an existing policy. Choose a policy in the filtered 
list and click on the Edit button.

b Click on the Create button. The Telco Qos Node Level Policy (Create) form 
opens with the General tab displayed.

3 Configure the parameters. They include:

• Configuration Action
• Auto-Assign ID
• Displayed Name
• Description
• Queue Algorithm

4 If the Queue Algorithm parameter is set to Strict Priority, go to step 6.

5 Click on the Scheduling Tx Queue tab button.

i Configure the parameters. There is one Txq parameter for each queue. The 
number of queues and Txq parameters depends on the Queue Algorithm 
parameter value chosen in step 3.

ii Repeat step i for each Txq parameter on the Scheduling Tx Queue tab.

6 Click on the Traffic Class Entries tab button.

7 Click on the Add button. The QoSTrafficClassEntry (Create) form opens.
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8 Configure the parameters. They include:

• Traffic Class
• DSCP
• Priority
• Color
• DSCP Value

9 Click on the OK button. The QoSTrafficClassEntry (Create) form closes and a 
confirmation dialog box appears.

10 Click on the OK button to close the dialog box. The Telco QoS Node Level Policy 
form reappears with the newly created policy entries displayed.

11 To add more policy entries, repeat steps 7 to 10.

12 Click on the Apply button to save the policy. The Telco QoS Node Level Policy form 
is refreshed with additional tabs.

13 Click on the Distribute button to manually distribute the policy locally to devices. The 
Distribute form appears. Policies are also automatically distributed to devices when 
they are used by resources on the device.

14 Close the Telco QoS Node Level Policy form. The Telco QoS Node Level Manager 
form reappears. 

15 Click on the Search button to display the newly created policy or policies in the 
bottom panel of the form. 

Procedure 28-14  To create a Telco ACL standard IP filter policy

1 Choose Policies→Filter→Telco ACL Standard IP Filter from the 5620 SAM main 
menu. The Manage Telco ACL Standard IP Filter Policy form opens.

2 Perform one of the following tasks:

a Specify a filter to search for an existing policy. Choose a policy in the filtered 
list and click on the Edit button.

b Click on the Create button. The Telco ACL Standard IP Filter (Create) form 
opens with the General tab displayed.

3 Configure the parameters. They include:

• Configuration Action
• Filter ID
• Displayed Name
• Description

4 Click on the Filter Entries tab button.

5 Click on the Add button. The Telco ACL Standard IP Filter entry form opens with the 
General tab displayed.
28-50 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



28 —  Policies
6 Configure the parameters. They include:

• Displayed Name
• Description

7 Click on the Filter Properties tab button.

8 Configure the parameters. They include:

• Action
• Source IP
• Src Mask
• Loggable
• VLAN Priority Tag

The VLAN Priority Tag parameter is configurable when its check box is selected.

9 Click on the OK button. The Telco ACL Standard IP Filter entry form closes and a 
confirmation dialog box appears.

10 Click on the OK button to close the dialog box. The Telco ACL Standard IP Filter 
form reappears with the newly created filter entries displayed.

11 To add more filter entries, repeat steps 5 to 10 of this procedure.

12 Click on the Apply button to save the policy. The Telco ACL Standard IP Filter form 
is refreshed with additional tabs.

13 Click on the Distribute button to manually distribute the policy locally to devices. The 
Distribute form appears. Policies are also automatically distributed to devices when 
they are used by resources on the device.

14 Close the Telco ACL Standard IP Filter form. The Telco ACL Standard IP Filter 
Manager form reappears. 

15 Click on the Search button to display the newly created policy or policies in the 
bottom panel of the form. 

Procedure 28-15  To create a Telco ACL extended IP filter policy

1 Choose Policies→Filter→Telco ACL Extended IP Filter from the 5620 SAM main 
menu. The Manage Telco ACL Extended IP Filter Policy form opens.

2 Perform one of the following tasks:

a Specify a filter to search for an existing policy. Choose a policy in the filtered 
list and click on the Edit button.

b Click on the Create button. The Telco ACL Extended IP Filter (Create) form 
opens with the General tab displayed.
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3 Configure the parameters. They include:

• Configuration Action
• Filter ID
• Displayed Name
• Description

4 Click on the Filter Entries tab button.

5 Click on the Add button. The Telco ACL Extended IP Filter entry form opens.

6 Configure the parameters. They include:

• Displayed Name
• Description

7 Click on the Filter Properties tab button.

8 Configure the parameters. They include:

To configure the TOS, Precedence, and VLAN Priority Tag parameters, select the 
corresponding check box.

When you set the Protocol parameter to ICMP, TCP, or UDP, additional parameters 
appear that can be configured. Use the Source Port, Dest Port and related 
parameters to determine the range of objects against which the filters are used.

9 Click on the OK button. The Telco ACL Extended IP Filter entry form closes and a 
confirmation dialog box appears.

10 Click on the OK button to close the dialog box. The Telco ACL Extended IP Filter 
form reappears with the newly created filter entries displayed.

11 To add more filter entries, repeat steps 5 to 10 of this procedure.

12 Click on the Apply button to save the policy. The Telco ACL Extended IP Filter form 
is refreshed with additional tabs.

13 Click on the Distribute button to manually distribute the policy locally to devices. The 
Distribute form appears. Policies are also automatically distributed to devices when 
they are used by resources on the device.

14 Close the Telco ACL Extended IP Filter form. The Telco ACL Extended IP Filter 
Manager form reappears. 

15 Click on the Search button to display the newly created policy or policies in the 
bottom panel of the form. 

• Source IP
• Destination IP
• Action
• Loggable
• Protocol

• Src Mask
• Dest Mask
• TOS
• Precedence
• VLAN Priority Tag
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Procedure 28-16  To create a Telco ACL IGMP filter policy

1 Choose Policies→Filter→ Telco ACL IGMP Filter from the 5620 SAM main menu. 
The Manage Telco ACL IGMP Filter Policy form opens.

2 Perform one of the following tasks:

a Specify a filter to search for an existing policy. Choose a policy in the filtered 
list and click on the Edit button.

b Click on the Create button. The Telco ACL IGMP Filter (Create) form appears 
with the General tab displayed.

3 Configure the parameters. They include:

• Filter ID
• Displayed Name
• Description
• Name

4 Click on the Filter Entries tab button.

5 Click on the Add button. The Entry, Telco ACL IGMP Filter (Create) form appears 
with the General tab displayed.

6 Configure the parameters. They include:

• Displayed Name
• Description

7 Click on the Filter Properties tab button.

8 Configure the parameters. They include:

• Action
• Source IP
• Src Mask
• Destination IP
• Dest Mask
• Loggable
• IGMP Option

9 Click on the OK button to save the filter entry and close the form. A confirmation 
dialog box appears.

10 Click on the OK button to close the dialog box. The Telco ACL IGMP Filter (Create) 
form reappears.

11 To add more filter entries, repeat steps 5 to 10.

12 Click on the OK button to close the Telco ACL IGMP Filter (Create) form and save 
the policy.

13 Click on the Distribute button to manually distribute the policy locally to Telco 
devices. The Distribute form appears. Policies are also automatically distributed to 
devices when they are used by resources on the device.
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14 Click on the Selected radio button to choose from the listed devices.

15 Choose one or more rows from the Available Nodes list.

16 Click on the right arrow button. The selected devices move to the list on the right 
side of the form.

17 Click on the Distribute button. The policy is distributed to the device or devices.

18 Close the Distribute form. The Telco ACL IGMP Filter Policy form reappears. 

19 Close the Telco ACL IGMP Filter Policy form. The Telco ACL IGMP Filter Manager 
form reappears.

20 Close the Telco ACL IGMP Filter Manager form.

Procedure 28-17  To create a Telco ACL MAC filter policy

1 Choose Policies→Filter→Telco ACL MAC Filter from the 5620 SAM main menu. 
The Manage Telco ACL MAC Filter Policy form opens.

2 Perform one of the following tasks:

a Specify a filter to search for an existing policy. Choose a policy in the filtered 
list and click on the Edit button.

b Click on the Create button. The Telco ACL MAC Filter (Create) form opens.

3 Configure the parameters. They include:

• Configuration Action
• Filter ID
• Displayed Name
• Description

4 Click on the Filter Entries tab button.

5 Click on the Add button. The Telco ACL MAC Filter entry form opens with the 
General tab displayed.

6 Configure the parameters. They include:

• Displayed Name
• Description

7 Click on the Filter Properties tab button.

8 Configure the parameters. They include:

• Source MAC
• Destination MAC
• Action
• Pattern

• Src Mask
• Dst Mask
• Loggable
• Pattern Mask
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The Pattern and Pattern Mask parameters are configurable when the check box is 
selected.

9 Click on the OK button. The Telco ACL MAC Filter entry form closes and a 
confirmation dialog box appears.

10 Click on the OK button to close the dialog box. The Telco ACL MAC Filter (Create) 
form reappears with the newly created filter entry displayed. 

11 To add more filter entries, repeat steps 5 to 10.

12 Click on the Apply button to save the policy. The Telco ACL Extended IP Filter form 
is refreshed with additional tabs.

13 Click on the Distribute button to manually distribute the policy locally to devices. The 
Distribute form appears. Policies are also automatically distributed to devices when 
they are used by resources on the device.

14 Close the Telco ACL MAC Filter form. The Telco ACL MAC Filter Manager form 
reappears.

15 Click on the Search button to display the newly created policy or policies in the 
bottom panel of the form. 

Procedure 28-18  To distribute a policy

Use this procedure to manually distribute policies used by network resources. Policies 
are also distributed to a device when the policy is assigned to a resource on that device. 

1 Choose Policies→Policy Type from the 5620 SAM main menu

where Policy Type  is the type of policy that you want to distribute

The appropriate policy manager form opens.

2 Choose Local or Global from the Policy scope drop-down menu. When you set it to 
Local, you can specify the Local Node IP Address parameter, and choose a device 
using the Select button and selecting a device from the list.

3 Click on the Search button.

4 Choose the policy or policies that you want to distribute. 

5 Click on the Distribute button. The Distribute form appears.

6 Click on the Selected radio button to choose from the listed devices.

7 Choose a row or rows from the Available Nodes list.

Note —  You cannot click on the Search button when you set Policy 
scope to Local. A list of search results is displayed.
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8 Click on the right arrow button. The chosen device or devices move to the panel on 
the right side of the form.

9 Click on the Distribute button. The policy is distributed to the device or devices.

10 Close the Distribute form. The policy manager form reappears. 

11 View the devices that a policy is distributed to.

i Choose the policy. 

ii Click on the Edit button. The policy form opens. 

iii Click on the Local Definitions tab button. The device information for the chosen 
policy is displayed.

12 To distribute additional policies, return to step 4.

Procedure 28-19  To edit a policy

Use this procedure to change existing policies and entries within policies using the 
5620 SAM GUI. Alternatively, you can use the CLI. The changes are applied immediately 
to all resources where the policy is applied. 

1 Choose Policies→Policy Type from the 5620 SAM main menu

where Policy Type is the type of policy that you want to edit

The Manage Policy Type form opens.

2 Choose either Local or Global from the Policy scope drop-down menu.

a If you choose Global, go to step 3.

b If you choose Local, click on the Select button to choose a network element. 
The Select a Network Element form opens.

i Click on the desired network element, then click on the OK button. The Select 
a Network Element form disappears, and the policy manager form reappears 
with a list of the chosen network element’s local policies in the bottom panel.

ii Go to step 4.

3 Click on the Search button. A list of search results is displayed in the bottom panel 
of the form.

4 Choose the policy that you want to edit.

5 Click on the Edit button. The policy configuration form opens. 

If the policy being edited is a local policy, a Site panel on the General form displays 
the site information and a Global Definitions tab is visible. The global definition of 
the selected local policy can be edited through the use of this tab.
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If the policy being edited is a global policy, a Local Definitions tab is visible. Local 
instances of the selected global policy can be edited through the use of this tab.

6 Configure the parameters, as required.

7 Click on the OK button to save the changes. A confirmation dialog box appears.

8 Click on the Yes button to close the dialog box. The policy configuration form closes 
and the policy manager form reappears. 

Procedure 28-20  To delete a policy

Each service SAP and network interface is associated, by default, with the appropriate 
ingress, egress, or network policy (ID 1). You can replace the default policy with a 
customer-configured policy, but you cannot entirely remove a QoS policy. When you 
remove a QoS policy from a SAP or IP interface, the policy association reverts to the 
default policy (ingress or egress policy ID 1). The default policy cannot be deleted.

A QoS or ACL policy cannot be deleted until it is removed from the all SAPs or network 
ports where it is applied. When a policy is deleted, it is removed from the 5620 SAM, 
including the database and all devices. 

1 Choose Policies→Policy Type from the 5620 SAM main menu, 

where Policy Type is the type of policy that you want to delete

The Manage Policy Type form opens.

2 Click on the Search button. A list of search results is displayed in the bottom panel 
of the form.

3 Choose the policy that you want to delete.

4 Click on the Remove button to delete the policy. A confirmation dialog box appears.

5 Click on the Yes button. The dialog box and the policy configuration form close and 
the policy manager form reappears. The policy is removed from the policy list.

Procedure 28-21  To copy or overwrite a policy

 You can copy an existing QoS policy, rename the policy with a new QoS policy ID, or 
overwrite an existing policy ID.

Caution —  Modification of a global policy through the 5620 SAM 
causes all local instances of the policy on associated network elements 
to be updated. 

Note —  If a local policy differs from the corresponding global policy 
because of changes applied to the local policy, a warning alarm is raised 
against the modified local policy.
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Instead of overwriting an existing policy, you can merge components of a policy with 
another by using the merge option. 

Procedure 28-22  To synchronize a policy

You can use the synchronize function to specify the local policy entry as global and 
redistribute it across all deployed associations. For example, if a policy is distributed to a 
wide range of devices and on one of these devices the policy was changed, you can use 
the synchronize command to synchronize the policy on the device and on the 5620 SAM. 
You must then distribute the policy to all participating devices, as described in 
Procedure 28-18.

1 Choose Policies→Policy Type from the 5620 SAM main menu

where Policy Type is the type of policy that you want to synchronize

The Manage Policy Type form opens.

2 Click on the Search button. A list of search results is displayed.

3 Choose the policy or policies that you want to synchronize.

4 Click on the Synchronize button. The Synchronize form appears.

5 Choose the device or devices to which the policy is to be distributed from the 
Available Nodes list. 

6 Click on the right arrow button. The chosen device or devices move to the panel on 
the right side of the form.

7 Click on the Synchronize button.

8 Click on the Cancel button to close the form.

Procedure 28-23  To remove an unassociated policy

You can use the Free Unused option to remove the policies that have no associations 
from one or more devices. When you perform this procedure, the policy is deleted from 
the devices where the policy is not associated with a particular service or router interface. 
When a policy is created and distributed to a device, it can subsequently be associated 
with a particular service or router interface. Until that association is performed, the policy 
is not in use although it remains on the device. 

When you remove unassociated policies from one or more devices, the policy remains 
accessible from the 5620 SAM and remains in the database. 

1 Choose Policies→Policy Type from the 5620 SAM main menu

where Policy Type is the type of policy that you want to remove

The Manage Policy Type form opens.
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2 Click on the Search button. A list of search results is displayed.

3 Choose the policy or policies that you want to remove.

4 Click on the Free Unused button. The policy form appears.

5 Click on the Cancel button to close the form.

Procedure 28-24  To perform a policy audit

An audit compares all local policies with the associated global policies. A policy audit can 
only be performed when another audit is not in progress.

1 Choose Tools→Policies Audit from the 5620 SAM main menu. The AuditStatus 
window appears.

2 Click on the Policy Audit button to proceed with the policy audit.

3 To interrupt an audit while it is proceeding, click on the Stop Audit button.

4 Click on the Cancel button to close the AuditStatus window after the audit finishes.
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29.1 Subscriber configuration and management overview

The 5620 SAM allows you to manage service subscribers. A service subscriber, or 
simply a subscriber, is the customer that pays for a service. The terms customer and 
subscriber are used synonymously in the context of the 5620 SAM.

An end user is the recipient of application content that is delivered through a service. 
The service is a means of transport for the application content and is owned by a 
service subscriber. For example, an end user subscribes to an high-speed Internet 
access service, and the Internet access service is owned by a service provider who is 
a service subscriber of the network provider. The 5620 SAM provides only service 
subscriber management, not end-user subscriber management.

On the General tab of a subscriber management form, you can configure basic 
subscriber information. From the other tabs on the form, you can configure and 
monitor service sites, templates, alarms, and statistics for a subscriber.

Each subscriber is associated with a subscriber ID that is assigned when the 
subscriber account is created. When configuring a service, you can use the subscriber 
ID or the listed name of the subscriber to associate a subscriber with a service.

A subscriber can own more than one service, but an individual service is owned by 
only one subscriber. Two or more services can be joined to form a composite service. 
The individual services that comprise the composite service can be owned by 
different subscribers. Subscribers that own services participating in a composite 
service are associated with the composite service.

29.2 Workflow to configure and manage subscribers

1 Create subscribers that will purchase and use services.

• Configure or modify key customer contact and billing information.
• Assign or associate equipment or resources to customers, as appropriate.

2 Create or modify services for subscribers, such as VPLS, VPRN, or VLL.

3 Monitor or troubleshoot subscribers based on SLAs between the subscriber and the 
service provider.

• Retrieve subscriber information and contact the customer when service 
problems or maintenance windows occur.

• Use 5620 SAM tools to monitor alarms that are raised against 
subscriber-assigned equipment or services.

• Perform diagnostics as appropriate to troubleshoot problems.

29.3 Subscriber configuration and management menu

Table 29-1 lists the subscriber configuration and management menu.
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Table 29-1 5620 SAM subscriber configuration and management menu

29.4 Subscriber configuration and management procedures 
list

Table 29-2 lists the procedures to configure and manage subscribers.

Table 29-2 5620 SAM subscriber configuration and management procedures list

29.5 Subscriber configuration and management procedures

The following procedures describe how to configure and manage subscribers.

Procedure 29-1  To create a subscriber

1 Choose Manage→Subscribers from the 5620 SAM main menu. The Manage 
Subscribers form opens, as shown in Figure 29-1.

Menu option Function

Manage→Subscribers Configure and manage subscribers.

Procedure Purpose

To create a subscriber Create a subscriber for a service.

To modify and manage subscriber information Modify subscriber information based on changes 
to the services used by the customer and to 
manage the customer account.

To delete subscribers Delete a subscriber.

To view a service map for a subscriber View a topology map of the devices used by a 
subscriber service.

To list subscriber services View a list of services that belong to a specific 
subscriber.
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Figure 29-1  Manage Subscribers form

2 Click on the Create button. The Subscriber (Create) form opens with the General 
tab displayed, as shown in Figure 29-2. The General tab shows subscriber contact 
and billing information.

Figure 29-2  Subscriber (Create) form - General
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3 Configure the parameters. They include:

• Auto-Assign ID
• ID
• Name
• Description
• Address
• Phone Number
• Contact
• Email

The information in the General tab is used to create a database of customer 
information, including contact information, so that the customer can be contacted if 
there is a service or equipment problem.

4 Click on the Apply button to save the subscriber information.

Procedure 29-2  To modify and manage subscriber information

Use this procedure to view and modify an inventory of all the services, interfaces, circuits, 
and other information that is associated with a subscriber.

1 Choose Manage→Subscribers from the 5620 SAM main menu. The Manage 
Subscribers form opens.

2 Search for the subscriber whose information you want to change. The search results 
are displayed in the bottom panel of the form.

3 Choose the subscriber and click on the Edit button. The Subscriber (Edit) form 
opens.

4 View or modify the information for the subscriber.

Each tab lists parameters you can view or modify, or functions that you can perform, 
related to subscriber management.

• The General tab lists the subscriber ID, the subscriber name, and contact 
information.

• The Sites tab lists PE devices used by the subscriber.
• The Aggregation tab lists aggregation schedulers defined for the subscriber. See 

Procedure 28-8 for information about creating aggregation schedulers.
• The Associated Templates tab lists service templates used to create services for 

the subscriber.
• The Faults tab lists all alarms generated against the subscriber.

5 Modify subscriber information as appropriate:

a To modify text in the General tab: 

i Make the changes in the appropriate fields and click on the OK button. A 
confirmation dialog box appears.
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ii Click on the Yes button. The Subscriber (Edit) form closes.

b To modify site or template information for the subscriber:

i Click on the appropriate tab button on the Subscriber (Edit) form.

ii Select the object in the list for which you want to modify information.

iii Click on the Edit button. The configuration form for the object opens.

iv Modify the information on the configuration form as required and click on 
the OK button. The changes are saved and the object configuration form 
closes.

Procedure 29-3  To delete subscribers

1 Choose Manage→Subscribers from the 5620 SAM main menu. The Manage 
Subscribers form opens.

2 Search for the subscriber that you want to delete. The search results are displayed 
in the bottom panel of the form.

3 Choose the subscriber from the list and click on the Remove button. A warning 
dialog box appears.

4 Perform one of the following:

a Click on the View Dependencies button. An information dialog box appears. 
Go to step 5.

b Click on the No button to avoid deleting the subscriber. The warning dialog box 
closes.

5 Click on the OK button to proceed. The information dialog box closes.

6 Select the I understand the implications of this action check box.

7 Click on the Yes button. The subscriber is deleted from the 5620 SAM database.

Procedure 29-4  To view a service map for a subscriber

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

Caution —  Ensure configuration changes do not affect customer 
services. Use the Turn Down button to turn down a service before making 
any changes that may affect customer traffic.

Caution —  Removing a subscriber deletes all information and services 
associated with the subscriber. Ensure that the correct subscriber has 
been selected.
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2 Choose Service (Service Management) from the filter list. A list appears in the 
Unused Properties window.

3 Select Subscriber from the Unused Properties window. Subscriber appears in the 
Filtered Properties window.

4 Filter based on a subscriber value, for example, to search on all services associated 
with subscriber 1, type 1.

5 Click on the Search button. A list of services matching the filter criteria appears.

6 Choose a service from the list and click on the Topology View button. A Topology 
View dialog box appears.

7 Click on the Yes button to proceed. The Service Topology - Service Name form 
opens.

8 Scroll the map to view the topology of the service and the devices used for the 
service.

9 Click on the Close button to close the map.

Procedure 29-5  To list subscriber services

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens with Service (Service Management) selected in the filter list.

2 Select Subscriber from the Unused Properties box and click on the right-facing 
arrow. The Subscriber property appears in the Filtered Properties box.

3 Set the search boundaries for the Subscriber property in the Filtered Properties box. 
For example, to search on all services associated with subscriber ABCindustries, 
select EQUALS from the drop-down menu and type ABCindustries in the field 
beside the drop-down menu.

4 Click on the Search button. A list of services matching the filter criteria appears.
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30.1 VLL service management overview

The 5620 SAM supports the provisioning of VLL services on edge devices. A VLL 
service is an L2 point-to-point service that connects access interfaces. A VLL service 
is completely transparent to subscriber data and to control protocols. Because of this, 
the device performs no MAC learning in a VLL service.

A VLL service that connects access interfaces on one device is called a local VLL 
service. As there is no need for signalling between devices, a local VLL service uses 
no SDPs.

The 5620 SAM supports the creation of three VLL service types:

• Epipe, or Ethernet VLL service
• Apipe, or ATM VLL service
• Fpipe, or frame relay VLL service

A VLL service that connects access interfaces on two devices is called a distributed 
VLL service. Subscriber data enters a distributed VLL service through access 
interfaces on different edge devices. The VLL service encapsulates the data and 
transports it across a service provider IP/MPLS network through GRE or MPLS 
service tunnels.

Packets that arrive at an edge device are associated with a VLL service based on the 
access interface on which they arrive. An access interface is uniquely identified 
using these parameters:

• physical port or POS port and channel
• encapsulation type 
• encapsulation identifier (if required, depending on encapsulation type)

A VLL service uses T-LDP signaling, and uses MPLS or GRE as the service tunnel 
transport.

A new or existing VLL can be configured as the spoke of an HVPLS. See “HVPLS” 
in section 31.1 and chapter 36 for more information.

The 5620 SAM supports end-to-end VLL configuration using the following 
methods:

• Tabbed configuration forms with an embedded navigation tree. The navigation 
tree provides a logical view of the service and acts as a configuration interface.

• Preconfigured template. Figure 30-1 shows the Create Service From Template 
form. A user with Service Mgmt privileges can create a service template. The 
service management user can also configure and bind site, circuit, and L2 
interface templates to the service template. See chapter 17 for more information 
about the administrative tasks associated with service templates.
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Figure 30-1  Create Service From Template form

Common to all device services, such as VLL, are policies that are assigned to the 
service. Policies are defined at a global level and can then be applied to components 
of the service, such as interfaces or circuits, when the service is configured or 
modified. The following policies are common to all device services:

• QoS policies define ingress classification, policing, shaping, and marking on the 
ingress side of the interface. QoS policies are configured using the Access Ingress 
Policy form, the Access Egress Policy form, and the ATM QoS Policy form. 
Because a VLL service is a point-to-point service, ingress QoS policies create 
only the unicast queues that are defined in the policy and not the multicast queues.

• Scheduling policies define hierarchical rate limiting and scheduling to govern the 
scheduling of queues. Scheduler policies are configured using the Scheduler 
Policy form.

• Filter policies control network traffic into or out of an interface or circuit based 
on IP or MAC matching criteria. Filter policies are configured using the ACL IP 
Filter form and the ACL MAC Filter form.

• Accounting policies measure the traffic on a service to ensure proper billing and 
enforcement of SLAs. Accounting policies are configured using the Accounting 
Policy form.

See chapter 28 for more information about policies.

OAM diagnostics can be performed on a per-service basis. See chapter 39 for more 
information.
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Figure 30-2  VLL service management form - General tab

The General tab of the 5620 SAM service management form displays useful 
information about the operational state of the service and its sites through the 
Aggregated Operational State and State Cause indicators, as shown in Figure 30-2.

The Aggregated Operational State indicator has four possible values: Up, Down, 
Partially Down, and Unknown. The value is derived from the operational states of 
the sites that are part of the service, as follows:

• Up—All sites are operationally up
• Partially Down—At least one site is operationally down
• Down—All sites are operationally down
• Unknown—The service has no provisioned sites

When the Aggregated Operational State is Partially Down or Down, a check mark 
appears beside the appropriate State Cause indicator to identify the type of fault to 
the 5620 SAM operator.
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Epipe (Ethernet VLL)

An Epipe, or Ethernet VLL service, provides a point-to-point Ethernet service. One 
endpoint of an Epipe uses Ethernet encapsulation, and the other endpoint uses 
Ethernet, ATM, or frame relay encapsulation. An Epipe effectively provides ATM 
and frame relay bridged encapsulation termination for interworking. The 5620 SAM 
supports local cross-connecting when the Epipe endpoints are on the same device. 
The device supports these Epipe connectivity scenarios:

•  a frame relay or ATM user in an ATM network communicating with an Ethernet 
user on an IP/MPLS network

• a frame relay or ATM user who connects to a PE device in an IP/MPLS network 
and communicates with an Ethernet user who connects to another PE device in 
the same network

ATM users connect through a UNI using AAL-5 or bridged Ethernet PDUs, and use 
the VCI/VPI as the ATM SAP identifier. frame relay users connect through a UNI 
that uses Multiprotocol Interconnect over frame relay or bridged Ethernet PDUs, or 
over an Ethernet UNI interface. The DLCI is the frame relay SAP identifier. The 
VCI/VPI and DLCI identifier tags are transparent to the service and remain 
unaffected during transport.

The 5620 SAM supports the following Ethernet SAP encapsulations for an Epipe 
service:

• null
• dot1q
• SONET/SDH BCP-null
• SONET/SDH BCP-dot1q

Apipe (ATM VLL)

An Apipe, or ATM VLL service, provides a point-to-point ATM service between 
users who connect to 7750 SR nodes in an IP/MPLS network directly or through an 
ATM access network. One endpoint of an Apipe uses ATM encapsulation and the 
other endpoint uses ATM or frame relay encapsulation. An ATM PVC—for 
example, a VC or a VP—is configured on the 7750 SR. As a result, the ATM 
switches at the service endpoints appear to be directly connected over an ATM link. 
The 5620 SAM supports VPI/VCI translation in an Apipe and supports local 
cross-connecting when the Apipe endpoints are on the same 7750 SR.

An Apipe encapsulates standard UNI/NNI cells that ingress the ATM SAP into a 
pseudowire packet using N:1 cell mode encapsulation or AAL-5 SDU mode 
encapsulation. When using N:1 cell mode encapsulation, an Apipe supports cell 
concatenation into a pseudowire packet and the setup of both VC- and VP-level 
connections.

For ATM and frame relay interworking, an Apipe provides a point-to-point service 
between a user who connects to an existing ATM network and another user who 
connects to a PE 7750 SR in an IP/MPLS network. An ATM AAL-5 SDU 
pseudowire or an frame relay 1-to-1 mode pseudowire connects the nodes. The PE 
7750 SR performs an FRF.5 interworking function to join the ingress and egress data 
paths.
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An ATM VT SAP on a PE 7750 SR is identified by the physical port and VPI range. 
Cells that arrive on a specified port and are within the specified VPI range go into a 
single pseudowire for transport through the IP/MPLS network. A user can configure 
the whole ATM port as a VT and does not need to specify a VPI range. There is no 
ingress or egress VPI/VCI translation or loss of cell order.

Fpipe (frame relay VLL)

An Fpipe, or frame relay VLL service, provides a point-to-point frame relay service 
between users who connect to PE 7750 SR nodes in an IP/MPLS network. Both 
endpoints of an Fpipe use frame relay encapsulation. An Fpipe connects users 
through frame relay PVCs. An Fpipe receives standard Q.922 core frames on the 
frame relay SAP and encapsulates them in a pseudowire packet according to the 
1-to-1 frame relay encapsulation mode. This is the VC type used on the SDP by 
default. The 5620 SAM does not support the many-to-one, or port encapsulation, 
mode. Fpipe creation supports local cross-connecting when the endpoints are on the 
same 7750 SR.

30.2 Sample VLL service

Figure 30-3 shows a sample VLL service.

Figure 30-3  Sample VLL service

Assuming the core IP/MPLS network and service tunnels have already been 
configured, Table 30-1 shows the high-level tasks required to configure this sample 
VLL service.

Device 1

Access
Interface 1VLL service 1 VLL service 1

17237

Service Tunnel 1

IP/MPLS
Network

Service Tunnel 2

Device 2
Circuit

Circuit

Subscriber 1 Subscriber 1

Access
Interface 2
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Table 30-1 Sample VLL service configuration

30.3 Workflow to create a VLL service

1 Set up group and user access privileges.

Task Description

1. Configure policies 
as required 

Policies should be configured prior to creating a service. Participation in policies is defined when 
you configure or modify resources such as access interfaces during VLL service creation or 
modification. The following key policies can be applied to resources that are part of a VLL service.

• Access ingress and egress interface policies, or ATM policies. Choose Policies→QoS→Access 
Ingress, Access Egress, or ATM QoS to open these forms.

• Scheduler policy. Choose Policies→QoS→Scheduler to open the scheduler policy form.
• ACL IP and ACL MAC filter policies. Choose Policies→Filter→ACL IP Filter or ACL MAC Filter 

to open the filter policy form.
• Accounting policy. Choose Policies→Accounting to open the accounting policy form.

2. Configure ports as 
access ports for use in 
the service

If applicable, choose a port from the navigation tree, right-click on the port, and choose Properties 
from the contextual menu. Specify the port as an access port and specify an encapsulation type, if 
required.

3. Configure service 
tunnels as required

Service tunnels are automatically created if there are no tunnels between the source and 
destination devices. You must choose GRE as the transport type for the 5620 SAM to automatically 
create service tunnels.

To manually create service tunnels, choose Manage→Service Tunnels. Unidirectional service 
tunnels carry service traffic between edge managed devices via aggregated SDP bindings. SDP 
bindings can be associated with service tunnels during service configuration.

During service creation, you can also configure the 5620 SAM to automatically create and associate 
service tunnels with SDP bindings. In this case, you do not have to create service tunnels before 
you create the service.

4. Create and 
configure Subscriber 1 

Choose Manage→Subscribers to open the subscriber manager form and create a subscriber.

5. Create and 
configure Service 1

Choose Create→Service→VLL→Type of VLL service. Use the tabbed form and embedded 
navigation tree to configure the service. You configure the following key elements when you 
configure Service 1.

• Associate Subscriber 1 with the service.
• Specify Device 1 and Device 2 as the sites for the VLL service.
• Configure and specify Access Interface 1 and Access Interface 2 as the access interfaces for 

the VLL service. You do the following when you configure access interfaces.
• Specify the ports for the access interfaces. Ethernet ports must be configured as access 

ports.
• Specify participation of the access interfaces in access ingress, access egress, and ATM 

QoS policies as required.
• Specify participation of the access interfaces in aggregation rate limiting across a card or 

port. If aggregation is not required, specify participation of the access interfaces in ingress 
and egress scheduler policies.If aggregation is required, specify participation of the access 
interfaces in an aggregation scheduler policy.

• Specify participation of the access interfaces in scheduler policies as required.

Create and configure circuits in both directions. Associate the circuit from Device 1 to Device 2 with 
Service Tunnel 1. Associate the circuit from Device 2 to Device 1 with Service Tunnel 2. You can 
also configure the 5620 SAM to automatically create and associate service tunnels with circuits.
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2 Configure the network:

i Build the IP or IP/MPLS core network.

ii Configure ports for the service as access ports.

iii Configure service tunnels, if required.

3 Configure pre-defined QoS, scheduling, filter, and accounting policies.

4 Provision the service:

i Set up subscribers or associate existing subscribers with the new service.

ii Create the VLL service.

• Define the service type as Epipe, Apipe, or Fpipe
• Ensure that the LSP network is configured when the transport mechanism 

is MPLS
• Specify the devices (sites) used in the service
• Specify the access interfaces
• Specify aggregation on a service basis, or across a card or port
• Specify QoS, scheduling, accounting, and filter policies

5 Create SDP bindings to use the service tunnels.

6 Turn up the service.

30.4 VLL service management menus

Table 30-2 lists and describes the 5620 SAM service management menus.

Table 30-2 VLL service management menus

30.5 VLL service management procedures list

Table 30-3 lists the procedures necessary to perform VLL service creation and 
management tasks.

Menu option Description

Manage→Subscribers Create and manage subscribers.

Create→Service→VLL→Type of VLL service Create a VLL service using configuration forms.

Manage→Composite Services Create an HVPLS composite service to connect a 
VLL to a VPLS.

Create→Service From Template Create a service using a pre-configured template.

Manage→Services Perform a filtered search on services.

Application→Service Tunnel Topology View a graphical representation of service tunnels 
(SDPs).
30-8 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



30 —  VLL service management
Table 30-3 5620 SAM VLL service management procedures list

30.6 VLL service management procedures

Use the following procedures to perform VLL service creation and management 
tasks.

Procedure 30-1  To create a VLL Epipe service using configuration 
forms

1 Choose Create→Service→VLL→Epipe from the 5620 SAM main menu. The VLL 
Epipe (Create) form opens.

2 Click on the Select button to choose a subscriber to associate with the VLL service. 
The Select Subscriber form opens.

3 Select a subscriber for the VLL service and click on the OK button. The Select 
Subscriber - Epipe (Create) form closes and the VLL Epipe (Create) form reappears 
with the subscriber information displayed on the General tab.

Procedure Purpose

To create a VLL Epipe service using 
configuration forms

Create an Ethernet VLL service.

To create a VLL Apipe service using 
configuration forms

Create an ATM VLL service.

To create a VLL Fpipe service using 
configuration forms

Create a frame relay VLL service.

To create a VLL service using a template Create a VLL service using a template.

To create an HVPLS using spoke SDP 
connectors

See Procedure 31-3.

To modify a VLL service Modify VLL service parameters.

To view the service operational status View the operational status of the service.

To view the service topology View a graphical representation of VLL services 
that shows the sites and interfaces.

To delete a VLL service Delete a VLL service.
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4 Configure the following parameters:

• Auto-Assign ID
• Service ID
• Inherit Value
• Default VC ID
• Service Name
• Description
• Administrative State
• Automatic SDP Binding Creation
• Transport Type
• Use Bandwidth-Reserved Paths

The Service ID parameter is enabled when the Auto-Assign ID parameter is 
disabled.

The Default VC ID parameter is enabled when the Inherit Value parameter is 
disabled.

The Transport Type and Use Bandwidth-Reserved Paths parameters are 
configurable when the Automatic SDP Binding Creation parameter is enabled. 

5 Perform one of the following.

a Create a site for the VLL. Go to step 6.

b Complete VLL creation if sites and interfaces are to be created later. Go to 
step 38.

6 Click on the Components tab button.

7 Right-click on VLL Epipe and choose Create Site. The Select Network Elements - 
Epipe (Create) form opens with a list of available sites.

8 Select a site and click on the OK button. The Site (Create) form opens with the 
General tab displayed.

9 Configure the following parameters:

• Name
• Description
• MTU
• Administrative State
• Monitor Access Interface Operational State

10 Click on the Components tab button.

11 Right-click on Access Interfaces and choose Create L2 Access Interface. The L2 
Access Interface (Create) form opens with the General tab displayed.

12 Configure the following parameters:

• Description
• Administrative State
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13 Click on the Port tab button.

14 Click on the Select button to choose a port to associate with the L2 access interface. 
The Select Terminating Port - L2 Access Interface (Create) form opens.

15 Use the configurable filter and Search button to choose a port, and click on the OK 
button. The Select Terminating Port - L2 Access Interface (Create) form closes and 
the L2 Access Interface (Create) form reappears with the selected port information 
displayed.

16 Configure the following parameters:

• Outer Encapsulation Value
• Inner Encapsulation Value
• Outer Encapsulation Value (VPI)
• Inner Encapsulation Value (VCI)

The Outer Encapsulation Value parameter is configurable only when the port 
encapsulation type is Dot1 Q or Q in Q.

The Inner Encapsulation Value parameter is configurable only when the port 
encapsulation type is Q in Q.

The Outer Encapsulation Value (VPI) parameter is configurable only when the port 
encapsulation type is ATM.

The Inner Encapsulation Value (VCI) parameter is configurable only when the port 
encapsulation type is ATM.

17 Assign ingress and egress QoS policies to the interface, if required.

i Click on the QoS tab button.

ii Configure the following parameters:

• Ingress Match QinQ Dot1P
• Use Shared Queue

Note —  Only ports in access mode appear in the list. To choose a port 
that does not appear in the list, use the 5620 SAM navigation tree to 
select a port, choose Properties from the contextual menu, and set the 
Mode parameter to Access. Close and reopen the Select Terminating 
Port form; the reconfigured port appears.

Note —  Items such as policies, schedulers and filters can be applied 
later to multiple service components at once by selecting and 
right-clicking the components in the service components tree, choosing 
Properties, and configuring the parameters on the appropriate tab.
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The Ingress Match QinQ Dot1P parameter is not configurable if the port 
encapsulation type is ATM or FR.

iii Click on the Select button in the Ingress Policy panel to choose an ingress QoS 
policy. The Select Ingress Policy - L2 Access Interface (Create) form opens.

iv Select an ingress QoS policy and click on the OK button. The Select Ingress 
Policy - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form reappears with the ingress QoS policy information displayed.

v Click on the Select button in the Egress Policy panel to choose an egress QoS 
policy. The Select Egress Policy - L2 Access Interface (Create) form opens.

vi Select an egress QoS policy and click on the OK button. The Select Egress 
Policy - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form reappears with the egress QoS policy information displayed.

18 Assign ingress and egress schedulers, or an aggregation scheduler, to the 
interface, if required.

i Click on the Schedulers tab button.

ii Configure the Aggregation parameter to specify whether an aggregation 
scheduler policy is applied to the interface:

• Choose off.
• Choose on. Go to step viii.

iii Click on the Select button in the Ingress Scheduler panel to choose an ingress 
scheduler. The Select Ingress Scheduler - L2 Access Interface (Create) form 
opens.

iv Select an ingress scheduler and click on the OK button. The Select Ingress 
Scheduler - L2 Access Interface (Create) form closes and the L2 Access 
Interface (Create) form refreshes with the ingress scheduler information 
displayed.

v Click on the Select button in the Egress Scheduler panel to choose an egress 
scheduler. The Select Egress Scheduler - L2 Access Interface (Create) form 
opens.

vi Select an egress scheduler and click on the OK button. The Select Egress 
Scheduler - L2 Access Interface (Create) form closes and the L2 Access 
Interface (Create) form refreshes with the egress scheduler information 
displayed.

vii Go to step 19.

viii Click on the Select button in the Aggregation Scheduler panel to choose an 
aggregation scheduler. The Select Aggregation Scheduler - L2 Access 
Interface (Create) form opens.

ix Select an aggregation scheduler and click on the OK button. The Select 
Aggregation Scheduler - L2 Access Interface (Create) form closes and the L2 
Access Interface (Create) form refreshes with the aggregation scheduler 
information displayed.
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19 Assign ingress and egress ACL filters to the interface, if required.

i Click on the ACL tab button.

ii Click on the Select button in the Ingress Filter panel to choose an ingress ACL 
filter. The Select Ingress Filter - L2 Access Interface (Create) form opens.

iii Select an ingress ACL filter and click on the OK button. The Select Ingress 
Filter - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form reappears with the ingress ACL filter information displayed.

iv Click on the Select button in the Egress Filter panel to choose an egress ACL 
filter. The Select Egress Filter - L2 Access Interface (Create) form opens.

v Select an egress ACL filter and click on the OK button. The Select Egress Filter 
- L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form reappears with the egress ACL filter information displayed.

20 Assign an accounting policy to the interface, if required.

i Click on the Accounting tab button.

ii Configure the Collect Accounting Statistics parameter.

iii Click on the Select button to choose an accounting policy. The Select 
Accounting Policy - L2 Access Interface (Create) form opens.

iv Select an accounting policy and click on the OK button. The Select Accounting 
Policy - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form reappears with the accounting policy information displayed.

21 Specify OAM functionality and assign ingress and egress ATM policies to the 
interface, if required.

i Click on the ATM tab button.

ii Configure the following parameters:

• AAL5 Encapsulation
• ATM OAM Alarm Cell Handling

iii Click on the Select button in the Ingress ATM Policy panel to choose an ingress 
ATM policy. The Select Ingress ATM Policy - Sap Atm Configuration (Create) 
form opens.

iv Select an ingress ATM policy and click on the OK button. The Select Ingress 
ATM Policy - Sap Atm Configuration (Create) form closes and the L2 Access 
Interface (Create) form reappears with the ingress ATM policy information 
displayed.

v Click on the Select button in the Egress ATM Policy panel to choose an egress 
ATM policy. The Select Egress ATM Policy - Sap Atm Configuration (Create) 
form opens.

vi Select an egress ATM policy and click on the OK button. The Select Egress 
ATM Policy - Sap Atm Configuration (Create) form closes and the L2 Access 
Interface (Create) form reappears with the egress ATM policy information 
displayed.
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22 Click on the OK button. A warning dialog box appears.

23 Click on the OK button. The L2 Access Interface (Create) form closes, and the Site 
(Create) form reappears with the new interface information displayed in the service 
components tree.

24 Perform one of the following.

a Create another L2 access interface for the site to create a local VLL service. 
Repeat steps 10 to 23.

b Create a spoke SDP binding for the site. Go to step 25.

c Complete site creation. Go to step 35.

25 Click on the Components tab button.

26 Right-click on Spoke SDP Bindings and choose Create Spoke SDP Binding. The 
Spoke SDP Binding (Create) form opens with the General tab displayed.

27 Specify a destination node for the spoke SDP binding:

a If the destination node is a managed node, choose from a list of managed 
nodes.

i Click on the Select button in the Destination panel. The Select Destination 
Network Element (Create) form opens.

ii Select a destination node and click on the OK button. The Select 
Destination Network Element (Create) form closes and the Spoke SDP 
Binding (Create) form refreshes with the destination node identifier 
displayed.

b If the destination node is an unmanaged node, specify the system ID for the 
Destination Node ID parameter.

28 Configure the following parameters:

• VC Type
• VLAN VC Tag
• Ingress Label
• Egress Label

29 Perform one of the following.

a If the Automatic SDP Binding Creation parameter in step 4 is disabled, choose 
a service tunnel to associate with the spoke SDP binding:

i Click on the Select button in the Tunnel panel. The Select Tunnel - Spoke 
Sdp Binding (Create) form opens.

ii Select a service tunnel for the spoke SDP binding and click on the OK 
button. The Select Tunnel - Spoke Sdp Binding (Create) form closes and 
the Spoke Sdp Binding (Create) form refreshes with the service tunnel 
information displayed on the General tab.
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b If the Automatic SDP Binding Creation parameter in step 4 is enabled, 
configure the following parameters in the Tunnel Auto Selection panel:

• Tunnel Transport
• Return Tunnel Transport

30 Click on the States tab button.

31 Configure the Administrative State parameter.

32 Assign ingress and egress ACL filters to the spoke SDP binding, if required.

i Click on the ACL tab button.

ii Click on the Select button in the Ingress Filter panel to choose an ingress ACL 
filter. The Select Ingress Filter - Spoke Sdp Binding (Create) form opens.

iii Select an ingress ACL filter and click on the OK button. The Select Ingress 
Filter - Spoke Sdp Binding (Create) form closes and the Spoke Sdp Binding 
(Create) form reappears with the ingress ACL filter information displayed.

iv Click on the Select button in the Egress Filter panel to choose an egress ACL 
filter. The Select Egress Filter - Spoke Sdp Binding (Create) form opens.

v Select an egress ACL filter and click on the OK button. The Select Egress Filter 
- Spoke Sdp Binding (Create) form closes and the Spoke Sdp Binding (Create) 
form reappears with the egress ACL filter information displayed.

33 Click on the OK button. The Spoke SDP Binding (Create) form closes and a warning 
dialog box appears.

34 Click on the OK button. The Site (Create) form reappears with the new spoke SDP 
binding information displayed in the service components tree.

35 Click on the OK button. The Site (Create) form closes and a warning dialog box 
appears.

36 Click on the OK button. The VLL Epipe (Create) form reappears with the new 
information displayed in the service components tree.

37 Perform one of the following.

a Create an additional site for the VLL service, if required. Repeat steps 6 to 36.

b Complete service creation. Go to step 38.

38 Click on the OK button. The VLL Epipe (Create) form closes.

Procedure 30-2  To create a VLL Apipe service using configuration 
forms

1 Choose Create→Service→VLL→Apipe from the 5620 SAM main menu. The VLL 
Apipe (Create) form opens.
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2 Click on the Select button to choose a subscriber to associate with the VLL service. 
The Select Subscriber form opens.

3 Select a subscriber for the VLL service and click on the OK button. The Select 
Subscriber - Apipe (Create) form closes and the VLL Apipe (Create) form reappears 
with the subscriber information displayed on the General tab.

4 Configure the following parameters:

• Auto-Assign ID
• Service ID
• Inherit Value
• Default VC ID
• Service Name
• Description
• Administrative State
• Automatic SDP Binding Creation
• Transport Type
• Use Bandwidth-Reserved Paths
• VC Type

The Service ID parameter is enabled when the Auto-Assign ID parameter is 
disabled.

The Default VC ID parameter is enabled when the Inherit Value parameter is 
disabled.

The Transport Type and Use Bandwidth-Reserved Paths parameters are 
configurable when the Automatic SDP Binding Creation parameter is enabled. 

5 Perform one of the following.

a Create a site for the VLL. Go to step 6.

b Complete VLL creation if sites and interfaces are to be created later. Go to 
step 36.

6 Click on the Components tab button.

7 Right-click on VLL Apipe and choose Create Site. The Select Network Elements - 
Apipe (Create) form opens with a list of available sites.

8 Select a site and click on the OK button. The Site (Create) form opens with the 
General tab displayed.

9 Configure the following parameters:

• Name
• Description
• MTU
• Administrative State
• Monitor Access Interface Operational State
• Interworking Type

10 Click on the Components tab button.
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11 Right-click on Access Interfaces and choose Create L2 Access Interface. The L2 
Access Interface (Create) form opens with the General tab displayed.

12 Configure the following parameters:

• Description
• Administrative State
• ATM Connection Type

The ATM Connection Type parameter is configurable only when the VC Type 
parameter is set to Atm-cell in step 4.

13 Click on the Port tab button.

14 Click on the Select button to choose a port to associate with the L2 access interface. 
The Select Terminating Port - L2 Access Interface (Create) form opens.

15 Use the configurable filter and Search button to choose a port, and click on the OK 
button. The Select Terminating Port - L2 Access Interface (Create) form closes and 
the L2 Access Interface (Create) form reappears with the selected port information 
displayed.

16 Configure the following parameters:

• Outer Encapsulation Value (VPI)
• Inner Encapsulation Value (VCI)
• Encapsulation Value (Start VPI)
• Encapsulation Value (End VPI)
• Encapsulation Value (VPI)

The Encapsulation Value (Start VPI) parameter and the Encapsulation Value (End 
VPI) parameter are configurable only when the VC Type parameter is set to Atm-cell 
in step 4 and the ATM Connection Type parameter is set to PVT in step 12.

The Encapsulation Value (VPI) parameter is configurable only when the VC Type 
parameter is set to Atm-vpc in step 4.

17 Assign ingress and egress QoS policies to the interface, if required.

Note —  Only ports in access mode appear in the list. To choose a port 
that does not appear in the list, use the 5620 SAM navigation tree to 
select a port, choose Properties from the contextual menu, and set the 
Mode parameter to Access. Close and reopen the Select Terminating 
Port form; the reconfigured port appears.
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i Click on the QoS tab button.

ii Configure the Use Shared Queue parameter.

iii Click on the Select button in the Ingress Policy panel to choose an ingress QoS 
policy. The Select Ingress Policy - L2 Access Interface (Create) form opens.

iv Select an ingress QoS policy and click on the OK button. The Select Ingress 
Policy - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form reappears with the ingress QoS policy information displayed.

v Click on the Select button in the Egress Policy panel to choose an egress QoS 
policy. The Select Egress Policy - L2 Access Interface (Create) form opens.

vi Select an egress QoS policy and click on the OK button. The Select Egress 
Policy - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form reappears with the egress QoS policy information displayed.

Note —  Items such as policies, schedulers, and filters can be applied 
later to multiple service components at once by selecting and 
right-clicking the components in the service components tree, choosing 
Properties, and configuring the parameters on the appropriate tab.
30-18 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



30 —  VLL service management
18 Assign ingress and egress schedulers, or an aggregation scheduler, to the 
interface, if required.

i Click on the Schedulers tab button.

ii Configure the Aggregation parameter to specify whether an aggregation 
scheduler policy is applied to the interface:

• Choose off.
• Choose on. Go to step viii.

iii Click on the Select button in the Ingress Scheduler panel to choose an ingress 
scheduler. The Select Ingress Scheduler - L2 Access Interface (Create) form 
opens.

iv Select an ingress scheduler and click on the OK button. The Select Ingress 
Scheduler - L2 Access Interface (Create) form closes and the L2 Access 
Interface (Create) form refreshes with the ingress scheduler information 
displayed.

v Click on the Select button in the Egress Scheduler panel to choose an egress 
scheduler. The Select Egress Scheduler - L2 Access Interface (Create) form 
opens.

vi Select an egress scheduler and click on the OK button. The Select Egress 
Scheduler - L2 Access Interface (Create) form closes and the L2 Access 
Interface (Create) form refreshes with the egress scheduler information 
displayed.

vii Go to step 19.

viii Click on the Select button in the Aggregation Scheduler panel to choose an 
aggregation scheduler. The Select Aggregation Scheduler - L2 Access 
Interface (Create) form opens.

ix Select an aggregation scheduler and click on the OK button. The Select 
Aggregation Scheduler - L2 Access Interface (Create) form closes and the L2 
Access Interface (Create) form refreshes with the aggregation scheduler 
information displayed.

19 Assign an accounting policy to the interface, if required.

i Click on the Accounting tab button.

ii Configure the Collect Accounting Statistics parameter.

iii Click on the Select button to choose an accounting policy. The Select 
Accounting Policy - L2 Access Interface (Create) form opens.

iv Select an accounting policy and click on the OK button. The Select Accounting 
Policy - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form reappears with the accounting policy information displayed.
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20 Specify OAM functionality and assign ingress and egress ATM policies to the 
interface, if required.

i Click on the ATM tab button.

ii Configure the following parameters:

• ATM OAM Alarm Cell Handling
• ATM OAM Terminate

The ATM OAM Alarm Cell Handling parameter is configurable only when the 
VC Type parameter is set to Atm-vcc or Atm-vpc in step 4.

The ATM OAM Terminate parameter is configurable only when the VC Type 
parameter is set to Atm-sdu in step 4.

iii Click on the Select button in the Ingress ATM Policy panel to choose an ingress 
ATM policy. The Select Ingress ATM Policy - Sap Atm Configuration (Create) 
form opens.

iv Select an ingress ATM policy and click on the OK button. The Select Ingress 
ATM Policy - Sap Atm Configuration (Create) form closes and the L2 Access 
Interface (Create) form reappears with the ingress ATM policy information 
displayed.

v Click on the Select button in the Egress ATM Policy panel to choose an egress 
ATM policy. The Select Egress ATM Policy - Sap Atm Configuration (Create) 
form opens.

vi Select an egress ATM policy and click on the OK button. The Select Egress 
ATM Policy - Sap Atm Configuration (Create) form closes and the L2 Access 
Interface (Create) form reappears with the egress ATM policy information 
displayed.

21 Click on the OK button. A warning dialog box appears.

22 Click on the OK button. The L2 Access Interface (Create) form closes, and the Site 
(Create) form reappears with the new interface information displayed in the service 
components tree.

23 Perform one of the following.

a Create another L2 access interface for the site to create a local VLL service. 
Repeat steps 10 to 22.

b Create a spoke SDP binding for the site. Go to step 24.

c Complete site creation. Go to step 33.

24 Click on the Components tab button.

25 Right-click on Spoke SDP Bindings and choose Create Spoke SDP Binding. The 
Spoke SDP Binding (Create) form opens with the General tab displayed.

26 Specify a destination node for the spoke SDP binding:

a If the destination node is a managed node, choose from a list of managed 
nodes.
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i Click on the Select button in the Destination panel. The Select Destination 
Network Element (Create) form opens.

ii Select a destination node and click on the OK button. The Select 
Destination Network Element (Create) form closes and the Spoke SDP 
Binding (Create) form refreshes with the destination node identifier 
displayed.

b If the destination node is an unmanaged node, specify the system ID for the 
Destination Node ID parameter.

27 Configure the following parameters:

• Ingress Label
• Egress Label

28 Perform one of the following.

a If the Automatic SDP Binding Creation parameter in step 4 is disabled, choose 
a service tunnel to associate with the spoke SDP binding:

i Click on the Select button in the Tunnel panel. The Select Tunnel - Spoke 
Sdp Binding (Create) form opens.

ii Select a service tunnel for the spoke SDP binding and click on the OK 
button. The Select Tunnel - Spoke Sdp Binding (Create) form closes and 
the Spoke Sdp Binding (Create) form refreshes with the service tunnel 
information displayed on the General tab.

b If the Automatic SDP Binding Creation parameter in step 4 is enabled, 
configure the following parameters:

• Tunnel Transport
• Return Tunnel Transport

29 Click on the States tab button.

30 Configure the Administrative State parameter.

31 Click on the OK button. The Spoke SDP Binding (Create) form closes and a warning 
dialog box appears.

32 Click on the OK button. The Site (Create) form reappears with the new spoke SDP 
binding information displayed in the service components tree.

33 Click on the OK button. The Site (Create) form closes and a warning dialog box 
appears.

34 Click on the OK button. The VLL Apipe (Create) form reappears with the new 
information displayed in the service components tree.

35 Perform one of the following.

a Create an additional site for the VLL service, if required. Repeat steps 6 to 34.

b Complete service creation. Go to step 36.
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36 Click on the OK button. The VLL Apipe (Create) form closes.

Procedure 30-3  To create a VLL Fpipe service using configuration 
forms

1 Choose Create→Service→VLL→Fpipe from the 5620 SAM main menu. The VLL 
Fpipe (Create) form opens.

2 Click on the Select button to choose a subscriber to associate with the VLL service. 
The Select Subscriber form opens.

3 Select a subscriber for the VLL service and click on the OK button. The Select 
Subscriber - Fpipe (Create) form closes and the VLL Fpipe (Create) form reappears 
with the subscriber information displayed on the General tab.

4 Configure the following parameters:

• Auto-Assign ID
• Service ID
• Inherit Value
• Default VC ID
• Service Name
• Description
• Administrative State
• Automatic SDP Binding Creation
• Transport Type
• Use Bandwidth-Reserved Paths
• VC Type

The Service ID parameter is enabled when the Auto-Assign ID parameter is 
disabled.

The Default VC ID parameter is enabled when the Inherit Value parameter is 
disabled.

The Transport Type and Use Bandwidth-Reserved Paths parameters are 
configurable when the Automatic SDP Binding Creation parameter is enabled. 

5 Perform one of the following.

a Create a site for the VLL. Go to step 6.

b Complete VLL creation if sites and interfaces are to be created later. Go to 
step 35.

6 Click on the Components tab button.

7 Right-click on VLL Fpipe and choose Create Site. The Select Network Elements - 
Fpipe (Create) form opens with a list of available sites.

8 Select a site and click on the OK button. The Site (Create) form opens with the 
General tab displayed.
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9 Configure the following parameters:

• Name
• Description
• MTU
• Administrative State
• Monitor Access Interface Operational State

10 Click on the Components tab button.

11 Right-click on Access Interfaces and choose Create L2 Access Interface. The L2 
Access Interface (Create) form opens with the General tab displayed.

12 Configure the following parameters:

• Description
• Administrative State

13 Click on the Port tab button.

14 Click on the Select button to choose a port to associate with the L2 access interface. 
The Select Terminating Port - L2 Access Interface (Create) form opens.

15 Use the configurable filter and Search button to choose a port, and click on the OK 
button. The Select Terminating Port - L2 Access Interface (Create) form closes and 
the L2 Access Interface (Create) form reappears with the selected port information 
displayed.

16 Configure the Outer Encapsulation Value parameter.

17 Assign ingress and egress QoS policies to the interface, if required.

Note —  Only ports in access mode appear in the list. To choose a port 
that does not appear in the list, use the 5620 SAM navigation tree to 
select a port, choose Properties from the contextual menu, and set the 
Mode parameter to Access. Close and reopen the Select Terminating 
Port form; the reconfigured port appears.
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i Click on the QoS tab button.

ii Configure the Use Shared Queue parameter.

iii Click on the Select button in the Ingress Policy panel to choose an ingress QoS 
policy. The Select Ingress Policy - L2 Access Interface (Create) form opens.

iv Select an ingress QoS policy and click on the OK button. The Select Ingress 
Policy - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form reappears with the ingress QoS policy information displayed.

v Click on the Select button in the Egress Policy panel to choose an egress QoS 
policy. The Select Egress Policy - L2 Access Interface (Create) form opens.

vi Select an egress QoS policy and click on the OK button. The Select Egress 
Policy - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form reappears with the egress QoS policy information displayed.

Note —  Items such as policies, schedulers, and filters can be applied 
later to multiple service components at once by selecting and 
right-clicking the components in the service components tree, choosing 
Properties, and configuring the parameters on the appropriate tab.
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18 Assign ingress and egress schedulers, or an aggregation scheduler, to the 
interface, if required.

i Click on the Schedulers tab button.

ii Configure the Aggregation parameter to specify whether an aggregation 
scheduler policy is applied to the interface:

• Choose off.
• Choose on. Go to step viii.

iii Click on the Select button in the Ingress Scheduler panel to choose an ingress 
scheduler. The Select Ingress Scheduler - L2 Access Interface (Create) form 
opens.

iv Select an ingress scheduler and click on the OK button. The Select Ingress 
Scheduler - L2 Access Interface (Create) form closes and the L2 Access 
Interface (Create) form refreshes with the ingress scheduler information 
displayed.

v Click on the Select button in the Egress Scheduler panel to choose an egress 
scheduler. The Select Egress Scheduler - L2 Access Interface (Create) form 
opens.

vi Select an egress scheduler and click on the OK button. The Select Egress 
Scheduler - L2 Access Interface (Create) form closes and the L2 Access 
Interface (Create) form refreshes with the egress scheduler information 
displayed.

vii Go to step 19.

viii Click on the Select button in the Aggregation Scheduler panel to choose an 
aggregation scheduler. The Select Aggregation Scheduler - L2 Access 
Interface (Create) form opens.

ix Select an aggregation scheduler and click on the OK button. The Select 
Aggregation Scheduler - L2 Access Interface (Create) form closes and the L2 
Access Interface (Create) form refreshes with the aggregation scheduler 
information displayed.

19 Assign ingress and egress ACL filters to the interface, if required.

i Click on the ACL tab button.

ii Click on the Select button in the Ingress Filter panel to choose an ingress ACL 
filter. The Select Ingress Filter - L2 Access Interface (Create) form opens.

iii Select an ingress ACL filter and click on the OK button. The Select Ingress 
Filter - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form reappears with the ingress ACL filter information displayed.

iv Click on the Select button in the Egress Filter panel to choose an egress ACL 
filter. The Select Egress Filter - L2 Access Interface (Create) form opens.

v Select an egress ACL filter and click on the OK button. The Select Egress Filter 
- L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form reappears with the egress ACL filter information displayed.
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20 Assign an accounting policy to the interface, if required.

i Click on the Accounting tab button.

ii Configure the Collect Accounting Statistics parameter.

iii Click on the Select button to choose an accounting policy. The Select 
Accounting Policy - L2 Access Interface (Create) form opens.

iv Select an accounting policy and click on the OK button. The Select Accounting 
Policy - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form reappears with the accounting policy information displayed.

21 Click on the OK button. A warning dialog box appears.

22 Click on the OK button. The L2 Access Interface (Create) form closes, and the Site 
(Create) form reappears with the new interface information displayed in the service 
components tree.

23 Perform one of the following.

a Create another L2 access interface for the site to create a local VLL service. 
Repeat steps 10 to 22.

b Create a spoke SDP binding for the site. Go to step 24.

c Complete site creation. Go to step 32.

24 Click on the Components tab button.

25 Right-click on Spoke SDP Bindings and choose Create Spoke SDP Binding. The 
Spoke SDP Binding (Create) form opens with the General tab displayed.

26 Specify a destination node for the spoke SDP binding:

a If the destination node is a managed node, choose from a list of managed 
nodes.

i Click on the Select button in the Destination panel. The Select Destination 
Network Element (Create) form opens.

ii Select a destination node and click on the OK button. The Select 
Destination Network Element (Create) form closes and the Spoke SDP 
Binding (Create) form refreshes with the destination node identifier 
displayed.

b If the destination node is an unmanaged node, specify the system ID for the 
Destination Node ID parameter.

27 Configure the following parameters:

• Ingress Label
• Egress Label

28 Perform one of the following.

a If the Automatic SDP Binding Creation parameter in step 4 is disabled, choose 
a service tunnel to associate with the spoke SDP binding:
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i Click on the Select button in the Tunnel panel. The Select Tunnel - Spoke 
Sdp Binding (Create) form opens.

ii Select a service tunnel for the spoke SDP binding and click on the OK 
button. The Select Tunnel - Spoke Sdp Binding (Create) form closes and 
the Spoke Sdp Binding (Create) form refreshes with the service tunnel 
information displayed on the General tab.

b If the Automatic SDP Binding Creation parameter in step 4 is enabled, 
configure the following parameters:

• Tunnel Transport
• Return Tunnel Transport

29 Click on the States tab button.

30 Configure the Administrative State parameter.

31 Assign ingress and egress ACL filters to the spoke SDP binding, if required.

i Click on the ACL tab button.

ii Click on the Select button in the Ingress Filter panel to choose an ingress ACL 
filter. The Select Ingress Filter - Spoke Sdp Binding (Create) form opens.

iii Select an ingress ACL filter and click on the OK button. The Select Ingress 
Filter - Spoke Sdp Binding (Create) form closes and the Spoke Sdp Binding 
(Create) form reappears with the ingress ACL filter information displayed.

iv Click on the Select button in the Egress Filter panel to choose an egress ACL 
filter. The Select Egress Filter - Spoke Sdp Binding (Create) form opens.

v Select an egress ACL filter and click on the OK button. The Select Egress Filter 
- Spoke Sdp Binding (Create) form closes and the Spoke Sdp Binding (Create) 
form reappears with the egress ACL filter information displayed.

32 Click on the OK button. The Spoke Sdp Binding (Create) form closes and a warning 
dialog box appears.

33 Click on the OK button. The Site (Create) form reappears with the new information 
displayed in the service components tree.

34 Perform one of the following.

a Create an additional site for the VLL service, if required. Repeat steps 6 to 33.

b Complete service creation. Go to step 35.

35 Click on the OK button. A warning dialog box appears.

36 Click on the OK button. The VLL Fpipe (Create) form reappears.

37 Click on the OK button. The VLL Fpipe (Create) form closes.
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Procedure 30-4  To create a VLL service using a template

1 Choose Create→Service From Template from the 5620 SAM main menu. The 
Create Service From Template form opens, as shown in Figure 30-1.

2 Select the template associated with the service that you want to add to the 
5620 SAM.

3 Click on the OK button. The service template creation form opens.

4 Configure the parameters. The 5620 SAM administrator defines the parameters that 
you can configure. An exclamation mark (!) identifies parameters that you must 
configure before using the template. (The ! icon also appears on the tabs containing 
parameters that require configuration.) A lock icon identifies parameters restricted 
by the 5620 SAM administrator. See chapter 17 for more information about the 
administrative tasks associated with service templates.

See chapter 48 for information about the parameters associated with creating a VLL 
service.

5 Click on the appropriate tab buttons to add site, interface, or SDP binding service 
components, if required. The template administrator can create secondary site, 
interface, and SDP binding templates and bind them to the primary VLL template. 
See chapter 17 for more information about the administrative tasks associated with 
service templates.

6 Click on the OK button to save the changes and close the service template creation 
form.

Procedure 30-5  To modify a VLL service

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a VLL service and click on the Edit button. The VLL Type of VLL (Edit) form 
opens with the general properties of the service displayed on the General tab.

Caution —  Modifying parameters can be service-affecting.
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The following tabs list the service elements that can be individually or collectively 
selected and configured:

• Components tab — displays the various service components in a tree format
• Sites tab — lists the sites that are included in the service
• L2 Access Interfaces tab — lists the L2 access interfaces that are included in the 

service
• Spoke SDP Bindings tab — displays the spoke SDP bindings that are associated 

with the service
• Faults tab — displays the faults associated with the service

4 Modify the parameters for the service as required.

To configure items in the Components tab, select and right-click on the items and 
choose Properties from the contextual menu.

To configure items on the tabs that contain lists of service elements, select the items 
and click on the Edit button.

5 Click on the OK button. A confirmation dialog box appears.

6 Click on the Yes button to confirm the action. The VLL Type of VLL (Edit) form 
closes and the Manage Services form reappears.

7 Click on the Close button to close the Manage Services form.

Procedure 30-6  To view the service operational status

The Aggregated Operational State and State Cause indicators on the General tab of the 
service management form display information about service faults.

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a service and click on the Edit button. The VLL Type of VLL (Edit) form opens.

4 View the Aggregated Operational State and State Cause indicators. When the 
Aggregated Operational State is Down or Partially Down, a check mark beside the 
appropriate State Cause indicator identifies the type of associated service fault.

5 Click on the appropriate tab button to view or edit an object that is identified as faulty 
by a State Cause indicator.

6 Click on the Faults tab button to view the alarms for the object. The Object Alarms 
tab is displayed.

7 Click on the Aggregated Alarms tab button to view the aggregated alarms for the 
object. The Aggregated Alarms tab is displayed.

8 Close the VLL Type of VLL (Edit) form.
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9 Click on the Close button to close the Manage Services form.

Procedure 30-7  To view the service topology

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a VLL service and click on the Topology View button. A Topology View dialog 
box appears.

4 Click on the Yes button to proceed. The Service Topology - Service Name map 
opens.

See chapter 37 for more information about service topology views.

Procedure 30-8  To delete a VLL service

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Choose a VLL service from the list.

4 Click on the Remove button. A confirmation dialog box appears.

5 Click on the Yes button to confirm the action. The service is deleted and removed 
from the list.

6 Click on the Close button to close the Manage Services form.
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31.1 VPLS management overview

The 5620 SAM supports VPLS multipoint switched service on edge 7750 SRs and 
7450 ESSes. VPLS is a class of virtual private network multipoint L2 service that 
allows multiple customer sites to be connected in a single bridged domain contained 
within the service provider-managed IP/MPLS network. Customer sites in the VPLS 
appear to be on the same LAN, even if the sites are geographically dispersed. 

 VPLS offers the following advantages:

• Ethernet interfaces on the customer access side simplify provisioning.
• All routers in the VPLS are part of the same LAN, which simplifies IP addressing 

and allows customers to control and simplify their routing strategies.
• VPLS is protocol independent, which means there is no L2 protocol conversion 

between LAN and WAN technologies.

A VPLS can span a single site or multiple sites. A VPLS that spans a single site is 
called a local VPLS. In a local VPLS, subscriber data enters the service through 
multiple access interfaces on a single PE device. No circuit provisioning is required 
for the local VPLS.

A VPLS that spans multiple sites is called a distributed VPLS. In a distributed VPLS, 
customer data enters the service using two or more interfaces on different PE 
devices. The VPLS is transported by service circuits over an IP/MPLS provider core 
network carried by service tunnels. Service tunnels are created using GRE or MPLS 
LSPs.

You can use HVPLS to eliminate the need for a full mesh of virtual circuits between 
devices in the VPLS. See “HVPLS” in this section for more information.

The 5620 SAM supports end-to-end VPLS configuration using the following 
methods:

• Tabbed configuration forms with an embedded navigation tree. The navigation 
tree provides a logical view of the service and acts as a configuration interface. 

• Pre-configured template. Figure 31-1 shows the Create Service From Template 
form. A user with Service Mgmt privileges can create a service template. See 
chapter 17 for more information about the administrative tasks associated with 
service templates.

Figure 31-1  Create Service From Template form
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Figure 31-2  VPLS management form - General tab

The General tab of the 5620 SAM service management form displays useful 
information about the operational state of the service and its sites through the 
Aggregated Operational State and State Cause indicators, as shown in Figure 31-2.

The Aggregated Operational State indicator has four possible values: Up, Down, 
Partially Down, and Unknown. The value is derived from the operational states of 
the sites that are part of the service, as follows:

• Up—All sites are operationally up
• Partially Down—At least one site is operationally down
• Down—All sites are operationally down
• Unknown—The service has no provisioned sites

When the Aggregated Operational State is Partially Down or Down, a check mark 
appears beside the appropriate State Cause indicator to identify the type of fault to 
the 5620 SAM operator.
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Common to all services, such as VPLS, are policies that are assigned to the service. 
Policies are defined at a global level and can then be applied to components of the 
service, such as interfaces and circuits, when the service is configured or modified. 
The following policies are common to all services:

• QoS policies to define ingress classification, policing, shaping, and marking on 
the ingress side of the interface. QoS policies are configured using the Access 
Ingress Policy Manager and the Access Egress Policy Manager.

• Scheduling policies to define hierarchical rate limiting and scheduling to govern 
the scheduling of queues. Scheduler policies are configured using the Scheduler 
Policy Manager.

• Filter policies to control network traffic into or out of an interface or circuit based 
on IP or MAC matching criteria. Filter policies are configured using the ACL IP 
Filter Manager and the ACL MAC Filter Manager.

• Accounting policies to count the traffic on a service to ensure proper billing and 
enforcement of SLAs. Accounting policies are configured using the Accounting 
Policy Manager.

See chapter 28 for more information about policies.

Packets that arrive at an edge device are associated with a VPLS based on the access 
interface on which they arrive. An access interface is uniquely identified using the 
following parameters:

• physical Ethernet port or POS port and channel
• encapsulation type
• encapsulation identifier (if required)

If there are service issues, the service provider can use OAM tools to troubleshoot 
service and network transport issues, and ensure problems are handled properly 
through the physical and logical network. See chapter 39 for more information.

To provide a VPLS over an MPLS infrastructure, the device is configured to provide 
bridging and replication for each VPLS. The routers that are part of the VPLS are 
connected by MPLS LSPs. Multiple VPLSes can use the same set of service tunnels. 
Multiple service tunnels can rely on multiple LSPs. The signaling is specified in sets 
of ingress and egress VC labels for each VPLS.

The following additional features are configured for the VPLS.

• MAC learning for the access ports and tunnels, including filtering based on MAC 
addresses on a per SAP basis

• rate limiting of broadcast, destination unknown, and multicast traffic on a per 
access port basis

• FIB for each VPLS, including FIB size limits, static MAC addresses, alarms, and 
discarding unknown locations

• optional support for spanning tree for loop detection

HVPLS

A hierarchical VPLS is created by enhancing the VPLS core mesh with access-spoke 
circuits interconnected to another VPLS, a VLL, or a site.
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HVPLS offers the following advantages:

• reduces the complexity of mesh configuration
• decreases the amount of signaling of routes between devices

When traffic arrives at an access-spoke circuit, it acts like a bridge port where 
flooded traffic received on the access spoke is replicated to all other spokes, meshes, 
or service access points but it is not transmitted on the port where it is received.

Figure 31-3 shows a sample HVPLS with a mesh and spoke configuration. Spokes 
50 and 51 are unidirectional access-spoke circuits bound to service tunnels. The 
access-spoke circuits exist within the context of a VLL service or VPLS that is 
interconnected to the original, fully meshed VPLS. Alternatively, the access-spoke 
circuit can provide interconnectivity to a service site.

Figure 31-3  HVPLS configuration

The 5620 SAM supports the following HVPLS interconnectivity via spoke SDPs:

• VPLS to VPLS 
• VPLS to VLL

HVPLS is a composite service. All component VPLS or VLL services are created 
separately, then linked by composite-service spoke SDP connectors.
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MVPLS

VPLS topology loops can occur if:

• two VPLSes are connected by redundant spoke SDPs, or
• a customer-edge site is connected to a VPLS with redundant L2 access interfaces.

To remove topology loops, RSTP must be run on the redundant spoke SDPs or L2 
access interfaces to block some of them from passing traffic. Both cases require the 
implementation of an MVPLS. Note that SDPs are equivalent to service tunnels and 
SDP bindings are the association of a circuit with a service tunnel.

An MVPLS is created to run RSTP and manage traffic on the associated VPLSes. An 
MVPLS contains sites, spoke SDP bindings, mesh SDP bindings, and L2 access 
interfaces. The MVPLS spoke SDP bindings and L2 access interfaces are configured 
to manage the associated VPLS spoke SDP bindings and L2 access interfaces. 

In the case of spoke redundancy, the MVPLS runs RSTP on the redundant spoke 
SDPs and associates the resultant traffic-blocking actions with all VPLSes that use 
the same spoke SDPs. Mesh SDP traffic is not affected.

MVPLS traffic blocking can also be used on the access side to manage redundant L2 
access interface connections. A VLAN ID range is specified for each MVPLS L2 
access interface which identifies the VC IDs of the managed VPLS L2 access 
interfaces.

RSTP is enabled by default on an MVPLS. When the Admin state of an MVPLS is 
down, all managed L2 access interfaces and spoke SDPs in the associated VPLSes 
are disabled. However, if the Admin state of individual L2 access interfaces or spoke 
SDPs of an MVPLS are down, then the managed VPLS L2 access interfaces or spoke 
SDPs are not affected by traffic blocking.

A common MVPLS situation occurs when two VPLSes are connected by redundant 
spoke SDPs. If traffic is not blocked on one of the redundant spoke SDPs, then a loop 
results. To remove the loop, RSTP must be run on the spoke SDPs that form the loop 
to block one of the redundant spoke SDPs. Blocking is accomplished by creating an 
MVPLS on each side of the redundant spoke SDPs and creating a composite MVPLS 
to connect the MVPLSes. 

Figure 31-4 shows an example of a composite MVPLS composed of MVPLS1 and 
MVPLS2, with connecting spoke SDPs.
31-6 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



31 —  VPLS management
Figure 31-4  MVPLS composite service

Another scenario occurs when multiple L2 access interfaces from a VPLS are 
connected to the same customer edge equipment. In this case, a single MVPLS must 
be created with L2 access interfaces defined to manage the traffic on the associated 
VPLS redundant L2 access interfaces. 

MVR VPLS

Multicast VPLS Registration (MVR) is a bandwidth optimization method for 
applications on a broadband services network. MVR allows a subscriber on a port to 
subscribe and unsubscribe to a multicast stream on one or more network-wide 
multicast VPLS instances.

MVR assumes that subscribers join and leave multicast streams by sending IGMP 
join and leave messages. The IGMP leave and join message are sent inside the 
VLAN to which the subscriber port is assigned. The multicast VPLS is shared in the 
network while the subscribers remain in separate VLANs.

Using MVR, users on different VLANs cannot exchange any information between 
them, but still multicast services are provided.

An MVR VPLS is a VPLS that is responsible for sending multicast traffic through 
the network. A user VPLS is a VPLS that contains SAPs that receive multicast traffic 
from an MVR VPLS. Each SAP is configured to us a specific MVR VPLS. An MVR 
VPLS can also be a user VPLS.

On an MVR VPLS, IGMP snooping must be enabled. On the user VPLS, IGMP 
snooping and MVR work independently. If IGMP snooping and MVR are both 
enabled, MVR reacts only to join and leave messages from multicast groups 
configured under MVR. Join and leave messages from all other multicast groups are 
managed by IGMP snooping. This way, potentially several MVR VPLS instances 
could be configured, each with its own set of multicast channels.
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The 7450 ESS, Release 3.0 or later, allows multicast traffic to be sent to a SAP other 
than the one that originated the IGMP message. The IGMP SAP acts as an MVR 
proxy to the destination SAP. When configuring MVR by proxy, you must indicate 
the MVR VPLS on which the multicast channel is available and the SAP to which 
the multicast traffic must be copied. The multicast traffic must not be copied from 
the MVR VPLS to the VLAN on which the IGMP message was received but to 
another VLAN.

FIBs

The edge devices perform the packet replication required for broadcast and multicast 
traffic across the bridged domain. Devices perform MAC-address learning to reduce 
the amount of unknown destination MAC address flooding. The edge devices learn 
the source MAC addresses of the traffic arriving on their access and network ports. 
You can also specify and manage static MAC addresses using the FIB entries table.

Each device maintains a FIB for each VPLS instance. Learned MAC addresses are 
populated in the FIB table of the service. All traffic is switched based on MAC 
addresses and forwarded between all participating sites using the service. Unknown 
destination packets (i.e., the destination MAC address has not been learned) are 
forwarded on all LSPs to the participating devices for that service until the router 
responds and the MAC address is learned by the device associated with that service.

The size of the VPLS FIB can be configured with a low watermark and a high 
watermark expressed as a percentage of the total FIB size limit. If the actual FIB size 
grows above the configured high watermark percentage, an alarm is generated. If the 
FIB size falls below the configured low watermark percentage, the alarm is cleared.

MAC learning

Like an L2 device, learned MACs within a VPLS instance can be aged out if no 
packets are sourced from the MAC address for a specified period of time (the aging 
time). In each VPLS, there are independent aging timers for locally learned MAC 
and remotely learned MAC entries in the FIB. A local MAC address is a MAC 
address associated with an access interface, because it ingressed on a SAP. A remote 
MAC address is a MAC address received via a service tunnel from another device 
that is part of the VPLS.

Unknown MAC discard is a feature which discards all packets ingressing the service 
where the destination MAC address is not in the FIB. The normal behavior is to flood 
these packets to all end points in the service.

MAC move

A sustained high MAC re-learn rate can be a sign of a loop somewhere in the VPLS 
topology. Typically, STP detects loops in the topology, but for those networks that 
do not run STP, the MAC move feature is an alternative way to protect the network 
against loops.

Note —  Each VPLS FIB entry consumes system resources. The 
devices allow you to set the maximum number of MAC entries 
allowed in a VPLS instance to prevent a VPLS instance from 
consuming a disproportionate amount of resources.
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When enabled on a VPLS, MAC move monitors the re-learn rate of each MAC. If 
the rate exceeds the configured maximum allowed limit, it disables the SAP where 
the source MAC was last seen. The SAP can be disabled permanently, or for a length 
of time that grows linearly with the number of times the SAP was disabled.

There is also the option of marking a SAP as non-blockable, meaning that when the 
re-learn rate has exceeded the limit, another (blockable) SAP will be disabled 
instead.

The MAC move feature can be enabled at the VPLS level for SAPs and spoke SDPs. 

Flooding

Traffic that is normally flooded throughout the VPLS can be rate limited on SAP 
ingress through the use of Service Ingress QoS Policies. In a Service Ingress QoS 
Policy, individual queues can be defined per forwarding class to provide shaping of 
broadcast traffic, MAC multicast traffic and unknown destination MAC traffic. You 
can also specify how to classify frames.

Multiple services and service types can be configured on a port. VPLS spanning tree 
protocols are configured on a per-service site basis, not a per-port basis, thus, 
multiple instances of STP per site are supported. Unknown destinations, broadcasts, 
and multicasts are flooded to all other SAPs in the service.

The flooding mechanism and the way that the Interior Gateway Protocol (IGP) 
operates ensure that no packets are duplicated on any interface. If SAPs are 
connected together, either through misconfiguration or for redundancy purposes, 
loops can form and duplicate packets can traverse the network. The STP is designed 
to prevent multiple SAPs from forwarding a packet into the VPLS

Spanning tree protocols

The 5620 SAM supports RSTP for VPLS instances and maintains support for legacy 
STP implementations. STP on the 7750 SR incorporates an optimized and 
compatible implementation of IEEE 802.1D which attempts to eliminate STP 
blocking of links in the core of the VPLS. STP on the 7450 ESS is used to guarantee 
that service tunnels are not blocked in any circumstance while not imposing artificial 
restrictions on the placement of the root bridge within the network. To provide this 
support, all mesh service tunnels are configured as root ports or designated ports.

RSTP, which is the default STP mode managed by the 5620 SAM, is compliant with 
IEEE standard 802.1D-2004. Other available STP types include an RSTP variant 
with 802.1w backward compatibility and an STP variant that is compliant with 
802.1w.

The 5620 SAM verifies STP parameters that are configured within each VPLS 
instance. However, it does not check the compatibility of STP configurations 
between interconnected VPLS instances.
Alcatel 5620 Service Aware Manager, Release 3.0 R1 31-9
October 2005 3HE00214 CA



31 —  VPLS management
IGMP snooping

IGMP snooping allows a device to snoop packets sent between IP multicast routers 
or switches and IP multicast hosts in order to learn the IP multicast group 
membership. The device checks the IGMP packets for the group registration 
information, and configures multicasting accordingly. 

Without IGMP snooping, multicast traffic is forwarded to all ports, which is the same 
as broadcast traffic. IGMP snooping ensures that multicast traffic is only forwarded 
to ports that are members of the specific multicast group, which reduces the amount 
of multicast traffic passing through the device. 

You can enable IGMP snooping for VPLS on 7450 ESS and 7750 SR, Release 3.0. 
A database of group members per VPLS instance is built by listening to IGMP 
queries and reports from each SAP and SDP of the instance. The reports are 
forwarded to the multicast routers.

Split horizon groups

SHGs control traffic that flows through SAPs or spoke SDPs for a VPLS site. SHGs 
prevent a packet received on a SAP within the group from being propagated to other 
members of the group.

SHGs are defined when you create or modify a VPLS site. You can create multiple 
SHGs for a VPLS site. SHGs can support a mix of spoke SDPs and SAPs. When you 
create SAPs or spoke SDPs they can be associated with an SHG.

Users can: 

• configure, modify, or delete SHGs on a VPLS site
• associate SAPs or spoke SDPs with SHGs

Residential split horizon groups

RSHGs are SHGs with the Residential parameter enabled. SAPs that are associated 
with RSHGs are called lightweight SAPs. RSHGs use dual-pass queue optimization 
and do not support downstream broadcast or multicast traffic.

Users can: 

• configure, modify, or delete RSHGs on a VPLS site
• associate SAPs or spoke SDPs with RSHGs

Note —  If a SAP or spoke SDP is associated with an RSHG, then the 
following apply:

• MAC pinning is enabled by default and cannot be disabled for the 
interface

•  IGMP snooping and MVR are not configurable for the interface
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31.2 Sample VPLS configuration

Figure 31-5 shows a sample VPLS configuration.

Figure 31-5  Sample VPLS

VPLS 1 is a distributed service, which consists of customer 1 connected to PE A, PE 
B, and PE C, at sites alpha, gamma, and beta, respectively. All three customer sites 
belong to VPLS 1.

In the following example, Customer 1 wants to send data from site alpha to site beta. 
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Customer 1 packets arriving at PE A are associated to the appropriate VPLS 1 for 
that customer, based on the combination of the access port and the dot1q (VLAN ID) 
in the packet. PE A learns the source MAC address in the packet and creates an entry 
in the FIB table that associates the MAC address to the access port on which it was 
received.

PE A is sending the packets to PE C. The destination MAC address in the packet is 
looked up in the FIB table of PE A for the VPLS instance, as shown in Figure 31-6.

Figure 31-6  Packet forwarding by ingress router PE A

The destination MAC address in the FIB table has one of two values:

• known
• unknown

If the destination MAC address is known by PE A, an existing entry in the FIB table 
identifies the far-end PE C and the service VC label (VLAN ID) used to send the 
packets from PE A to PE C. PE A chooses a transport LSP to send the packets to PE 
C. The packets from the customer 1 site alpha to site beta are sent on the LSP once 
the VC label is removed and the transport label is added to the packet, as shown in 
Figure 31-6.

If the destination MAC address is not known by PE A, PE A floods packets to both 
PE B and PE C, which are both part of VPLS 1. PE A uses the VC labels (VLAN 
IDs) that PE B and PE C previously signaled for this VPLS 1.

As shown in Figure 31-7, the packets from PE A are transported across the core 
IP/MPLS network.
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Figure 31-7  Packet forwarding from PE A across the core IP/MPLS network

The core routers are LSRs that switch the packets towards their destination based on 
the tunnel label, also called a transport label. The core routers are not aware that the 
packets belong to a VPLS.

When the packets from PE A arrive at PE C, PE C takes away the tunnel label to 
reveal the VC label that identifies that these packets belong to VPLS 1, as shown in 
Figure 31-8.
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Figure 31-8  Packet forwarding by the egress router PE C

PE C learns the source MAC address of PE A and creates an entry in its FIB table 
that associates the MAC address and the VC label with PE A. The destination MAC 
address is looked up in the FIB table. It has one of two values:

• known
• unknown

If the destination MAC address is known by PE C, an existing entry in the FIB table 
identifies the local access (egress SAP) port used by VPLS 1 site beta and the service 
VC label (VLAN ID) that needs to be added to send the packets from PE C to 
customer 1.

If the destination MAC address is not known by PE C, PE C floods packets to all 
local access ports that belong to VPLS 1.

Assuming the core IP/MPLS network has already been configured, the following 
high-level tasks are required to configure this sample VPLS.
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Task Description

1. Configure policies 
as required 

Policies should be configured prior to creating a service. Participation in policies is defined when 
you configure or modify resources, such as access interfaces or circuits, during service creation or 
modification. The following key policies can be applied to resources that are part of a VPLS:

• Access ingress and egress interface policies. Choose Policies→QoS→Access Ingress or 
Access Egress to open the access ingress and egress interface policy forms.

• Scheduler policy. Choose Policies→QoS→Scheduler to open the scheduler policy form.
• ACL MAC filter policies. These policies specify access control lists based on MAC addresses. 

You can specify MAC learning for access ports or tunnels. Choose Policies→Filter→ACL MAC 
Filter to open the ACL filter policy form.

• Accounting policy. Choose Policies→Accounting to open the accounting policy form.

2. Configure ports as 
access ports for use in 
the service

Choose a port from the navigation tree, right click on the port, and choose Properties. Specify the 
port as an access port and specify an encapsulation type if required.

(1 of 3)
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3. Configure service 
tunnels as required

Service tunnels, or SDPs, are automatically created if there are no tunnels between the source and 
destination devices. You must choose GRE as the transport type for the 5620 SAM to automatically 
create service tunnels.

To manually create service tunnels, choose Manage→Service Tunnels. Service tunnels carry 
service traffic between edge-managed routers. Services are associated with service tunnels by 
SDP bindings during service configuration.

During service creation, you can also configure the 5620 SAM to automatically create SDP bindings 
to associate service tunnels with a service. In this case, you do not have to create service tunnels 
before you create the service.

4. Create and 
configure Subscriber 1 

Choose Manage→Subscribers to open the subscriber manager form and create a subscriber.

5. Create and 
configure Service 1

• Specify customer 1 as the subscriber for the VPLS.
• Configure MVR for the VPLS, if required.
• Specify PE A, PE B, and PE C as the routers (sites) for customer 1 VPLS.
• Specify VPLS STP parameters, if required.
• Specify VPLS FIB parameters, if required.
• Specify VPLS MAC move parameters, if required.
• Specify VPLS MAC flush parameters, if required.
• Specify VPLS IGMP snooping parameters, if required.
• Create an SHG for the VPLS, if required.
• Configure and specify access interfaces on each of the routers (PE A and PE C) as the access 

interfaces for the VPLS to site alpha and site beta. You do the following when you configure 
interfaces:
• Specify the ports for the access interfaces and configure the access interfaces. Ports must 

be configured as access ports.
• Specify participation of the access interfaces in ingress and egress policies, as required.
• Specify participation of the access interfaces in aggregation rate limiting across a card or 

port. If aggregation is not required, specify participation of the access interfaces in ingress 
and egress scheduler policies. If aggregation is required, specify participation of access 
interfaces in an aggregation scheduler policy.

• Specify the participation of the access interfaces in ACL filter policies as required.
• Specify the participation of the access interfaces in accounting policies as required.
• Configure STP for the interface, if required.
• Configure FIB parameters for the interface, if required.
• Configure IGMP snooping for the interface, if required.
• Configure DHCP for the interface, if required.
• Assign a subscriber authentication policy to the interface, if required.
• Configure MVR for the interface, if required.
• Configure ATM functionality and policies for the interface, if required.
• Configure anti-spoofing for the interface, if required.

• Create and configure circuits in both directions.
• If the VPLS is a distributed VPLS, configure mesh SDP bindings to connect the VPLS sites. You 

can also configure the 5620 SAM to automatically create SDP bindings.

6. Create, update, or 
configure additional 
subscribers to the 
VPLS, or create a new 
VPLS with new or 
additional subscribers

Repeat the above steps as required.

Task Description

(2 of 3)
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31.3 Workflow to create a VPLS

1 Set up group and user access privileges.

2 Configure the network:

i Build the IP or IP/MPLS core network.

ii Configure ports for the service as access ports.

iii Configure service tunnels.

3 Configure predefined QoS, scheduling, filter, and accounting policies. You do not 
have to create predefined policies if policies are created on a per-service basis.

7. For an HVPLS, 
create a composite 
service of VPLSes and 
VPLSes or VLLs

An HVPLS is a composite service consisting of VPLSes connected to other VPLSes or VLLs. In a 
composite service, service components are linked by spoke SDP connectors. You perform the 
following tasks when you configure an HVPLS.

• Create a composite service with VPLS and VLL services. You can add existing services or new 
services to the composite service. See chapter 36 for information about creating a composite 
service. See chapter 30 for information about creating a VLL service. See Procedure 31-1 in 
this chapter for information about creating a VPLS.

• Create connectors between the service components. For each spoke SDP connector, create 
two spoke SDP bindings, one in each direction. Specify existing service tunnels and a VC ID 
for the spoke SDP connector, as required.

8. Create a single 
MVPLS 

Create an MVPLS to run RSTP and to protect redundant spoke SDPs or SAPs in the associated 
VPLSes.

9. Create a composite 
MVPLS to manage 
traffic blocking for 
multiple VPLSes 

An MVPLS composite service manages traffic for multiple VPLSes with redundant spoke SDPs or 
SAPs. You perform the following tasks when you configure an MVPLS composite service.

• Create a composite service and add the individual MVPLSes.
• Create spoke SDP connectors between the MVPLSes. 

Task Description

(3 of 3)
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4 Provision the service:

i Set up subscribers or associate existing subscribers with the new service.

ii Create the VPLS and associate the subscriber with the VPLS. The necessary 
parameters are listed in Table 31-1.

• Define the service type as VPLS.
• Configure HVPLS redundancy, if required.
• Ensure the LSP network is configured when the transport mechanism is 

MPLS.
• Specify the routers (sites) used in the service.
• Specify the multicast package policy if required.
• Configure the split horizon groups parameters, if required.
• Specify the access interfaces.
• Specify the STP parameters for the service, if required.
• Specify aggregation on a service basis, or across a card or port.
• Specify QoS, scheduling, accounting, and filter policies.
• Specify MAC ACL filters, if required.
• Configure the FIB parameters, if required.
• Configure IGMP snooping parameters, if required.
• Configure DHCP relay parameters, if required.
• Configure anti-spoofing parameters, if required.

5 Create SDP bindings to associate with the service tunnels.

6 Turn up the service.

7 Add access spoke circuits for HVPLS, as required.

31.4 VPLS management menus

Table 31-2 describes the VPLS management menus.

Table 31-2 VPLS management menus

Menu item Description

Manage→Subscribers Create and manage subscribers.

Create→Service→VPLS Create a VPLS using configuration forms.

Create→Service From Template Create a service using a preconfigured template.

Manage→Services Perform a filtered search on services.

Manage→FIB Entries Manage FIB entries.

Application→Service Tunnel Topology View a graphical representation of service tunnels.

Manage→Composite Services Manage HVPLSes or composite MVPLSes
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31.5 VPLS management procedures list

Table 31-3 lists the procedures necessary to perform VPLS management tasks.

Table 31-3 VPLS management procedures list

31.6 VPLS management procedures

Use the following procedures to perform VPLS creation and management tasks.

Procedure 31-1  To create a VPLS using configuration forms

1 Choose Create→Service→VPLS from the 5620 SAM main menu. The VPLS 
(Create) form opens with the General tab displayed.

2 Click on the Select button to choose a subscriber to associate with the VPLS. The 
Select Subscriber - Vpls (Create) form opens.

3 Select a subscriber for the VPLS and click on the OK button. The Select Subscriber 
- Vpls (Create) form closes and the VPLS (Create) form refreshes with the 
subscriber information displayed.

Procedure Purpose

To create a VPLS using configuration forms Create a VPLS.

To create a VPLS using a template

To create an HVPLS using spoke SDP 
connectors

Create an HVPLS composite service to connect 
a VPLS to another VPLS or a VLL.

To create a single MVPLS Create an MVPLS to manage traffic blocking on 
the associated VPLS redundant spoke SDPs or 
SAPs.

To create an MVPLS composite service Create an MVPLS composite service to connect 
single or composite MVPLSes.

To add or modify FIB entries Manage FIB entries.

To view IGMP snooping queriers View a list of routers to which IGMP membership 
reports are forwarded.

To modify a VPLS Modify VPLS parameters.

To view the service operational status View the operational status of the service.

To view the service topology View a graphical representation of a VPLS that 
shows the sites and interfaces.

To delete a VPLS Delete a VPLS.
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4 Configure the following parameters:

• Auto-Assign ID
• Service ID
• Service Name
• Description
• Administrative State
• Default Mesh VC ID
• Inherit Value
• Automatic Mesh SDP Binding Creation
• Transport Type
• Use Bandwidth-Reserved Paths

The Transport Type and Use Bandwidth-Reserved Paths parameters are 
configurable when the Automatic SDP Binding Creation parameter is enabled.

5 Depending on the type of device being configured, the MVR tab is present. 
Configure multicast parameters for the VPLS, if required.

i Click on the MVR tab button.

ii Click on the Select button to choose a multicast package policy. The Select 
Multicast Package Policy form opens.

iii Select a multicast package policy and click on the OK button. The Select 
Multicast Package Policy form closes and the VPLS (Create) form refreshes 
with the multicast package policy information displayed.

After the multicast package policy is applied to the VPLS, the 5620 SAM 
distributes the policy as the routing policy format to all MVR-capable VPLS 
sites. If you apply another package policy to the site, the 5620 SAM distributes 
the policy to the site, but does not remove the previous policy from the site.

6 Perform one of the following.

a Create a site for the VPLS. Go to step 7.

b Complete service creation if sites, access interfaces, and circuits for the VPLS 
are to be created later. Go to step 68.

7 Click on the Components tab button.

8 Right-click on VPLS and choose Create Site. The Select Network Elements - Vpls 
(Create) form opens with a list of available sites displayed.

9 Select a site and click on the OK button. The Site Service Name (Create) form opens 
with general information about the site displayed.

10 Configure the following parameters:

• Name
• Description
• MTU
• Administrative State
• Monitor Access Interface Operational State
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11  Configure MFib, STP, and FIB parameters for the site, if required.

i Click on the Forwarding Control tab button. The MFib tab is displayed.

ii Configure the following parameters:

• Table size (entries)
• High Watermark (%)
• Low Watermark (%)

iii Configure STP parameters for the site, if required. Otherwise, go to step vi.

iv Click on the STP tab button.

v Alcatel STP can be used within a VPLS to interoperate with customer STP 
implementations as a mechanism for loop detection and prevention. The 
bridge-level parameters allow STP to be balanced between the resiliency and 
speed of convergence extremes. Note that modifying the bridge-level 
parameters must be done within the constraints of the following two formulas:

• 2 × (Bridge Forward Delay – 1.0 s) >= Bridge Max Age
• Bridge Max Age >= 2 × (Bridge Hello Time + 1.0 s)

Configure the following bridge-level STP parameters for the site:

vi Configure FIB parameters for the site, if required. Otherwise, go to step 12.

vii Click on the FIB tab button.

viii Configure the following parameters:

• High Watermark (%)
• Low Watermark (%)
• Local Age Time (seconds)
• Remote Age Time (seconds)
• Size (entries)
• Aging Enabled
• Learning Enabled
• Discard Unknown Destinations

ix Depending on the type of device being configured, the Mac move panel is 
present. Configure the Mac move parameters, if required:

• Move Frequency
• Retry Timeout
• Administrative State

• Bridge Forward Delay 
(seconds)

• Bridge Hello Time 
(seconds)

• Bridge Max Age (seconds)
• Priority

• RSTP Type
• Maximum BPDUs (PDUs/Hello 

interval) 
• Administrative State
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12 Depending on the type of device that you are configuring, the MAC Flush tab is 
present. Configure MAC flush for the site, if required.

i Click on the MAC Flush tab button.

ii Configure the MAC Flush on fail parameter.

13 Configure IGMP Snooping for the site, if required.

i Click on the IGMP Snooping tab button.

ii Configure the following parameters:

• Administrative State
• Query-interval (seconds)
• Robust count
• Report source address

14 Configure an SHG on the site, if required.

i Click on the Split Horizon Groups tab button.

ii Click on the Add button. The Site, New Split Horizon Group (Create) form 
opens.

iii Configure the following parameters:

• Name
• Description
• Residential

The Residential parameter is configurable on the 7450 ESS, Release 3.0 or 
later.

Note —  You must configure an SHG or RSHG if you plan to create a 
spoke circuit from this VPLS site to a VLL or to another VPLS.
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15 Depending on the type of device you are configuring, the MVR tab is present. 
Configure MVR parameters for the site, if required.

i Click on the MVR tab button. The General tab is displayed.

ii Configure the following parameters:

• Administrative State
The Administrative State parameter specifies whether a VPLS site is an 
MVR VPLS site.

• Description
•  Use Component Package Policy
• Policy Name

iii If you disable the Use Component Package Policy parameter, you must 
specify a multicast package policy to associate with the VPLS site. Perform 
one of the following.

• Click on the Select button to specify a multicast package policy. The Select 
(Create) form opens.

• If no multicast policy exists, go to step v.

iv Use the configurable filter and Search button to choose a policy, and click on 
the OK button. The Select (Create) form closes and the selected policy name 
is displayed on the Site (Create) form.

v Enter a multicast policy name as the Policy Name parameter value.

vi Click on the User MVR SAPs tab button to view all the VPLS SAPs that are 
using this MVR VPLS site.

vii Click on the Find button. The VPLS SAPs are listed on the tab.

16 Perform one of the following.

a Create an access interface for the site. Go to step 17

b Create a mesh SDP binding for the site. Go to step 38.

c Create a spoke SDP binding for the site. Go to step 51.

d If access interfaces and mesh SDP bindings are to be created later, go to 
step 65.

17 Click on the Components tab button.

18 Right-click on Access Interfaces and choose Create L2 Access Interface. The L2 
Access Interface (Create) form opens with the General tab displayed.

19 Configure the following parameters:

• Description
• Administrative State
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20 Choose an SHG for the interface, if required.

i Click on the Select button in the Split Horizon Group panel. The Select Split 
Horizon Group Name - L2 Access Interface (Create) form opens.

ii Select an SHG and click on the OK button. The Select Split Horizon Group 
Name - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form refreshes with the SHG information displayed.

21 Click on the Port tab button.

22 Click on the Select button to choose a port to associate with the L2 access interface. 
The Select Terminating Port - L2 Access Interface (Create) form opens.

23 Use the configurable filter and Search button to choose a port, and click on the OK 
button. The Select Terminating Port - L2 Access Interface (Create) form closes and 
the L2 Access Interface (Create) form refreshes with the selected port information 
displayed.

24 Configure the following parameters:

• Outer Encapsulation Value
• Inner Encapsulation Value
• Outer Encapsulation Value (VPI)
• Inner Encapsulation Value (VCI)

The Outer Encapsulation Value is configurable only when the port is an Ethernet or 
frame relay port with Dot1 Q or Q in Q encapsulation.

The Inner Encapsulation Value is configurable only when the port is an Ethernet or 
frame relay port with Q in Q encapsulation.

The Outer Encapsulation Value (VPI) and Inner Encapsulation Value (VCI) 
parameters are configurable only when the port is an ATM port.

25  Assign ingress and egress QoS policies to the interface, if required. Otherwise, go 
to step 26.

i Click on the QoS tab button.

Note —  You must configure an SHG or residential SHG if you plan to 
create a spoke circuit from this VPLS site to a VLL or another VPLS.

Note —  Only ports in access mode appear in the list. To choose a port 
that does not appear in the list, use the 5620 SAM navigation tree to 
select a port, choose Properties from the contextual menu, and set the 
Mode parameter to Access. Close and reopen the Select Terminating 
Port form; the reconfigured port appears.
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ii Configure the following parameters:

• Ingress Match QinQ Dot1P
• Use Shared Queue

iii Click on the Select button in the Ingress Policy panel to choose an ingress QoS 
policy. The Select Ingress Policy - L2 Access Interface (Create) form opens.

iv Select an ingress QoS policy and click on the OK button. The Select Ingress 
Policy - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form refreshes with the ingress QoS policy information displayed.

v Click on the Select button in the Egress Policy panel to choose an egress QoS 
policy. The Select Egress Policy - L2 Access Interface (Create) form opens.

vi Select an egress QoS policy and click on the OK button. The Select Egress 
Policy - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form refreshes with the egress QoS policy information displayed.

Note —  Items such as policies, schedulers, and filters can be applied 
later to multiple service components at once by selecting and 
right-clicking the components in the service components tree, choosing 
Properties, and configuring the parameters on the appropriate tab.
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26 Assign ingress and egress schedulers, or an aggregation scheduler, to the 
interface, if required.

i Click on the Schedulers tab button.

ii Configure the Aggregation parameter to specify whether an aggregation 
scheduler policy is applied to the interface:

• Choose Off.
• Choose On. Go to step viii.

iii Click on the Select button in the Ingress Scheduler panel to choose an ingress 
scheduler. The Select Ingress Scheduler - L2 Access Interface (Create) form 
opens.

iv Select an ingress scheduler and click on the OK button. The Select Ingress 
Scheduler - L2 Access Interface (Create) form closes and the L2 Access 
Interface (Create) form refreshes with the ingress scheduler information 
displayed.

v Click on the Select button in the Egress Scheduler panel to choose an egress 
scheduler. The Select Egress Scheduler - L2 Access Interface (Create) form 
opens.

vi Select an egress scheduler and click on the OK button. The Select Egress 
Scheduler - L2 Access Interface (Create) form closes and the L2 Access 
Interface (Create) form refreshes with the egress scheduler information 
displayed.

vii Go to step 27.

viii Click on the Select button in the Aggregation Scheduler panel to choose an 
aggregation scheduler. The Select Aggregation Scheduler - L2 Access 
Interface (Create) form opens.

ix Select an aggregation scheduler and click on the OK button. The Select 
Aggregation Scheduler - L2 Access Interface (Create) form closes and the L2 
Access Interface (Create) form refreshes with the aggregation scheduler 
information displayed.

27 Assign ingress and egress ACL filters to the interface, if required.

i Click on the ACL tab button.

ii Click on the Select button in the Ingress Filter panel to choose an ingress ACL 
filter. The Select Ingress Filter - L2 Access Interface (Create) form opens.

iii Select an ingress ACL filter and click on the OK button. The Select Ingress 
Filter - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form refreshes with the ingress ACL filter information displayed.

iv Click on the Select button in the Egress Filter panel to choose an egress ACL 
filter. The Select Egress Filter - L2 Access Interface (Create) form opens.

v Select an egress ACL filter and click on the OK button. The Select Egress Filter 
- L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form refreshes with the egress ACL filter information displayed.
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28 Assign an accounting policy to the interface, if required.

i Click on the Accounting tab button.

ii Configure the Collect Accounting Statistics parameter.

iii Click on the Select button to choose an accounting policy. The Select 
Accounting Policy - L2 Access Interface (Create) form opens.

iv Select an accounting policy and click on the OK button. The Select Accounting 
Policy - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form refreshes with the accounting policy information displayed.

29 Configure STP and FIB parameters for the interface, if required.

i Click on the Forwarding Control tab button. The STP tab is displayed.

ii Configure the following parameters:

iii Click on the FIB tab button.

iv Configure the following parameters:

• Aging Enabled
• Learning Enabled
• Maximum Entries
• Limit Mac Move

• Path Cost
• Port Number
• Priority
• Edge Port

• Edge Capability Detection
• Link Type
• Administrative State
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30 The ATM tab is configurable when the interface port is an ATM port. Specify OAM 
functionality and assign ingress and egress ATM policies to the interface, if required.

i Click on the ATM tab button.

ii Configure the following parameters:

• AAL5 Encapsulation
• ATM OAM Alarm Cell Handling

iii Click on the Select button in the Ingress ATM Policy panel to choose an ingress 
ATM policy. The Select Ingress ATM Policy - Sap Atm Configuration (Create) 
form opens.

iv Select an ingress ATM policy and click on the OK button. The Select Ingress 
ATM Policy - Sap Atm Configuration (Create) form closes and the L2 Access 
Interface (Create) form refreshes with the ingress ATM policy information 
displayed.

v Click on the Select button in the Egress ATM Policy panel to choose an egress 
ATM policy. The Select Egress ATM Policy - Sap Atm Configuration (Create) 
form opens.

vi Select an egress ATM policy and click on the OK button. The Select Egress 
ATM Policy - Sap Atm Configuration (Create) form closes and the L2 Access 
Interface (Create) form refreshes with the egress ATM policy information 
displayed.

31 The IGMP Snooping tab is configurable when IGMP snooping is supported by the 
device at the interface level. Configure IGMP snooping for the interface, if required.

i Click on the IGMP Snooping tab button. The General tab is displayed.

ii Configure the following parameters:

• Import Policy
• Fast-leave
• Mrouter attached
• Send queries
• General query interval 

(seconds)

• Max. Response interval (seconds)
• Robust count
• Max. Response interval group queries 

(tenths of seconds)
• Max. number of groups
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The General query interval (seconds), Max. Response interval (seconds), and 
Robust count parameters are configurable when the Send queries parameter 
is enabled.

iii Click on the Static Mcast Group tab button to configure a static multicast group, 
if required. Otherwise, go to step 32.

iv Click on the Add button. The Access Interface Igmp Snooping Mcast Group 
Display (Create) form opens.

v Configure the following parameters:

• Group Address
• Source Address

vi Click on the Apply button if you want to create additional entries. A dialog box 
appears. Otherwise, go to step ix.

vii Click on the OK button.

viii Repeat steps v to vii to create additional entries, if required.

ix Click on the OK button. A dialog box appears.

x Click on the OK button. The Static Mcast Group tab refreshes with the 
multicast group entries displayed in a list.

32 Configure DHCP for the interface, if required.

i Click on the DHCP tab button.

ii Configure the following parameters:

The Enable Lease Populate parameter is configurable when the Snooping 
parameter is enabled.

iii Depending on the type of device that you are configuring, the Subscriber 
Authentication Policy panel is present. Click on the Select button in the 
Subscriber Authentication panel to choose a subscriber authentication policy, 
if required. The Select Subscriber Authentication Policy - L2 Access Interface 
(Create) form opens. Otherwise, go to step 33.

iv Select a subscriber authentication policy and click on the OK button. The 
Select Subscriber Authentication Policy - L2 Access Interface (Create) form 
closes, and the L2 Access Interface (Create) form refreshes with the 
subscriber authentication policy name displayed in the Authentication panel.

• Enable DHCP Relay
• Description
• Snooping
• Enable Lease Populate

• Reforwarding Policy
• Circuit-id Suboption
• Remote-id Suboption
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33 Depending on the type of device that you are configuring, the MVR tab is present. 
Configure MVR for the interface, if required.

i Click on the MVR tab button.

ii Click on the Select button in the Source MVR VPLS panel to choose an MVR 
VPLS as the source of the multicast traffic. The Select Source MVR VPLS - L2 
Access Interface (Create) form opens.

iii Select a source MVR VPLS and click on the OK button. The Select Source 
MVR VPLS - L2 Access Interface (Create) form closes and the L2 Access 
Interface (Create) form refreshes with the source MVR VPLS information 
displayed.

iv Click on the Select button in the Proxy MVR SAP panel to choose a proxy MVR 
SAP. The Select Proxy MVR SAP - L2 Access Interface (Create) form opens.

v Select a proxy MVR SAP and click on the OK button. The Select Proxy MVR 
SAP - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form refreshes with the proxy MVR SAP information displayed.

If the SAP already has a proxy SAP, or is the proxy SAP of another SAP, the 
SAP can no longer be the proxy SAP.

34 Configure anti-spoofing filters for the interface, if required.

i Click on the Anti-Spoofing tab button.

ii Configure the following parameters:

• Anti-Spoofing
• ARP Reply Agent
• MAC Pinning

The ARP Reply Agent parameter is configurable when an IP address and a 
MAC address are specified for the static hosts on the SAP.

iii Configure static subscriber host entries, if subscriber entries are not available 
through DHCP lease management. Otherwise, go to step 35.

iv Click on the Static Hosts tab button.

v Click on the Add button. The Access Interface Anti-Spoofing Static Host 
Display (Create) form opens.

vi Configure the following parameters.

• IP Address
• MAC Address
• Subscriber Identification
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At least one IP address or MAC address must be specified for each static host. 
The values that are specified for the Anti-Spoofing and ARP Reply Agent 
parameters determine the type of address entry that is required for the static 
host. For example, if you set the Anti-Spoofing parameter to Source Ip Addr, 
you must specify at least the IP address for the static host.

vii Click on the Apply button if you want to create additional entries. A dialog box 
appears. Otherwise, go to step x.

viii Click on the OK button.

ix Repeat steps vi to viii to create additional entries, if required.

x Click on the OK button. A dialog box appears.

xi Click on the OK button. The Access Interface Anti-Spoofing Static Host Display 
(Create) form closes and the Static Hosts tab refreshes with the static hosts 
displayed in a list.

35 Click on the OK button. The L2 Access Interface (Create) form closes and a dialog 
box appears.

36 Click on the OK button. The Site Service Name (Create) form refreshes with the new 
access interface displayed in the components tree.

37 Perform one of the following.

a Create an additional access interface for the site. Repeat steps 17 to 36.

b Create a mesh SDP binding for the site. Go to step 38.

c Create a spoke SDP binding for the site. Go to step 51.

d Complete site creation. Go to step 65.

38 Click on the Components tab button.

39 Right-click on Mesh SDP Bindings and choose Create Mesh SDP Binding. The 
Mesh SDP Binding (Create) form opens with the General tab displayed.

40 Specify a destination node for the mesh SDP binding:

a If the destination node is a managed node, choose from a list of managed 
nodes.

i Click on the Select button in the Destination panel. The Select Destination 
Network Element (Create) form opens.

ii Select a destination node and click on the OK button. The Select 
Destination Network Element (Create) form closes and the Mesh SDP 
Binding (Create) form refreshes with the destination node identifier 
displayed.

b If the destination node is an unmanaged node, enter the system ID in the 
Destination Node ID field.
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41 Configure the following parameters:

• VC Type
• VLAN VC Tag
• Ingress Label
• Egress Label

42 Perform one of the following.

a If the Automatic Mesh SDP Binding Creation parameter in step 4 is disabled, 
choose a service tunnel to associate with the mesh SDP binding:

i Click on the Select button in the Tunnel panel. The Select Tunnel - Mesh 
Sdp Binding (Create) form opens.

ii Select a service tunnel for the mesh SDP binding and click on the OK 
button. The Select Tunnel - Mesh Sdp Binding (Create) form closes and 
the Mesh Sdp Binding (Create) form refreshes with the service tunnel 
information displayed.

b If the Automatic Mesh SDP Binding Creation parameter in step 4 is enabled, 
configure the following parameters:

• Tunnel Transport
• Return Tunnel Transport

43 Specify whether the mesh SDP binding is in or out of service.

i Click on the States tab button.

ii Configure the Administrative State parameter.

44 Assign ingress and egress ACL filters to the mesh SDP binding, if required.

i Click on the ACL tab button.

ii Click on the Select button in the Ingress Filter panel to choose an ingress ACL 
filter. The Select Ingress Filter - Mesh Sdp Binding (Create) form opens.

iii Select an ingress ACL filter and click on the OK button. The Select Ingress 
Filter - Mesh Sdp Binding (Create) form closes and the Mesh Sdp Binding 
(Create) form refreshes with the ingress ACL filter information displayed.

iv Click on the Select button in the Egress Filter panel to choose an egress ACL 
filter. The Select Egress Filter - Mesh Sdp Binding (Create) form opens.

v Select an egress ACL filter and click on the OK button. The Select Egress Filter 
- Mesh Sdp Binding (Create) form closes and the Mesh Sdp Binding (Create) 
form refreshes with the egress ACL filter information displayed.

45 Configure an anti-spoofing filter for the mesh SDP binding, if required. 

i Click on the Anti-Spoofing tab button.

ii Configure the MAC Pinning parameter.
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46 Configure IGMP Snooping for the mesh SDP binding, if required.

i Click on the IGMP Snooping tab button.

ii Configure the following parameters:

The General query interval (seconds), Max. Response interval (seconds), and 
Robust count parameters are configurable when the Send queries parameter 
is enabled.

47 Configure DHCP for the mesh SDP binding, if required.

i Click on the DHCP tab button.

ii Configure the following parameters:

• Description
• Snooping

48 Click on the OK button. A dialog box appears.

49 Click on the OK button. The Mesh Sdp Binding (Create) form closes and the Site 
Service Name (Create) form reappears.

50 Perform one of the following.

a Create an additional mesh SDP binding for the site. Repeat steps 38 to 49.

b Create a spoke SDP binding for the site. Go to step 51.

c Create an access interface for the site. Go to step 17.

d Complete site creation. Go to step 65.

51 Click on the Components tab button.

52 Right-click on Spoke SDP Bindings and choose Create Site SDP Binding. The 
Spoke SDP Binding (Create) form opens with the General tab displayed.

53 Specify a destination node for the spoke SDP binding:

a If the destination node is a managed node, choose from a list of managed 
nodes.

i Click on the Select button in the Destination panel. The Select Destination 
Network Element (Create) form opens.

ii Select a destination node and click on the OK button. The Select 
Destination Network Element (Create) form closes and the Spoke SDP 
Binding (Create) form refreshes with the destination node identifier 
displayed.

• Import Policy
• Fast-leave
• Send queries
• General query interval 

(seconds)

• Max. Response interval (seconds)
• Robust count
• Max. Response interval group queries 

(tenths of seconds)
• Max. number of groups
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b If the destination node is an unmanaged node, enter the system ID in the 
Destination Node ID field.

54 Configure the following parameters:

• VC ID
• VC Type
• VLAN VC Tag
• Ingress Label
• Egress Label

55 Perform one of the following.

a If the Automatic Mesh SDP Binding Creation parameter in step 4 is disabled, 
choose a service tunnel to associate with the spoke SDP binding:

i Click on the Select button in the Tunnel panel. The Select Tunnel - Spoke 
Sdp Binding (Create) form opens.

ii Select a service tunnel for the spoke SDP binding and click on the OK 
button. The Select Tunnel - Spoke Sdp Binding (Create) form closes and 
the Spoke Sdp Binding (Create) form refreshes with the service tunnel 
information displayed on the General tab.

b If the Automatic Mesh SDP Binding Creation parameter in step 4 is enabled, 
configure the following parameters:

• Tunnel Transport
• Return Tunnel Transport

56 Specify whether the spoke SDP binding is in or out of service.

i Click on the States tab button.

ii Configure the Administrative State parameter.

57 Assign ingress and egress ACL filters to the spoke SDP binding, if required.

i Click on the ACL tab button.

ii Click on the Select button in the Ingress Filter panel to choose an ingress ACL 
filter. The Select Ingress Filter - Spoke Sdp Binding (Create) form opens.

iii Select an ingress ACL filter and click on the OK button. The Select Ingress 
Filter - Spoke Sdp Binding (Create) form closes and the Spoke Sdp Binding 
(Create) form refreshes with the ingress ACL filter information displayed.

iv Click on the Select button in the Egress Filter panel to choose an egress ACL 
filter. The Select Egress Filter - Spoke Sdp Binding (Create) form opens.

v Select an egress ACL filter and click on the OK button. The Select Egress Filter 
- Spoke Sdp Binding (Create) form closes and the Spoke Sdp Binding (Create) 
form refreshes with the egress ACL filter information displayed.
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58 Configure an anti-spoofing filter for the spoke SDP binding, if required. 

i Click on the Anti-Spoofing tab button.

ii Configure the MAC Pinning parameter.

59 Configure STP and FIB parameters for the spoke SDP binding, if required.

i Click on the Forwarding Control tab button. The STP tab is displayed.

ii Configure the following parameters:

iii Click on the FIB tab button.

iv Configure the following parameters:

60 Configure IGMP Snooping for the spoke SDP binding, if required.

i Click on the IGMP Snooping tab button. The General tab is displayed.

ii Configure the following parameters:

• Path Cost
• Port Number
• Priority
• Edge Port

• Edge Capability Detection
• Link Type
• Administrative State

• Aging Enabled
• Learning Enabled
• Maximum Entries

• Limit Mac Move
• Discard Unknown Source

• Import Policy
• Fast-leave
• Mrouter attached
• Send queries
• Max. number of groups

• General query interval (seconds)
• Max. Response interval (seconds)
• Robust count
• Max. Response interval group queries 

(tenths of seconds)
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The General query interval (seconds), Max. Response interval (seconds), and 
Robust count parameters are configurable when the Send queries parameter 
is enabled.

iii Click on the Static Mcast Group tab button to configure a static multicast group, 
if required. Otherwise, go to step 61.

iv Click on the Add button. The Circuit Igmp Snooping Mcast Group Display 
(Create) form opens.

v Configure the following parameters:

• Group Address
• Source Address

vi Click on the Apply button if you want to create additional entries. A dialog box 
appears. Otherwise, go to step ix.

vii Click on the OK button.

viii Repeat steps v to vii to create additional entries, if required.

ix Click on the OK button. A dialog box appears.

x Click on the OK button. The Static Mcast Group tab refreshes with the static 
multicast group entries displayed in a list.

61  Configure DHCP for the spoke SDP binding, if required.

i Click on the DHCP tab button.

ii Configure the following parameters:

• Description
• Snooping

62 Click on the OK button. A dialog box appears.

63 Click on the OK button. The Spoke Sdp Binding (Create) form closes and the Site 
Service Name (Create) form reappears.

64 Perform one of the following.

a Create an additional spoke SDP binding for the site. Repeat steps 51 to 63.

b Create a mesh SDP binding for the site. Go to step 38.

c Create an access interface for the site. Go to step 17.

d Complete site creation. Go to step 65.

65 Click on the OK button. A dialog box appears.

66 Click on the OK button. The Site Service Name (Create) form closes and the VPLS 
(Create) form reappears.

67 Perform one of the following.

a Create an additional site for the VPLS. Go to step 7.
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b Complete service creation. Go to step 68.

68 Click on the OK button. A confirmation dialog box appears.

69 Click on the Yes button to confirm the action. The VPLS (Create) form closes.

Procedure 31-2  To create a VPLS using a template

1 Choose Create→Service From Template from the 5620 SAM main menu. The 
Create Service From Template form opens, as shown in Figure 31-1.

2 Select the template associated with the service that you want to add to the 
5620 SAM.

3 Click on the OK button. The service template creation form opens.

4 Configure the parameters. The 5620 SAM administrator defines the parameters that 
you can configure. An exclamation mark (!) identifies parameters that you must 
configure before using the template. (The ! icon also appears on the tabs containing 
parameters that require configuration.) A lock icon identifies parameters restricted 
by the 5620 SAM administrator. See chapter 17 for more information about the 
administrative tasks associated with service templates.

See chapter 51 for information about the parameters associated with creating a 
VPLS.

5 Click on the appropriate tab buttons to add site, interface, or SDP binding service 
components, if required. The template administrator can create secondary site, 
interface, and SDP binding templates and bind them to the primary VPLS template. 
See chapter 17 for more information about the administrative tasks associated with 
service templates.

6 Click on the OK button to save the changes and close the service template creation 
form.

Procedure 31-3  To create an HVPLS using spoke SDP connectors

Perform this procedure to create an HVPLS composite service consisting of a new or 
existing VPLS connected to a new or existing VPLS or VLL using a spoke SDP connector.

1 Choose Manage→Composite Services from the 5620 SAM main menu. The 
Manage Composite Services form opens. Click on the Create button. The 
Composite Service (Create) form opens with the General tab displayed.

2 Configure the following parameters:

• Composite ID
• Auto-Assign ID
• Name
• Description
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3 Click on the Apply button. The form title changes to Composite Service Service 
Name (Edit) and the form refreshes with an additional tab button and a Status panel.

4 Click on the Components tab button.

5 To add a VPLS, right-click on Services in the CompositeService components tree. 

a To create a new VPLS, choose Create VPLS from the contextual menu. 
Perform Procedure 31-1 to create the VPLS.

b To add an existing VPLS, choose Add Services from the contextual menu. The 
Add Services list appears. Select the appropriate VPLS from the Add Services 
list and click on the OK button. The VPLS must not be a member of any other 
composite service.

6 After you have added a VPLS to the HVPLS composite service, add another VPLS 
or a VLL.

a To add a VPLS, repeat step 5.

b To add a VLL, right-click on Services in the CompositeService components 
tree and perform one of the following.

• To create a new VLL, choose Create VLL from the contextual menu. Follow 
Procedure 30-1. Go to step 7.

• To add an existing VLL, choose Add Services from the contextual menu. 
The AddServices list appears. Select the appropriate VLL service from the 
Add Services list and click on the OK button. The VLL must not be a 
member of any other composite service. Go to step 7.

7 To add a connector for the HVPLS composite service, right-click on Connector in 
the Components tab of the Composite Service Service Name (Edit) form and select 
Create SpokeConnector.
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8 To create an SDP connector made up of two unidirectional spoke SDP bindings in 
opposite directions:

i Enter the SDP connector name and description in the Name and Description 
fields.

ii Select the first VPLS to be connected by clicking on the Select button in the 
Service A panel. The Select Service A form opens. Select a service from the 
list and click on the OK button.

iii Select the second VPLS or VLL to be connected by clicking on the Select 
button in the Service B panel. The Select Service B form opens. Select a 
service from the list and click on the OK button.

iv Select a site from Service A by clicking on the Select button in the Site A panel. 
This site is the source for one of the two unidirectional spoke SDP bindings. 
The Select Site - Spoke Connector form opens. Choose a site from the list and 
click on the OK button. A VPLS site must have a split horizon group configured.

v Select a site from Service B by clicking on the Select button in the Site B panel. 
This site is the source for the other of the two unidirectional spoke SDP 
bindings. The Select Site - Spoke Connector form opens. Choose a site from 
the list and click on the OK button. A VPLS site must have a split horizon group 
configured.

vi To define the service tunnels for the new spoke SDP bindings, click on the 
Transport tab button. Configure the parameters:

• The VC ID specifies the circuit assigned to both unidirectional spoke SDP 
bindings.

• To automatically select the transport tunnels, select the Auto Select 
Tunnels check box. Configure the Transport Type parameter. 

• To manually select the transport tunnels, deselect the Auto Select Tunnels 
check box. Select the transport tunnels originating from Site A and Site B 
as follows:

• Click on the Select button in the Tunnel A panel and choose a tunnel from 
the Select Tunnel from Site A list. Click on the OK button. 

• Click on the Select button in the Tunnel B panel and choose a tunnel from 
the Select Tunnel from Site B list. Click on the OK button.

9 Click on the OK button to close the Composite Service Service Name (Edit) form.

Procedure 31-4  To create a single MVPLS

A single MVPLS is created to run RSTP and manage traffic blocking on the associated 
VPLSes. Perform this procedure to create an MVPLS to manage traffic on the associated 
VPLS redundant spoke SDPs or SAPs.

1 Choose Create→Service→MVPLS from the 5620 SAM main menu. The MVPLS 
Create form opens with the General tab displayed.
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2 Select a subscriber by clicking on the Select button to launch the subscriber list 
form. Click on the appropriate subscriber in the list. Click on the OK button. The 
MVPLS Create form reappears. 

3 Configure the following parameters on the General tab:

• Auto-Assign ID
• Service ID
• Default Mesh VC ID
• Inherit Value
• Service Name
• Description
• Administrative State
• Automatic SDP Binding Creation
• Transport Type
• Use Bandwidth-Reserved Paths

The Transport Type and Use Bandwidth-Reserved Paths parameters are 
configurable when the Automatic SDP Binding Creation parameter is enabled.

4 Click on the MVR tab button to configure multicast parameters, if required.

i Click on the Select button to launch a multicast package policy list.

ii Select a policy from the list and click on the OK button.

5 Click on the Components tab button to specify the sites for the MVPLS.

i Right-click on MVPLS and choose Create Site to add a site to the MVPLS. 

ii A network element list appears. Select a site by clicking on the appropriate 
network element in the list. Click on the OK button.

iii Define the site as explained in Procedure 31-1 step 9 to step 65. If an MVPLS 
site contains any L2 access interface SAPs that will manage traffic on the 
associated VPLS SAPs, then one additional configuration step is necessary 
when defining L2 access interface SAPs on the L2 Access Interface form:

• Click on the Redundant VLANs tab button and click on the Add button to 
add a VLAN ID range. This range describes the VC IDs of the VPLS SAPs 
that are controlled by the MVPLS SAP.

iv Click on the OK button. The Site Create form closes and the MVPLS Create 
form reappears. Repeat substeps i to iii for each site to be created in the 
MVPLS.

6 When you have added and configured all sites, click the OK button on the MVPLS 
Create form. 
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Procedure 31-5  To create an MVPLS composite service

Perform this procedure to create an MVPLS composite service to interconnect separate 
MVPLSes with redundant spoke SDPs.

1 Choose Manage→Composite Services from the 5620 SAM main menu.The 
Manage Composite Services form opens. Click on the Create button. The 
CompositeService Create form opens.

2 Configure the parameters on the General tab:

• If the composite service ID is to be automatically assigned, select the 
Auto-assign ID check box. If you want to assign an ID, then deselect the check 
box and enter an ID in the Composite ID field.

• Enter the name of the new composite service in the Name field and click on the 
Apply button. The form name changes to CompositeService Edit. 

• Enter a description for the composite service in the Description field.

3 To add MVPLSes and connectors to the new MVPLS composite service, click on 
the Components tab button.

4 To add a service, right-click on Services in the CompositeService components tree.

a Choose Create MVPLS from the contextual menu. Follow procedure 31-4 to 
create the MVPLS.

b If the MVPLS already exists, then choose Add Services from the contextual 
menu. The Add Services form opens. Select the appropriate MVPLS from the 
Add Services list and click on the OK button.

5 Repeat step 4 for each MVPLS that is to be part of the MVPLS composite service.

6 To add a connector for the composite service, right-click on Connector in the 
Components tab of the CompositeService Edit form. Select Create 
SpokeConnector. MVPLSes should only be connected using the SpokeConnector 
type.
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7 To create an SDP connector consisting of two unidirectional spoke SDP bindings in 
opposite directions:

i Enter the SDP connector name and description in the Name and Description 
fields.

ii Select the first MVPLS to be connected by clicking on the Select button for 
Service A. The Select Service A form opens. Select a service from the list and 
click on the OK button.

iii Select the second MVPLS to be connected by clicking on the Select button for 
Service B. The Select Service B form opens. Select a service from the list and 
click on the OK button.

iv Select a site from Service A by clicking on the Select button in the Site A panel. 
This site is the source for one of the two unidirectional spoke SDP 
bindings.The Select Site - Spoke Connector form opens. Choose a site from 
the site list and click on the OK button.

v Select a site from Service B by clicking on the Select button in the Site B panel. 
This site is the source for the other of the two unidirectional spoke SDP 
bindings. The Select Site - Spoke Connector form opens. Choose a site from 
the site list and click on the OK button.

vi To define the transport SDP tunnels for the new spoke SDP bindings click on 
the Transport tab button. Configure the parameters:

• The VC ID specifies the circuit assigned to both unidirectional spoke SDP 
bindings.

• If you want to automatically select the transport tunnels, then select the 
Auto Select Tunnels check box. Specify theTransport Type parameter. 

• To manually select the transport tunnels, deselect the Auto Select Tunnels 
check box. Select the transport tunnels originating from Site A and Site B 
as follows:

• Click on the Select button in the Tunnel A panel and choose a tunnel from 
the Select Tunnel from Site A form. Click on the OK button. 

• Click on the Select button in the Tunnel B panel and choose a tunnel from 
the Select Tunnel from Site B form. Click on the OK button.

8 Repeat step 7 for each required redundant spoke SDP connector.

9 When the MVPLSes have all been added to the MVPLS composite service and the 
required spoke SDP connectors created to link them, click on the OK button on the 
CompositeService Edit form.
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Procedure 31-6  To add or modify FIB entries

You can create and manage FIBs from the following 5620 SAM entities:

• the global FIB entries form
• each subscriber
• each service site
• each access interface
• each circuit

Use the following procedure to add or modify FIB entries using the subscriber FIB entry 
form:

1 Choose Manage→Services from the 5620 SAM main menu. 

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Browse Services form.

3 Select a VPLS and click on the Edit button. The VPLS (Edit) form opens with the 
General tab displayed.

4 Click on the Forwarding Control tab button.

5 Click on the FIB Entries tab button.

6 Click on the Find button. A list of FIB entries appears, as shown in Figure 31-9.

Figure 31-9  FIB Entries tab
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7 Add or modify FIB entries as required.

a To add a FIB entry:

i Click on the Add button. The FibEntry (Create) form opens, as shown in 
Figure 31-10.

Figure 31-10  FIB Entry form

ii Configure the following parameters:

• MAC Address
• Auto Complete

iii Choose an interface or circuit from the list in the L2 Interfaces or the 
Services Circuits tab.

iv Click on the OK button to save the entry.

b To modify FIB entries:

i Choose a FIB entry from the FIB Entries tab.

ii Modify the FIB entry as required.

You can view additional FIB entry information, including faults, and 
modify some parameters, by choosing the FIB entry and clicking on the 
Edit button.

Procedure 31-7  To view IGMP snooping queriers

1 Choose Manage→Services from the 5620 SAM main menu.
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2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Choose a VPLS from the list.

4 Click on the Edit button. A VPLS edit form opens with the General tab displayed.

5 Click on the components tab button.

6 Right-click on a site and select Properties. The Site - Service Name form opens with 
the General tab displayed.

7 Click on the IGMP Snooping tab button.

8 Click on the MRouters tab button. The MRouters table opens that displays the list of 
IGMP snooping queriers and their properties.

Procedure 31-8  To modify a VPLS

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a VPLS and click on the Edit button. The VPLS Service Name (Edit) form 
opens with the General tab displayed.

The following tabs contain parameter information for the service:

• General tab — displays the general properties of the service
• MVR tab — displays multicast package policy information for the service

The following tabs list the service elements that can be individually or collectively 
selected and configured:

• Components tab — displays the various service components in a tree format
• Forwarding Control tab — lists FIB and STP instances that are associated with 

the service
• Sites tab — lists the sites that are included in the service
• L2 Interfaces tab — lists the L2 access interfaces that are included in the service
• Mesh SDP Bindings tab — displays the mesh SDP bindings associated with the 

service
• Spoke SDP Bindings tab — displays the spoke SDP bindings associated with 

the service
• Faults tab — displays the faults associated with the service

4 Modify the parameters for the service, as required.

Caution —  Modifying parameters can be service-affecting.
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To configure items on the Components tab, select and right-click on the items and 
choose Properties from the contextual menu.

To configure items on the tabs that contain lists of service elements, select the items 
and click on the Edit button.

5 Click on the OK button. A confirmation dialog box appears.

6 Click on the Yes button to confirm the action. The VPLS Service Name (Edit) form 
closes and the Manage Services form reappears.

7 Click on the Close button to close the Manage Services form.

Procedure 31-9  To view the service operational status

The Aggregated Operational State and State Cause indicators on the General tab of the 
service management form display information about service faults.

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a service and click on the Edit button. The VPLS (Edit) form opens.

4 View the Aggregated Operational State and State Cause indicators. When the 
Aggregated Operational State is Down or Partially Down, a check mark beside the 
appropriate State Cause indicator identifies the type of associated service fault.

5 Click on the appropriate tab button to view or edit an object that is identified as faulty 
by a State Cause indicator.

6 Click on the Faults tab button to view the alarms for the object. The Object Alarms 
tab is displayed.

7 Click on the Aggregated Alarms tab button to view the aggregated alarms for the 
object. The Aggregated Alarms tab is displayed.

8 Close the VPLS (Edit) form.

9 Click on the Close button to close the Manage Services form.

Procedure 31-10  To view the service topology

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.
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3 Select a VPLS and click on the Topology View button. A Topology View dialog box 
appears.

4 Click on the Yes button to proceed. The Service Topology - Service Name map 
opens.

See chapter 37 for more information about service topology views.

Procedure 31-11  To delete a VPLS

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Choose a VPLS from the list.

4 Click on the Remove button. A confirmation dialog box appears.

5 Click on the Yes button to confirm the action. The service is deleted and removed 
from the list.

6 Click on the Close button to close the Manage Services form.
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32.1 IES management overview

An IES is a routed connectivity service in which the subscriber communicates with 
an IP router interface, which is a Layer 3 interface, to send and receive Internet 
traffic. 

IES allows customer-facing IP interfaces in the same routing instance to be used for 
service network core routing connectivity. IES requires that the IP addressing 
scheme that is used by the subscriber be unique among other provider addressing 
schemes and potentially the entire Internet.

Packets arriving at the edge device are associated with an IES based on the access 
interface on which they arrive. An access interface is uniquely identified using these 
parameters:

• port
• service ID
• IP address

The 5620 SAM supports end-to-end IES configuration using the following methods:

• Tabbed configuration forms with an embedded navigation tree. The navigation 
tree provides a logical view of the service and acts as a configuration interface.

• Pre-configured template. Figure 32-1 shows the Create Service From Template 
form. A user with Service Mgmt privileges can create a service template. See 
chapter 17 for more information about the administrative tasks associated with 
service templates.

Figure 32-1  Create Service From Template form
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Figure 32-2  IES management form - General tab

The General tab of the 5620 SAM service management form displays useful 
information about the operational state of the service and its sites through the 
Aggregated Operational State and State Cause indicators, as shown in Figure 32-2.

The Aggregated Operational State indicator has four possible values: Up, Down, 
Partially Down, and Unknown. The value is derived from the operational states of 
the sites that are part of the service, as follows:

• Up—All sites are operationally up
• Partially Down—At least one site is operationally down
• Down—All sites are operationally down
• Unknown—The service has no provisioned sites

When the Aggregated Operational State is Partially Down or Down, a check mark 
appears beside the appropriate State Cause indicator to identify the type of fault to 
the 5620 SAM operator.
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Common to all device services, such as IES, are policies that are assigned to the 
service. Policies are defined at a global level and can then be applied to components 
of the service, such as interfaces or circuits, when the service is configured or 
modified. The following policies are common to all device services:

• QoS policies define ingress classification, policing, shaping, and marking on the 
ingress side of the interface. QoS policies are configured using the Access Ingress 
Policy form, the Access Egress Policy form, and the ATM QoS Policy form.

• Scheduling policies define hierarchical rate limiting and scheduling to govern the 
scheduling of queues. Scheduler policies are configured using the Scheduler 
Policy form.

• Filter policies control network traffic into or out of an interface or circuit based 
on IP or MAC matching criteria. Filter policies are configured using the ACL IP 
Filter form and the ACL MAC Filter form.

• Accounting policies measure the traffic on a service to ensure proper billing and 
enforcement of SLAs. Accounting policies are configured using the Accounting 
Policy form.

• Routing policies control the size and content of the routing tables, the routes that 
are advertised, and the best route to take to reach a destination. Routing policies 
are configured using the Routing Policy Manager.

See chapter 28 for more information about policies.

Although IES is part of the routing domain, the usable IP address space may be 
limited. IES allows a portion of the service provider address space to be reserved for 
service IP provisioning and to be administered by a separate, but subordinate, 
address authority.

Multiple IESs can be created to separate subscriber-owned IP interfaces. More than 
one IES can be created for one subscriber. More than one IP interface can be created 
in one IES. All IP interfaces created in an IES belong to the same subscriber.

The IES IP interfaces are restricted to the routing protocols that can be defined on the 
interface based on the fact that the customer has a different routing domain for this 
service. The IP interfaces support the following routing protocols:

• RIP
• OSPF
• BGP
• ISIS
• PIM
• IGMP

Customer routes can be advertised to the network core using static routes, RIP, or 
BGP. BGP and static routes are the most commonly used routing methods.

An IES can be connected to a VLL service or to a VPLS by an internal cross-connect 
through a CCAG adapter. This configuration eliminates the need for the physical 
port, cable, and other MDA-specific components and results in a less costly and more 
reliable interconnection. See chapter 36 for information about joining services to 
form composite services.
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32.2 Sample IES configuration

Figure 32-3 shows a sample IES configuration.

Figure 32-3  Sample IES configuration

Table 32-1 lists the high-level tasks necessary to configure this sample IES.

Table 32-1 Sample IES configuration

Subscriber
Network

Internet

Access interface 1

Specify
policies

Service 1

17233

Subscriber 1

7750 SR (router 1)

Task Description

1. Configure policies 
as required 

Policies should be configured prior to creating a service. Participation in policies by access 
interfaces is defined when you configure or modify access interfaces during service creation or 
modification. The following key policies can be applied to resources that are part of an IES.

• QoS access ingress and egress interface policies. Choose Policies→QoS→Access Ingress or 
Access Egress to open these forms.

• Scheduler policy. Choose Policies→QoS→Scheduler to open the scheduler policy form.
• ACL IP filter policies. Choose Policies→Filter→ACL IP Filter to open the IP filter form.
• Accounting policy. Choose Policies→Accounting to open the accounting policy form.

(1 of 2)
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32.3 Workflow to create an IES

1 Set up group and user access privileges.

2 Configure the network.

i Build the IP core network. You do not need an IP/MPLS network for IESs.

ii Configure routing protocols.

iii Have access ports available on the router.

3 Configure new or choose existing QoS, filter, and accounting policies.

2. Create and 
configure Subscriber 1 

Choose Manage→Subscribers to open the subscriber manager form and create a subscriber.

3. Create and 
configure Service 1

Ensure that the operator creating the service has Service Mgmt and Interface Mgmt user group 
privileges. See chapter 11 for more information about user and user group privileges.

Choose Create→Service→IES. Use the tabbed form and embedded navigation tree to configure 
the service. You configure the following key elements when you configure Service 1. 

• Choose Subscriber 1 as the subscriber for the IES.
• Choose Router 1 as the site for the IES.
• Configure and choose L3 access interface 1 as the access interface for the IES. You do the 

following when you configure access interfaces:
• Specify the router (site). This is router 1 in the example.
• Specify the port for the access interfaces. In the example, this would be access interface 1. 

Ports must be configured as access ports. Ports can be configured as dot1q. The 
specification of the customer ID, the port ID, and the Encap (VLAN ID) for the dot1q port 
defines the SAP.

• Specify the IP address for the IES: one primary IP address and, optionally, multiple 
secondary IP addresses.

• Specify service-specific QoS ingress and egress policies.
• Specify participation of the access interfaces in aggregation rate limiting across a card or 

port. If aggregation is not required, specify participation of the access interfaces in ingress 
and egress scheduler policies.If aggregation is required, specify participation of the access 
interfaces in an aggregation scheduler policy.

• Specify participation of the access interfaces in ACL filter policies as required.
• Specify participation of the access interfaces in accounting policies as required.
• Specify ICMP parameters to control messaging and error reports, and to provide 

information relevant to IP packet processing.
• Specify static ARP entries, ARP timeout, and proxy ARP settings.
• Specify DHCP parameters to enable DHCP relay and snooping.
• Specify anti-spoofing parameters to configure anti-spoof filters.

Task Description

(2 of 2)

Note —  PIM and IGMP are applied to an IES after the service is created. 
For information about how to apply PIM to an IES, see Procedure 32-6. 
For information about how to apply IGMP to an IES, see Procedure 32-5.

Note —  RIP, ISIS and OSPF are applied to an IES after the service is 
created. For information about how to apply RIP, ISIS, or OSPF to an IES, 
see Procedure 32-3. For information about how to apply RIP, ISIS, or 
OSPF to an IES L3 interface, see Procedure 32-4.
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4 Provision the service.

i Set up subscribers or associate existing subscribers with new services.

ii Configure customer-specific QoS, filter, scheduling, and accounting policies, 
or use pre-defined policies.

iii Create the IES. The sample parameters are listed in Table 32-1.

• Define the service type as IES
• Choose a router (site)
• Configure the IP interface
• Associate an access port with the IP interface
• Specify policies for the service, such as QoS

iv Apply routing protocols, such as OSPF, RIP, or ISIS to the IES or to IES 
interfaces, if required.

v Add IGMP or PIM interfaces to the IES, if required.

5 Turn up the service.

32.4 IES management menus

Table 32-2 lists and describes the 5620 SAM IES menus.

Table 32-2 IES management menus

32.5 IES management procedures list

Table 32-3 lists the procedures necessary to perform IES management tasks.

Table 32-3 IES procedures list

Menu item Description

Manage→Subscribers Create and manage subscribers.

Create→Service→IES Create an IES using configuration forms.

Create→Service From Template Create a service using a pre-configured template.

Manage→Services Perform a filtered search on services.

Procedure Purpose

To create an IES using configuration forms Create an IES for subscribers to communicate 
with an IP router interface to send and receive 
Internet traffic.To create an IES using a template

To apply OSPF, RIP, or ISIS to an IES Apply OSPF, RIP, or ISIS to an existing IES.

(1 of 2)
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32.6 IES management procedures

Use the following procedures to perform IES creation and management tasks.

Procedure 32-1  To create an IES using configuration forms

1 Choose Create→Service→IES from the 5620 SAM main menu. The IES (Create) 
form opens with the General tab displayed.

2 Configure the following parameters:

• Service ID
• Auto-Assign ID
• Service Name
• Description
• Administrative State

3 Click on the Select button to choose a subscriber to associate with the IES. The 
Select Subscriber - IES (Create) form opens.

4 Select a subscriber for the IES and click on the OK button. The Select Subscriber - 
Epipe (Create) form closes and the Epipe (Create) form reappears with the 
subscriber information displayed on the General tab.

5 Perform one of the following.

a Create a site for the IES. Go to step 6.

b Complete service creation if sites and access interfaces for the IES are to be 
created later. Go to step 30.

6 Click on the Components tab button.

7 Right-click on IES and choose Create Site. The Select Network Elements - Ies 
(Create) form opens with a list of available sites.

8 Select a site and click on the OK button. The Site Service Name (Create) form opens 
with general information about the site displayed.

To apply OSPF, RIP, or ISIS to an IES L3 
interface

Apply OSPF, RIP, or ISIS to an existing IES L3 
interface.

To add an IGMP interface to an IES Add an IGMP interface to an existing IES.

To add a PIM interface to an IES Add a PIM interface to an existing IES.

To modify an IES Modify IES parameters.

To view the service operational status View the operational status of the service.

To view the service topology View a graphical representation of an IES that 
shows the site and interfaces.

To delete an IES Delete an IES.

Procedure Purpose

(2 of 2)
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9 Configure the following parameters:

• Name
• Description
• Administrative State
• Monitor Access Interface Operational State

10 Perform one of the following.

a Create an access interface for the site. Go to step 11.

b Complete site creation if access interfaces for the site are to be created later. 
Go to step 27.

11 Click on the Components tab button.

12 Right-click on Access Interfaces and choose Create L3 Access Interface. The L3 
Access Interface (Create) form opens with the General tab displayed.

13 Configure the following parameters:

14 If the Loopback Enabled parameter in step 13 is enabled, you cannot associate a 
port with the L3 interface. Go to step 21.

15 Configure a port for the interface.

i Click on the Port tab button.

ii Click on the Select button to choose a port to associate with the L3 access 
interface. The Select Terminating Port - L3 Access Interface (Create) form 
opens.

iii Use the configurable filter and click on the Search button to choose a port, and 
click on the OK button. The Select Terminating Port - L3 Access Interface 
(Create) form closes and the L3 Access Interface (Create) form reappears with 
the selected port information displayed.

iv Configure the following parameters:

• Outer Encapsulation Value
• Inner Encapsulation Value
• Outer Encapsulation Value (VPI)
• Inner Encapsulation Value (VCI)
• Description

• Interface ID
• Auto-Assign ID
• Name
• Description
• Cflowd Type

• Administrative State
• MAC Address
• Allow Directed Broadcasts
• Loopback Enabled
• Trusted

Note —  Only ports in access mode appear in the list. To choose a port 
that does not appear in the list, use the 5620 SAM navigation tree to 
select a port, choose Properties from the contextual menu, and set the 
Mode parameter to Access. Close and reopen the Select Terminating 
Port form; the reconfigured port appears.
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The Outer Encapsulation Value is configurable only when the port is an 
Ethernet or frame relay port with Dot1 Q or Q in Q encapsulation.

The Inner Encapsulation Value is configurable only when the port is an 
Ethernet or frame relay port with Q in Q encapsulation.

The Outer Encapsulation Value (VPI) and Inner Encapsulation Value (VCI) 
parameters are configurable only when the port is an ATM port.

16 Some devices, such as the 7750 SR, support the application of QoS and accounting 
policies, queue schedulers, and ACL filters to interfaces.

a If your device supports these functions, go to step 17.

b If your device does not support these functions, the QoS, Schedulers, ACL, 
and Accounting tabs are not present. Go to step 21.

17 Assign ingress and egress QoS policies to the interface, if required.

i Click on the QoS tab button.

ii Configure the following parameters:

• Ingress Match QinQ Dot1P
• Use Shared Queue

iii Click on the Select button in the Ingress Policy panel to choose an ingress QoS 
policy. The Select Ingress Policy - L3 Access Interface (Create) form opens.

iv Select an ingress QoS policy and click on the OK button. The Select Ingress 
Policy - L3 Access Interface (Create) form closes and the L3 Access Interface 
(Create) form reappears with the ingress QoS policy information displayed.

v Click on the Select button in the Egress Policy panel to choose an egress QoS 
policy. The Select Egress Policy - L3 Access Interface (Create) form opens.

vi Select an egress QoS policy and click on the OK button. The Select Egress 
Policy - L3 Access Interface (Create) form closes and the L3 Access Interface 
(Create) form reappears with the egress QoS policy information displayed.

Note —  Items such as policies, schedulers, and filters can be applied 
later to multiple service components at once by selecting and 
right-clicking the components in the service components tree, choosing 
Properties, and configuring the parameters on the appropriate tab.
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18 Click on the Schedulers tab button to assign ingress and egress schedulers, or an 
aggregation scheduler, to the interface, if required.

i Configure the Aggregation parameter to specify whether an aggregation 
scheduler policy is applied to the interface.

• Choose Off.
• Choose On. Go to step vii.

ii Click on the Select button in the Ingress Scheduler panel to choose an ingress 
scheduler. The Select Ingress Scheduler - L3 Access Interface (Create) form 
opens.

iii Select an ingress scheduler and click on the OK button. The Select Ingress 
Scheduler - L3 Access Interface (Create) form closes and the L3 Access 
Interface (Create) form refreshes with the ingress scheduler information 
displayed.

iv Click on the Select button in the Egress Scheduler panel to choose an egress 
scheduler. The Select Egress Scheduler - L3 Access Interface (Create) form 
opens.

v Select an egress scheduler and click on the OK button. The Select Egress 
Scheduler - L3 Access Interface (Create) form closes and the L3 Access 
Interface (Create) form refreshes with the egress scheduler information 
displayed.

vi Go to step 19.

vii Click on the Select button in the Aggregation Scheduler panel to choose an 
aggregation scheduler. The Select Aggregation Scheduler - L3 Access 
Interface (Create) form opens.

viii Select an aggregation scheduler and click on the OK button. The Select 
Aggregation Scheduler - L3 Access Interface (Create) form closes and the L3 
Access Interface (Create) form refreshes with the aggregation scheduler 
information displayed.

19 Assign ingress and egress ACL filters to the interface, if required.

i Click on the ACL tab button.

ii Click on the Select button in the Ingress Filter panel to choose an ingress ACL 
filter. The Select Ingress Filter - L3 Access Interface (Create) form opens.

iii Select an ingress ACL filter and click on the OK button. The Select Ingress 
Filter - L3 Access Interface (Create) form closes and the L3 Access Interface 
(Create) form reappears with the ingress ACL filter information displayed.

iv Click on the Select button in the Egress Filter panel to choose an egress ACL 
filter. The Select Egress Filter - L3 Access Interface (Create) form opens.

v Select an egress ACL filter and click on the OK button. The Select Egress Filter 
- L3 Access Interface (Create) form closes and the L3 Access Interface 
(Create) form reappears with the egress ACL filter information displayed.
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20 Assign an accounting policy to the interface, if required.

i Click on the Accounting tab button.

ii Configure the Collect Accounting Statistics parameter.

iii Click on the Select button to choose an accounting policy. The Select 
Accounting Policy - L3 Access Interface (Create) form opens.

iv Select an accounting policy and click on the OK button. The Select Accounting 
Policy - L3 Access Interface (Create) form closes and the L3 Access Interface 
(Create) form reappears with the accounting policy information displayed.

21 Assign an IP address to the interface.

i Click on the Address tab button.

ii Click on the Add button. The IP Address (Create) form opens.

iii Configure the following parameters:

• IP Address
• Subnet Mask
• Broadcast Address Format
• Primary

After you assign a primary IP address to the interface, you can assign multiple 
secondary IP addresses to the interface by repeating this step with the Primary 
parameter deselected.

The secondary IP addresses must not overlap with the primary IP address.

iv Click on the OK button. The IP Address (Create) form closes, and a dialog box 
appears.

v Click on the OK button. The L3 Access Interface (Create) form reappears with 
the assigned IP addresses displayed.

22 Configure ICMP for the interface, if required.

i Click on the ICMP tab button.

ii Configure the following parameters:

• Mask Reply
• Redirects
• Unreachables
• TTL Expired
• Number of Redirects
• Redirects Time 

(seconds)

• Number of Unreachables
• Unreachables Time (seconds)
• Number of TTL Expired
• TTL Expired Time (seconds)
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23 Configure ARP for the interface, if required.

i Click on the ARP tab button. The General tab is displayed.

ii Configure the Timeout parameter.

iii To add a static ARP entry, click on the Add button. The Static Arp (Create) form 
opens.

iv Configure the following parameters:

• IP Address
• Physical Address

v Click on the Apply button if you want to create additional entries. A dialog box 
appears. Otherwise, go to step viii.

vi Click on the OK button.

vii Repeat steps iv to vi to create additional entries, if required.

viii Click on the OK button. A dialog box appears.

ix Click on the OK button. The Static Arp (Create) form closes and the General 
tab refreshes with the configured static hosts displayed in a list.

x Click on the Proxy ARP tab button.

xi Configure the following parameters:

• Enable Proxy ARP
• Enable Local Proxy ARP

When you set the Enable Proxy ARP parameter to true, the Proxy ARP 
Policies panel appears with the following parameters to configure.

• Proxy Arp Policy 1
• Proxy Arp Policy 2
• Proxy Arp Policy 3
• Proxy Arp Policy 4
• Proxy Arp Policy 5

24 Configure DHCP relay for the interface, if required.
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i Click on the DHCP tab button.

ii Configure the following parameters:

You must enable the Enable Info Option parameter to display the Action, 
Circuit Id, and Remote Id parameters.

DHCP snooping is enabled automatically when the Lease Populate parameter 
is enabled.

The Snooping parameter is supported for the following devices:

• 7750 SR Release 2.1
• 7450 ESS Release 2.0
• 7450 ESS Release 2.0 R2
• 7450 ESS Release 2.0 R5

iii Depending on the type of device being configured, the Subscriber 
Authentication Policy panel is present. Click on the Select button to choose a 
subscriber authentication policy, if required. The Select Subscriber 
Authentication Policy - Dhcp Relay Configuration (Create) form opens. 
Otherwise, go to step 26.

iv Select a subscriber authentication policy and click on the OK button. The 
Select Subscriber Authentication Policy - Dhcp Relay Configuration (Create) 
form closes, and the L3 Access Interface (Create) form refreshes with the 
subscriber authentication policy name displayed in the panel.

Note —  DHCP relay is configurable on the 7750 SR only when Ethernet 
encapsulation is enabled at the port level and when the Loopback 
Enabled parameter is not selected on the L3 Access Interface (Create) 
form.

• Enable DHCP Relay
• Description
• Enable Info Option
• Trusted
• Lease Populate

• Action
• Circuit Id
• Remote Id
• Snooping
• Server 1 through Server 8
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25 The ATM tab is configurable when the interface port is an ATM port. Specify OAM 
functionality and assign ingress and egress ATM policies to the interface, if required.

i Click on the ATM tab button.

ii Configure the following parameters:

• AAL5 Encapsulation
• ATM OAM Alarm Cell Handling

iii Click on the Select button in the Ingress ATM Policy panel to choose an ingress 
ATM policy. The Select Ingress ATM Policy - Sap Atm Configuration (Create) 
form opens.

iv Select an ingress ATM policy and click on the OK button. The Select Ingress 
ATM Policy - Sap Atm Configuration (Create) form closes and the L2 Access 
Interface (Create) form refreshes with the ingress ATM policy information 
displayed.

v Click on the Select button in the Egress ATM Policy panel to choose an egress 
ATM policy. The Select Egress ATM Policy - Sap Atm Configuration (Create) 
form opens.

vi Select an egress ATM policy and click on the OK button. The Select Egress 
ATM Policy - Sap Atm Configuration (Create) form closes and the L2 Access 
Interface (Create) form refreshes with the egress ATM policy information 
displayed.

26 Configure anti-spoofing filters for the interface, if required.

i Click on the Anti-Spoofing tab button.

ii Configure the following parameters:

• Anti-Spoofing
• ARP Populate

The ARP Populate parameter is configurable when all of the IP addresses of 
the defined static hosts on the interface are in one of the subnets configured 
for the interface.

iii Click on the Static Hosts tab button to configure static subscriber host entries, 
if subscriber entries are not available through DHCP lease management. 
Otherwise, go to step 27.

iv Click on the Add button. The Access Interface Anti-Spoofing Static Host 
Display (Create) form opens.

v Configure the following parameters:

• IP Address
• MAC Address
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At least one IP address or MAC address must be specified for each static host. 
The values specified for the Anti-Spoofing and ARP Populate parameters 
determine the type of address entry that is required for the static host. For 
example, when you set the Anti-Spoofing parameter to Source Ip Addr, you 
must specify at least the IP address for the static host.

When the ARP Populate parameter is enabled, the IP address of the new static 
host must be in one of the subnets that is configured for the interface in step 21.

vi Click on the Apply button if you want to create additional entries. A dialog box 
appears. Otherwise, go to step ix.

vii Click on the OK button.

viii Repeat steps v to vii to create additional entries, if required.

ix Click on the OK button. A dialog box appears.

x Click on the OK button. The Access Interface Anti-Spoofing Static Host Display 
(Create) form closes and the Static Hosts tab refreshes with the configured 
static hosts displayed in a list.

27 Click on the OK button. A dialog box appears.

28 Click on the OK button. The Site Service Name (Create) form closes, and the 
IES (Create) form reappears with the new site information displayed in the service 
components tree.

29 Perform one of the following.

a Create an additional site for the IES. Go to step 6.

b Complete service creation. Go to step 30.

30 Click on the OK button. A confirmation dialog box appears.

31 Click on the Yes button to confirm the action. The IES (Create) form closes.

Procedure 32-2  To create an IES using a template

1 Choose Create→Service From Template from the 5620 SAM main menu. The 
Create Service From Template form opens, as shown in Figure 32-1.

2 Select the template associated with the service that you want to add to the 
5620 SAM.

3 Click on the OK button. The service template creation form opens.

Note —  You can configure a static host on a SAP only when no static 
ARP entries exist on the IP interface.
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4 Configure the parameters. The 5620 SAM administrator defines the parameters that 
you can configure. An exclamation mark (!) identifies parameters that you must 
configure before using the template. (The ! icon also appears on the tabs containing 
parameters that require configuration.) A lock icon identifies parameters restricted 
by the 5620 SAM administrator. See chapter 17 for more information about the 
administrative tasks associated with service templates.

See chapter 50 for information about the parameters associated with creating an 
IES.

5 Click on the appropriate tab buttons to add site, interface, or SDP binding service 
components, if required. The template administrator can create secondary site, 
interface, and SDP binding templates and bind them to the primary IES template. 
See chapter 17 for more information about the administrative tasks associated with 
service templates.

6 Click on the OK button to save the changes and close the service template creation 
form.

Procedure 32-3  To apply OSPF, RIP, or ISIS to an IES

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select an IES in the list and click on the Edit button. The IES Service Name (Edit) 
form opens with the general properties of the service displayed on the General tab.

4 Click on the Sites tab button.

5 Select a site in the list and click on the Edit button. The Site (Edit) form opens.

6 Click on the Protocols tab button.

7 Click on the Add button. The Create Interface form opens.

8 Specify the interface type by setting the What type of interface would you like to 
create? parameter. The options are:

• OSPF
• RIP
• ISIS

9 The Interface (Create) form opens. See section 24.5 for information about 
configuring specific routing protocols.-

Note —  OSPF, RIP, or ISIS must be enabled at the routing instance 
level before you can apply OSPF, RIP, or ISIS to an IES. 
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Procedure 32-4  To apply OSPF, RIP, or ISIS to an IES L3 interface

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select an IES and click on the Edit button. The IES Service Name (Edit) form opens 
with the general properties of the service displayed on the General tab.

4 Click on the L3 Access Interfaces tab button.

5 Select an L3 interface in the list and click on the Edit button. The L3 Interface (Edit) 
form opens.

6 Click on the Protocols tab button.

7 Click on the Add button. The Create Interface form opens.

8 Specify the interface type by setting the What type of interface would you like to 
create? parameter. The options are:

• OSPF
• RIP
• ISIS

9 Click on the OK button. The Interface (Create) form opens. See section 24.5 for 
information about configuring specific routing protocols.

Procedure 32-5  To add an IGMP interface to an IES

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select an IES and click on the Edit button. The IES Service Name (Edit) form opens 
with the general properties of the service displayed on the General tab.

4 Click on the Sites tab button.

5 Select a site in the list and click on the Edit button. The Site (Edit) form opens.

6 Click on the Multicast tab button.

Note —  OSPF, RIP, or ISIS must be enabled at the routing instance 
level before you can apply OSPF, RIP, or ISIS to an L3 interface. 

Note —  IGMP must be enabled at the routing instance level before you 
can create an IGMP interface. 
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7 Click on the Add button. The Create Interface form opens.

8 Set the What type of interface would you like to create? parameter to IGMP.

9 Click on the OK button. The IGMP Interface (Create) form opens with the General 
tab displayed.

10 Click on the Select button to specify an interface.

11 Configure the following parameters:

• Description
• Administrative State
• Administrative Version

12 Click on the Behavior tab button.

13 Configure the Import Policy parameter.

14 Click on the Static/Group Source tab button.

15 Click on the Add button to add a new entry, if required. 

16 Configure the following parameters:

• Static Multicast Group
• Static Source

17 Click on the following tab buttons to view and edit information.

• Multicast Group
• Multicast Group/Source
• Statistics

18 Click on the OK button to close the IGMP Interface (Create) form.

19 Click on the OK button to close the Site (Edit) form.

20 Click on the OK button to close the IES Service Name (Edit) form. A confirmation 
dialog box appears.

21 Click on the Yes button to confirm the action. The IES Service Name (Edit) form 
closes.

22 Click on the Close button to close the Manage Services form.

Procedure 32-6  To add a PIM interface to an IES

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

Note —  Before you can add a PIM interface to an IES, PIM must be 
applied to All or IES during the PIM configuration at the routing instance 
level. See Procedure 24-26 for more information.
Alcatel 5620 Service Aware Manager, Release 3.0 R1 32-19
October 2005 3HE00214 CA



32 —  IES management
2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select an IES in the list and click on the Edit button. The IES Service Name (Edit) 
form opens with the general properties of the service displayed on the General tab.

4 Click on the Sites tab button.

5 Select a site in the list and click on the Edit button. The Site (Edit) form opens.

6 Click on the Multicast tab button.

7 Click on the Add button. The Create Interface form opens.

8 Set the What type of interface would you like to create? parameter to PIM.

9 Click on the OK button. The PIM Interface (Create) form opens with the General tab 
displayed.

10 Click on the Select button to specify an interface.

11 Configure the following parameters:

• Description
• Administrative State

12 Click on the Behavior tab button.

13 Configure the following parameters:

The Operational DR Priority parameter is configurable when the Sticky DR 
parameter is enabled.

14 Click on the Neighbor tab button, if present, to view and edit information. The 
Neighbor tab is present only when a neighbor PIM interface exists.

15 Click on the OK button to close the IGMP Interface (Create) form.

16 Click on the OK button to close the Site (Edit) form.

17 Click on the OK button to close the IES Service Name (Edit) form. A confirmation 
dialog box appears.

18 Click on the Yes button to confirm the action. The IES Service Name (Edit) form 
closes.

19 Click on the Close button to close the Manage Services form.

• Hello Interval (seconds)
• Tracking Support
• BSM Check Router Alert
• Improved assert
• MultiCast Senders

• Hello Multiplier
• DR Priority
• Sticky DR
• Operational DR Priority
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Procedure 32-7  To modify an IES

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select an IES and click on the Edit button. The IES Service Name (Edit) form opens 
with the general properties of the service displayed on the General tab.

The following tabs list the service elements that can be individually or collectively 
selected and configured:

• Components tab — displays the various service components in a tree format
• Sites tab — lists the sites that are included in the service
• L3 Access Interfaces tab — lists the L3 access interfaces that are included in the 

service
• Spoke SDP Bindings tab — displays the spoke SDP bindings that are associated 

with the service
• Address tab — lists the IP addresses that are associated with the service

• Faults tab — displays the faults associated with the service

4 Modify the parameters for the service, as required.

To configure items on the Components tab, select and right-click on the items and 
choose Properties from the contextual menu.

To configure items on the tabs that contain lists of service elements, select the items 
and click on the Edit button.

5 Click on the OK button. A confirmation dialog box appears.

6 Click on the Yes button to confirm the action. The IES Service Name (Edit) form 
closes and the Manage Services form reappears.

7 Click on the Close button to close the Manage Services form.

Procedure 32-8  To view the service operational status

The Aggregated Operational State and State Cause indicators on the General tab of the 
service management form display information about service faults.

Caution —  Modifying parameters can be service-affecting.

Note —  You cannot remove an IP address from an interface when the 
IP address of a static host is defined in the subnet of the interface IP 
address and the ARP Populate parameter is enabled on the 
Anti-Spoofing tab.
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1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a service and click on the Edit button. The IES (Edit) form opens.

4 View the Aggregated Operational State and State Cause indicators. When the 
Aggregated Operational State is Down or Partially Down, a check mark beside the 
appropriate State Cause indicator identifies the type of associated service fault.

5 Click on the appropriate tab button to view or edit an object that is identified as faulty 
by a State Cause indicator.

6 Click on the Faults tab button to view the alarms for the object. The Object Alarms 
tab is displayed.

7 Click on the Aggregated Alarms tab button to view the aggregated alarms for the 
object. The Aggregated Alarms tab is displayed.

8 Close the IES (Edit) form.

9 Click on the Close button to close the Manage Services form.

Procedure 32-9  To view the service topology

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select an IES and click on the Topology View button. A Topology View dialog box 
appears.

4 Click on the Yes button to proceed. The Service Topology - Service Name map 
opens.

See chapter 37 for more information about service topology views.

Procedure 32-10  To delete an IES

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Choose an IES from the list.

4 Click on the Remove button. A confirmation dialog box appears.
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5 Click on the Yes button to confirm the action. The service is deleted and removed 
from the list.

6 Click on the Close button to close the Manage Services form.
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33.1 VPRN service management overview

The 5620 SAM supports the creation of VPRN services using the 7750 SR as a PE 
and provider core (P) router. VPRNs, also called IP VPNs or BGP/MPLS VPNs, are 
defined in RFC 2547bis. This standard details a method of forwarding data and 
distributing routing information across an IP/MPLS service provider core network.

The 5620 SAM does not support the configuration of CE routers or devices.

VPRN services use BGP to exchange the VPRN routes among the PE routers that 
participate in the VPRN. This is done in a way that ensures that routes from different 
VPRN remain distinct and separate, even if two VPRNs have an overlapping address 
space. PE routers distribute routes between CE routers in the VPRN. Since the CE 
routers do not peer with each other there is no overlay visible to the VPRN’s routing 
algorithm.

Each route within a VPRN service is assigned an MPLS label. When BGP distributes 
a VPRN route, it also distributes an MPLS label for that route. Before a customer 
data packet travels across the backbone network, it is encapsulated with the MPLS 
label that corresponds, in the customer VPRN, to the route that best matches the 
destination address of the packet. 

The MPLS packet is further encapsulated with either another MPLS label or with an 
IP or GRE tunnel header, so that it gets tunneled across the backbone to the proper 
PE router. Each route exchanged by the MP-BGP protocol includes a RD, that 
identifies the VPRN association. Thus the backbone core routers do not need to know 
the VPRN routes.

The 5620 SAM supports end-to-end VPRN configuration using the following 
methods:

• Tabbed configuration forms with an embedded navigation tree. The navigation 
tree provides a logical view of the service and acts as a configuration interface.

• Pre-configured template. Figure 33-1 shows the Create Service From Template 
form. A user with Service Mgmt privileges can create a service template. See 
chapter 17 for more information about the administrative tasks associated with 
service templates.

Figure 33-1  Create Service From Template form
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Figure 33-2  VPRN service management form - General tab

The General tab of the 5620 SAM service management form displays useful 
information about the operational state of the service and its sites through the 
Aggregated Operational State and State Cause indicators, as shown in Figure 33-2.

The Aggregated Operational State indicator has four possible values: Up, Down, 
Partially Down, and Unknown. The value is derived from the operational states of 
the sites that are part of the service, as follows:

• Up—All sites are operationally up
• Partially Down—At least one site is operationally down
• Down—All sites are operationally down
• Unknown—The service has no provisioned sites

When the Aggregated Operational State is Partially Down or Down, a check mark 
appears beside the appropriate State Cause indicator to identify the type of fault to 
the 5620 SAM operator.
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Common to all device services, such as VPRN, are policies that are assigned to the 
service. Policies are defined at a global level and can then be applied to components 
of the service, such as interfaces or circuits, when the service is configured or 
modified. The following policies are common to all device services:

• QoS policies define ingress classification, policing, shaping, and marking on the 
ingress side of the interface. QoS policies are configured using the Access Ingress 
Policy form, the Access Egress Policy form, and the ATM QoS Policy form.

• Scheduling policies define hierarchical rate limiting and scheduling to govern the 
scheduling of queues. Scheduler policies are configured using the Scheduler 
Policy form.

• Filter policies control network traffic into or out of an interface or circuit based 
on IP or MAC matching criteria. Filter policies are configured using the ACL IP 
Filter form and the ACL MAC Filter form.

• Accounting policies measure the traffic on a service to ensure proper billing and 
enforcement of SLAs. Accounting policies are configured using the Accounting 
Policy form.

• Routing policies control the size and content of the routing tables, the routes that 
are advertised, and the best route to take to reach a destination. Routing policies 
are configured using the Routing Policy Manager.

See chapter 28 for more information about policies.

VPRN service routers

A VPRN service consists of CE routers or devices connected to PE routers. PE 
routers connected to P routers transport data across the IP/MPLS provider core 
network in service tunnels. 

Packets that arrive at an edge 7750 SR are associated with a VPRN service based on 
the access interface on which they arrive. An access interface is uniquely identified 
by the following parameters:

• physical Ethernet port or POS port and channel
• encapsulation type 
• encapsulation identifier (if required)

Table 33-1 describes the general functions performed by PE, P, and CE routers in a 
VPRN. See Figure 33-3 in this chapter for a sample VPRN. See the 7750 SR OS 
Services Guide for more detailed information about VPRN functionality on the 
7750 SR.
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Table 33-1 VPRN router functionality

PIM for VPRN

The PIM protocol can be applied to a VPRN service to create a private multicast 
distribution network. PIM uses an MDT group address to identify multicast traffic 
for the VPRN instance to prevent flooding of multicast packets to PE devices in the 
VPRN. VRFs with the same MDT address are members of that group and receive 
multicast traffic from each other. The MDT address cannot be in the SSM range.

Troubleshooting

If there are service issues, the service provider can use OAM tools to troubleshoot 
service and network transport issues, and ensure problems are handled properly 
through the physical and logical network. See chapter 39 for more information.

33.2 Sample VPRN configuration

Figure 33-3 shows a sample VPRN service configuration. Your configuration will 
vary depending on your network requirements.

Router type Functionality

PE • Are directly connected to PE, CE, and P routers
• Learn VPRN routes from CE devices using e-BGP, RIP, or static routes
• Maintain a separate routing table, called a VRF, for each service
• Exchange VPRN route information with other PE routers using MP-BGP
• Distribute MPLS inner labels using MP-BGP. Before data traverses the IP/MPLS backbone, it is 

encapsulated with the MPLS label that corresponds, within the VPRN, to the route that best matches 
the packet’s destination address.

• Distribute MPLS outer labels using RSVP-TE or LDP. Before the MPLS packet traverses the 
IP/MPLS backbone, it is further encapsulated with either another MPLS label or with a GRE or MPLS 
LSP service tunnel header, so that it is tunneled across the backbone to the appropriate PE router.

• Use RDs to identify the VPRN associations
• Use RTs to determine when a received route is destined for a VPRN

P • Are directly connected to PE and P routers
• Act as transit LSRs
• Maintain routes to PE routers and are unaware of specific VPRN routing information

CE • Are directly connected to PE routers
• Provide customer access to the VPRN 
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Figure 33-3  Sample VPRN Configuration

Assuming the core IP/MPLS or GRE network is already configured, Table 33-2 lists 
the high-level tasks that are required to configure this sample VPRN service. 

Table 33-2 Sample VPRN service configuration
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Task Description

1. Configure policies 
as required 

Policies should be configured before you create a service. Participation in policies is defined when 
you configure or modify resources, such as access interfaces or circuits, during service creation or 
modification. The following key policies can be applied to resources that are part of a VPRN.

• Routing policies. Choose Policies→Routing to open the routing policy form.
• Access ingress and egress interface policies. Choose Policies→QoS→Access Ingress or 

Access Egress to open these forms.
• Scheduler policies. Choose Policies→QoS→Scheduler to open the scheduler policy form.
• ACL IP filter policies. Choose Policies→Filter→ACL IP Filter to open the ACL form.
• Accounting policy. Choose Policies→Accounting to open the accounting policy form.

2. Configure ports as 
access ports for use in 
the service

Right-click on a port from the equipment navigation tree and choose Properties. Specify the port as 
an access port and specify an encapsulation type, if required.

(1 of 2)
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33.3 Workflow to create a VPRN service

1 Set up group and user access privileges.

2 Configure equipment and the network.

i Build the IP or IP/MPLS core network.

ii Create service tunnels, if required.

iii Configure ports for the service as access ports.

3. Configure service 
tunnels as required

Choose Manage→Service Tunnels to create service tunnels. Service tunnels carry service traffic 
between edge-managed routers by circuits aggregated in unidirectional service tunnels. Circuits 
can be associated with service tunnels during service configuration.

4. Configure MP-BGP 
for PE to PE routing. 

Perform the following steps. See chapter 24 for more information about protocol configuration.

• Right-click on a router instance in the network navigation tree and choose Properties. In the 
Properties form that opens, click on the Protocols tab and select the BGP check mark box.

• Right-click on the BGP instance in the network navigation tree and choose Properties. In the 
Properties form that opens, click on the VPN tab and select the VPN IPv4 check mark box.

• Right-click on the BGP Peer Group instance in the network navigation tree and choose Create 
Peer. In the Peer form that opens, configure the Peer Address and other parameters as 
required.

5. Create and 
configure subscribers

Choose Manage→Subscribers to open the subscriber manager form and create a subscriber.

6. Create and 
configure the Service

Ensure that the operator creating the service has Service Mgmt and Interface Mgmt user group 
privileges. See chapter 11 for more information about user and user group privileges.

Choose Create→Service→VPRN. Use the tabbed form and embedded navigation tree to configure 
the service. You configure the following key elements when you configure Service 1. 

• Specify a customer as the subscriber for the VPRN service.
• Specify and configure the routers (sites) for the VPRN service. For each VRF:

• Configure autobinding to specify that the service is automatically bound to service tunnels.
• Configure routing properties.
• Configure the route distinguisher.
• Configure VRF targets.
• Configure import and export route targets.
• Configure import and export routing policies.
• If required, configure static routes, BGP, or RIP on PE routers for PE-to-CE routing.
• If required, configure PIM to create a multicast domain within the VPRN.

• Configure and specify access interfaces on each of the routers for the VPRN service.
• Configure a name, ID, MAC address, and other parameters.
• Specify ports for the access interfaces. Ports must be configured as access ports.
• Specify participation of the access interfaces in ingress and egress policies, as required.
• Specify participation of the access interfaces in aggregation rate limiting across a card or 

port. If aggregation is not required, specify participation of the access interfaces in ingress 
and egress scheduler policies. If aggregation is required, specify participation of the access 
interfaces in an aggregation scheduler policy.

• Specify participation of the access interfaces in ACL filter policies as required.
• Specify participation of the access interfaces in accounting policies as required.
• Specify ICMP parameters.
• Specify static ARP entries, ARP timeout, and proxy ARP settings.
• Specify DHCP parameters.
• Specify anti-spoofing parameters.

Task Description

(2 of 2)
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3 Configure pre-defined routing, QoS, scheduling, filter, and accounting policies. You 
do not have to create pre-defined policies if policies are created on a per-service 
basis.

4 Provision the service.

i Set up subscribers or associate existing subscribers with the new service.

ii Create the VPRN and associate the subscriber with the VPRN.

iii Apply protocols, such as BGP, PIM, or RIP, and PIM interfaces to the VPRN 
service, if required.

5 Turn up the service.

33.4 VPRN service management menus

Table 33-3 lists and describes the VPRN service management menus.

Table 33-3 VPRN management menus

33.5 VPRN service management procedures list

Table 33-4 lists the procedures necessary to perform VPRN service management 
tasks.

Table 33-4 VPRN management procedures list

Menu item Description

Manage→Subscribers Create or manage subscribers.

Create→Service→VPRN Create a VPRN service using configuration forms.

Create→Service From Template Create a service using a pre-configured template.

Manage→Services Perform a filtered search on services.

Procedure Purpose

To create a VPRN service using configuration 
forms

Create a VPRN service.

To create a VPRN service using a template

To apply BGP, PIM, or RIP to a VPRN routing 
instance

Apply BGP, PIM, or RIP to a VPRN routing 
instance.

To add a PIM interface to a VPRN Add a PIM interface to a VPRN.

To modify a VPRN service Modify VPRN service parameters.

To view the service operational status View the operational status of the service.

(1 of 2)
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33.6 VPRN service management procedures

Use the following procedures to perform VPRN creation and management tasks.

Procedure 33-1  To create a VPRN service using configuration forms

1 Choose Create→Service→VPRN from the 5620 SAM main menu. The VPRN 
(Create) form opens with the General tab displayed.

2 Configure the following parameters:

• Auto-Assign ID
• Service ID
• Service Name
• Description
• Administrative State

3 Click on the Select button to choose a subscriber to associate with the VPRN. The 
Select Subscriber - Vprn (Create) form opens.

4 Select a subscriber for the VPRN and click on the OK button. The Select Subscriber 
- Vprn (Create) form closes and the VPRN (Create) form reappears with tab buttons 
visible and the subscriber information displayed on the General tab.

5 Perform one of the following.

a Create a site for the VPRN. Go to step 6.

b Complete service creation, if sites and access interfaces for the VPRN are to 
be created later. Go to step 48.

6 Click on the Components tab button.

7 Right-click on VPRN and choose Create Site. The Select Network Elements - Vprn 
(Create) form opens with a list of available sites displayed.

8 Select a site and click on the OK button. The Site Service Name (Create) form 
opens.

9 Configure the following parameters:

• Name
• Description
• Administrative State
• Monitor Access Interface Operational State

To view the service topology View a graphical representation of a VPRN 
service that shows the sites and interfaces.

To delete a VPRN service Delete a VPRN service.

Procedure Purpose

(2 of 2)
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10 Click on the Protocols tab button to enable a routing protocol on the site.

11 Configure the following parameters:

• BGP Enabled
• RIP Enabled

When you choose a protocol, the site and the protocols that are enabled on the site 
appear in the list panel.

12 Configure multicast for the site, if required:

i Click on the Multicast tab button.

ii Configure the PIM Enabled parameter.

When you select a protocol, the site and the enabled protocol appear in the list 
panel.

13 Click on the Routing tab button to configure a routing instance. The General tab is 
displayed.

14 Configure the following parameters:

• Router ID
• Maximum Number of Equal Cost Routes
• Autonomous System
• Enforce Maximum Number of Routes
• Route Distinguisher Type
• Enforce Maximum Number of Multicast Routes

When you set the Route Distinguisher Type parameter to Type 0, the following 
configurable parameters appear:

• Type 0 Administrative Value
• Type 0 Assigned Value

When you set the Route Distinguisher Type parameter to Type 1, the following 
configurable parameters appear:

• Type 1 IP Address
• Type 1 Assigned Value

When you select the Enforce Maximum Number of Routes parameter, the following 
configurable parameters appear:

• Maximum Number of Routes
• Log Only
• Threshold (%)

When you select the Enforce Maximum Number of Multicast Routes parameter, the 
following configurable parameters appear:

• Maximum Number of Multicast Routes
• Log Only
• Threshold (%)
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15 Click on the VRF Target tab button to configure a VRF instance.

16 Configure the VRF Target Type parameter:

a Specify None if you do not want to specify a VRF target for the site. Go to 
step 20.

b Specify Define Default if you want to specify a default VRF target for the site. 
Go to step 17.

c Specify Define Import and Export if you want to specify import and export VRF 
targets for the service site. Go to step 18.

Route targets are used to identify the VRFs of a VPRN. A PE router that is not a 
route reflector or an AS border router installs a VPRN route only when its import 
target matches the target of the route. 

A fully-meshed VPRN requires one target for all participating VRFs. A 
hub-and-spoke VPRN requires VRF import and export targets. The export target of 
the hub VRF must be the same as the import target of the spoke VRFs. The import 
target of the hub VRF must be the same as the export target of the spoke VRF. 
VPRN VRF targets must not overlap.

17 Configure the Target Format parameter. 

a Specify AS if you want to specify an AS number for the default target.

i Configure the following parameters:

• Target AS Value
• Target Extended Community Value

ii Go to step 20.

b Specify IP Address if you want to specify an IP address for the default target.

i Configure the following parameters:

• Target IP Address
• Target Community Value

ii Go to step 20.

18 Configure the Import Target Format parameter:

a Choose None to specify no VRF import target format for the site.

b Choose AS as the import target format for the site.

i Configure the following parameters:

• Import Target AS Value
• Import Target Extended Community Value

ii Go to step 19.

c Choose IP Address as the import target format for the site.
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i Configure the following parameters:

• Import Target IP Address
• Import Target Community Value

ii Go to step 19.

19 Configure the Export Target Format parameter:

a Choose None to specify no VRF export target format for the site.

b Choose AS as the export target format for the site.

i Configure the following parameters:

• Export Target AS Value
• Export Target Extended Community Value

ii Go to step 20.

c Choose IP Address as the export target format for the site.

i Configure the following parameters:

• Export Target IP Address
• Export Target Community Value

ii Go to step 20.

20 Click on the Auto-Bind tab button to configure the binding of the site to service 
tunnels.

21 Configure the Transport parameter. 

a Choose None to explicitly specify service tunnels and circuits for the service.

b Choose MPLS:LDP for the service to be automatically bound to MPLS service 
tunnels.

c Choose GRE for the service to be automatically bound to GRE service tunnels.

22 Click on the VRF Import Policies tab button.

23 Specify up to five VRF import policies.

24 Click on the VRF Export Policies tab button.

25 Specify up to five VRF export policies.

Note —  To use MPLS as the transport type, you must bind LSPs to 
service tunnels during service tunnel configuration. See Procedure 26-1 
for more information.
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26 Configure static routes, if required. 

i Click on the Static Routes tab button.

ii Click on the Add button to define a static route that the PE VRF is to exchange 
with the CE. The Static Route (Create) form opens.

iii Configure the following parameters:

iv Click on the OK button. The Static Route (Create) form closes and the Site 
Service Name (Create) form reappears. The static route and route parameters 
appear on the form.

27 Perform one of the following.

a Create an access interface for the site. Go to step 28.

b Complete site creation, if access interfaces are to be created later. Go to 
step 42.

28 Click on the Components tab button.

29 Right-click on Access Interfaces in the site components tree and choose Create L3 
Access Interface. The L3 Access Interface (Create) form opens with the General tab 
displayed.

30 Configure the following parameters:

31 Configure a port for the interface.

i Click on the Port tab button.

ii Click on the Select button to choose a port to associate with the L3 access 
interface. The Select Terminating Port - L3 Access Interface (Create) form 
opens.

• Static Route ID
• Auto-Assign ID
• Destination
• Mask
• Type

• IP Address
• Preference
• Metric
• Administrative State
• Tag

• Interface ID
• Auto-Assign ID
• Name
• Description
• Trusted

• Administrative State
• MAC Address
• Allow Directed Broadcasts
• Loopback Enabled
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iii Use the configurable filter and Search button to choose a port, and click on the 
OK button. The Select Terminating Port - L3 Access Interface (Create) form 
closes and the L3 Access Interface (Create) form reappears with the selected 
port information displayed.

iv Configure the following parameters:

• Outer Encapsulation Value
• Inner Encapsulation Value
• Outer Encapsulation Value (VPI)
• Inner Encapsulation Value (VCI)

The Outer Encapsulation Value is configurable only when the port is an 
Ethernet or frame relay port with Dot1 Q or Q in Q encapsulation.

The Inner Encapsulation Value is configurable only when the port is an 
Ethernet or frame relay port with Q in Q encapsulation.

The Outer Encapsulation Value (VPI) and Inner Encapsulation Value (VCI) 
parameters are configurable only when the port is an ATM port.

32 Assign ingress and egress QoS policies to the interface, if required.

i Click on the QoS tab button.

ii Configure the following parameters:

• Ingress Match QinQ Dot1P
• Use Shared Queue

iii Click on the Select button in the Ingress Policy panel to choose an ingress QoS 
policy. The Select Ingress Policy - L3 Access Interface (Create) form opens.

iv Select an ingress QoS policy and click on the OK button. The Select Ingress 
Policy - L3 Access Interface (Create) form closes and the L3 Access Interface 
(Create) form reappears with the ingress QoS policy information displayed.

v Click on the Select button in the Egress Policy panel to choose an egress QoS 
policy. The Select Egress Policy - L3 Access Interface (Create) form opens.

vi Select an egress QoS policy and click on the OK button. The Select Egress 
Policy - L3 Access Interface (Create) form closes and the L3 Access Interface 
(Create) form reappears with the egress QoS policy information displayed.

Note —  Only ports in access mode appear in the list. To choose a port 
that does not appear in the list, use the 5620 SAM navigation tree to 
select a port, choose Properties from the contextual menu, and set the 
Mode parameter to Access. Close and reopen the Select Terminating 
Port form; the reconfigured port appears.

Note —  Items such as policies, schedulers, and filters can be applied 
later to multiple service components at once by selecting and 
right-clicking the components in the service components tree, choosing 
Properties, and configuring the parameters on the appropriate tab.
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33 Assign ingress and egress schedulers, or an aggregation scheduler, to the 
interface, if required.

i Click on the Schedulers tab button.

ii Configure the Aggregation parameter to specify whether an aggregation 
scheduler policy is applied to the interface:

• Choose Off.
• Choose On. Go to step viii.

iii Click on the Select button in the Ingress Scheduler panel to choose an ingress 
scheduler. The Select Ingress Scheduler - L3 Access Interface (Create) form 
opens.

iv Select an ingress scheduler and click on the OK button. The Select Ingress 
Scheduler - L3 Access Interface (Create) form closes and the L3 Access 
Interface (Create) form refreshes with the ingress scheduler information 
displayed.

v Click on the Select button in the Egress Scheduler panel to choose an egress 
scheduler. The Select Egress Scheduler - L3 Access Interface (Create) form 
opens.

vi Select an egress scheduler and click on the OK button. The Select Egress 
Scheduler - L3 Access Interface (Create) form closes and the L3 Access 
Interface (Create) form refreshes with the egress scheduler information 
displayed.

vii Go to step 34.

viii Click on the Select button in the Aggregation Scheduler panel to choose an 
aggregation scheduler. The Select Aggregation Scheduler - L3 Access 
Interface (Create) form opens.

ix Select an aggregation scheduler and click on the OK button. The Select 
Aggregation Scheduler - L3 Access Interface (Create) form closes and the L3 
Access Interface (Create) form refreshes with the aggregation scheduler 
information displayed.

34 Assign ingress and egress ACL filters to the interface, if required.

i Click on the ACL tab button.

ii Click on the Select button in the Ingress Filter panel to choose an ingress ACL 
filter. The Select Ingress Filter - L3 Access Interface (Create) form opens.

iii Select an ingress ACL filter and click on the OK button. The Select Ingress 
Filter - L3 Access Interface (Create) form closes and the L3 Access Interface 
(Create) form reappears with the ingress ACL filter information displayed.

iv Click on the Select button in the Egress Filter panel to choose an egress ACL 
filter. The Select Egress Filter - L3 Access Interface (Create) form opens.

v Select an egress ACL filter and click on the OK button. The Select Egress Filter 
- L3 Access Interface (Create) form closes and the L3 Access Interface 
(Create) form reappears with the egress ACL filter information displayed.
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35 Assign an accounting policy to the interface, if required.

i Click on the Accounting tab button.

ii Configure the Collect Accounting Statistics parameter.

iii Click on the Select button to choose an accounting policy. The Select 
Accounting Policy - L3 Access Interface (Create) form opens.

iv Select an accounting policy and click on the OK button. The Select Accounting 
Policy - L3 Access Interface (Create) form closes and the L3 Access Interface 
(Create) form reappears with the accounting policy information displayed.

36 Assign an IP address to the interface.

i Click on the Address tab button.

ii Click on the Add button. The IP Address (Create) form opens.

iii Configure the following parameters:

• IP Address
• Subnet Mask
• Broadcast Address Format
• Primary

After you assign a primary IP address to the interface, you can assign multiple 
secondary IP addresses to the interface by repeating this step with the Primary 
parameter deselected.

The secondary IP addresses must not overlap with the primary IP address.

iv Click on the OK button. The IP Address (Create) form closes, and a dialog box 
appears.

v Click on the OK button. The L3 Access Interface (Create) form reappears with 
the assigned IP addresses displayed.

37 Configure ICMP for the interface, if required.

i Click on the ICMP tab button.

ii Configure the following parameters:

• Mask Reply
• Redirects
• Unreachables
• TTL Expired
• Number of Redirects
• Redirects Time 

(seconds)

• Number of Unreachables
• Unreachables Time (seconds)
• Number of TTL Expired
• TTL Expired Time (seconds)
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38 Configure ARP for the interface, if required.

i Click on the ARP tab button. The General tab is displayed.

ii Configure the Timeout parameter.

iii Click on the Proxy ARP tab button.

iv Configure the following parameters:

• Enable Proxy ARP
• Enable Local Proxy ARP

When you set the Enable Proxy ARP parameter to true, the Proxy ARP 
Policies panel appears with the following configurable parameters:

• Proxy Arp Policy 1
• Proxy Arp Policy 2
• Proxy Arp Policy 3
• Proxy Arp Policy 4
• Proxy Arp Policy 5

39 Configure DHCP relay for the interface, if required.

i Click on the DHCP tab button.

ii Configure the following parameters:

The Action, Circuit Id, and Remote Id parameters appear and are configurable 
when the Enable Info Option parameter is enabled.

DHCP snooping is enabled automatically when the Lease Populate parameter 
is enabled.

The Snooping parameter is supported for the following devices:

• 7750 SR Release 2.1
• 7450 ESS Release 2.0
• 7450 ESS Release 2.0 R2
• 7450 ESS Release 2.0 R5

Note —  DHCP relay is configurable on the 7750 SR only when Ethernet 
encapsulation is enabled at the port level, and when the Loopback 
Enabled parameter is not selected on the L3 Access Interface (Create) 
form.

• Enable DHCP Relay
• Description
• Enable Info Option
• Action
• Circuit Id
• Remote Id

• Trusted
• Lease Populate
• Snooping
• Server 1 through Server 8
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40 The ATM tab is configurable when the interface port is an ATM port. Specify OAM 
functionality and assign ingress and egress ATM policies to the interface, if required.

i Click on the ATM tab button.

ii Configure the following parameters:

• AAL5 Encapsulation
• ATM OAM Alarm Cell Handling

iii Click on the Select button in the Ingress ATM Policy panel to choose an ingress 
ATM policy. The Select Ingress ATM Policy - Sap Atm Configuration (Create) 
form opens.

iv Select an ingress ATM policy and click on the OK button. The Select Ingress 
ATM Policy - Sap Atm Configuration (Create) form closes and the L2 Access 
Interface (Create) form reappears with the ingress ATM policy information 
displayed.

v Click on the Select button in the Egress ATM Policy panel to choose an egress 
ATM policy. The Select Egress ATM Policy - Sap Atm Configuration (Create) 
form opens.

vi Select an egress ATM policy and click on the OK button. The Select Egress 
ATM Policy - Sap Atm Configuration (Create) form closes and the L2 Access 
Interface (Create) form reappears with the egress ATM policy information 
displayed.

41 Configure anti-spoofing filters for the interface, if required.

i Click on the Anti-Spoofing tab button.

ii Configure the following parameters:

• Anti-Spoofing
• ARP Populate

The ARP Populate parameter is configurable when all of the IP addresses of 
the defined static hosts on the interface are in one of the subnets configured 
for the interface.

iii Click on the Static Hosts tab button to configure static subscriber host entries, 
if subscriber entries are not available through DHCP lease management. 
Otherwise, go to step 42.

iv Click on the Add button. The Access Interface Anti-Spoofing Static Host 
Display (Create) form opens.

v Configure the following parameters:

• IP Address
• MAC Address
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Specify at least one IP address or MAC address for each static host. The 
values specified for the Anti-Spoofing and ARP Populate parameters 
determine the type of address entry that is required for the static host. For 
example, when you set the Anti-Spoofing parameter to Source Ip Addr, you 
must specify at least the IP address for the static host.

When the ARP Populate parameter is enabled, the IP address of the new static 
host must be in one of the subnets that is configured for the interface in step 36.

vi Click on the Apply button if you want to create additional entries. A dialog box 
appears. Otherwise, go to step ix.

vii Click on the OK button.

viii Repeat steps v to vii to create additional entries, if required.

ix Click on the OK button. A dialog box appears.

x Click on the OK button. The Access Interface Anti-Spoofing Static Host Display 
(Create) form closes and the Static Hosts tab refreshes with the configured 
static hosts displayed.

42 Click on the OK button. A dialog box appears.

43 Click on the OK button. The Site Service Name (Create) form reappears.

44 Perform one of the following.

a Create an additional access interface for the site. Repeat steps 28 to 43.

b Go to step 45.

45 Click on the OK button. A dialog box appears.

46 Click on the OK button. The Site Service Name (Create) form closes, and the VPRN 
(Create) form reappears with the new site information displayed in the service 
components tree.

47 Perform one of the following.

a Create an additional site for the VPRN. Go to step 6.

b Go to step 48.

48 Click on the OK button. A confirmation dialog box appears.

49 Click on the Yes button to confirm the action. The VPRN (Create) form closes.

Note —  You can configure a static host on a SAP only when no static 
ARP entries exist on the IP interface.
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Procedure 33-2  To create a VPRN service using a template

1 Choose Create→Service From Template from the 5620 SAM main menu. The 
Create Service From Template form opens, as shown in Figure 33-1.

2 Select the template associated with the service that you want to add to the 
5620 SAM.

3 Click on the OK button. The Service Template form opens.

4 Configure the parameters. The 5620 SAM administrator defines the parameters that 
you can configure. An exclamation mark (!) identifies parameters that you must 
configure before using the template. (The ! icon also appears on the tabs containing 
parameters that require configuration.) A lock icon identifies parameters restricted 
by the 5620 SAM administrator. See chapter 17 for more information about the 
administrative tasks associated with service templates.

See chapter 49 for information about the parameters associated with creating a 
VPRN service.

5 Click on the appropriate tab buttons to add site, interface, or SDP binding service 
components, if required. The template administrator can create secondary site, 
interface, and SDP binding templates and bind them to the primary VPRN template. 
See chapter 17 for more information about the administrative tasks associated with 
service templates.

6 Click on the OK button to save the changes and close the Create Service From 
Template form.

Procedure 33-3  To apply BGP, PIM, or RIP to a VPRN routing 
instance

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a VPRN service.

4 Click on the Edit button. The VPRN Service Name (Edit) form opens with the general 
properties of the service displayed on the General tab.

5 Click on the Components tab button.

6 Right-click on Protocols below a VPRN routing instance and choose one of the 
following:

a Create BGP. The BGP (Create) form opens. Perform steps 4 to 29 of 
procedure 24-2.

b Create PIM. The PIM (Create) form opens. Perform steps 3 to 35 of 
procedure 24-26.
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c Create RIP. The RIP (Create) form opens. Perform steps 4 to 14 of 
procedure 24-6.

7 Click on the OK button. A dialog box appears.

8 Click on the OK button.

9 Click on the OK button to close the VPRN Service Name (Edit) form. A confirmation 
dialog box appears.

10 Click on the Yes button to confirm the action. The VPRN Service Name (Edit) form 
closes.

11 Click on the Close button to close the Manage Services form.

Procedure 33-4  To add a PIM interface to a VPRN

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a VPRN service.

4 Click on the Edit button. The VPRN Service Name (Edit) form opens with the general 
properties of the service displayed on the General tab.

5 Click on the Components tab button.

6 Right-click on a PIM instance in the service components tree and choose Create 
PIM Interface. The PIM Interface (Create) form opens.

7 Configure the following parameters:

• Description
• Administrative State

8 Click on the Behavior tab button.

9 Configure the following parameters:

The Operational DR Priority parameter is configurable when the Sticky DR 
parameter is enabled.

• Hello Interval 
(seconds)

• Tracking Support
• BSM Check Router 

Alert
• Improved assert
• Sticky DR

• MultiCast Senders
• Hello Multiplier
• DR Priority
• Operational DR Priority
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10 Click on the OK button. A dialog box appears.

11 Click on the OK button.

12 Click on the OK button to close the VPRN Service Name (Edit) form. A confirmation 
dialog box appears.

13 Click on the Yes button to confirm the action. The VPRN Service Name (Edit) form 
closes.

14 Click on the Close button to close the Manage Services form.

Procedure 33-5  To modify a VPRN service

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a VPRN service and click on the Edit button. The VPRN Service Name (Edit) 
form opens with the general properties of the service displayed on the General tab.

The following tabs list the service elements that can be individually or collectively 
selected and configured:

• Components tab — displays the various service components in a tree format
• Sites tab — lists the sites that are included in the service
• L3 Access Interfaces tab — lists the L3 access interfaces that are included in the 

service
• Spoke SDP Bindings tab — displays the spoke SDP bindings that are associated 

with the service
• Address tab — lists the IP addresses that are associated with the service

• Faults tab — displays the faults associated with the service

4 Modify the parameters for the service, as required.

To configure items in the Components tab, select and right-click on the items and 
choose Properties from the contextual menu.

To configure items in the tabs that contain lists of service elements, select the items 
and click on the Edit button.

5 Click on the OK button. A confirmation dialog box appears.

Caution —  Modifying parameters can be service-affecting.

Note —  You cannot remove an IP address from an interface when the 
IP address of a static host is defined in the subnet of the interface IP 
address and the ARP Populate parameter is enabled on the 
Anti-Spoofing tab.
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6 Click on the Yes button to confirm the action. The VPRN Service Name (Edit) form 
closes and the Manage Services form reappears.

7 Click on the Close button to close the Manage Services form.

Procedure 33-6  To view the service operational status

The Aggregated Operational State and State Cause indicators on the General tab of the 
service management form display information about service faults.

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a service and click on the Edit button. The VPRN (Edit) form opens.

4 View the Aggregated Operational State and State Cause indicators. When the 
Aggregated Operational State is Down or Partially Down, a check mark beside the 
appropriate State Cause indicator identifies the type of associated service fault.

5 Click on the appropriate tab button to view or edit an object that is identified as faulty 
by a State Cause indicator.

6 Click on the Faults tab button to view the alarms for the object. The Object Alarms 
tab is displayed.

7 Click on the Aggregated Alarms tab button to view the aggregated alarms for the 
object. The Aggregated Alarms tab is displayed.

8 Close the VPRN (Edit) form.

9 Click on the Close button to close the Manage Services form.

Procedure 33-7  To view the service topology

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a VPRN service and click on the Topology View button. A Topology View 
dialog box appears.

4 Click on the Yes button to proceed. The Service Topology - Service Name map 
opens.
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See chapter 37 for more information about service topology views.

Procedure 33-8  To delete a VPRN service

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Choose a VPRN service.

4 Click on the Remove button. A confirmation dialog box appears.

5 Click on the Yes button to confirm the action. The service is deleted and removed 
from the list.

6 Click on the Close button to close the Manage Services form.
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34.1 VLAN service management overview

The 5620 SAM supports the creation of VLAN services using Telco devices 
configured as PE devices. VLANs can be configured as:

• standard VLAN services
• management VLAN services
• L2 VPN VLAN services
• BTV VLAN services
• Internet access (super-VLAN) services

The 5620 SAM supports end-to-end VLAN configuration using the following 
methods:

• Tabbed configuration forms with an embedded navigation tree. The navigation 
tree provides a logical view of the service and acts as a configuration interface.

• Pre-configured template. Figure 34-1 shows the Create Service From Template 
form. A user with Service Mgmt privileges can create a service template. See 
chapter 17 for more information about the administrative tasks associated with 
service templates.

Figure 34-1  Create Service From Template form
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Figure 34-2  Ring in a metropolitan and broadcast network

VLAN ring groups are used to send traffic across an Ethernet ring using copper or 
fiber optic connections from the source traffic device, for example, from a 7450 ESS, 
to all devices in the ring. Automatic STP configuration on the Telco devices ensures 
that there is a constant stream of traffic in either direction by rerouting traffic around 
breaks in the physical links between Telco devices. Figure 34-2 shows how the Telco 
ring group is part of a larger metropolitan area network.
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Figure 34-3  VLAN service management form - General tab

The General tab of the 5620 SAM service management form displays useful 
information about the operational state of the service and its sites through the 
Aggregated Operational State and State Cause indicators, as shown in Figure 34-3.

The Aggregated Operational State indicator has four possible values: Up, Down, 
Partially Down, and Unknown. The value is derived from the operational states of 
the sites that are part of the service, as follows:

• Up—All sites are operationally up
• Partially Down—At least one site is operationally down
• Down—All sites are operationally down
• Unknown—The service has no provisioned sites

When the Aggregated Operational State is Partially Down or Down, a check mark 
appears beside the appropriate State Cause indicator to identify the type of fault to 
the 5620 SAM operator.
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Telco policies

Policies can be assigned to all devices or ports on Telco devices. Policies are defined 
at a global level and then applied to components of the service, such as a port. The 
policy on the component is then a local version of the global policy. The following 
policies are common to VLAN services:

• QoS policies define ingress classification, policing, shaping, and marking on the 
device. QoS policies are configured using the Telco Qos Node Level Policy 
Manager.

• Filter policies control network traffic into or out of an interface or device based 
on IP or MAC matching criteria. Filter policies are configured using the Telco 
ACL Standard IP Filter Manager, the Telco ACL Extended IP Filter Manager, 
and the Telco ACL MAC Filter Manager.

• Multicast policies define the available broadcast addresses (BTV channels) for a 
Telco ring. ACL IGMP filters specify the filters that are applied for subscribers 
to the channels to ensure only the subscribed channels are delivered. Multicast 
polices and subscriber filters are configured using the Multicast Package Policy 
Manager and the Telco ACL IGMP Filter Manager, and are applied during 
service creation.

See chapter 28 for more information about policies.

Telco network management

Management of Telco devices is performed from the 5620 SAM using a combination 
of SNMP and CLI messages. To ensure the latest management view of the network, 
a management VLAN must be created on Telco devices that belong to a ring group. 
This is done by:

• ensuring ports are configured to allow management messages
• making the 7450 ESS part of a management VPLS, used to relay SNMP and CLI 

messages to the Telco devices

The following high-level steps describe the sequence:

1 Choose a management VLAN ID to be used in the ring, for example, ID 1000.

2 Create a VPLS on the 7450 ESS that has the SAPs in the VPLS set with 
encapsulation 1000. See chapter 31 for more information about creating a VPLS.

3 The port to which the 5620 SAM is connected to the network is added to the 
VPLS without encapsulation.

4 Create a management VLAN on each Telco device, for example, using CLI on a 
Telco device:

• config vlan
• create mgt_1000
• config mgt_1000
• add ports 1/2/1, 1/2/2 tagged
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5 Exclude all other VLANs from being management VLANs, for example, using 
CLI on a Telco device:

• config vlan
• no management 1-999,1001-4094

6 Ensure only the uplink ports from the Telco devices have device management 
capabilities to ensure user ports cannot access CLI, SNMP, or FTP functionality, 
for example, using CLI on a Telco device:

• config
• no port management 1/1/1-1/1/24

34.2 Sample VLAN configuration for L2 VPNs

Figure 34-4 shows a sample VLAN L2 VPN service configuration. The 
configuration depends on the specific network requirements.

Figure 34-4  Sample VLAN configuration for L2 VPNs
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Verify that the following preconfigurations are complete.

• Ensure that the appropriate preconfigurations have been performed on the Telco 
devices.

• pre-discovery CLI modifications
• discovery including mediation configuration with the CLI user names and 

passwords
• ports are configured as access and network

• Ensure that the TLS VPLS that feeds the Telco ring VLAN service is configured 
on the 7450 ESSs. The encapsulation of the SAPs that belong to the VPLS on the 
7450 ESSs should match the VLAN ID of the Telco VLAN.

• Configure the Telco ports as access and network, as required, from the navigation 
tree.

• Configure the bridge instances for the Telco devices from the network view in the 
navigation tree.

• Telco devices that belong to the ring, and the 7450 ESS that the ring connects to, 
should be added to the ring group.

Table 34-1 lists the high-level tasks that are required to configure this sample VLAN 
L2 VPN service. 

Table 34-1 Sample VLAN L2 VPN service configuration

Task Description

1. Manage and 
configure devices

Ensure that the required configurations are completed to equipment, including configuring access 
and network ports, enabling CLI configuration on managed Telco devices, and the creating of ring 
groups that are enabled to receive TLS (L2 VPN) streams:

• The ring group contains all three devices.
• TLS is enabled for the ring group.
• Ports 1/1/23 and 1/1/24 on the device connected to Site A and 1/2/1 and 1/2/2 connected to Site 

B are configured as network. 
• Ports 1/1/2 and 1/1/3 are configured as access on the 7450 ESS, and the encapsulation 

matches the VLAN ID (444).
• Ports 1/1/2 and 1/1/8 on the Telco devices are configured as access ports.

2. Configure policies 
as required

Policies should be configured before you create a service. The following key policies can be applied 
to resources that are part of a VLAN.

• QoS policies for the Telco devices and ports
• scheduling policies
• filter policies, including IGMP filter policies to create and deploy access control lists on the Telco 

devices in the ring

3. Distribute policies to 
devices

Distribute configured policies to the devices. The policies are used during the creation of VLAN 
services.

4. Create VLAN 
services

Create VLAN services using a series of configuration forms:

• A VLL with 0 encapsulation is created between the SAPs (1/1/2 and 1/1/3) on the 7450 ESS.
• A L2 VPN VPLS is created on the 7450 ESS.
• The SAPs on the 7450 ESS that are part of the VPLS use the same encapsulation as the VLAN 

ID for the ring group (444).
• The VLAN created for the ring group uses ID 444.

5. Add access 
interfaces

Associate access interfaces (similar to SAPs) with VLAN services, that are the physical ports to 
which subscribers are connected. Use the L2 Interfaces tab button on the VLAN properties form to 
associate VLAN services with the ports used by subscribers.
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34.3 Sample VLAN configuration for BTV

Figure 34-5 shows a sample VLAN broadcast service configuration. The 
configuration depends on the specific network requirements.

Figure 34-5  Sample VLAN configuration for BTV
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Verify that the following preconfigurations are complete:

• Ensure that the appropriate preconfigurations have been performed on the Telco 
devices.

• pre-discovery CLI modifications
• SNMP trap forwarding to the 5620 SAM
• discovery including mediation configuration with the CLI user names and 

passwords
• ports are configured as access and network

• Ensure that the BTV VPLS that feeds the Telco ring VLAN service is configured 
on the 7450 ESSs. The encapsulation of the SAPs that belong to the VPLS on the 
7450 ESSs should match the VLAN ID of the Telco VLAN.

• Configure Telco ports as access and network, as required, from the navigation 
tree.

• Configure the bridge instances for the Telco devices from the network view in the 
navigation tree.

• Enable IGMP snooping on the bridge instance for the Telco devices included in 
the broadcast TV VLAN.

• Telco devices that belong to the ring, and the 7450 ESS that the ring connects to, 
should be added to the ring group.

• Create and manage the necessary broadcast TV policies, including multicast 
package and IGMP filtering.

Table 34-2 lists the high-level tasks that are required to configure this sample VLAN 
broadcast TV service. 

Table 34-2 Sample VLAN broadcast TV service configuration

Task Description

1. Manage and 
configure devices

Ensure that the required configurations are completed to equipment, including configuring access 
and network ports, enabling CLI configuration on managed Telco devices, and the creation of ring 
groups that are enabled to receive BTV MVR streams:

• The ring group contains all three devices.
• Ports 1/1/23 and 1/2/2 on the device with the IP address 138.120.200.246 and ports 1/2/1 and 

1/2/2 on the device with the IP address 138.120.200.247 are configured as network.
• Ports 1/1/2 and 1/1/3 are configured as access on the 7450 ESS with an encapsulation 

matching the VLAN ID (333).
• Port 1/1/1 on the Telco 48T is configured as access.

2. Configure policies 
as required

Policies should be configured before you create a service. The following key policies can be applied 
to resources that are part of a VLAN BTV service.

• QoS policies for the Telco devices and ports
• scheduling policies
• filter policies, including IGMP filter policies to create and deploy access control lists on the Telco 

devices in the ring
• multicast package policies to determine the content of the broadcast streams that are sent to 

the Telco devices in the ring

3. Distribute policies to 
devices

Distribute configured policies to the devices. Policies are used during the creation of VLAN services.

(1 of 2)
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34.4 Sample configuration for super VLAN

Figure 34-6 shows a sample super VLAN configuration. The configuration depends 
on the specific network requirements.

Figure 34-6  Sample configuration for super VLAN
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which subscribers are connected. You use the L2 Interfaces tab button on the VLAN properties form 
to associate VLAN services with the ports used by subscribers.

Task Description

(2 of 2)

17765

IES

Super
Vlan
20

7450 ESS

138.120.200.246 138.120.200.247

User port

1/2/2

1/1/1

1/2/1 1/2/1

1/2/2

Internet
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Verify that the following preconfigurations are complete:

• Ensure that the appropriate preconfigurations have been performed on the Telco 
devices.

• pre-discovery CLI modifications
• SNMP trap forwarding to the 5620 SAM
• discovery including mediation configuration with the CLI user names and 

passwords
• ports are configured as access and network

• Ensure that the 7450 ESS is configured to support super VLAN internet access. 
• Configure Telco ports as access and network, as required, from the navigation 

tree.
• Telco devices that belong to the ring, and the 7450 ESS that the ring connects to, 

should be added to the ring group.

Table 34-3 lists the high-level tasks that are required to configure this sample super 
VLAN service. 

Table 34-3 Sample configuration for super VLAN

34.5 Workflow to create a VLAN service

1 Ensure that the appropriate preconfigurations have been performed on the Telco 
devices.

• pre-discovery CLI modifications
• discovery including mediation configuration with CLI user name and passwords
• creation of a management VLAN for all devices that belong to a ring group.

Task Description

1. Manage and 
configure devices

Ensure that the required configurations are completed to equipment, including configuring access 
and network ports, enabling CLI configuration on managed Telco devices, and the creation of ring 
groups that are enabled to receive BTV MVR streams:

• The ring group contains all three devices.
• Ports 1/2/1 and 1/2/2 on the device with the IP address 138.120.200.246 and ports 1/2/1 and 

1/2/2 on the device with the IP address 138.120.200.247 are configured as network.
• Port 1/1/1 on 138.120.200.246 is configured as access.

2. Configure policies 
as required

Policies should be configured before you create a service. The following key policies can be applied 
to resources that are part of a super VLAN service.

• QoS policies for the Telco devices and ports
• scheduling policies

3. Distribute policies to 
devices

Distribute configured policies to the devices. Policies are used during the creation of VLAN services.

4. Create VLAN 
services

Create VLAN services using a series of configuration forms:

• An IES is created on the 7450 ESS.
• The super VLAN created for the ring group uses ID 20.

5. Add access 
interfaces

Associate access interfaces (similar to SAPs) with VLAN services, that are the physical ports to 
which subscribers are connected. Use the L2 Interfaces tab button on the VLAN properties form to 
associate VLAN services with the ports used by subscribers.
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2 Ensure the TLS or BTV VPLS that feeds the Telco ring VLAN service is configured 
on the 7450 ESSs. The encapsulation of the SAPs that belong to the VPLS on the 
7450 ESSs should match the VLAN ID of the Telco VLAN. 

For super VLAN services, ensure the IES that provides Internet access to the Telco 
ring VLAN service is configured on the 7450 ESSs.

3 Configure Telco ports as access and network, as required, from the navigation tree.

4 Configure device- or port-wide QoS policies, as required.

5 Configure the bridge instances for the Telco devices from the network view in the 
navigation tree, as described in chapter 24.

6 Create and add devices connected to the 7450 ESS as part of a ring group, as 
described in chapter 21.

7 For BTV VLAN services:

i Manage the multicast addresses of television channels using the Multicast 
Package Manager, as described in chapter 28.

ii Configure and manage IGMP filters using the IGMP Policy Manager to specify 
the multicast channels that end users can access from the ring that is 
delivering the broadcast streams.

iii Distribute the policies to the managed devices.

8 Provision the service.

i Set up subscribers or associate existing subscribers with the new service.

ii Create the VLAN and associate the subscriber with the VLAN. 

iii Add the physical access interface of the end user for the service from the L2 
Interface tab.

iv Associate IP access groups with the port used for the subscriber.

9 Turn up the service.

34.6 VLAN service management menus

Table 34-4 lists and describes the VLAN service management menus.

Table 34-4 VLAN service management menus

Menu item Description

Manage→Subscribers Create or manage subscribers.

Create→Service→VLAN Create a VLAN service using configuration forms.

Create→Service From Template Create a service using a pre-configured template.

Manage→Services Perform a filtered search on services.
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34.7 VLAN service management procedures list

Table 34-5 lists the procedures necessary to perform VLAN service management 
tasks.

Table 34-5 VLAN service management procedures list

34.8 VLAN service management procedures

Use the following procedures to perform VLAN creation and management tasks.

Procedure 34-1  To create a BTV VLAN service

1 Choose Create→Service→VLAN from the 5620 SAM main menu. The VLAN 
(Create) form opens with the General tab displayed.

2 Configure the following parameters:

• Auto-Assign ID
• Service ID
• Service Name
• Description
• Administrative State

Procedure Purpose

To create a BTV VLAN service Create a BTV VLAN service to send multicast 
television traffic across a ring group.

To create an L2 VPN VLAN service Create a VLAN service to interconnect sites 
using an L2 VPN.

To create a super VLAN service Create a super VLAN service to restrict traffic 
between user ports.

To create a standard VLAN service Create a standard VLAN service.

To create a management VLAN service Create a management VLAN service to allow the 
management of Telco devices that use the same 
VLAN ID.

To associate a VLAN service with a subscriber 
access interface

Associate a configured VLAN service with the 
physical port access interface used by the 
subscriber.

To create a VLAN service using a template Create a VLAN service using a preconfigured 
template.

To modify a VLAN service Modify VLAN service parameters.

To view the service operational status View the operational status of the service.

To view the service topology View a graphical representation of a VLAN 
service.

To delete a VLAN service Delete a VLAN service.
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3 Click on the Select button to choose a subscriber to associate with the BTV VLAN. 
The Select Subscriber - Vlan (Create) form opens.

4 Select a subscriber for the BTV VLAN and click on the OK button. The Select 
Subscriber - Vlan (Create) form closes and the VLAN (Create) form reappears with 
the subscriber information displayed on the General tab.

5 Click on the VLAN tab button.

6 Configure the Application parameter. Choose the Broadcast TV (MVR) option.

7 Click on the Select button in the Ring Group panel to choose a ring group to 
associate with the BTV VLAN. The Select Ring Group - Vlan (Create) form opens.

8 Select a ring group and click on the OK button. The Select Ring Group - Vlan 
(Create) form closes and the VLAN (Create) form reappears with the ring group 
information displayed.

9 Click on the MVR tab button.

10 Configure the following parameters:

• Mode
• Query Response Time (seconds)

11 Click on the Select button in the Multicast Package panel to choose a multicast 
package for the BTV VLAN. The Select Multicast Package - Mvr Configuration 
(Create) form opens.

12 Select a multicast package and click on the OK button. The Select Multicast 
Package - Mvr Configuration (Create) form closes and the VLAN (Create) form 
reappears with the multicast package information displayed.

13 Click on the Components tab button.

14 Right-click on VLAN and choose Create Site. The Site Service Name (Create) form 
opens.

15 Click on the Select button in the Network Element panel to choose a site for the BTV 
VLAN. The Select Network Element - Site (Create) form opens.

16 Select a site and click on the OK button. The Select Network Element - Site (Create) 
form closes and the Site, Service Name (Create) form reappears with the site 
information displayed on the General tab.

17 Configure the following parameters:

• Description
• Administrative State
• Monitor Access Interface Operational State

18 Click on the MVR tab button to configure the Mode parameter, if required.

19 Click on the Components tab button.

20 Right-click on Access Interfaces and choose Create VLAN Access Interface. The 
VLAN Access Interface (Create) form opens with the General tab displayed.
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21 Configure the following parameters:

• Name
• Description
• Administrative State

22 Click on the Port tab button.

23 Click on the Select button in the Terminating Port panel to choose a port for the 
interface. The Select Terminating Port - L2 Access Interface (Create) form opens.

24 Use the configurable filter and Search button to choose an appropriate port for 
subscriber-side access to the BTV VLAN, and click on the OK button. The Select 
Terminating Port - L2 Access Interface (Create) form closes and the VLAN Access 
Interface (Create) form reappears with the selected port information displayed.

25 Configure the remaining parameters, if required. If the port is configured with VLAN 
encapsulation values, the remaining parameters are read-only.

26 Click on the OK button. The VLAN Access Interface (Create) form closes, and a 
dialog box appears.

27 Click on the OK button. The Site Service Name (Create) form reappears.

28 Repeat steps 20 to 27 for each access interface to be created on the site.

29 Click on the OK button. The Site Service Name (Create) form closes, and a dialog 
box appears.

30 Click on the OK button. The VLAN (Create) form reappears with the site information 
displayed in the service components tree.

31 Click on the OK button to close the VLAN (Create) form.

Procedure 34-2  To create an L2 VPN VLAN service

1 Choose Create→Service→VLAN from the 5620 SAM main menu. The VLAN 
(Create) form opens with the General tab displayed.

2 Configure the following parameters:

• Auto-Assign ID
• Service Name
• Description
• Administrative State

3 Click on the Select button to choose a subscriber to associate with the L2 VPN. The 
Select Subscriber - Vlan (Create) form opens.

Note —  Only ports in access mode appear in the list. To choose a port 
that does not appear in the list, use the 5620 SAM navigation tree to 
select a port, choose Properties from the contextual menu, and set the 
Mode parameter to Access. Click on the Search button again; the 
reconfigured port appears.
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4 Select a subscriber for the L2 VPN and click on the OK button. The Select 
Subscriber - Vlan (Create) form closes and the VLAN (Create) form reappears with 
the subscriber information displayed on the General tab.

5 Click on the VLAN tab button.

6 Configure the Application parameter. Choose the L2-VPN (TLS) option.

7 Click on the Select button in the Ring Group panel to choose a ring group to 
associate with the L2 VPN. The Select Ring Group - Vlan (Create) form opens.

8 Select a ring group and click on the OK button. The Select Ring Group - Vlan 
(Create) form closes and the VLAN (Create) form reappears with the ring group 
information displayed.

9 Click on the Components tab button.

10 Right-click on VLAN and choose Create Site. The Site Service Name (Create) form 
opens.

11 Click on the Select button in the Network Element panel to choose a site for the L2 
VPN. The Select Network Element - Site (Create) form opens.

12 Select a site and click on the OK button. The Select Network Element - Site (Create) 
form closes and the Site Service Name (Create) form reappears with the site 
information displayed on the General tab.

13 Configure the following parameters:

• Description
• Administrative State
• Monitor Access Interface Operational State

14 Click on the Components tab button.

15 Right-click on Access Interfaces and choose Create VLAN Access Interface. The 
VLAN Access Interface (Create) form opens with the General tab displayed.

16 Configure the following parameters:

• Name
• Description
• Administrative State

17 Click on the Port tab button.

18 Click on the Select button in the Terminating Port panel to choose a port for the 
interface. The Select Terminating Port - L2 Access Interface (Create) form opens.

19 Use the configurable filter and Search button to choose an appropriate port for 
subscriber-side access to the L2 VPN, and click on the OK button. The Select 
Terminating Port - L2 Access Interface (Create) form closes and the VLAN Access 
Interface (Create) form reappears with the selected port information displayed.
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20 Configure the remaining parameters, if required. If the port is configured with VLAN 
encapsulation values, the remaining parameters are read-only.

21 Click on the OK button. The VLAN Access Interface (Create) form closes, and a 
dialog box appears.

22 Click on the OK button. The Site Service Name (Create) form reappears.

23 Repeat steps 15 to 22 for each access interface to be created on the site.

24 Click on the OK button. The Site Service Name (Create) form closes, and a dialog 
box appears.

25 Click on the OK button. The VLAN (Create) form reappears with the new site 
information displayed in the service components tree.

26 Click on the OK button to close the VLAN (Create) form.

Procedure 34-3  To create a super VLAN service

1 Choose Create→Service→VLAN from the 5620 SAM main menu. The VLAN 
(Create) form opens with the General tab displayed.

2 Configure the following parameters:

• Auto-Assign ID
• Service Name
• Description
• Administrative State

3 Click on the Select button to choose a subscriber to associate with the super VLAN. 
The Select Subscriber - Vlan (Create) form opens.

4 Select a subscriber for the super VLAN and click on the OK button. The Select 
Subscriber - Vlan (Create) form closes and the VLAN (Create) form reappears with 
the subscriber information displayed on the General tab.

5 Click on the VLAN tab button.

6 Configure the Application parameter. Choose the Internet Access (Super-VLAN) 
option.

7 Click on the Select button in the Ring Group panel to choose a ring group to 
associate with the super VLAN. The Select Ring Group - Vlan (Create) form opens.

8 Select a ring group and click on the OK button. The Select Ring Group - Vlan 
(Create) form closes and the VLAN (Create) form reappears with the ring group 
information displayed.

Note —  Only ports in access mode appear in the list. To choose a port 
that does not appear in the list, use the 5620 SAM navigation tree to 
select a port, choose Properties from the contextual menu, and set the 
Mode parameter to Access. Click on the Search button again; the 
reconfigured port appears.
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9 Click on the Components tab button.

10 Right-click on VLAN and choose Create Site. The Site Service Name (Create) form 
opens.

11 Click on the Select button in the Network Element panel to choose a site for the 
super VLAN. The Select Network Element - Site (Create) form opens.

12 Select a site and click on the OK button. The Select Network Element - Site (Create) 
form closes and the Site Service Name (Create) form reappears with the site 
information displayed on the General tab.

13 Configure the following parameters:

• Description
• Administrative State
• Monitor Access Interface Operational State

14 Click on the Components tab button.

15 Right-click on Access Interfaces and choose Create VLAN Access Interface. The 
VLAN Access Interface (Create) form opens with the General tab displayed.

16 Configure the following parameters:

• Name
• Description
• Administrative State

17 Click on the Port tab button.

18 Click on the Select button in the Terminating Port panel to choose a port for the 
interface. The Select Terminating Port - L2 Access Interface (Create) form opens.

19 Use the configurable filter and Search button to choose an appropriate port for 
subscriber-side access to the super VLAN, and click on the OK button. The Select 
Terminating Port - L2 Access Interface (Create) form closes and the VLAN Access 
Interface (Create) form reappears with the selected port information displayed.

20 Configure the remaining parameters, if required. If the port is configured with VLAN 
encapsulation values, the remaining parameters are read-only.

21 Click on the OK button. The VLAN Access Interface (Create) form closes, and a 
dialog box appears.

22 Click on the OK button. The Site Service Name (Create) form reappears.

23 Repeat steps 15 to 22 for each access interface to be created on the site.

24 Click on the OK button. The Site Service Name (Create) form closes, and a dialog 
box appears.

Note —  Only ports in access mode appear in the list. To choose a port 
that does not appear in the list, use the 5620 SAM navigation tree to 
select a port, choose Properties from the contextual menu, and set the 
Mode parameter to Access. Click on the Search button again; the 
reconfigured port appears.
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25 Click on the OK button. The VLAN (Create) form reappears with the new site 
information displayed in the service components tree.

26 Click on the OK button to close the VLAN (Create) form.

Procedure 34-4  To create a standard VLAN service

1 Choose Create→Service→VLAN from the 5620 SAM main menu. The VLAN 
(Create) form opens with the General tab displayed.

2 Configure the following parameters:

• Auto-Assign ID
• Service Name
• Description
• Administrative State

3 Click on the Select button to choose a subscriber to associate with the VLAN. The 
Select Subscriber - Vlan (Create) form opens.

4 Select a subscriber for the VLAN and click on the OK button. The Select Subscriber 
- Vlan (Create) form closes and the VLAN (Create) form reappears with the 
subscriber information displayed on the General tab.

5 Click on the VLAN tab button.

6 Configure the Application parameter. Choose the Standard VLAN option.

7 Click on the Select button in the Ring Group panel to choose a ring group to 
associate with the VLAN. The Select Ring Group - Vlan (Create) form opens.

8 Select a ring group and click on the OK button. The Select Ring Group - Vlan 
(Create) form closes and the VLAN (Create) form reappears with the ring group 
information displayed.

9 Click on the Components tab button.

10 Right-click on VLAN and choose Create Site. The Site Service Name (Create) form 
opens.

11 Click on the Select button in the Network Element panel to choose a site for the 
super VLAN. The Select Network Element - Site (Create) form opens.

12 Select a site and click on the OK button. The Select Network Element - Site (Create) 
form closes and the Site Service Name (Create) form reappears with the site 
information displayed on the General tab.

13 Configure the following parameters:

• Description
• Administrative State
• Monitor Access Interface Operational State

14 Click on the Components tab button.
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15 Right-click on Access Interfaces and choose Create VLAN Access Interface. The 
VLAN Access Interface (Create) form opens with the General tab displayed.

16 Configure the following parameters:

• Name
• Description
• Administrative State

17 Click on the Port tab button.

18 Click on the Select button in the Terminating Port panel to choose a port for the 
interface. The Select Terminating Port - L2 Access Interface (Create) form opens.

19 Use the configurable filter and Search button to choose an appropriate port for 
subscriber-side access to the VLAN, and click on the OK button. The Select 
Terminating Port - L2 Access Interface (Create) form closes and the VLAN Access 
Interface (Create) form reappears with the selected port information displayed.

20 Configure the remaining parameters, if required. If the port is configured with VLAN 
encapsulation values, the remaining parameters are read-only.

21 Click on the OK button. The VLAN Access Interface (Create) form closes, and a 
dialog box appears.

22 Click on the OK button. The Site Service Name (Create) form reappears.

23 Repeat steps 15 to 22 for each access interface that you wish to create on the site.

24 Click on the OK button. The Site Service Name (Create) form closes, and a dialog 
box appears.

25 Click on the OK button. The VLAN (Create) form reappears with the new site 
information displayed in the service components tree.

26 Click on the OK button to close the VLAN (Create) form.

Procedure 34-5  To create a management VLAN service

1 Choose Create→Service→VLAN from the 5620 SAM main menu. The VLAN 
(Create) form opens with the General tab displayed.

2 Configure the following parameters:

• Auto-Assign ID
• Service Name
• Description
• Administrative State

Note —  Only ports in access mode appear in the list. To choose a port 
that does not appear in the list, use the 5620 SAM navigation tree to 
select a port, choose Properties from the contextual menu, and set the 
Mode parameter to Access. Click on the Search button again; the 
reconfigured port appears.
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3 Click on the Select button to choose a subscriber to associate with the management 
VLAN. The Select Subscriber - Vlan (Create) form opens.

4 Select a subscriber for the management VLAN and click on the OK button. The 
Select Subscriber - Vlan (Create) form closes and the VLAN (Create) form 
reappears with the subscriber information displayed on the General tab.

5 Click on the VLAN tab button.

6 Configure the Application parameter. Choose the Management VLAN option.

7 Click on the Select button in the Ring Group panel to choose a ring group to 
associate with the management VLAN. The Select Ring Group - Vlan (Create) form 
opens.

8 Select a ring group and click on the OK button. The Select Ring Group - Vlan 
(Create) form closes and the VLAN (Create) form reappears with the ring group 
information displayed.

9 Click on the Components tab button.

10 Right-click on VLAN and choose Create Site. The Site Service Name (Create) form 
opens.

11 Click on the Select button in the Network Element panel to choose a site for the 
management VLAN. The Select Network Element - Site (Create) form opens.

12 Select a site and click on the OK button. The Select Network Element - Site (Create) 
form closes and the Site Service Name (Create) form reappears with the site 
information displayed on the General tab.

13 Configure the following parameters:

• Description
• Administrative State
• Monitor Access Interface Operational State

14 Click on the Components tab button.

15 Right-click on Access Interfaces and choose Create VLAN Access Interface. The 
VLAN Access Interface (Create) form opens with the General tab displayed.

16 Configure the following parameters:

• Name
• Description
• Administrative State

17 Click on the Port tab button.

18 Click on the Select button in the Terminating Port panel to choose a port for the 
interface. The Select Terminating Port - L2 Access Interface (Create) form opens.
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19 Use the configurable filter and Search button to choose an appropriate port for 
subscriber-side access to the management VLAN, and click on the OK button. The 
Select Terminating Port - L2 Access Interface (Create) form closes and the VLAN 
Access Interface (Create) form reappears with the selected port information 
displayed.

20 Configure the remaining parameters, if required. If the port is configured with VLAN 
encapsulation values, the remaining parameters are read-only.

21 Click on the OK button. The VLAN Access Interface (Create) form closes, and a 
dialog box appears.

22 Click on the OK button. The Site Service Name (Create) form reappears.

23 Repeat steps 15 to 22 for each access interface to be created on the site.

24 Click on the OK button. The Site Service Name (Create) form closes, and a dialog 
box appears.

25 Click on the OK button. The VLAN (Create) form reappears with the new site 
information displayed in the service components tree.

26 Click on the OK button to close the VLAN (Create) form.

Procedure 34-6  To associate a VLAN service with a subscriber 
access interface

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Use the configurable filter and Search button to choose the VLAN service to be 
associated with a subscriber interface, and click on the Edit button. The VLAN - 
Service Name (Edit) form opens.

3 Click on the Components tab button.

4 Scroll through the service components tree to find the site for the new access 
interface.

5 Right-click on the Access Interfaces branch of the tree that is connected to the site 
and choose Create VLAN Access Interface. The VLAN Access Interface (Create) 
form opens with the General tab displayed.

6 Configure the following parameters:

• Name
• Description
• Administrative State

Note —  Only ports in access mode appear in the list. To choose a port 
that does not appear in the list, use the 5620 SAM navigation tree to 
select a port, choose Properties from the contextual menu, and set the 
Mode parameter to Access. Click on the Search button again; the 
reconfigured port appears.
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7 Click on the Port tab button.

8 Click on the Select button in the Terminating Port panel to choose a port for the 
interface. The Select Terminating Port - L2 Access Interface (Create) form opens.

9 Use the configurable filter and Search button to choose an appropriate port for 
subscriber-side access to the VLAN, and click on the OK button. The Select 
Terminating Port - L2 Access Interface (Create) form closes, and a dialog box 
appears.

10 Click on the OK button. The VLAN Access Interface (Create) form reappears with 
the port information displayed.

11 Configure the remaining parameters, if required. If the port is configured with VLAN 
encapsulation values, the remaining parameters are read-only.

12 Click on the OK button. The VLAN Access Interface (Create) form closes, and a 
dialog box appears.

13 Click on the OK button. The VLAN - Service Name (Edit) form reappears with the 
new interface displayed in the service components tree under Access Interfaces for 
the site specified in step 4.

14 Click on the OK button. A dialog box appears.

15 Click on the Yes button to confirm the action and close the dialog box. The Manage 
Services form reappears.

16 Click on the Close button to close the Manage Services form.

Procedure 34-7  To create a VLAN service using a template

1 Choose Create→Service From Template from the 5620 SAM main menu. The 
Create Service From Template form opens, as shown in Figure 34-1.

2 Select the template associated with the service that you want to add to the 
5620 SAM.

3 Click on the OK button. The service template creation form opens.

4 Configure the parameters. The 5620 SAM administrator defines the parameters that 
you can configure. An exclamation mark (!) identifies parameters that you must 
configure before using the template. (The ! icon also appears on the tabs containing 
parameters that require configuration.) A lock icon identifies parameters restricted 
by the 5620 SAM administrator. See chapter 17 for more information about the 
administrative tasks associated with service templates.

See chapter 52 for information about the parameters associated with creating a 
VLAN service.

Note —  Only ports in access mode appear in the list. To choose a port 
that does not appear in the list, use the 5620 SAM navigation tree to 
select a port, choose Properties from the contextual menu, and set the 
Mode parameter to Access. Click on the Search button again; the 
reconfigured port appears.
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5 Click on the appropriate tab buttons to add site, interface, or SDP binding service 
components, if required. The template administrator can create secondary site, 
interface, and SDP binding templates and bind them to the primary VLAN template. 
See chapter 17 for more information about the administrative tasks associated with 
service templates.

6 Click on the OK button to save the changes and close the service template creation 
form.

Procedure 34-8  To modify a VLAN service

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a VLAN service.

4 Click on the Edit button. The VLAN Service Name (Edit) form opens with the general 
properties of the service displayed on the General tab.

The following tabs contain non-configurable parameter information for the service:

• VLAN tab — displays information about the VLAN type
• MVR tab — displays multicast package policy information for the service

The MVR tab button is not selectable for some types of VLAN.

The following tabs list the service elements that can be individually or collectively 
selected and configured:

• Components tab — displays the various service components in a tree format
• Sites tab — lists the sites that are included in the service
• VLAN Access Interfaces tab — lists the L2 access interfaces that are included 

in the service
• Faults tab — displays the faults associated with the service

5 Modify the parameters for the service as required.

To configure items in the Components tab, select and right-click on the items and 
choose Properties from the contextual menu.

To configure items in the tabs that contain lists of service elements, select the items 
and click on the Edit button.

6 Click on the OK button. A confirmation dialog box appears.

7 Click on the Yes button to confirm the action. The VLAN Service Name (Edit) form 
closes and the Manage Services form reappears.

Caution —  Modifying parameters can be service-affecting.
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8 Click on the Close button to close the Manage Services form.

Procedure 34-9  To view the service operational status

The Aggregated Operational State and State Cause indicators on the General tab of the 
service management form display information about service faults.

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a service and click on the Edit button. The VLAN (Edit) form opens.

4 View the Aggregated Operational State and State Cause indicators. When the 
Aggregated Operational State is Down or Partially Down, a check mark beside the 
appropriate State Cause indicator identifies the type of associated service fault.

5 Click on the appropriate tab button to view or edit an object that is identified as faulty 
by a State Cause indicator.

6 Click on the Faults tab button to view the alarms for the object. The Object Alarms 
tab is displayed.

7 Click on the Aggregated Alarms tab button to view the aggregated alarms for the 
object. The Aggregated Alarms tab is displayed.

8 Close the VLAN (Edit) form.

9 Click on the Close button to close the Manage Services form.

Procedure 34-10  To view the service topology

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a VLAN service and click on the Topology View button. A Topology View 
dialog box appears.

4 Click on the Yes button to proceed. The Service Topology - Service Name map 
opens.

See chapter 37 for more information about service topology views.
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Procedure 34-11  To delete a VLAN service

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Choose a VLAN service from the list.

4 Click on the Remove button. A confirmation dialog box appears.

5 Click on the Yes button to confirm the action. The service is deleted and removed 
from the list.

6 Click on the Close button to close the Manage Services form.

Caution —  Do not delete any VLANs that are used for network 
management, otherwise connectivity between the 5620 SAM and the 
Telco devices is lost.
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35.1 Service mirror overview

The 5620 SAM GUI implementation of service mirroring provides mirroring of 
service traffic packets from any service type.

In a mirrored service, originating packets are forwarded to their service destination, 
and a copy of the entire packet, or a portion of the packet, as specified during 
configuration of the service mirror, is sent to the mirror destination. The mirrored 
packet can be viewed by an operator using a packet sniffer device that is attached to 
the destination mirror port. A service mirror can have many mirror sources and only 
one destination. Mirroring is performed on a unidirectional basis. The mirrored 
packets are transported across the core network using IP or MPLS tunneling.

Figure 35-1  Service mirroring

Figure 35-1 shows how service mirroring is performed. Service mirroring can be 
used to:

• troubleshoot problems with customer packet delivery and content
• help service providers meet regulations by providing itemized call records and 

wiretaps, as authorized by investigative authorities
• simplify the complex traffic-analysis networks that are often implemented as 

overlays to the customer-facing network
• specify full-packet or sliced-packet mirroring, depending on the requirements

The 5620 SAM supports end-to-end service mirror configuration using the following 
methods:

• Tabbed configuration forms with an embedded navigation tree. The navigation 
tree provides a logical view of the service and acts as a configuration interface.

• Preconfigured template. Figure 35-2 shows the Create Service From Template 
form. A user with Service Mgmt privileges can create a service template. The 
service management user can also configure and bind site, circuit, and L2 
interface templates to the service template. See chapter 17 for more information 
about the administrative tasks associated with service templates.
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Figure 35-2  Create Service From Template form

Figure 35-3  Service mirror management form - General tab

The General tab of the 5620 SAM service management form displays useful 
information about the operational state of the service and its sites through the 
Aggregated Operational State and State Cause indicators, as shown in Figure 35-3.

The Aggregated Operational State indicator has four possible values: Up, Down, 
Partially Down, and Unknown. The value is derived from the operational states of 
the sites that are part of the service, as follows:

• Up—All sites are operationally up
• Partially Down—At least one site is operationally down
• Down—All sites are operationally down
• Unknown—The service has no provisioned sites
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When the Aggregated Operational State is Partially Down or Down, a check mark 
appears beside the appropriate State Cause indicator to identify the type of fault to 
the 5620 SAM operator.

Consider the following information before you implement service mirrors.

• The default subscriber is the only subscriber to a service mirror. The default 
subscriber ID is 1.

• The destination of a service mirror must be an L2 SAP.
• You must have Admin or Service Mgmt user group privileges to create or modify 

a service mirror.
• Ingress or egress SAPs, or ingress or egress ports, can be mirrored. The types of 

packets that are mirrored differ based on the type of service or port used.
• Service mirror IDs are obtained from the same pool of IDs used by other services. 

When you manually assign ID values, ensure that you do not assign an ID that 
belongs to another service.

• Up to 255 mirror destinations are supported per managed network.
• You can use the packet-slicing option to copy a specific packet size for each 

frame. This option is useful for monitoring network usage without copying the 
customer data. It also limits the amount of mirrored traffic that streams through 
the managed devices and the core network.

• When the mirror destination site is not on the same NE as the mirror source, there 
must be a service tunnel between the source and destination NEs.

• The 5620 SAM can automatically create a service tunnel between the source and 
destination sites in the following case:

• automatic SDP binding (formerly known as circuit) creation is enabled
• GRE is the transport type
• no other service tunnel is available between the source and destination sites

• The encapsulation type must be the same for all sites associated with a mirror.
• When the same packet is referenced by multiple mirrors (for example, from a 

SAP and a port), the packet can only be mirrored once in the following 
non-configurable order:

• MAC or IP filters
• MPLS labels (ingress label)
• SAP
• port

35.2 Sample service mirror configuration

Figure 35-4 shows a sample service mirror configuration.

Caution —  Service mirroring can affect performance across the 
network and in the source and destination devices, and should be 
planned accordingly.
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Figure 35-4  Sample service mirror configuration

In this sample, Router B is the mirror source that carries the customer packets. Router 
A is the mirror destination. The ingress and egress traffic on Port 5/2/1 is mirrored 
on the destination, Port 3/1/3. Table 35-1 lists the high-level tasks to configure the 
sample service mirror.

Table 35-1 Sample service mirror configuration

35.3 Workflow to create a service mirror

1 Verify that an existing service for a customer is configured, available, and turned up.

2 Set up a packet-sniffing device at the SAP that is the destination of the service 
mirror.

3 Specify the SAP with the attached packet-sniffing device as the mirror destination.

4 Configure the source of the packets to be mirrored.

5 Turn up the service mirror.
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Specify the Tunnel ID 1000 as the transport tunnel to the mirror destination.

All the parameters required to configure the type of mirroring, for example, slicing and mirror 
classification, are specified in the destination parameters.

3. Specify the Layer 2 or Layer 
3 SAP to be mirrored.

The egress and ingress traffic on Port 5/2/1 is to be mirrored.
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35.4 Service mirror menus

Table 35-2 describes the service mirror menus.

Table 35-2 Service mirror menus

35.5 Service mirror procedures list

Table 35-3 lists the procedures to create, delete, view, and manage service mirrors.

Table 35-3 Service mirror procedures list

35.6 Service mirror procedures

Use the following procedures to create, delete, view, and modify service mirrors.

Procedure 35-1  To create a service mirror

1 Choose Create→Service→Mirror from the 5620 SAM main menu. The Mirror 
(Create) form opens with the General tab displayed.

2 Configure the following parameters:

• Auto-Assign ID
• Service ID
• Service Name
• Description
• Administrative State

3 Perform one of the following.

Menu item Description

Create→Service→Mirror Create a service mirror.

Manage→Services Perform a filtered search on services.

Procedure Purpose

To create a service mirror Create a service mirror.

To create a service mirror using a template Create a service mirror using a template.

To modify a service mirror Modify service mirror parameters.

To view the service operational status View the operational status of the service mirror.

To view the service topology View a graphical representation of a mirror 
service that shows the sites and interfaces.

To delete a service mirror Delete a service mirror.
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a Leave the Automatic SDP Binding Creation parameter disabled.

When you leave the Automatic SDP Binding Creation parameter disabled, you 
must create SDP bindings for the service and bind the SDPs to a service tunnel 
in step 30 of this procedure.

b Enable the Automatic SDP Binding Creation parameter.

When you enable the Automatic SDP Binding Creation parameter, SDP 
bindings for the service are automatically created and bound to service 
tunnels.

i Configure the Transport Type parameter.

ii Configure the Use Bandwidth-Reserved Paths parameter, if applicable.

The Use Bandwidth-Reserved Paths parameter is configurable only 
when the Transport Type parameter is set to MPLS:RSVP-LSP or Any.

4 Click on the Components tab button.

5 Right-click on Destination Site in the service components tree and choose Create 
Destination Site from the contextual menu. The Select Network Elements form 
opens with a list of available sites displayed.

6 Select a site and click on the OK button. The Select Network Elements form closes 
and the Site (Create) form opens with the system identifier of the selected site 
displayed in the Network Element panel.

7 Configure the following parameters:

• Name 
• Description 
• Administrative State
• Monitor Access Interface Operational State
• Encapsulation Type

8 Click on the Mirroring Configuration tab button.

9 Configure the following parameters:

• Source Administrative State
• Slice Size
• Forwarding Class

Note —  You must select GRE as the transport type to allow the 
5620 SAM to automatically create SDP bindings between the source and 
destination sites. No other service tunnel must be available between the 
source and destination sites.

Note —  To use MPLS:RSVP-LSP or MPLS:LDP as the transport type, 
you must bind LSPs to service tunnels during service tunnel 
configuration. See Procedure 26-1 for more information.
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Choose the default of 0 for the Slice Size parameter when you configure a 
destination mirror site, unless slicing at the destination is necessary. Packet slicing 
is normally configured only for mirror sources to minimize the amount of mirrored 
traffic that traverses the network.

10 Click on the OK button. A dialog box appears.

11 Click on the OK button. The Site (Create) form closes and the Mirror (Create) form 
reappears with the selected site displayed in the service components tree.

12 Right-click on L2 Access Interface (Test Equipment Interface) under the selected 
site in the service components tree and choose Create L2 Access Interface from the 
contextual menu to assign an interface as the mirror destination. The L2 Access 
Interface (Create) form opens.

13 Click on the Select button to choose a port to associate with the L2 access interface. 
The Select Terminating Port - L2 Access Interface (Create) form opens.

14 Use the configurable filter and Search button to choose a port, and click on the OK 
button. The Select Terminating Port - L2 Access Interface (Create) form closes and 
the L2 Access Interface (Create) form refreshes with the selected terminating port 
information displayed.

15 Configure the following parameters:

• Outer Encapsulation Value
• Inner Encapsulation Value

The Outer Encapsulation Value parameter is configurable only when the port 
encapsulation type is Dot1 Q or Q in Q.

The Inner Encapsulation Value parameter is configurable only when the port 
encapsulation type is Q in Q.

16 Assign an egress QoS policy to the interface, if required.

i Click on the QoS tab button.

ii Click on the Select button in the Egress Policy panel to choose an egress QoS 
policy. The Select Egress Policy - L2 Access Interface (Create) form opens.

iii Select an egress QoS policy and click on the OK button. The Select Egress 
Policy - L2 Access Interface (Create) form closes and the L2 Access Interface 
(Create) form refreshes with the egress QoS policy information displayed.

iv Click on the OK button. A dialog box appears.

v Click on the OK button. The Mirror (Create) form refreshes with the L2 access 
interface information displayed below L2 Access Interface (Test Equipment 
Interface) in the service components tree.

17 If no mirror sources are to be configured on the destination site, go to step 23.

Note —  Only ports in access mode appear in the list. To choose a port 
that does not appear in the list, use the 5620 SAM navigation tree to 
select a port, choose Properties from the contextual menu, and set the 
Mode parameter to Access. Close and re-open the Select Terminating 
Port form; the reconfigured port appears.
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18 Choose a source SAP on the destination site for mirroring, if required..

i Right-click on Source SAPs in the service components tree and choose Create 
Source Interface from the contextual menu. The Source Interface (Create) 
form opens.

ii Click on the Select button to choose an access interface to associate with the 
source interface. The Select Mirrored Interface - Source Interface (Create) 
form opens.

iii Use the configurable filter and Search button to choose an access interface, 
and click on the OK button. The Select Mirrored Interface - Source Interface 
(Create) form closes and the Source Interface (Create) form refreshes with the 
selected interface information displayed.

iv Configure the following parameters:

• Enable Egress
• Enable Ingress

v Click on the OK button. A confirmation dialog box appears.

vi Click on the OK button. The Mirror (Create) form refreshes with the source 
SAP displayed below Source SAPs in the service components tree.

vii Repeat steps i to vi to specify additional mirror source SAPs for the site.

19 Choose a source port on the destination site for mirroring, if required.

i Right-click on Source Ports in the service components tree and choose Create 
Source Port from the contextual menu. The Source Port (Create) form opens.

ii Click on the Select button to choose a port. The Select - Source Port (Create) 
form opens.
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The source port can be one of the following:

• physical port
• channel
• LAG
• bundle
• CCAG

iii Use the configurable filter and Search button to choose a port, and click on the 
OK button. The Select - Source Port (Create) form closes and the Source Port 
(Create) form refreshes with the selected port information displayed.

iv Configure the following parameters:

• Enable Egress
• Enable Ingress

v Click on the OK button. A confirmation dialog box appears.

vi Click on the OK button. The Mirror (Create) form refreshes with the source port 
displayed below Source Ports in the service components tree.

vii Repeat steps i to vi to specify additional mirror source ports for the site.

20  Choose an IP filter entry for the mirror site, if required.

i Right-click on Source IP Filters in the service components tree and choose 
Create Source IP Filter from the contextual menu. The Source IP Filter 
(Create) form opens.

ii Click on the Select button to choose an IP filter entry. The Select Filter - Source 
Ip Filter (Create) form opens.

iii Use the configurable filter and Search button to choose an IP filter entry, and 
click on the OK button. The Select Filter - Source Ip Filter (Create) form closes 
and the Source IP Filter (Create) form refreshes with the selected IP filter ID 
and IP filter entry ID displayed.

iv Click on the OK button. A confirmation dialog box appears.

v Click on the OK button. The Mirror (Create) form refreshes with the source IP 
filter displayed below Source IP Filters in the service components tree.

vi Repeat steps i to v to specify additional source IP filters.
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21  Choose a MAC filter entry for the mirror, if required.

i Right-click on Source MAC Filters in the service components tree and choose 
Create Source MAC Filter from the contextual menu. The Source MAC Filter 
(Create) form opens.

ii  Click on the Select button to choose a MAC filter entry. The Select Filter - 
Source Mac Filter (Create) form opens.

iii Use the configurable filter and Search button to choose a MAC filter entry, and 
click on the OK button. The Select Filter - Source Mac Filter (Create) form 
closes and the Source MAC Filter (Create) form refreshes with the selected 
MAC filter ID and MAC filter entry ID displayed.

iv Click on the OK button. A confirmation dialog box appears.

v Click on the OK button. The Mirror (Create) form refreshes with the source 
MAC filter displayed below Source MAC Filters in the service components tree.

vi Repeat steps i to v to specify additional source MAC filters.

22 Choose an MPLS ingress label for the mirror, if required.

i Right-click on Source MPLS Ingress Labels in the service components tree 
and choose Create Source Ingress Label from the contextual menu. The 
Source Ingress Label (Create) form opens.

ii  Configure the Ingress Label parameter.

iii Click on the OK button. A confirmation dialog box appears.

iv Click on the OK button. The Mirror (Create) form refreshes with the MPLS 
ingress label displayed below Source MPLS Ingress Labels in the service 
components tree.

v Repeat steps i to iv to specify additional source MPLS ingress labels.

23 To configure a mirror source on a site other than the destination site, right-click on 
Source Sites in the service components tree and choose Create Source Site from 
the contextual menu. Otherwise, go to step 41.

24 The Select Network Elements form opens with a list of available sites displayed. 
Select a site and click on the OK button. The Select Network Elements form closes 
and the Site (Create) form opens with the system identifier of the selected site 
displayed in the Network Element panel.

25 Configure the following parameters:

• Name
• Description
• Administrative State
• Monitor Access Interface Operational State
• Encapsulation Type

26 Click on the Mirroring Configuration tab button.
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27 Configure the following parameters:

• Source Administrative State
• Forwarding Class
• Slice Size

28 Click on the OK button. A dialog box appears.

29 Click on the OK button. The Site (Create) form closes and the Mirror (Create) form 
reappears with the Components tab selected. The service components tree is 
refreshed with the selected site displayed under Source Sites.

30 Right-click on Mirror SDP Binding under the source site in the service components 
tree and choose Create Mirror SDP Binding from the contextual menu to choose an 
SDP binding for the mirror source, if required. Otherwise, go to step 35.

31 The Mirror SDP Binding (Create) form opens. Specify a destination node for the 
mesh SDP binding:

a If the destination node is a managed node, choose from a list of managed 
nodes.

i Click on the Select button in the Destination panel to choose a destination 
for the SDP binding. The Select Destination Network Element - Mirror 
Sdp Binding (Create) form opens.

ii Select a node and click on the OK button. The Select Destination Network 
Element - Mirror Sdp Binding (Create) form closes and the Mirror SDP 
Binding (Create) form refreshes with the destination node ID displayed in 
the Destination panel.

b If the destination node is not managed by the 5620 SAM, specify the system 
ID of the destination node for the Destination Node ID parameter.

32 Perform one of the following.

a If the Automatic SDP Binding Creation parameter from step 2 is disabled, 
choose a service tunnel to associate with the mesh SDP binding:

i Click on the Select button in the Tunnel panel. The Select Tunnel - Mirror 
Sdp Binding (Create) form opens.

ii Select a service tunnel for the mirror SDP binding and click on the OK 
button. The Select Tunnel - Mirror Sdp Binding (Create) form closes and 
the Mirror SDP Binding (Create) form refreshes with the service tunnel ID 
and name displayed in the Tunnel panel.

b If the Automatic SDP Binding Creation parameter from step 2 is enabled, 
configure the Tunnel Transport parameter.

33 Click on the OK button. A dialog box appears.

34 Click on the OK button. The Mirror SDP Binding (Create) form closes and the Mirror 
(Create) form refreshes with the mirror SDP binding displayed under Mirror SDP 
Binding for the site.

35 To specify a SAP for mirroring on the source site, perform step 18.
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36 To specify a port for mirroring on the source site, perform step 19.

37 To specify an IP filter for the mirror source site, perform step 20.

38 To specify a MAC filter for the mirror source site, perform step 21.

39 To specify an MPLS ingress label for the mirror source site, perform step 22.

40 Perform one of the following.

a Configure an additional source site for the service mirror. Perform steps 23 
to 39.

b Complete the service mirror configuration. Go to step 41.

41 Click on the OK button. The Mirror (Create) form closes.

Procedure 35-2  To create a service mirror using a template

1 Choose Create→Service From Template from the 5620 SAM main menu. The 
Create Service From Template form opens, as shown in Figure 35-2.

2 Select the template associated with the service that you want to add to the 
5620 SAM.

3 Click on the OK button. The service template creation form opens.

4 Configure the parameters. The 5620 SAM administrator defines the parameters that 
you can configure. An exclamation mark (!) identifies parameters that you must 
configure before using the template. (The ! icon also appears on the tabs containing 
parameters that require configuration.) A lock icon identifies parameters restricted 
by the 5620 SAM administrator. See chapter 17 for more information about the 
administrative tasks associated with service templates.

See chapter 53 for information about the parameters associated with creating a 
service mirror.

5 Click on the appropriate tab buttons to add site, interface, or SDP binding service 
components, if required. The template administrator can create secondary site, 
interface, and SDP binding templates and bind them to the primary service mirror 
template. See chapter 17 for more information about the administrative tasks 
associated with service templates.

6 Click on the OK button to save the changes and close the service template creation 
form.

Procedure 35-3  To modify a service mirror

Caution —  Modifying parameters can be service-affecting.
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1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a service mirror and click on the Edit button. The Mirror Service Name (Edit) 
form opens with the general properties of the service displayed on the General tab.

The following tabs list the service elements that can be individually or collectively 
selected and configured:

• Components tab — displays the various service components in a tree format
• Sites tab — lists the sites that are included in the service
• L2 Access Interface tab — lists the destination L2 access interface that is 

included in the service
• Mirror SDP Bindings tab — displays the SDP bindings that are associated with 

the service
• Faults tab — displays the faults associated with the service

4 Modify the parameters for the service, as required.

To configure items in the Components tab, select and right-click on the items and 
choose Properties from the contextual menu.

To configure items in the tabs that contain lists of service elements, select the items 
and click on the Edit button.

5 Click on the OK button. A confirmation dialog box appears.

6 Click on the Yes button to confirm the action. The Mirror Service Name (Edit) form 
closes and the Manage Services form reappears.

7 Click on the Close button to close the Manage Services form.

Procedure 35-4  To view the service operational status

The Aggregated Operational State and State Cause indicators on the General tab of the 
service management form display information about service faults.

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a service and click on the Edit button. The Mirror (Edit) form opens.

4 View the Aggregated Operational State and State Cause indicators. When the 
Aggregated Operational State is Down or Partially Down, a check mark beside the 
appropriate State Cause indicator identifies the type of associated service fault.
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5 Click on the appropriate tab button to view or edit an object that is identified as faulty 
by a State Cause indicator.

6 Click on the Faults tab button to view the alarms for the object. The Object Alarms 
tab is displayed.

7 Click on the Aggregated Alarms tab button to view the aggregated alarms for the 
object. The Aggregated Alarms tab is displayed.

8 Close the Mirror (Edit) form.

9 Click on the Close button to close the Manage Services form.

Procedure 35-5  To view the service topology

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Select a service mirror and click on the Topology View button. A Topology View 
dialog box appears.

4 Click on the Yes button to proceed. The Service Topology - Service Name map 
opens.

See chapter 37 for more information about service topology views.

Procedure 35-6  To delete a service mirror

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Configure the list filter parameters and click on the Search button. A list of services 
appears at the bottom of the Manage Services form.

3 Choose a service mirror.

4 Click on the Remove button. A confirmation dialog box appears.

5 Click on the Yes button to confirm the action. The service mirror is deleted and 
removed from the list.

6 Click on the Close button to close the Manage Services form.
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36.1 Composite service management overview

A composite service is a set of linked services. Composite service functionality 
supports complex applications that require a combination of services, such as VLAN 
connections to an HVPLS, an IES spoke into a VPLS, or a VPRN-to-VPLS 
interconnection.

Services that are owned by different customers can be connected to form a composite 
service. An example is an HVPLS in which the core VPLS belongs to one customer 
and the satellite VPLS instances belong to other customers. An HVPLS is considered 
to be a composite service by the 5620 SAM.

Composite services consist of subscriber services, called SCs in the context of a 
composite service, and connectors. A connector is a bidirectional logical link 
between two SCs, such as a pair of PW spokes that carry traffic in opposite directions 
between VLL and VPLS instances, a dot1Q-encapsulated link between a VLAN and 
a VPLS, or an internal cross-connect.

The term SCP describes a type of connector endpoint. In the case of the services that 
are available on the 7450 ESS or the 7750 SR, an SCP is a service interface or SAP. 
For L2 switches, such as the Telco, an SCP may be a network interface, such as an 
uplink port.

Composite services exist only in the context of the 5620 SAM and are configured 
through the 5620 SAM GUI or an OSS application. They are unknown to individual 
network devices. To simplify composite service configuration and to ensure that 
non-5620 SAM device configuration does not disrupt the management of composite 
services, the following rules apply to the creation, deletion, modification, and 
presentation of composite services.

• A composite service can have zero SCs.
• A composite service can have zero connectors.
• Two connected SCs can belong to only one composite service.
• A connector between two SCs belongs to only one composite service.
• An SC cannot be removed from a composite service until its connector to the 

composite service is removed.
• A group of connected services can be moved from one composite service to 

another.

The 5620 SAM supports composite-service configuration using the following 
methods.

• Tabbed configuration forms with an embedded navigation tree that provides a 
logical, hierarchical view of the composite service and acts as a configuration 
interface. When you right-click on an object in the navigation tree, a menu 
specific to the object appears. When you choose an object in the menu, the related 
configuration form opens. Figure 36-1 shows the composite service navigation 
tree.

• Pre-configured template. A user with service management privileges can create a 
composite-service template. The service management user can also create a 
connector template. See Chapter 17 for more information about the 
administrative tasks associated with creating and using templates.
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Figure 36-1  5620 SAM composite service navigation tree

If a service that is specified for inclusion in a composite service does not currently 
belong to a composite service, it is added to the composite service regardless of its 
administrative or operational state. If the specified service is part of an existing 
composite service, it can be moved to a different composite service. However, SCs 
that are connected to the specified service are also moved to the new composite 
service upon confirmation of the action by the 5620 SAM operator. The 5620 SAM 
performs no such action confirmation for OSS applications.

Network discovery of composite services

The 5620 SAM associates SCs and connectors with composite services during 
network discovery. The following rules apply to this process.

• When the 5620 SAM discovers a valid connector between two services that do 
not belong to a composite service, a composite service that contains the services 
and connector is automatically created.

• When the 5620 SAM discovers a valid connector between two services and one 
of the services belongs to a composite service, the other service is added as an SC 
of the composite service.

• When the 5620 SAM discovers a valid connector between two services and the 
two services are SCs of different composite services, an alarm is raised and the 
connector is excluded from the 5620 SAM database.

A composite service has Connection State and Aggregated Operational State status 
indicators. The General tab of the composite service management form displays 
these indicators, as shown in Figure 36-2.
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Figure 36-2  Composite service management form - General tab

The Connection State indicator displays one of three values, as follows:

• No Connection—None of the SCs is connected to any other SC
• Partially Connected—One SC is not able to communicate directly or indirectly 

with all other SCs
• Strongly Connected—All SCs are able to communicate

For example, a composite service has five services named A, B, C, D, and E. A is 
connected to B, C is connected to D, and D is connected to E. The Connection State 
in this case is Partially Connected. When A or B becomes connected to C, D, or E, 
the Connection State becomes Strongly Connected.

The Aggregated Operational State indicator has four possible values: Up, Down, 
Partially Down, and Unknown. The value is derived from the aggregated SC 
operational states as follows.

• Up—All SCs are operationally up
• Partially Down—At least one SC is operationally down
• Down—All SCs are operationally down
• Unknown—The status of at least one SC is undetermined

Connector types

There are three types of connectors that join SCs in a composite service:

• SCP-to-SCP
• internal cross-connect
• PW spoke
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SCP-to-SCP connectors

SCP-to-SCP connectors can join any two SC types that have service interfaces on the 
same device or on different devices. A connector between VPLS and VPRN SAPs is 
an SCP-to-SCP connector, as is a connector between a dot1Q-encapsulated VPLS 
SAP and L2 switch uplink port of the same encapsulation in a VLAN ring group. The 
two interfaces must be of the same encapsulation type and encapsulation value. The 
following encapsulation types are supported:

• Ethernet (dot1q, Q in Q, Null)
• ATM (VPI/VCI, VPI)
• FR (DLCI)

The operational status of an SCP-to-SCP connector depends on the operational status 
of its endpoints. An alarm raised against one of the endpoints causes an alarm to be 
raised against the connector. Such alarms are aggregated within the composite 
service.

Internal cross-connect connectors

An internal cross-connect connector can join any SC types. It uses a CCAG to join 
two SCs that have SAPs or network interfaces on the same device. This functionality 
is available in the 7450 ESS and 7750 SR, Release 3.0 and later. The following rules 
apply to internal cross-connect connectors.

• A SAP can be connected to another SAP or to a network interface using a CCAG.
• When a SAP or network interface is deleted, the connector associated with it is 

also deleted.
• The deletion of an internal cross-connect connector causes the associated 

interfaces and SAPs to be deleted.

The operational state of an internal cross-connect connector depends on the 
operational state of the CCAG. An alarm raised against the CCAG causes an alarm 
to be raised against the connector. Such alarms are aggregated within the composite 
service.

PW spoke connectors

A PW spoke connector generally joins VPLS instances to create an HVPLS service. 
In the 7450 ESS and 7750 SR, Release 3.0 and later, a PW spoke can, for example, 
connect IES and VPLS instances to provide distributed Internet access service. The 
endpoints of a PW spoke connector must be on different devices. PW spoke 
connectors are subject to restrictions on the SC types that they can join. Table 36-1 
shows the SC types that can be linked by PW spoke connectors.

Table 36-1 Valid PW spoke interconnections

SC type Valid PW spoke SC interconnections

VLL IES, VPLS

VLAN —

VPLS IES, VLL, VPLS

(1 of 2)
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The operational state of a PW spoke connector depends on the operational state of 
the underlying SDP bindings. An alarm raised against one of the SDP bindings 
causes an alarm to be raised against the connector. Such alarms are aggregated within 
the composite service.

36.2 Sample composite service configuration

Figure 36-3 shows a sample composite service configuration that involves a variety 
of subscriber services and uses the three SC connector types.

Figure 36-3  Sample composite service configuration

36.3 Workflow to create a composite service

1 Set up group and user access privileges.

MVPLS MVPLS

IES VLL, VPLS

VPRN —

SC type Valid PW spoke SC interconnections

(2 of 2)

VLL service

VPLS

VLAN service

VPLS

IES

Cross-connect connector
using CCAG

= SCP-SCP connectors
= PW spoke connectors
= Cross-connect connector

18118
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2 Configure the network.

i Build the IP or IP/MPLS core network.

ii Configure service tunnels.

3 Create the subscriber services that are to be SCs of the composite service.

4 Create the composite service.

i Define general properties for the composite service.

ii Specify the subscriber services that are participating in the composite service. 
You can specify multiple services in one operation.

iii Create connectors to link the SCs of the composite service.

5 Turn up the composite service.

36.4 Composite service management menus

Table 36-2 lists and describes the composite service management menus.

Table 36-2 Composite service management menus

36.5 Composite service management procedures list

Table 36-3 lists the procedures necessary to perform composite service management 
tasks.

Table 36-3 Composite service management procedures list

36.6 Composite service management procedures

Use the following procedures to perform composite service creation and 
management tasks.

Menu item Description

Manage→Composite Services Create, modify, or delete a composite service, or 
perform a filtered search on composite services.

Procedure Purpose

To create a composite service Create a composite service.

To modify a composite service Modify composite service parameters.

To delete a composite service Delete a composite service.
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Procedure 36-1  To create a composite service

1 Choose Manage→Composite Services from the 5620 SAM main menu. The 
Manage Composite Services form opens.

2 Click on the Create button. The Composite Service (Create) form opens.

3 Configure the following parameters:

• Composite ID
• Auto-Assign ID
• Name
• Description

4 Click on the Apply button. The form title changes to Composite Service Service 
Name (Edit) and the form refreshes with an additional tab button and a Status panel.

5 Click on the Components tab button.

6 Perform one of the following.

a Add an SC to the composite service. Go to step 7.

b Complete composite service creation if SCs and connectors are to be created 
later. Go to step 15.

7 Right-click on the Services icon and choose Add Services. The Add Services form 
opens with a list of available services.

8 Select a service and click on the OK button. You can select multiple services at 
once. The CompositeService - Service Name (Edit) form refreshes with the SC 
information displayed.

9 Perform one of the following.

a Add a connector to the composite service. Go to step 10.

b Complete composite service creation if connectors are to be created later. Go 
to step 15.

10 Right-click on the Connector icon on the Components tab and choose one of the 
following options:

a Create CrossConnect. Go to step 11.

b Create ScpConnector. Go to step 12.

c Create SpokeConnector. Go to step 13.

11 The Cross Connect (Create) form opens.

Note —  You can create a service for inclusion in the composite service 
by right-clicking on the Services icon and choosing Create Service Type.
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i Configure the following parameters:

• Name
• Description

ii Click on the Select button in the Service A panel to choose an SC to associate 
with the connector. The Select Service A - Cross Connect (Create) form opens 
with a list of available SCs displayed.

iii Select an SC and click on the OK button. The Select Service A - Cross Connect 
(Create) form closes and the Cross Connect (Create) form refreshes.

iv Click on the Select button in the Service B panel to choose an SC to associate 
with the connector. The Select Service B - Cross Connect (Create) form opens 
with a list of available SCs displayed.

v Select an SC and click on the OK button. The Select Service B - Cross Connect 
(Create) form closes and the Cross Connect (Create) form refreshes.

vi Click on the Select button in the Site A panel to choose a site to associate with 
the connector. The Select Site - Cross Connect (Create) form opens with a list 
of available sites displayed.

vii Select a site and click on the OK button. The Select Site - Cross Connect 
(Create) form closes and the Cross Connect (Create) form refreshes.

viii Click on the Select button in the Site B panel to choose an SC to associate with 
the connector. The Select Site - Cross Connect (Create) form opens with a list 
of available sites displayed.

ix Select a site and click on the OK button. The Select Site - Cross Connect 
(Create) form closes and the Cross Connect (Create) form refreshes.

x Click on the Transport tab button.

xi Click on the Select button to choose a CCAG for the connector. The Select 
CCAG - Cross Connect (Create) form opens with a list of available CCAGs 
displayed.

xii Select a CCAG and click on the OK button. The Select CCAG - Cross Connect 
(Create) form closes and the Cross Connect (Create) form refreshes.

xiii Configure the CC Id parameter.

xiv Click on the OK button. The Cross Connect (Create) form closes and the 
CompositeService - Service Name (Edit) form refreshes.

xv Go to step 14.

Note —  The service endpoints of a cross-connect connector must be on 
the same NE.
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12 The ScpConnector (Create) form opens.

i Configure the following parameters:

• Name
• Description

ii Click on the Select button in the Service A panel to choose an SC to associate 
with the connector. The Select Service A - ScpConnector (Create) form opens 
with a list of available SCs displayed.

iii Select an SC and click on the OK button. The Select Service A - Scp Connector 
(Create) form closes and the ScpConnector (Create) form refreshes.

iv Click on the Select button in the Service B panel to choose an SC to associate 
with the connector. The Select Service B - Scp Connector (Create) form opens 
with a list of available SCs displayed.

v Select an SC and click on the OK button. The Select Service B - Scp Connector 
(Create) form closes and the ScpConnector (Create) form refreshes.

vi Click on the Select button in the Site A panel to choose a site to associate with 
the connector. The Select Site - Scp Connector (Create) form opens with a list 
of available sites displayed.

vii Select a site and click on the OK button. The Select Site - Scp Connector 
(Create) form closes and the ScpConnector (Create) form refreshes.

viii Click on the Select button in the Site B panel to choose a site to associate with 
the connector. The Select Site - Scp Connector (Create) form opens with a list 
of available sites displayed.

ix Select a site and click on the OK button. The Select Site - Scp Connector 
(Create) form closes and the ScpConnector (Create) form refreshes.

x Click on the Service Connection Point tab button.
36-10 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



36 —  Composite service management
xi Click on the Select button in the Service Connection Point A panel to choose 
an SCP to associate with the connector. The Select Service Connection Point 
A - Scp Connector (Create) form opens with a list of available SCPs displayed.

xii Select an SCP and click on the OK button. The Select Service Connection 
Point A - Scp Connector (Create) form closes and the ScpConnector (Create) 
form refreshes.

xiii Click on the Select button in the Service Connection Point B panel to choose 
an SCP to associate with the connector. The Select Service Connection Point 
B - Scp Connector (Create) form opens with a list of available SCPs displayed.

xiv Select an SCP and click on the OK button. The Select Service Connection 
Point B - Scp Connector (Create) form closes and the ScpConnector (Create) 
form refreshes.

xv Click on the OK button. the ScpConnector (Create) form closes and the 
CompositeService - Service Name (Edit) form refreshes.

xvi Go to step 14.

13 The SpokeConnector (Create) form opens.

Note —  The service endpoints of an SCP connector must have the 
same encapsulation type and encapsulation value.
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i Configure the following parameters:

• Name
• Description

ii Click on the Select button in the Service A panel to choose an SC to associate 
with the connector. The Select Service A - Spoke Connector (Create) form 
opens with a list of available SCs displayed.

iii Select an SC and click on the OK button. The Select Service A - Spoke 
Connector (Create) form closes and the SpokeConnector (Create) form 
refreshes.

iv Click on the Select button in the Service B panel to choose an SC to associate 
with the connector. The Select Service B - Spoke Connector (Create) form 
opens with a list of available SCs displayed.

v Select an SC and click on the OK button. The Select Service B - Spoke 
Connector (Create) form closes and the SpokeConnector (Create) form 
refreshes.

vi Click on the Select button in the Site A panel to choose a site from service A 
to associate with the connector. The Select Site - Spoke Connector (Create) 
form opens with a list of available sites displayed.

vii Select a site and click on the OK button. The Select Site - Spoke Connector 
(Create) form closes and the SpokeConnector (Create) form refreshes.

viii Click on the Select button in the Site B panel to choose a site from service B 
to associate with the connector. The Select Site - Spoke Connector (Create) 
form opens with a list of available sites displayed.

ix Select a site and click on the OK button. The Select Site - Spoke Connector 
(Create) form closes and the SpokeConnector (Create) form refreshes.

x Click on the Transport tab button.

xi Configure the following parameters:

• VC Id
• Auto Select Tunnels
• Transport Type

Note —  The service endpoints of a spoke connector must be on 
different NEs.
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The Transport Type parameter is configurable when the Auto Select Tunnels 
parameter is enabled.

xii If the Auto Select Tunnels parameter is enabled, go to step xvii.

xiii Click on the Select button in the Tunnel A panel to choose a service tunnel to 
associate with the connector. The Select Tunnel From Site A - Spoke 
Connector (Create) form opens with a list of available service tunnels 
displayed.

xiv Select a tunnel and click on the OK button. The Select Tunnel From Site 
A - Spoke Connector (Create) form closes and the SpokeConnector (Create) 
form refreshes.

xv Click on the Select button in the Tunnel B panel to choose a service tunnel to 
associate with the connector. The Select Tunnel From Site B - Spoke 
Connector (Create) form opens with a list of available service tunnels 
displayed.

xvi Select a tunnel and click on the OK button. The Select Tunnel From Site 
B - Spoke Connector (Create) form closes and the SpokeConnector (Create) 
form refreshes.

xvii The L3 Access Interface panel is present, if one of the SCs in the composite 
service is an IES. If the L3 Access Interface panel is not present, go to step xx.

xviii Click on the Select button in the L3 Access Interface panel to choose an 
access interface to associate with the spoke connector. The Select L3 Access 
Interface - Spoke Connector (Create) form opens with a list of available L3 
access interfaces displayed.

xix Select an L3 access interface and click on the OK button. The Select L3 
Access Interface - Spoke Connector (Create) form closes and the 
SpokeConnector (Create) form refreshes.

xx Click on the OK button. The SpokeConnector (Create) form closes and the 
CompositeService - Service Name (Edit) form refreshes.

14 Perform one of the following.

a Add an SC to the composite service. Repeat steps 7 to 8.

b Add a connector to the composite service. Go to step 10.

c Complete site creation. Go to step 15.

15 Click on the OK button. The CompositeService - Service Name (Edit) form closes 
and a confirmation dialog box appears.

16 Click on the Yes button to confirm the action. The Manage Composite Services form 
reappears with the new composite service displayed in the list.

17 Close the Manage Composite Services form.
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Procedure 36-2  To modify a composite service

1 Choose Manage→Composite Services from the 5620 SAM main menu. The 
Manage Composite Services form opens.

2 Configure the list filter parameters and click on the Search button. A list of composite 
services appears at the bottom of the Manage Composite Services form.

3 Select a composite service and click on the Edit button. The CompositeService - 
Service Name (Edit) form opens with the General tab displayed.

4 To configure parameters for an item, click on the Components tab, select and 
right-click on the item, and choose Properties from the contextual menu.

Using the contextual menu, you can also:

• Add SCs and connectors to a composite service
• Create services for inclusion in the composite service. When you create services 

by using the contextual menu, the services are automatically added to the 
composite service.

• Remove SCs and connectors from a composite service
• Move SCs to another composite service
• Delete SCs

5 Click on the OK button. A confirmation dialog box appears.

6 Click on the Yes button to confirm the action. The CompositeService - Service 
Name (Edit) form closes and the Manage Composite Services form reappears.

7 Click on the Close button to close the Manage Composite Services form.

Procedure 36-3  To delete a composite service

1 Choose Manage→Composite Services from the 5620 SAM main menu. The 
Manage Composite Services form opens.

2 Use the configurable filter and Search button on the form to select the composite 
service that is to be deleted.

3 Click on the Remove button. A confirmation dialog box appears.

4 Click on the Yes button to confirm the action. The service is removed from the list 
and deleted.

Caution —  Modifying parameters can be service-affecting.

Warning —  Deleting an SC is not the same as removing an SC from a 
composite service. Deleting an SC removes the service from the 
5620 SAM database. To avoid a service outage, be certain of the action 
that you are taking.
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5 Click on the Close button to close the Manage Services form.
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37.1 Network topology maps overview

The following network topology maps are available on the 5620 SAM:

• LSP topology map
• LSP path topology map
• service topology map
• service path topology maps

The maps visually display network information, and provide contextual menus and 
submenus to open forms that display additional information.

Figure 37-1 shows the main elements of a map.

Figure 37-1  Map elements
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Map toolbar

The map toolbar allows you to manipulate the view of a 5620 SAM map. The toolbar 
appears in the top right corner of the map. The toolbar is available on the service 
topology map. Figure 37-2 shows the map toolbar. The toolbar elements include the 
following:

• Reload button
• Overview Window button
• Select Tool button
• Hand Tool button
• Zoom in Tool button
• Zoom out Tool button
• scale combo box

Figure 37-2  Map toolbar

Click on the Reload button to reload the topology view from the 5620 SAM 
database. The service topology map is updated to display the latest service 
configurations.

Click on the Overview Window button to launch the Overview window. Use the 
Overview window to pan the entire network map and select the area that you want to 
view. Figure 37-3 shows the Overview window.

Overview Window button

Scale combo box

Reload button
Cursor buttons
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Figure 37-3  Overview window

Click on the Select Tool button to select and move an object on the map, or to view 
object information.

Click on the Hand Tool button to move the contents of the map in any direction. Use 
the hand tool to focus on a specific area on a large background map.

Click on the Zoom in Tool and Zoom out Tool buttons to resize the objects in a map.

Use the scale combo box to increase or decrease the zoom in the map. You can 
choose a zoom percentage value from 25% to 300%, or fit all objects in the window 
from the drop-down menu. The scale combo box displays the current scale of the 
map.

LSP topology map

An LSP topology map is available on the 5620 SAM by choosing 
Application→LSP Topology from the 5620 SAM main menu. Configure the 
network filter parameters in the Filter form that appears and click on the OK button. 
The LSP topology map appears as shown in Figure 37-4.

Note —  When you use the Hand Tool button and want to select an 
object or view object information, you must click on the Select Tool 
button to return to the pointer icon.

Handles allow you
to resize the map

view limits box

The map view limit (dotted line)
outlines what portion of the whole

area is shown in the map pane

You can reposition the map
view limits box by clicking

and dragging within the box
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Figure 37-4  LSP topology map

The LSP topology map is used to view all LSPs in a grouped manner, according to 
their source and destination nodes.

When you view the LSP topology map, the source and destination devices are linked 
by straight lines, where each line represents the group of RSVP-TE LSPs between 
the two devices. When all the LSPs of the group are in the same direction, an arrow 
indicates the direction. When the LSPs are in different directions, a circle is shown.

The LSP topology map includes the following information:

• source and destination devices
• status of the device at the source and destination
• device type, name, and system identifier
• system IP addresses of non-managed devices

Right-click on a managed device, port, or link to open a contextual menu. Contextual 
menus allow you to open additional information forms, including the properties form 
for a service or access interface.

LSP path topology map

An LSP path topology map is available from the MPLS Path form and the LSP Path 
form. The LSP path topology map is used to view a specific provisioned or actual 
LSP path in the context of its source, and transient and destination hops. Figure 37-5 
shows an LSP path topology map.
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Figure 37-5  LSP path topology map

When you view the LSP path topology map, hops are linked by straight lines, where 
each line represents a sub-path between two hops of the LSP path. The direction of 
each path is indicated by an arrow. Green lines indicate provisioned paths, and gray 
lines indicate actual paths.

Service topology map

A service topology map is available on the 5620 SAM from the Manage Services 
form.

To view the map from the Manage Services form, choose Manage→Services from 
the 5620 SAM main menu and list services by clicking on the Search button. Choose 
a service in the list and click on the Topology View button.

Figure 37-6 shows the service topology map.
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Figure 37-6  Service topology map

The large icons represent managed devices. The small icons represent unmanaged 
devices. The label of the managed device icon indicates the service name and the IP 
address of the device.

 The symbol and color in the top left corner of the managed device icon represents 
the aggregated alarm status, the most severe alarm on any of the services on the 
device. The symbol in the top middle of the icon and the color of the icon together 
indicate the alarm status for the service site. A red icon indicates that the service on 
the device is down. A green icon indicates that the service is up.

The port icons represent managed access interfaces. A service site can support up to 
20 SAPs. When the number of SAPs on a service site exceeds 20, all of the SAPs on 
that site are grouped into a SAP group, represented by a SAP group icon on the map. 
When the number of SAPs drops below 20, the SAP group icon is replaced with the 
icons for all the individual SAPs on the map. To view the list of SAPs in a SAP 
group, right-click on the SAP group icon and choose List L2 Access Interface or List 
L3 Access Interface, depending on the service type, from the contextual menu. The 
corresponding Site form for the service opens with the L2 Access Interface or L3 
Access Interface tab button selected.

A line between two map objects represents a link or group of links. Links between 
device icons represent service circuits. Links between device icons and port icons 
represent the binding of an access port or interface to a service. The symbol and color 
in the top right corner of the managed device icon represents the connectivity alarm 
status. The status is inherited from the link endpoints. The arrow icon in the centre 
of the link indicates whether the link is unidirectional or bidirectional.

Right-click on a managed device, port, or link to open a contextual menu. Contextual 
menus allow you to open additional information forms, including the properties form 
for a service or access interface.
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Service tunnel topology maps

A service tunnel map is available on the 5620 SAM by choosing 
Application→Service Tunnel Topology from the 5620 SAM main menu. Configure 
the network filter parameters in the form that appears and click on the OK button. 
The Service Tunnel Topology map appears, as shown in Figure 37-7.

Figure 37-7  Service tunnel topology map

Icons in the service path topology map represent devices. The color of the device 
icon represents the status of the device. Red indicates that the device is down. Green 
indicates that the device is up. Yellow indicates that the device is being 
synchronized.

Link groups between devices represent service tunnels. When a link group is red, at 
least one tunnel in the link group is down. For link groups between managed devices, 
right click on the link group icon to list and edit tunnels in the link group. For link 
groups between managed and unmanaged devices, right-click on the link group icon 
to open contextual menus and submenus which allow you to open additional 
information forms for the service tunnel, including the properties form.

37.2 Map management workflow

1 Determine the map you want to use.

• view maps that show services
• view maps that show topology
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2 View the relationship between objects drawn on the map by choosing one of the 
following map types:

• services show which network elements are used by the services
• topology maps show the appropriate relationship between network elements in 

the routing domain.

37.3 Map management menus

Table 37-1 lists the map management menus and the tasks they perform.

Table 37-1 5620 SAM map management menus

37.4 Map management procedures list

Table 37-2 lists the procedures to perform map management tasks.

Table 37-2 5620 SAM map management procedures list

Menu option Function

Application→Service Tunnel Topology View the Service Tunnel Topology map.

Application→LSP Topology View the LSP Topology map.

Manage→Services View the Service Topology map.

Manage→MPLS Paths Create MPLS paths and view topology map for 
provisioned MPLS paths. See chapter 25 for 
more information about creating MPLS paths.

Manage→LSPs Create LSPs and view topology for provisioned 
LSP paths. See chapter 25 for more information.

Manage→Service Tunnels Create service tunnels. See chapter 26 for more 
information.

Procedure Purpose

To open a map from the 5620 SAM main menu Open a map from the main menu

To open a service topology map To view managed service sites and access 
interfaces

To open an LSP path map from the MPLS Path 
form

To view a specific LSP path in context of its 
source, and transient and destination hops

To open an LSP path map from the LSP Path 
form

To view a specific LSP path in context of its 
source, and transient and destination hops

To view and understand map elements Interpret the map elements

To list or view object information from a map To find and open the appropriate contextual 
menu from map objects

To zoom in and zoom out of a map To manipulate the size of objects displayed on 
the map
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37.5 Map management procedures

Use the following procedures to perform map management tasks.

Procedure 37-1  To open a map from the 5620 SAM main menu

1 Choose Application from the 5620 SAM main menu.

2 Choose a type of map to view from the menu options.

a Service Tunnel Topology to view service tunnels.

b LSP Topology to view LSPs

The appropriate Filter form opens.

3 Create a filter to narrow the range of objects that are displayed on the map. The 
options that appear depend on the map choice made in step 2.

4 Click on the OK button. The appropriate map is appears showing the filtered 
network objects.

To understand map elements, see Procedure 37-5. To list or view object information 
from a map, see Procedure 37-6.

Procedure 37-2  To open a service topology map

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Create an appropriate filter and click on the Search button. The list of filtered 
services appears.

3 Choose a service from the list and click on the Topology View button. A confirmation 
dialog box appears.

4 Click on the Yes button to continue. The Service Topology map opens.

To understand map elements, see Procedure 37-5. To list or view object information 
from a map, see Procedure 37-6. To manipulate the map view, see section 37.1.

Procedure 37-3  To open an LSP path map from the MPLS Path form

1 Choose Manage→MPLS Paths from the 5620 SAM main menu. The Manage MPLS 
Paths form opens.

2 Create an appropriate filter and click on the Search button. The list of filtered MPLS 
paths appears.
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3 Choose an MPLS path from the list and click on the Edit button. The MPLS Path 
configuration form for the MPLS path opens.

4 Click on the Provisioned Path tab button. The hops of the MPLS path appear in a list.

5 Choose a hop from the list and click on the Topology View button. The LSP path 
map opens showing the hops between the devices.

To understand map elements, see Procedure 37-5. To list or view object information 
from a map, see Procedure 37-6.

Procedure 37-4  To open an LSP path map from the LSP Path form

1 Choose Manage→LSPs from the 5620 SAM main menu. The Manage LSP Paths 
form opens.

2 Create an appropriate filter and click on the Search button. The list of filtered LSPs 
appears.

3 Choose an LSP from the list and click on the Edit button. The DynamicLsp (Edit) 
form opens.

4 Click on the LSP Paths tab button. The LSP paths appear in a list.

5 Choose an LSP path from the list and click on the Edit button. The LSP Path 
configuration form opens.

6 Click on the Provisioned Path tab. The hops of the LSP path appear in a list.

7 Choose a hop from the list and click on the Topology button. The LSP path map 
opens showing the hops between the devices.

To understand map elements, see Procedure 37-5. To list or view object information 
from a map, see Procedure 37-6.

Procedure 37-5  To view and understand map elements

1 Open a map as indicated in Procedures 37-1 through 37-4.
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2 View the map information. Figure 37-1 shows the map main elements.

• The icon in the top left corner of a device icon represents the most serious alarm 
raised against the device.

• The icon in the top right corner of a device icon represents the connectivity to the 
device.

• The color in the body of the device icon represents connectivity status as follows:
• red means down or unreachable

• yellow means reconciling or discovering
• green means normal

• On a service topology map, the icon in the top middle section of a device icon, 
together with the color of the device icon, represents the alarm status for the 
service site.

Procedure 37-6  To list or view object information from a map

1 Open a map as indicated in Procedures 37-1 through 37-4.

2 Right-click on one of the following objects:

a A device icon

b A circle or arrow in the centre of a link or path group

c A port of custom node indicating the end-point of a link, path, tunnel, or service

The appropriate contextual menu appears.

3 Navigate through the available contextual menu options. You can do the following, 
depending on the object selected in step 2.

• View a list of network objects, for example, the service tunnels of LSPs running 
in the group chosen. You can then choose one and view or edit its configuration.

• Create new connections between the devices, as appropriate.
• View the properties of the object such as a 7450 ESS. You can then view or edit 

the device configuration.

Procedure 37-7  To zoom in and zoom out of a map

1 Open a map as indicated in Procedures 37-1 through 37-4.

2 Click on the Zoom in or Zoom out button.

3 Move your cursor into the map pane. The icon changes to a magnifying glass 
containing a + or - sign.

4 Click on the area of the map you want to expand or contract. The map expands or 
contracts. Continue clicking until the desired zoom level is reached.
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Use the opposite button and an equal number of clicks to return the map to its 
default setting.

5 To return to the pointer icon, perform one of the following:

a Click on the Reset Cursor button.

b Click on the Select Tool button in the toolbar of the service topology map.
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38.1 Fault management using alarms overview

The 5620 SAM converts SNMP traps from network devices to events and alarms. 
These are then correlated against the managed equipment and configured services 
and policies. Alarms are applied against the appropriate equipment and services.

The fault management system provides:

• conversion of SNMP traps of device events to many X.733-standard alarm fields
• impact analysis and correlation of alarms to equipment and service-affecting 

faults
• updated operational status of equipment, services, and interfaces in 

near-real-time from the network device resources
• alarm policy control by network administrators so the administrators can 

determine how to handle individual incoming alarms and how alarm logs are 
created and stored

• point-and-click alarm management from both the dynamic alarm list and from 
equipment and services configured on the 5620 SAM GUI

• operator notes and acknowledgement to track the work undertaken to fix the 
problem that caused the alarm

• correlated data in a historical alarm database to provide trend analysis and records

Correlated alarms mean that one alarm may cause fault conditions for many other 
objects. When alarms are correlated, the alarms may appear in multiple places. For 
example, if an alarm is raised because a port goes down, any services using that port 
would receive indication of the alarm, viewable from the service property form. This 
means that all object information forms contain a Faults tab, which lists alarms 
affecting the object. All alarms appear on the dynamic alarm list.

Figure 38-1 shows how alarms are handled by the fault management system.
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Figure 38-1  Alarm handling

Figure 38-2 shows the following alarm relationships on the GUI:

• incoming alarms and the dynamic alarm list
• display of the object alarm
• impact of the alarm policy parameter settings on the alarm
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Figure 38-2  Alarm relationships on the GUI

Alarm status, severity, and aggregation

Alarm status for the network is indicated in the navigation tree and the dynamic 
alarm window. Use the navigation tree to view the status of alarms on individual 
objects, and the aggregated alarm status.

Aggregated alarm status is displayed using the:

• navigation tree
• alarm lists found within tab buttons on appropriate object property forms

Figure 38-3 shows the alarm status information in the navigation tree.
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Figure 38-3  Alarm status information display in navigation tree

Alarm status information is similarly displayed on the topology maps. See the 5620 
SAM Troubleshooting Guide for more information about using maps for alarm 
management. Figure 38-4 shows alarm and status information displayed on topology 
map icons.

Figure 38-4  Alarm status information displayed in topology map icons

Alarm severity is indicated by different colors on the GUI. The color code is used 
consistently throughout the GUI, for example, in the navigation tree or the dynamic 
alarm list. Table 38-1 lists the default alarm colors.

Table 38-1 5620 SAM alarm default colors
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Alarms are considered related or affecting when there is a relationship between 
objects. The 5620 SAM business logic determines that, for example, if a port goes 
down, and the port is used as a SAP, then a customer must be affected by the port 
down alarm.

 Figure 38-5 shows how aggregation and affected alarms are determined.

Figure 38-5  Aggregation and affected alarm inheritance
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Note —  On the navigation tree, an aggregated alarm may appear but 
no child object in the tree shows an alarm. This is because the 
navigation tree is a filter, which presents different views of 
information. Aggregation of alarms on the navigation tree is affected 
by the view chosen. Change the view, for example, from Equipment 
to Network from the drop-down menu. The aggregated alarm on the 
child object may be visible from the new view.
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From the Faults tab of a object property form, this information is displayed in tabs:

• Object alarms, containing details of the alarm as viewed from the dynamic alarm 
list. For example, shelf1 is the object, and alarmE2 is the object alarm

• Affecting alarms, containing details of the alarms on objects that are directly 
affecting this object. For example, alarmE4 on object port1 is affecting object 
L2Int1, because of the relationship between the L2 interface and its association 
with port1.

• Aggregated alarms, containing details of all alarms for objects below the listed 
object in the containment hierarchy. For example, object shelf1 contains two 
propagated alarms; alarmE3 and alarmE4, because the shelf contains both card1 
and port1

• Related alarms, containing details of all alarms that have an indirect relationship 
with the object. For example, alarmA4 is displayed in the Alarms on Related 
Objects tab for port1, because it is related to the fault condition on port1.

Table 38-2 shows the alarm relationships based on the example.

Table 38-2 Alarm relationships

Figure 38-6 shows how to navigate from the aggregated or object alarms in the 
navigation tree to the appropriate Faults tab on object properties forms.

Object Object alarms Affecting alarms Aggregated alarms Related alarms

node1 alarmE1 — alarmE2

alarmE3

alarmE4

—

shelf1 alarmE2 — alarmE3

alarmE4

—

card1 alarmE3 — alarmE4 —

port1 alarmE4 — — alarmA4

subscr1 alarmA1 — alarmA2

alarmA3

alarmA4

—

svc1 alarmA2 — alarmA3

alarmA4

—

svcSite1 alarmA3 — alarmA4 —

L2Int1 alarmA4 alarmE4 — —
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Figure 38-6  Navigating from the navigation tree to Faults tabs on properties forms

Alarm thresholds

The 5620 SAM provides tools to escalate and de-escalate the severity of alarms 
using alarm threshold measures, configurable using the specific alarm parameters as 
described in Procedure 38-3.

Figure 38-7 shows an example of what happens when an alarm threshold escalation 
is reached, and a policy is applied. Figure 38-8 shows two escalation and two 
de-escalation policies applied to an alarm. 
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Figure 38-7  Alarm thresholds without de-escalation policies

The preceding figure shows two escalation policies applied to an alarm. Escalation 
rules are applied when the number of instances of the alarm, also called the 
frequency, reaches the configured value. De-escalation rules are applied when the 
number of instances of the alarm drops below the configured frequency value. When 
the escalation value is reached, the alarm is escalated to the configured value. As 
shown in the figure, the first escalation is to major priority and then to critical 
priority. When the appropriate frequency to escalate and de-escalate is reached, the 
alarm is first escalated in severity and then de-escalated. However, if the alarm is 
deleted, then the frequency calculation is affected.

Figure 38-8 shows two escalation and two de-escalation policies applied to an alarm. 

Note —  When no de-escalation policy is applied, escalated alarms 
are not de-escalated once the frequency of the alarm drops below the 
alarm escalation threshold.
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Figure 38-8  Alarm thresholds with de-escalation policies

Escalation policies are affected by the auto parameter of the global alarm deletion 
policy. See Procedure 38-1 for more information. When an escalation policy uses the 
“default when cleared” option, the escalation policy does not work. You must 
configure the parameter to a value other than “when cleared” to ensure the escalation 
policy is successful.

Alarm suppression

The 5620 SAM is designed to not raise alarms when numerous SNMP traps are sent 
in quick succession for the same type of event. This prevents alarm storms during 
intermittent outages in the network caused by bouncing devices; for example, when 
links go up and down rapidly. The 5620 SAM continues to resynchronize the 
network, and if the bouncing devices continue to send down state SNMP traps, the 
5620 SAM eventually receives the trap and generates the appropriate alarm.

To indicate how often an alarm is raised, the number of occurrences of each instance 
of the alarm is tracked within the alarm record of the initial alarm. Click on the 
Statistics tab of an individual Alarm Info form to see how often the alarm was raised.

To cause alarm severity to escalate if an alarm reoccurs a specific number of times, 
use the threshold crossing alert functionality, as described in Procedure 38-3 using 
the escalation parameter or the de-escalation parameter.

38.2 Workflow to manage network faults using alarms

1 Set up the managed devices to send SNMP traps of managed device faults and 
events to the 5620 SAM. See the appropriate device documentation for more 
information.
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2 Set alarm policies on the 5620 SAM using Administration→Alarm Settings:

i Set global policies for incoming alarms.

ii Set specific policies for each alarm type.

iii Set alarm database behaviour for the storage of historical alarm records.

3 Set alarm options using the Application→User Preferences menu. Choose to 
enable or disable the alarm bell when an incoming alarm is registered.

4 Monitor alarms:

i For SLAs by monitoring SAP and subscriber service alarms.

ii For each piece of equipment or logical component using the Faults tab button 
from each equipment form, logical component form, or from the navigation tree 
equipment view.

iii For the network from the dynamic alarm list.

iv For incoming SNMP traps from managed devices by viewing logs.

For information about troubleshooting using alarm information guidelines see the 
5620 SAM Troubleshooting Guide.

5 Reload alarms to ensure the alarm service cache is refreshed, as required by the 
system administrator. This can only be performed by a user with admin privileges, 
and should only be done when necessary.

6 Reset alarm policy based on changing network and new alarm support 
requirements.

7 Review historical alarm records in the alarm log database for trends and store the 
alarms for record-keeping.

38.3 Fault management using alarms menus

Table 38-3 lists the fault management using alarms menus and their functions.

Table 38-3 5620 SAM fault management using alarms menus

Menu option Function

Administration→Alarm Settings Set alarm policies for all incoming alarms, alarm 
types, and historical alarm storage.

Administration→Reload Alarm Information Ensure the latest alarm information is retrieved 
from the database and available to all clients.

Application→User Preferences→Audible Alarms Enable or disable the incoming alarm bell.

Tools→Historical Alarms Review historical alarms for trends.
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38.4 Fault management using alarms procedures list

Table 38-4 lists the procedures necessary to execute fault management tasks.

Table 38-4 5620 SAM fault management procedures list

38.5 Fault management using alarms procedures

Use the following procedures to perform fault management tasks.

Procedure 38-1  To set global alarm policies

Global alarm policies affect all network alarms, and can be set by users with system 
administration privileges.

1 Choose Administration→Alarm Settings from the 5620 SAM main menu. The Alarm 
Settings form appears

2 Click on the Global tab button.

3 Click on the Alarm Behavior tab button.

4 Set the severity policies by clicking on the Severity tab button:

i Select the Severity Alterable parameter to enable setting the severity 
parameters. When you enable severity alterable functionality, you can specify 
whether to allow automatic changes to severity based on individual alarm 
policies or manual changes to severity based on operator actions.

Procedure Purpose

To set global alarm policies Specify how incoming alarms are handled.

To set alarm history behavior Determine the parameters for alarms stored in 
the database.

To set specific alarm policies Specify the behavior of one or more incoming 
alarms.

To view alarms raised against equipment, logical 
components, and services

View specific faults on the equipment.

To view alarm information View all alarm information fields.

To view all network alarms using the dynamic 
alarm list

View all incoming network alarms.

To view network alarm statistics View statistics related to all incoming network 
alarms.

To review historical alarm records Review records and trend analysis.

To reload all alarms Reload the current set of alarms from the 
database to the server, and display the current 
set on all clients.
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Severity cannot be altered unless the check box is enabled.

ii Configure the parameters. They include:

• manual severity alterations
• severity promotion
• severity demotion
• clearing (if not one-shot alarm)
• automatic severity alterations
• implicit severity promotion
• implicit severity demotion
• Escalation (defined by specific policy)
• de-escalation (defined by specific policy)

5 Set the deletion policies by clicking on the Deletion tab button:

i Select the Alarm deletion parameter to allow the creation of a deletion policy.

Deletion policies cannot be changed unless the check box is enabled.

ii Choose the appropriate deletion policy. When you enable deletion 
functionality, you can specify whether to allow operators to delete alarms or 
allow the automatic deletion of alarms.

Configure the parameters. They include:

• manual
• auto

6 Click on the Apply button to save the changes.

7 Click on the OK button to close the form.

Procedure 38-2  To set alarm history behavior

The 5620 SAM stores new and old alarms for record-keeping and trend analysis. You can 
specify how alarms are stored in the database.

1 Choose Administration→Alarm Settings from the 5620 SAM main menu. The Alarm 
Settings form appears.

2 Click on the Global tab button.

3 Click on the Alarm History DB Behavior tab button.

4 Set the alarm history behavior:

Caution —  Deleting an alarm resets the frequency of an alarm to 1. 
This may cause conflicts with configured alarm escalation and 
de-escalation policies.
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a Configure the parameters. They include:

• Max Log Size (records) 
• Log Full Action
• Clear Window (records) 
• Administrative State
• Log On Change
• Log On Deletion

By default, the Clear Window (records) parameter is set to delete 500 alarm 
history log records when the log is full using the Log Full Action parameter 
Round Robin option.

b Purge alarms with the Purge All or Purge Range button. The Purge Range 
button can be used when a filter policy is applied by selecting the Set Purge 
Range button.

Procedure 38-3  To set specific alarm policies

Specific alarm policies allow you to modify the behavior of one or more specific types of 
alarms, if you want that alarm to behave differently than the default.

1 Choose Administration→Alarm Settings from the 5620 SAM main menu. The Alarm 
Settings form appears.

2 Click on the Specific tab button.

A list of alarm types appears.

3 Choose an alarm type. Alternately, you can select multiple alarms at the same time.

The alarm types are listed by domain.alarm name.

4 Click on the Edit button.

The SpecificPolicy form appears.

Figure 38-9 shows an single alarm type (bgpPeer) selected in the list, and its sample 
configuration form.

Note —  Alcatel recommends using the Log on Deletion option, to 
ensure historical log records of all deleted alarms exists.

Caution —  Purged alarms are not logged, and cannot be retrieved.
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Figure 38-9  Alarm type configuration form opened from the Alarm Policy specific tab button

5 Set the policies for the selected alarm:

a Configure the parameters. They include:

• Group Tag
• Squelch
• Initial Severity Assignment 
• Automatically Assigned Urgency
• Interval
• History Enabled

b Select the Escalation or De-escalation check boxes to escalate or de-escalate 
the severity of an alarm based on how frequently that alarm is processed by 
the 5620 SAM.

i Select the escalation parameter or the de-escalation parameter.

ii Click on the Add button.

iii Configure the Frequency parameter. This is the threshold in a 24-hour 
period of how often the alarm must arrive before the severity is escalated 
or de-escalated.

The alarms are analyzed at faster, non-configurable intervals to verify 
whether the Frequency setting is reached.

iv Configure the Severity parameter to specify the new severity applied 
against the alarm if the escalation or de-escalation threshold is reached.

v Click on the Apply button.
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The new escalation or de-escalation policy is applied to the alarm.

Procedure 38-4  To view alarms raised against equipment, logical 
components, and services

Alarms raised against network objects allow you to view faults on each device in the 
network down to the service, path, or port level. The 5620 SAM correlates all incoming 
alarms to ensure that the alarms are listed against the appropriate equipment or service. 
This feature is useful when you troubleshoot an equipment or service problem.

Objects that can have alarms issued against them contain a Faults tab button. The tables 
in the Faults tab button list the alarms issued against the specific equipment or service. 
For some forms, the Faults tab is further broken down into the Affecting Alarms, 
Propagated Alarms, and Alarms on Related Objects tabs. These tabs show alarms 
against specific objects, such as ports, and related problems, such as services that use 
the ports.

1 Choose:

a Application→Equipment Manager from the 5620 SAM main menu to view 
equipment alarms. The Equipment Manager form opens. Choose a network 
element from the drop-down list.

b Another menu that displays a path, logical component, service, or subscriber 
form.

2 Click on the Faults tab button. A list of alarms appears under the appropriate tabs. 
Select an appropriate tab to display alarms of interest.

3 Review the alarm information. See Table 38-5 for the type of information available 
in an alarm. Scroll across each line to view the information contained in the alarm.

4 To view a specific alarm, double-click on the line or select the View Alarm button to 
open the alarm info form. See Table 38-5 for the alarm information available under 
all tabs in the form.

5 Click on the View Alarmed Object button to open the properties form for the alarmed 
object.

6 Handle alarms according to your fault management policies. For information about 
troubleshooting using alarm information guidelines see the 5620 SAM 
Troubleshooting Guide.

Caution —  Deleting an alarm resets the frequency of an alarm to 1. 
This may cause conflicts with configured alarm escalation and 
de-escalation policies.
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Procedure 38-5  To view alarm information

Alarm information is available from:

• the dynamic alarm list
• the equipment manager fault tab alarm list
• the navigation tree
• policy, service, and other fault tabs
• the alarm information form when you double-click on a row in an alarm list

1 Click on the appropriate fault tab.

Fault tabs include tabs listing alarms against the specific object, and alarms against 
related objects that affect the specific object.

2 Open an alarm from a list by selecting an alarm from the list and clicking on the View 
Alarm button. Alternately, you can double-click on the alarm in the list.

Figure 38-10 shows an Alarm Info form.

Figure 38-10  Alarm Info form - Info

3 Review the alarm information.

Note —  GUI performance can suffer when sorting more than 15 000 
outstanding or logged alarms. Use filters to ensure that a reasonable 
number of alarms are listed.
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a View the alarm information in each tab and respond according to your 
alarm-handling policies.

Table 38-5 lists the types of alarm information available to users from the 
Alarm Info form. For information about troubleshooting using alarm information 
guidelines see the 5620 SAM Troubleshooting Guide.

Table 38-5 Alarm information from the Alarm Info form

Alarm field Information

Alarm row from list or Info tab on Alarm Info form

Domain The general area of the 5620 SAM software that is affected by the alarm. This 
is of particular interest and use to those monitoring alarms using the XML OSS 
interface. See the 5620 SAM-O OSS Interface Developer Guide for more 
information.

Application domain

Site ID IP address of the router issuing the alarm

Site Name Name of the router

Object Type Type of object

Alarmed Object Type

Object Name Name of the object

Alarmed Object Name

Object Id Unique string identifying the object down to the lowest level, for example, 
network ID #, chassis #, slot #, daughterCardSlot #

Alarmed Object Id

Alarm Name of the alarm

Alarm Name

Time Detected When the alarm was raised

Type Vendor-specific and X.733 standards for the event type of the alarm

Alarm Type

Cause Vendor-specific and X.733 standards for the probable cause of the alarm

Alarm Cause

Severity Vendor-specific, TMN, and X.733 standards for severity of the alarm

Alarm Severity

Ack Whether the alarm has been acknowledged by an operator (true) or not (false)

Acknowledged

Acknowledged By Name of operator that acknowledged the alarm

Urgency Urgency setting of the alarm

Additional text Any extra text included with the alarm

First Time Detected Time of the first recorded instance of the alarm

Last Time Detected Time of the last recorded instance of the alarm

Severity tab on Alarm Info form

(1 of 2)
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b Click on the Affected Objects tab to view other network objects that are 
indirectly affected by this alarm. Click on the View Alarmed Object button to 
open the properties form for the affected object.

Severity details

Cleared details

Promoted details

Escalated details

Information about alarm severity.

You can modify the alarm severity by clicking on the View Policy button.

You can delete, clear to the historical database, acknowledge, or view the 
history of the alarm.

Statistics tab on Alarm Info form

Frequency

Number of Occurrences

Number of Occurrences Since Clear

Number of Occurrences Since Ack.

You can modify the alarm frequency by clicking on the View Policy button and 
modifying the individual alarm settings.

How often the alarm has been raised, based on the specified scenarios.

You can delete, clear to the historical database, acknowledge, or view the 
history of the alarm.

Acknowledgement tab on Alarm Info form, Acknowledgement Info tab selected

Acknowledged

Acknowledged by

Last Time Acknowledged

Previously Acknowledged

Assigned Urgency

Urgency Assigned By

Information about when the alarm was acknowledged, the user that 
acknowledged the alarm, and the user that set the urgency.

You can modify the acknowledgement and urgency by clicking on the View 
Policy button and modifying the individual alarm settings.

You can delete, clear to the historical database, acknowledge, or view the 
history of the alarm.

Acknowledgement tab on Alarm Info form, Notes tab selected

View button

Edit button

New button

Note tab button

Revision History tab button

Create notes by clicking on the New button and entering the note. 

You can edit or view notes from the same form. Information about the note, 
including the time created and the name of the user who created the note, are 
displayed in rows for each note entered.

Click on the Revision History tab button to view all notes created for the alarm.

Select a note from the list and click on the View button to view the note.

Affected Objects tab on Alarm Info form, Related tab selected

Related tab Click on the tabs to view alarms related to the currently viewed alarm.

A hierarchical tree showing the network object Id of the object that raised the 
alarm, from the IP address of the device to the affected chassis, slot, card, 
MDA, and port, if applicable.

Related objects are objects that are affected by an alarm because of a 
relationship between objects, for example, when a port is down, then service 
access points that terminate on the port are down.

Object Id The unique instance of the object in the network.

Name The name of the object that generated the alarm.

Type The type of object that generated the alarm.

Application Domain The general area of the 5620 SAM software that is affected by the alarm. This 
is of particular interest and use to those monitoring alarms using the XML OSS 
interface. See the 5620 SAM-O OSS Interface Developer Guide for more 
information.

View Object button Click on the View Object button to open the appropriate form or list for the object 
that has the alarm raised against it.

Alarm field Information

(2 of 2)
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For example, a service tunnel alarm is raised. From the Alarm Info form, click 
on the View Alarmed Object button to go directly to the properties form for that 
service tunnel. The properties form opens. Click on the Faults tab to see the 
same alarm listed under the Object Alarms tab button. Figure 38-11 shows 
both forms.

Figure 38-11  Alarm Info form and properties form

4 Handle the alarm according to your company’s alarm handling policy:

a Click on the Delete button to delete the alarm, if you have permissions to delete 
alarms.

b Click on the Clear button to clear the alarm. The alarm is cleared from the list, 
and is added to the alarm log as an alarm history record.

c Click on the Acknowledge button to acknowledge the alarm.

i From the Note tab button, modify the urgency and assigned severity of 
the alarm.

You need permissions to modify the alarm.

ii Add a note to the alarm from the Notes tab button and click on the Apply 
button.

iii If required, you can click on the Revision History tab button and choose a 
note from the list, click on the Edit button, and modify the note by setting 
the Reason for change and Detailed Text parameters.

iv Click on the Apply button to save the changes.

v Click on the Ok button to acknowledge the alarm.

Caution —  You cannot recover a deleted alarm.
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The alarm is acknowledged. When you view the alarm again, the 
acknowledgement information is updated to include:

• the user that acknowledged the alarm
• when the alarm was acknowledged
• whether the alarm had already been previously acknowledged
• any changes to the assigned urgency of the alarm

d Click on the View Policy button. The Specific Policy form appears. You can 
view the policy configured for the alarm type, as described in Procedure 38-3.

e Click on the View Alarm History>> button to view the alarm log for this type of 
alarm. An Alarm History Filter window appears with the Alarm Name filter equal 
to the type of alarm you are viewing.

i Click on the Search button.

A list of alarm history records appears based on the filter.

ii Choose the record from the alarm history log, as described in 
Procedure 38-8.

Procedure 38-6  To view all network alarms using the dynamic alarm 
list

The dynamic alarm list allows you to monitor incoming faults from the devices and 
software. This feature is most useful when monitoring the network. Figure 38-12 shows 
the dynamic alarm list.

Figure 38-12  Dynamic alarm list

1 Click on the Alarm Table tab button from the bottom of the 5620 SAM client GUI.

The dynamic list of incoming network alarms appears.

The color bar under the Alarm Table tab indicates the number of alarms of each type 
in the dynamic list, color-coded by severity.

Note —  GUI performance can suffer when sorting more than 15 000 
outstanding or logged alarms. Use filters to ensure that a reasonable 
number of alarms are listed.
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2 Right-click on an alarm entry row.

The contextual alarm menu appears.

3 Choose:

a Show Alarm(s) to view the alarm info form. Table 38-5 lists the alarm 
information displayed.

b Show Affected Object to display the configuration form for the object against 
which the alarm is raised.

c Acknowledge Alarm(s) to open the acknowledgement form.

d Assign Severity to change the severity policy of the alarm.

e Delete Alarm(s) to delete the alarm.

f Clear Alarm(s) to clear the alarm.

g CLI Session→option to start a SSH or Telnet session with the managed 
equipment that generated the alarm.

h Show Sorting to determine the sort order of how alarm information is displayed:

i Use the left, right, up, and down arrows to resequence the alarm fields as 
required. 

ii Click on the Sort Ascending and Sort Descending buttons to specify the 
order of displayed alarms. 

iii Click on the Close button to return to the dynamic alarm list.

4 Handle the alarm(s) according to your fault management policies. Alarm handling is 
described in Procedure 38-5. For information about troubleshooting using alarm 
information guidelines see the 5620 SAM Troubleshooting Guide.

After alarms are cleared or deleted, the alarms are stored in the alarm log.

Procedure 38-7  To view network alarm statistics

1 Click on the Alarm Statistics tab button in the dynamic alarm list.

The alarm statistics table appears.

2 View the alarm statistics information.

Caution —  You cannot recover a deleted alarm.
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The Alarm Statistics table lists the number of network alarms sorted in columns by 
acknowledged and unacknowledged status, and then by the number of critical, 
major, minor, warning, condition, info, indeterminate, and cleared alarms.

Procedure 38-8  To review historical alarm records

Alarms are logged as historical alarm records in an alarm log database.

1 Choose Tools→Historical Alarms from the 5620 SAM main menu. The Alarm 
History form appears.

2 If required, choose a filter to narrow the range of historical alarms displayed.

3 Click on the Search button.

4 The historical alarm records appear based on the filtering criteria.

Table 38-5 lists the information displayed for each historical alarm record. 
Table 38-6 lists the additional historical alarm information available from the alarm 
history form for logged alarms.

Table 38-6 Additional information for logged alarms

5 Manage the logged historical alarm records:

a Click on the View Policy button to view the Specific Policy form. See 
Procedure 38-3 for more information.

b Click on the Purge Filtered button to purge alarms that meet the purging 
criteria.

c Click on the Edit button to view the details of the historical alarm record. See 
Table 38-5 for more information.

Note —  When sorting alarms, sorting more than 15 000 outstanding or 
logged alarms may slow GUI performance. Use filters to ensure that a 
reasonable number of alarms are listed.

Alarm field Information

Time Logged Time stamp of when alarm was moved to the historical 
alarm database

Alarm Status Reason the alarm was logged to the historical alarm 
database

Highest Severity The most severe status assigned to the alarm. Alarm 
severity can change due to escalation policies.

Number Of Occurrences How often the alarm was raised
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6 Click on the Close button to close the form.

Procedure 38-9  To reload all alarms

The 5620 SAM uses an alarm service to cache alarm information. To ensure the cache 
is current with all alarms stored in the database, administrators can reload all alarms from 
the database.

1 Log on to a 5620 SAM client GUI as admin user. Enter and confirm the admin 
password and click on the OK button.

2 Choose Administration→Reload Alarm information from the 5620 SAM main menu.

3 Confirm that you are aware all other users will be affected by the alarm reload by 
clicking on the OK button.

Alarm information is reloaded, and all active client GUIs are updated with the 
confirmation message that the alarms have been reloaded. Client GUI users can 
close then reopen windows as required, to refresh the alarm information.

4 Close then reopen any open windows or forms, if required.

Caution —  Once the procedure is complete, client GUI users viewing 
open alarm forms and windows may have out-of-date information. 
Operators should close all open windows and forms, then relaunch them. 
This includes windows and forms displaying alarm status information, for 
example, the navigation tree.
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39.1 Troubleshooting and fault management using service 
assurance OAM tools overview

The proper delivery of services requires that a number of operations must occur 
correctly at different levels within the service creation model. For example, 
operations such as the association of packets to a service, VC labels to a service, and 
each service to a service tunnel (also called an SDP) must be performed successfully 
for the service to pass traffic to subscribers as agreed to according to SLAs.

Even when tunnels are operating correctly and are correctly bound to services, 
incorrect FIB information may cause connectivity issues.

To verify that a service is operational and that FIB information is correct, a set of 
configurable in-band or out-of-band, packet-based OAM tools is available.

For in-band, packet-based testing, the OAM packets closely resemble customer 
packets to effectively test the customer's forwarding path. However, these packets 
are distinguishable from customer packets, so they are kept within the service 
provider's network and not forwarded to the customer. For out-of-band testing, OAM 
packets are sent across a portion of the transport network, for example, across LSPs 
to test reachability.

You can configure and manage OAM tests:

• from the properties forms of network objects, for example, LSP pings from the 
LSP properties form

• from the Manage Tests form

Table 39-1 lists the supported OAM test types, the objects against which the tests can 
be performed, the test types, and the network layer being tested.

Table 39-1 Service assurance OAM test types and test objects

Network level Test type Network object or service 
component for test

Application (level 7) DNS lookup (1) DNS

DHCP lookup (1) DHCP

Service (level 6) VPRN ping VPRN site

VPRN trace

CPE ping (2) VPLS site

VLL siteMFIB ping (2)

MAC populate

MAC ping

MAC trace

MAC purge

Service transport binding 
(level 5)

Service site ping Network element

(1 of 2)
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Notes
(1) Cannot be performed using the 5620 SAM or using CLI on devices.
(2) Not yet supported using the 5620 SAM.

MTU ping OAM

The MTU ping OAM diagnostic tool, which is called sdp-mtu in the CLI, provides a 
tool for service providers to determine the exact frame (MTU) size that is supported 
on a service tunnel, to within one byte. Use the MTU ping OAM to:

• determine the maximum frame size supported
• solve troubleshooting issues that are related to equipment used across the network 

core that may not be able to handle large frame sizes

In a large network, network devices can support a variety of packet sizes, up to a 
limit, that are transmitted across its interfaces. This size limit is referred to as the 
MTU of network interfaces. You must consider the MTU of the entire service tunnel 
end-to-end when you provision services, especially for VLL services in which the 
service must support the ability to transmit the largest customer packet.

Tunnel ping OAM

The Tunnel ping OAM tool, which is called sdp-ping in the CLI, performs in-band 
unidirectional or bidirectional connectivity tests on service tunnels. The OAM 
packets are sent in-band in the tunnel encapsulation, so they follow the same path as 
the service traffic. The response can be received out-of-band in the control plane or 
in-band using the data plane for a bidirectional test.

Service transport (level 4) MTU ping Service tunnel (SDP)

Tunnel ping

Transport (level 3) LSP ping LSP

LSP pathLSP trace

LDP ping MPLS site

LDP trace

Routed network (level 2) ICMP ping (1) IP unicast traffic

ICMP traceroute (1)

Multicast trace (2) IP multicast traffic

Multicast stat (2)

Multicast router information (2)

Layer 1 or layer 2 (level 1) MAC ping (2) Ethernet

MAC traceroute (2)

ATM ping ATM PVC connection

Network level Test type Network object or service 
component for test

(2 of 2)
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For a unidirectional test, tunnel ping OAM tests:

• egress service tunnel ID encapsulation
• whether the packet can reach the far-end IP address destination of the service 

tunnel ID within its encapsulation
• whether a packet of the specified size goes to the far-end IP address of the service 

tunnel ID within its encapsulation
• forwarding class mapping to ensure that the test packet is treated the same as the 

customer traffic

For a bidirectional test, tunnel OAM uses a local egress service tunnel ID and an 
expected remote service tunnel ID, so the user can specify where the returned 
messages should be sent from based on the far-end tunnel ID.

Figure 39-1 shows how a tunnel OAM packet can be inserted to test the connectivity 
between two customer LANs across the IP/MPLS core.

Figure 39-1  Sample OAM diagnostic

Service site ping OAM

The service site ping OAM diagnostic tool, which is svc-ping in the CLI and was 
formerly called the circuit ping, provides end-to-end connectivity testing for an 
individual service. This diagnostic operates at a higher level than the tunnel OAM 
ping because it verifies connectivity for an individual service rather than 
connectivity across the service tunnel. This allows you to isolate a problem within 
the service rather than at the port, which is the endpoint of the service tunnel.
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The diagnostic tests a service ID for correct and consistent provisioning between two 
service endpoints. The following information can be obtained from a service site 
ping OAM:

• verification that the local and remote service sites exists
• verification of the current state of the local and remote service sites
• ensuring that the local and remote service types are correlated
• ensuring that the same customer is associated with the local and remote service 

sites
• ensuring that there is a service-to-circuit association at both the local and remote 

service sites using the Use Local Tunnel and Use Remote Tunnel options, to 
check the circuit between service sites

• verification that the local and remote ingress and egress service labels match

LSP ping OAM

The LSP ping OAM tool, which is called lsp-ping in CLI, performs in-band LSP 
connectivity tests.

In an LSP ping, the originating router creates an MPLS echo request packet for the 
LSP and MPLS path to be tested. The MPLS echo request packet is sent and awaits 
an MPLS echo reply packet from the router that terminates the LSP. The status of the 
LSP is displayed when the MPLS echo reply packet is received. Figure 39-2 shows 
an LSP ping.

Figure 39-2  LSP ping diagnostic

LSP trace OAM

The LSP trace OAM tool, which is called lsp-trace in CLI, displays the hop-by-hop 
route used by the LSP.

In an LSP trace, the originating router creates an MPLS echo request packet for the 
LSP to be tested. The packet contains increasing TTL values. The MPLS echo 
request packet is sent and awaits a TTL exceeded response or the MPLS echo reply 
packet from the router that terminates the LSP. The devices along the hop-by-hop 
route reply to the MPLS echo request packets with TTL and MPLS echo reply 
information.

Figure 39-3 shows an LSP trace.
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Figure 39-3  LSP trace diagnostic

MAC ping OAM

The MAC ping OAM tool, which is called mac-ping in CLI, is used to test 
connectivity in a VLL or VPLS service by verifying a remote MAC address. 
Figure 39-4 shows a sample MAC ping from one end of a service to the far-end MAC 
address of the service.

Figure 39-4  Sample MAC ping diagnostic
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The MAC ping determines the existence of the far-end egress point of the service. 
MAC pings can be sent in-band or out-of-band. You must specify either:

• the target (far-end) MAC address
• the broadcast address

In a MAC ping that is out-of-band, the ping is forwarded along the flooding domain 
when no MAC address bindings exist or is sent along the bindings if MAC address 
bindings exist. A response ping is sent from the far-end device when there is an 
egress binding for the service.

In a MAC ping that is in-band, the ping is sent with a VC label TTL of 255. The ping 
packet goes across each hop, and when it reaches the egress router, it is identified by 
the OAM label and the response is sent back along the management plane.

MAC trace OAM

The MAC trace OAM tool, which is called mac-trace in CLI, displays the 
hop-by-hop route of MAC addresses used to reach the target MAC address at the far 
end. MAC traces can be sent in-band or out-of-band.

You must specify either:

• the target (far-end) MAC address
• the broadcast address

In a MAC trace that is out-of-band, the destination IP address is specified by 
mapping the destination MAC address. If the destination MAC address is known to 
be a specific site, the far-end IP address of the service tunnel is used. If the 
destination MAC address is not known, the packet is sent to all service tunnels in the 
service.

In a MAC trace that is in-band, the trace request contains tunnel encapsulation, VC 
label, OAM, and other information. If the destination MAC address is known, the 
appropriate tunnel encapsulation and VC label is used. If the destination MAC 
address is not known, the packet is sent to all service tunnels, including all necessary 
tunnel encapsulation and egress VC labels for each bound service tunnel.

Figure 39-5 shows a MAC trace.
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Figure 39-5  MAC trace diagnostic

MAC populate OAM

The MAC populate OAM tool, which is called mac-populate in CLI, is used to 
populate a service FIB with an OAM-tagged MAC entry. This MAC entry indicates 
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• age an OAM-tagged MAC address

In a MAC populate, the OAM-tagged MAC address is populated on the egress point 
of the service. You can specify whether to flood this OAM-tagged MAC address to 
other devices so that the same OAM-tagged entry is added to the FIB tables of other 
devices.

MAC purge OAM

The MAC purge OAM tool, which is called mac-purge in CLI, is used to delete an 
OAM-tagged entry from a FIB, which was generated using the MAC populate OAM 
tool.
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The VPRN ping and VPRN trace OAM tools are enabled from the VRF site of the 
subscriber’s VPRN service. The VPRN ping determines the existence of the far-end 
egress point of the service. VPRN pings can be sent in-band or out-of-band. The 
VPRN trace displays the hop-by-hop route used to reach the target address at the far 
end. VPRN traces can be sent in-band or out-of-band.
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ATM OAM ping

The ATM OAM ping tool, which is called atmoam-ping in CLI, performs an ATM 
ping on an existing ATM PVC from the PVC endpoint using ATM OAM loopback 
cells. An ATM ping tests VC integrity and endpoint connectivity for PVCs using 
OAM loopback capabilities.

Service assurance test management and configuration

There are two main types of forms for the service assurance test manager.

• Browse and list manager, to generate lists of OAM diagnostics and to run OAM 
diagnostics

• Configuration form, to create or modify service assurance tests and review the 
results of service assurance tests

Figure 39-6 shows the browse and list manager form.

Figure 39-6  Service assurance test manager browse and list form

Each service assurance test configuration form contains multiple tabs. Figure 39-7 
shows a sample service assurance OAM test with the General tab displayed.

Manage Tests found
under Tools menu

Filtering options for
searching existing tests

Tests in the system are
also listed under the Tests

tab button on the applicable
object properties form

Perform the test
as configured 

Drop-down menu
of test types

18036
Alcatel 5620 Service Aware Manager, Release 3.0 R1 39-9
October 2005 3HE00214 CA



39 —  Troubleshooting and fault management using service assurance tools
Figure 39-7  Service assurance OAM test configuration form - General tab

Figure 39-8 shows the same sample service assurance OAM test with the Test 
Parameters tab displayed.

Create a name for listing,
including details of test

Configure the 5620 SAM-managed
object against when the

tests are to be run

Use this test as the
base of a new test

Run the test immediately
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Figure 39-8  Service assurance OAM test configuration form - Test Parameters tab

Figure 39-9 shows the same sample service assurance OAM test with the Results 
Configuration tab displayed.

Configure details
on how the test
should be run

Determine test
packet settings
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Figure 39-9  Service assurance OAM test configuration form - Results Configuration tab

Figure 39-10 shows the same sample service assurance OAM test with the Results 
tab displayed. Selecting the Results tab button opens an additional form, which 
provides detailed test results, including OAM test packet details, when the OAM test 
involves sending test packets.

18035

Configure details
regarding how results
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Figure 39-10  Service assurance OAM test configuration form - Results tab

39.2 Sample OAM diagnostic sequence for a service

Figure 39-11 shows a sample OAM diagnostic sequence, illustrating how you can 
use multiple OAM tests to verify service creation and diagnose service problems. 
This sample shows a VPLS.

Test information
including user

Packet return codes
and status, indicating

success or failure

Details about
test packet

Results
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Figure 39-11  Sample OAM diagnostic sequence for a VPLS

Table 39-2 lists the high-level tasks necessary to configure this sample.

Table 39-2 Sample OAM diagnostic sequence configuration for a service

B

PE
Customer
location C

PE A

PE
Customer 1
location B

Apply VC and
Tunnel Labels

Circuit

Circuit

= Service Tunnel

= VPLS service
= LSP

B

B

Pre-assigned and
Signaled by PE C

Pre-assigned and
Signaled by PE B

Customer 1
location A

Tunnel
Label

VC
Label Y

Dest
MAC

Src
MAC

Customer
Packet
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Dest
MAC

Site
MAC

VLAN
ID

Customer
Packet

Tunnel
Label

VC
Label X

Dest
MAC

Src
MAC

Customer
Packet

Ingress look-up based on
access port or port VLAN ID

Task Description

Service creation and OAM validation

1. MPLS and LSP 
creation

Create an MPLS network and LSPs for use by the service tunnels connecting the VPLS sites. Test 
the validity of the LSPs using LSP ping.

If the results indicate a problem with the path, use LSP trace to check the specific MPLS path for 
the device causing the ping failure.

2. Service tunnel 
creation

Create a service tunnel that uses the MPLS LSP created earlier and perform a tunnel ping on the 
service tunnel to verify tunnel connectivity.

Create all tunnels necessary to interconnect the VPLS sites, and repeat the tunnel ping to ensure 
tunnel connectivity.

Once all tunnels are created, use the tunnel ping remote tunnel option and specify the return tunnel 
path. Verify bidirectional tunnel connectivity.

(1 of 2)
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39.3 Workflow to manage network faults using OAM tools

1 Create the transport network and customer services.

2 Monitor customer services or troubleshoot the transport network before you 
commission, according to your company’s policies.

3. Service creation Create a service using the service tunnels to interconnect the VPLS sites, either using mesh or 
spoke service tunnel bindings.

Use a service site ping between each VPLS site device and its neighboring sites to verify service 
configuration consistency.

4. MAC diagnostics Connect the CPE devices to the VPLS and verify traffic.

Use MAC trace from the edge devices to verify MAC address learning by the VPLS sites and to 
ensure that the correct associations are made between MAC addresses and the service tunnels or 
SAPs to which they are bound.

Use MAC ping against an unknown MAC address to verify that no response is returned.

Use MAC populate to create an OAM-specific MAC address. Use MAC ping and MAC trace against 
the created MAC address to verify that customer traffic is not affected by the additional MAC 
address.

Use MAC purge to remove the created OAM MAC address.

Service OAM diagnostics

1. Diagnose traffic flow 
problems at a specific 
MAC address

Use MAC ping against the MAC address to which traffic is not flowing. Use the source and 
destination MAC address to simulate customer traffic routes as closely as possible.

Use MAC trace to pinpoint the location of the traffic failure.

Check for MAC filter rules or MAC table sizes to identify possible causes of the failure, for example, 
incorrect configurations.

2. Diagnose the 
components of the 
service

Use service site ping to test the potential next hops to ensure consistent configuration.

Use tunnel ping to the far end of the tunnel using the remote tunnel option and specify the return 
tunnel path. Verify bidirectional tunnel connectivity.

Use LSP ping to determine if the tunnel is working. Use an LSP trace to determine if an intervening 
device is down.

Task Description

(2 of 2)
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3 When the creation of a tunnel needs to be tested, or a customer service is 
compromised, use the service assurance tools to troubleshoot the problem.

i Use MTU ping to troubleshoot and resolve tunnel and service problems that 
are related to frame size across all equipment that is used by the service or 
tunnel. 

ii Use tunnel ping to troubleshoot and resolve tunnel and service problems that 
are related to issues that circuits may have transmitting traffic across the GRE 
or MPLS network.

iii Use service site ping to troubleshoot and resolve service problems that are 
related to the end-to-end connectivity of a customer service within the provider 
network.

iv Use LSP ping and LSP trace to troubleshoot and resolve problems that are 
related to MPLS LSPs, LDPs, and MPLS paths.

v Use MAC ping, MAC trace, MAC populate, and MAC purge to troubleshoot and 
resolve problems that are related to FIBs and MAC addressing. The four MAC 
tests are used in combination, for example, MAC populate to inject a MAC 
address into the network, MAC ping to determine where the address was 
learned, MAC trace to determine the path, and MAC purge to remove the 
injected MAC address.

vi Use the VPRN ping and VPRN trace to troubleshoot and resolve problems with 
a VPRN service.

vii Use ATM ping to test ATM PVC connections.

4 Use the OAM tool diagnostic response messages and results form details to resolve 
the customer service problem.

39.4 Fault management using OAM menus

Table 39-3 lists the OAM menus and their function.

Table 39-3 5620 SAM OAM menus

39.5 Fault management using OAM diagnostics procedures list

Table 39-4 lists the procedures necessary to execute OAM tasks.

Menu option Function

Manage→Service Tunnels Search for and open a service tunnel, and use 
the OAM tools to ensure that the GRE or MPLS 
transport network topology is valid.

Manage→Services Search for and open the service, site, or 
subscriber that is compromised, and use the 
OAM tools to troubleshoot the service.

Tools→Manage Tests Create, edit, and manage OAM diagnostic tests
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Table 39-4 5620 SAM OAM diagnostic procedures list

39.6 Fault management using OAM diagnostics procedures

Use the following procedures to perform OAM diagnostics.

Procedure 39-1  To create and run MTU ping OAM diagnostics from 
a service tunnel

Use the MTU ping diagnostic to find the largest valid frame size.

Procedure Purpose

To create and run MTU ping OAM diagnostics 
from a service tunnel

Validate the GRE or MPLS transport network 
before services are created.

To create and run tunnel ping OAM diagnostics 
from a service tunnel

To create an MTU ping OAM diagnostic from the 
test manager

To create a tunnel ping OAM diagnostic from the 
test manager

To configure and run VPRN OAM diagnostics 
from a service

Locate the compromised service and start the 
OAM diagnostic to troubleshoot and solve the 
service issue.

To configure and run MAC populate OAM 
diagnostics

Perform tests or updates of MAC address and 
FIB entries along the length of services and on 
the service site.

To configure and run MAC purge OAM 
diagnostics

To configure and run MAC ping OAM diagnostics

To configure and run MAC trace OAM 
diagnostics

To configure and run service site ping OAM 
diagnostics

Locate the compromised service and start the 
OAM diagnostic to troubleshoot and solve the 
service issue.

To configure and run LSP ping OAM diagnostics Validate connectivity for MPLS LSPs.

To configure and run LSP trace OAM diagnostics

To configure and run an ATM OAM ping Validate connectivity for PVCs using OAM 
loopback capabilities.

To edit an OAM diagnostic test Change the configuration of an existing OAM 
diagnostic test.

To delete an OAM diagnostic test Delete an existing OAM diagnostic test.

To view OAM diagnostic test results View tests results

To interpret OAM diagnostic results Interpret the data from the OAM diagnostic to 
determine the solution to the problem that 
compromised the GRE or MPLS transport 
network or caused a service issue.
Alcatel 5620 Service Aware Manager, Release 3.0 R1 39-17
October 2005 3HE00214 CA



39 —  Troubleshooting and fault management using service assurance tools
1 Choose Manage→Service Tunnels from the 5620 SAM main menu. The Service 
Tunnel Manager form opens.

2 Filter to list only the source and destination routers of the service tunnel and click on 
the Search button. The list of service tunnels appears.

3 Double-click on a service tunnel from the list. The Tunnel (Edit) form opens.

4 Click on the Tests tab button.

5 Click on the MTU ping tab button.

6 Click on the Add button. The MTU ping create form opens with the General tab 
displayed. The form displays information about the service tunnel being tested and 
the originating tunnel ID.

7 Configure the parameters. They include:

• Administrative State
• Name

8 Click on the Test Parameters tab button and configure the parameters. They 
include:

• Packet Interval (seconds)
• Packet Timeout (seconds)
• Size (octets)
• MTU Start Size (octets)
• MTU End Size (octets)
• MTU Step Size (octets)

9 Click on the Results Configuration tab button and configure the parameters. They 
include:

• History Size (rows)
• Test Failure Threshold
• Packet Failure Threshold
• Test Completion
• Test Failure
• Probe Failure

10 Click on the Apply button to save the changes.

11 Confirm the action. The created MTU ping test appears in the list of tests on the 
MTU ping tab button.

Note —  If the step size is small but the end message size is large, the 
amount of time to complete the MTU ping may be many minutes. Ensure 
that you have an appropriate step size that reflects the range of MTU 
packet sizes you want to test.
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12 Perform an MTU ping.

i Select an MTU ping from the list.

ii Click on the Execute button. The MTU ping diagnostic starts. A deployed test 
is created and run. Open the deployed test from the Deployed Tests tab button 
to view its current state. When the test is complete, the deployed test is 
removed, and you can view the results. The diagnostic is complete.

iii Click on the Results tab button. The list of MTU ping OAM probes sent is 
displayed. You can click on the Edit button to view additional results details.

iv Click on the row(s) as appropriate to view diagnostic information.

v Click on the Edit button. The OAM results form opens. The diagnostic 
information includes:

• source and destination of the diagnostic
• timestamp of when the test was completed
• time to complete the diagnostic, in milliseconds
• frame size sent
• OAM diagnostic status
• diagnostic code returned

See Procedure 39-17 for more information about the diagnostic status 
messages. Use the status message to interpret the diagnostic results. For 
example, the status message Response Received indicates that the MTU 
OAM diagnostic completed successfully.

vi Close the form.

13 Close the Tunnel (Edit) form when the OAM diagnostics are complete.

Procedure 39-2  To create and run tunnel ping OAM diagnostics from 
a service tunnel

1 Choose Manage→Service Tunnels from the 5620 SAM main menu. The Service 
Tunnel Manager form opens.

2 Filter to list only the source and destination routers of the service tunnel and click on 
the Search button. The list of service tunnels opens.

3 Double-click on a service tunnel from the list. The Tunnel (Edit) form opens.

4 Click on the Tests tab button.

5 Click on the Tunnel ping tab button.

6 Click on the Add button. The Tunnel Ping create form opens with the General tab 
displayed. The form displays information about the circuit being tested, including the 
originating tunnel ID.
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7 Configure the parameters. They include:

• Administrative State
• Name
• Return Tunnel

8 Click on the Test Parameters tab button and configure the parameters. They 
include:

• Number of Test Packets
• Packet Interval (seconds)
• Packet Timeout (seconds)
• Size (octets)
• Forwarding Class
• Forwarding Profile

Ensure that the forwarding class is configured to work with the services planned to 
be sent across the tunnel. The interval only applies if multiple packets are to be sent.

9 Click on the Results Configuration tab button and configure the parameters. They 
include:

• History Size (rows)
• Test Failure Threshold
• Packet Failure Threshold
• Test Completion
• Test Failure
• Probe Failure

10 Click on the Apply button to save the changes.

11 Confirm the action. The created tunnel ping test appears in the list of tests on the 
Tunnel Ping tab button.
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12 Perform a tunnel ping OAM diagnostic:

i Select the created tunnel ping from the list.

ii Click on the Execute button. A deployed test is created and run. Open the 
deployed test from the Deployed Tests tab button to view its current state. 
When the test is complete, the deployed test is removed, and you can view the 
results. The diagnostic is complete.

iii Click on the Results tab button. The list of tunnel ping OAM packets sent is 
displayed. You can click on the Edit button to view additional result details.

iv Click on the row(s) as appropriate to view diagnostic information.

v Click on the Edit button. The OAM results form opens. The diagnostic 
information includes:

• source and destination of the diagnostic
• timestamp of when the test was completed
• time to complete the diagnostic, in milliseconds
• OAM diagnostic status
• diagnostic code returned

See Procedure 39-17 for more information about the diagnostic status 
messages. Use the status message to interpret the diagnostic results.

vi Close the form.

13 Close the Tunnel (Edit) form when the OAM diagnostics are complete.

Procedure 39-3  To create an MTU ping OAM diagnostic from the test 
manager

1 Choose Tools→Manage Tests from the 5620 SAM main menu. The Manage Tests 
form opens.

2 Click on the Create button.

3 Choose Service Transport→Create MTU Ping from the Create contextual menu. 
The MTU ping create form opens.

4 Configure the parameters described in Procedure 39-1. You must additionally 
configure the source of the service tunnel.

i Click on the Select button next to the Source Site ID parameter. The Select 
originating tunnel form opens.

ii Choose a tunnel from the list.

iii Click on the OK button. The MTU ping create form reappears with the IP 
address and ID of the selected service tunnel.

5 Click on the OK button to save the changes.
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6 Choose the created test from the list of MTU pings.

7 Click on the Execute button to start the ping. A deployed test is created and run. 
Open the deployed test from the Deployed Tests tab button to view its current state. 
When the test is complete, the deployed test is removed, and you can view the 
results. The status of the test is displayed in the General tab.

8 View the test results in the Results tab. The results depend on the type of test. See 
Procedure 39-16. Result information includes:

• Number of Probes Sent
• Time Last Response
• Number of Responses Received

Procedure 39-4  To create a tunnel ping OAM diagnostic from the 
test manager

1 Choose Tools→Manage Tests from the 5620 SAM main menu. The Manage Tests 
form opens.

2 Click on the Create button.

3 Choose Service Transport→Create SDP Ping from the Create contextual menu. 
The Tunnel ping create form opens.

4 Configure the parameters described in Procedure 39-2. You must additionally 
configure the source of the service tunnel.

i Click on the Select button next to the Source Site ID parameter. The Select 
originating tunnel form opens.

ii Choose a tunnel from the list.

iii Click on the OK button. The Tunnel ping create form reappears with the IP 
address and ID of the selected service tunnel.

5 Click on the OK button to save the changes.

6 Choose the created test from the list of OAM diagnostics.

7 Click on the Execute button to start the tunnel ping. A deployed test is created and 
run. Open the deployed test from the Deployed Tests tab button to view its current 
state. When the test is complete, the deployed test is removed, and you can view 
the results.

8 View the test results in the Results tab. The results depend on the type of test. See 
Procedure 39-16. Result information includes:

• Number of Probes Sent
• Time Last Response
• Number of Responses Received
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Procedure 39-5  To configure and run VPRN OAM diagnostics from 
a service

1 Choose Manage→Services from the 5620 SAM main menu. The Manage Services 
form opens.

2 Filter to list only the services on which you want to perform OAM diagnostics and 
click on the OK button. The list of services opens in the Browse Service form.

3 Choose a service from the list and click on the Edit button. The Service (Edit) form 
opens.

4 Click on the Sites tab button.

5 Choose a site or sites from the list and click on the Edit button. The site form opens.

6 Click on the Tests button.

7 Configure and run a VPRN ping or VPRN trace OAM diagnostic.

a To configure and run a VPRN ping:

i Click on the VPRN Ping tab. A list of VPRN services appears.

ii Double-click on a row in the list to edit an existing test, or click on the Add 
button to create a new test. The VPRN ping form opens with the General 
tab displayed.

iii Configure the parameters. They include:

• Administrative State
• Name

iv Click on the Test Parameters tab and configure the parameters. They 
include:

• Number of Test Packets
• Packet Interval (seconds)
• Packet Timeout (seconds)
• Size (octets)
• Source IP Address
• Target IP Address
• Time To Live
• Reply via Control Plane

v Click on the Results Configuration tab button and configure the 
parameters. They include:

• History Size (rows)
• Test Failure Threshold
• Packet Failure Threshold
• Test Completion
• Test Failure
• Probe Failure
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vi Click on the OK or Apply button to save the changes.

vii Confirm the action.

viii Choose the diagnostic from the list.

ix Click on the Execute button. A deployed test is created and run. Open the 
deployed test from the Deployed Tests tab button to view its current state. 
When the test is complete, the deployed test is removed, and you can 
view the results. The VPRN ping is performed. 

b To configure and run a VPRN trace:

i Click on the VPRN Trace tab. A list of VPRN trace diagnostics appears.

ii Double-click on a row in the list to edit an existing test, or click on the Add 
button to create a new test. The VPRN trace form opens with the General 
tab displayed.

iii Configure the parameters. They include:

• Administrative State
• Name

iv Click on the Test Parameters tab and configure the parameters. They 
include:

• Number of Test Packets
• Packet Interval (seconds)
• Packet Timeout (seconds)
• Size (octets)
• Source IP Address
• Target IP Address
• Initial Time to Live
• Maximum Time to Live
• DiffServ Field
• Reply via Control Plane

v Click on the Results Configuration tab button and configure the 
parameters. They include:

• History Size (rows)
• Maximum Failures
• Test Completion
• Test Failure
• Probe Failure

vi Click on the OK or Apply button to save the changes.

vii Confirm the action.

viii Choose the diagnostic from the list.
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ix Click on the Execute button. A deployed test is created and run. Open the 
deployed test from the Deployed Tests tab button to view its current state. 
When the test is complete, the deployed test is removed, and you can 
view the results.

8 View the test results in the Results tab. The results depend on the type of test. See 
Procedure 39-16. Result information includes:

• Number of Probes Sent
• Time Last Response
• Number of Responses Received

Procedure 39-6  To configure and run MAC populate OAM 
diagnostics

1 Choose Tools→Manage Tests from the 5620 SAM main menu. The Manage Tests 
form opens.

2 Click on the Create button.

3 Choose L2 Service→Create MAC Populate from the Create contextual menu. The 
MAC populate create form opens with the General tab displayed.

4 Configure the parameters. They include:

• Administrative State
• Name
• Target Type
• Target MAC Address
• Port ID
• Send via Control Plane
• Force OAM
• Flood
• Age (seconds)

5 Click on the Results Configuration tab button and configure the parameters. They 
include:

• History Size (rows)
• Test Failure Threshold
• Packet Failure Threshold
• Test Completion
• Test Failure
• Path Change

6 Click on the OK button to save the changes.

7 Choose the created test from the list of OAM diagnostics.
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8 Click on the Execute button to start the MAC populate diagnostic. A deployed test 
is created and run. Open the deployed test from the Deployed Tests tab button to 
view its current state. When the test is complete, the deployed test is removed, and 
you can view the results.

9 View the test results in the Results tab. The results depend on the type of test. See 
Procedure 39-16. Result information includes:

• Number of Probes Sent
• Time Last Response
• Number of Responses Received

Procedure 39-7  To configure and run MAC purge OAM diagnostics

1 Choose Tools→Manage Tests from the 5620 SAM main menu. The Manage Tests 
form opens.

2 Click on the Create button.

3 Choose L2 Service→Create MAC Purge from the Create contextual menu. The 
MAC purge create form opens with the General tab displayed.

4 Configure the parameters. They include:

• Administrative State
• Name
• Target Type
• Target MAC Address
• Send via Control Plane
• Flood
• Inhibit Learning

5 Click on the Results Configuration tab button and configure the parameters. They 
include:

• History Size (rows)
• Test Failure Threshold
• Packet Failure Threshold
• Test Completion
• Test Failure
• Path Change

6 Click on the OK button to save the changes.

7 Choose the created test from the list of OAM diagnostics.

8 Click on the Execute button to start the MAC purge diagnostic. A deployed test is 
created and run. Open the deployed test from the Deployed Tests tab button to view 
its current state. When the test is complete, the deployed test is removed, and you 
can view the results.
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9 View the test results in the Results tab. The results depend on the type of test. See 
Procedure 39-16. Result information includes:

• Number of Probes Sent
• Time Last Response
• Number of Responses Received

Procedure 39-8  To configure and run MAC ping OAM diagnostics

1 Choose Tools→Manage Tests from the 5620 SAM main menu. The Manage Tests 
form opens.

2 Click on the Create button.

3 Choose L2 Service→Create MAC Ping from the Create contextual menu. The MAC 
ping create form opens with the General tab displayed.

4 Configure the parameters. They include:

• Administrative State
• Name
• Target Type
• Target MAC Address
• Source MAC Address
• Size (octets)
• Packet Interval (seconds)

5 Click on the Test Parameters tab button and configure the parameters. They 
include:

• Number of Test Packets
• Packet Interval (seconds)
• Packet Timeout (seconds)

6 Click on the Results Configuration tab button and configure the parameters. They 
include:

• History Size (rows)
• Test Failure Threshold
• Packet Failure Threshold
• Test Completion
• Test Failure
• Probe Failure

7 Click on the OK button to save the changes.

8 Choose the created test from the list of OAM diagnostics.
Alcatel 5620 Service Aware Manager, Release 3.0 R1 39-27
October 2005 3HE00214 CA



39 —  Troubleshooting and fault management using service assurance tools
9 Click on the Execute button to start the MAC ping. A deployed test is created and 
run. Open the deployed test from the Deployed Tests tab button to view its current 
state. When the test is complete, the deployed test is removed, and you can view 
the results.

10 View the test results in the Results tab. The results depend on the type of test. See 
Procedure 39-16. Result information includes:

• Number of Probes Sent
• Time Last Response
• Number of Responses Received

Procedure 39-9  To configure and run MAC trace OAM diagnostics

1 Choose Tools→Manage Tests from the 5620 SAM main menu. The Manage Tests 
form opens.

2 Click on the Create button.

3 Choose L2 Service→Create MAC Trace from the Create contextual menu. The 
MAC trace create form opens with the General tab displayed.

4 Configure the parameters. They include:

• Administrative State
• Name
• Target Type
• Target MAC Address
• Source MAC Address
• Initial Time to Live
• Maximum Time to Live

5 Click on the Test Parameters tab button and configure the parameters. They 
include:

• Number of Test Packets
• Packet Interval (seconds)
• Packet Timeout (seconds)

6 Click on the Results Configuration tab button and configure the parameters. They 
include:

• History Size (rows)
• Maximum Failures
• Test Completion
• Test Failure
• Path Change

7 Click on the OK button to save the changes.

8 Choose the created test from the list of OAM diagnostics.
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9 Click on the Execute button to start the MAC trace. A deployed test is created and 
run. Open the deployed test from the Deployed Tests tab button to view its current 
state. When the test is complete, the deployed test is removed, and you can view 
the results.

10 View the test results in the Results tab. The results depend on the type of test. See 
Procedure 39-16. Result information includes:

• Number of Probes Sent
• Time Last Response
• Number of Responses Received

Procedure 39-10  To configure and run service site ping OAM 
diagnostics

1 Choose Tools→Manage Tests from the 5620 SAM main menu. The Manage Tests 
form opens.

2 Click on the Create button.

3 Choose Service→Create Service Site Ping from the Create contextual menu. The 
Service site ping create form opens with the General tab displayed.

4 Configure the parameters. They include:

• Administrative State
• Name
• System ID (Loopback Ip Address)

5 Click on the Test Parameters tab button and configure the parameters. They 
include:

• Target IP Address
• ID
• Use Local Tunnel
• Use Remote Tunnel

When you set the target IP address, then choose a service ID, only service IDs from 
the selected site are available. When you set the Use Local Tunnel and Use Remote 
Tunnel parameters, the test becomes a ping that tests the service tunnel bindings 
between the service sites.

6 Click on the Results Configuration tab button and configure the parameters. They 
include:

• History Size (rows)
• Test Failure Threshold
• Packet Failure Threshold
• Test Completion
• Test Failure
• Probe Failure
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7 Click on the OK button to save the changes.

8 Choose the created test from the list of OAM diagnostics.

9 Click on the Execute button to start the service site ping. A deployed test is created 
and run. Open the deployed test from the Deployed Tests tab button to view its 
current state. When the test is complete, the deployed test is removed, and you can 
view the results.

10 View the test results in the Results tab. The results depend on the type of test. See 
Procedure 39-16. Result information includes:

• Number of Probes Sent
• Time Last Response
• Number of Responses Received

Procedure 39-11  To configure and run LSP ping OAM diagnostics

1 Choose Tools→Manage Tests from the 5620 SAM main menu. The Manage Tests 
form opens.

2 Click on the Create button.

3 Choose MPLS→Create LSP Ping from the Create contextual menu. The LSP ping 
create form opens with the General tab displayed.

4 Configure the parameters. They include:

• Administrative State
• Name
• Target Type
• ID
• Site ID
• LDP Prefix
• LDP Prefix Length

5 Click on the Test Parameters tab button and configure the parameters. They 
include:

• Number of Test Packets
• Packet Interval (seconds)
• Packet Timeout (seconds)
• Size (octets)
• Time To Live
• Forwarding Class
• Forwarding Profile

When you set the target IP address, then choose a service ID, only service IDs from 
the selected site are available.
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6 Click on the Results Configuration tab button and configure the parameters. They 
include:

• History Size (rows)
• Test Failure Threshold
• Packet Failure Threshold
• Test Completion
• Test Failure
• Probe Failure

7 Click on the OK button to save the changes.

8 Choose the created test from the list of OAM diagnostics.

9 Click on the Execute button to start the LSP ping. A deployed test is created and 
run. Open the deployed test from the Deployed Tests tab button to view its current 
state. When the test is complete, the deployed test is removed, and you can view 
the results.

10 View the test results in the Results tab. The results depend on the type of test. See 
Procedure 39-16. Result information includes:

• Number of Probes Sent
• Time Last Response
• Number of Responses Received

Procedure 39-12  To configure and run LSP trace OAM diagnostics

1 Choose Tools→Manage Tests from the 5620 SAM main menu. The Manage Tests 
form opens.

2 Click on the Create button.

3 Choose MPLS→Create LSP Trace from the Create contextual menu. The LSP trace 
create form opens with the General tab displayed.

4 Configure the parameters. They include:

• Administrative State
• Name
• Target Type
• ID
• Site ID
• LDP Prefix
• LDP Prefix Length
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5 Click on the Test Parameters tab button and configure the parameters. They 
include:

• Number of Test Packets
• Packet Interval (seconds)
• Packet Timeout (seconds)
• Size (octets)
• Initial Time To Live
• Maximum Time To Live
• Forwarding Class
• Forwarding Profile

When you set the target IP address, then choose a service ID, only service IDs from 
the selected site are available.

6 Click on the Results Configuration tab button and configure the parameters. They 
include:

• History Size (rows)
• Test Failure Threshold
• Packet Failure Threshold
• Test Completion
• Test Failure
• Path Change

7 Click on the OK button to save the changes.

8 Choose the created test from the list of OAM diagnostics.

9 Click on the Execute button to start the LSP trace. A deployed test is created and 
run. Open the deployed test to view its current state. When the test is complete, the 
deployed test is removed, and you can view the results.

10 View the test results. in the Results tab. The results depend on the type of test. See 
Procedure 39-16. Result information includes:

• Number of Probes Sent
• Time Last Response
• Number of Responses Received

Procedure 39-13  To configure and run an ATM OAM ping

1 Choose Tools→Manage Tests from the 5620 SAM main menu. The Manage Tests 
form opens.

2 Click on the Create button.

3 Choose L1/L2→Create ATM Ping from the Create contextual menu. The ATM ping 
create form opens with the General tab displayed.
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4 Configure the parameters. They include:

• Administrative State
• Name
• ATM Interface ID

5 Click on the Test Parameters tab button and configure the parameters. They 
include:

•  Number of Test Packets
• Packet Interval (seconds)
• Packet Timeout (seconds)
• Loopback Location (hex)
• Destination Type

6 Click on the Results Configuration tab button and configure the parameters. They 
include:

• History Size (rows)
• Test Failure Threshold
• Packet Failure Threshold
• Test Completion
• Test Failure
• Probe Failure

7 Click on the Apply button to save the settings. A confirmation window opens. 

8 Click on the Yes button. The confirmation window closes. 

9 Choose the created test from the list of OAM diagnostics.

10 Click on the Execute button to start the ATM ping. A deployed test is created and 
run. Open the deployed test from the Deployed Tests tab button to view its current 
state. When the test is complete, the deployed test is removed, and you can view 
the results.

11 View the test results in the Results tab. The results depend on the type of test. See 
Procedure 39-16. Result information includes:

• Number of Probes Sent
• Time Last Response
• Number of Responses Received

12 To configure another ATM OAM ping, click on the Clear button and repeat steps 5 
to 11. Otherwise, go to step 13.

13 Click on the Cancel button to close the form.

Procedure 39-14  To edit an OAM diagnostic test

1 Choose Tools→Manage Tests from the 5620 SAM main menu. The Manage Tests 
form opens.
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2 Select the Tests filter option. Use the configurable filters choices and properties 
options on the Manage Tests form and click on the Search button. The list of tests 
that meet the filter criteria is displayed. 

3 Choose one ore more OAM diagnostic tests from the results list and click on the Edit 
button. The appropriate edit form opens.

4 Change any configurable parameter for the test.

5 Click on the OK button to save the changes.

6 Confirm the action. The modified test or tests are shown in the list.

Procedure 39-15  To delete an OAM diagnostic test

1 Choose Tools→Manage Tests from the 5620 SAM main menu. The Manage Tests 
form opens.

2 Select the Tests filter option. Use the configurable filters choices and properties 
options on the Manage Tests form and click on the Search button. The list of tests 
that meet the filter criteria are displayed. 

3 Choose one ore more OAM diagnostic tests from the results list and click on the 
Remove button.

4 Confirm the action. The test or tests are deleted from the list of available OAM 
diagnostic tests.

Procedure 39-16  To view OAM diagnostic test results

1 Choose Tools→Manage Tests from the 5620 SAM main menu. The Manage Tests 
form opens.

2 Select the Tests Result filter option. Use the configurable filters choices and 
properties options on the Manage Tests form and click on the Search button. The 
list of test results that meet the filter criteria are displayed. 

3 Choose a test result from the list and click on the Edit button. The appropriate OAM 
diagnostic test results form opens with the General tab displayed.

4 View the results from the General and Packet tab buttons, as required. You can click 
on the View button next to an object and launch the properties form for that object.
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a MTU ping OAM diagnostic information includes:

• source and destination site IP addresses
• originating tunnel ID
• administrative and operational states
• information about previous diagnostics, including the start and finish sizes 

of the MTU datagram (packet)
• ID of the service being diagnosed
• name of the service being diagnosed
• MTU response size, indicating the largest packet size that the tunnel can 

transport

b Tunnel ping OAM diagnostic information includes:

• source and destination site IP addresses
• originating and return tunnel IDs
• administrative state
• operational state
• probes to be issued information
• message size
• forwarding class used by the service
• ID of the service being diagnosed
• name of the service being diagnosed
• average, minimum, and maximum one-way time values, in ms, with a value 

of 0 indicating that no one-way trip measurement is available
• sum-of-squares one-way time for all ping responses received, used to 

enable a standard deviation calculation
• round trip jitter, in ms, for a ping probe, with a value of 0 indicating that no 

measurement is available

c VPRN ping diagnostic information includes:

• target and source IP addresses
• service ID and name
• number of probes to be issued
• operational size
• number of responses
• round trip jitter, in ms, for a ping probe, with a value of 0 indicating that no 

measurement is available
• inner and outer encapsulation value of the SAP supporting the requested 

ping response, when the address type is a SAP and in the case that the 
inner encapsulation value is from a 5620 SAM-managed device

d VPRN trace diagnostic information includes:

• target and source IP addresses
• service ID and name
• number of probes to be issued
• operational size
• number of responses
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e MAC ping diagnostic information includes:

• target and source MAC addresses
• service ID and name
• number of probes to be issued
• administrative and operational states
• information about previous diagnostics
• average, minimum, and maximum round trip time values, in ms, with a 

value of 0 indicating no round trip measurement is available
• sum-of-squares round trip time for all ping responses received, used to 

enable a standard deviation calculation

f MAC trace diagnostic information includes:

• target and source MAC addresses
• service ID and name
• number of probes to be issued
• administrative and operational states
• information about previous diagnostics

g Service site ping OAM diagnostic information includes:

• target and source IP addresses
• service ID and name
• probes to be issued information
• check mark buttons to specify whether a local tunnel, remote tunnel, or 

local and remote tunnel is performed
• information about previous service site OAM diagnostics, including probes 

sent and responses received, loss percentage, packet timeouts, and last 
good packet time

• ID of the service being diagnosed

h LSP ping diagnostics information includes:

• target and source IP addresses
• service ID and name
• number of probes to be issued
• operational size
• number of responses
• round trip jitter, in ms, for a ping probe, with a value of 0 indicating that no 

measurement is available
• average, minimum, and maximum one-way trip time values, in ms, with a 

value of 0 indicating no one-way trip measurement is available
• sum-of-squares one-way trip time for all ping responses received, used to 

enable a standard deviation calculation

Procedure 39-17  To interpret OAM diagnostic results

1 Perform the OAM diagnostic, as described in Procedure 39-1 to Procedure 39-13.
39-36 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



39 —  Troubleshooting and fault management using service assurance tools
2 Perform Procedure 39-16 to view the results.

3 The General and Packet tabs display the key information about OAM diagnostic 
results. When there is no packet information required, as for an OAM ping, the 
information appears on the packets results form without any tab buttons. For 
example, status and return code information appears directly on the results form. 
You can view test packet information by performing the following actions:

i Click on the Packet tab button. A list of test packets appears.

ii Choose a packet or packets from the list and click on the Edit button. The 
Packets Results form opens.

iii Interpret the results, based on the status and return code information.

a For MTU OAM diagnostics, the key information is how many frames were sent 
and incrementally increased in size before the frames could not be sent. When 
the frame cannot be sent because it is too large, that results in a request 
timeout message. The largest frame that was sent is the last frame size with 
an associated success response.

b For tunnel OAM diagnostics, the key information is the result of the diagnostic, 
displayed in the status message. Table 39-5 lists the displayed messages and 
descriptions.

Table 39-5 Tunnel OAM diagnostics results

Displayed message Description

Request Timeout The request timed out with a reply.

Orig-SDP Non-Existent The request was not sent because the originating SDP 
does not exist.

Orig-SDP Admin-Down The request was not sent because the originating SDP 
administrative state is operationally down.

Orig-SDP Oper-Down The request was not sent because the originating SDP 
operational state is down.

Request Terminated The operator terminated the request before a reply could 
be received or before the timeout of the request could 
occur.

Far End: Originator-ID Invalid The request was received by the far end, but the far end 
indicates that the originating SDP ID is invalid.

Far End: Responder-ID Invalid The request was received by the far end, but the 
responder ID is not the same destination SDP ID that was 
specified.

Far End:Resp-SDP Non-Existent The reply was received, but the return SDP ID used to 
respond to the request does not exist

Far End:Resp-SDP Invalid The reply was received, but the return SDP ID used to 
respond to the request is invalid.

Far End:Resp-SDP Down The reply was received, but the return SDP ID indicates 
that the administrative or operational state of the SDP is 
down.

Success The tunnel is in service and working as expected. A reply 
was received without any errors.
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c For service site OAM diagnostics, the key information is the result of the 
diagnostic, which is displayed in the status message and with the other records 
from the General tab. 

As the diagnostic traverses the service across the originating and destination 
IP addresses, the service tunnels, and the used VCs, the status of each portion 
of the service is displayed. Table 39-6 lists the displayed messages and 
descriptions.

Table 39-6 Service site OAM diagnostics results

d For MAC and VPRN ping OAM diagnostics, the key information is the result of 
the diagnostic. Table 39-7 lists the displayed messages, the return code, and 
descriptions.

Table 39-7 MAC and VPRN ping OAM diagnostics results

Displayed message Description

Sent - Request Timeout The request timed out with a reply.

Sent - Request Terminated The request was not sent because the diagnostic 
was terminated by the operator.

Sent - Reply Received The request was sent and a successful reply 
message was received.

Not Sent - Non-Existent Service-ID The configured service ID does not exist.

Not Sent - Non-Existent SDP for Service There is no SDP for the service being tested.

Not Sent - SDP For Service Down The SDP for the service is down.

Not Sent - Non-Existent Service Egress Label There is a service label mismatch between the 
originator and responder.

Displayed message (return code) Description

notApplicable (0) The OAM diagnostic message does not apply to 
the OAM diagnostic performed.

fecEgress (1) The replying router is an egress for the FEC.

fecNoMap (2) The replying router has no mapping for the FEC.

notDownstream (3) The replying router is not a downstream router.

downstream (4) The replying router is a downstream router, and 
the mapping for this FEC on the router interface 
is the specified label.

downstreamNotLabel (5) The replying router is a downstream router, and 
the mapping for this FEC on the router interface 
is not the specified label.

downstreamNotMac (6) The replying router is a downstream router, but it 
does not have the given MAC address.

downstreamNotMacFlood (7) The replying router is a downstream router, but it 
does not have the specified MAC address and 
cannot flood the request to other routers.

(1 of 2)
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e For most diagnostics, some common return codes are used. The return codes 
indicate the status of OAM tests, usually when there was a problem performing 
the test. Table 39-8 lists the messages, return codes, and descriptions.

malformedEchoRequest (8) The received echo request is malformed.

tlvNotUnderstood (9) One or more TLVs were not understood.

Displayed message (return code) Description

(2 of 2)
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Table 39-8 OAM diagnostics return codes

Displayed message (return code) Description

responseReceived (1) A response was received on the device to the 
OAM diagnostic performed.

unknown (2) The OAM diagnostic failed for an unknown 
reason.

internalError (3) An internal error on the device caused the 
diagnostic to not be performed.

maxConcurrentLimit Reached (4) The device cannot perform the OAM diagnostics 
because there are too many OAM diagnostic 
operations already running.

requestTimedOut (5) The OAM diagnostic could not be completed 
because no reply was received within the 
allocated timeout period.

unknownSDPOrigin (6) Indicates an invalid or non-existent originating 
service tunnel.

downOrigSdpId (7) The originating service tunnel is operationally 
down.

requestTerminated (8) The OAM diagnostic was cancelled before the 
timeout or reply period was reached.

invalidOriginatorId (9) The far-end device replied indicating that the 
originating ID was invalid.

invalidResponderId (10) The far-end device replied with an invalid 
responding ID.

unknownRespSdpId (11) The far-end device replied with an invalid 
response service tunnel ID.

downRespSdpId (12) The responding service tunnel with the given ID 
is operationally or administratively down.

invalidServiceId (13) An invalid or non-existent service ID.

invalidSdp (14) An invalid or non-existent service tunnel for the 
service.

downServiceSdp (15) The service tunnel bound to the service is down.

noServiceEgressLabel (16) The egress label for the service does not exist.

invalidHostAddress (17) The IP address for the host is invalid, for 
example, in the case of a broadcast or multicast 
IP address.

invalidMacAddress (18) The MAC address specified in the OAM 
diagnostic is invalid.

invalidLspName (19) The LSP name specified in the OAM diagnostic is 
invalid.

macIsLocal (20) The MAC address is the local SAP or device 
MAC address, not the MAC address of the 
downstream SAP or device, therefore the MAC 
ping or trace cannot be sent.

farEndUnreachable (21) No route is available to the far-end GRE service 
tunnel.

downOriginatorId (22) The originating ping device is operationally down.

(1 of 3)
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downResponderId (23) The device responding to the ping is 
operationally down.

changedResponderId (24) The ID of the device responding to the ping has 
changed.

downOrigSvcId (25) The originating service identified by the ID is 
operationally down.

downRespSvcId (26) The service responding to the ping identified by 
the ID is operationally down.

noServiceIngressLabel (27) The ingress label for the service does not exist.

mismatchCustId (28) The subscriber ID identified with the service 
differs from the originating device compared to 
the responding device.

mismatchSvcType (29) The service type identified with the service differs 
from one device to another.

mismatchSvcMtu (30) The service MTU size associated with the service 
differs from the originating device compared to 
the responding device.

mismatchSvcLabel (31) The service label identified with the service 
differs from the originating device compared to 
the responding device.

noSdpBoundToSvc (32) There is no service tunnel bound to the service.

downOrigSdpBinding (33) The service tunnel associated with the originating 
device’s service is operationally down.

invalidLspPathName (34) The LSP path name specified in the OAM 
diagnostic is invalid.

noLspEndpointAddr (35) There is no LSP endpoint address specified in 
the OAM diagnostic.

noActiveLspPath (36) There is no active LSP path.

downLspPath (37) The far end of the LSP is operationally down.

invalidLspProtocol (38) The LSP protocol is not valid or is not supported.

invalidLspLabel (39) The LSP label is invalid.

routeIsLocal (40) For a VPRN ping, the route is a local route.

noRouteToDest (41) For a VPRN ping, there is no route available to 
the destination of the OAM diagnostic.

localExtranetRoute (42) For a VPRN ping, the route is a local extranet 
route.

srcIpInBgpVpnRoute (43) For a VPRN ping, the source IP address belongs 
to a BGP VPN route.

srcIpInvalid (44) For a VPRN ping, the source IP address is invalid 
or no route is available to the source IP address.

bgpDaemonBusy (45) For a VPRN trace, the BGP routing process is 
busy on the device, and VPRN route target 
information cannot be retrieved.

mcastNotEnabled (46) —

Displayed message (return code) Description

(2 of 3)
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mTraceNoSGFlow (47) —

mTraceSysIpNotCfg (48) —

Displayed message (return code) Description

(3 of 3)
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40.1 Fault management using APS overview

APS is designed to protect SONET/SDH lines from linear unidirectional and 
bidirectional failures. The network elements in a SONET/SDH network constantly 
monitor the health of the network. When a failure is detected, the network proceeds 
to transfer, or switch over, live traffic from a working (active) line to a protection 
(standby) line. The transfer occurs quickly to minimize lost traffic. The traffic 
remains on the protection line until the fault on the working line is cleared, at which 
time the traffic can revert to the working line, if required.

The 5620 SAM supports 1+1 APS configurations on 7750 SR, Release 3.0 or later. 
In a 1+1 architecture, the active OC-n signal is transmitted to both the working and 
protection ports, so the same payloads are transmitted identically to the working and 
protection ports in the egress direction. The working and protection signals are 
selected independently in the ingress direction.

In the 5620 SAM, the main elements of APS are:

• APS groups
An APS group is an aggregation of one or two SONET/SDH ports and their 
associated APS channels. The first port is known as the working channel, which 
must always be configured in the APS group. The second port is known as the 
protection channel, which is optionally configurable. In APS, if you have 
configured the protection channel, it carries the traffic from the failed working 
line. If the protection line fails, then the working channel carries the traffic.

• APS channels
APS channels model both the working and protection channels. An APS channel 
exists separately from a working or protection channel because it has a different 
set of associated data, which includes identification of the corresponding physical 
port, identification as either working or protection, and the name of the APS 
group to which the APS channel belongs.

• APS common port configurations
All SONET/SDH port parameters, with the exception of the parameters listed 
below, must be identical for each port associated with an APS channel within the 
same APS group. When a working or protection channel is added to an APS 
group, it inherits the configured common port settings. The following 
SONET/SDH port parameters do not have to be identical for each port:

• Clock Source
• Loopback
• Report Alarms
• BER Signal Degradation Threshold
• BER Signal Failure Threshold
• Sonet Section Trace Mode

• APS commands
Each APS channel has one APS operational command associated with it, which 
is the last command that was issued to the APS channel. APS commands affect 
the operational conditions of APS but do not affect the configuration. The 
operational state does not persist across restarts of the 7750 SR.

Caution —   The 7750 SR only transmits data on the active line. For 
a single failure, this configuration can cause a data hit of up to 100 ms 
during an APS switch.
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Table 40-1 describes the events that affect 1+1 protection and their relative priority 
in the system.

Table 40-1 Events affecting 1+1 protection

Consider the following when configuring APS:

• A single 7750 SR supports the creation of up to 64 APS groups.
• An APS group has one set of APS channels. The set can contain either one or two 

APS channels.
• An APS channel can belong to only one APS group.
• A SONET/SDH port can either belong to one APS channel or not belong to any 

APS channels.
• A SONET/SDH port cannot belong to more than one APS channel.
• A port can belong to only one APS group.
• A port must not have any channels configured.
• Two ports that belong to the same APS group must be of the same port type and 

have the same traffic speed.

Directional modes

The 7750 SR supports the following 1+1 system directional modes:

• bidirectional (default)
• unidirectional

In bidirectional mode, a signal failure in either direction causes both the near-end and 
far-end devices to switch to the protection channels. The highest-priority local 
request is compared with the remote request from the far-end device issuing an APS 
command, and the request that has the greater priority is selected. See Table 40-1 for 
the list of events that affect 1+1 protection.

The 7750 SR is configured to operate in unidirectional mode for APS signaling to 
allow interoperability with other devices that are configured for unidirectional APS 
and do not support bidirectional APS. The 7750 SR generates and transmits switch 
requests based on local requests or conditions only as required by APS signaling.

The 7750 SR always receives and transmits on the same active channel.

Priority Event Event type

1 Lockout of protection User initiated

2 Signal failure of protection line Automatically initiated

3 Forced switch User initiated

4 Signal failure of working line Automatically initiated

5 Signal degrade Automatically initiated

6 Manual switch User initiated

7 WTR time (revertive switching only) User initiated

8 No reversion (non-revertive switching only) User initiated
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Switching modes

The 7750 SR supports the following 1+1 system switching modes:

• non-revertive (default)
• revertive

In non-revertive switching, a switch to the protection channel is maintained even 
after the working line has recovered from a failure or the manual switch has been 
cleared.

In revertive switching, the traffic is switched back to the working channel after the 
working line has recovered from a failure or a manual switch has been cleared.

For revertive switching, you can define a period of time that the system must wait 
before it can restore traffic from the protection line to the working line. This 
wait-to-restore time prevents frequent automatic switches from occurring as a result 
of intermittent failures.

In case of failure on both the working and protection lines, the line that has the less 
severe error is active. If there is a signal degrade on both ports, the active port that 
failed last remains active. If there is a signal failure on both ports, the working port 
always remains active because a signal failure on the protection line is a higher 
priority than a signal failure on the working line.

APS port configurations

The 7750 SR network and access ports can be connected to an ADM or other APS 
capable device with both the working and protection lines on different I/O modules 
in a single device. Both channelized and non-channelized ports are supported.

All SONET/SDH MDAs support APS functionality. Table 40-2 lists the possible 
port pairings to provide APS protection. Both ports must be of the same type and 
have the same traffic speed.

Table 40-2 APS port configurations

Note —  Mirroring parameters configured on a specific port or 
service are maintained during an APS failover.

MDA type—Working channel MDA type—Protection channel

16 × OC12/OC3 SFP 8 × OC12/OC3 SFP or 16 × OC12/OC3 SFP

8 × OC12/OC3 SFP 8 × OC12/OC3 SFP or 16 × OC12/OC3 SFP

16 × OC3 SFP 8 × OC3 SFP or 16 × OC3 SFP

8 × OC3 SFP 8 × OC3 SFP or 16 × OC3 SFP

4 × OC48 SFP 2 × OC48 SFP or 4 × OC48 SFP

2 × OC48 SFP 2 × OC48 SFP or 4 × OC48 SFP

1 × OC192 1 × OC192

1 × OC12 Deep Channel 1 × OC12 Deep Channel 

(1 of 2)
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APS support on a single node

1+1 APS can be implemented on a port-by-port basis. If all ports on an MDA or IOM 
need to be protected, then the ports must be individually configured.

The working and protection lines are capable of being connected to:

• two ports on the same MDA
• two ports on different MDAs, but the MDAs are on the same IOM
• two ports on different IOMs installed in different slots

If the working channel and protection channel are on the same MDA, protection is 
limited to the physical port and the media connecting the two devices. If different 
IOMs are used, protection extends to failure of the IOM.

Working and protection lines can be connected to an ADM and serve as an access 
port that provides one or more services to the 7750 SR. The access port can be a 
single channel or multiple channels; each channel must support PPP. In the case of 
the ATM MDA, each channel must support ATM.

The ADM or compatible head-end device transmits a valid data signal to both the 
working and protection lines. The signal on the protection line is ignored until the 
working channel fails or degrades to the degree that requires a switchover to the 
protection channel. When the switchover occurs, all services, including all service 
QoS and filter policies, are activated on the protection channel.

The working channel on a 7750 SR must connect to the working channel on a peer 
device, and the protection channel on a 7750 SR must connect to the protection 
channel on a peer device.

40.2 Workflow to manage network faults using APS

1 Create a 1+1 APS configuration on SONET/SDH ports as required.

2 Perform one of the following APS commands against each APS channel as 
required:

4 × OC3 Deep Channel 4 × OC3 Deep Channel

4 × ATM OC12/OC3 SFP 4 × ATM OC12/OC3 SFP

Note —  The working and protection channel lines for the following 
MDA port pairs are set to the same traffic speed based on the APS 
group speed configuration:

• 16 × OC12/OC3 SFP and 16 × OC12/OC3 SFP 
• 16 × OC12/OC3 SFP and 8 × OC12/OC3 SFP
• 8 × OC12/OC3 SFP and 16 × OC12/OC3 SFP
• 8 × OC12/OC3 SFP and 8 × OC12/OC3 SFP
• 4 × ATM OC12/OC3 SFP and 4 × ATM OC12/OC3 SFP

MDA type—Working channel MDA type—Protection channel

(2 of 2)
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a Use the Lockout of Protection command to prevent any working channels from 
switching to the protection line.

b Use the Forced Switch of Working to Protection command to force a 
high-priority switch of the specified working channel to the protection line.

c Use the Forced Switch of Protection to Working command to force a 
high-priority switch of the specified working channel back from the protection 
line to the working line.

d Use the Manual Switch of Working to Protection command to manually switch 
the specified working channel to the protection line.

e Use the Manual Switch of Protection to Working command to manually switch 
the specified working channel back from the protection line to the working line.

f Use the Exercise command in the bidirectional mode to exercise the protocol 
for a protection switch of the specified working channel by issuing a request for 
that channel and checking the response on the APS channel.

g Use the Clear command to clear the switch commands for the specified 
channel.

3 Remove an APS configuration as required.

40.3 Fault management using APS menus

Table 40-3 lists the menus, and their functions, used to manage network faults using 
APS.

Table 40-3 5620 SAM menus to manage network faults using APS

40.4 Fault management using APS procedures list

Table 40-4 lists the procedures necessary to execute APS fault management tasks.

Table 40-4 5620 SAM APS procedures list

Menu option Function

Contextual menu for Aps Groups objects in the 
equipment view of the navigation tree

View, open, create, and configure APS group 
and APS channel properties, including issuing 
APS commands against APS channels

Procedure Purpose

To configure APS on SONET/SDH ports Create and configure APS groups, including 
working and protection channels

To change the operational state of APS Issue an APS command against an APS channel

To remove APS from a SONET/SDH port Delete an APS configuration
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40.5 Fault management using APS procedures

Use the following procedures to perform APS fault management tasks.

Procedure 40-1  To configure APS on SONET/SDH ports

1 Locate and expand the shelf object for which you want to configure APS in the 
equipment view of the 5620 SAM navigation tree. The APS Groups object is 
displayed below the shelf object, as shown in Figure 40-1.

2 Right-click on the APS Groups object and select Add from the contextual menu. The 
Aps Group (Create) form opens with the Aps group tab displayed, as shown in 
Figure 40-1.

Figure 40-1  Aps Group (Create) form - APS group tab

3 Configure the Wait To Restore (seconds) parameter.

4 Click on the General tab button to configure the common port parameters for the 
APS group.

Note —  All members in a multilink bundle must be configured in the 
same physical port if APS is required on that port.

When a multi-service site is configured on an IOM, both the working and 
protection ports must be configured on the same IOM.
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5 Configure the following parameters.

• Administrative State
• Description
• Configured MAC
• Mode
• Encap Type
• Speed
• MTU (bytes)

6 Click on the States tab button to configure the administrative state for the APS 
group. 

7 Configure the Administrative State parameter.

When a working channel or protection channel is added to the APS group, the 
channel inherits the current administrative state of the APS group. After the channel 
is added to the APS group, the administrative state of the physical port can be 
changed independently.

8 Click on the APS Channels tab button to add APS channels to the APS group.

9 Click on the Add button. The APS Channel Manager form opens.

10 Choose an APS working channel.

11 Choose an APS protection channel, if required.

12 Click on the OK button. The APS Channel Manager form closes. The Aps Group 
(Create) from refreshes with the selected ports displayed in the APS Channels tab.

13 Perform the following as required for SONET/SDH ports.

a Click on the SONET tab button and configure the Clock Source and Loopback 
parameters.

b Click on the SONET Monitoring tab button to configure the following 
parameters:

• BER Signal Degradation Threshold
• BER Signal Failure Threshold
• Report Alarms

c Click on the SONET Overhead tab button to configure the Sonet Section Trace 
Mode parameter.

14 Click on the OK button. The Aps Group (Create) form closes. The navigation tree 
refreshes with the APS Group - APS Group Name object under the Aps Groups 
object. The APS Common Port, APS Working Port, and APS Protection Port objects 
appear below the APS Group - APS Group Name object, depending on the 
configuration of the APS group.
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Procedure 40-2  To change the operational state of APS

1 Right-click on the APS Group - APS Group Name object in the equipment view of 
the 5620 SAM navigation tree and select Properties from the contextual menu. The 
Aps Group (Edit) form opens.

2 Click on the APS Channels tab button.

3 Select an APS channel from the list and click on the Edit button. The APS Channel 
Manager form opens.

4 Configure the Command Switch parameter.

5 Click on the OK button. The operational state of the APS channel changes and the 
APS Channel Manager form closes.

6 Click on the OK button. The Aps Group (Edit) form closes.

Procedure 40-3  To remove APS from a SONET/SDH port

1 Right-click on the APS Group - APS Group Name object in the equipment view of 
the 5620 SAM navigation tree and select Properties from the contextual menu. The 
Aps Group (Edit) form opens.

2 Click on the APS Channels tab button.

3 Select the APS protection channel from the list, if required, and click on the Remove 
button. The APS protection channel is removed from the APS group.

4 Select the APS working channel from the list and click on the Remove button. The 
APS working channel is removed from the APS group.

5 Click on the OK button. The Aps Group (Edit) form closes.

6 Right-click on the APS Group - APS Group Name object in the equipment view of 
the 5620 SAM navigation tree and select Remove from the contextual menu. The 
working and protection ports are removed from the selected APS group. The APS 
Group - APS Group Name object is removed from the navigation tree.
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41.1 Accounting and performance monitoring using statistics 
overview

This chapter contains general information on the configuration and collection of 
accounting and performance statistics. See the 5620 SAM Statistics Management 
Guide for detailed information on statistics and an example of how to collect 
statistics from a real-world network configuration.

Statistics types
Performance monitoring and accounting statistics collection are performed on the 
5620 SAM using service- and equipment-related statistics counters from the 
managed devices. There are two types of statistics collected:

• service access points and network ports for accounting statistics, which can be 
used for billing and traffic-analysis purposes

• network object performance statistics, for control plane, data forwarding plane, 
and device utilization statistics

41.2 Workflow for statistics collection

1 Create a file policy to specify:

• the frequency of accounting statistics log collection from the managed devices
• the compact flash device where the accounting statistic logs are stored as the 

counters are collected and the completed logs are stored
• how long the accounting collected statistics logs are stored

2 Create multiple accounting policies to determine how statistics are collected for 
each business model or type of service provided.

The statistics logs are retrieved and stored in the 5620 SAM database as specified 
in the file policies and accounting policies.

3 Modify existing accounting policies or create new policies, as required.

4 Monitor performance statistics data from the GUI based on:

a Services based on applied accounting policies.

b Equipment and other network objects using near-real-time network 
performance statistics logged from the managed devices. Modify the network 
statistics counter collection policy for network ports as required.

41.3 Statistics menus

Table 41-1 lists the statistics menus and their functions.
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Table 41-1 5620 SAM statistics menus

41.4 Statistics procedures list

Table 41-2 lists the procedures for using statistics.

Table 41-2 5620 SAM statistics procedures list

41.5 Performance monitoring using statistics procedures

Use the following procedures to perform 5620 SAM statistics-related tasks.

Procedure 41-1  To create or modify a file policy

A file policy is used in tandem with an accounting policy to manage statistics collection. 
You can create multiple file policies.

1 Choose Policies→File from the 5620 SAM main menu. The Manage File Policies 
form appears.

2 You can:

a Create a policy by clicking on the Create button.

The File Policy Global Policy (Create) form appears. Go to step 3.

b Modify an existing policy:

Menu option Function

Policies→File Create one or more file policies.

Policies→Accounting Create one or more accounting policies to 
manage statistics collection.

Tools→Log Records View statistics logs

Procedure Purpose

To create or modify a file policy Specify how often log files of collected statistics 
counters are collected and managed.

To create or modify an accounting policy Specify the types of statistics collected on a 
per-usage and per-service basis.

To view equipment and other object-based 
performance statistics

Monitor near-real time statistics on network 
equipment and other network objects, such as 
protocols.

To modify equipment and object-based 
performance statistics policies

Set specific polling and log collection policies for 
statistics classes and counters, on a per object 
and per statistics class basis.

To view statistics logs View statistic log files
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i Use the filter form to narrow the search for an existing policy.

ii Specify the Policy scope parameter to set a local or global policy search. 
Local policies are those policies applied to specific managed devices.

iii Click on the Search button.

The list of file policies appears.

iv Choose a file policy from the list.

v Click on the Edit button.

The File Policy Global Policy (Edit) form appears.

3 Configure the parameters, as required. They include:

• Configuration Action
• Displayed Name
• Rollover (min)
• Retention (hr)
• Drive
• Actual Drive

4 Click on:

a The Local Definitions tab to view accounting file policies in effect on managed 
devices.

b The Logs tab button to view any logs created using the specified file policy.

c The Access L2 Interfaces or Access L3 Interfaces tab button to view any 
interfaces using the specified file policy.

Procedure 41-2  To create or modify an accounting policy

An accounting policy is used in tandem with a file policy to manage statistics collection. 
You can create multiple accounting policies.

1 Choose Policies→Accounting from the 5620 SAM main menu. The Manage 
Accounting Policies form appears.

2 You can:

a Create a policy by clicking on the Create button.

The Accounting Policy Manager (Create) form appears with the General tab 
button selected. Go to step 3.

Note —  The managed devices have sufficient resources to support 
large scale statistical policy usage. Ensure that all collection intervals, file 
retention intervals, and rollover intervals are sufficient. Also, ensure that 
statistics are retrieved from the storage devices on a regular basis.
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b Modify an existing policy:

i Filter to narrow the search for an existing policy.

ii Specify the policy scope using the Policy scope parameter. Local policies 
are those policies applied to specific managed devices.

iii Click on the Search button.

The list of accounting policies appears.

iv Choose an accounting policy from the list.

v Click on the Edit button.

The Accounting Policy Global Policy (Edit) form appears.

3 Configure the parameters. They include:

• Configuration Action
• Type
• Default
• Collection Interval (m) 

4 Choose a file policy.

i Click on the Select button and choose a file policy from the list.

ii Click on the OK button.

The file policy ID is shown in the File ID parameter.

Click on the Remove button in the File pane of the Accounting Policy (Edit) window 
to remove an existing file policy from the Name parameter and choose a new policy.

5 Click on the Apply button.

6 Click on:

a The Access L2 Interfaces or Access L3 Interfaces tab button to view any 
interfaces using the specified file policy.

b The Faults tab button to view any alarm raised against the file policy.

c The Local Definitions tab button to view any instances of the accounting policy 
being used locally on equipment or services.

i Click on a row representing the local instance.

ii Click on the Edit button.

The policy form for the specific equipment or service appears. The tab 
buttons change to indicate local or global instances.

iii Click on the OK button to change the parameters, or click the Cancel 
button to close the form.

7 You can:
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a Choose an accounting policy when you create a service. Alcatel recommends 
that you use this method for accounting policies.

b Click on the Distribute button to send the accounting policy to the network 
devices. Alcatel does not recommend that you use this method.

c Click on the Delete button to remove an accounting policy.

d Click on the Free Unused button to remove any accounting policies not being 
used by a service or other object.

e Click on the Copy button to create another accounting policy with the same 
parameter settings.

Procedure 41-3  To view equipment and other object-based 
performance statistics

Equipment and object-based performance statistics help operators monitor the usage of 
physical and logical network elements in near-real time. Statistics logs are used to show 
equipment and logical network object usage rates.

1 Open a view of the equipment or logical object.

For example, to view port statistics, choose Equipment from the navigation tree view 
selector and navigate to a port using the path Router→Shelf→Card Slot→Daughter 
Card Slot→Port. Right-click on the port icon and choose Properties from the 
contextual menu.

2 Choose the equipment on which to view statistics.

You can view statistics on logical or physical interfaces, for example, SONET ports.

3 Click on the Statistics tab button.

Additional statistics tabs appear. The tabs that appear are determined by the type 
of equipment. Click on the tab buttons to view specific statistics.

4 Review the most recent interval of performance statistics collected for the 
equipment or object.

By default, the rows are listed by most recent polling interval. You can sort based on 
the monitored object column, which represents the physical or logical object.

5 You can update the list of performance statistics using the Resync button.

i Click on the appropriate statistics tab button.

ii Click on the Resync button.

iii Confirm the resynchronization by clicking on the Yes button.

The latest statistics are displayed.

iv Repeat for each statistics tab, as required.
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6 Select a statistic interval from the list and click on the Edit button. The record for that 
statistic interval appears.

7 Click on the View History button.

8 Create a filter, or use the provided filter, and click on the OK button.

The performance statistics information appears in the Browse Log Records form as 
a series of rows, one for each interval.

9 Click on an interval row of statistics and click on the Edit button. 

The statistics form appears.

10 Review the statistics data, as required.

Procedure 41-4  To modify equipment and object-based 
performance statistics policies

The collection of statistics for equipment and other logical network objects is independent 
per statistics class. Therefore you can fine-tune the collection and polling policies per 
object type.

1 Perform Procedure 41-3 until step 3.

2 Click on the Edit Policy button to open the statistics polling policy configuration form 
for the specific equipment or object.

The polling policy configuration form (called the logger form on the GUI) appears 
with the General tab button selected.

3 The General tab contains parameters that determine the polling configuration. The 
statistics class full name appears in the titlebar of the configuration form. For 
example, logger.ospf.AreaBasicStats is the statistics class.

4 Configure the general parameters. They include:

• Max Log Records
• Clear Window
• Administrative State
• Threshold Reporting State

5 Click on the Thresholds tab button. 

6 Configure the threshold parameters. If the threshold is exceeded for that statistics 
counter, the user is notified by a threshold crossing alarm.

Note —  When you change polling policies for one statistics class for one 
network object, the same changes apply to all other network objects that 
use the same statistics class.
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7 Click on the Apply button to save the changes. Click on the OK button to close the 
form.

Procedure 41-5  To view statistics logs

Statistics logs contain the statistics data for network ports that collect performance 
statistics.

1 Choose Tools→Log Records from the 5620 SAM main menu. The Manage Log 
Records form appears.

2 Modify the filter to generate a list of statistical data.

a Specify the Log Class parameter by choosing a type of statistic from a 
drop-down list of log classes. The log classes indicate which classes of 
statistics are available.

If the logged statistics are generated from a device MIB, see Table 45-1 in 
chapter 45 for the types of accounting statistics generated.

b Specify the Log Type parameter. Choose from a drop-down list of the types of 
log records, for example the most current set of data for the statistics class, or 
data that has already been logged.

c Choose a filter from the Unused Properties list. Available filters are determined 
by the log class selected. For each log class, there are multiple individual 
statistics on which you can filter.

For example, if you choose OSPF-related Area Basic statistics as the log 
class, specific counters for that class, such as Area Border Router Count and 
Maintained Object, appear in the Unused Properties list. These counters are 
available when you view the statistic log.

3 Click on the Search button. The list of statistics log records for that class appears.

4 Scroll the listed logs to view the statistics. By default, the rows are sorted to show 
the most recently collected logs first. Each row represents a network object.

a Scroll across the row of each log to view the statistics for the equipment or 
object.

b Double-click on a row in the list.

The form of logged statistics for the network object appears.

5 Click on:

a The Resync button to generate the latest set of logged statistics.

b The Edit Policy button to view the policy settings for the statistic class. 

c The Close button to close the form.
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Numerics

1354 BM 1354 Broadband Network Manager

A network management software application that extends optical network 
management to include the management of data transport services for ATM 
and Ethernet over optical networks.

5620 NM 5620 Network Manager

The 5620 NM provides advanced management of large, complex 
LAN/WAN networks, including hybrid circuit-switched, IP/MPLS, ATM, 
frame relay, and X.25 networks. The GUI operates on a Sun workstation. It 
can be used to configure databases, monitor network operation in real time, 
set up and manage paths, and perform diagnostics to isolate and manage 
problems on the network.

With the addition of optional software modules, the 5620 NM can perform 
advanced management functions such as managing multivendor equipment, 
interfacing with UMS, and partitioning networks.

5620 SAM 5620 Service Aware Manager

The 5620 SAM is the network manager portfolio of modules for the 
7750 SR, 7450 ESS, and Telco nodes.

5620 SAM client The 5620 SAM client provides a GUI to configure IP network elements.

5620 SAM database The 5620 SAM database stores network objects and configurations.

5620 SAM server The 5620 SAM server mediates between the 5620 SAM database, the 
5620 SAM client, and the network.
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5620 SAM-A 5620 SAM Assurance

The 5620 SAM-A provides service assurance functionality.

5620 SAM-E 5620 SAM Element Manager

The 5620 SAM-E provides network element configuration and management 
functionality.

5620 SAM-O Alcatel 5620 SAM Open Interfaces

The 5620 SAM-O provides an XML interface for OSS applications to 
interact with the 5620 SAM.

5620 SAM-P Alcatel 5620 SAM Provisioning

The 5620 SAM-P provides service provisioning functionality.

7450 ESS 7450 Ethernet Service Switch

An Ethernet switch that enables the delivery of metro Ethernet services and 
high-density service-aware Ethernet aggregation over IP/MPLS-based 
networks.

7750 SR 7750 Service Router

The 7750 SR is a router that provides scalable, high-speed private data 
services with SLAs.

802.1D An IEEE standard that specifies a general method for the operation of MAC 
bridges, including the STP.

802.1p An IEEE standard to provide QoS in Ethernet networks. The standard uses 
packet tags that define up to eight traffic classes and allows switches to 
transmit packets based on the tagged priority value.

802.1Q An IEEE standard that defines the operation of VLAN bridges that permit 
the definition, operation, and administration of VLAN topologies within a 
bridged LAN infrastructure.

802.1w An IEEE standard that defines the changes required for the operation of a 
MAC bridge to provide rapid reconfiguration capability.

802.1X 802.1X is the IEEE standard for transmitting EAP authentication messages 
over a LAN. The EAP messages are encapsulated in Ethernet frames and 
transported from the client to be authenticated through the access point, 
which is typically an access port on an edge device, to the authentication 
device, which is typically a RADIUS server. 

A

AAA authentication, authorization, and accounting

The functions of security-based protocols, such as RADIUS, to ensure 
secure communications.
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AAL-5 ATM adaptation layer type 5

AAL-5 supports the conversion of VBR, delay-tolerant, connection-oriented 
traffic such as signaling and control data, and network management data. 
This traffic requires minimal sequencing and minimal error detection 
support.

ABR area border router

A router located on the border of one or more OSPF areas that connects those 
areas to the backbone network. The ABR is considered to be a member of 
the OSPF backbone and the attached areas. The router maintains routing 
tables that describe both the backbone topology and the topology of other 
areas.

ACK acknowledge

ACK represents an acknowledging signal that confirms the receipt of a data 
packet.

ACL access control list

An access control list, which is also known as a filter policy, is a template 
applied to services or ports to control network traffic into (ingress) or out 
(egress) of an SAP or port based on IP and MAC matching criteria. Filters 
are applied to services to examine packets entering or leaving a SAP or 
network interface. An ACL policy can be used on several interfaces. The 
same filter can be applied to ingress traffic, egress traffic, or both.

active An active database or active server is the currently operating system. For 
example, the active server is the system that can read and write to the active 
database. Clients can connect to the active server to provision and view 
network elements.

adjacency An adjacency is the portion of the local routing information that pertains to 
the reachability of a single neighbor end system or intermediate system. A 
separate adjacency is created for each neighbor, and for each level of routing 
on a broadcast circuit.

ADM add/drop multiplexer

A device installed at an intermediate point on a transmission line that enables 
new signals to be added in the line and existing signals to be dropped out of 
the line. Add/drop multiplexing can be done with optical or electrical 
signals.

alarm An alarm is a node-generated message created as a result of an event, such 
as an interface status change.

API application programming interface

An API is a set of programming functions and routines that provides an 
interface to the network for application programs. APIs translate high-level 
program code into low-level computer instructions that run the network. 
Thus, application programs (for example, word processors) can 
communicate with low-level programs handling network data traffic.
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APS automatic protection switching

The capability of a transmission system to detect a failure on a working line 
and to switch automatically to a protection line to recover the traffic.

area In the OSPF protocol, network management and scalability can be 
simplified by partitioning a network into regions. These OSPF network 
regions are called areas. Each area, also called a routing sub-domain, 
maintains detailed routing information about its own internal composition, 
and also maintains routing information which allows it to reach other areas.

ARP address resolution protocol

ARP is a TCP/IP protocol used to convert an IP address into a physical 
address, such as an Ethernet address.

AS AS is expanded two ways:

1 autonomous system

An AS is a collection of routers under one administrative entity that 
cooperates by using a common IGP (such as OSPF). AS is synonymous 
with the ISO term “routing domain”. Routing between autonomous 
systems is done with an inter-AS or interdomain EGP, such as BGP-4.

2 alarm surveillance

AS is an application that receives, stores, displays, and manages 
real-time alarms. The AS tool consists of an IM to receive, filter, and 
store alarms; and a USM to display and manage alarm information.

ASBR autonomous system boundary router

In OSPF, an ASBR is a router that exchanges information with devices from 
other ASs. ASBRs are also used to import routing information about RIP, 
direct, or static routes from non-OSPF attached interfaces.

ATM asynchronous transfer mode

A transport and switching mechanism that employs 53-byte cells as a basic 
unit of transfer. Information is routed through the network in the cell using 
addressing information contained in the header.

AU administrative unit

See AU-N.

AUG administrative unit group

One or more AUs that occupy fixed, defined positions in an STM payload.
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AU-N administrative unit - level N

A managed entity within the SDH structure that is the top of the STM-1 
configuration hierarchy.

AU-3 has the payload pointer for each payload envelope that is consolidated 
with the respective payload in one unit. An STM-1 frame has three payload 
envelopes; therefore, the frame has three AU-3 units. AU-4 applies to the 
entire STM-1 payload. The AU-4 structure is the only AU in an STM-1 
frame.

B

BCP bridging control protocol

A protocol configures, enables, and disables the bridge protocol modules on 
both ends of a point-to-point link.

BER bit error rate

The percentage of bits that have errors relative to the total number of bits 
received in a transmission.

BERT bit error rate tester

BERT is a device that determines the BER on a communication channel.

BGP border gateway protocol

BGP is an IETF standard EGP used to propagate routing information 
between autonomous systems.

BGP-4 border gateway protocol 4

A BGP that supports CIDR addressing, which increases the number of 
available IP addresses.

binding A collection of configuration parameters, including at least an IP address, 
associated with a DHCP client. DHCP servers manage bindings.

BiNOS BATM internetworking operating system

An operating system that supports the administration, management, QoS, 
and security performance requirements of telecommunications networks by 
supporting a wide range of IEEE standards and industry conventions, such 
as ACLs.

 BATM refers to BATM Advanced Communications Ltd.

BOF boot option file

A file that specifies where the device system searches for runtime images, 
configuration files, and other operational parameters during system 
initialization.
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BPDU bridge protocol data unit

BPDU is the frame used by LAN bridges that support 802.1D STP to 
communicate with each other.

bridge Bridges connect two or more network segments which increases the network 
diameter. Bridges also help regulate traffic. They can send and receive 
transmissions but a bridge does not originate any traffic of its own other than 
a special Ethernet frame that allows it to communicate with other bridges. 

broadcast TV See BTV.

BSA broadband service aggregator

A high-speed Ethernet-centric aggregation device supporting hundreds of 
ports, tens of thousands of filter policies, and tens of thousands of queues to 
aggregate subscriber traffic. An example of a BSA is the 7450 ESS.

BSR BSR is expanded two ways:

1 bootstrap router

A BSR is a PIM router that manages RP and group information in a 
multicast network.

2 broadband service router

A BSR terminates L2 access services and routes over IP/MPLS, 
supporting hundreds of ports and sophisticated QoS for services and for 
differentiating content and source. An example of a BSR is the 7750 SR.

BTV broadcast television

The transmission of television signals that are available to all users. This 
television service is used on cable, satellite, and off-air systems.

C

CBR constant bit rate

CBR is an ATM service category that is used to carry traffic characterized 
by a service bit rate specified by a constant value and an evenly-spaced cell 
stream.

CBS committed buffer size

CBSR candidate bootstrap router

A router that is configured as a potential BSR. If the current BSR fails, the 
CBSR participates in an automated BSR election process.

CCA cross-connect adapter

See VSM-CCA .
GL-6 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



Glossary
CCAG cross-connect aggregation group

VSM-CCAs are placed in a CCAG. A CCAG provides a mechanism to 
aggregate multiple CCAs into one forwarding group. The CCAG uses 
conversation hashing to dynamically distribute cross-connect traffic to the 
active CCAs in the aggregation group. In the event that an active CCA fails 
or is removed from the group, the conversation hashing function will 
redistribute the traffic over the remaining active CCAs within the group. The 
conversation hashing mechanism for a CCAG is identical to that used by 
Ethernet LAGs.

CE customer edge

A device with the functionality needed on the customer premises to access 
provider-provisioned services.

cflowd Enabling cflowd allows for the collection and analysis of traffic flow 
samples through a router. It is used for network planning and traffic 
engineering, capacity planning, security, application and user profiling, 
performance monitoring, usage-based billing, and SLA measurement.

cHDLC Cisco HDLC data encapsulation

cHDLC is a Cisco variation of HDLC encapsulation, a bit-oriented 
synchronous data link layer protocol. HDLC specifies a data encapsulation 
method on synchronous serial links using frame characters and checksums. 
cHDLC also uses a control protocol to maintain serial link keepalives. You 
can only configure Cisco HDLC on IES SAPs.

CIDR classless interdomain routing

An address aggregation process that simplifies routing.

CIR committed information rate

The CIR is the guaranteed minimum rate of throughput between two 
end-user devices over a network under normal operating circumstances. This 
rate, measured in bits or kb/s, is used in congestion control procedures.

circuit A circuit is a communications connection between two points. It has a line 
interface from which it transmits and receives data and signaling. A circuit 
is also known as a port, channel, or timeslot. An electronic circuit is one or 
more electronic components connected together to perform a specific 
function.

CLI command line interface

The CLI is an interface that allows the user to interact with the operating 
system by typing alphanumeric commands and optional parameters at a 
command prompt. UNIX provides a CLI.

CMAS confederation member autonomous system

A subdivision of an AS that is recognized only by other peers within the 
confederation. Within the confederation, each BGP peer treats only the peers 
in its CMAS as internal peers. Peers in different CMASs are treated as 
external peers.
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confederation In BGP, a confederation is an AS that has been subdivided into smaller ASs 
called CMASs. A confederation appears to be a single AS to other ASs and 
is recognized only by other confederation members.

CoS class of service

CoS is the degree of importance assigned to traffic. There are standard and 
premium classes of services. During queuing and forwarding, service points 
give preferential treatment to traffic that originates on elements configured 
for premium CoS.

CPE customer premises equipment

Network equipment that resides on the customer’s premises.

CPM central processor module

The dual CPU control plane module is dedicated for system control, 
centralized protocol processing, and management.

CPU central processing unit

CRC cyclic redundancy check

CRC checks transmission errors applied to a block of information. CRC 
involves a bit string (computed from the data to transmit) associated with 
each transmitted block, and ensures the check on reception.

C-RP candidate rendezvous point

A router that is configured as a potential RP. If the current RP fails, the C-RP 
participates in an automated RP election process.

CSNP complete sequence number PDU

A PDU sent by a designated router to ensure database synchronization.

CSPF constrained shortest path first

CSPF is a component of constraint-based routing that uses a TED to find the 
shortest path through an MPLS domain that meets established constraints. 
The ingress router determines the physical path for each LSP by applying the 
CSPF algorithm to the information in the TED. Input into the CSPF 
algorithm includes topology link-state information learned from the IGP, 
administrative attributes for the LSP (such as bandwidth requirements, 
maximum hop count, and administrative policy requirements), and 
network-resource attributes (such as total link bandwidth, reserved link 
bandwidth, available link bandwidth, and link color) that are carried by IGP 
extensions and stored in the TED.

As CSPF considers each candidate node and link for a new LSP, it either 
accepts or rejects a specific path component based on resource availability 
and whether selecting the component violates user policy constraints. The 
output of the CSPF calculation is an explicit route consisting of a sequence 
of router addresses that provides the shortest path through the network which 
meets the constraints. This explicit route is then passed to the signaling 
component, which establishes forwarding states in the routers along the LSP.
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CSU channel service unit

CSV comma separated value

CSV is a way of recording parameters and values in text format, with each 
value followed by a comma.

D

DB database

A collection of data that is organized so that its contents can be easily 
accessed, managed, and updated.

demultiplexer A device that separates signals that have been combined as a single signal by 
a multiplexer for transmission over a communications channel.

de-mux See demultiplexer.

DES data encryption standard

An unclassified U.S. government-sanctioned encryption and decryption 
technology that uses 56-bit encryption, with 8-bit error detection.

destination SAP See DSAP.

device A generic term for a network element such as a router, switch, or bridge.

DHCP dynamic host configuration protocol

An Internet protocol to automate the configuration of computers that use 
TCP/IP. The DHCP can be used to automatically assign IP addresses, deliver 
TCP/IP stack configuration parameters such as the subnet mask and default 
router, and provide other configuration information such as the addresses for 
printer, time, and news servers.

DHCP client An Internet host that uses DHCP to obtain configuration parameters, such as 
a network address, from a DHCP server.

DHCP relay DHCP relay allows a router to intercept a DHCP broadcast packet and 
forward the packet to a specific DHCP server.

DHCP relay agent A router used to interconnect DHCP clients with a DHCP server that is 
connected to another LAN segment or network. A DHCP relay agent can 
also be used to insert client circuit information.

DHCP server A server that stores network addresses and delivers configuration parameters 
to DHCP clients.

DHCP snooping DHCP snooping provides network security by monitoring and analyzing 
DHCP messages from hosts outside the managed network that can cause 
traffic attacks within the managed network. DHCP snooping builds and 
maintains a binding table that contains information such as MAC addresses 
and IP addresses that correspond to the hosts that are connected from outside 
the managed network.
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Dijkstra Routing algorithm used by ISIS and OSPF that uses the length of path to 
determine a shortest-path spanning tree. Sometimes also called SPF.

DLC data link control

A transport protocol used to communicate with mainframes.

DLCI data link connection identifier

DLCI is a 10-bit routing address of the virtual circuit at either the UNI or the 
NNI. DLCI allows the user and network management to identify the frame 
as being from a particular PVC. The DLCI is used for multiplexing several 
PVCs over one physical link.

DP drop precedence

Attribute of a packet which affects the probability of the packet being 
dropped within a CoS.

DR designated router

A DR is a PIM-enabled router that manages multicast stream delivery for a 
group of receiver hosts in a multicast network. DRs exchange information 
regarding multicast sources and dynamically adjust to changes in source 
availability.

DSAP destination service access point

DSCP differentiated services code point

A six-bit value encoded in the type of service field of an IP packet header, 
which identifies CoS and the DP the packet receives.

DSLAM digital subscriber line access multiplexer

DS-N digital signal - level N

A digital signaling rate of N Mb/s; for example, the DS-1 rate is 1.544 Mb/s.

DU downstream unsolicited

An MPLS LDP technique, where LSRs distribute bindings to LSRs that have 
not explicitly requested them.

DVD digital versatile disc

An optical digital disc that stores up to 4.7 Gbytes of data. A DVD can be 
recorded on both sides and in dual layers.

DVD-ROM digital versatile disc - read-only memory

A read-only DVD that is used to store data and software, as well as audio and 
video content.

dynamic host A host that is temporarily configured on the SAP. The 5620 SAM learns 
dynamic hosts when the DHCP lease populate function is enabled.
GL-10 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



Glossary
E

E1 A European standard for high-speed voice and data transmission at 
2.048 Mb/s.

E3 A wide-area digital transmission scheme used predominantly in Europe that 
carries data at a rate of 34.368 Mb/s. E3 lines can be leased for private use 
from common carriers.

EAP extensible authentication protocol

EAP provides a generalized framework for different types of authentication 
methods. This allows access devices to hand off authentication packets to an 
authentication system, such as a RADIUS server, without knowing the 
authentication method used.

EBGP exterior border gateway protocol

A BGP session established between routers in different ASs. EBGPs 
communicate among different network domains.

e-BGP See EBGP.

ECMP equal-cost multipath

EGP exterior gateway protocol

A generic term for a routing protocol that is used to exchange routing 
information between two hosts in a network of ASs. An EGP is typically 
used between hosts on the Internet to share routing table information.

EIC equipment ID code

encapsulation Encapsulation is the addition of information to the beginning and end of 
data. Encapsulation is used by layered network protocols as data moves from 
one stack down to the next. Header and trailer information is added to the 
data at each layer. Encapsulation is also used to bridge connections between 
different types of networks.

EtherType A field in the Ethernet frame header that is used to indicate the version of 
Ethernet protocol.

EXP experimental

A field in the MPLS packet header.

F

failover Failover is the process of changing the roles of a redundant system, for 
example, when the standby database takes over the role of a failed active 
database. A failover is irreversible.

Fast Ethernet A LAN transmission standard that provides a data rate of 100 Mb/s.
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fault A fault is a failure or defect in a network, causing the network, or part of the 
network, to malfunction.

FC flow control

Flow control is the procedure that shuts down transmission when a receiving 
workstation is unable to store the data it is receiving.

FCAPS fault management, configuration, administration, performance, and security

The major functional areas for network and element configuration and 
management.

FEC forwarding equivalency class

A group of IP packets which are forwarded in the same manner, for example, 
over the same path, with the same forwarding treatment.

FIB forwarding information base

FIB is the set of information that represents the best forwarding 
information—for example, next IP hop—for each destination (or set 
thereof). The entries in the FIB are derived from the reachability information 
held in the RIB, subject to administrative routing.

FIC frame ID code

flash memory A rewritable memory chip that retains its content without power.

forwarding class A forwarding class, also called a CoS, provides to network elements a 
method to weigh the relative importance of one packet over another in a 
different forwarding class. Each forwarding class is important only in 
relation to other forwarding classes.

Queues are created for a specific forwarding class to determine the manner 
in which the queue output is scheduled into the switch fabric and the type of 
parameters the queue accepts. The forwarding class of the packet, along with 
the in-profile or out-of-profile state, determines how the packet is queued 
and handled (the per-hop behavior at each hop along its path to a destination 
egress point).

FR frame relay

A standard for high-speed data communications that offers users 
transmission speeds of at least 2.048 Mb/s. Its main application is 
interconnecting LANs.

FTP file transfer protocol

FTP is the Internet standard client-server protocol for transferring files from 
one computer to another. FTP generally runs over TCP or UDP.

G

Gig Gigabit
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Gigabit Ethernet An Ethernet interface with a peak data rate of 1000 Mb/s.

Gig Ethernet See Gigabit Ethernet.

GR graceful restart

Many Internet routers implement a separation of control and forwarding 
functions. These routers can continue to forward data while the control 
software is restarted or reloaded. This function is called graceful restart. A 
successful graceful restart requires the use of a GR helper.

GRE generic routing encapsulation

A protocol for the encapsulation of an arbitrary network-layer protocol over 
another arbitrary network-layer protocol.

GR helper graceful restart helper

A GR helper is a neighboring router that is configured to cooperate during a 
graceful restart. The GR helper monitors the network topology for any 
changes and, if there are none, advertises that the router performing the 
graceful restart is still active.

GUI graphical user interface

A GUI is a computer user interface that incorporates graphics to make 
software easier to use.

H

HP OpenView Hewlett-Packard OpenView 

HP OpenView is a network management platform used primarily for 
managing SNMP nodes.

HP OpenView NNM Hewlett-Packard OpenView Network Node Manager 

HP OpenView NNM is a graphical management application for SNMP LAN 
nodes.

HQoS hierarchical quality of service

HQoS provides the ability to rate limit across multiple queues from either 
single or multiple access interfaces for a given customers.

HTTP hypertext transfer protocol

A set of rules for exchanging text, graphics, sound, video, and other 
multimedia files on the Web.

HTTPS secure hypertext transfer protocol

A protocol built into a Web browser that provides encryption and decryption 
of Web page requests and responses. Also known as HTTP over SSL.

HVPLS hierarchical virtual private LAN service
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I

IBGP interior border gateway protocol

IBGP is a type of BGP used within a single AS. IBGP is a protocol for 
exchanging routing information between gateways within an autonomous 
network. The routing information can then be used by IP or other network 
protocols to specify how to route packets.

ICMP Internet control message protocol

ICMP is a protocol that sends and receives the control and error messages 
used to manage the behavior of the TCP/IP stack. ICMP is defined in 
RFC 792.

ID identifier

IEEE Institute of Electrical and Electronics Engineers

IES Internet enhanced service

IES is a routed connectivity service where the subscriber communicates with 
an IP router interface to send and receive Internet traffic. An IES has one or 
more logical IP router interfaces, each with a SAP which acts as the access 
point to the subscriber network. IES allows customer-facing IP interfaces to 
participate in the same routing instance used for service network core 
routing connectivity. IES services require that the IP addressing scheme 
used by the subscriber be unique between other provider addressing schemes 
and possibly the entire Internet.

While the IES is part of the routing domain, the usable IP address space may 
be limited. This allows a portion of the service provider address space to be 
reserved for service IP provisioning, and be administered by a separate but 
subordinate address authority.

IP interfaces defined within the context of an IES service must have a SAP 
associated as the access point to the subscriber network. Multiple IES 
services are created to segregate subscriber-owned IP interfaces.

IETF Internet Engineering Task Force

The IETF is the organization that provides coordination of standards and 
specifications developed for IP network and related protocols.

IGMP Internet group management protocol

IGMP is an extension to the Internet protocol, used by IP hosts to report their 
host group memberships to neighboring multicast routers.

IGMP snooping IGMP snooping enables a device to listen to IGMP messages to identify 
users that are members of multicast groups. The device forwards the 
multicast packets to the appropriate users and prevents users that are not in 
the specified groups from receiving the packets. 
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IGP Interior gateway protocol

Generic term applied to any protocol used to propagate network reach and 
routing information within autonomous system.

I/O input/output

Connections between a system and its controlled devices (output) and 
incoming statuses (input).

IOM input/output module

In the 7750 SR architecture, a board that contains two independent data 
paths, with each path connected to an MDA. IOMs implement IP and MPLS 
functions.

I/O module See IOM.

IP Internet protocol

IP is the network layer for the TCP/IP protocol suite. It is a connectionless, 
best-effort packet-switching protocol defined by the IETF.

IPCP Internet protocol control protocol

A protocol that establishes and configures IP over PPP. Elements of IPCP 
include packet encapsulation, code fields, and timeouts.

IP precedence A three-bit field in an IP packet header which is used to identify the level of 
service a packet receives in the network. IP precedence bits are the least 
significant bits in a DSCP value.

IPX internetwork packet exchange

The network-layer protocol in the NetWare operating system. It contains a 
network address and allows messages to be routed to a different network or 
subnet.

IS intermediate system

This term is used interchangeably with router.

IS-IS See ISIS.

ISIS intermediate system to intermediate system

ISIS is an ISO standard link-state routing protocol. Integrated ISIS allows 
ISIS to be used for route determination in IP networks.

ISO International Standards Organization

ITU-T International Telecommunication Union - Telecommunication 
Standardization Sector
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J

Java An object-oriented programming language developed by Sun Microsystems 
for portable, interpretive code that supports interaction among disparate 
objects.

JMS Java Message Service

JMS is an API that combines Java technology with enterprise messaging. 
The JMS API defines a common set of interfaces for creating applications 
for reliable asynchronous communication among components in a 
distributed computing environment, so that the applications are portable 
across different enterprise systems.

JRMP Java remote method protocol

A proprietary wire-level protocol designed by Sun Microsystems to 
transport Java RMI.

L

L2 Layer 2

The data link or MAC layer of the OSI model. In networking, it is a 
communications protocol that contains the physical address of a client or 
server station that is inspected by a bridge or switch.

L3 Layer 3

The network layer of the OSI model. In networking, it is a communications 
protocol that contains the logical address of a client or server station that is 
inspected by a router, which forwards the address through the network. L3 
contains a type field so that traffic can be prioritized and forwarded based on 
the message type as well as the network destination.

LACP link aggregation control protocol

LACP is used to detect whether all local members of a LAG are physically 
connected to the remote ports that are part of the far end of the LAG.

LAG link aggregation group

A LAG increases the bandwidth available between two nodes by grouping 
up to eight ports into one logical link. The aggregation of multiple physical 
links allows for load sharing and offers seamless redundancy. If one of the 
links fails, traffic is redistributed over the remaining links. Up to eight links 
can be supported in a single LAG, and up to 64 LAGs can be configured on 
a node.

LAIS line alarm indication signal
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LAN local area network

A LAN is a group of computers or associated devices that share a common 
communications line and typically share the resources of a single processor 
or server within a small geographic area, for example, within an office 
building.

Layer 2 See L2.

Layer 3 See L3.

LDP label distribution protocol

LDP is a signaling protocol used for MPLS path setup and teardown. An 
LDP is used by LSRs to indicate to other LSRs of the meaning of labels used 
to forward traffic. LDP is defined in RFC 3036.

lease For DHCP, the amount of time that a given IP address is valid for a 
computer.

LED light-emitting diode

LER label edge router

An LER is a router at the edge of a service-provider network that forwards 
IP packets using LSPs.

level 1 and level 2 
intermediate system

These systems deliver and receive NPDUs from other systems, and relay 
NPDUs from other source systems to other destination systems. Level 1 
systems route directly to systems within their own area, and route towards a 
level 2 system. A level 2 systems route towards another destination area or 
another routing area. Level 2 systems constitute the IS-IS backbone area.

LFI Link Fragmentation and Interleaving

LFI interleaves high priority traffic within a stream of fragmented lower 
priority traffic. LFI helps avoid excessive delays to high priority, 
delay-sensitive traffic over a low-speed link.

LIC location ID code

LLC logical link control

LLC is the upper sublayer of the ISO model data link layer. LLC governs 
packet transmission as specified by IEEE 802.2.

load balancing Load balancing is the distribution of network traffic among the ports by a 
device so that no single port is overwhelmed, and network bandwidth is 
optimized.

LOC loss of clock

LOF loss of frame

LOS loss of signal
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LPE logical provider edge

A set of devices in a provider network that implement the functionality of a 
service, such as VPLS.

LRDI line remote defect indication

LSA link state advertisement

LSA describes the local state of a device or network, including the state of 
the device’s interfaces and adjacencies. Each LSA is flooded throughout the 
routing domain. The collected LSAs of all devices and networks form the 
protocol’s topological database.

LSP label switched path

LSPs support MPLS functionality and allow network operators to perform 
traffic engineering. There are two types of LSPs:

• static LSP
A static LSP specifies a static path. All devices that the LSP traverses 
must be configured manually with labels. No signaling is required.

• signaled LSP
A signaled LSP is an LSP that is set up using a signaling protocol. The 
signaling protocol allows labels to be assigned from an ingress router to 
an egress router. Signaling is triggered by the ingress router. Only the 
ingress router, and not the intermediate routers, must be configured. 
Signaling also facilitates path selection.

LSP path A LSP associated with an MPLS path. This path could be an actual route, or 
a configured route. A configured route can be primary, secondary, or 
standby. An LSP could have at most one actual route, one primary route, and 
multiple standby or secondary routes.

LSR label switched router

An LSR is an MPLS node that runs MPLS control protocols and is capable 
of forwarding packets based on labels. An MPLS node may also be capable 
of forwarding native Layer 3 packets.

M

MAC media access control

MAC is a sublayer of the data link layer, defined in IEEE 802.2 
specifications that accesses the LAN medium. The MAC layer handles the 
recognition and identification of individual network devices. Every 
computer and network node has a MAC address that is hardware-encoded.

MAC pinning MAC pinning is a restriction on a MAC entry in the MAC forwarding table 
such that it cannot be relearned on another port within the lifetime of the 
entry. The entry can still age.

MAF management access filter
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MAN metropolitan area network

A telecommunications network that covers a geographic area such as a city 
or suburb.

MD5 message digest 5

MD5 is a security algorithm that takes an input message of arbitrary length 
and produces as an output a 128-bit message digest of the input. MD5 is 
intended for digital signature applications, where a large file must be 
compressed securely before being encrypted.

MDA media dependent adaptor

MDA is a pluggable interface module that distributes traffic between the 
network and the system IOM. Also referred to as a daughter card.

MDCR minimum desirable cell rate

MDCR is equivalent to MIR.

MDL message data link

A data transmission path that is used to communicate identification or test 
signal information at the data link layer.

MDT multicast distribution tree

An MDT is a group of network paths in a multicast domain that originate at 
a common multicast source and terminate at CE devices.

MED multi-exit discriminator

An attribute that is used by an external AS to determine the preferred route 
into the AS that is advertising the attribute.

menu bar The menu bar is a tool on the GUI that organizes tasks across broad 
headings. You can perform functions on the application by selecting an 
action from the menu bar.

MIB management information base

A formal description of a set of network objects that can be managed using 
SNMP.

MIR minimum information rate

MIR is the minimum data transfer rate for a path, such as a frame relay, VPC, 
or VCC path.

MP-BGP multiprotocol border gateway protocol

An enhanced BGP that carries IP multicast routes. MP-BGP carries two sets 
of routes: one set for unicast routing and one set for multicast routing. The 
routes associated with multicast routing are used by PIM to build multicast 
data distribution trees.
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MPLS multiprotocol label switching

MPLS is a technology in which forwarding decisions are based on 
fixed-length labels inserted between the data link layer and network layer 
headers to increase forwarding performance and flexibility in path selection.

MRRU maximum received reconstructed unit

MRRU is the maximum frame size that can be reconstructed from multilink 
fragments.

MSTP multiple spanning tree protocol

An RSTP that allows different spanning trees to co-exist on the same 
Ethernet switched network.

MTU maximum transmission unit

MTU is the largest unit of data that can be transmitted over a particular 
interface type in one packet. The MTU can change over a network.

multicast routing Multicast routing delivers source traffic to multiple receivers without any 
additional burden to the source or the receivers. Multicast packets are 
replicated in the network by routers that are enabled with PIM, which results 
in the efficient delivery of data to multiple receivers.

Multicast routing is based on an arbitrary group of receivers that expresses 
an interest in receiving a particular data stream. The group does not have 
physical boundaries—the hosts can be located anywhere on the Internet. The 
hosts must join the group using IGMP in order to receive the data stream.

MVPLS management virtual private LAN service

An MVPLS is created to run RSTP and manage traffic on the associated 
VPLSs. An MVPLS is required to remove topology loops when redundant 
spoke SDPs or L2 access interfaces have been created for HVPLS 
configurations. RSTP must be run on the redundant spoke SDPs or L2 access 
interfaces to block some of them from passing traffic. VPLSs that have 
redundant spoke SDPs or L2 access interfaces that are managed by the 
MVPLS also have their traffic blocked appropriately.

MVR multicast VLAN registration

MVR allows a single multicast VLAN to be shared in a network while 
subscribers remain in separate VLANs. This provides the continuous 
distribution of multicast streams in the multicast VLAN, and bars 
subscribers from streams that they should not access. MVR and IGMP 
snooping are used on Telco devices to provide multicast BTV services.

N

navigation tree The navigation tree displays a view of all managed equipment, services, and 
protocols, and allows you to navigate through these components.
GL-20 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



Glossary
NE network element

A physical device in the network, such as a 7750 SR router, or a switch, such 
as the 7670 RSP.

neighbor An adjacent system reachable by traversing a single sub-network by a PDU

networkstation A UNIX platform where the 5620 SAM software runs.

network topology A network topology is the layout of a network, which can include the way in 
which elements in a network, such as nodes, are connected and how they 
communicate.

NIST National Institute of Standards and Technology

NMS network management system

A system that manages at least part of a network. An NMS is generally a 
reasonably powerful and well-equipped computer such as an engineering 
workstation. The NMS communicates with agents to help keep track of 
network statistics and resources.

NNI NNI is expanded two ways:

1 network-to-network interface

An NNI is a standard interface between two ATM nodes or two frame 
relay nodes.

2 network node interface

NNI is the interface between two ATM network nodes that operate under 
different administrative domains, such as a vendor ATM switch and an 
ATM switch from another vendor.

NOC network operations center

NPDU network protocol data unit

A packet of data at the network layer of the OSI model.

nrt-VBR non real-time variable bit rate

nrt-VBR is an ATM service category that guarantees low cell loss and low 
delay for applications, such as video and frame relay, which are 
characterized by an on/off source with known, predictable transmission 
patterns. During the on period, cells are transmitted at the peak information 
rate. No cells are transmitted during the off period. nrt-VBR allows 
statistical multiplexing gains using the traffic descriptors (PCR and SCR). It 
does not provide delay commitments.

NSSA not-so-stubby-area

NSSA is an OSPF area type where OSPF propagates any external routes that 
it obtains from the AS.

NTP network time protocol

Internet protocol used to synchronize time between network equipment.
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O

OAM operations, administration, and maintenance

A general term used to describe the costs, tasks involved, or other aspects of 
operating, administering, and managing a telecommunications network. The 
5620 SAM provides a series of OAM tools to monitor and administer the 
network.

OC-N Optical Carrier - level N

An optical SONET signal carried at the speed of N, for example, OC-12 is a 
signal at 622.08 Mb/s.

Option 82 See Relay Information Option

ORF outbound route filtering

ORF is used to reduce the amount of time required to filter routes from a 
BGP peer.

OS operating system

OSI Open Systems Interconnection

A reference model of protocols organized in seven layers. OSI standards and 
applications facilitate the interworking of equipment from different 
manufacturers.

OSPF open shortest path first

OSPF is an IETF standard link-state routing protocol used to determine the 
most direct path for a transmission in IP networks.

OSS operational support system

A network management system supporting a specific management function, 
such as alarm surveillance and provisioning, in a service provider network.

OUI organizationally unique identifier

A three-octet field in a SNAP header that identifies an organization.

P

PAE port access entity

A logical entity that supports the IEEE 802.1X protocol that is associated 
with a port.

PAP password authentication protocol

A protocol to communicate with a security server for a user authentication.
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PC personal computer

A low-cost, standalone data-processing installation designed for a single 
user.

PCR peak cell rate 

PCR is the cell rate, in cells per second, that the endpoint may never exceed. 

PDF portable document format

The file format in Adobe Acrobat document exchange technology.

PDH plesiochronous digital hierarchy

A technology used in telecommunications networks to transport large 
quantities of data over digital transport equipment such as fiber optic and 
microwave radio systems.

PDU protocol data unit

A PDU is a message of a given protocol comprising payload and 
protocol-specific control information, typically contained in a header. PDUs 
pass over the protocol interfaces which exist between the layers of protocols, 
as indicated in the OSI model.

PE provider edge

The name of the device or set of devices at the edge of the provider network 
with the functionality that is needed to interface with the customer and with 
the MPLS network. A PE can be a router or a switch. All the MPLS tunnels 
are set up and terminated in the PE. All VPN functionalities reside in the PE.

PHB per-hop behavior

An IETF standard term for CoS plus DP.

PID protocol identification

A two-octet field in a SNAP header that specifies the protocol type.

PIM protocol independent multicast

Multicast routing architecture that allows the addition of IP multicast routing 
on existing IP networks. PIM is unicast routing protocol independent and 
can be operated in two ways—dense and sparse.

PIR peak information rate

The PIR is the peak data transfer rate for a path, such as a frame relay, VPC, 
VCC, or DE service path. The PIR is the PCR converted to kb/s.

PKI public key infrastructure

PKI represents the set of hardware, software, people, policies and 
procedures needed to create, manage, store, distribute, and revoke public key 
certificates based on public-key cryptography. 
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POS packet over SONET

A technology that allows IP packets to be sent directly over SONET/SDH 
frames.

PPP point-to-point protocol

PPP is a protocol for communication between two computers using a serial 
interface, typically a PC connected by phone line to a server. PPP uses the 
IP. It is considered as a member of the TCP/IP suite of protocols.

pseudowire A mechanism that emulates the essential attributes of a service such as 
ATM, frame relay, or Ethernet over a packet-switched network.

PVC permanent virtual circuit

A PVC is an ATM end-to-end logical connection that extends between two 
user/network interfaces. A single PVC may pass through several ATM 
switching nodes.

PVP permanent virtual path

A permanent ATM connection that is used to carry one or more PVCs.

PW See pseudowire.

Q

Q in Q Q in Q is a type of Ethernet encapsulation in which a second 802.1Q VLAN 
tag is added to an 802.1Q frame. Service providers can then use VLAN IDs 
to segregate customer services and still allow customers to assign their own 
VLAN IDs without the possibility of ID duplication.

QoS quality of service

QoS is a term for the set of parameters and their values that determine the 
performance of a virtual circuit. This service level is usually described in a 
network by delay, bandwidth, and jitter.

R

RADIUS remote authentication dial-in user service

A remote user authentication, authorization, and accounting protocol.

RD route distinguisher

A BGP eight-byte field that allows a user to create distinct routes to a 
common IPv4 address prefix.
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RED random early detection

RED is an algorithm that detects and avoids traffic congestion in a 
packet-switched network. Incoming congestion is detected by calculating 
the average queue size. If the gateway decides that the average queue size 
exceeds a predetermined threshold, it either randomly drops packets arriving 
at the gateway or sets a bit in the packet headers. The packet transmission 
rate is reduced until all the packets reach their destination.

Relay Information 
Option

The Relay Information Option is defined in RFC 3046 and allows a DHCP 
relay agent to append to the relayed DHCP request information that 
identifies from where the originating DHCP request was sent. 

RFC request for comments

Documents that describes the specifications of a technology. RFCs are used 
by the IETF and other standards bodies.

RIB routing information base

Router database containing the routing information required to forward 
packets.

RIP routing information protocol

RIP is a Bellman-Ford routing protocol based on distance vector algorithms 
that measure the shortest path between two points on a network in terms of 
the number of hops between those points. Various forms of RIP are used to 
distribute routing information in IP, XNS, IPX, and VINES networks.

See also OSPF.

RJ-45 registered jack 45

A telephone connector that holds up to eight wires. RJ-45 plugs and sockets 
are used in Ethernet and Token Ring Type 3 devices.

RMI remote method invocation

A standard from Sun Microsystems for distributed objects written in Java. 
RMI is a remote procedure call that allows Java objects (software 
components) stored in the network to be run remotely.

root bridge The bridge with the highest priority ID, selected as the root in a spanning 
tree.

route flapping A routing problem caused by network problems where an advertised route 
between two devices changes back and forth between two different paths.

router A router is an interface device that connects two networks. It maintains 
configuration tables and uses various network protocols to select 
cost-effective routes that move data between a source and destination 
device. Also called a device.

routing instance A routing instance is the configuration of a router, including information 
such as protocols, interfaces, routing, and policies.
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routing protocol A routing protocol is used to determine the correct route for packets within 
IP and IP/MPLS networks.

RP rendezvous point

An RP is a PIM-enabled router that is elected by PIM as a central distribution 
source for multicast groups in a multicast domain.

RPF reverse path forwarding

A mechanism used by PIM to forward multicast packets down a distribution 
tree.

RSHG residential split horizon group

A type of SHG with dual-pass queue optimization. Downstream broadcast 
or multicast traffic are not supported. SAPs associated with an RSHG are 
lightweight SAPs.

RSTP rapid spanning tree protocol

RSTP is an enhanced version of STP, as defined in IEEE standard 
802.1w-2001 and incorporated in IEEE standard 802.1D-2004. RSTP 
supersedes STP for standards conformance. RSTP provides faster automatic 
reconfiguration for route failures than STP by facilitating a rapid change in 
port roles.

RSVP resource reservation protocol is used two ways:

1 RSVP is the process of reserving network and host resources to achieve 
a QoS for an application.

2 RSVP is an IP-based protocol that is used for communicating 
application QoS requirements to intermediate transit nodes in a network. 
RSVP uses a soft-state mechanism to maintain path and reservation state 
in each node in the reservation path.

RT route target

In BGP/MPLS VPNs, an RT is an attribute that identifies a set of sites.

rt-VBR real-time variable bit rate

rt-VBR is a variant of the VBR service category available only for VPC 
paths and VCC paths. It allows statistical multiplexing gains using the traffic 
descriptors (PCR and SCR). The rt-VBR service provides delay 
commitments. rt-VBR supports variable bit rate traffic with sustained and 
peak traffic parameters that require strict delay control, such as packetized 
voice or video.

An rt-VBR is an ATM service category that guarantees very low cell loss 
and very low delay for time-sensitive applications such as voice and video, 
which are characterized by unpredictable, bursty transmission patterns.

rt-VBR is a variant of the VBR service category that is only available for 
VPC and VCC paths. nrt-VBR is the other variant of VBR available for these 
paths. 
GL-26 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



Glossary
S

SAP service access point

A SAP is a point of communication exchange between an application and the 
LLC or between layers of software.

SC service component

An SC is a subscriber service that is a component of a composite service.

SCP service connection point

An SCP is a type of connector endpoint in a composite service. It can be a 
SAP, service interface, or network port, depending on the device.

SCR sustainable cell rate

An upper bound on the conforming average rate of an ATM connection over 
time scales that are long relative to those for which the PCR is defined.

SDH synchronous digital hierarchy

SDH is a hierarchical set of digital transport structures, standardized for the 
transport of suitably adapted payloads over physical transmission networks. 
SDH is a standard for communicating digital information over optical fiber 
and microwaves. SDH was developed to replace the PDH system for 
transporting large amounts of telephone and data traffic.

SDP service distribution path

The 5620 SAM uses this term interchangeably with service tunnel.

service mirror A service mirror is a type of service in which the packets that are associated 
with a particular subscriber service are copied, or mirrored, to a second 
destination for troubleshooting or surveillance purposes.

service tunnel A service tunnel acts as a logical way of unidirectionally directing traffic 
from one device to another device. The service tunnel is provisioned to a 
specific encapsulation method, for example, GRE, and the services are 
mapped to the service tunnel.

SFP small form factor pluggable

A high-speed, compact, and hot-swappable optical modular transceiver.

SHA secure hash algorithm

A NIST standard hash algorithm, also known as SHA-1.

SHG split horizon group

A group of SAPs or spoke SDPs. Members of the group cannot send traffic 
to each other. 
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SLA service-level agreement

An SLA is a service contract between a network service provider and a 
subscriber that guarantees a particular QoS. SLAs are used for providing 
network availability and data-delivery reliability.

SLOF section loss of frame

SLOS section loss of signal

SMTP simple mail transfer protocol

A TCP/IP protocol used to send and receive e-mail.

SNAP subnetwork access protocol

An Internet protocol that operates between a network entity in the 
subnetwork and a network entity in the end system. The SNAP specifies a 
standard method of encapsulating IP datagrams and ARP messages on IEEE 
networks. The SNAP entity in the end system uses the subnetwork services 
and performs three key functions: data transfer, connection management, 
and QoS selection.

sniffer A sniffer is a software tool that is used to monitor and analyze network 
traffic for troubleshooting or surveillance purposes.

SNMP simple network management protocol

A protocol used for the transport of network management information 
between a network manager and a network element. SNMP is the most 
commonly used standard for most interworking devices.

SNMP trap An SNMP trap is an unsolicited notification that indicates that the SNMP 
agent on the node has detected a node event, and that the network 
management domain should be aware of the event. SNMP trap information 
typically includes alarm and status information, and standard SNMP 
messages.

SNTP simple network transmission protocol

SOAP simple object access protocol

An XML-based protocol for the exchange of information in a decentralized, 
distributed environment.

Solaris The name for the UNIX operating system variant developed by Sun 
Microsystems.
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SONET synchronous optical network

SONET is an ANSI standard for fiber optic transmission of high-speed 
digital traffic. SONET allows internetworking of transmission products 
from multiple vendors and defines a physical interface, optical line rates 
known as OC signals, frame format, and an OAM protocol. The base rate is 
51.84 Mb/s (OC-1), and higher rates are multiples of the base rate.

SONET uses synchronous high-speed signals and provides easy access to 
low-speed signals by mapping them into VTs.

SONET is a North American standard that is technically consistent with 
SDH, which is international.

SPF shortest path first

SPF is an algorithm used by IS-IS and OSPF to make routing decisions 
based on the state of network links.

spoofing A technique used to gain unauthorized access to devices, whereby the 
intruder sends messages using a source IP address that appears to come from 
a trusted host.

SSAP source service access point

SSH secure shell

The SSH protocol is used to protect communications between two hosts by 
encrypting a Telnet or FTP connection between the 5620 SAM and some 
nodes. 5620 SAM uses SSH version 1.5. Both ends of the client/server 
connection are authenticated, and passwords are protected by being 
encrypted. 

SSL secure socket layer

The SSL is a protocol developed by Netscape for transmitting private 
documents via the Internet. Many Web sites use the protocol to obtain 
confidential user information, such as credit card numbers. It is also used for 
data encryption, server authentication, and message integrity between 
5620 SAM server and clients.

SSLF section synchronization line failure

SSM source-specific multicast

An extension of PIM that enables a receiving client to obtain content directly 
from the source rather than from the shared RP.

standby A standby database or standby server is the operating system not currently 
operating, but providing protection for the active system. For example, the 
standby server is a system that can read and write to the active database, 
however, it is in standby mode, and ignores events from the network. Clients 
cannot connect to the standby server.

static host See static subscriber host.

static subscriber host A host that is configured directly on the SAP.
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statistics Statistics are the quantitative data collected in the 5620 SAM, which 
includes equipment statistics and network alarm statistics.

STM-N synchronous transport module - level N

An SDH signal carried at the speed of N, for example STM-4 is a signal at 
622.08 Mb/s.

STP spanning tree protocol

The STP is specified in IEEE 802.1D. This protocol automatically ensures a 
loop-free topology in any interconnection of Ethernet LAN or WAN 
devices.

STS synchronous transport signal

The electrical equivalent of the SONET optical signal. In SDH, STS is 
known as STM.

subscriber A subscriber is a customer who buys services from a network provider.

switch Switches are Layer 2 devices that make it possible for several users to send 
information over a network at the same time without slowing each other 
down. Switches allow different nodes of a network to communicate directly 
with one another in an efficient manner. 

switchover Switchover is the process of switching the roles of a redundant system, for 
example, switching the roles of an active and standby database. A 
switchover is reversible.

T

T1 A 1.544-Mb/s point-to-point dedicated digital circuit provided by the 
telephone companies in North America.

TACACS+ terminal access controller access control system

A remote user authentication, authorization, and accounting protocol.

TAF time-average-factor

Specifies a weight factor between the previous shared buffer average 
utilization and current shared buffer instantaneous utilization when a new 
shared buffer average utilization is calculated.

TCP transmission control protocol

TCP is a protocol used, along with the IP, to send data in the form of message 
units between computers over the Internet. While IP takes care of handling 
the actual delivery of the data, TCP takes care of keeping track of the 
individual units of data (called packets) that a message is divided into for 
efficient routing through the Internet.
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TDM time division multiplexing

Multiplexing in which a separate periodic time interval is allocated to each 
tributary channel in a common aggregated channel.

TED traffic engineering database

A TED is a database used by CSPF for storing route constraint information.

telco telephone company

A company that provides local, or local and long distance telephone 
services.

Telnet Telnet is the Internet-standard TCP/IP protocol for remote terminal 
connection service. It allows a user at one site to interact with a remote 
timesharing system at another site as if the user’s terminal connected directly 
to the remote machine.

The Telnet command and program are used to log in from one Internet site 
to another. It gets the user to the login prompt of another host.

tiered architecture Tiered architecture refers to the way in which the GUI and the network 
management components use a Java-based technology that provides 
distributed, secure, and scalable applications. This tiered architecture allows 
for scaling and fair load balancing, which improves performance.

T-LDP targeted LDP

An LDP session between indirect connect peers.

TLS transparent LAN service

TLS is used to transport customer VLANs while keeping traffic in each 
VLAN secure from other customer VLANs. In Telco devices, TLS is a 
tagging mechanism in the encapsulated source Ethernet frames that are 
transported from the customer edge, across the provider network, to the 
destination customer edge.

TLV type length value

Traffic engineering information is carried by signaling objects, for example, 
LDPs. The type, length, and values of this traffic engineering information is 
specified in the TLV.

TOS type of service

An eight-bit field in an IP packet header that contains a three-bit IP 
precedence value or six-bit DSCP value. This value is used to identify the 
level of service that a packet receives in the network.

TPSDA triple play service delivery architecture

A model of service delivery for triple play (video, voice, and data services) 
based on call admission for video and VoIP, with the need to guarantee 
delay, jitter, and packet loss characteristics once the service connection is 
accepted. Its architecture also meets the QoS needs of data high speed 
Internet services with per-subscriber bandwidth controls.
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TTL time-to-live

An IETF specification that calls for a minimum default value of 64 hops 
before a data packet expires.

TUG tributary unit group

A TUG consists of identical TUs. A multiplexing scheme that is used to 
assemble the TUs into a higher unit of bandwidth.

TU-N tributary unit - level N

The basic unit of an SDH payload, which includes management overheads 
and synchronization data. The TU consists of a virtual container and a TU 
pointer. It provides a unit of bandwidth that is required to convey a T1- or 
E1-framed carrier.

tuple In programming languages, a tuple is an ordered set of values. The delimiter 
for each value is often a comma, depending on the rules of the particular 
language. As a data type, a tuple can be used to pass a string of parameters 
from one program to another.

U

UBR unspecified bit rate

UBR is an ATM service category that is used for applications that do not 
require guarantees of low cell loss or low delay. Specifically, UBR does not 
include the notion of a per-connection negotiated bandwidth. No numerical 
commitments are made with respect to the cell loss ratio experienced by a 
UBR connection, or as to the cell transfer delay experienced by cells on the 
connection. UBR emulates the connectionless services provided by 
conventional bridged and routed data networks. It provides best effort 
delivery.

UDP user datagram protocol

A minimal transport protocol above the IP network layer that does not 
guarantee datagram delivery. The UDP is used by applications that do not 
require the level of service of TCP or that need to use communications 
services (for example, multicast or broadcast delivery) not available from 
TCP.

UIC unit ID code

UNI user-network interface

UNI is an interface point between ATM end users and a private ATM switch, 
or between a private ATM switch and the public carrier ATM network; 
defined by physical and protocol specifications per ATM Forum UNI 
documents. UNI is also the standard adopted by the ATM Forum to define 
connections between users or end stations and a local ATM network switch.

UNIX UNIX is a multi-user, multitasking operating system, which is used on 
mainframes, workstations, and PCs. UNIX is the basis of Solaris and 
SunOS, which are operating systems used by Sun workstations.
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URL uniform resource locator

USM user service manager

A GUI application for a management system. It usually performs as a 
manager towards an information manager application, although it may also 
connect directly with the managed system.

V

VBR variable bit rate

VBR is an ATM service category that provides guaranteed low cell loss and 
low delay for applications such as video and frame relay, and is 
characterized by an on/off source with known, predictable transmission 
patterns. During the on period, cells are transmitted at the peak information 
rate. No cells are transmitted during the off period.

VBR supports VBR data traffic with average and peak traffic parameters.

VBR is intended for applications that generate bursty traffic at a rate that 
varies with time. There are two service categories in VBR. The first is 
rt-VBR and is used by real-time applications. The second one is nrt-VBR 
and is intended for non-real-time applications.

See also nrt-VBR and rt-VBR.

VC virtual connection

A technique ensuring that packets are delivered to the correct recipient in the 
same order as they were submitted.

VCC virtual channel connection

A VCC is the series of cross-connections used to traverse an ATM network 
end-to-end. This ATM concept describes a type of path through an ATM 
network, defined by its VPI and VCI values.

VCCs represent a specific instance of a PVC, SPVC, or SVC. They are 
formed as a concatenation of one-hop connections that are cross-connected 
on workgroup switches. VCCs are unidirectional. They do not use 
bandwidth if there is no data to transmit. 

VCI virtual channel identifier

The VCI is part of the address of a VCC. The complete address of the VCC 
consists of the VCI and the VPI. A unique numerical tag as defined by a 
16-bit field in the ATM cell header identifies a virtual channel, over which 
the cell is to travel. VCIs are assigned for one hop only; each switch 
cross-connects cells from one VC to the next, reassigning VCIs.

VINES virtual networking system
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virtual link Virtual links connect separate elements of a backbone, and function as if 
they are unnumbered point-to-point networks between two devices. A 
virtual link uses the intra-area routing of its transit area (the non-backbone 
area that both devices share) to forward packets.

VLAN virtual LAN

 A logical grouping of two or more nodes which are not necessarily on the 
same physical network segment but which share the same IP network 
number.

VLL virtual leased line

A virtual leased line is a type of VPN where IP is transported in a 
point-to-point manner. CPE devices are connected through nodes, and the 
nodes are connected to an IP tunnel.

VoIP voice over Internet protocol

A telephone service that uses the Internet as a global telephone network.

VPC virtual path connection

VPCs are a series of linked VPs that extend between the point where the VCI 
values are assigned and the point where those values are translated or 
removed.

A VPC carries VCCs between sites. VPC traffic is carried on full ATM 
trunks. VPCs use physical bandwidth only when the end user devices have 
traffic. They do not use bandwidth if there is no data to transmit.

A VPC is a concatenation of the VP links. The endpoints of a VPC are the 
points at which the ATM payload is passed to or received from the users of 
the ATM layer. A long-term VPC is known as a PVPC. A VPC is identified 
by its VPI.

VPI virtual path identifier

The VPI is an 8-bit field in the ATM cell header that indicates the virtual 
path over which the cell should be routed.

The VPI is assigned on connection setup by the devices at the two ends of a 
hop. Multihop VPC paths use multiple VPIs to go from source to destination. 
Each switch that the VPC traverses cross-connects the VPC from one port 
and VPI to another port and VPI.

VPLS virtual private LAN service

A VPLS is a type of VPN in which a number of sites are connected in a 
single bridged domain over an IP/MPLS network. Although the services 
may be from different locations, in a VPLS, they appear to be on the same 
LAN.

When implemented with Layer 2 interfaces, this service is called VPLS. 
When implemented with Layer 3 interfaces, this service is called an IP-VPN
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VPN virtual private network

A private network that is configured within a public network (a carrier 
network or the Internet) in order to take advantage of the economies of scale 
and management facilities of large networks. VPNs are used by enterprises 
to create WANs that span large geographic areas to provide site-to-site 
connections to branch offices and to allow mobile users to dial up their 
company LANs.

VPRN virtual private routed network

A network exhibiting at least some of the characteristics of a private 
network, even though it uses the resources of a public switched network.

VRF virtual routing and forwarding

A logical or virtual routing function with associated routing table that can be 
instantiated in a device capable of supporting IP VPN services.

VRRP virtual router redundancy protocol

VRRP is a protocol to provide redundancy in statically-defined routed 
networks, rather than in dynamically-defined networks, such as RIP and 
OSPF. VRRP is an election protocol that dynamically assigns responsibility 
for one or more virtual router(s) to the VRRP router(s), allowing several 
routers on a multiaccess link to utilize the same virtual IP address. A VRRP 
router is configured to run the VRRP protocol in conjunction with one or 
more other routers.

VSM-CCA versatile service module cross-connect adapter

The VSM-CCA is a new type of MDA for the 7450 ESS and 7750 SR 
platforms, designed to provide an extra set of egress and ingress forwarding 
paths through a set of virtual ports. This design eliminates the need for a 
physical port MAC address, cable, or other MDA specific components thus 
producing a less costly and more reliable adapter.

VT virtual trunk

An aggregation of ATM VCs. All connections on a VT map to a single VPC 
with a public network-assigned VPI.

VTG virtual tributary group

One or more virtual tributaries of the same rate that are bundled into an 
STS-1 payload.

VT-N virtual tributary - level N

A SONET format for mapping a lower-rate signal into a SONET payload; 
for example, VT1.5 is used to transport a DS-1 signal.
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W

WAN wide-area network

A geographically dispersed, long-haul telecommunications network that 
usually consists of backbone links. A WAN may be privately owned or 
leased. The term usually connotes the inclusion of public networks that are 
highly regulated, and provide superior reliability and resilience.

window Windows are forms, panels of information, equipment drawings, or graphics 
that appear on a screen. Windows commonly allow a user to input data and 
initiate functions but some windows simply display information.

workflow The 5620 SAM workflow is a defined series of tasks that describe how to 
install, configure, create, and manage services.

working pane The working pane is a component of the 5620 SAM GUI that can include 
windows, drawings, and configuration forms.

WRED weighted random early detection

WRED is a variation of RED, but instead of dropping packets randomly 
when there is high traffic congestion, the packets are dropped based on 
traffic priority.

WTR wait to restore

A period of time that must elapse after a failed working line has recovered 
before switching back to the working line from the protection line.

X

X.25 An ITU-T data communications protocol and interface for public 
packet-switched communication between a network user and the network.

X.733 X.733

X.733 is the standard that describes the alarm reporting function.

XML extensible markup language

XML defines the syntax to customize markup languages. The markup 
languages are used to create, manage, and transmit documents across the 
Web. 

XNS Xerox network standard

The term for the suite of Internet protocols developed by researchers at 
Xerox Corporation.
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1354 BM, 19-2
launching GUI on 5620 SAM client GUI, 

19-5
monitoring 5620 SAM server, 19-7

5620 NM, 19-2
launching GUI on 5620 SAM client GUI, 

19-5
5620 SAM, 8-2

CLI, 7-2
DHCP configuration for 5750 SSC, 18-36
discovering devices using HP OpenView 

NNM, 19-8
integration with 1354 BM, 19-2
integration with 5620 NM, 19-2
integration with 5750 SSC, 18-2
integration with HP OpenView NNM, 19-2
launching 1354 BM GUI, 19-5
launching 5620 NM GUI, 19-5
launching from AS tool USM, 19-6
launching GUI from HP OpenView NNM, 

19-5
managing 7450 ESS security, 12-2
managing 7750 SR security, 12-2
managing devices using HP OpenView 

NNM, 19-8
menu changes in Release 3.0, 4-2
monitoring server status from 1354 BM, 

19-7
new features, 2-2

policy creation for 5750 SSC, 18-22
reconfiguring, 8-3
redundancy, 16-2
Release 2.0 features, 2-13
Release 2.1 features, 2-7
TPSDA, 27-6

5620 SAM and 5750 SSC
menus, 18-6
procedures, 18-7
procedures list, 18-6

5620 SAM and 5750 SSC network managers
workflow, 18-5

5620 SAM and non-5620 SAM network 
managers

menus, 19-4
procedures, 19-5
procedures list, 19-4
workflow, 19-4

5620 SAM database
failover, 16-18
manual switchover, 16-18
recovery from a failover, 16-19
redundancy, 16-2

5620 SAM GUI; See GUI
5620 SAM security; See security for 5620 

SAM
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5620 SAM server — ATM encapsulation
5620 SAM server
DES security keys, 9-11
manual activity switch, 16-17
MD5 security keys, 9-11

5620 SAM workflow, 1-2
configuring end-user services, 1-2
installing software, 1-2
managing end-user services, 1-2

5750 SSC, 18-2
5620 SAM-O user accounts, 18-19
creating subscribers on 5620 SAM, 18-20
DHCP, 18-36
discovering devices, 18-20
option 82, 18-21
policy creation on 5620 SAM, 18-22
VPLS configuration, 18-21

7450 ESS
commissioning, 8-4
device support, 20-6
discovering using HP OpenView NNM, 

19-8
grouping in rings, 21-14
managing using HP OpenView NNM, 19-8

7450 ESS database
backing up, 14-13
restoring, 14-13
restoring older backups, 14-13

7450 ESS security; See security for 7450 ESS
7750 SR

commissioning, 8-4
device support, 20-5
discovering using HP OpenView NNM, 

19-8
grouping in rings, 21-14
managing using HP OpenView NNM, 19-8

7750 SR database
backing up, 14-13
restoring, 14-13
restoring older backups, 14-13

7750 SR security; See security for 7750 SR
802.1X

disabling, 21-16
enabling, 21-16

802.1X policies
creating, 28-40

A

access egress policies, 28-9
creating, 28-28
QoS, 27-25

access ingress policies, 28-6
creating, 28-23
forwarding classes, 28-8
forwarding subclasses, 28-9
QoS, 27-25

accounting statistics, 41-2 
menus, 41-2
procedures, 41-3
procedures list, 41-3
workflow, 41-2

activity logs for GUIs, 11-21
activity switches, 16-2
alarm suppression, 38-10
alarm thresholds, 38-8
alarms

See also fault management using alarms
acknowledging, 38-17
aggregation, 38-4
deleting, 38-17
global policies, 38-12
historical records, 38-23
history behavior, 38-13
network statistics, 38-22
notes, 38-17
policies for individual alarms, 38-14
relationships on the GUI, 38-4
reloading, 38-24
severity, 38-4
status, 38-4
suppression, 38-10
thresholds, 38-8
viewing, 38-21
viewing for network objects, 38-16
viewing information, 38-17

APS; See fault management using APS
AS tool USM

launching GUI on a 5620 SAM client GUI, 
19-6

ATM encapsulation, 20-19
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ATM OAM ping — database manager
ATM OAM ping
performing, 39-32

ATM ping, 39-9
ATM QoS policies, 28-19

creating, 28-46
automatic protection switching; See fault 

management using APS

B

BGP, 24-3
configuring confederation, 24-19
configuring global-level, 24-16
configuring peer group-level, 24-22
configuring peer-level, 24-23
enabling on routers, 24-16

bridging, 24-11
configuring, 24-59

BSA
TPSDA, 27-6

BSR
TPSDA, 27-6

BTV multicast, 27-13

C

card slot objects, 20-11
cards, 20-11

creating daughter, 21-20
creating types, 21-20

CCAG objects, 20-9
CCAGs

creating and configuring, 21-17
channels, 20-13

configuring SDH sub-channels, 21-33
configuring SONET clear channels, 21-27
configuring SONET sub-channels, 21-30
creating TDM channels, 21-39
SONET sub-channels, 20-19
TDM, 20-17

circuit templates; See service templates
clear channels

ATM encapsulation, 20-19
DS3, 20-15
STS3 to STS192, 20-14

CLI, 7-2
commissioning device before 5620 SAM 

management, 8-4
creating scripts, 7-5
launching, 7-3
menus, 7-2
procedures, 7-3
procedures list, 7-3
saving scripts, 7-7
setting console parameters, 7-4
using scripts, 7-5
workflow, 7-2

clipboards, 3-4
using, 3-19

commissioning
7450 ESS, 8-4
7750 SR, 8-4
Telco, 8-4

composite service management, 36-2
menus, 36-7
procedures, 36-7
procedures list, 36-7
sample configuration, 36-6
workflow, 36-6

composite services, 36-2
connector types, 36-4
creating, 36-8
deleting, 36-14
modifying, 36-14
network discovery of, 36-3

containing windows
turning off warnings, 3-10

contextual menus
equipment view, 21-4
navigation tree, 21-4
ring group view, 21-11

D

database manager, 15-2
analyzing database, 15-5
backing up database, 15-6
menu, 15-2
procedures, 15-3
procedures list, 15-2
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database manager (continued) — equipment configuration
viewing general database statistics, 15-3
workflow, 15-2

daughter cards, 20-11
creating, 21-20
limits, 3-17

deployment and site backup/upgrade, 14-2
configuring 5620 SAM-to-node 

deployment policy, 14-9
menu, 14-8
procedures, 14-9
procedures list, 14-8
restoring older backups, 14-13
scheduling node backup, 14-11
starting immediate backup, 14-13
starting immediate restore, 14-13
troubleshooting configuration deployment, 

14-10
upgrading node software image, 14-14
viewing backup status, 14-16
viewing restore status, 14-16
viewing upgrade status, 14-16
workflow, 14-8

DES
generating security keys, 9-11

device objects, 20-5
devices

7450 ESS, 20-6
7750 SR, 20-5
changing configuration from equipment 

manager, 22-9
changing properties from navigation tree, 

21-15
discovering, 9-12
navigation tree contextual menus, 21-4
preconfiguring, 8-4
release support, 20-5
security, 12-2
supported, 20-5
Telco, 20-8

DHCP
5750 SSC, 18-36
option 82 and 5750 SSC, 18-21

diagnostics; See fault management using OAM

discovery, 9-2, 9-2
configuring DES or MD5 security keys, 

9-11
configuring poller policies, 9-5
configuring poller SNMPv3, 9-9, 9-10
deleting and creating new discovery rule, 

9-18
discovering devices, 9-12
editing discovery rule, 9-17
managing routers, 9-20
menus, 9-4
procedures, 9-5
procedures list, 9-4
rescanning network, 9-20
workflow, 9-3

discovery manager; See discovery
discovery rules

deleting and creating, 9-18
disabling, 9-19
editing, 9-17
enabling, 9-19
removing, 9-19

drawings
using to view parameters, 3-10

dynamic alarm list
opening, 3-10

E

endpoints
connection termination points, 20-14

equipment
See also nodes, routers
viewing alarms for, 38-16

equipment configuration
CCAGs, 21-17
changing from equipment manager, 22-9
configuring Ethernet ports, 21-21
configuring SDH sub-channels, 21-33
configuring SONET clear channels, 21-27
configuring SONET ports, 21-24
configuring SONET sub-channels, 21-30
configuring TDM ports, 21-26
contextual menus, 21-4
creating card types, 21-20
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equipment configuration (continued) — fault management using OAM
creating daughter cards, 21-20
creating TDM channels, 21-39
forms, 21-2
LAGs, 21-18

equipment management
overview, 20-2

equipment manager, 22-2
configuring devices, 22-9
filtering views, 22-9
forms, 22-2
menus, 22-8
network element filter, 22-9
procedures list, 22-8
workflow, 22-8

equipment view, 21-4
contextual menus, 21-4
Make Root In New Tree option, 3-3
Make Root option, 3-3

Ethernet ports, 20-15
configuring, 21-21

F

failover, 16-2
restoring redundancy, 16-19

FAQs
basic troubleshooting, 2-17

fault management using alarms, 38-2
alarm status and aggregation, 38-4
menus, 38-11
procedures, 38-12
procedures list, 38-12
reloading alarms, 38-24
reviewing historical alarms, 38-23
setting alarm history behavior, 38-13
setting global alarm policies, 38-12
setting specific alarm policies, 38-14
suppression, 38-10
thresholds, 38-8
viewing alarm information, 38-17
viewing alarms, 38-16
viewing network alarm statistics, 38-22
viewing network alarms, 38-21
workflow, 38-10

fault management using APS, 40-2
APS port configurations, 40-4
APS support on single node, 40-5
changing operational state, 40-9
configuring on SONET/SDH ports, 40-7
directional modes, 40-3
menus, 40-6
overview, 40-2
procedures, 40-7
procedures list, 40-6
removing from SONET/SDH ports, 40-9
switching modes, 40-4
workflow, 40-5

fault management using OAM, 39-2
ATM ping, 39-9
interpreting diagnostic results, 39-36
LSP ping, 39-5
LSP trace, 39-5
MAC ping, 39-6
MAC populate, 39-8
MAC purge, 39-8
MAC trace, 39-7
menus, 39-16
MTU ping, 39-3
performing ATM OAM ping, 39-32
performing MTU ping from service tunnel, 

39-17
performing MTU ping from test manager, 

39-21
performing tunnel ping from a service 

tunnel, 39-19
performing tunnel ping from test manager, 

39-22
performing VPRN diagnostics from VPRN 

service, 39-23
procedures, 39-17
procedures list, 39-16
sample diagnostic sequence, 39-13, 39-13
service site ping, 39-4
tunnel ping, 39-3
VPRN ping, 39-8
VPRN trace, 39-8
workflow, 39-15
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features — HQoS
features
new, 2-2
Release 2.0, 2-13
Release 2.1, 2-7

FIB entries
managing, 31-42

FIBs
VPLS, 31-8

filter policies, 28-17
creating ACL IP, 28-43
creating ACL MAC, 28-45

filters
resetting defaults, 6-6
setting defaults, 6-6

firewalls, 8-4
flooding

VPLS, 31-9
form management

procedures, 5-4
procedures list, 5-4
workflow, 5-3

forms, 5-2
arranging, 5-4
closing, 5-5
equipment manager, 22-2
menu options, 5-3
moving to foreground, 5-5
using to view parameters, 3-10

forwarding classes, 28-9
forwarding subclasses, 28-9
FTP, 8-4

G

global policies, 28-2
grouping devices, 21-14
GUI, 3-2, 39-9

alarm relationships, 38-4
containing windows, 3-10
Copy to Clipboard button, 3-4
disabling activity check, 3-8
elements, 3-2
enabling activity check, 3-8
exiting, 3-20
hiding toolbar, 3-9

Make Root At Top Level button, 3-3
managing lists, 3-13, 3-15
manipulating filtered list forms, 3-15
manipulating listed information, 3-13
menus, 3-5
modifying toolbar, 3-9
navigating, 3-8
navigation tree contextual menus, 21-4
navigation tree view selector, 21-2
opening dynamic alarm list, 3-10
opening navigation tree, 3-10
procedures, 3-6
procedures list, 3-5
saving preferences, 3-15
showing toolbar, 3-9
starting from PC, 3-7
starting from Solaris workstation, 3-7
toolbar configuration, 3-9
using drawings to set or view parameters, 

3-10
using forms to set or view parameters, 3-10
using menus, 3-8
using OAM test manager, 39-9
using shortcuts, 3-8
using the clipboard, 3-19
using the navigation tree toolbar, 3-3
using the toolbar, 3-8
using windows to set or view parameters, 

3-10
viewing listed information, 3-13
workflow, 3-4

GUI sessions
listing, 11-20
logging, 11-21

H

hierarchical schedulers, 28-16
HP OpenView NNM, 19-2

discovering devices, 19-8
launching 5620 SAM GUI, 19-5
managing devices, 19-8

HQoS
sample VPLS, 27-31
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HVPLS — LSP trace
HVPLS, 31-4
creating, 31-36

I

IES, 32-2
creating, 32-8
deleting, 32-22
modifying, 32-21

IES management, 32-2
menus, 32-7
procedures, 32-8
procedures list, 32-7
sample configuration, 32-5
viewing operational status, 32-21
viewing service topology maps, 32-22
workflow, 32-6

IGMP, 27-15
adding interfaces to IES, 32-18
configuring on routers, 24-56
creating on interfaces, 24-58
enabling on routers, 24-55

IGMP snooping
VPLS, 31-10

in-band and out-of-band management
configuring poller policies, 10-4
menu, 10-4
procedure, 10-4
procedure list, 10-4
workflow, 10-3

IS-IS
See ISIS

ISIS, 24-9
configuring interfaces, 24-47
configuring NET addresses, 24-46
configuring router-wide parameters, 24-43
enabling on routers, 24-43
planning configuration, 24-42

L

L2 interface templates; See service templates
L3 interface templates; See service templates
LAG objects, 20-10
LAGs

creating and configuring, 21-18

LDP, 24-7
configuring global-level parameters, 24-37
configuring interfaces, 24-39
configuring peers, 24-41
configuring targeted peers, 24-40
enabling on routers, 24-37
supported on, 24-36

license key
changing, 8-3
exporting information, 3-18
viewing, 3-17

lightweight SAPs, 27-6
lists

creating LSPs, 25-7
filters, 6-6
LSPs, 25-13
managing filtered information, 3-15
managing information, 3-13
MPLS paths, 25-13
saving preferences, 3-15, 3-18
saving table list preferences, 6-5
service tunnels, 26-6
viewing, 3-13
viewing filtered information, 3-15

local authentication
security for 5620 SAM, 11-7, 12-4

local policies, 28-2
auditing, 28-59

log files
GUI sessions, 11-21

logical components
viewing alarms for, 38-16

login screen, 11-12
LSP path map

opening from LSP Path form, 37-11
opening from MPLS Paths form, 37-10

LSP path topology map, 37-5
LSP paths

configuring, 25-11
LSP ping, 39-5

performing, 39-30
LSP topology map, 37-4
LSP trace, 39-5

performing, 39-31
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LSPs — naming conventions
LSPs
creating, 25-7

M

MAC learning
VPLS, 31-8

MAC move
VPLS, 31-8

MAC ping, 39-6
performing, 39-27

MAC populate, 39-8
performing, 39-25

MAC purge, 39-8
performing, 39-26

MAC trace, 39-7
performing, 39-28

Make Root At Top Level button, 21-48
Make Root In New Tree option, 21-48
Make Root option, 21-48
map management, 37-2

menus, 37-9
procedures, 37-10
procedures list, 37-9
workflow, 37-8

maps
listing object information, 37-12
LSP, 37-4
LSP path, 37-5
opening from 5620 SAM main menu, 

37-10
opening LSP path from LSP Path form, 

37-11
opening LSP path from MPLS Paths form, 

37-10
service topology, 37-6
service tunnel topology, 37-8
toolbar, 37-3
viewing elements, 37-11
viewing LSPs, 25-13
viewing object information, 37-12
zooming, 37-12

MD5
generating security keys, 9-11

MDA limits, 3-17

menus
5620 SAM security, 11-11
Release 3.0 changes, 4-2
using, 3-10

MIBs
SNMP, 9-21

modules
verifying installation, 3-18

MP-BGP, 24-3
MPLS

configuring administrative group policies, 
23-21

MPLS configuration, 25-2
configuring LSP paths, 25-11
creating interfaces, 25-4
creating LSPs, 25-7
creating paths, 25-6
enabling on routing instance, 25-3
listing LSPs, 25-13
listing paths, 25-13
menus, 25-2
procedures, 25-3
procedures list, 25-3
viewing LSP map, 25-13
workflow, 25-2

MTU ping, 39-3
performing, 39-17
performing from test manager, 39-21

multicast package policies
creating, 28-47

multilink bundle
creating, 21-42

multiple device support, 20-5
MVPLS, 31-6

creating composite service, 31-40
creating single, 31-38

MVR
VPLS, 31-7

N

naming conventions
SONET channels, 20-19
TDM channels, 20-17
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navigation tree — passwords
navigation tree
changing device properties, 21-15
configuring Ethernet ports, 21-21
configuring SDH sub-channels, 21-33
configuring SONET clear channels, 21-27
configuring SONET ports, 21-24
configuring SONET sub-channels, 21-30
configuring TDM ports, 21-26
contextual menus, 21-4
copying to clipboard, 3-19
creating and configuring CCAGs, 21-17
creating and configuring LAGs, 21-18
creating card types, 21-20
creating daughter cards, 21-20
creating TDM channels, 21-39
creating TU11 or TU12 sub-channels, 

21-35
creating VT1.5 or VT2 sub-channels, 

21-35
disabling 802.1X, 21-16
enabling 802.1X, 21-16
equipment menus, 21-12
equipment procedures list, 21-13
grouping devices, 21-14
Make Root At Top Level button, 3-3
making an object the root of another 

navigation tree, 21-48
making an object the root of the navigation 

tree, 21-48
opening, 3-10
overview, 21-2
restoring the default root, 21-48
using the toolbar, 3-3
view selector, 21-2
workflow to manage equipment, 21-12

network element filter, 22-9
network faults

workflow using alarms, 38-10
workflow using APS, 40-5

network hierarchy, 21-2
network maps; See maps
network objects, 20-4
network policies, 28-10

creating, 28-30
QoS, 27-26

network queue policies, 28-11
creating, 28-34
QoS, 27-27

nodes
See also routers
scheduling backups, 14-11
upgrading software image, 14-14

O

OAM diagnostics, 39-9
OAM; See fault management using OAM
objects, 20-3

CCAGs, 20-9
changing device properties from 

navigation tree, 21-15
channels, 20-13
creating, 20-4
daughter cards, 20-11
devices, 20-5
grouping devices, 21-14
LAGs, 20-10
network, 20-4
ports, 20-13
ring groups, 20-26
shelves, 20-11

option 82
VPLS SAP metadata, 18-21

OSPF, 24-6
adding router to area, 24-35
configuring area, 24-31
configuring on routers, 24-28
creating virtual links, 24-36
enabling on routers, 24-28
planning configuration, 24-27

out-of-band management; See in-band and out-
of-band management

P

password expiry, 11-13
password policy, 11-7
passwords

changing as system administrator, 11-19
changing as user, 11-20
Alcatel 5620 Service Aware Manager, Release 3.0 R1 IN-9
October 2005 3HE00214 CA



Index

paths — QoS
paths
creating MPLS, 25-6

performance monitoring statistics, 41-2 
See also accounting statistics
creating accounting policy, 41-4
creating file policy, 41-3
menus, 41-2
modifying accounting policy, 41-4
modifying equipment statistics, 41-7
modifying file policy, 41-3
modifying object-based statistics, 41-7
procedures, 41-3
procedures list, 41-3
viewing equipment statistics, 41-6
viewing object-based statistics, 41-6
viewing statistics logs, 41-8
workflow, 41-2

performing searches
menu, 6-2
procedures, 6-3
procedures list, 6-3
specifying endpoints, 6-6
using menus, 6-3
using Search button, 6-3
using Select button, 6-8
workflow, 6-2

permissions, 11-3
PIM, 27-14

adding interfaces to IES, 32-19
adding interfaces to VPRN services, 33-21
configuring on routers, 24-51
creating on interfaces, 24-54
enabling on routers, 24-50
for VPRN services, 33-5

policies, 28-2
802.1X, 28-40
access egress, 28-9
access ingress, 28-6
ATM QoS, 28-19
auditing, 28-59
copying, 28-57
deleting, 28-57
deleting security policies, 12-22
distributing, 28-55
distributing security policies, 12-22

editing, 28-56
filter, 28-17
global, 28-2
local, 28-2
multicast package, 28-20
network, 28-10
network queue, 28-11
overwriting, 28-57
removing unassociated, 28-58
scheduler, 28-15
service management, 28-6
setting for global alarms, 38-12
setting for specific alarms, 38-14
shared queue, 28-14
slope, 28-13
subscriber authentication, 12-19
synchronizing, 28-58
Telco, 28-21

poller policies
configuring for network elements, 9-5
configuring for SNMPv3 security, 9-9, 

9-10
configuring in-band and out-of-band, 10-4

ports, 20-13
configuring Ethernet ports, 21-21
configuring SONET ports, 21-24
configuring TDM ports, 21-26
Ethernet ports, 20-15
SDH port encapsulation, 20-16
SONET port encapsulation, 20-16

preferences
saving GUI workspace, 3-15

PVC
configuring, 21-41

Q

QoS, 27-20
access egress policies, 27-25
access ingress policies, 27-25
network policies, 27-26
network queue policies, 27-27
policies, 27-23
scheduler policies, 27-28
workflow, 27-21
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R — routing protocol configuration
R

RADIUS
access policies, 12-16
creating 5620 SAM user account 

authentication policies, 11-17
local and remote authentication user 

account overview, 11-7, 12-4
redundancy, 16-2

5620 SAM database failover, 16-18
5620 SAM database recovery from a 

failover, 16-19
checking redundancy status, 16-15
checking status, 16-15
manual 5620 SAM database switchover, 

16-18
manual 5620 SAM server activity switch, 

16-17
menus, 16-14, 16-14
procedures, 16-15
procedures list, 16-14, 16-14
workflow, 16-13

remote authentication
security for 5620 SAM, 11-7, 12-4

Remove button, 3-19
restoring older 7450 ESS database backups, 

14-13
restoring older 7750 SR database backups, 

14-13
ring group view, 21-11

contextual menus, 21-11
ring groups, 20-26

grouping devices, 21-14
RIP, 24-5

configuring global-level, 24-24
configuring group-level, 24-26
configuring interface-level, 24-26

router configuration, 23-2
configuring Layer 3 interface, 23-11
configuring MPLS administrative group 

policy, 23-21
configuring routing instance parameters, 

23-8
configuring routing policy, 23-17
configuring static route, 23-24

menus, 23-8
modifying Layer 3 interface, 23-15
procedures, 23-8
procedures list, 23-8
workflow, 23-7

routers
See also nodes
managing, 9-20
reconciling elements, 9-20
unmanaging, 9-20

routing configuration
configuring RSVP interfaces, 24-50
configuring RSVP parameters, 24-49

routing policy, 23-3
configuration, 23-17

routing protocol configuration, 24-2
adding IGMP interfaces to IES, 32-18
adding Layer 3 interfaces to OSPF area, 

24-31
adding PIM interfaces to IES, 32-19
adding PIM interfaces to VPRN services, 

33-21
adding router to OSPF area, 24-35
applying BGP, PIM, or RIP to VPRN 

service routing instances, 33-20
applying OSPF, RIP, or ISIS to IES, 32-17
applying OSPF, RIP, or ISIS to IES L3 

interfaces, 32-18
configuring BGP confederation, 24-19
configuring global-level BGP, 24-16
configuring global-level LDP parameters, 

24-37
configuring global-level RIP, 24-24
configuring group-level RIP, 24-26
configuring IGMP on routers, 24-56
configuring interface-level RIP, 24-26
configuring ISIS interfaces, 24-47
configuring ISIS NET addresses, 24-46
configuring LDP interfaces, 24-39
configuring LDP peers, 24-41
configuring LDP targeted peers, 24-40
configuring OSPF area, 24-31
configuring OSPF on routers, 24-28
configuring peer group-level BGP, 24-22
configuring peer-level BGP, 24-23
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routing protocol configuration (continued) — security for 7450 ESS
configuring PIM on routers, 24-51
configuring router-wide ISIS parameters, 

24-43
creating IGMP interfaces, 24-58
creating PIM interfaces, 24-54
creating virtual links, 24-36
enabling BGP on routers, 24-16
enabling IGMP on routers, 24-55
enabling ISIS on routers, 24-43
enabling LDP on routers, 24-37
enabling OSPF on routers, 24-28
enabling PIM on routers, 24-50
menus, 24-13
procedures, 24-15
procedures list, 24-13
workflow, 24-11

routing protocols
BGP, 24-3
IGMP, 27-15
ISIS, 24-9
LDP, 24-7
MP-BGP, 24-3
OSPF, 24-6
PIM, 27-14
RIP, 24-5
RSTP, 31-9
STP, 31-9

RSVP, 24-11
configuring interfaces, 24-50
configuring parameters, 24-49

S

SAM-A
verifying installation, 3-18

SAM-O
verifying installation, 3-18

SAM-P
verifying installation, 3-18

SAPs
lightweight, 27-6

scheduler policies
aggregation schedulers, 27-28
creating, 28-38
hierarchical, 28-16

multi-tier, 27-28
QoS, 27-28
single tier, 27-28, 28-16

SDP; See service tunnels
security for 5620 SAM

authentication failure for user accounts, 
11-13

changing user passwords as system 
administrator, 11-19

changing user passwords as user, 11-20
configuration group procedures, 11-12
configuration group procedures list, 11-11, 

13-3
configuration user procedures, 11-12
configuration user procedures list, 11-11, 

13-3
creating RADIUS and TACACS+ policies 

for user accounts, 11-17
creating user accounts, 11-16, 11-16
creating user groups, 11-15
deleting user accounts, 11-18
deleting user groups, 11-18
email configuration for user accounts, 

11-14
GUI sessions, 11-20
log files, 11-21
login screen, 11-12
menus, 11-11
password policy, 11-7
permissions, 11-3
reinstating users, 11-19
suspended account actions for user 

accounts, 11-14
suspending users, 11-19
user account expiry, 11-13
workflow for groups, 11-10, 13-2
workflow for users, 11-10, 13-2

security for 7450 ESS, 12-2
creating RADIUS access policies, 12-16
creating subscriber authentication policies, 

12-19
creating TACACS+ access policies, 12-17
creating user accounts, 12-12
creating user profiles, 12-11
deleting policies, 12-22
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distributing policies, 12-22
editing policies, 12-21
managing user accounts, 12-12
menus, 12-6
modifying password policies, 12-15
procedures, 12-7
procedures list, 12-6
RADIUS policies and permissions, 12-4
specifying password policies, 12-15
system security, 12-18
TACACS+ policies and permissions, 12-4
user and group permissions, 12-3
workflow, 12-5

security for 7750 SR, 12-2
creating NE management access filter 

policies, 12-7, 12-9
creating RADIUS access policies, 12-16
creating site management access filter 

policies, 12-7, 12-9
creating TACACS+ access policies, 12-17
creating user accounts, 12-12
creating user profiles, 12-11
deleting policies, 12-22
distributing policies, 12-22
editing policies, 12-21
managing user accounts, 12-12
menus, 12-6
modifying NE management access filter 

policies, 12-7, 12-9
modifying password policies, 12-15
modifying site management access filter 

policies, 12-7, 12-9
procedures, 12-7
procedures list, 12-6
RADIUS policies and permissions, 12-4
specifying password policies, 12-15
system security, 12-18
TACACS+ policies and permissions, 12-4
user and group permissions, 12-3
workflow, 12-5

security policy editing, 12-21
service management, 27-2

access interfaces, 27-5
sample QoS network configuration, 27-29

service management policies, 28-6
access egress, 28-9
access ingress, 28-6
ATM QoS, 28-19
copying, 28-57
creating access egress, 28-28
creating access ingress, 28-23
creating ACL IP filter, 28-43
creating ACL MAC filter, 28-45
creating aggregation scheduler, 28-41
creating ATM QoS, 28-46
creating multicast package, 28-47
creating network, 28-30
creating network queue, 28-34
creating scheduler, 28-38
creating slope, 28-32
deleting, 28-57
distributing, 28-55
editing, 28-56
filter, 28-17
menu, 28-21
multicast package policies, 28-20
network, 28-10
network queue, 28-11
overwriting, 28-57
procedures, 28-23
procedures list, 28-22
removing unassociated, 28-58
scheduler, 28-15
shared queue, 28-14
slope, 28-13
synchronizing, 28-58
Telco policies, 28-21
workflow, 28-21

service mirror management, 35-2
menus, 35-6
procedures, 35-6
procedures list, 35-6
sample configuration, 35-4
viewing operational status, 35-14
viewing service topology maps, 35-15
workflow, 35-5
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service mirrors — subscribers
service mirrors, 35-2
creating, 35-6
deleting, 35-15
modifying, 35-13

service site ping
performing, 39-29

service site ping diagnostic, 39-4
service templates, 17-2

binding site, circuit, and interface 
templates, 17-11

creating L2 interface templates, 17-8
creating L3 interface templates, 17-10
creating SDP binding (service tunnel) 

templates, 17-7
creating service templates, 17-11
creating site templates, 17-5
menus, 17-5
parameter configuration options, 17-2
procedures, 17-5
procedures list, 17-5
secondary template binding, 17-4
site templates, 17-4
subscriber association, 17-4
text masks, 17-3
workflow, 17-4

service topology map, 37-6
viewing, 29-6

service tunnel topology map, 37-8
service tunnels, 26-2

configuring, 26-4
listing, 26-6
managing, 26-7
menus, 26-3
procedures, 26-4
procedures list, 26-4
viewing map, 26-6

services
configuration workflow, 1-2
management workflow, 1-2
sample VPLS using HQoS, 27-31
TPSDA, 27-6
viewing alarms for, 38-16

shared queue policies, 28-14
shelf objects, 20-11
single tier schedulers, 28-16

site templates; See service templates
slope policies, 28-13

creating, 28-32
QoS, 27-28

SNMP MIBs, 9-21 
SNMPv2c

updating to SNMPv3, 9-10
SNMPv3 security, 9-9

DES and MD5 security keys, 9-11
moving from SNMPv2c, 9-10

software release
viewing, 3-17

SONET ports
configuring, 21-24
configuring clear channels, 21-27
configuring SDH sub-channels, 21-33
configuring SONET sub-channels, 21-30

SONET/SDH clear channels
ATM encapsulation, 20-19

spanning tree protocols, 31-9
Telco T5C fast ring, 24-11

split horizon groups, 31-10
residential, 31-10

spoke access circuits
creating, 31-36
VLL, 31-36

SSH session, 7-2
statistics

viewing for database, 15-3
viewing for network alarms, 38-22

status
checking redundancy, 16-15

subscriber configuration, 29-2
menu, 29-2
procedures, 29-3
procedures list, 29-3
workflow, 29-2

subscriber services
listing, 29-7

subscribers, 29-2
associating with service templates, 17-4
creating, 29-3
creating authentication policies, 12-19
deleting, 29-6
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subscribers (continued) — VLAN service management
listing, 29-7
managing information, 29-5

switchover, 16-2

T

tables
saving list preferences, 6-5

TACACS+
access policies, 12-17
creating 5620 SAM user account 

authentication policies, 11-17
local and remote authentication user 

account overview, 11-7, 12-4
taskbar, 5-5
TDM channels

configuring properties, 21-44
creating, 21-39

TDM ports
configuring, 21-26

Telco
bridging configuration, 24-59
commissioning, 8-4
device support, 20-8
grouping devices, 21-14
management, 34-5
policies, 28-21
ring groups, 21-14

Telco policies
creating Telco ACL extended IP filter, 

28-51
creating Telco ACL IGMP filter, 28-53
creating Telco ACL MAC filter, 28-54
creating Telco ACL standard IP filter, 

28-50
creating Telco node QoS level, 28-49
VLAN, 34-5

Telco T5C
bridging, 24-11

Telnet session, 7-2
templates; See service templates
text masks for service templates, 17-3
TMN OS

monitoring 5620 SAM server, 19-7

toolbar
buttons, 37-3
modifying, 3-9
navigation tree view selector, 21-2
using, 3-9
using on navigation tree, 3-3
zooming, 37-3

TPSDA, 27-6
BTV multicast, 27-13
QoS, 27-8

troubleshooting
basic FAQs, 2-17
configuration deployment, 14-10
using alarms, 38-2
using OAM, 39-2

TU11 or TU12 sub-channels
creating, 21-35

tunnel ping, 39-3
performing, 39-19
performing from test manager, 39-22

U

user account authentication failure, 11-13
user account email parameters, 11-14
user account expiry, 11-13
user account suspended account actions, 11-14

V

views
filtering using equipment manager, 22-9

VLAN
Telco policies, 34-5

VLAN service management, 34-2
menus, 34-12
procedures, 34-13
procedures list, 34-13
sample BTV configuration, 34-8
sample L2 VPN configuration, 34-6
sample super VLAN configuration, 34-10
viewing operational status, 34-25
viewing service topology maps, 34-25
workflow, 34-11
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VLAN services — workspace preferences
VLAN services, 34-2
associating with subscriber access 

interfaces, 34-22
creating BTV, 34-13
creating L2 VPN, 34-15
creating management, 34-20
creating standard, 34-19
creating super, 34-17
deleting, 34-26
modifying, 34-24

VLL service management, 30-2
menus, 30-8
procedures, 30-9
procedures list, 30-8
sample configuration, 30-6
viewing operational status, 30-29
viewing service topology maps, 30-30
workflow, 30-7

VLL services, 30-2
Apipe, 30-5
creating Apipe, 30-15
creating Epipe, 30-9
creating Fpipe, 30-22
deleting, 30-30
Epipe, 30-5
Fpipe, 30-6
modifying, 30-28

VPLS, 31-2
creating, 31-18
creating spoke access circuits for, 31-36
deleting, 31-46
distributed, 31-2
FIBs, 31-8
flooding, 31-9
hierarchical, 31-4
IGMP snooping for, 31-10
local, 31-2
MAC learning for, 31-8
MAC move for, 31-8
modifying, 31-44
MVPLS, 31-6
MVR, 31-7
sample using HQoS, 27-31
spoke redundancy in, 31-6

VPLS management, 31-2
managing FIB entries, 31-42
menus, 31-17
procedures, 31-18
procedures list, 31-18
sample configuration, 31-11
viewing IGMP snooping queriers, 31-43
viewing operational status, 31-45
viewing service topology maps, 31-45
workflow, 31-16

VPRN ping, 39-8
VPRN ping and VPRN trace

performing, 39-23
VPRN service, 33-2

creating, 33-9
deleting, 33-24
modifying, 33-22

VPRN service management, 33-2
menus, 33-8
procedures, 33-9
procedures list, 33-8
sample configuration, 33-5
viewing operational status, 33-23
viewing service topology maps, 33-23
workflow, 33-7

VPRN service routers, 33-4
VPRN service troubleshooting, 33-5
VPRN trace, 39-8
VT1.5 or VT2 sub-channels

creating, 21-35

W

warning messages
suppressing containing window, 3-10

windows
floating, 3-3
setting or viewing parameters, 3-10
suppressing containing warnings, 3-10

workspace
saving GUI preferences, 3-15

workspace preferences
containing window warnings, 3-10
IN-16 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 3HE00214 CA



Customer documentation and product support

Technical support

Customer documentation

Product manuals and documentation updates are available through the Alcatel Support
Documentation and Software Download service at Alcatel.com. If you are a new user and
require access to this service, please contact your Alcatel sales representative.

Customer documentation feedback

http://www.alcatel.com/support/

http://www.alcatel.com/osds/

documentation.feedback@alcatel.com



© 2005 Alcatel. All rights reserved.
3HE00214 CA 

95-5957-01-00-A


	User Guide
	Preface
	About this document
	Procedure 1 To view 5620 SAM Parameter Guide parameter descriptions from the 5620 SAM User Guide

	About related documentation
	Conventions used in this guide
	Procedures with options or substeps
	Important information


	Contents
	Getting started
	1 - Workflows
	1.1 5620 SAM workflow
	1.2 Workflow to install, configure, create, and manage end-user services

	2 - 5620 SAM releases features and functionality
	2.1 New for this release of the 5620 SAM
	2.2 5620 SAM Release 2.1 functionality
	2.3 5620 SAM Release 2.0 functionality
	2.4 Basic FAQs for using the 5620 SAM
	How do I limit the number of reads and writes to the router?
	How should I name objects on the GUI?


	3 - The 5620 SAM GUI
	3.1 5620 SAM GUI overview
	Floating windows
	Form titles in the working pane
	Using the navigation tree toolbar

	3.2 5620 SAM GUI workflow
	3.3 5620 SAM GUI menus
	3.4 5620 SAM GUI procedures
	3.5 5620 SAM GUI basic operation procedures
	Procedure 3-1 To start the 5620 SAM GUI from a PC
	Procedure 3-2 To start the 5620 SAM GUI from a Solaris workstation
	Procedure 3-3 To disable or enable the GUI inactivity check
	Procedure 3-4 To navigate the GUI
	Procedure 3-5 To use menus, the toolbar, or shortcuts
	Procedure 3-6 To modify or hide the toolbar
	Procedure 3-7 To turn off and on containing window warnings
	Procedure 3-8 To open or hide the navigation tree and dynamic alarm list
	Procedure 3-9 To use windows, menus, and forms to set or view parameters
	Procedure 3-10 To view and manipulate listed information
	Procedure 3-11 To save list preferences
	Procedure 3-12 To save GUI workspace preferences
	Procedure 3-13 To manipulate list forms with filters
	Procedure 3-14 To view software release and license key information
	Procedure 3-15 To verify that all software modules are installed
	Procedure 3-16 To export license information to file
	Procedure 3-17 To use Remove buttons
	Procedure 3-18 To use the clipboard
	Procedure 3-19 To exit the 5620 SAM GUI


	4 - Mapping Release 2.1 to 3.0 or later menu changes
	4.1 5620 SAM menu changes for Release 3.0 overview
	4.2 5620 SAM menu mapping

	5 - Form management
	5.1 Form overview
	5.2 Form management workflow
	5.3 Form menus
	5.4 Form management procedures list
	5.5 Form management procedures
	Procedure 5-1 To arrange forms
	Procedure 5-2 To move an open form to the foreground
	Procedure 5-3 To close forms


	6 - Search and find functions
	6.1 Performing searches overview
	6.2 Workflow to perform searches
	6.3 Performing searches menus
	6.4 Performing searches procedures list
	6.5 Performing searches procedures
	Procedure 6-1 To perform a simple search from menus
	Procedure 6-2 To save results table preferences
	Procedure 6-3 To save a filter, clear a filter, and load a filter
	Procedure 6-4 To perform a search by specifying endpoints
	Procedure 6-5 To perform a search using the Select button



	Commissioning and discovering devices
	7 - Using CLI from the 5620 SAM
	7.1 CLI overview
	7.2 Workflow to use the CLI
	7.3 CLI menus
	7.4 CLI procedures list
	7.5 CLI procedures
	Procedure 7-1 To launch a CLI session
	Procedure 7-2 To configure CLI console terminal preferences
	Procedure 7-3 To create and use CLI scripts
	Procedure 7-4 To save CLI scripts


	8 - Device commissioning configurations
	8.1 5620 SAM network and element management overview
	8.2 Changing 5620 SAM configurations
	Procedure 8-1 To change the license key

	8.3 Commissioning devices before managing 5620 SAM using CLI
	Firewalls and FTP
	Procedure 8-2 To enable 7750 SR and 7450 ESS functionality before using the 5620 SAM
	Procedure 8-3 To enable Telco functionality before using the 5620 SAM


	9 - Discovery manager
	9.1 Network element discovery overview
	Discovery and SNMP packet size

	9.2 Discovery workflow
	9.3 Discovery menus
	9.4 Discovery procedures list
	9.5 Discovery procedures
	Procedure 9-1 To configure poller policies
	Procedure 9-2 To configure polling policies and discovery to use SNMPv3
	Procedure 9-3 To switch from SNMPv2c management of a device to SNMPv3 management
	Procedure 9-4 To create MD5 or DES security keys
	Procedure 9-5 To discover devices
	Procedure 9-6 To edit a discovery rule
	Procedure 9-7 To delete an old discovery rule and create a new discovery rule for the same device
	Procedure 9-8 To enable or disable a discovery rule
	Procedure 9-9 To remove a discovery rule
	Procedure 9-10 To rescan the network according to a discovery rule
	Procedure 9-11 To manage or unmanage a device
	Procedure 9-12 To reconcile device elements in the 5620 SAM database

	9.6 SNMP MIBs

	10 - In-band and out-of-band management
	10.1 Network element in-band and out-of-band management overview
	10.2 In-band and out-of-band management workflow
	10.3 In-band and out-of-band management menu
	10.4 In-band and out-of-band management procedure list
	10.5 In-band and out-of-band management procedure
	Procedure 10-1 To configure in-band or out-of-band polling policies



	Network system administration tasks
	11 - Security management for 5620 SAM client GUI users and user groups
	11.1 Security management for 5620 SAM users and user groups overview
	User and user group permissions
	Password policy
	Users and user accounts when combined local and remote authentication is used
	Client session control

	11.2 Sample configuration for 5620 SAM users and user groups
	11.3 Workflow to manage security for 5620 SAM users and user groups
	11.4 5620 SAM user and user group configuration menus
	11.5 5620 SAM user and user group configuration procedures list
	11.6 5620 SAM user and user group configuration procedures
	Procedure 11-1 To create a proprietary 5620 SAM initial login screen
	Procedure 11-2 To set expiry periods for user accounts, passwords, and GUI inactivity checks
	Procedure 11-3 To configure authentication failure actions
	Procedure 11-4 To configure suspended account actions
	Procedure 11-5 To configure email parameters
	Procedure 11-6 To create 5620 SAM user groups
	Procedure 11-7 To create 5620 SAM user accounts
	Procedure 11-8 To create RADIUS and TACACS+ authentication policies for 5620 SAM user accounts
	Procedure 11-9 To delete 5620 SAM user groups
	Procedure 11-10 To delete 5620 SAM user accounts
	Procedure 11-11 To suspend or re-instate 5620 SAM users
	Procedure 11-12 To change 5620 SAM user passwords as system administrator
	Procedure 11-13 To change a 5620 SAM user password as user
	Procedure 11-14 To view active 5620 SAM client sessions
	Procedure 11-15 To view activity logs


	12 - Security management for managed device access, including RADIUS or TACACS+
	12.1 Security management for managed devices, including RADIUS or TACACS+ overview
	User and group permissions on managed devices
	User and user accounts when combined local and remote authentication is used
	RADIUS and TACACS+ policies and permissions
	CPM filters and traffic management

	12.2 Workflow to manage security for managed device access and RADIUS or TACACS+
	12.3 Managed device user access and RADIUS or TACACS+ menus
	12.4 Managed device user access and RADIUS or TACACS+ configuration procedures list
	12.5 Managed device security configuration procedures
	Procedure 12-1 To create or modify site management access filter policies for managed devices
	Procedure 12-2 To create or modify CPM filter policies for managed devices
	Procedure 12-3 To create user profiles for managed device access
	Procedure 12-4 To create, modify, and manage user accounts for access to managed devices
	Procedure 12-5 To specify or modify password policies
	Procedure 12-6 To create RADIUS access policies
	Procedure 12-7 To create TACACS+ access policies
	Procedure 12-8 To configure system security policies
	Procedure 12-9 To create subscriber authentication policies
	Procedure 12-10 To edit security policies
	Procedure 12-11 To distribute security policies
	Procedure 12-12 To delete security policies


	13 - SSL configuration for secure messaging
	13.1 SSL configuration overview
	13.2 Workflow to configure SSL for 5620 SAM server-to-client messaging
	13.3 SSL configuration procedures list
	13.4 SSL configuration procedures
	Procedure 13-1 To configure the 5620 SAM server security domain for SSL
	Procedure 13-2 To configure the 5620 SAM server for EJB over SSL
	Procedure 13-3 To configure the 5620 SAM server for JMS over SSL
	Procedure 13-4 To configure 5620 SAM GUI or 5620 SAM-O clients for SSL
	Procedure 13-5 To configure the 5620 SAM server for HTTPS or HTTP to the 5620 SAM-O clients


	14 - Deployment and site backup/upgrade management
	14.1 Deployment and site backup/upgrade overview
	Example deployment policy configuration
	Example backup/restore policy configuration

	14.2 Workflow for deployment and site backup/upgrade
	14.3 Deployment and site backup/upgrade menu
	14.4 Deployment and site backup/upgrade procedures list
	14.5 Deployment and site backup/upgrade procedures
	Procedure 14-1 To configure a 5620 SAM deployment policy
	Procedure 14-2 To troubleshoot a configuration deployment
	Procedure 14-3 To schedule a device backup
	Procedure 14-4 To start an immediate backup or restore
	Procedure 14-5 To restore an older backup
	Procedure 14-6 To upgrade the node software image
	Procedure 14-7 To view the status of the backup, restore, or upgrade


	15 - 5620 SAM database manager
	15.1 5620 SAM database manager overview
	15.2 Workflow to manage the 5620 SAM database
	15.3 5620 SAM database menu
	15.4 5620 SAM database procedures list
	15.5 5620 SAM database procedures
	Procedure 15-1 To view general database statistics
	Procedure 15-2 To analyze the database
	Procedure 15-3 To back up the database
	Procedure 15-4 To perform a switchover


	16 - 5620 SAM redundancy
	16.1 5620 SAM redundancy overview
	5620 SAM co-located redundancy
	5620 SAM distributed redundancy
	General information about 5620 SAM redundancy activity switches, switchovers, and failovers
	5620 SAM server activity switches
	5620 SAM database switchovers
	5620 SAM database failovers
	Redundancy scenarios in the NMS LAN

	16.2 Workflow for 5620 SAM redundancy
	16.3 5620 SAM redundancy menus
	16.4 5620 SAM redundancy procedures list
	16.5 5620 SAM redundancy procedures
	Procedure 16-1 To check redundancy status
	Procedure 16-2 To perform an activity switch on 5620 SAM servers
	Procedure 16-3 To perform a manual switchover on 5620 SAM databases
	Procedure 16-4 To perform a manual failover on 5620 SAM databases
	Procedure 16-5 To recover from a database failover


	17 - Service template administration
	17.1 Service template overview
	Parameter configuration options
	Text masks
	Secondary template binding
	Subscriber association

	17.2 Workflow to create a service template
	17.3 Service template menus
	17.4 Service template procedures list
	17.5 Service template management procedures
	Procedure 17-1 To create a site template
	Procedure 17-2 To create an SDP binding (circuit) template
	Procedure 17-3 To create an L2 access interface template
	Procedure 17-4 To create an L3 access interface template
	Procedure 17-5 To create a service template


	18 - 5620 SAM and 5750 SSC integration configurations
	18.1 5620 SAM and 5750 SSC integration overview
	18.2 Workflow for 5620 SAM network management interworking
	18.3 5620 SAM and 5750 SSC interworking menus
	18.4 5620 SAM and 5750 SSC interworking procedure list
	18.5 5620 SAM network management interworking procedures
	Procedure 18-1 To configure the 5750 SSC Service Manager to interwork with the 5620 SAM
	Procedure 18-2 To verify 5620 SAM plug-in installation
	Procedure 18-3 To create a 5620 SAM-O user account
	Procedure 18-4 To create a 5750 SSC system subscriber on the 5620 SAM
	Procedure 18-5 To configure managed devices for 5750 SSC management
	Procedure 18-6 To enable and configure FTP on the 5620 SAM server
	Procedure 18-7 To configure VPLS SAP metadata using option 82
	Procedure 18-8 To configure policies in 5620 SAM for use by 5750 SSC Service Manager bandwidth management
	Procedure 18-9 To discover 5620 SAM VPLS SAP data and add accounts to the 5750 SSC Service Manager
	Procedure 18-10 To rediscover VPLS SAP information
	Procedure 18-11 To search for 5750 SSC users and user accounts
	Procedure 18-12 To create new accounts in the 5750 SSC service manager
	Procedure 18-13 To configure L2 and L3 SAPs as DHCP relay agents


	19 - 5620 SAM and network management software interworking
	19.1 5620 SAM and network management software interworking and integration overview
	5620 SAM client GUI startup and navigation rules

	19.2 Workflow for 5620 SAM network management interworking
	19.3 5620 SAM network management interworking menus
	19.4 5620 SAM network management interworking procedures list
	19.5 5620 SAM network management interworking procedures
	Procedure 19-1 To display the 1354 BM GUI on a 5620 SAM client GUI
	Procedure 19-2 To display the 5620 NM GUI on a 5620 SAM client GUI
	Procedure 19-3 To display the 5620 SAM GUI from HP OpenView NNM
	Procedure 19-4 To navigate from an AS tool USM to the 5620 SAM client GUI
	Procedure 19-5 To display 5620 SAM server status from a TMN OS on the 1354 BM
	Procedure 19-6 To discover devices on an HP OpenView NNM
	Procedure 19-7 To manage devices discovered using HP OpenView NNM



	Router and IP/MPLS network configuration and management
	20 - Equipment management overview
	20.1 Equipment management overview
	20.2 Working with objects
	Procedure 20-1 To create an object

	20.3 Working with network objects
	20.4 Working with device objects
	Multiple device support
	7750 SR support
	7450 ESS support
	Telco device support

	20.5 Working with CCAG objects
	20.6 Working with LAG objects
	20.7 Working with shelf objects
	20.8 Working with card and card slot objects
	20.9 Working with daughter card objects
	20.10 Working with port and channel objects
	Connection termination points for services and interfaces
	STS-3 to STS-192 clear channel
	DS3 clear channel
	DS0 channel groups
	Ethernet ports
	SONET/SDH and TDM port encapsulation
	SONET clear-channel applications
	TDM channelization and clear channel applications
	ATM encapsulation

	20.11 SONET and SDH sub-channel applications and structure
	SONET DS3 payload
	SONET VT1.5 and VT2 payloads
	SONET sub-channel syntax
	Comparison of SONET and SDH hierarchies
	SDH AU-4 and AU-3 sub-channel applications
	SDH TU3 payload
	SDH E3 or DS3 payload
	SDH TU11 and TU12 payloads

	20.12 Working with ring group objects

	21 - Equipment management using the navigation tree
	21.1 Navigation tree overview
	Contextual menus for objects in the navigation tree

	21.2 Workflow to manage equipment using the navigation tree
	21.3 Navigation tree equipment management menus
	21.4 Navigation tree equipment management procedures list
	21.5 Navigation tree equipment management procedures
	Procedure 21-1 To group Telco and other devices in a ring group
	Procedure 21-2 To change device properties
	Procedure 21-3 To enable or disable 802.1X
	Procedure 21-4 To create and configure a CCAG
	Procedure 21-5 To create and configure a LAG
	Procedure 21-6 To create a card type
	Procedure 21-7 To create daughter cards
	Procedure 21-8 To configure Ethernet ports
	Procedure 21-9 To configure SONET ports
	Procedure 21-10 To configure TDM ports
	Procedure 21-11 To configure SONET clear channels
	Procedure 21-12 To configure SONET sub-channels
	Procedure 21-13 To configure SDH sub-channels
	Procedure 21-14 To create VT1.5 (TU11) or VT2 (TU12) sub-channels
	Procedure 21-15 To create TDM channels
	Procedure 21-16 To configure a PVC
	Procedure 21-17 To create a multilink bundle
	Procedure 21-18 To configure properties of TDM channels
	Procedure 21-19 To make a selected object the root of the navigation tree
	Procedure 21-20 To make a selected object the root of another navigation tree
	Procedure 21-21 To restore the default navigation tree root


	22 - Equipment management using the equipment manager
	22.1 Equipment manager overview
	Equipment Manager form

	22.2 Workflow to manage equipment using the equipment manager
	22.3 Equipment manager menu
	22.4 Equipment manager procedures list
	22.5 Equipment manager procedures
	Procedure 22-1 To use the equipment manager filter
	Procedure 22-2 To change the configuration of devices using the equipment manager


	23 - Router configuration
	23.1 Router configuration overview
	Routing policies

	23.2 Workflow to configure routers
	23.3 Router configuration menus
	23.4 Router configuration procedures list
	23.5 Router configuration procedures
	Procedure 23-1 To configure routing instance parameters
	Procedure 23-2 To configure a Layer 3 interface
	Procedure 23-3 To modify a Layer 3 interface
	Procedure 23-4 To configure a routing policy
	Procedure 23-5 To configure an MPLS administrative group policy
	Procedure 23-6 To configure a static route


	24 - Routing protocol configuration
	24.1 Routing protocol configuration overview
	BGP
	RIP
	OSPF
	LDP
	ISIS
	RSVP
	Bridging on Telco devices

	24.2 Workflow to configure routing protocols
	24.3 Routing protocol configuration menus
	24.4 Routing protocol configuration procedures list
	24.5 Routing protocol configuration procedures
	BGP
	Procedure 24-1 To enable BGP on a router
	Procedure 24-2 To configure global-level BGP
	Procedure 24-3 To configure a BGP confederation
	Procedure 24-4 To configure peer group-level BGP
	Procedure 24-5 To configure peer-level BGP
	RIP
	Procedure 24-6 To configure global-level RIP
	Procedure 24-7 To configure group-level RIP
	Procedure 24-8 To configure interface-level RIP
	OSPF
	Procedure 24-9 To enable OSPF on a router
	Procedure 24-10 To configure OSPF on a router
	Procedure 24-11 To configure an OSPF area and add Layer 3 interfaces to the area
	Procedure 24-12 To add a router to an OSPF area
	Procedure 24-13 To create a virtual link
	LDP
	Procedure 24-14 To enable LDP on a router
	Procedure 24-15 To configure global-level LDP parameters
	Procedure 24-16 To configure LDP interfaces
	Procedure 24-17 To configure LDP targeted peers
	Procedure 24-18 To configure LDP peers
	ISIS
	Procedure 24-19 To enable ISIS
	Procedure 24-20 To configure ISIS parameters
	Procedure 24-21 To configure ISIS NET addresses
	Procedure 24-22 To configure ISIS interfaces
	RSVP
	Procedure 24-23 To configure RSVP parameters
	Procedure 24-24 To edit RSVP interfaces
	PIM
	Procedure 24-25 To enable PIM on a router
	Procedure 24-26 To configure PIM on a router
	Procedure 24-27 To create a PIM interface
	IGMP
	Procedure 24-28 To enable IGMP on a router
	Procedure 24-29 To configure IGMP on a router
	Procedure 24-30 To create an IGMP interface
	Procedure 24-31 To configure bridging


	25 - MPLS
	25.1 MPLS configuration overview
	25.2 Workflow to configure MPLS
	25.3 MPLS menus
	25.4 MPLS procedures list
	25.5 MPLS procedures
	Procedure 25-1 To enable MPLS on a routing instance
	Procedure 25-2 To create MPLS interfaces
	Procedure 25-3 To create MPLS paths
	Procedure 25-4 To create LSPs
	Procedure 25-5 To configure LSP paths
	Procedure 25-6 To list MPLS paths
	Procedure 25-7 To list LSPs
	Procedure 25-8 To view the LSP topology map


	26 - Service tunnels
	26.1 Service tunnel overview
	26.2 Service tunnel menus
	26.3 Service tunnel procedures list
	26.4 Configuring service tunnels procedures
	Procedure 26-1 To configure service tunnels
	Procedure 26-2 To list service tunnels
	Procedure 26-3 To view the service tunnel topology map
	Procedure 26-4 To manage service tunnels



	Managing subscriber services
	27 - Service management, triple play, QoS, and HQoS
	27.1 Service management overview
	Access interfaces
	Lightweight SAPs

	27.2 5620 SAM and the triple play service delivery architecture
	Service differentiation and QoS
	BTV multicast
	BTV multicast configuration examples

	27.3 QoS and HQoS overview
	27.4 Implementing QoS workflow
	27.5 5620 SAM QoS and HQoS policies
	Access ingress policies
	Access egress policies
	Network policies
	Network queue policies
	Scheduling
	Slope policies

	27.6 Sample network configuration using QoS
	27.7 Sample HQoS configuration for use by a service SAP
	Procedure 27-1 To configure HQoS for a service SAP


	28 - Policies
	28.1 Policies overview
	28.2 Service management policies
	Access ingress policies
	Access egress policies
	Network policies
	Network queue policies
	Slope policies
	Shared queue policies
	Scheduler policies
	802.1X policies
	Filter policies
	ATM QoS policies
	Multicast package policies
	Telco policies

	28.3 Workflow to create policies
	28.4 Policies menu
	28.5 Policies procedures list
	28.6 Policies procedures
	Procedure 28-1 To create an access ingress policy
	Procedure 28-2 To create an access egress policy
	Procedure 28-3 To create a network policy
	Procedure 28-4 To create a WRED slope policy
	Procedure 28-5 To create a network queue policy
	Procedure 28-6 To create a scheduler policy
	Procedure 28-7 To create an 802.1X policy
	Procedure 28-8 To create an aggregation scheduler
	Procedure 28-9 To create an ACL IP filter policy
	Procedure 28-10 To create an ACL MAC filter policy
	Procedure 28-11 To create an ATM QoS policy
	Procedure 28-12 To create a multicast package policy
	Procedure 28-13 To create a Telco node QoS level policy
	Procedure 28-14 To create a Telco ACL standard IP filter policy
	Procedure 28-15 To create a Telco ACL extended IP filter policy
	Procedure 28-16 To create a Telco ACL IGMP filter policy
	Procedure 28-17 To create a Telco ACL MAC filter policy
	Procedure 28-18 To distribute a policy
	Procedure 28-19 To edit a policy
	Procedure 28-20 To delete a policy
	Procedure 28-21 To copy or overwrite a policy
	Procedure 28-22 To synchronize a policy
	Procedure 28-23 To remove an unassociated policy
	Procedure 28-24 To perform a policy audit


	29 - Subscriber configuration and management
	29.1 Subscriber configuration and management overview
	29.2 Workflow to configure and manage subscribers
	29.3 Subscriber configuration and management menu
	29.4 Subscriber configuration and management procedures list
	29.5 Subscriber configuration and management procedures
	Procedure 29-1 To create a subscriber
	Procedure 29-2 To modify and manage subscriber information
	Procedure 29-3 To delete subscribers
	Procedure 29-4 To view a service map for a subscriber
	Procedure 29-5 To list subscriber services


	30 - VLL service management
	30.1 VLL service management overview
	Epipe (Ethernet VLL)
	Apipe (ATM VLL)
	Fpipe (frame relay VLL)

	30.2 Sample VLL service
	30.3 Workflow to create a VLL service
	30.4 VLL service management menus
	30.5 VLL service management procedures list
	30.6 VLL service management procedures
	Procedure 30-1 To create a VLL Epipe service using configuration forms
	Procedure 30-2 To create a VLL Apipe service using configuration forms
	Procedure 30-3 To create a VLL Fpipe service using configuration forms
	Procedure 30-4 To create a VLL service using a template
	Procedure 30-5 To modify a VLL service
	Procedure 30-6 To view the service operational status
	Procedure 30-7 To view the service topology
	Procedure 30-8 To delete a VLL service


	31 - VPLS management
	31.1 VPLS management overview
	HVPLS
	MVPLS
	MVR VPLS
	FIBs
	MAC learning
	MAC move
	Flooding
	Spanning tree protocols
	IGMP snooping
	Split horizon groups
	Residential split horizon groups

	31.2 Sample VPLS configuration
	31.3 Workflow to create a VPLS
	31.4 VPLS management menus
	31.5 VPLS management procedures list
	31.6 VPLS management procedures
	Procedure 31-1 To create a VPLS using configuration forms
	Procedure 31-2 To create a VPLS using a template
	Procedure 31-3 To create an HVPLS using spoke SDP connectors
	Procedure 31-4 To create a single MVPLS
	Procedure 31-5 To create an MVPLS composite service
	Procedure 31-6 To add or modify FIB entries
	Procedure 31-7 To view IGMP snooping queriers
	Procedure 31-8 To modify a VPLS
	Procedure 31-9 To view the service operational status
	Procedure 31-10 To view the service topology
	Procedure 31-11 To delete a VPLS


	32 - IES management
	32.1 IES management overview
	32.2 Sample IES configuration
	32.3 Workflow to create an IES
	32.4 IES management menus
	32.5 IES management procedures list
	32.6 IES management procedures
	Procedure 32-1 To create an IES using configuration forms
	Procedure 32-2 To create an IES using a template
	Procedure 32-3 To apply OSPF, RIP, or ISIS to an IES
	Procedure 32-4 To apply OSPF, RIP, or ISIS to an IES L3 interface
	Procedure 32-5 To add an IGMP interface to an IES
	Procedure 32-6 To add a PIM interface to an IES
	Procedure 32-7 To modify an IES
	Procedure 32-8 To view the service operational status
	Procedure 32-9 To view the service topology
	Procedure 32-10 To delete an IES


	33 - VPRN service management
	33.1 VPRN service management overview
	VPRN service routers
	PIM for VPRN
	Troubleshooting

	33.2 Sample VPRN configuration
	33.3 Workflow to create a VPRN service
	33.4 VPRN service management menus
	33.5 VPRN service management procedures list
	33.6 VPRN service management procedures
	Procedure 33-1 To create a VPRN service using configuration forms
	Procedure 33-2 To create a VPRN service using a template
	Procedure 33-3 To apply BGP, PIM, or RIP to a VPRN routing instance
	Procedure 33-4 To add a PIM interface to a VPRN
	Procedure 33-5 To modify a VPRN service
	Procedure 33-6 To view the service operational status
	Procedure 33-7 To view the service topology
	Procedure 33-8 To delete a VPRN service


	34 - VLAN service management
	34.1 VLAN service management overview
	Telco policies
	Telco network management

	34.2 Sample VLAN configuration for L2 VPNs
	34.3 Sample VLAN configuration for BTV
	34.4 Sample configuration for super VLAN
	34.5 Workflow to create a VLAN service
	34.6 VLAN service management menus
	34.7 VLAN service management procedures list
	34.8 VLAN service management procedures
	Procedure 34-1 To create a BTV VLAN service
	Procedure 34-2 To create an L2 VPN VLAN service
	Procedure 34-3 To create a super VLAN service
	Procedure 34-4 To create a standard VLAN service
	Procedure 34-5 To create a management VLAN service
	Procedure 34-6 To associate a VLAN service with a subscriber access interface
	Procedure 34-7 To create a VLAN service using a template
	Procedure 34-8 To modify a VLAN service
	Procedure 34-9 To view the service operational status
	Procedure 34-10 To view the service topology
	Procedure 34-11 To delete a VLAN service


	35 - Service mirror management
	35.1 Service mirror overview
	35.2 Sample service mirror configuration
	35.3 Workflow to create a service mirror
	35.4 Service mirror menus
	35.5 Service mirror procedures list
	35.6 Service mirror procedures
	Procedure 35-1 To create a service mirror
	Procedure 35-2 To create a service mirror using a template
	Procedure 35-3 To modify a service mirror
	Procedure 35-4 To view the service operational status
	Procedure 35-5 To view the service topology
	Procedure 35-6 To delete a service mirror


	36 - Composite service management
	36.1 Composite service management overview
	Network discovery of composite services
	Connector types

	36.2 Sample composite service configuration
	36.3 Workflow to create a composite service
	36.4 Composite service management menus
	36.5 Composite service management procedures list
	36.6 Composite service management procedures
	Procedure 36-1 To create a composite service
	Procedure 36-2 To modify a composite service
	Procedure 36-3 To delete a composite service


	37 - Map management
	37.1 Network topology maps overview
	Map toolbar
	LSP topology map
	LSP path topology map
	Service topology map
	Service tunnel topology maps

	37.2 Map management workflow
	37.3 Map management menus
	37.4 Map management procedures list
	37.5 Map management procedures
	Procedure 37-1 To open a map from the 5620 SAM main menu
	Procedure 37-2 To open a service topology map
	Procedure 37-3 To open an LSP path map from the MPLS Path form
	Procedure 37-4 To open an LSP path map from the LSP Path form
	Procedure 37-5 To view and understand map elements
	Procedure 37-6 To list or view object information from a map
	Procedure 37-7 To zoom in and zoom out of a map



	Fault management
	38 - Fault management using alarms
	38.1 Fault management using alarms overview
	Alarm status, severity, and aggregation
	Alarm thresholds
	Alarm suppression

	38.2 Workflow to manage network faults using alarms
	38.3 Fault management using alarms menus
	38.4 Fault management using alarms procedures list
	38.5 Fault management using alarms procedures
	Procedure 38-1 To set global alarm policies
	Procedure 38-2 To set alarm history behavior
	Procedure 38-3 To set specific alarm policies
	Procedure 38-4 To view alarms raised against equipment, logical components, and services
	Procedure 38-5 To view alarm information
	Procedure 38-6 To view all network alarms using the dynamic alarm list
	Procedure 38-7 To view network alarm statistics
	Procedure 38-8 To review historical alarm records
	Procedure 38-9 To reload all alarms


	39 - Troubleshooting and fault management using service assurance tools
	39.1 Troubleshooting and fault management using service assurance OAM tools overview
	MTU ping OAM
	Tunnel ping OAM
	Service site ping OAM
	LSP ping OAM
	LSP trace OAM
	MAC ping OAM
	MAC trace OAM
	MAC populate OAM
	MAC purge OAM
	VPRN ping and VPRN trace
	ATM OAM ping
	Service assurance test management and configuration

	39.2 Sample OAM diagnostic sequence for a service
	39.3 Workflow to manage network faults using OAM tools
	39.4 Fault management using OAM menus
	39.5 Fault management using OAM diagnostics procedures list
	39.6 Fault management using OAM diagnostics procedures
	Procedure 39-1 To create and run MTU ping OAM diagnostics from a service tunnel
	Procedure 39-2 To create and run tunnel ping OAM diagnostics from a service tunnel
	Procedure 39-3 To create an MTU ping OAM diagnostic from the test manager
	Procedure 39-4 To create a tunnel ping OAM diagnostic from the test manager
	Procedure 39-5 To configure and run VPRN OAM diagnostics from a service
	Procedure 39-6 To configure and run MAC populate OAM diagnostics
	Procedure 39-7 To configure and run MAC purge OAM diagnostics
	Procedure 39-8 To configure and run MAC ping OAM diagnostics
	Procedure 39-9 To configure and run MAC trace OAM diagnostics
	Procedure 39-10 To configure and run service site ping OAM diagnostics
	Procedure 39-11 To configure and run LSP ping OAM diagnostics
	Procedure 39-12 To configure and run LSP trace OAM diagnostics
	Procedure 39-13 To configure and run an ATM OAM ping
	Procedure 39-14 To edit an OAM diagnostic test
	Procedure 39-15 To delete an OAM diagnostic test
	Procedure 39-16 To view OAM diagnostic test results
	Procedure 39-17 To interpret OAM diagnostic results


	40 - Fault management using APS
	40.1 Fault management using APS overview
	Directional modes
	Switching modes
	APS port configurations
	APS support on a single node

	40.2 Workflow to manage network faults using APS
	40.3 Fault management using APS menus
	40.4 Fault management using APS procedures list
	40.5 Fault management using APS procedures
	Procedure 40-1 To configure APS on SONET/SDH ports
	Procedure 40-2 To change the operational state of APS
	Procedure 40-3 To remove APS from a SONET/SDH port



	Statistics
	41 - Accounting and performance monitoring using statistics
	41.1 Accounting and performance monitoring using statistics overview
	Statistics types

	41.2 Workflow for statistics collection
	41.3 Statistics menus
	41.4 Statistics procedures list
	41.5 Performance monitoring using statistics procedures
	Procedure 41-1 To create or modify a file policy
	Procedure 41-2 To create or modify an accounting policy
	Procedure 41-3 To view equipment and other object-based performance statistics
	Procedure 41-4 To modify equipment and object-based performance statistics policies
	Procedure 41-5 To view statistics logs



	Glossary
	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W


